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1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2.  Installation Guide

2.1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

2.2.  Overview of a WebCenter Installation

The WebCenter installation procedure involves a number of different steps that need to be performed
in a specific order.

The table below shows a list of the steps required to install WebCenter either for the first time or as an
upgrade:

Step Description

1 Check the Requirements and perform pre-installation work:

• Hardware and Software Requirements on page 16

• Pre-Installation Steps on page 26

2 Installing WebCenter on page 29:

1. Install SQL Server 2012/ 2017/2019 Express Edition on the Database Server on page
30

2. Install ArtiosCAD Enterprise on the Application Server on page 31
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Step Description

3. Install the WebCenter Application Server on page 33
4. Install the WebCenter Web Server on page 39
5. Start the WebCenter Services on page 40
6. Install the On-Board Graphics Engine (OBGE) on the Application Server on page 41

3 Testing WebCenter on page 43

4 Configuring WebCenter on page 43:

1. Configure the OBGE on page 43
2. Configuring the E-Mail Notifications on page 45
3. Secure your WebCenter Site with SSL on page 49
4. Install Certificates for LDAPS on the Application Server on page 62
5. Integrate WebCenter with a Workflow Production Server on page 64
6. Expose WebCenter to the Internet on page 68

2.3.  Hardware and Software Requirements

Attention:  For the latest hardware and software requirements, please check the Esko website.

WebCenter employs three distinct servers, a Web Server, an Application Server, and a Database
Server.

It also has a FileStore and an On-Board Graphics Engine (OBGE), which is used to generate view data.

New IT Requirements since WebCenter 21.03
There are no specific new requirements for WebCenter 21.03. For the latest hardware and software
requirements, please check the Esko website.

New IT Requirements since WebCenter 14
Since 14, WebCenter runs on 64-bit operating systems only. Only Windows Server 2012 or later are
supported.

Entry Level (Two Server Systems Required)
WebCenter Entry Level requirements are based on an activity with 10 concurrent users active at any
time and less than 100 users in the system. Customers with higher performance needs should refer to
the Advanced Level requirements.

In the Entry Level setup, the installation of the Application Server and Database Server is combined
onto a single machine. The OBGE and the FileStore are on the Application Server.

For reasons of security the Web Server is always on its own dedicated computer and placed in a
demilitarized zone (DMZ). We recommend the use of hardware firewalls for creating the DMZ.
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Advanced Level (Three or More Server Systems Required)
When the WebCenter Entry Level cannot meet the load requirements of the system, it is possible to
scale the system.

For reasons of security the Web Server will always be a separate computer in a DMZ.

Each of the other WebCenter components (Application Server, Database Server, FileStore and OBGE)
can be ooaded onto separate machines in different combinations.

For Advanced Level installations, it is recommended to choose the Advanced Installer option to allow
more custom configuration, and to choose Extra Large for the Deployment Size.

Requirements

Category Entry Level (Standard - < 100
users)

Advanced Level (Extra Large -
100+ users)

Operating System Microsoft Windows Server 2012
or better

Microsoft Windows Server 2012
or better

Processor - Application Server
with On-Board Graphics Engine

x86-64 compatible processor
(Intel or AMD), minimum 8 cores

x86-64 compatible processor
(Intel or AMD), minimum 12
cores, 6 + 6 per 100 users

Processor - All other WebCenter
Servers

x86-64 compatible processor
(Intel or AMD), minimum 4 cores

x86-64 compatible processor
(Intel or AMD), minimum 6 cores,
2 + 4 per 100 users, 2 + 6 per 100
users for separate DB server

RAM Memory (Application Server
with DB and OBGE)

16 GB or more 36 GB or more

RAM Memory (Application Server
with OBGE)

16 GB or more 28 GB or more

RAM Memory (Application Server) 12 GB or more 18 GB or more

RAM Memory (Separate Database
Server)

12 GB or more minimum 12 GB or the size of
the DB (whichever is larger), add
8 GB per 100 users

RAM Memory (Web Server) 6 GB or more 12 GB or more

Available hard disk space -
Application Server

20 GB or more 60 GB or more

Available hard disk space - Web
Server

20 GB or more 60 GB or more

Available hard disk space -
Database Server

40 GB or more 80 GB or more

Available hard disk space - File
Store

100 GB, should be expandable as
data storage grows with usage.
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Category Entry Level (Standard - < 100
users)

Advanced Level (Extra Large -
100+ users)

For WebCenter to perform
according to expectations,
the FileStore needs to be on
Windows file servers.

Recommended to use Windows
Server 2008 R2, Windows Server
2012 or Windows Server 2012 R2
and Windows Server 2016 as file
server (but ReFS data volumes
are not supported yet).

Display 1024 x 768 pixels, 16-bit color
minimum

1024 x 768 pixels, 16-bit color
minimum

Media drives - Application Server DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Media drives - Web Server DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Network (all servers) 10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

Database software • Microsoft SQL Server
2012/2014/2016/ 2017/2019
(Express Edition, Workgroup
Edition, Standard Edition,
Enterprise Edition)

• Oracle 10g or 11g or 12c
Enterprise Edition

Note:  Oracle 8i and 9i are no
longer supported.

• Microsoft SQL Server
2012/2014/2016 /2017/2019
(Workgroup Edition,
Standard Edition, Enterprise
Edition)

• Oracle 10g or 11g or 12 c
Enterprise Edition

Note:  Oracle 8i and 9i are no
longer supported.

Notes
• The Database Server needs 10 GB of free space on the partition containing the database files to

allow for database expansion.
• If you install the Global Vision extension on the OBGE, the OBGE needs to be separated from the

WebCenter Application Server.

If you install the additional Automation Engine Processor module license for WebCenter, the OBGE
needs to be separated from the WebCenter Application Server.

• The Application Server is the default location for uploaded files (also known as the FileStore).

Ensure it has at least 50 GB of available hard drive space, and that the disk space is expandable.
Alternatively, find a network location with expandable disk space to specify as the file storage
location when loading the Application Server.

• The Web, Application and Database Servers must have the same OS language, regional setting
(such as English (United States)), and time zone setting.
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• You must be able to download and install Java applets automatically to use the Java Viewer.

If Java is installed but a red X appears in the browser when launching the Viewer, consult your
system administrator to see if a firewall or proxy blocks Java downloads.

• If you are using a Microsoft Hyper-V hypervisor virtual machine, do not install both the WebCenter
Web Server and the Esko Licensing software on this virtual machine.

2.4.  WebCenter Installation Tips

Licenses
• WebCenter Licenses

To install WebCenter 21.03, request for the WebCenter 21.03 licenses.

The old WebCenter 20,18.x, 16.x, 14.x or 12.x licenses will not work anymore.
• WebCenter supports two types of licensing models. You can have counted licenses in the Named

User Model and Concurrent License Model where you can have licenses that are taken up during a
log-in sessions.

• Named User Licenses: A named user license is an exclusive license of rights assigned to a
single software user. This License model lets you pay for the number of users you want to create
in WebCenter. This means that the purchased number of licenses (per type of users) limit the
number of users that can be created. Read more in: Licensing and Users and in this FAQ.

• Concurrent Licenses:

In this model, you can create as many users as you want. The number of users who may use
the system at the same time is determined by your Concurrent Licenses. The licensing model
distinguishes between three types of users: guaranteed users, concurrent users, and editor
users.

Note:  Since WebCenter 14.0.2, large installations from 50 concurrent users require a
WebCenter Advanced License. A special 'advanced' variant of the concurrent user licenses is
also needed in this case.

Network Licensing Tool
For WebCenter 21.03, you need to install ArtiosCAD Enterprise 21.03, this installation includes the
required Network License Manager.

To know more about Network Licenses, click here..

Server Configuration
Port Configurations

Below you can find the ports which need to be open/available for proper functioning of WebCenter:

• Port 80 (HTTP) from the internet to the WebCenter Web Server (DMZ).
• Port 443 (HTTPS) from the internet to the WebCenter Web Server (DMZ).
• Port 80 (HTTP) from the LAN to the WebCenter Web Server (DMZ).
• Port 443 (HTTPS) from the LAN to the WebCenter Web Server (DMZ).
• Port 4444 from the WebCenter Web Server (DMZ) to the WebCenter Application Server (LAN).
• Port 5445 from the WebCenter Application Server to the Automation Engine server (LAN) for

approval feedback
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• Port 25 (SMTP) from the WebCenter Application Server (LAN) to the Mail Server.

Note:

• The following ports are internal ports for the Application Server and need not be configured on the
firewalls. However, if any of these ports are taken by another application, the Application Server will
not start. Ports: 8083, 8086, 1161, 1162, 1090.

• The following ports are internal ports for the WebServer and do not need to be configured on the
firewalls. However, if any of these ports are taken by another application, the WebServer will not
start. Ports: 8081, 8009.

Note:  It is recommended to install the external viewer during the installation process.

• Database

The database shipped as default with WebCenter 21.03 is MSSQL 2012 / 2017 Express.

• OBGE

In case the OBGE 21.03 is installed on the Web Server (not recommended), make sure to stop the EG
Web Server service before starting Tomcat.

Note:  Since 16.1, Automation Engine no longer uses Hot Folders explicitly, but you can now
configure the FileStore JDF Hot Folder by creating an Access Point which is described in Create a
JDF Hot Folder (Access Point) for WebCenter.

• IIS

If you move to WebCenter 21.03 from WebCenter 12.x, leaving the installation of IIS intact, a
change to IIS may be needed. In IIS, go to Application Pools and open the Advanced Settings for
DefaultAppPool. Make sure that ‘Enable 32-Bit Applications’ is set to ‘False’. After changing the
setting, click ‘Recycle’.

• Simple or Advanced Installation

Since WebCenter 14, it is possible to choose between a Simple or Advanced installation. If the
Advanced installation mode is selected, the memory size allocated for the JBoss service on the
Application Server and the TomCat service on the Web Server need to be specified. Choosing the
Extra Large option is recommended for servers that are expected to experience a heavy load and
high concurrent user access.

• Internal or External Viewer

In case of an Advanced installation, the Viewer service can be set to Internal or External. Selecting
External will make the Viewer service run as a separate process. Note that choosing External
requires extra ports to be opened between the Application and Web Server: 14444. And the
following ports need to be available for the application server: 1091, 3528 and 4446.

• Database user

In case of an Advanced installation, it is possible to set a custom password for the WebCenter
database user.

• Boards

Previously, in older versions of ArtiosCAD Enterprise, the Boards needed to be installed by running
a .bat file after the WebCenter installation. Since ArtiosCAD Enterprise 14.0, you can install the
Boards automatically during the ArtiosCAD Enterprise installation, this is highly recommended.

Servicing
• Admin Console
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Since WebCenter 14, it is possible to inspect JBoss by going to: http://yourhost:8086/
admin-console.

• Services

Since WebCenter14, you will only see the following services:

• JBoss
• Tomcat
• CAD-X

The App-X and Search Crawler services are no longer needed since WebCenter 12.

Note:  In order to run the services interactively, open the command prompt and go to ..\Esko
\Artios\WebCenter\ApplicationServer\NAMEOFSERVICE\bin for each service, and
run wcr_nameofservice_srv_cmdrun.bat. For example: C:\Esko\Artios\WebCenter
\ApplicationServer\JBoss\bin\wcr_jboss_srv_cmdrun.bat.

2.5.  Installation Checklist

The Installation Checklist can be used as a tool alongside the rest of the Installation Guide to ensure
you completed all the necessary steps during the installation. There are two versions, the first one can
be used for a fresh installation, the second one can be used in case of an upgrade.

2.5.1.  Installation Checklist for Fresh Installation

This checklist can be used whilst performing a fresh installation of WebCenter (meaning WebCenter
was not installed on the same machine(s) before).

Please complete the Installation Checklist in the same order as listed here.

Note:  Do not run this installation from a network share.

On the Application Server...

Install ArtiosCAD Enterprise located on the WebCenter DVD.

Install License Server Components from the ArtiosCAD Enterprise Installer.

Activate Network Licenses via the Network License Manager:

 WebCenter (Standard or Advanced)

 CAD Engine

 OBGE

 Optional licenses

If you are going to use MS SQL Server (no prerequisites for Oracle):

 Install MS .NET framework 3.5 (run the script from the WebCenter DVD to install it).
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 Install MS .NET framework 4.5 (run the script from the WebCenter DVD to install it).

Note:  For servers with Windows Server 2012 or with access to the Internet, this will happen
automatically.

 Install the SQL Server 2012 SP1 Express Edition Database engine for WebCenter or SQL Server
2017 Express Edition or SQL Server 2019 Express Edition.

 Always install SQL Management Studio on the Application Server.

Create the local BGSYSTEM Windows user (run the script from the WebCenter DVD to create it)
and enter a password.

Create the FileStore folder and share it as a network folder with all rights enabled for the
BGSYSTEM user.

Install the Application Server component of WebCenter; build the Database schema and REBOOT.

Install the OBGE from the Automation Engine DVD by selecting the option: Install Automation
Engine 21.03 as On Board Graphics Engine (OBGE) for WebCenter.

Configure the Access Point (formerly known as Hot Folder) in the Automation Engine Pilot to
generate view files for graphic files.

On the Web Server...

Install and configure IIS 8 (Windows Server 2012) on the Web Server.

It is recommended to auto install IIS using the provided PowerShell Script from the installation
disk, to configure IIS on Windows Server 2012 or later.

Make sure that Enable 32-bit programs in IIS is set to False.

Increase the upload limit in the request filtering.

Install the Web Server component of WebCenter and REBOOT.

On the Application Server...

Since WebCenter 12.1, services are started automatically. Verify that the following services are
started:

 JBoss

 CAD-X

 Application Monitor

On the Web Server...

Verify that the following services have been started:

 TomCat

 Application Monitor

Connect to WebCenter in your browser: http://[WebServer]/WebCenter_Inst.
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 Username: admin. Password: [blank].

 Change password.

Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).

Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X service

Run the Studio Defaults installer, to install Studio Print Finishing Profiles for working with
advanced material effects in 3D visualization

2.5.2.  Installation Checklist for Upgrade

This checklist can be used whilst performing an upgrade installation of WebCenter 21.03 from an older
version.

Please complete the Installation Checklist in the same order as listed here.

Note:  Do not run this installation from a network share.

On the Web and Application Server...

Stop all WebCenter services.

On the Application Server...

Backup the whole ..\WebCenter\ApplicationServer folder (make a copy, do not move it)
and backup the following:

 FileStore

 Database

 Email configuration (if you upgrade from a WebCenter< 12)

On the Web Server...

Backup the whole ..\WebCenter\WebServer folder (make a copy, do not move it).

Uninstall the old version of WebCenter on both Application and Web Server and REBOOT
both servers after uninstall. Delete all the sub folders present in ..\WebCenter
\ApplicationServer.

Remove all WebCenter instances in IIS on the Web Server.

On the Application Server...

Upgrade to ArtiosCAD Enterprise 21.03 located on the WebCenter DVD.

Upgrade the Network License Manager via the Install License Server Components from the
ArtiosCAD installer.

Upgrade WebCenter Licenses and dependants (CAD Engine and OBGE) to 21.03.
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If you are using MS SQL Server, make sure that SQL Management Studio is always installed on the
Application Server.

Install the Application Server component of WebCenter using the existing FileStore and
Database. DO NOT REBOOT YET

Re-apply email customization on the Application Server.

Build the Database schema if this was not done during the installation.

REBOOT

Update to Automation Engine OBGE 21.03 and configure the Access Point (formerly known as Hot
Folder) in the Pilot to generate view files for graphic files.

On the Web Server...

Install the Web Server component of WebCenter.

Make sure that Enable 32-bit programs in IIS is set to False.

To be able to use Excel based lists from the Web Server, install a 64-bit driver (see link on the
WebCenter DVD). DO NOT REBOOT YET

Re-deploy WebCenter Instance(s) and re-apply customizations.

REBOOT

On the Application Server...

Since WebCenter12.1, services are started automatically. Verify that the following services are
started:

 JBoss

 CAD-X

 Application Monitor

On the Web Server...

Verify that the following services have been started:

 TomCat

 Application Monitor

Connect to WebCenter in your browser: http://[WebServer]/WebCenter_Inst.

 Username: admin. Password: [old admin password].

Install or merge the ArtiosCAD Defaults in English and Import the Boards (directly from the
ArtiosCAD Defaults Installer).

Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).

24



2WebCenter

Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X
service

Run the Studio Defaults installer, to install Studio Print Finishing Profiles for working with

advanced material effects in 3D visualization.

2.6.  CHILI-WebCenter Connection

2.6.1.  Share between CHILI and WebCenter

A CHILI share is used to temporarily hold the files while registering them to the CHILI server.
WebCenter will create a sub folders corresponding to the CHILI environments in this CHILI share root
folder.

Note:

The share must have:

• read and write permissions for WebCenter 'BGSYSTEM' user.
• read permissions for CHILI server.

2.6.2.  Requirements for Reverse Proxy for CHILI Server

IIS ports accessing CHILI over the WebCenter web server should be:

• 80 for IIS http
• 443 for IIS https

The https ports must have a security certificate attached to it in order to be able to work with Web
Server.

Note:  The best practise is to install a properly signed certificate, matching the CHILI server hostname
(NOT the tricked hostname) on the CHILI server. In this scenario, the validation of the SSL certificate
will be smooth when the WebCenter Application Server makes a connection to it.

Alternatively, you may use a self-signed certificate. However, these are not supported for the
WebCenter WebServer. You may get SSL validation errors when the WebCenter Application Server
tries to connect to the CHILI server due to this.

As a work-around, use the WebCenter LDAP CertInstall tool:

• Go to the <Installation Directory>\ApplicationServer\LDAP.
• Run the following command:

CertInstall.bat
                        <chiliserver>:443

25



2 WebCenter

• Select the right certificate to install by entering a digit.

• Restart the JBoss.

This will solve the SSL validation problems.

2.7.  Pre-Installation Steps

Execute the following steps to make sure you have all the required information and materials for the
installation.

1. Log on to all servers as a local administrator user.

Attention:

Logging on as DOMAIN ADMIN does not ensure you are a member of the local Administrators
group.

Verify that the account you are using to log on to each machine belongs to the local
Administrators group before you continue!

2. Make sure you use compatible software versions:
a) Gather the installation media on CD or DVD for ArtiosCAD Enterprise, WebCenter, and

Automation Engine (OBGE).
b) Only very specific versions of ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE)

work with each other.

You CANNOT assume that a new version or build of one product will be compatible with older
versions of the other products.

Software Version Build

ArtiosCAD Enterprise . . . . . . . . . . . .

WebCenter . . . . . . . . . . . .

Automation Engine . . . . . . . . . . . .

3. Check the licenses for the Esko installers:
a) Gather Graphics and CAD licenses.
b) If this is an upgrade, you will need to ask for updated license files.
c) Check the license files against your software order.

Verify that the licenses have the correct number of users, the expiration date if applicable,
and the correct ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE) version
information.

4. Gather the required mail server information:
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Note:

The mail server must be on the same network as the WebCenter Application Server.

Also, ensure this mail server has a send-only e-mail account already created for specific
use with WebCenter notifications (this usually requires creation of an account such as
webcenter@mycompany.com).

Mail Server Information Value

Mail Server Name . . . . . .

Mail Server IP Address . . . . . .

SMTP Port . . . . . .

WebCenter Sender Address . . . . . .

SMTP Authentication User Name . . . . . .

SMTP Authentication Password . . . . . .

5. Gather the required database information from the database administrator:

Database Item Value

server name . . . . . .

“sa” password . . . . . .

database instance name . . . . . .

SQL Server

database port (default is
1433)

. . . . . .

server name . . . . . .

‘sys’ password . . . . . .

TNS name . . . . . .

System ID (SID) . . . . . .

Oracle Server

database port (default is
1527)

. . . . . .

6. Ask the database administrator whether a custom password for the 'WebCenter' database user will
be required and if so, retrieve the expected target password for this database user.

7. Perform a Web Server health check:
a) We highly recommend not to begin the install with the Web Server inside the DMZ. It is best to

configure on a local LAN first.
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Get all applications installed, configured, and fully functional before moving the Web Server
inside the DMZ. Otherwise any required troubleshooting will be dicult and will take longer than
needed.

b) Verify that Internet Information Services (IIS) is installed and its services are started: IISADMIN
and W3SVC (World Wide Web Publishing).

c) Make sure the Server service is running.
8. Test the mail server connection:

Note:

Ensure that you can use telnet commands and that its port is not blocked in any way.

Make sure you test this before starting the installation. IT Administrators often block the required
SMTP ports.

a) From the Application Server, open a command prompt.
b) Use a telnet command with the following syntax: telnet <mail_server_name_or_ip>

<smtp_port#>.

For example, my mail server name is mail.eskowebcenter1.com and my SMTP port is 25.

I would type: telnet mail.eskowebcenter1.com 25.

You are looking for a successful response (for example like the one below); a 220 response is
good.

telnet mail.eskowebcenter1.com 25Trying 62.204.32.250...Connected to
 mail.eskowebcenter1.com (62.204.32.250).220 mail.eskowebcenter1.com Mail Server;
 Mon, 2 Jun 2014 11:26:40 EST

Type QUIT to exit the telnet command.
9. Make sure the Server service is running on the Application Server.
10. Check the Database Server:

a) Ensure the correct database engine, version and service pack are installed. See section Install
SQL Server 2012 Express Edition on the Database Server.

b) For SQL Server 2012/2017/2019 or Express 2008/2012/2017/2019 verify these configurations:

• Must be configured to run in Mixed Mode for authentication;
• Language/Character set of SQL Server must match the Operating System language;
• TCP/IP must be enabled.
• If a named instance is used, the SQL Server Browser must be set to start automatically (and

must be running).
c) This assumes that the system is protected by an external firewall.

11. Check performance for all servers:
a) For all servers (Web, Application, Database), ensure Windows System Performance is set to

Adjust for Best Performance:

Go to Control Panel > System > Advanced and select Adjust for Best Performance from the
Performance list.

b) Ensure Control Panel > Automatic Updates is set to Download updates for me, but let me
choose when to install.
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Windows Updates have been known to interfere with WebCenter operation: some updates lock
down ports and stop services related to web and internet.

It is your responsibility to test Microsoft updates before applying them to production servers.
c) Ensure Windows Firewall is disabled:

Go to Control Panel > Network Connections, right-click on the active network connection and
choose Properties. On the Advanced tab, ensure Internet Connection Firewall is disabled.

d) Stop and temporarily disable virus software.

Temporarily stop virus services on the Web Server and the Application Server as they are known
to interfere with the WebCenter installation script.

Only after the software is installed should you enable the virus software again.

2.8.  Installing WebCenter

Installing WebCenter is a multi-step process spread over two or three servers depending on your
configuration. We strongly recommend having three servers.

2.8.1.  Overview of the Installation Procedure

This is a broad overview of the steps required to install WebCenter.

1. Perform the Pre-Installation Steps on page 26.
2. On the Database Server, optionally create a database called WebCenter4_0 if using Microsoft SQL

Server. If you do not create the database at this point, it will be done by the WebCenter installer.

If using Oracle, we recommend that the SID (System Identifier) of the database be WCenter,
but it can be anything; just make sure you know the exact name so you can enter it while loading
WebCenter on the Application Server.

3. On the Application Server:
a) If using Microsoft SQL Server or SQL Server Express Edition, install Microsoft SQL Server

Management Studio (if you have not done so already). This is provided as part of the MSSQL
Express installer provided on the DVD. If you are using Oracle, it is advised to also install SQL
Developer Studio, which can be downloaded from the Oracle web site.

b) Install ArtiosCAD Enterprise.

Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you must load
the version that came with WebCenter.

For more information on loading and configuring ArtiosCAD Enterprise, refer to the installation
instructions on its media.

c) Activate the Licenses on page 32
d) Install the WebCenter Application Server.

4. Run the Database Schema Scripts on the Application Server.

This is only required if the database schema scripts were not run automatically, or if the automatic
run failed. Running the database schema scripts automatically is preferred. If needed, it is still
possible to run the database scripts manually from the Application Server.
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5. On the Web Server, install the WebCenter Web Server.

Reboot the Web Server machine if prompted.
6. Start the WebCenter Services:

a) On the Application Server, start JBOSS and CAD-X.
b) On the Web Server, start Tomcat.

Note:  These services are set to start automatically by the installer and will thus be started
automatically after each machine reboot. If you prefer to start the services manually, you may
set them to start manually by changing their properties in the Services applet via Control Panel >
Administrative Tools.

Note:  Since WebCenter 12 a new monitoring service is installed and started automatically. This
service can be used by your WebCenter support agent for troubleshooting.

7. Install the On-Board Graphics Engine (OBGE) from the Automation Engine media. This will take about
a half hour.

Note:

You must install the OBGE even if you are running a separate Automation Engine production server.

The OBGE will handle files uploaded through the WebCenter user interface, reducing the load on
your Automation Engine production server.

WebCenter is now installed.
8. Log on the WebCenter web interface and:

a) Change the administrator password.
b) Configuring the E-Mail Notifications on page 45 if you will be using it.

9. Install the ArtiosCAD defaults.
See Loading the ArtiosCAD Defaults for details.

2.8.2.  Install SQL Server 2012/ 2017/2019 Express Edition on the Database
Server

Microsoft SQL Server 2012 / 2017/2019 Express Edition (supplied with WebCenter) is a free version that
can serve as the database engine for WebCenter.

To install it, use the Install the SQL Server 2012 / 2017 /2019 Express Edition database engine for
WebCenter link on the WebCenter installation media.

Following steps describe how to install the MSSQL Server 2012/ 2017/2019 Express database on a clean
system:

1. When the SQL Server Installation Center launches, select the option New SQL Server stand-alone
installation or add features to an existing installation.

2. If prompted, accept the License Terms and click Next.
3. A quick check will be done and the installation will be prepared.
4. Select the Features you wish to install. If unsure, enable all except LocalDB.
5. On the Instance Configuration screen, select Named Instance and name your instance

WEBCENTER. You can also change the instance root directory if you want.

30



2WebCenter

6. On the Server Configuration screen, you can define separate accounts for each service, leave as
default.

7. You can also specify your Database Engine Collation, leave as default.
8. On the Database Engine Configuration screen, choose the Mixed Mode authentication type.
9. On the same screen, specify the SQL Server system administrator (sa) password.
10. On the Reporting Services Configuration screen, select Install and Configure and click Next.
11. The system will now continue with the installation. The last screen shows that the installation

process was completed successfully. You may be asked to restart the computer.
12. If you now inspect your Programs, you should see Microsoft SQL Server 2012 / 2017  listed, along

with other tools like SQL Server Management Studio.
13. Launch the SQL Server Management Studio to check the connection to the Database Engine.
14. In case it has not been created yet, add a new database named WebCenter4_0.
15. Launch the SQL Server Configuration Manager to check the TCP/IP and SQL Server service

statuses.
16. Choose SQL Server Network Configuration > Protocols for WEBCENTER > , make sure TCP/IP is

set to Enabled for WebCenter.
17. In the SQL Server Services section, restart the SQL Server service. Also, make sure the SQL Server

Browser service is running.
18. If Microsoft SQL Server 2017 Management Studio is installed, you will also need to install the

Microsoft SQL Command Line Utility (sqlcmd).

2.8.3.  Install the Application Server Components

Install ArtiosCAD Enterprise on the Application Server
1. Log on to the Application Server as a member of the local Administrators group.
2. Load the ArtiosCAD Enterprise media that came with WebCenter.

Important:

Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you must load the
version that came with WebCenter. In the case of WebCenter 21.03, you need ArtiosCAD Enterprise
21.03.

Make sure to also run the Install Network License Components installer from the ArtiosCAD
Enterprise Installer.

In order for WebCenter to output PDF files, the ArtiosCAD PDF option must be purchased and then
chosen when installing.

For more information on loading and configuring ArtiosCAD Enterprise, refer to its installation
instructions on the ArtiosCAD media.

3. In the Esko ArtiosCAD Setup window, click Install Esko ArtiosCAD Enterprise 21.03 en.
Depending on your system configuration prior to loading ArtiosCAD, the Microsoft Data Access
Components and MSXML 6 may be copied to your system.

If the system prompts you to reboot, do so; the installation program will resume automatically when
you log in after the system comes up again. Do not postpone rebooting if the system requests it.

4. The Esko ArtiosCAD Enterprise 21.03 en InstallShield Wizard opens.
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a) In the Licensing Method screen, choose Network Licenses. Make sure the Server field contains
the name of the Application Server (it should be filled in by default).

b) In the Setup Type screen, choose Typical for a regular WebCenter installation, or Advanced if
you will be working with ArtiosCAD Enterprise.

c) In the Feature Selection screen, make sure PDF Import/Export is enabled.

Note:  You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.

d) In the Advanced Options screen, you can leave the default options selected. If you wish to
change them please see the ArtiosCAD documentation for details.

Note:  You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.

e) In the User Files Folder screen, keep the default location for the storage of user files, or Change
it if desired. If you change the location to another system, use a UNC locator (for example \
\system2\designs) instead of a mapped drive letter.

Note:  You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.

f) Click Install.
g) Once the installation is complete, click Finish to close the installer.

5. If the system asks you to reboot, do so.

Note:  You will need to perform extra configuration later to work with ArtiosCAD Enterprise.

Note:  Since ArtiosCAD Enterprise 14.0, you can install the Boards automatically during the
ArtiosCAD Defaults installation, this is highly recommended. In case you do not choose to install the
Boards during the ArtiosCAD Enterprise installation, you will have to import them manually later.

Create a Detailed Installation Log

For Installation debugging and troubleshooting purposes, you can create a detailed installation log file
for any Esko Installer programs. To do this:

Run setup using the following syntax: Path+program space /v”/l*v space path+logfilename

• For example: For ArtiosCAD Enterprise installation from CD-ROM in my D:\ drive,

• Open a command prompt and Change to the D:\ drive

• Type: setup /v”/l*v c:\temp\ACsetup.log”

Activate the Licenses
If you have not done so already, install the Network License Components from the ArtiosCAD
Enterprise Installer first.

Activate your licenses using the Esko Network License Manager.

Note:  To perform this task, consult the Network License Manager User Manual.

You need to activate:
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• your ArtiosCAD Enterprise license,
• your WebCenter licenses (your basic WebCenter license and any additional WebCenter license you

have, for example WebCenter Task Management, WebCenter Advanced Approval, Reporting, etc.).
• your license for the OBGE (Automation Engine license).

Install the WebCenter Application Server
The Application Server components of WebCenter can be installed from a link on the installation
media.

Before doing so, click the link on the DVD to Create the local BGSYSTEM Windows user, if this user was
not created earlier.

1. Log on to the Application Server as a member of the local Administrators group.
2. Insert the WebCenter media into the media drive, and click Software Installation on the menu that

appears at left, then Install WebCenter 21.03.
3. The setup wizard opens with a Welcome screen. Click Next.
4. In the License Agreement screen, read the agreement, and if you agree to it, select I accept the

terms in the license agreement and click Next.
5. Select either Simple (default) or Advanced Installation. Keep Simple (default) selected unless you

mean to specify non-default values for either Installation Size, Image Viewer Service or Database
User management.

6. In the Custom Setup screen:
 

 
a) Click the icon next to WebServer and select This feature will not be available.
b) Click the icon next to Application Server, and select This feature, and all subfeatures, will be

installed on local hard drive.
c) If desired, click Change to change the installation folder.
d) Click Next.
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7. In the WebCenter File Storage Folder screen, choose the location where all data files uploaded to
WebCenter will be stored (the FileStore).

Note:  If you want to change the FileStore location, click Change... and browse to your desired
location or enter a UNC address. Using a UNC location such as \\system\sharename
\FileStore is the most reliable option. The FileStore should be on a partition with at least 50 GB
of free space.

Troubleshooting:

If the installer fails to create the FileStore, it will give you a message saying that you have to set it up
manually.

Go to the folder that you will use as a FileStore (by default, C:\Esko\Artios\WebCenter
\FileStore, or the location of your choice), and share it (typically to the user BGSYSTEM).

Click Next.
8. In the Web Server System screen, enter the name you will give to the Web Server and click Next.

Note:  Once you have completed the installation and launched WebCenter, the Application Server
must be able to resolve the Web Server name you have entered here into an IP address.

9. In the Database Configuration screen, enter your database information:.
a) Choose your Database program (Microsoft SQL Server or Oracle).
b) Enter the name of your Database Server in Database server system.
c) If you chose...

• Microsoft SQL Server, enter your Database Instance Name. By default, this is WEBCENTER
(using the SQL Server 2012/2017 Express Edition installer on the WebCenter installation
media created this instance).

• Oracle, enter your Database System Identifier (SID).

Click Next when done.
10. A custom WebCenter database user password can be set. In that case you will need to provide a

password value. This screen will only be shown in case of an Application Server installation.

Note:  This screen appears only for Advanced installation.

11. Choose between a Standard (default) and an Extra Large deployment. If Extra Large is selected,
Tomcat and/or JBoss (depending on the server being installed) will be able to allocate 3 times more
memory as is the case with a Standard installation.

Note:  This screen appears only for Advanced installation.

12. Choose between an Internal or External (default) View server. If Internal is selected, the View
Server runs inside the JBoss process. If External is selected, an additional process running the
View Server will be started automatically. For the External view server to work, other ports need to
be open in the firewall between the web and the application server: 14444.

Note:  If installing Web and Application server component separately – a matching mode (either
external or internal) has to be selected for both the Application server and Web server – otherwise
the Viewer will not function properly.
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13. Click Install in the Ready to Install the Program screen.
14. The Esko Station Information Service may be installed if this is the first Esko software being

loaded on the machine.

If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.

15. Click Finish when the installation completes.
16. If prompted, reboot the system.

Attention:  This is important; do not postpone this step!

2.8.4.  Run the Database Schema Scripts on the Application Server

Since WebCenter 12.1, it is no longer necessary to run the database schema scripts manually. The
database schema scripts can now be run from the installer dialog, for both local and remote databases.

When the database scripts are run automatically, a system console readout window will show feedback
on the progress. Individual SQL statement blocks are displayed as they are being executed.
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To run the database scripts automatically, database connection parameters need to be entered in the
Database Configuration dialog which is displayed during the installation of the WebCenter Application
Server:

1. Choose your database type from the Database program list.
2. Enter the database host name in the Database Server system field.
3. For SQL, enter the instance name in the Database Instance Name field.
4. For Oracle, enter the SID in the Database System Identifier (SID) field.
5. The checkbox Run DB update scripts during installation determines whether the database schema

scripts are run automatically during installation (preferred), or not.
6. If running the scripts automatically is enabled, the DB sysadmin connection password field

becomes available. Enter the password of the default database administrator user for your
Database Server in this field.

If you still want to run the scripts manually, do the following:

1. Locate the ServerTools\update_db.bat file in your WebCenter installation folder (for
example C:\Esko\Artios\WebCenter\ServerTools\update_db.bat).

2. Run this file with the appropriate parameters in the console.

36



2WebCenter

Tip:

Run this file without parameters first to see help about which parameters you need to use.

• If you have a SQL database, you will see this:
 

 

• If you have an Oracle database, you will see this:
 

 

2.8.5.  Install the Web Server
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Uninstall IIS on the Web Server if Configured Incorrectly
In some cases IIS may already be installed on the Web Server, but configured incorrectly. For example,
your hosting company may have set up IIS for you. In this case, IIS needs to be uninstalled. After which
it can be installed again and configured correctly.

The procedure below describes how to uninstall IIS 7.

1. Start the Server Manager.
2. Navigate to the Roles section using the navigation tree.
3. Click Remove Roles.
4. The Remove Roles Wizard is started, use this to remove the IIS role. Removing roles and services

from the server can take a couple of minutes.
5. You may get prompted to restart your server. If so please do this.

Install IIS on the Web Server
If IIS is not installed on your Web Server, you need to install it. The procedure below explains how to IIS
8 on Windows Server 2012.

Note:  From WebCenter 18.1 installation, IIS can also be installed with a script provided in the
Installation disk.

1. Open the Server Manager.
2. IIS 8: In the Select installation type screen, select Role-based or feature-based installation.
3. IIS 8: In the Select destination server screen, select the appropriate server (local is selected by

default) and click Next.
4. In the Select server roles screen, select Web Server (IIS).

If the wizard prompts you to add features required for the Web Server, do so.
5. IIS 8: In the Select features screen, you do not need to add any additional features. Click Next.
6. IIS 8: Click Next in the subsequent Web Server Role (IIS) screen as well.
7. In the Select role services screen:

a) Enable ASP, ISAPI Extensions and ISAPI Filters in the Application Development section.

If the wizard prompts you to add role services required for ASP, do so.
b) In Health and Diagnostics, enable HTTP Logging, Logging Tools, Request Monitor and Tracing.
c) In Management Tools, enable IIS Management Tools and IIS 6 Management Compatibility, IIS 6

Metabase Compatibility, IIS 6 Scripting Toolsand IIS 6 WMI Compatibility
d) In Common HTTP features, make sure Default Document, Directory Browsing, HTTP Errors and

Static Content are enabled.
e) In Security, make sure Request filtering is enabled.
f) In Performance make sure to enable Dynamic and Static Content Compression.

8. In the Confirm installation selections screen, check the settings and click Install.

This installs the IIS 8 Role with the settings you have selected and the default settings.

The Installation Results screen should show Installation succeeded.
9. Click Close to exit the wizard and restart the server if prompted.
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Extend the Upload Limitation
IIS 7 has a limitation on how much you can upload at once (30 MB). You can change it to 2GB by
following these steps:

1. Open IIS Manager.
2. Select the website for which you want enable large file uploads.
3. In the main window, double click Request filtering.
4. Once the window is opened you may see a list of tabs (file name extensions, rules, hidden

segments…).
Regardless of the tab you select, right-click in the main window and select Edit Feature Settings.

5. Modify the Maximum allowed content length (bytes): change the value to 2000000000 (a 2 and 9
zeros) to be able to upload files close to 2GB.

Disable 32 Bit Applications

Note:  Only do this if you previously had WebCenter 10.x or 12.x installed on the same system.
Previously, 32 Bit Applications needed to be enabled. Now however, this settings needs to be disabled.

1. In IIS, go to Application Pools and select the DefaultAppPool.
2. Click Advanced Settings..., then set the Enable 32 Bit Applications option to False and click OK.
3. Click Recycle... at right.

Install the WebCenter Web Server
The Web Server components of WebCenter can be installed from a link on the WebCenter installation
media.

1. Log on to the Web Server as a member of the local Administrators group.
2. Ensure that Internet Information Services (IIS) has already been loaded by verifying that the

Internet Information Services applet is in Administrative Tools in the Control Panel.

Note:  If it has not been loaded, you must load it through Add/Remove Windows Components in
Add/Remove Programs in the Control Panel.

3. Insert the WebCenter media into the media drive, and click Software Installation on the menu that
appears at left, then Install WebCenter 21.03.

4. The setup wizard opens with a Welcome screen. Click Next.
5. In the License Agreement screen, read the agreement, and if you agree to it, select I accept the

terms in the license agreement and click Next.
6. In the Custom Setup screen:

a) Click the icon next to WebServer, and select This feature, and all subfeatures, will be installed
on local hard drive.

b) Click the icon next to Application Server and select This feature will not be available.
c) If desired, click Change to change the installation folder.
d) Click Next.

7. In the Option Selection screen:
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a) Enter the name of the Application Server.

This should be a different machine than the one currently running the installation.

Note:

You cannot configureWebCenter with IP addresses. If the web server is not able to find the
application server via name resolution, you can map the IP address of the application server
and the hostname of the application server in the C:\Windows\System32\drivers\etc
\hosts file. For example: 10.31.140.69 myappserver.

• Read also: https://wiki.esko.com/pages/viewpage.action?pageId=76730042.

• Configuring to use NAT translation on page 1104.

b) If you want to install WebCenter using an already-existing IIS website (rather than the Default
Web Site), select it in the list.

c) Click Next.
8. Click Install.
9. The Esko Station Information Service may be installed if this is the first Esko software being

loaded on the machine.

If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.

10. Click Finish when the installation completes.
11. Reboot the machine if prompted.

Start the WebCenter Services
After installing WebCenter, you need to start its services using the Services applet in the Windows
Administrative Tools.

Start the WebCenter Services on the Application Server

1. Log on to the Application Server as a member of the local Administrators group.
2. Click Start > Settings > Control Panel > Administrative Tools > Services.
3. Select the WebCenter JBOSS Application Server and click Action > Start.
4. If not started yet, select the WebCenter Application Monitor service and click Action > Start.
5. Select the WebCenter CAD-X Server and click Action > Start.
6. If you want to change the services to start automatically when the machine reboots, do so now:

a) Right-click a WebCenter service and choose Properties.
b) In the General tab, choose Automatic in the Startup type list.
c) Click OK.
d) Repeat for each service that has to start automatically.

7. Close the Services tool and log off.

Start the WebCenter Services on the Web Server

1. Log on to the Web Server as a member of the local Administrators group.
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2. Click Start > Settings > Control Panel > Administrative Tools > Services.
3. Start the Tomcat service:

a) Right-click Tomcat Web Server and choose Properties.
b) In the General tab, choose Automatic in the Startup type list.

This makes the service start automatically when the machine reboots.
c) Click OK to close the Properties dialog.
d) Select the Tomcat Web Server and click Action > Start.

4. If not started yet, select the WebCenter Application Monitor service and click Action > Start.
5. Close the Services tool and log off.

Easily Identify when WebCenter is Ready to Access

WebCenter services loads a lot of data into memory during startup of its services. It is important to
watch the CPU activity before accessing a WebCenter site.

You want both the Web Server and the Application Server to have a CPU activity of under 5% before
accessing the site, otherwise all components may not have started and you may experience error
messages. Another way is to check whether wcr_jboss_srv.exe threads exceed 160 and
wcr_tomcat_srv.exe threads exceed 100.

To help watch the CPU activity easily, add the CPU performance monitor to the system tray of each
WebCenter server. To do this (on both the Web Server and the Application Server):

1. Create a new shortcut in theStart Menu > Programs > Startup folder.
2. Browse to Windows\system32\TASKMGR.EXE.
3. Set the shortcut to Run "Minimized".

2.8.6.  Install the On-Board Graphics Engine (OBGE) on the Application Server

The Automation Engine On-Board Graphics Engine or OBGE is required for WebCenter systems to
generate view data.

How to Perform the Automation Engine 21.03 System Readiness Check
Before you install the OBGE, a System Readiness Check is required. This checks whether the operating
system is suited for installing and running this Esko product.

1. On the DVD, in the section Software installation, click the type of installation that fits your purpose
(as explained in Types of Installations).

2. In the section Installation, under Instructions, click Run the Automation Engine Readiness Check.
3. At the end of the Readiness Check, read the resulting messages carefully.
4. If the Readiness Check resulted in any problem, correct it before proceeding.
5. Click Exit.

How to Install the Prerequisite Components
Depending on the products to be installed on this particular system, various components are required
for installation. The installation wizard for these prerequisite components checks the licenses, lists the
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prerequisite components to install, requests confirmation for installation and then installs the required
components.

The installation wizard installs the following components:

• Microsoft Visual Studio Redistributables

• Database Engine for the Automation Engine components (if you choose a Standard Automation
Engine Installation)

Follow these steps:

1. On the DVD, in the section installation, click Install the Prerequisites Components.
2. Follow the instructions of the installation wizard.
3. When you choose a Standard installation, when asked to enter a password for the SQL Server, click

Use Default to use the default sa password. Or you can enter a Password, confirm it and click Use
Password to use a different password, for example because of "Strong Password" requirements.

You can know more about Installation of Automation Engine in this KB article

Note:  During the pre-installation of the Database Engine for Automation Engine, the
Microsoft .NET Framework 4.6.1 will be installed. You may get a warning saying that the system
needs to be rebooted, followed by a fatal error "The SQL Server instance is not installed". If this
happens, reboot your server and install the prerequisites again.

4. Depending on your activated licenses, the Automation Engine Prerequisite Components
Installation process may ask you separately about the CAD-X component installation for both the
Standard Edition component and the Enterprise Edition component. If the Automation Engine is
installed on the Application server, Click No.

5. Click Exit.
You will be redirected to the installation page to continue with the next step.

How to Install Automation Engine 21.03
1. After running the System Readiness Check and installing the License Server Components, when

all prerequisites are fulfilled, you can start the installation.
2. Click the Install Automation Engine 21.03 link on the installation page.

The Automation Engine 21.03 Software Installation wizard will open up.
3. Follow the instructions of the installation wizard.
4. Read the Software and Data license agreement carefully and select Yes, I accept the license

agreement.
5. When asked to select the products to install on this system, select Automation Engine 21.03.

The group Common Components cannot be deselected and will be installed on all systems.
6. Select the Destination Folder for the chosen products or accept the defaults.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.

The pre-installation task checks the password complexity rules and domain policies. If the default
password for the BGSYSTEM user does not fulfill the requirements, a pop-up dialog requests a
password. During installation, only a BGSYSTEM user is created. This user will be used as Automation
Engine System Account (you can choose to change it later using the Server Config tool on the AE server
itself). A clean installation ends with two empty local user groups: BGUSERS and BGADMIN. Add the
BGSYSTEM user to the BGADMIN local user group.
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Note:  Learn more about Users and Groups in the separate chapter Pre-Install IT Requirements.

After installation of Automation Engine, a shortcut named "Automation Engine Client Apps" is put on
the desktop of the server computer.

Double-click this shortcut to open the Automation Engine Client Apps web page in your default
browser.

This page describes the two types of client applications:

• Desktop client applications (Pilot or Shuttle): These need to be installed on each workstation from
where you want to use Automation Engine.

• Browser based client applications: These run inside a browser and do not need to be installed. You
may want to bookmark some specific pages.

2.9.  Testing WebCenter

On the Application Server and the Web Server, ensure IIS and the WebCenter services are started and
configured to start automatically.

After starting/restarting the WebCenter services, always wait a few moments until the CPU processor
activity on both servers become idle (<5%) before attempting to access the login page.

Testing each facet of WebCenter in the exact order below helps to easily and quickly identify points of
failure, if any.

• IIS Connectivity – use IIS Manager to access the WebCenter_Inst site
• IIS Security settings – can access the home page after logging in
• Database connection and Schema – can add a new record to the database
• FileStore connectivity – can write a file to the FileStore and then retrieve it
• View Data generation – can upload a graphic file and the OBGE does its job
• View and Annotate applet – can launch the applet successfully on a Graphic file
• View the status in the Trouble shooting tool for View Server Deployment Status

2.10.  Configuring WebCenter

2.10.1.  Configure the OBGE

The Pilot lets you configure the Automation Engine On-Board Graphics Engine (OBGE) for use with
WebCenter.

You must create a container and a hotfolder pointing to the WebCenter FileStore.

Create a Container
1. Log on to the Application Server as a member of the local Administrators group.
2. Double-click the Pilot icon on the desktop.
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3. In the Logon Information dialog, enter BGSYSTEM as the User Name and the enter the same
password that is set for the BGSYTEM in WebCenter. Type the name of the Application Server in
Server Name. Click OK.

This opens the Pilot. User creation in Automation Engine is done by following steps provided here.
4. Go to Tools > Containers to open the Containers window.

 

 
To more about Containers in Automation Engine, you can read here.

5. In that window, go to File > New or click .

This opens the Create Container Wizard.
6. In the Welcome screen, click Next.
7. In the Location of the Job Container screen, select Existing Shared Folder and click Next.
8. In the Location of the Network Folder screen, type the name of the Application Server in the

Computer Name field and click Next.
9. In the Select the shared folder screen, select the FileStore share and click Next.
10. Click Finish and close the Containers window.

Create a JDF Hot Folder (Access Point) for WebCenter
1. Choose Tools > Access Points from the Pilot main menu.
2. Click the Create a new Access Point button.
3. Choose type Folder and click OK.
4. Enter a Name.
5. In the Folder Settings tab, specifiy the hotin folder. This should look like: file://myserver/FileStore/

JDFHotfolder/hotin.
6. In the Monitoring tab, set Check every...minutes to a low number preferably, the recommended

setting is 1.
7. In the Automatic Actions tab, fill in the hotout folder in the Move File to and Output Folder fields.

This should look like: file://myserver/FileStore/JDFHotfolder/hotout. Make sure Action is set to
Process JDF.

8. Click OK.
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The Hot Folder/Access Point now appears in the Pilot and is ready for use.

2.10.2.  Configuring the E-Mail Notifications

Use the E-Mail Notifications page to configure the e-mail environment for the notifications framework.
Only WebCenter Administrators can access this page.

Configure E-Mail Notification
While logged in to the WebCenter web interface as an administrator:

1. Go to Admin > Configuration > E-Mail Environment Setup.
2. Set up your e-mail environment:

Setting Description

E-Mail Service Protocol WebCenter only supports the SMTP protocol.

E-Mail functionality
enabled

To enable/disable e-mail functionality.

E-Mail debugging output
in log

To enable/disable e-mail debugging output in log files.

E-Mail Service Host The address for the preferred mail server that will act as the
server for dispatching WebCenter e-mail notifications (this
server has to comply to the selected protocol type (see above)).

E-Mail Service Port
Number

The port number on which the defined mail server is listening for
incoming e-mails.

Outgoing E-Mail
Notifications' "FROM"
Address

Supply a valid e-mail address. This will be used in the "From" e-
mail header for every e-mail sent by WebCenter.

Use TLSv1.2 Select this option to use TLSv1.2 when you are trying to connect
over SSL to the SMTP server. WebCenter uses the STARTTLS
protocol command to indicate that, it can upgrade the insecure
connection to TLSv1.2. To ensure that TLSv1.2 is used during the
connection, the SMTP server should be configured to prevent
insecure connections.

Note:  This however does mean that if the smtp server doesn’t
support TLSv1.2, the insecure connection will be used instead.

E-Mail Session
Authentication

Select this option if the mail server connection requires
authentication with a user name and password.
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Setting Description

E-Mail Service
Username

Provide the mail account user name if authentication is required.

E-Mail Service Password Provide the mail account password if authentication is required.

Note:  This password is stored in an encrypted form.

3. Click Send Testing E-mail.

The Test E-Mail Environment Settings page appears.

 

 
4. Type a Recipient address and click Send E-mail.

WebCenter attempts to send an e-mail to the recipient.

The E-Mail Configuration page appears, displaying a message depending on the result of the test:

• Test E-Mail Sent: The environment is set up correctly.

• JMS System Error: Communication with the JBoss' proprietary messaging framework failed.

An administrator should check the JBoss server configuration and/or log files for possible
causes.

• Mail Server Connection Error: The connection to the specified mail server did not succeed.

Either the data the administrator supplied on the e-mail environment setup page was incorrect,
or the mail server is currently down.

An administrator should either check the e-mail environment settings for possible misspellings
or contact the mail provider as to the status of the mail server.
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Note:  The settings you defined are saved in the database. For updates from older WebCenter
installations, the email setup is first loaded from the old emailconfig.xml file and the settings
are subsequently stored in the database.

2.10.3.  Configure WebCenter for Use with ArtiosCAD Enterprise

Configuring BLOBs
ArtiosCAD Enterprise supports the use of BLOBs in the database. BLOBs are Binary Large OBjects -
files stored as data in the database. Using BLOBs is transparent for the user.

When you configure ArtiosCAD Enterprise to use BLOBs, it also stores managed documents in the
WebCenter FileStore as a cache to improve performance. If you delete a file from the FileStore, the
next time you save it in ArtiosCAD Enterprise, it will be recreated in the FileStore from the BLOB.

Note:

You should decide if you want to use BLOBs when you install WebCenter. Switching to using BLOBs
after having used ArtiosCAD Enterprise is not recommended or supported.

Editing appconfig.xml on the Application Server
To enable BLOBs, you must change a line in a configuration file on the Application Server. On the
Application Server:

1. Log in as Administrator or as a user with administrative privileges.
2. Make a backup copy of C:\Artios\WebCenter\config\appconfig.xml. This file will be on

the C: drive no matter where you installed WebCenter.
3. Open the file named in the previous step in a text editor such as Notepad.
4. Scroll down to <store_files_in_blob value="false"/> and change false to true.

5. Save the file and exit the text editor.

Restarting Services
Once you have changed appconfig.xml on the Application Server, restart all the Application
Server’s WebCenter services to start using BLOBs in ArtiosCAD Enterprise.

1. On the Application Server, still logged in as Administrator or as a member of the local
Administrators group, open the Services applet in the Administrative Tools group in Control Panel.

2. Restart the following services by clicking each one and then clicking the Restart link:
a) WebCenter JBOSS Application Server
b) WebCenter CAD-X

3. Close the Services applet and log off the Application server.

ArtiosCAD Enterprise is now configured to use BLOBs. Note that WebCenter will keep copies of
managed documents in its FileStore to improve performance.

47



2 WebCenter

Step 2 - Optionally Uploading Boards
In case the boards were not installed yet, follow this procedure after logging in to WebCenter for the
first time:

1. Log in on the Web server as a member of the local Administrators group.
2. Run the setup program with WebCenter DVD.
3. Click Upload Boards.
4. In the Log In To Web Browser dialog box, enter the address of the WebCenter server, an admin

user's username, and that user's password. Click OK.
5. An Upload Boards progress bar will appear.
6. Click Close when the upload finishes.

Step 3 - Creating Shared Defaults for the First Time
The next step is to run the ArtiosCAD Defaults Manager installed when you installed ArtiosCAD
Enterprise on the Application server. The first time you install ArtiosCAD Enterprise 16 or later, you
have to create the Shared Defaults. You can choose to either create completely new Shared Defaults,
or you can choose to migrate older Defaults that are merged with the defaults for the version you are
installing. In the future, you will add a new version's Defaults to the existing Shared Defaults Project.

You may also use this utility to migrate location and user defaults from older versions of ArtiosCAD
Enterprise to newer versions of ArtiosCAD Enterprise.

Note:

Even if you do not plan to use WebCenter in combination with ArtiosCAD Enterprise, it is still necessary
to install the Defaults in order for WebCenter to be able to process CAD files properly. Therefore, it is
highly recommended to install the Defaults, even if you do not plan to use CAD files initially.

Note:

The system you use for loading the Defaults must be able to keep the Defaults on it. You will have
to follow the same process to load future Defaults and the new installation will reference the older
version’s Defaults as part of its installation. We recommend using the Application Server for this
process.

Note:

This procedure takes a significant amount of time. We recommend starting it and doing other things
until it completes.

1. Log in to the Application Server as a member of the local Administrators group.
2. Click Start > All Programs > Esko > ArtiosCAD > Defaults Management to start the Defaults

Manager.
3. In the Login to Web Browser dialog box, enter your WebCenter server URL, admin username, admin

password, and click OK.
4. Click Create new shared defaults.
5. A progress bar appears. This step will take a few minutes.
6. Click Close when the installation process is done.
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Configuration in the WebCenter User Interface

Note:  See the WebCenter Administration Guide for more details about the following steps.

1. Log on to WebCenter with the admin account (see Log On to WebCenter and Change the Admin
Password).

2. Configure a Company and Location for the initial ArtiosCAD Enterprise users.
3. Create a custom group, if desired, for the initial ArtiosCAD Enterprise users.
4. Create the initial ArtiosCAD Enterprise users. While creating them:

a) Make sure they are at least Project Managers with Limited Visibility of Companies and Groups.
b) Assign them to the Company and Location you created.
c) Assign them to one or more groups.

Even if you did not create any custom group, you should assign them to the USERS group.
5. Invite them to the System Defaults Project (which is Shared Defaults in ArtiosCAD Enterprise).

Tip:  You can do this either individually for every user or once through Group membership if you
added all users to the same group (such as USERS).

Inviting them to the Project means that they will be able to use the Defaults.

In order for users to change Shared Defaults, they must have Full permissions on the Project and be
members of the ADMINS group.

Note:  All ArtiosCAD Enterprise users must be invited to the System Defaults Project. Users who
are not invited to the project will receive a UFANEX error when they launch ArtiosCAD Enterprise.

2.10.4.  Secure your WebCenter Site with SSL

SSL is a protocol for securing communication over the Internet. It works by using a private key to
encrypt data that is transferred over an SSL connection.

URLs using an SSL connection start with https:// instead of http://.

To use SSL, you are required to obtain an SSL certificate and install it into Internet Information
Services (IIS) on the Web Server.

Note:  We strongly recommend you secure your WebCenter site with SSL, especially if you plan to use
WebCenter over the internet (not only within a Local Area Network).

Secure the WebCenter Web Server with SSL
You will need to:

1. Create a Certificate Signing Request (CSR) on page 50.
2. Request an SSL Certificate from a Certificate Authority on page 50.
3. Install the Intermediate SSL Certificate on page 51.
4. Install your Signed Certificate on page 52.
5. Export your Certificate if Necessary on page 52.
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You only need to do this if you haven't installed the certificates directly on your Web Server.
6. Bind your Certificate to your WebCenter Site on page 53.
7. Redirect HTTP Trac to HTTPS on page 54.

Create a Certificate Signing Request (CSR)
To get an SSL certificate, you need to first create a Certificate Signing Request, that you will send to a
Certificate Authority.

1. On the Web Server, click Start, then Administrative Tools, then Internet Information Services (IIS)
Manager.

2. In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
3. In the dialog's central pane, double-click the Server Certificates icon in the Security section.
4. In the Actions pane at right, click Create Certificate Request...

This opens the Request Certificate wizard.
5. In the Distinguished Name Properties screen, enter your information as follows:

• Common Name: the name through which the certificate will be accessed (usually the fully-
qualified domain name, for example www.domain.com).

• Organization: the legally registered name of your organization/company.

• Organizational unit: the name of your department within the organization.

• City/locality: the city in which your organization is located.

• State/province: the state in which your organization is located.

• Country/region: the two-lettered ISO-3166 country code of the country in which your
organization is located. You can find a list of valid country codes on http://www.ssl.com/csrs/
country_codes.

Click Next.
6. In the Cryptographic Service Provider Properties screen:

• leave Cryptographic Service Provider to Microsoft RSA SChannel Cryptographic Provider,

• in Bit length, select 2048 or higher.

Click Next.
7. In the File Name screen, enter a name for your Certificate Signing Request, and select a location in

which to save it.

Click Finish.

Request an SSL Certificate from a Certificate Authority
The customer is responsible for choosing the SSL provider (Certificate Authority), obtaining
certificates, as well as following that company's specific instructions for installation and configuration.

Esko cannot obtain SSL certificates on behalf of its customers.

1. Send your Certificate Signing Request file to a public Certificate Authority.
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Note:

• If you do an Internet Search for “SSL certificate”, you will find many providers with different
pricing and options. We have good experiences with VeriSign, Network Solutions, Godaddy.com,
and Thawte.

• The application process can take up to 30 days… Start the application process well in advance!

• If your company has a DNB (Dun & Bradstreet) number, the application process will be a lot
easier and quicker if you can provide it.

• Your certificate will be linked to your website (for example webcenter.domain.com).
Changing your website name will require a new certificate.

2. The Certificate Authority will provide you with:

• an intermediate certificate, verified by the root certificate installed by default on your Web
Server (where you created the Certificate Signing Request),

Note:  You may need to download this from a web link.

• your server certificate, verified by that intermediate certificate (signed by the Certificate
Authority).

Make sure you have both certificates before going further! You will need to install both of them on
your Web Server.

3. Copy those certificates to your Web Server.

Install the Intermediate SSL Certificate
You need to install the intermediate certificate before you install your signed certificate.

1. On your Web Server, click Start, then Run...
2. Type mmc and press Enter.
3. In the Microsoft Management Console (Console1) window that opens, go to File > Add/Remove

Snap-in...
4. In the Add or Remove Snap-ins dialog, select Certificates, and click Add.
5. In the Certificates snap-in dialog, select Computer Account, and click Next.
6. In the Select Computer screen, select Local Computer, then click Finish.
7. Click OK in the Add or Remove Snap-ins dialog.
8. In the Console1 window:

a) expand the Certificates (Local Computer) folder,
b) right-click Intermediate Certification Authorities, and go to All Tasks > Import...

9. In the Certificate Import Wizard dialog:
a) click Next to get to the File to Import screen,
b) browse to the location containing your intermediate certificate file,
c) in the Open dialog, change the file extension filter to PKCS #7 Certificates (*.spc;*.p7b),
d) select your *_iis_intermediates.p7b file, and click Open.
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Note:  Only install your intermediate certificate, not your signed certificate in this area!
Installing your signed certificate here would remove your intermediate certificate from the list,
and you would need to reinstall it.

e) Click Next.
10. In the Certificate Store screen:

a) select Place all certificates in the following store,
b) click Browse, select Intermediate Certification Authorities in the Select Certificate Store pop-

up, and click OK,
c) click Next.

11. Click:
a) Finish in the Certificate Import Wizard dialog,
b) OK in the Certificate Import Wizard pop-up stating that the import was successful.

12. Close the Console1 window, then click No in the pop-up asking to save the console settings.

Install your Signed Certificate
Once your intermediate certificate is installed, install your signed certificate:

1. On the Web Server, extract your *.cer certificate file from the zip file you got from the Certificate
Authority.

2. Click Start, then Administrative Tools, then Internet Information Services (IIS) Manager.
3. In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
4. In the dialog's central pane, double-click the Server Certificates icon in the Security section.
5. In the Actions pane at right, click Complete Certificate Request...

This opens the Complete Certificate Request wizard.
6. In the Specify Certificate Authority Response screen:

a) browse to your *.cer certificate file,
b) enter a Friendly name for your certificate.

This will be used by the server administrator to easily distinguish the certificate.
c) Click OK.

Your certificate is now installed. If you cannot see it yet in the Server Certificates list of the Internet
Information Services (IIS) Manager dialog, press F5 to refresh.

Export your Certificate if Necessary
We recommend you create the Certificate Signing Request and install the certificates directly on your
WebCenter Web Server.

However, if you do this on another server, you can export the signed certificate then import it on your
Web Server.

1. If you haven't done so already, install the intermediate certificate on your Web Server.
2. Export your signed certificate from the server it is installed on:

a) In Internet Information Services (IIS) Manager, select your certificate in the Server Certificates
list and click Export... in the Actions pane at right.

b) In the Export Certificate dialog that opens:
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1. Type a file name in Export to, or click the browse button to navigate to a file in which to store
the certificate for exporting.

2. Type a Password if you want to associate a password with the exported certificate.
3. Retype the password in Confirm password and click OK.

This exports your certificate to a .pfx file.
3. Import your signed certificate on your Web Server:

a) Click Start, then Administrative Tools, then Internet Information Services (IIS) Manager.
b) In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
c) In the dialog's central pane, double-click the Server Certificates icon in the Security section.
d) In the Actions pane at right, click Import...
e) In the Import Certificate dialog that opens:

1. browse to your Certificate file (.pfx),
2. enter the Password associated with your certificate if there is one,
3. make sure that Allow this certificate to be exported is selected.

Note:  This is important, as due to a bug in IIS, the site binding will not work if the certificate
is not exportable.

4. Click OK.

Your certificate is now installed on your Web Server. If you cannot see it yet in the Server Certificates
list of the Internet Information Services (IIS) Manager dialog, press F5 to refresh.

Bind your Certificate to your WebCenter Site
Once you have installed your certificate on your Web Server, you need to bind it to your WebCenter site,
so that the certificate will be used to authenticate your WebCenter site when users browse to it.

1. Still in the Internet Information Services (IIS) Manager, right-click the Default Web Site node in the
Connections pane, (or the node of the IIS website you have deployed your Web Server on if it's not
the default website) and select Edit Bindings...

2. In the Site Bindings dialog that opens, click Add.
3. In the Add Site Binding pop-up:

a) Choose https as Type.
b) Leave the default https Port (443).
c) In the SSL Certificate list, select your Web Server.
d) Click OK and then OK again.
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Redirect HTTP Trac to HTTPS
To ensure security, end users should only use https:// to access your WebCenter site. If someone
accidentally uses http:// instead, they will not be using a secure connection.

To avoid this, you can make sure http:// trac to your WebCenter site is automatically redirected to
https://. This will be transparent for the users (they will not get an error page but will simply be able
to access your site through https://).

For this, you need to download a (free) extension for IIS.

1. On your Web Server, download and install the URL Rewrite extension for IIS.

Go to http://www.iis.net/downloads/microsoft/url-rewrite, click the Install this extension button
and follow the steps on screen.

2. In the Internet Information Services (IIS) Manager, make sure SSL is not required so users don't get
an error when connecting to your site using http://:
a) Select the Default Web Site node in the Connections pane, (or the node of the IIS website you

have deployed your Web Server on if it's not the default website).
b) Double-click SSL Settings in the center pane.
c) Under SSL Settings, make sure that Require SSL is not selected.

3. Click Default Web Site or the node of your IIS website again, then double-click URL Rewrite in the
center pane.

4. Create a blank inbound rule:
a) Click Add Rule(s)... in the Actions pane at right.
b) In the Add Rule(s) pop-up, click Blank rule under Inbound rules, then click OK.

The center pane now shows the Edit Inbound Rule form.
5. Edit the rule as follows to perform the automatic redirection:

a) Enter a Name for the rule, for example HTTP to HTTPS redirect.
b) Under Match URL, fill in the settings as follows:

Requested URL Matches the Pattern

Using Regular Expressions

Pattern (.*)

Ignore case on

c) Under Conditions, select Match All in Logical grouping.
d) Add the first condition:

1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:

Condition input {HTTPS}

Check if input string Matches the Pattern

54

http://www.iis.net/downloads/microsoft/url-rewrite


2WebCenter

Pattern off

Ignore case on

This ignores addresses starting with https:// (they don't need to be redirected).
3. Click OK.

e) Add the second condition:

1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:

Condition input {SERVER_ADDR}

Check if input string Does Not Match the Pattern

Pattern ::1

Ignore case on

This ignores addresses using localhost through IPV6 (::1), as forcing https:// for those
would give a certificate error as the one below (because the certificate is linked to your site
name and not the server's IPV6 address).
 

 
3. Click OK.

f) Add the third condition:

1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:

Condition input {SERVER_ADDR}

Check if input string Does Not Match the Pattern

Pattern 127.0.0.1
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Ignore case on

This ignores addresses using localhost through IPV4 (127.0.0.1), as forcing https:// for
those would give a certificate error (because the certificate is linked to your site name and
not the server's IPV4 address).

3. Click OK.
g) Under Action, fill in the settings as follows:

Action type Redirect

Redirect URL https://website-name.com/
{R:1}

where website-name.com is the
name of your WebCenter site, to which
you have linked your certificate

Append query string on

Redirect type Found (302)

Your rule should look like this:
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h) Click Apply in the Actions pane at right.

You should now see your rule in the URL Rewrite list in the center pane.
6. Browse to your WebCenter site using http:// and check that it is redirected to a https://

connection.
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Install SSL Certificates on the Workflow Production Server
If...

• you are planning to integrate your Automation Engine server with WebCenter,

• your WebCenter site is secure (it demands https:// connections),

• your Automation Engine server and your WebCenter are not located within the same Local Area
Network,

... you need to make sure your Automation Engine server can communicate with your WebCenter
server over https://.

Important:

If you have installed your certificates properly on the Web Server (the intermediate certificate and the
signed server certificate), this should work without you having to do anything.

If you haven't, or you are still experiencing connection problems, you should import the WebCenter
certificates into the Automation Engine keystore.

This can also apply when WebCenter and Automation Engine are in the same LAN, if https://
communication is also enforced inside the LAN. Check with your network administrator if this is the
case.

Export the Certificates from the WebCenter Site

1. Log on to the Automation Engine server as a local administrator.
2. Open a web browser and navigate to the secured WebCenter site.
3. Examine the WebCenter site’s certificates.

How you do this depends on the web browser you use:

a) Click the lock icon at the end of the address bar and click View certificates in the pop-up.
 

 
b) In the Certificate dialog, click the Certification Path tab.

This tab displays the certificate hierarchy. Each top-level entry in the hierarchy represents a
certificate.
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4. Export all the certificates (top-level entries) in the hierarchy:

a) Highlight the first certificate in the hierarchy (for example, Thawte Server CA (SHA1)).
b) Click View Certificate.
c) Click the Details tab.
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d) Click Copy to File to begin the Export Wizard. Click Next.
e) Select DER encoded binary… (.CER) and click Next.

 

 
f) Click Browse or type in a valid path and name the certificate (*.cer). We recommend using a

short path and name (such as c:\temp\vali.cer). Click Next.
g) Click Finish, then OK and once more OK.
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h) Repeat these steps until you have exported all the certificates. Close the web browser when you
are finished.

Import the Certificates into the Workflow Server Keystore
While still logged on to the Automation Engine server as a local administrator, import the certificate
files into the Automation Engine keystore:

1. Open a DOS command prompt.
2. Change to the Esko Automation Engine software directory which contains the keytool utility: c:

\esko\bg_prog_fastservercltnt_v210\jre\bin

For ESKO Software platform , this will typically be c:\esko\bg_prog_fastservercltnt_v210\jre\bin
3. Run the import utility for each certificate downloaded, in the proper order: keytool

–importcert –file <path>\*.cer –alias <aliasname> -keystore
<keystore_path>.

Your <keystore_path> is the path to bg_prog_fastserver_vxxx\jre\lib\security
\cacerts. For example: c:\esko\bg_prog_fastserver_v210\jre\lib\security
\cacerts.

You will be prompted for a password. The password is: changeit (case sensitive).
4. You might be asked to trust the certificate. Enter Y for Yes.

It is also possible that the tool tells you that this certificate is already installed. If so, that’s ok, go on
with the next certificate.

You should get a successful message like Certificate was added to keystore.
5. Repeat for each certificate to import in the hierarchy.
6. Reboot the Automation Engine computer to ensure that the changes take effect.

Example

You are running Automation Engine 21.03 and the Automation Engine server software is installed on
E:\Esko.

You have downloaded two certificates from the WebCenter site in the folder c:\temp:
valicert.cer and starfield.cer.

valicert.cer was first in the hierarchy, so you would import this first, then repeat for
starfield.cer.

You would proceed as follows:

1. Using a command prompt, go to e:\esko\bg_prog_fastserver_v140\jre\bin.
2. Type Keytool –importcert –file c:\temp\valicert.cer –alias valicert –

keystore e:\esko\bg_prog_fastserver_v210\jre\lib\security\cacerts

3. If asked for the password, type changeit.
4. If asked to trust the certificate, type Y.
5. Repeat the same command for the next certificate, startfield.cer.
6. Reboot the Automation Engine computer to ensure that the changes take effect.
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Import the Certificates into the Workflow Client Keystore
With a secured WebCenter site (requiring https://), you cannot check the connection between
Automation Engine and WebCenter with the Check Connection button in Configure.

To be able to do this, you need to install the Web Server certificates in the Automation Engine client
keystore too (even if the client is running on the same machine as the Automation Engine server).

Tip:

You should also do this if publishing fails because Automation Engine doesn't have the appropriate
certificates. Typically, this gives an error message like the one below:

javax.net.ssl.SSLHandshakeException: sun.security.validator.ValidatorException: PKIX path
 building failed: sun.security.provider.certpath.SunCertPathBuilderException: unable to
 find valid certification path to requested target

1. While logged on to the Automation Engine client machine as a local administrator, open a DOS
command prompt.

2. Change to the Esko Automation Engine software directory which contains the keytool utility:
\bg_prog_fastservercltnt_vxxx\jre\bin

For ESKO Software platform, this will typically be c:\esko
\bg_prog_fastservercltnt_v210\jre\bin

Note:  For the client, make sure to use bg_prog_fastservercltnt and not
bg_prog_fastserver as for the server!

3. Run the import utility for each certificate downloaded, in the proper order: keytool
–importcert –file <path>\*.cer –alias <aliasname> -keystore
<keystore_path>.

Your <keystore_path> is the path to bg_prog_fastservercltnt_vxxx\jre\lib\security
\cacerts. For example: c:\esko\bg_prog_fastservercltnt_v210\jre\lib
\security\cacerts.

You will be prompted for a password. The password is: changeit (case sensitive).
4. You might be asked to trust the certificate. Enter Y for Yes.

It is also possible that the tool tells you that this certificate is already installed. If so, that’s ok, go on
with the next certificate.

You should get a successful message like Certificate was added to keystore.
5. Repeat for each certificate to import in the hierarchy.
6. Reboot the Automation Engine computer to ensure that the changes take effect.

2.10.5.  Install Certificates for LDAPS on the Application Server

To connect your WebCenter installation to a secure LDAP server (LDAPS), you have to install a
certificate obtained from that LDAPS server.

1. Open a command prompt on the WebCenter Application Server.
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2. Change directory to the location of \WebCenter\ApplicationServer\LDAP
\CertInstall.bat.

3. Issue the following command: CertInstall servername:port, where servername is the name or IP of
the LDAP server and port is the port used for secure connection (typically 636).
 

 
4. To make changes active ensure that you restart JBoss, if JBoss was running.

If successful, a list of certificates sent by the server is displayed (ignore any additional messages).

 

 
5. To install a given certificate, enter its number in the list and press Enter.

We suggest that you install all certificates. Only one certificate can be installed each time you run
CertInstall so it can be necessary to run it multiple times.
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Note:

Troubleshooting the certificate installation

The certificates should be properly installed. If not, try these troubleshooting tips:

• Server or port name is not correct

If the supplied parameters are wrong, the result can look something like the following:

 

 

In this case, contact your IT system administrator and verify the parameters supplied.

2.10.6.  Integrate WebCenter with a Workflow Production Server

You can configure WebCenter to integrate with your existing Automation Engine production server.
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In this documentation, we assume that you have both these applications installed and running properly.

Understanding WebCenter Integration
WebCenter can run without Automation Engine, but its full potential is realized when integrating both
systems.

Integrating WebCenter with an Automation Engine production server allows you to upload production
files to WebCenter for approval and advanced project management.

To make this collaboration between the systems possible, you must:

• Add the WebCenter site information in the Automation Engine Configure window.

• Configure the Job Web Page URLs in the Automation Engine Configure window.

• Set up the WebCenter View information for the Automation Engine users.

• Set up the Publish on WebCenter ticket.

Add the WebCenter Site Information

1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

2. Choose Tools > Configure.
3. In the Configure window, select WebCenter Sites in the left pane.
4. Click the + icon.

5. In the Website field of the Delivery area, enter the URL of the WebCenter site (for example:
http://wcrserver/WebCenter_Inst).

Note:  If your site uses secure HTTP, make sure to enter an HTTPS address.

6. Click Open... to test the connection. The login page for WebCenter should appear. If it doesn't,
check your settings.

7. If the Automation Engine server and the WebCenter Application Server are not on the same LAN,
deselect WebCenter and Automation Engine are in the same LAN.

If using Automation Engine 18.0.1, 18.0, or 16.1.1 to connect to WebCenter for outside-LAN approval
feedback, you need to install a hotfix on Automation Engine for this functionality to still work after
updating to WebCenter 18.1.

The hotfixes can be downloaded from mysoftware.esko.com:
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• Automation Engine 16.1.1: HF_201801047_20181212_AE-WCR_18_1
• Automation Engine 18.0: HF_201806059_20181212_AE-WCR_18_1
• Automation Engine 18.0.1: HF_201811018_20181212_AE-WCR_18_1

Older versions of Automation Engine are not ocially supported.

The User Name and Password fields then become available. This is where the Automation Engine
Approval Client configuration in WebCenter is used.

Create a user name and password combination in WebCenter, then enter that same (case-sensitive)
user name and password in the appropriate fields in Automation Engine Configure.

Click Check Connection to test the connection.

Important:  You must be using the Pilot on the Automation Engine server itself to run this check.

A dialog box appears, proving that the connection works and displaying the WebCenter version
number.

8. If the Connect to JDF Processor area is visible, leave JMF selected in it.
9. Click Check to test the connection.

An Info dialog appears, reporting that the connection is OK. Click OK.

If this dialog does not appear, check your settings.
10. On the left of the Configure window, scroll down and select the new WebCenter1 entry under

WebCenter Sites.
11. Click File > Rename and enter a descriptive name for your WebCenter site.
12. Click File > Save to save the settings.

Configure the Job Web Page URLs
The Job Web Page enables you to go to your WebCenter project from within your Automation Engine
Job.

1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

2. Choose Tools > Configure.
3. In the Configure window, select Jobs > Job Web Page in the left pane.
4. In the Address field, enter the URL of the WebCenter site (for example: http://pacwebserver/

WebCenter).
5. Still in the Address field, append this text to the end of the URL: /projdetails.jsp?

projectName=

Attention:  This is case-sensitive; enter it exactly as written. Do not include a space or
period at the end.

6. Click +[ ] InsertSmartNames.
7. In the SmartNames column, scroll down and click JobName.
8. Click Insert to append it to the URL in the Address field.
9. Click Close to return to the Configure window.
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The result should resemble http://pacwebserver/WebCenter/projdetails.jsp?
projectName=[JobName] with [JobName] in green.

10. Click File > Save to save the settings.

You can now right-click your Job folder in the Automation Engine Pilot and select Go to Job Web Page;
this opens the WebCenter project associated with your Job in a browser.

Set Up the Publish on WebCenter Ticket
The Publish on WebCenter ticket in Automation Engine creates output and uploads the resulting files
to WebCenter.

For more details, please see the Automation Engine documentation.

1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

2. Click the Tickets view.
3. Locate the Publish on WebCenter default ticket, right-click it and click Duplicate....
4. In the Save As pop-up that opens, replace the word Default in the Save As field with a meaningful

name (for example the name of your WebCenter site).
5. In the Scope area, select the Global option.

If you have no blue job folders containing files, you are not prompted to select the scope.
6. Click Save. The new ticket should appear in the list.
7. Double-click your new Publish on WebCenter ticket to change its settings.
8. On the Destination tab, define where you want to publish your file:

a) In the Site list, select your desired WebCenter site.
b) In the Project field, enter the JobName SmartName so that the files are published to the

WebCenter project corresponding to your Automation Engine job.

Note:

• The project does not have to exist in WebCenter at upload time. If the project does not exist,
it will be created. In this case, the person that does the upload from Automation Engine
needs to be Project Manager in WebCenter! Otherwise the upload will fail.

• If your main goal is not to upload files but to create WebCenter Projects through Automation
Engine, we recommend you use the Create or Modify WebCenter Project ticket instead (see
the Automation Engine documentation for more information).

c) Leave the Folder and Project Template fields blank unless you know the exact names of the
folder and project template you want to use for every new Project.

In this case, enter them as appropriate; all new WebCenter Projects created with this ticket will
use these values.
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Note:

• The Project Template field refers to a template in WebCenter, not Automation Engine.

• You can only use templates that are visible by the WebCenter user performing the upload
(see sub-step f).

d) Enter a Document Name if you want your published document to have a name different from the
input file name.

Note:  If the document already exists, the task will create a new version of that document. If it
exists but is in a different folder, the task will fail.

e) Enter a Document Description if desired; this description will be available in WebCenter as a
Version Comment.

f) Leave the User Name and Password fields blank unless there is a specific (and valid!)
WebCenter user who will own each document revision published using this ticket; in that case,
enter the appropriate information.

If you leave these fields blank, anyone using the ticket will have to supply a valid user name and
password each time it is used.

9. On the Publish tab:
a) Leave Prepare for viewing and annotating and Make available for download selected.
b) In the Allow Downloading in WebCenter area, choose the kind of files to upload to WebCenter.

• Input files are the original files themselves.

• PDF files for proofing are proxy files created by using the selected ticket. If you choose
PDF files for proofing, leave the default Create SoftProof for WebCenter ticket selected, or
choose another ticket if desired. Proxy files uploaded in this manner will have Download PDF
for printing as an option in WebCenter.

The combination of preparing for viewing but not making available for download is intended for
Graphics files that only need Approval.

10. On the Approval tab, deselect Start the Approval Cycle.
11. Click Save. Then click Yes to confirm overwriting the ticket.

2.10.7.  Expose WebCenter to the Internet

Exposing WebCenter to the Internet is the responsibility of your local IT department. Esko cannot do
this for you.

Register a Domain Name
Register and pay for a domain name, such as www.esko.com, to allow internet users to navigate to
your WebCenter site.

Once you have registered the domain name, your company is the only one authorized to use that
specific domain name for a certain period.

• Contact a proper authority (VeriSign, GoDaddy, etc) and purchase a domain name.
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Contact Your ISP to Set Up an A Record
The purpose of an A record is to associate your domain name to your public firewall/router, so web
trac (HTTP and HTTPS) going to the domain name is routed to that public firewall/router.

Think of this as telling the Postman how to get to your mailbox.

Note:  It takes several days for the A record information to propagate around the world.

1. Identify the public IP Address of your router/firewall.

This is the hardware appliance your Internet connection is plugged into (i.e. T1, DSL).

For example: My T1 is plugged into a firewall with 66.55.44.33 as public IP address.
2. Contact your ISP and ask them to add an ‘A’ Record (Address record) to the global DNS (Domain

Name Servers), associating your domain name and your router/firewall public IP address.
3. Verify that you can ping your domain name from computers inside and outside your LAN.
4. Ensure the reply you get contains the correct IP address for your public firewall/router.

Example

MCI is your ISP. You contact MCI and ask them to add an A record for your new domain name,
www.esko.com, to forward HTTP and HTTPS trac to your public firewall IP address of 66.55.44.33.

After about 3 days or so, this record has been propagated across the world. If someone in Thailand
‘pings’ the domain name www.esko.com, he/she should receive a reply with the IP address of
66.55.44.33.

Move the Web Server Inside the Demilitarized Zone (DMZ)
You should physically arrange the network devices so that the Web Server is in a proper DMZ
architecture (between two firewalls or plugged into a DMZ port of the public router/firewall).

1. Configure Firewall 1 (public router/firewall):
a) Allowed to route trac to Web Server inside DMZ for HTTP and HTTPS.
b) Default ports 80 (HTTP) and 443 (HTTPS).

2. Configure Firewall 2 (gatekeeper for private network):
a) Allowed to route trac on specific ports to WebCenter’s Application Server.
b) Default ports 1099, 2500, 4444.

Note:  You can change the default port numbers used at any time—to do this, modify the IIS settings
and the WebCenter configuration files on both the Web Server and the Application Server to reflect
these custom port numbers.

Configure IIS to Receive Trac
Web trac is delivered to the public firewall because of the A record. That firewall then forwards the
web trac to the Web Server inside the DMZ.

The Web Server application (IIS) needs to be configured to pick up this trac for processing. To do
this, the Web Server must be assigned a static Private IP Address.
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1. On the Web Server, click Start > Run and type inetmgr. Then click OK to start Internet Information
Services (IIS) Manager.

2. Expand the Web Site node.
3. Right-click the Web Site node and choose Properties.
4. Click the Web Site tab and verify that the IP Address is correct (or use the drop down list to change

it).
5. In the TCP Port field, ensure you are using the correct port for HTTP trac; the default port is 80

(this needs to match your firewall rules).
6. Close IIS Manager.

2.11.  Deploying WebCenter

WebCenter uses a three-tier installation framework to facilitate in-house development and
configuration before deploying it in production form. The three tiers are the Installation version, the
Development version, and the Production version.

Deployment Workflow
The intended workflow is to install WebCenter, deploy it to Development, modify the Development
version, and then when you are satisfied, deploy the Development version to Production.

As time goes by, you can keep modifying the Development version as desired without affecting the
Production version. When you are satisfied with the changes made to the Development version, you
can deploy it to Production.

At the time of deployment, the custom directory is not overwritten if it already exists in a target
instance, so customizationConfig.xml and any other customized files in the custom directory
are not changed. But when a new instance is created by deployment, the custom directory is created
with its default configuration.

The WebCenter Deployment Manager
The WebCenter Deployment Manager, located in Start > Programs > WebCenter, manages the
deployment process. If there is more than one website on the Web Server, choose the website with
which the WebCenter Deployment Manager will work and click OK.

 

 

To further develop the installed version, use the WebCenter Deployment Manager:
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• If you want to change the name of the development version, click the ... button in the Development
area, and specify the new name of the development version. When you have changed the name,
click Deploy Development.

Web authors can then modify the site at http://WebServer_name/WebCenter_Dev (or
whatever name you chose earlier), while normal users can still work using the site at http://
WebServer_name/WebCenter_Inst.

• Once the developed version is ready for production use, use the WebCenter Deployment Manager
again.

If you want to change the name and location of the production version, click the ... button in the
Production area and enter the new name. Then, click Deploy Production.

The site in WebCenter_Dev will be copied to WebCenter. Production use starts by users pointing
their browsers to http://WebServer_name/WebCenter.

Note:

You can have multiple development and deployment versions of WebCenter by changing the names for
each deployment, e.g. DEV1, DEV_Other, WebCenter_Prod1, and so forth.

Also, the deployment name is not case sensitive, so for example WebCenter_Dev and WebCenter_dev
are considered to be the same deployment instances.

2.12.  Localizing WebCenter

Localization is the process of making a program ready to run anywhere in the world.

It encompasses modifying the display language, the way units are displayed, decimal separators, time
and date formats, and currency format to match the local user preferences.

2.12.1.  Understanding Localization in WebCenter

WebCenter uses references to separate language files (text strings files) instead of using hard-coded
words. WebCenter ships with a variety of language files. Additionally, the text strings files can be
translated into any language.

Each WebCenter user can change to a different language in My WebCenter > My Preferences.

The default language can be changed in General Preferences at any time by any WebCenter user who is
a member of the Admins group.

2.12.2.  How to Install Custom Translations

The language files are in the languages subdirectory of the WebCenter installation on the Web
Server, such as \Artios\WebCenter\WebServer\tomcat\webapps\<site name>
\languages.

They are named wcstrings_xx.xml where xx is a two-letter code for the language, for example en
for English, fr for French, and de for German.
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1. Copy one of the existing language files, and rename the copy changing the two-letter language
code to the new language code.

Note:  The language code must match the ocial list of two-letter ISO 639-1 codes at http://
www.loc.gov/standards/iso639-2/englangn.html. For example, a Danish language word
strings file would be named wcstrings_da.xml.

2. Translate the strings in the file.
3. On the Web Server, open \Artios\WebCenter\WebServer\tomcat\webapps

\WebCenter_instance\config\config.xml in a text editor or an XML editor. In the
Languages section of the file, add a key for the new language, for example <Language key=”da”/>
for a Danish translation.

4. Put the translated language file in the languages subdirectory of the WebCenter installation.
5. Open every other wcstrings_xx.xml file and add a <NLanguage_xx>Language</

NLanguage_xx> string after the strings for the existing languages.

For example, add the string <NLanguage_da>Danish</NLanguage_da> to install a Danish strings
file, substituting the word for Danish in the appropriate language for the string file.

6. If the chosen language is a multi-byte language (such as Japanese, Chinese, or Thai), log on to the
Application Server and edit \Artios\WebCenter\config\appconfig.xml. Change the value
in the index_lang field to the appropriate language code that is listed in the comment below the
field, and save the file.

7. Restart the Web Server to see the changes.

2.13.  The Help System

Old style dynamic help system

WebCenter uses a dynamic help system that checks for the existence of specifically-named
XSL files on the Web Server in \Artios\WebCenter\WebServer\tomcat\webapps\
<WebCenter_instance>\help.

A Help link will appear in the menu of the page that has the same name as an XSL file in this directory.
The content of a Help file can be anything provided it is in XSL and the file has an .XSL extension.

Note:  Esko recommends the use of xmlspy® for authoring WebCenter Help XSL files. It is available
from http://www.xmlspy.com. There are also shareware and freeware XSL editors available. You could
also modify the sample provided using a text editor such as Notepad; do not use WordPad as it inserts
its own formatting codes.

• To change the Webmaster contact name and e-mail address displayed on the login help page, edit
login.xsl.

• If using foreign-language files, append _xx (where xx is the code for the language) to the end of the
file name before the extension, such as login_fr.xsl for a French help file for the login page.

When determining if a Help link should be on a page, WebCenter looks for a localized Help file, and then
for an English one if a localized one is not found. If neither exist, WebCenter does not put a Help link on
the page.

New style dynamic help system linked to help.esko.com
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Since WebCenter 12.1, a lot of pages (mostly in the admin section) use a dynamic help system linked
to help.esko.com. When a user clicks the help icon, context-aware help information is displayed. By
default the documentation from help.esko.com is shown, but this behavior is customizable.

It is possible to customize a specific help topic, or to link a subset of help topics to a specific manual or
page. The behavior of the help functionality can be configured in the custom folder on the Web Server.

Each help link has a topic (i.e. common/wc/reference/re_task ). The topic of a help link can be found by
looking at the link address: a help icon always links to help.jsp?topic={TOPIC}&lang={LANG}.

For customization, the following options are available:

• By placing html files in the correct location in the custom folder on the Web Server: Customization
for help pages is done in the custom/help directory. Customization can be done per language (by
adding files to custom/help/{LANG} directory (where {LANG} is the abbreviation for the language in
WebCenter i.e. custom/help/en for English). Customization can also be done for all languages. This
is done by putting files in custom/help/all.

• By adding a helpconfig.xml file with specific settings to the custom/help folder on the Web Server:
This file can contain a set of rules that will be applied when no specific custom topic is found. In the
custom help file you define rules that match topic names. When a rule matches, the rule is applied
by sending the user to the correct location, defined in the rule.

Note:

The system first searches in the language specific custom folder for a customized html file, if no html
file is found for a specific language, it will search in the custom/help/all folder for that topic.

2.14.  Upgrading WebCenter

You can upgrade directly to WebCenter 21.03 from older versions.

If you have an older version than 12.0, you will need to first upgrade to WebCenter 10.1 or 10.2, make
sure it is running correctly, then upgrade to WebCenter 21.03.

2.14.1.  Forced System Reboot during Upgrade

When updating WebCenter, a full re-installation is required. You need to remove the existing
installation before installing a new version.

After uninstalling, you have to reboot to be able to proceed with a new Installation process. This is
enforced before installing another version.

Note:  Reboot pending state of a system can be activated not only by WebCenter but also by completed
Windows updates or other application installation operations.

2.14.2.  Configuration Retained During Upgrade
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Retained Configuration Values during Upgrade
WebCenter Installer will store specific configuration values of the existing installation when it is being
uninstalled. These configuration values will be used during the upgrade.

The Installer input fields will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.

The following values are stored by the system:

• Web Server

• Application Server Hostname

• Application Server

• Web Server Hostname
• Database Server Hostname
• Database type (MS SQL or Oracle)
• Database Instance name (MS SQL only, default instance can be used in which case this setting is

empty)
• Database connection SID (Oracle only)
• SA database User password (default password)

Note:

1. The password value is not retained, if a custom password was used during the previous
installation. You will have to type in this password in this field.

2. Settings made for weekend days other than Saturday and Sunday, has to be made again in
Application server. Refer to the steps here.

• FileStore folder path(s) (UNC path is allowed)

Note:  As this mechanism includes persistence of custom FileStore path values, the
appconfig.xml configuration file does not have to be modified after re-installing a new
WebCenter version.

• Installation Choice: Simple or Advanced

• If Advanced Installation is selected, the following choices are retained:

• Java Heap Space Size: Normal or Extra Large
• View Server: Internal or External
• Database (internal) User password: Default or Custom

Note:  The password field is always left empty.

FileStore Split during Upgrade
To prevent FileStore size problems, WebCenter supports FileStore split into separate folders. The
configuration of the different FileStore paths is stored within appconfig.xml.
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During the uninstallation phase, the application reads the appconfig.xml file and stores all the
custom settings. When you re-install, the Installer updates the appconfig.xml with these custom
values instead of default values (derived from the default FileStore location).

Following FileStore paths can be customized in appconfig.xml and the custom values are kept
during the reinstall process:

• temp_dir- This node mentions the folder used to keep temporary work files.
• viewer_data_dir- The node mentions the folder used to store 2D Viewer data files for individual

viewable WebCenter Documents.
• document_thumbnails_dir- The node to store thumbnail files for Documents that support having

custom thumbnails generated per Document WebCenter object.

This is optional. If it is missing, Document Thumbnails are stored in the same folder as the main
Document files (as set in document_dir node).

• document_perspectives_dir- The node to store various default and custom Document Perspective
files for individual Documents (set of supported Perspective types varies based on the Document
Type).

This is also an optional folder. If it is missing, Document Perspectives are stored in the same folder
as the main Document files (as set in document_dir node).

2.15.  Prepare for the Upgrade

This describes how to upgrade from older versions of WebCenter   to the latest build of WebCenter
21.03.

Note:

This procedure applies to all upgrade installations of WebCenter 21.03, even to "minor" updates
between builds of the same version.

Note:

This procedure is fairly complex and involves direct manipulation of core application and database
files.

Expert help is available to perform the upgrade for you at a minimal cost: contact your local Esko
Customer Services division for a quote and scheduling.

For more detailed instructions than the brief overview provided in this document, please consult the
main WebCenter Installation Guide on the installation media.

2.15.1.  Prerequisites for the Upgrade

Installation Media and Licenses
Make sure you have the following at hand before proceeding:

Media

• WebCenter 21.03 DVD
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• Automation Engine 21.03 DVD

Licenses

• ArtiosCAD (21.03 FlexNet server license)
• WebCenter 21.03 (plus optionally Task Management, Advanced Approval, PDF download, Reporting,

extra concurrent users)
• OBGE (On Board Graphics Engine)

Information Needed
Make sure you collect the following information:

• The location of the FileStore (you can find this information in C:\Artios\WebCenter\Config
\appconfig.xml)

• The database engine to use (SQL Server 2008 (R2) / 2012(Express Edition) /2014(Express
Edition)/2016 (Express Edition), 2017( Express Edition), 2019 (Express Edition) Oracle 10g or Oracle
11g or Oracle 12c).

• The name of the Database Server, the Oracle Database Identifier (SID) if using an Oracle database,
and the database administrator password (sys password).

• The name and location of the WebCenter4_0 database instance (you can find this information in

<DRIVE>:\Esko\Artios\WebCenter\ApplicationServer\Jboss\server\default\configuration
\standalone.xml. Use your Esko customer login and password for activating licenses.

• The IP address or name of the LDAP server and the port used for the secure connection (typically
636).

If you are upgrading from 16.1.1 or 18.0 to 18.0.1 or 18.1.1 to 20.0
WebCenter Installer will store specific configuration values of the existing installation when it is being
uninstalled. These configuration values will be used during the upgrade.

The Installer input fields will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.

The following values are stored by the system:

• Web Server

• Application Server Hostname
• Application Server

• Web Server Hostname
• Database Server Hostname
• Database type (MS SQL or Oracle)
• Database Instance name (MS SQL only, default instance can be used in which case this setting is

empty)
• Database connection SID (Oracle only)
• SA database User password (default password)

Note:

1. The password value is not retained, if a custom password was used during the previous
installation. You will have to type in this password in this field.

2. Settings made for weekend days other than Saturday and Sunday, has to be made again in
Application server. Refer to the steps here.

• FileStore folder path(s) (UNC path is allowed)
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Note:  As this mechanism includes persistence of custom FileStore path values, the
appconfig.xml configuration file does not have to be modified after re-installing a new
WebCenter version.

• Installation Choice: Simple or Advanced

• If Advanced Installation is selected, the following choices are retained:

• Java Heap Space Size: Normal or Extra Large
• View Server: Internal or External
• Database (internal) User password: Default or Custom

Note:  The password field is always left empty.

2.15.2.  Prepare for the Upgrade on the Application Server

1. Copy the following onto the Application Server:

• WebCenter 21.03 DVD
• Automation Engine 21.03 DVD
• ArtiosCAD en license
• WebCenter 21.03 license (plus optional module licenses)
• OBGE (On Board Graphics Engine) license

2. Back up:

• the FileStore
• the WebCenter4_0 database
• the \Artios\WebCenter folder
• the \Esko\Artios\WebCenter folder
• any E-mail Notification customizations that may be stored in \WebCenter

\ApplicationServer\EmailNotifications\Custom
• all other non-standard customizations you may have implemented outside of the custom

folders
3. Make a restore point for the OBGE.
4. Make a backup of the server software configuration.

For detailed instructions on step 3 and 4, please refer to the Automation Engine 21.03 Installation
Manual.

2.15.3.  Prepare for the Upgrade on the Web Server

1. Copy the following onto the Web Server:

• WebCenter 21.03 DVD
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2. Back up \Artios\WebCenter and any non-standard customizations you have implemented
outside of the WebCenter instances.

2.16.  Upgrade WebCenter

2.16.1.  Remove WebCenter

1. On the Application Server:
a) Remove the WebCenter software using the Add/Remove Programs applet in the Control Panel.
b) Reboot the server.
c) Using Windows Explorer, remove the \Artios\WebCenter and \Esko\Artios\WebCenter

folders, and any other remaining WebCenter-related folders.

Note:  Take care not to remove the FileStore if it is inside a WebCenter folder!

2. On the Web Server:
a) Remove the WebCenter software using the Add/Remove Programs applet in the Control Panel.
b) Reboot the Web Server.
c) Using IIS, remove all WebCenter instances (only the default "WebCenter_Inst" is removed

automatically).
d) Using Windows Explorer, remove \Artios\WebCenter, and any other remaining WebCenter-

related folders.

2.16.2.  Install WebCenter 21.03

1. On the Application Server, update the older version of ArtiosCAD Enterprise to the latest version
of ArtiosCAD Enterprise, choosing the options described in Install ArtiosCAD Enterprise on the
Application Server on page 31 and the Use the default configuration upgrade option.

2. Upgrade the license component using the Automation Engine 21.03 DVD:
a) Insert the Automation Engine  21.03DVD.

If the DVD does not auto-start, double-click setup.exe in its root folder.
b) In the window that opens, click English.
c) Click either:

• Software Installation in the main menu on the left of the window,

• Proceed to the installation >> at the bottom of the window.
d) Click Install on the next page.
e) On the Instructions page, click Run the Automation Engine System Readiness Check.

At the end of the Readiness Check, read the resulting messages carefully. If the Readiness
Check resulted in a problem, correct it before proceeding. Click Exit in the Automation Engine
System Readiness Check dialog when this is done.

f) Click Install the License Server Components.
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g) Click Install the System Controller 1.0 and follow the instructions of the installation wizard.
3. Activate the Licenses on page 32.
4. Uninstall the old version of ArtiosCAD Enterprise.
5. Install WebCenter 21.03, using the English language installer, on the Application Server and on the

Web Server, making use of the existing FileStore location and WebCenter4_0 database location.

Note:  The installers in other languages should not be used, until further notice.

See Installing WebCenter on page 29 for more information on the installation procedure.
6. Install Certificates for LDAPS on the Application Server on page 62.
7. When the upgrade installation is completed, the search crawler needs to be updated. This is to

ensure that the search results are up to date or else may result in incomplete search results. To
rebuild Search Crawler, Go to Configuration > Search Crawler Set up and click on Rebuild Index.
This operation can take several hours depending on the number of projects, tasks, document
(versions) present. Rebuilding the search index has a serious performance impact, and it is advised
to run this over the weekend. Search results will be incomplete as long as the index is being rebuild.
This is to ensure that the search results are upto date and complete.

2.16.3.  Upgrade the OBGE

Note:

• The OBGE must have the same or a later version than the Automation Engine production server.
• Make sure that you do not update any CADx component while updating the OBGE! CADx must only

be updated by the ArtiosCAD Enterprise installer.

Upgrade the OBGE (On-Board Graphic Engine) to Automation Engine  21.03 :

1. Upgrade the prerequisite components:
a) Insert the Automation Engine 21.03 DVD.

If the DVD does not auto-start, double-click setup.exe in its root folder.
b) In the window that opens, click English.
c) Click either:

• Software Installation in the main menu on the left of the window,

• Proceed to the installation >> at the bottom of the window.
d) Click Install on the next page.
e) Click Install the prerequisite components and follow the instructions of the installation wizard.

Note:  Remember to not update any CADx component!

The prerequisite components are now upgraded.
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2. Test the OBGE and check its configuration (Hot Folder and container, see Configure the OBGE on
page 43 for details).

2.16.4.  Configure WebCenter

1. If you had WebCenter customizations:
a) Reapply the email notification customization that you backed up in your custom folder.

Mentions of an older version of WebCenter are automatically updated to "WebCenter 14".
b) Apply any standard customizations you saved earlier to your new WebCenter instance(s).
c) Redo any other non-standard customization that you may have had.

See the WebCenter Customization guide for more information.

Attention:

• Do NOT copy the files as the XML structure might be different and you might break it.
• Do not customize the Default instance of WebCenter as if it doesn't work anymore

you will have to completely reinstall it!

2. In case running the database scripts automatically (preferred) is switched off, run the WebCenter 14
database scripts.

See Run the Database Schema Scripts on the Application Server on page 35 for more information
on the database schema scripts.

3. Log on the WebCenter web interface and change the administrator password (see Log On to
WebCenter and Change the Admin Password).

4. Deploy new WebCenter instances as desired.
See Deploying WebCenter on page 70 for more information.

The upgrade is complete.

2.16.5.  Additional step when you upgrade from 18 to later versions

When performing an upgrade to installation of a WebCenter 18.0 or later, if the Web server is on the
same host as the installer, then the following options are available if the custom folders is backed up:
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• Redeploy web instances with customizations: This is the default option. Re-deploys the custom
instances marked during the previous uninstall procedure as well as the custom folders backup.

• Redeploy web instances without customizations: Re-deploys the custom instances marked during
the previous uninstall procedure but will not retain the backed-up custom folders.

• Do not redeploy automatically: Will not re-deploy any of the custom instances and their custom
folder backups.

2.17.  Uninstalling WebCenter

1. Log on to the Web Server as a member of the local Administrators group.
2. Stop the IIS Admin service.
3. Backup all deployed sites within \Artios\WebCenter\WebServer\Tomcat\webapps in case

they are needed in the future.
4. In WebCenter 18.0 or later, Web server installer records the names of all the custom WebCenter

instances while backing up the custom folder where all Web server based customizations of a given
instance including the default WebCenter_Inst are stored.

Common App Data root folder is used to store the customization files backup on the target Web
server host. The default path on most Windows server would be C:\ProgramData\Esko\WebCenter
\WebInstanceCustomData.

This folder is the root and each WebCenter web instance custom folder files that was backed up is
stored under a subfolder that takes the name of the appropriate instance.

The list of web instances that were found and can be later re-deployed are stored in the registry
among the other WebCenter upgrade values. Read more about this here Additional step when you
upgrade from 18 to later versions on page 80.

5. Use the Add/Remove Programs applet in Control Panel to remove WebCenter.
6. Manually delete all subdirectories under \Artios\WebCenter.
7. Log on to the Application Server as a member of the local Administrators group.
8. Back up \Artios\WebCenter\Filestore and all its subdirectories in case they are needed in

the future.
9. Use the Add/Remove Programs applet in Control Panel to remove WebCenter.
10. Manually delete all subdirectories under \Artios\WebCenter

for the Automation Engine Prerequisites

If WebCenter is uninstalled with the intention of installing a newer version (and keeping an existing
database), do NOT delete the files in \Artios\WebCenter as they contain information needed
for the new version to run with the existing admin password.

11. If using Microsoft SQL Server 2008, or Microsoft SQL Server 2008 Express Edition, back up the
WebCenter4_0 database and then use Enterprise Manager to manually delete the WebCenter4_0
database.

If using Oracle, backup the database and either delete the instance, or, if it is shared, connect to the
instance and issue the drop user webcenter cascade; command.

12. If the OBGE is installed, remove all the Esko products using the Add/Remove Programs applet in
Control Panel. Select all products except the FLEXlm flexid drivers.
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13. Remove ArtiosCAD Enterprise by using the Add/Remove Programs applet in Control Panel. Once all
the products are removed, WebCenter should be completely removed.

14. Reboot your machine. If you need to install another version, this is a required step.
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3.  Administration Guide

3.1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

3.2.  What's New in WebCenter 21.03

WebCenter 21.03 is a minor release of the WebCenter including new and much improved functionality
in the following areas:

Inline Editing in Dashboards

• Additional document sources available
• Document source inline action-buttons
• Set required fields in dashboard forms
• Version-up in upload landing
• Upload a new Version of document
• Required Fields

Content Management Improvements

• Performance Improvements
• Text inheritance
• Drop-down support

Flexible Approvals
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• Workflow Node: Add and Replace Approvers
• Add/remove or Replace approvers without stopping approval cycles
• Reason(s) for Forced Rejection
• Route on Reason for Rejection from any stage

3D Assembly Improvements

• Create assemblies directly from CAD and Collada files
• Improvements to View component widget

3.3.  WebCenter Administration Basics

WebCenter installs with a minimal configuration because every installation has different needs. This
guide explains as how to set up WebCenter and make it ready for use.

3.3.1.  A Note on Web Browsers

Due to differences between the Web browsers, some configuration issues in Firefox and Safari require
extra action in order for WebCenter to function properly. Anyone using WebCenter with either of these
browsers on any platform should consider performing these configuration changes.

Mozilla Firefox
Refreshing pages may not get the most current data from the WebCenter Web server. In order to
ensure the most current data is seen, caching must be disabled, or you must press ctrl-r on any
suspect pages to forcibly reload them.

To disable caching, do the following:

1. Log in and start Firefox.
2. In the Address field, type about:config and press enter.
3. Scroll down to the network.http.use-cache entry and double-click it so that its value changes from

true to false.
4. Restart Firefox.

Safari
When using Safari, the built-in browser for Apple Macintosh computers running OS X, there is no way to
configure caching. When using the Back button, click Refresh to ensure you see the most current data.

3.3.2.  Understanding the WebCenter Page Layout

Header
The top right of the WebCenter page always shows:

• the name of the current user,
•

a  icon to go back to the user's start page,
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•

a  Discussions icon which indicates the unread messages and redirect to My Discussions. You
can view all discussions related to Project or Document or Tasks that you are involved in. For more
details, refer to Discussions in WebCenter on page 837

•
the Cart ,

•
Avatar  icon displays the user initials (first letter of first name and last name),or an image, if any
is uploaded in the User page.
 

 

• a link to the WebCenter Welcome page,

• Admin (if the user is a member of the Admins group),

• Contact,

• Logout.

Top Menu Bar
By default, the top menu bar contains the following menus: My Work, Projects, Task Types, Search,
My WebCenter, Create (if you are a Project Manager) and Upload (see The Default WebCenter Menus on
page 546 for more details). An administrator can customize the menus.

 

 

If you have the optional Task Management module and the User Can Create Task Type permission,
Task Types also appears in the top menu bar.

Documents Pages
Below is a sample of project's Documents page, in grid layout, for a user who is a Project Manager.

Area 1 is the project actions area, allowing you to perform actions on the whole project (for example,
mail a link to the project to a reviewer, add the project to your favorite projects...)
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• Area 2 is the Project Details area, containing the project icon, the name and description of the
project, the project status...

• Area 3 shows links to the project pages. For example, click Members to view the project members.
The page you are on is shown in bold.

• Areas 4 and 5 are part of the content pane, that changes depending on the project page you are on.
Here, on the Documents page, they show the project folders and documents.

• Area 4 is the Folders pane, showing the projects folders. Click a folder to see the documents it
contains.

• Area 5 is the document pane, that can show the documents in a list or grid view, with or without
thumbnails.

Notes
• To act on many documents at once, select their check boxes and then choose an action in the

Actions menu.

• To select all documents in the current folder, select the check box before the Documents header.

• To switch to a list layout, click Show as List.

• Hovering over a thumbnail shows a larger version of it in a pop-up window.

For Graphic documents viewable by the WebCenter Viewer, you can click the zoom icon to show
an even larger thumbnail (500 x 500 pixels). This is applied to all Graphic documents on which you
hover until the page is reloaded.

The pop-up window closes when you move the cursor off the thumbnail.

There is usually more than one way to accomplish a task by using a combination of menu entries,
action menus, and clicking status messages. Many methods will lead to the same result.
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Note:  This layout is the default layout. However, your layout might be different depending on your
customization.

3.3.3.  Filtering Content

As more information is managed over time by WebCenter, some pages can potentially show large
amounts of information. To reduce the time needed to show the page when it first loads, some pages
have a filter.

To use the filter, enter a search string with an asterisk either before it, surrounding it, or after it in the

Search field, and click . For example, on the Companies page, to only see those companies with the

word Containers in their name, enter *Containers* and click .

When filtering users, use the last name of the user.

To show all the items, up to the truncation limit, click with nothing in the field.

Note:  The truncation limit prevents lists of thousands of items from impacting response time; if you
know in advance that your search will return that many items, refine it with the filter. The truncation
limit can be changed; contact Professional Services at your local Esko oce for more information.

3.3.4.  The Admin Menu

All administration is done initially by Admin, the administrative user who has full control over
WebCenter.

The Admin user and members of the Admins group have the Admin  button in the right side of the
header.

 

 

Click the Admin  button to go to the Admin menu. The Users page is shown by default.

To return to the normal WebCenter menus, click the Exit Admin  button.

3.4.  WebCenter Preferences

The Preferences menu in the Admin section of WebCenter allows you to set system-wide preferences
in a number of categories:

• General

• Password Preferences
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• Security

• Document Types

• Notifications

• Menus

• My Work

• Customizations

• Reports

3.4.1.  General Preferences

Click General on the Preferences bar to set system-wide preferences.

Note:  The individual users can override nearly all of these properties for themselves in My WebCenter
> My Preferences. Those users who have changed these settings are not affected by later changes
made to the same fields in Admin > Preferences > General by an administrator.

General
• Language sets the language used by the user interface.

• Start Page sets the page that appears when you log on. It could be either Dashboard, Document
Search, My Favorites, My Locked Documents, My Preferences, My Profile, My Work, Projects, Project
Search, Saved Search, Welcome page. If Dashboard or Saved Search is chosen, further drop down is
shown to chose from the existing Dashboard or Saved Search.

• Default Project Page sets the page that appears when clicking a project name. It could either be
Project Dashboard, Documents Page, Attributes page, Tasks page, Bills of Materials page.

Note:  When Dashboard is chosen as Default Project Page or Start Page, you can either chose from
the existing dashboards or Create New Dashboard.

• Default Document Page sets the page that appears when clicking a document name.

It could be either be History, Approval, Attributes or Details page.

• Units sets units for all measurements to either Metric (mm, cm, dm, m) or Imperial (in, ft, yd).

• Thumbnails: selecting Show thumbnails shows thumbnails in document lists by default.

• Cart: Clear Cart on Logout is always enabled by default. Disable this option if you want your users to
access their Cart contents across sessions.

Project Lists
• Show ... rows sets the number of projects displayed in the List layout.

Document Lists
• Default Layout sets the default view for document lists: Grid or List layout.

• Show in Grid sets the number of documents displayed on a single page in the Grid layout (defined as
a number of Columns and Rows in the grid).
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• Show in List sets the number of documents displayed on a single page in the List layout (defined as
a number of Rows in the list).

Search Results - All
Show in List sets the number of documents displayed on a single page in the Search results List layout
(defined as a number of Rows in the list).

Show Cards sets the number of individual document objects that are displayed as a table of document
thumbnails on a single page in the Search Results.

You can choose to Show date and time for Date Attributes/Specifications. By default date attributes
in Search Results will not show time information.

Search Results - Documents
• Default Layout sets the default view for document Search results pages to Grid, List or

Cardslayout.

• Show in Grid sets the number of documents displayed on a single page in the Search results Grid
layout. You can also specify the position of the Thumbnail position in the results as Top or Left.

Search Results - Projects
• Default Layout sets the default view for project Search results pages to Grid or List layout.

• Show in Grid sets the number of projects displayed on a single page in the Search results Grid
layout. You can also specify the position of the Thumbnail position in the results as Top or Left.

Discussions
• Discussions per Page sets the number of discussion threads displayed per page on the

Discussions pages.

• Postings per Page sets the number of discussion posts displayed per page on the Discussions
page.

Roles
Invite Group Default sets the system-wide default state of the Invite Group check box, available on
the Manage Roles page and in the Members area of the Project Creation page (when creating a project
based on a project/template that contains roles).

Bill Of Materials
Use Bill of Materials enables the Bill of Materials functionality for the entire WebCenter system. See Bill
of Materials on page 456 for more information.

My Work Defaults
• My Approvals Assignee Filter sets what users view by default in the My Approvals section of their

My Work page (approvals assigned to Me, Me or Group I Am In or Group I Am In).

• My Tasks Assignee Filter sets what users view by default in the My Tasks section of their My Work
page (tasks assigned to Me, Me or Group I Am In or Group I Am In).

• Non Started Tasks sets whether users' My Work page displays tasks assigned to them that aren't
started yet.
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Project Autoname Generation
Use the Project Autoname Generation settings to automatically generate project names.

These settings use a naming template (Prefix, Sux and Counter Length) to define the automatically
generated names.

Define Prefix and Sux by selecting from Smart Namesdrop-down menu.

Note:  Make sure to read the notes at the bottom of the page for restrictions. The building blocks are
case-sensitive.

The Counter Length is a numerical field that gets incremented for each new Project using the same
prefix. It is placed between the prefix and the sux.

In the Counter Length field, enter the length of that incremental counter. For example, enter 5 for
numbers that will be five digits long.

Select Use Automatic Naming for Creation of Blank Projects if you want to automatically generate the
names of projects created from a blank project.

Discussions
• Discussion Counter option is enabled by default. When enabled, the counter will display all the

unread messages including the unread messages from private discussions within a project, where
the PM / Admin users are also part of. This option only affects the global counter on the top menu
bar.

• Default Participants: This is a radio button option. You can either choose

• To start the discussion with everyone who has access to the current Project / Document/ Task
• To restrict the option to have the default participant as the Discussion Creator.

Other Preferences
• Host URL sets the URL at which the WebCenter site can be accessed. This is the URL used to send

automatic email notifications.
• Host URL for internal use sets the URL at which internal components, like Automation Engine, can

access the WebCenter site. Use this to go through the local network (using your WebCenter server's
local computer name) instead of through the internet (using your WebCenter server's public IP or
computer name).

You should use this if, due to your setup, the DNS doesn't know the WebCenter server's public name
inside your Local Area Network.

Note:  You can only use this when Automation Engine and WebCenter are on the same LAN.

If this is not filled in, Automation Engine will connect to WebCenter using the Host URL.

For both Host URL and Host URL for internal use, you can choose to use either http:// or https://.
Choose the protocol defined during the WebCenter installation.

PDF Download Options
Admin user can set options to add some more information to the PDF documents when they are
downloaded by selecting the required options.

• Add Approval information to downloaded PDF
• Show Approval information in landscape layout
• Prepend Approval Information
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• Show User Company / Location in a separate column

You can also add the Project Attribute IDs and Document Attribute Ids of either Text or Date/Time
attribute type in the respective fields, which are then displayed in the report when the document is
downloaded.

Note:  You may contact Esko Solution Architects for further details.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

Viewer
• Select your Viewer Type. You can set your preference to the HTML5 Viewer or keep at the default (

Java Viewer ).

Note:  You can always switch to Java Viewer from HTML5 Viewer using the  button.

• Viewer and Workflow Applet: When opening a document in the Viewer or when creating a workflow,
WebCenter will download a Java applet to your computer.

From Java 1.7.0_21 (for Windows and Mac OS X 10.7 or later), you will get a security warning as the
one below when the applet is downloaded. This makes the WebCenter applet look like a security risk
for your computer.

 

 

You can adapt how this security warning will look like when downloading the applet. In Viewer and
Workflow Applet, choose either:

• Signed (sandboxed) if you want to run the applet in a strict sandboxed environment (with no
access to your computer's resources). As the applet is signed by Esko, the security warning
looks less threatening.
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Note:

As the applet is sandboxed, it will also show a warning when trying to print from the Viewer. You
will just need to click OK to be able to print.
 

 

• Signed (not sandboxed) if you want to run the applet without restricting it to a sandbox (the
applet can request additional access to your computer's resources). This means that you will not
get an additional warning when printing from the Viewer.

As the applet is signed by Esko, the security warning looks less threatening.
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• Unsigned if you want to run the applet as a default unsigned applet. You will get the default

security warning that does not mention Esko, but the applet will be sandboxed. This means that
you will have an additional security warning when printing from the Viewer, as for the Signed
(sandboxed) applet.

Tip:

By default, the applet is set to run as Signed (sandboxed). This will work fine for most users.

More frequent users may want to switch to the Signed (not sandboxed) option to avoid always
having to click an extra warning away when printing from the Viewer.

Mac OSX 10.6 users running Java 1.6.0 may also want to switch to the Signed (not sandboxed)
option to avoid getting a warning when closing the Viewer by clicking .

With the latest versions of Java 1.7 installed, most browsers block unsigned applets by default. In
this situation, it is recommended to use one of the signed settings instead.

• Viewer Style (Java Viewer) sets the Viewer mode as:

• Normal (Default): All HTML5 Viewer features are available in this mode.
• Restricted: In this mode, the user cannot access features such as Channels widget, CAD widget

and View widget.

The side panels displaying the widgets will be in a collapsed format by default.
• Advanced: In Java Viewer all features are activated.

• Viewer Workspace: Select any workspace from the drop down or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

• Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter viewer, when they are shared with a document to view or to approve.
Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.
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• Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

• Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.

• Select Enabled if you want the users to be allowed to annotate approved documents.

• Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

• Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

• Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

• Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.

• Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note:  A document version is considered under approval as soon as an approval cycle is started

Choose from the following settings:

• All Users: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

• All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

• All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

• Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

• Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.

• Specify the Viewer Quality as:

• Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

• Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Note:  This setting is applicable to both the HTML5 and Java Viewers.

• Settings for Automated Artwork

Note:  The below options are visible only when Automated Artwork license is enabled.
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• Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

• Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note:  This option requires Packaging Content Management License.

• PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note:  This option requires the Packaging Content Management License.

• Log out user when inactive  Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

• Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.

• Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note:  Project Managers who can Force Approve or Force Reject is not considered an approver. They
can add annotations only if the setting is All Users.

Configuring Viewer Workspace

Workspace
You can configure Workspaces specifically for Roles, Users, and at System level in WebCenter. It is
also possible for users to customize their own workspace in the viewer.

Admin users can create new workspace or assign a workspace or configure a workspace or delete a
workspace from the following locations :

• General Preferences where workspace selected is for all the users in the WebCenter
• Role configuration where workspace selected is for the specific Role
• User Preferences where workspace selected is for the specific user only

Workspace Configuration
On selecting the gear icon in the Viewer Workspace field, Configure Workspace pop up window is
available to make changes to the workspace.

Each of the tool is either in Visible state, or Available or Hidden state.

• Visible: Check box is selected for for the tool or widget is not visible for the user but it is available.
The user can add the Tool or Widget in the Viewer

• Available: Check box with a dash. Tool or Widget is not visible for the user but it is available. The
user can add the Tool or Widget in the Viewer

• Hidden: Tool is neither visible nor available for the user, so the user will not be able to use the tool or
widget in the workspace.

Only the tools and widgets in Visible and Available state are shown in the workspace for the users to
configure.

You can also choose the Color Theme of the viewer specific to the workspace in the Configure
Workspace pop up.
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Approval

Approval Cycle Start when Uploading New Document or Version
Define what should happen to a document approval cycle When uploading a new document or version.
You can choose to:

• Start if previous version's approval is on-going or finished
• Always start (if Approval setup exists)
• Never start

Select the checkbox

• Always allow the document owner to start/stop the Approval cycle to allow the document owner
to start or stop the approvals on the document(s).

• Allow the uploader to override the approval cycle start to allow the user to overwrite the approval
start behavior upon upload.

Require Approval Comments on Viewable Documents
Use this option to require the approvers to add their comments as annotations in the document.
Select:

• Prompt to start a dialog with a comment field when the Approver Rejects or Approves with a
Condition. The Approver can choose to comment in the dialog or leave the comment field empty.
This is the default setting.

• Any Annotation to enforce that at least one annotation is present while Rejecting or Approving with
a Condition. The comment field will contain the following message.

Document
                            annotated

• User Annotation to force the Approver to add at least one annotation in the document version
before Rejecting or Approving with Condition. The comment field will always contain the following
message.

Document annotated

Note:  This setting will be applied when submitting an Approval Status from pages outside the viewer.

Block approval when an annotation was set/changed on current version
Check this option to prevent users who have created an annotation on the current version of a
document from submitting the Approved status without a condition.

If Approved with Condition is not enabled, you can submit only the Rejected approval state. If users
have replied to an existing annotation from another user, they will no longer be able to approve the
document without condition.

Note:

This setting will also be applied when submitting an Approval Status from any page outside the Viewer.
The user will then get the corresponding feedback.

Reasons for Rejection List
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After configuring and uploading a list of Reasons for Rejection, an admin user can choose the list from
the drop down to enable reasons for rejection on the system. Then, when a user rejects a document,
the reasons for rejection can be picked from this structured list. Read more on how to configure the
list of Reasons for Rejection.

Note:  When the Reasons for Rejection are enabled in the system, bulk rejection is automatically
disabled.

ArtiosCAD
To open your document in the ArtiosCAD desktop application directly from the WebCenter server, you
need to set the ArtiosCAD Preferences accordingly.

Open ArtiosCAD Documents
• No Application: This is the default Preference. When this is selected, you cannot open the

documents in the ArtiosCAD desktop applications.
• ArtiosCAD Standard Edition: Select this setting to be able to download ArtiosCAD documents and

open them in your ArtiosCAD desktop application.
• ArtiosCAD Enterprise Edition: Select this to open your ArtiosCAD documents in the installed

ArtiosCAD Enterprise Edition directly from WebCenter.

The documents will open in the managed mode allowing you to make modifications to the file and
update it without having to browse to the corresponding project and folder.

Note:  This option is only supported from ArtiosCAD Enterprise 14 onwards.

Document Upload Preferences
• Allow raising Document Revision when uploading a new Document Version: Enable this to allow

the users to raise the revision while uploading a new document version.
• Allow Instant uploading when selecting documents: X Choose this option to start uploading

documents immediately when they are selected, while the rest of the page is still being filled in or
other documents are still being selected.

•

Packaging Content Management

Note:  You need the Packaging Content Management license to be able to use this module.

Smart Role Names for Editors and Approvers
To work with language specific Smart Role Naming on page 508 specify your:

• Language Editor Role Prefix/ Language Editor Role Sux
• Language Approver Role Prefix /Language Approver Role Sux
• Add Language Role Prefix/ Add Language Role Sux

The specified prefixes and suxes are used automatically to create Role names specific for each
language in the Role Mapping >  Manage Permissions page.

If the Roles column in Manage Permissions is left blank, values in Language Editor Role Prefix,
Language Editor Role Sux, Language Approver Role Prefix,Language Approver Role Sux, , Add
Language Role Prefix and Add Language Role Sux are taken to calculate the role names for Editor,
Approver Text Content and Add Language permissions.
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A change in a Text document creates a new document version. To allow or prevent the users from
creating new Revisions use the Revision Raise option:

Select Raise revision when Master Text Contents are updated to allow raising a Revision when master
text is updated.

Select Never raise revision if master text changes should not be saved as a new Revision.

Note:  This setting is independent of the Allow raising Document Revision when uploading a new
Document Version setting.

Copy comments from a text document
Choose either to Keep Comments or Remove comments if state reverted to Draft or Remove
Comments always when copying a document.

You can choose the option Keep Comments to copy all the comments when copying a document.

Comments are cleared if the state of the element is changed to draft, when the option Remove
Comments if state reverted to Draft is chosen.

Similarly, all the comments in the elements are cleared while copying, when the option Remove
Comment always is chosen.

Note:  Same behavior is replicated in workflow when documents are copied using Copy/ Move
Document. Move document option does not respect this setting.

Workflow Editor
By default, HTML5 is used as Workflow editor.

User Creation
To create a new approval User from an approval page quickly, you can select and apply a particular
user's settings as the Approval User Template.

Tip:  If you do not want to take up a license for a Template User, deactivate the user by unchecking the
Active User option in the Profile page.

It is possible to configure this at two levels.

• To specify a global template, go to Admin > Preferences > General > User Creation Preferences.
Select a particular user existing in the system as your Approval User Template.

This template will be set as the system wide approval user template. However, it is possible to
override this in My WebCenter > My Preferences > User Creation Preferences.

• To specify a template for a User who can create other users, go to My Preferences > User Creation
Preferences and specify an Approval User Template. You have the following options and your
choice will override the admin settings:

• Do No Use a Template

• Use Global Approval User Template to apply the user template specified in the Admin
Preferences.

Note:  If you have not explicitly selected the Do not Use a Template option or has any other user
specified as the template, the global template will be applied by default.
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• You can select a particular user as your template. In the drop-down you will see your own Users if
you are a Project Manager and all Users if you are an administrator.

The following Preferences and settings of the template are copied to the newly created user:

1. Preferences:

• Language

• Units

• Start Page

• User Menu

• My Work Setup

• Viewer Preferences

• Collada Viewer Preferences

• Workflow Editor Preferences

• Document Upload Preferences

• ArtiosCAD Preferences

• Download Formats(copied only if the user creating the new user is an Administrator)

• Group Memberships(copied only if the user creating the new user is an Administrator)

• Other Preferences are the user preferences not mentioned above (for example: show
thumbnails or not, search results layout, etc.).

2. The Authentication Settings (Deactivation, SSO, etc.)

Project creator
A new user type has been introduced from WebCenter 18.1 onwards called Project Creator. This user
can create new projects, but cannot manage them. This user type is similar to Project Manager but the
main difference is that the Project Creator does not have any rights over the project, once the project
is created.

Note:  A Project Creator user can access the project created,

• if added as a member of the project either directly or in a Group or Role within the project
• if the option Project Creator becomes Salesperson after Project Creation is enabled by the admin

user.

When WebCenter is under the Named User License model, a dedicated license is available for the
Project Creator users. Similar to the other named user license types, you can create as many Project
Creator users as you have licenses.

When WebCenter is running in the concurrent license model, you can create an unlimited number of
Project Creator users.

You can have two types of permissions for Project Creators users, namely:
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• Limited Visibility of Companies and Groups: Can view only the list of Groups / Users, Company and
locations that are limited to the user’s visibility scope

• Full Visibility: Can view all Groups/ Users, Company and locations without any restrictions.

Delegation Preferences- System Wide

Delegation Restrictions
To ensure that your user(s) delegate to a limited list of users, you can use the Delegation Restrictions
either as a system wide settings or per user.

The Administrators can specify system wide delegation restrictions. Admin users can place
restrictions on delegation based on various factors like:

• No Delegation which prevents your users from delegating their work.

• All Visible Users which allows to delegate any user who are visible in his or her list.

• Users in the same Company which allows you to choose delegates, only within the same company.

• Users in the same Location which allows you to choose delegates, only within the same location.

• Users in the same Group which allows you to choose delegates, only within the same group.

You can also enable Delegator receives e-mail notifications during delegation period option to
receive email notifications when a user has delegated the work.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.4.2.  Password Preferences

The Password Preferences determine whether passwords must meet security requirements, whether
they expire, and whether or not users need to provide their passwords when approving or rejecting
documents.

Password Complexity
You can enforce a number of password rules by enabling Passwords must meet complexity
requirements. When this feature is not enabled the only requirement is that passwords be non-blank.

If Passwords must meet complexity requirements is enabled, WebCenter passwords:

• May not contain the user's username, first name, or last name

• Must contain characters from three of the following four categories:

• English uppercase characters (A through Z)

• English lowercase characters (a through z)

• Base 10 digits (0 through 9)

• Non-alphanumeric characters (for example: ! $ # %)

• Admin can also additionally enable two more options in Password Complexity namely :
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• Set minimum password length  which can be between 6 to 16 characters.

Note:  Enabling this option or changing the value expires all passwords. Users will be required to
change their password on the next login. By default, it is set to eight characters.

• Set enforce password history reflects the number of unique passwords the users has to change
before an old password can be reused. This can be set between 1 to 20 and by default is set to 1.

Expiration Settings
Enabling password expiration allows you to limit the length of time that a password may be used. When
a user logs in with a password that has not been changed in the required number of days, he/she will be
required to change their password before accessing the site.

To enable password expiration, select the option Expire user passwords when they are ... days old and
type a number of days.

Note:  To immediately expire all passwords without changing the other password preferences, click
Expire all passwords now in the top right of the page.

Consecutive Failed Logins
If there are Consecutive Failed Logins, you can select the option Block authentication after __ failed
consecutive login attempts or you can choose to Never block authentication after failed login
attempts.

Digital Signature
• Enable the option Require password for Approvals/Rejections, if you want to force users to

provide their passwords whenever they approve or reject a page or document in WebCenter. Admin
users can also set additional options like

• Prompt for password : This is the default option. When this option is chosen, only the password
has to be provided for approval or rejection.

• Prompt for username and password: When this option is chosen, both the User name and
password has to be provided.

• Prompt for username and password once, afterward only prompt for password: When this
option is chosen, user name has to be provided in the first instance and thereafter only the
password has to be provided.

• Enable the option Allow alternative passwords to be used for Approval/ Rejections and Tasks,
in case the users need another level of authentication other than the WebCenter password
authentication.

• You can choose Block browser auto complete on password confirmation to ensure passwords are
not stored for any users in WebCenter.

Note:  It is applied to both the login page and also when the user does re-authorization for
Approvals and Task completion.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.
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3.4.3.  Security Preferences

Use the Security preferences if you want to tighten the security in WebCenter.

By default, all the actions are allowed unless mentioned otherwise in the explanation. Deselect them if
you do not want any user to perform these actions.

• Approval

• Allow Approval outside the Viewer option allows approval only in the HTML Viewer and the
approval option is disabled otherwise.

• Allow Force Approval By and

• Allow Force Rejection By : Both these options have the following drop down to choose from:

• PM, Administrators and Approval Master
• PM and Administrators
• Approval Master

• Allow Conditional Approval option in Approval setup allows a conditional approval option in the
approval setup. When you do not want to allow conditional approval in approval setup, simply
disable this option. Only the Admin can set this system-wide option. When this is disabled, the
allow conditional approval option will not be available for the users while setting up approval on
documents, projects or folders.

Note:  Enabling or disabling this option will not influence the approval cycles that are already
existing or started.

• Approved Documents

• Allow removing Documents with Approval actions option lets Project Managers or Project
members with the Delete right to delete documents that have already been approved /rejected /
commented by at least one person or group.

• Allow changing Attributes of approved documents option lets Project Managers or Project
members with the Change Properties right to edit the attributes of already approved
documents.

• Attributes

• Allow non-Administrators to change the Attribute Category of Projects/Documents option
allows Admin users to restrict other users from changing the Attribute Category of a Project or
Document. (By default, this option is enabled)

• Allow importing from/exporting to JDF on Attributes page option allows Admin users to
restrict the importing or exporting of Attributes to JDF. (By default, this option is enabled)

• Inactive Projects

• Allow changing Attributes of inactive projects lets Project Managers of the respective project
or the Admin user to edit the attributes of inactive projects (projects with the Non Active,
Completed, On Hold or Canceled status).

• Allow changing members of inactive projects lets the Project Managers and Admin users to
edit the members' list for inactive projects.
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• Allow Document operations on inactive projects lets the project members with the Change
Properties right to edit documents in inactive projects.

When this is selected, project members can:

1. download documents (the project history is updated in that case),
2. view the document
3. see a document history or the project history
4. copy documents to other projects (but not within the same project).
5. annotate documents.

But cannot:

1. upload documents to the project,
2. start an approval cycle or do approval operations on documents,
3. move documents,
4. delete documents,

Note:  Administrators and the Project Manager for the inactive project can perform all document-
related actions.

• Discussions

• Allow removing Discussions and Discussion Messages

• Archived Projects

• Allow non-administrators to see Archived Projects

• History Require adding a change comment.

• Email Notifications and Download Link

• Allow Project Members with Download permission to e-mail a link for non-authenticated
download of a document, allows Project Managers and members of a project with Download
permissions to send a download link for a file within their project to non-WebCenter users.

• Allow large Document preview (approval e-mail notifications) adds a preview of the graphics
and CAD documents in the approval related notification emails.

• Allow non-authenticated download of Documents (approval e-mail notifications) adds a
Download Document link to the default approval emails generated by WebCenter.

• This link will only be valid for a certain number of days (enter that number in the The download
link will be valid for ... days field). The default value is 14 days.

Note:

• By default, this option is deselected.
• If you deselect this option after non-authenticated download links have been sent, these

download links will become invalid.
• When a non-WebCenter user clicks a link that is invalid, expired or tampered with (for example if

the URL was changed), the user will see a web page stating that the link is invalid.
• Changing the link validity (number of days) will only apply to new links.

• Forward Link- Registered Users

• Allow sharing Viewer Link allows sharing of link from the Viewer or Document Action menu, to
the users already available in WebCenter.
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• Allow Forward Approval option in Approval setup allows sharing of link for Approval in the
Approval Setup (Project or Folder or Document ), to the users who are already available in
WebCenter.

• Allow Forward to  choosing one of the options enables the approver(s) to share the document
with

• Any Visible user(s) means any user irrespective being present in the role or groups or within
the project.

• User(s) in the same project means restricted to the users present in the project as an
individual member or in a Role or in a Group within the same project.

• User(s) in the same Approval Scope means can forward to anyone within the same Group or
Role as the forwarding user.

• Forward Link - Unregistered Users

• Allow sharing Viewer Link allows sharing of link from the Viewer or Document Action menu, to
any unregistered user.

• Allow Forward Approval option in Approval setup allows sharing of link for approval to
unregistered users from Project or Folder or Document.

You can commit the changes made in this page using the Save button.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.4.4.  Document Type Preferences

Document Types
The Document Types page controls the kind of files WebCenter supports. The document types you
enable here are available for selection:

• When uploading a new file.
• In the Search for field when searching for documents.

You can edit the Document Type preferences inPreferences > Document Types.

To enable or disable a specific Document Type, check or uncheck the option in the Enable column.
Click Save to confirm.

Note:

If you disable a document type and you already have documents of that type in WebCenter, they can
still be found by selecting All in the Search for field when searching.

Document Details pages for those document types will still be available, and the documents can still be
downloaded and have new versions uploaded.
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Other Preferences
On this page you can control the system wide settings for Automatic Document Naming, Default
Attribute Category and Start Task for new Documents/Versions. You can either choose None or choose
a different value.

Note:

These settings are found in each project and template on the Document Creation page where you can
specify:

• None
• Default (using the system wide settings)
• Custom (defining project/template wide settings)

For each Document Type, you can set up:

• Automatic Document Name

Note:  Optionally, you can enable the general option: Enable File Extension Specific Counter. This
will make sure that you have different counters for different types of documents.

• Default Attribute Category

You can setup a task to start automatically when you upload a specific file type as a new document or a
new version by enabling the following options:

• Start task for new Documents
• Start task for new Versions (new version of)

To selectively apply the above settings to documents in blank projects, you can enable or disable the
options (for all document types):

• Apply Automatic Naming to Documents in Blank Projects
• Apply Default Attribute Categories to Documents in Blank Projects
• Apply Default Start Task options to new Documents in Blank Projects
• Apply Default Start Task options to new Versions in Blank Projects

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

Find and Unlock Locked Documents
Locked documents are documents that users have downloaded and are working on, and want to flag to
prevent others from working on them.

The Admin user (or any member of the Admins group) can find locked documents belonging to all users
and unlock them so that others may work on them without receiving warnings that they are locked.

This is particularly useful for freeing up documents that have been locked by users who are absent for
longer periods of time, or who have left the project entirely.

1. Click Admin > Project Management > Find Locked Documents.
2. Either filter for users by entering (part of) their last name in the Search users by last name field, or

click Go right away to see all locked documents.
3. Select the document(s) to unlock by selecting the corresponding boxes.
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4. Click Unlock checked items .

3.4.5.  Notifications Preferences

The Notifications page allows you to specify exactly which events in WebCenter should trigger an e-
mail notification to the users involved.

For every event or action in WebCenter, you can determine whether it:

• is logged in the project history (select Include in Project History).

• triggers an e-mail notification to:

• the Project Manager only (select Manager),

• all the members involved with the event (select Involved People),

Tip:  Click on Involved People to see a list of involved people for each event.

• all the project members (select Members).

You can also set up WebCenter to Send a reminder to the assignee or an approver when a Task or an
Approval is overdue and Repeat the reminder every x days until the Task or Approval is finished.

To limit the number of overdue reminders, you can set the system to only send reminders for Started
tasks or Tasks that can be completed (for example, for tasks having a predecessor needing to be
completed before they can be started).

Those options are available when Send a reminder... is selected.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.4.6.  Menus

The Menus preferences allow you to define what users can see by customizing the WebCenter menus.
For example, you can remove certain menus for some users, so they have a simpler user interface to
work with (they only see the menus they need to use).

You can assign custom menus to users and / or companies (see Edit a User on page 275 and Edit a
Company on page 265).

The Menus page contains the Default menu, and any custom menu you have already created.

Note:

You cannot edit or delete the Default menu, but you can use it as a basis for creating custom menus.

From here, you can create/update a custom menu either through the WebCenter user interface or using
XML. You can also delete a custom menu.

System History Logs
All Menu related events like
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• Menu Created

• Menu Deleted and

• Menu Changed

are recorded and stored in System History. Read this page on how to access the records.

Create a Custom Menu through the WebCenter User Interface
You can create a custom menu for each category of users, to make it more convenient for them.

You will need to:

1. Determine which menus a particular group of users needs, and which menus they don't need.
2. On the Admin > Preferences > Menus page, click Add Menu.
3. Create your custom menu.

Note:  If you do not have Task Management License, the Task related items will show the following
warning:
 

 

4. Assign the menu to the user, group or company you created it for.
5. Log in to WebCenter as one of the users to which you gave the custom menu, and check whether

the menu works.

Create a Custom Menu

1. On the Admin > Preferences > Menus page, click Add Menu.
2. On the Add Menu page, enter a Menu Name and Menu Description for your new menu.
3. Click the type of menu you want to customize: Main Menu, Project Details or Document Details.

You are starting with a copy of the Default Menu.
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On the left hand side, you can see the Menu Gallery (1) containing the default menu items in bold,
and the default sub menu items under them.

On the right side, you can see the Menu Builder Canvas (2) (which is a graphical representation of
the menu). This reflects any changes you make.

At the bottom (3), you can see and edit the details of the menu or sub menu item currently selected.

At the top (4), there is a menu to switch between different types of pages. The toggle on the left
allows you to switch between Menus and Actions.

4. Edit the menu as desired:

• Add a Default (Sub) Menu Item on page 109,
• Add a Custom (Sub) Menu Item on page 112,
• Remove a (Sub) Menu Item on page 115.

Tip:  You can also re-order the menus, or the sub menus within a menu, by drag-and-dropping them
on the Menu Builder Canvas. You cannot drag-and-drop a sub menu to a different menu though.

5. Click Save at the bottom of the page.
6. When you are done editing your custom menu, you can click Return to go back to the Menus page.

Add a Default (Sub) Menu Item

To add a default menu or sub menu item:

1. Drag it from the Menu Gallery into the Menu Builder Canvas.
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Note:

You can add the same sub menu item to different menus on the Menu Builder Canvas, but you
cannot add the same sub menu item twice to the same menu, or add the same menu twice to the
Menu Builder Canvas.

To quickly see whether a (sub) menu item is already used in your custom menu, you can select it in
the Menu Gallery: this highlights where it is used on the Menu Builder Canvas.

Tip:  After making a change, you will see that the Default Menu label above the Menu Gallery
becomes Custom Menu. You will also see a Revert Menu link under it. Click this link if you want to
cancel all your changes and go back to an unedited copy of the default menu.

2. In the Edit Menu area at the bottom, you can change the properties of your (sub) menu:
a) To define what the (sub) menu is called:

• If you don't want to translate the (sub) menu (it will have the same name in all languages):

1. Choose Simple as Label Type.
2. In Label, enter the name to give your (sub) menu.

• If you want to define a new name in different languages:

1. Choose New Localized as Label Type.
2. In Language Tag, enter a new language tag to associate to that menu name in all

languages (this language tag is how WebCenter refers to that menu name internally. It
must be unique).

3. In the dialog that opens at right, enter the translations of that menu name in all your
WebCenter languages. You need to enter at least the English name.

Note:

Make sure your customizationConfig.xml file contains language tags for all the
languages you use here (see Customize the Language Files on page 1061).

If this is the case, your translations will automatically be added to your custom language
files. If you didn't have a custom language file for one or more languages in which you add
a translation here, these files will be created automatically.

Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a
Simple Label (it will be shown as it is for all languages).

• If you want to use an existing WebCenter string (piece of user interface text) and its
translations as menu name:

1. Choose Existing Localized as Label Type.
2. In Language Tag, enter the language tag that is associated with the string you want to

use in your language files (in your custom language files if you have any, otherwise in your
default language files).

Tip:  When you start typing a language tag, the Language Tag field shows all language
tags starting with the characters you typed; you can select the desired one in the list.
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3. The dialog that opens at right shows the translations of that string in all your WebCenter
languages.

Note:  You can edit those translations (click Edit and enter the new translations), but then
they will be changed on every WebCenter page that uses that string.

b) To define who can see it:

Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of
the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You
can see this example when hovering on the field.

 

 
c) To define where a user goes to when clicking it:

• If you want the (sub) menu to link to a specific page (within WebCenter or external):

1. In URL Type, select Provide URL.
2. In URL, enter or paste the URL of the page to link to.

• If you want it to show the results of a (global) saved search:

1. In URL Type, select Saved Search.
2. In Saved Search, select the global saved search you want to link to.
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• If you want it to use it as a shortcut to create a Project with a specific characteristic:

1. In URL Type, select Create Project with Characteristic.
2. In Characteristics, select the characteristic you want to use for the Project.

• If you want it to use it as a shortcut to create a Project from a specific template:

1. In URL Type, select Create Project with Template.
2. In Project Template, select the template you want to use for the Project.

• If you want it to show a list of Projects that have a specific characteristic

• 1. In URL Type, select Project List with Characteristic.
2. In Characteristics, select the characteristic of the Projects you want to show.

• If you want the (sub) menu to show a Dashboard

• In URL Type, select Dashboard.

• In Dashboard, select the dashboard from the drop down or Create New Dashboard

Note:  You can only select a Parent Menu when creating a new (sub) menu, not when editing an
existing one.

3. Click Save at the bottom of the page.

Add a Custom (Sub) Menu Item

1. On the Menu Builder Canvas, click where you want to add your sub menu (if you want to add a top-
level menu, you can click anywhere on the canvas).

2. In the Edit Menu area at the bottom, click Add Custom Menu.
3. Still in the Edit Menu area, define the properties of your (sub) menu:

a) To define what the (sub) menu is called:

• If you don't want to translate the (sub) menu (it will have the same name in all languages):

1. Choose Simple as Label Type.
2. In Label, enter the name to give your (sub) menu.

• If you want to define a new name in different languages:

1. Choose New Localized as Label Type.
2. In Language Tag, enter a new language tag to associate to that menu name in all

languages (this language tag is how WebCenter refers to that menu name internally. It
must be unique).

3. In the dialog that opens at right, enter the translations of that menu name in all your
WebCenter languages. You need to enter at least the English name.
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Note:

Make sure your customizationConfig.xml file contains language tags for all the
languages you use here (see Customize the Language Files on page 1061).

If this is the case, your translations will automatically be added to your custom language
files. If you didn't have a custom language file for one or more languages in which you add
a translation here, these files will be created automatically.

Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a
Simple Label (it will be shown as it is for all languages).

• If you want to use an existing WebCenter string (piece of user interface text) and its
translations as menu name:

1. Choose Existing Localized as Label Type.
2. In Language Tag, enter the language tag that is associated with the string you want to

use in your language files (in your custom language files if you have any, otherwise in your
default language files).

Tip:  When you start typing a language tag, the Language Tag field shows all language
tags starting with the characters you typed; you can select the desired one in the list.

3. The dialog that opens at right shows the translations of that string in all your WebCenter
languages.

Note:  You can edit those translations (click Edit and enter the new translations), but then
they will be changed on every WebCenter page that uses that string.

b) To define who can see it:

Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of
the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You
can see this example when hovering on the field.
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c) To define where a user goes to when clicking it:

• If you want the (sub) menu to link to a specific page (within WebCenter or external):

1. In URL Type, select Provide URL.
2. In URL, enter or paste the URL of the page to link to.

• If you want it to show the results of a (global) saved search:

1. In URL Type, select Saved Search.
2. In Saved Search, select the global saved search you want to link to.

• If you want it to use it as a shortcut to create a Project with a specific characteristic:

1. In URL Type, select Create Project with Characteristic.
2. In Characteristics, select the characteristic you want to use for the Project.

• If you want it to use it as a shortcut to create a Project from a specific template:

1. In URL Type, select Create Project with Template.
2. In Project Template, select the template you want to use for the Project.

• If you want it to show a list of Projects that have a specific characteristic

• 1. In URL Type, select Project List with Characteristic.
2. In Characteristics, select the characteristic of the Projects you want to show.
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• If you want the (sub) menu to show a Dashboard

• In URL Type, select Dashboard.

• In Dashboard, select the dashboard from the drop down or Create New Dashboard
d) To define where to put it in the menu structure:

• If you want this menu item to be a top-level menu, select Top Menu in Parent Menu. This will
place it at the right of the Menu Builder Canvas, after all the other menus.

Tip:  You can re-order the menus by drag-and-dropping them.

• If you want it to be under an existing menu item, select this existing menu item in Parent
Menu.

Tip:  You can also re-order the sub-menus within a menu by drag-and-dropping them.

Note:  You can only select a Parent Menu when creating a new (sub) menu, not when editing an
existing one.

Click Add when you are done.
4. Click Save at the bottom of the page.

Remove a (Sub) Menu Item

1. To remove a menu or sub menu item from your menu, select it in the Menu Builder Canvas and click
the grey cross  beside it.

2. Click Save at the bottom of the page.

Custom Actions
Just like custom Menus, you can customize Action buttons. This feature allows you to remove and re-
arrange default Actions for different (groups of) Users. Also, you can add new custom Actions ( such as
a JavaScript, Create Task, Start Workflow etc.) with custom icons.

There are different types of Actions such as:

• in a table header
• in the header of a Project or Document
• at the top right of pages
• and inside tables (icon-only)

Just like customizing Menu items, you can add or remove them, set a Label and Visibility and modify
their display order. You can also specify:

• Action Type
• Priority
• Selection
• Rendering
• Icon
• Icon Color
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Note:  The available settings depend on the Type of Action that is being customized.

Custom Actions in Different Locations

In the Menu Builder, select Actions to customize them. Menus and Actions. Once Actions is enabled,
different types of pages become available in the menu:

• Project Lists
• Project Details
• Document Details
• Search
• Cart
• My Work

Under every page type, the individual pages or sections that can be customized are listed. Here you can
find an overview of the meaning of each of these different sections:

Project Lists
You can customize the Actions displayed in the table header of the following pages: Favorite Projects,
Projects I am invited to, Projects I Manage, and Projects.

For each of the pages you can add or remove Header Actions and Table Actions. The Header Actions
are the buttons displayed top right, like Create New Project in the example below. The Table Actions
are the buttons listed in the table header, such as Add to Favorites and Add to Cart in this example.
 

 

Project Details
In this section Project Detail type pages and sections are listed. The Project Header has Left Actions
and Top Actions. The Top Actions are not used by default, but allow you to move (part of) the buttons
on the left to the top right of the page.
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Project Documents (Table) and Project Bill of Materials (Table) determine the Actions in the table
headers on the Project Details Documents and BOM pages.

 

 

Project Documents (Document) and Project Bill of Materials (Document) define the Action buttons that
are displayed when you hover over individual Documents listed (typically compact icon-only buttons).

 

 

Document Details
For now, this item only contains the Document Header. It works in a similar way as the Project Header
with Left Actions by default, and optional Top Actions. Note that some of the available Actions still
depend on Document Type. For example, the Run as Standard Action will only be shown for CAD Design
files.

 

 

Search
It is possible to customize the table header Actions for both Project and Document Search Results.

 

 

For Document Search Results, Action buttons can also be customized. In case this is already done in
the Saved Search setup, WebCenter will combine the two setups. For example, if the Download button
is present in both, it is displayed, if it is not present in one of them, it is not shown.
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For Search, it is possible to add an extra filter in individual Saved Searches based on Tag values defined
in the Action configuration. See Action Settings on page 119 for more details.

Cart
The Cart Projects and Document pages have table header Actions which can be customized.

 

 

My Work
On the My Work page, it is possible to customize the table header Actions for the My Approvals section.
The individual Document Actions can be customized for: My Approvals, My Recently Submitted
Approvals, and Approvals to Follow Up.
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Action Settings

Depending on the Action type and location, following settings may be available:

Priority
Priority determines if and how the Action button is displayed, there are a few options:

• Primary (always visible) - this type of button is always visible and has the primary color selected in
the Customization (by default a dark blue/grey shade).

• Secondary (always visible) - this button is similar to the primary button, but uses the default
button color selected in the Customization (by default: white).

• Default (visible if space available) - this button is similar to the secondary button, but is only
displayed if there is enough room, if not, the button is listed in a More dropdown menu allowing for
optimal use of available space.

• Available (always in "More") - this option is always displayed in the More dropdown menu.

Selection
The Selection setting determines when the button becomes available. You can set it to No selection
required if it is not needed to select anything to perform the Action, if one or more items are required,
select one of the other options (for example: to delete a Document, you need to select at least one
item).

Rendering and Icon
The Rendering setting can be used to determine whether to show only an icon, only the label, or both.
At the top of the settings panel, you can see a preview of your button.

 

 

In the Icon dropdown you can find a number of icons to choose from. It is not possible to add any
additional icons, but new icons will be added in future versions of WebCenter. Use the Color dropdown
to select one of the standard colors for your icon.

Tag
The Tag field is only available for custom Actions in Search. For Search, it is possible to add an extra
filter in individual Saved Searches based on Tag values defined in the Action configuration.

When the Custom Actions setting in the Search Layout Options of your Saved Search is enabled,
tags can be entered separated by a comma, by default there is a "default" tag. A * matches all tags.
When the checkbox is disabled, no custom Actions buttons will be shown for the Saved Search. When
the checkbox is enabled, all custom Actions which do not have a “tag” will be shown as well as all the
custom Actions which have one of the tags mentioned in the input field.
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Task Settings
For Workflow and Create Task buttons, several settings are available such as Task Type, Start Task
and which fields to show. For more details, see: Custom Action Types on page 120.

Custom Action Types

With the introduction of the customizable Action buttons, you can not only rearrange and remove the
regular Actions, but also add your own custom Actions. Following types are available in the gallery:

JavaScript
The custom JavaScript button has an additional JavaScript field (mandatory) where you may copy/
paste your own custom code.

It is possible to use fixed variables to reference WebCenter Projects or Documents in this JavaScript
code. These variables can be used for example when creating buttons that redirect to specific Project
or Document Details pages. An overview:

Variable Type How to use

selectedIDs Array If a Project list or Document list is available in the action context, the IDs
of the corresponding items (for Documents, this is the Document version
ID) is available in the variable “selectedIDs”.

projectID String If a single Project is available in the action context, the ID of this Project is
available in the variable “projectID”.

docVersionID String If a single document is available in the action context, the document
version ID of this document is available in the variable “docVersionID”.

menuFile String Where possible, the current Menu file selection (controlling the display of
the primary WebCenter Menu) is available in the variable “menuFile”.

Note:  It is not guaranteed that JavaScript segments relying on other parts of the browser page DOM or
detailed implementation of WebCenter pages will be supported in future versions.

Note:  Using other (undocumented) variables is not supported and highly discouraged.

Start Workflow
The custom Start Workflow button allows you to select a Workflow Task Type to launch upon clicking
the button. Any selected Documents will be added to the Workflow. In a Project context, it is possible to
either launch one Workflow per Project or one per selected Document using the Options setting.

Create Task
Using the Create Task custom Action button, it is possible to immediately create a new Task from the
selected Task Type. Use the Start Task options to either immediately start the Task, or at a later point
in time.

The Show setting allows you to enable/disable different fields on the Create New Task page. This
setting allows you to hide unwanted fields and elements from the page and reduce clutter. Disable
all checkboxes to immediately go to the Task Execution page or create the Task. The After Creation
setting determines whether the Task Execution page is displayed or not.
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If all buttons are disabled, and enough information is defined in the Action to create the Task, it is
possible to create a Task without any additional user input needed and (optionally) redirect to the Task
Execution page for supplying, for example, Task Specifications to the created Task (or Workflow).

Assisted QA Tool
This custom Action Type is available in all action contexts with Document Lists.

• Project Documents (Table)
• Project Bill of Materials (Table)
• Document Search Results (Table)
• Cart Documents
• My Approvals (Table)

To configure the selected Action button for Assisted QA, specific properties are to be updated.

Assisted QA Tool: (Mandatory) Select the QA Tool that you want to open, when the icon is selected in
the menu. If more than one QA tool is configured, then the list of all the available QA tools are viewable
in the drop down.

How to Create a Custom Action Button
Follow the steps below to create a custom Action button:

1. In your custom Menu, use the toggle top left to switch to Actions.
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2. Select the page/section you would like to customize.
3. Select the Action type you would like to add from the Action Gallery and drop it into the location

where you want to show it.
4. Make sure to select your Action and inspect the settings in the table below it. You can now change

settings such as Label, Visibility, Rendering, etc. A preview of your button is displayed in the header
of the settings panel. Also see: Action Settings on page 119.

5. Once your are done, save your Menu.

Note:  To see the Menu changes in effect, any User assigned this particular Menu needs to logout
and login.

Update a Custom Menu through the WebCenter User Interface

Note:  You cannot edit the Default menu.

1. On the Admin > Preferences > Menus page, click the name of the menu you want to update.
2. On the Edit Menu page, edit your menu as desired (as explained in Create a Custom Menu on page

108).
3. Click Save at the bottom of the page when you are done editing the menu.

Create a Custom Project Details / Document Details Menu through the User
Interface
You can create a custom menu item for Project Details / Document Details page. For example, you can
create a menu item for adding a Saved Search using SmartNames.

You can also specify the visibility of this menu item for particular groups or for certain types of
projects.

1. On the Admin > Preferences > Menus page, click Add Menu.
2. On the Add Menu page, enter a Menu Name and Menu Description for your new menu.
3. Click the type of menu you want to customize: Project Details or Document Details.

In the menu builder, you will see all the menu items of a default Project Details or Document Details
menu.

On the left hand side, you can see the Menu Gallery containing the default menu items in bold, and
the default sub menu items under them.

On the right side, you can see the Menu Builder Canvas (which is a graphical representation of the
menu). This reflects any changes you make.

At the bottom, you can see and edit the details of the menu or sub menu item currently selected.
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4. Edit the menu item. Select the URL Type as:

• Saved search if you are configuring a Saved Search as the menu item. Select your search from
the Saved search drop down list below.

• Attribute Category View to configure a menu item with a specific attribute category view.

Specify the Name as the attribute category view name.

Note:

The name entered here has to match the custom Attribute Category View name of the Attribute
Category (of the current Project or Document).

Your users can edit the attribute values and save them from this custom view.

Note:

From this Project Details attribute category view, the users cannot:

• change the attribute category.
• export or import the attribute category.

Read also Use Case: SmartName Search to find Related Projects on page 240.
5. Optionally:

You can assign a Project Details menu item for a certain group of Projects having a specific
Characteristic. This allows you to create menu items (for example, dedicated Saved Searches)
visible only in certain types of Projects.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics for
your custom menu items as well as the default ones.
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2. Create a Custom Project Details menu or select the default menu item to edit.
3. Select the specific Characteristic in the Project Visibility field. You can select this from the drop

down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.
6. Assign the menu to the user, group or company you created it for.

Create a Custom Menu Using XML
You can create a custom menu for each category of users, to make it more convenient for them.

Note:

Menus are XML files, so you can edit them using an XML editor (you can find various freeware XML
editors on the internet, for example XML Marker or Notepad++).

For more details on how to edit the XML files to create custom menus, you can read Create a Custom
Menu on page 1064 in the WebCenter Customization Guide.

You will need to:

1. Determine which menus a particular group of users needs, and which menus they don't need.
2. Download the default menu to use as a starting point (click the Download Menu link corresponding

to the Default menu, then save it to a file when it opens in your browser).
3. In an XML editor, remove the menu items that are not necessary for those users.

This allows you to simplify the WebCenter interface, especially for occasional users. For example,
you can create a menu that only contains My Work for approval users.

4. Add custom menu items, to link to the WebCenter pages of your choice.
This allows you to make the pages most used by your users more accessible. For example, you can
add menu items linking to saved searches, or to project creation from a specific project template.

5. When you are done editing the menu file, save it under a meaningful name.
6. Upload your custom menu:

a) click the Menu Upload button on the Menus page
b) on the Menu Upload page, browse to your XML file,
c) give your custom menu a Name and a Description,
d) click Upload.

7. Assign the menu to the user, group or company you created it for.
8. Log in to WebCenter as one of the users to which you gave the custom menu, and check whether

the menu works.

Update a Custom Menu Using XML
To update a menu you have created:

1. On the Menus page, click the Download Menu link corresponding to the menu to update.
2. Edit it in an XML editor (see the WebCenter Customization Guide).
3. On the Menus page, click the Menu Update link corresponding to the menu to update.
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4. On the Menu Update page:
a) browse to the XML file you edited,
b) change the menu's Name and / or Description if necessary,
c) click Update.
This updates your custom menu.

Note:  You cannot edit the Default menu.

Menu: Visibility Groups
You can decide the group visibility of a menu item present in the Main menu / Project Details /
Document Details page.

For example, you can create a Project details menu item with a custom Saved Search using
SmartNames and make it visible only to a particular group.

Follow the steps below:

• On the Admin > Preferences > Menus page, select the menu.
• Click the type of menu for which you want to edit the visibility: Main menu or Project Details or

Document Details.

At the bottom, you can see and edit the details of the item currently selected.
• Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of the
groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You can
see this example when hovering on the field.

Customize the Project Details Menu Using Characteristics
You can assign a Project Details menu item for a certain group of Projects having a specific
Characteristic. This allows you to create menu items (for example, dedicated Saved Searches) visible
only in certain types of Projects.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics for your
custom menu items as well as the default ones.

2. Create a Custom Project Details menu or select the default menu item to edit.
3. Select the specific Characteristic in the Project Visibility field. You can select this from the drop

down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.

Delete a Custom Menu
To delete a custom menu:

1. On the Menus page, click the Delete Menu link corresponding to the menu to delete.
2. Click OK in the confirmation dialog.
3. If your menu is assigned to users and / or companies, you need to assign another menu to them. In

the Menu Deletion page:
a) Select the new menu to assign to them.
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Note:  This will assign the same menu to all those users / companies. If you want them to
have different menus, you need to edit the users / companies individually from the Users or
Companies page.

b) Click Delete.

3.4.7.  My Work Preferences

The My Work preferences allow you to define what users can see on their My Work page.

Default and Custom My Work Pages
As an Admin, you can define a default My Work page, that will be available to all WebCenter users by
navigating to Preferences > My Work  > Default My Work Setup

You can also define custom My Work pages for specific users or companies, when editing that user or
company (see Create a User on page 273 and Create a New Company on page 264).

Users can then customize their personal My Work page to a certain extent, by adding or removing
predefined sections (using My Work > Edit My Work Setup).

Admin Users can define which sections are available for specific groups or user types.

In the My Work preferences, you can:

• create a new My Work section (to use in the default or custom My Work pages),

• change what the default My Work page looks like.

System History Logs
All My Work section related events like

• My Work section created

• My Work section deleted

• My Work section changed

are recorded and stored in System History. Read this page on how to access the records.

About My Work page
A My Work page can be customized using various blocks that are available.
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Default My Work Sections
WebCenter has the following default sections, that you can use in the default and custom My Work
pages:

This section... will show...

My Approvals a list of documents a user has to approve or
reject.

My Recently Submitted Approvals a list of documents a user has recently approved
or rejected.

My Approvals to Follow Up a list of documents for which a user is Approval
Master.

My Tasks a list of tasks assigned to a user
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This section... will show...

My Recently Handled Tasks a list of tasks a user has recently handled

My ToDo List shows Approvals and Tasks to be done by the user

Custom My Work Sections
You can create a My Work section from any html page. You can define which users will be able to see
and use the sections you create, and you can even specify the height the section will take in the page.
For details, see Custom My Work Section on page 128.

Custom My Work Section
To create a section to use in My Work pages, you need an html page, whose content will be shown in the
section.

1. Click Admin > Preferences > My Work. The My Work Sections page appears.
2. Click Create New My Work Section.
3. Give your new section a Name.
4. In the Type option, indicate if this section will show:

• a HTML page specifically designed for this purpose (Generic),

Note:  Please contact Esko's Professional Services if you require such a web page.

• a Saved Search (a search you have saved, see To Save a Search on page 562 for more
information),

• an External Web Page.

Note:  We recommend you do not add WebCenter pages as My Work sections.

5. If you have chosen to show a saved search, select the Saved Search to show.
6. If you have chosen to show an external web page, enter or paste its address in the External Web

Page field (for example: http://www.esko.com).

For saved searches and external web pages, the URL field is filled automatically by WebCenter.
7. If desired, you can change the height of the section.

To do this, add &h= followed by the desired height in pixels at the end of the URL. For example
iframe.jsp?url=http://www.esko.com&h=400 has a height of 400 pixels.

WebCenter calculates the width automatically.
8. In Scope, choose which type of users will be able to use this section in their My Work page:

• All Users,
• Administrators,
• Project Managers.

Note:  You can also change this for the default My Work sections.

9. You can use groups to further filter the users that will be able to see the section. In Role Groups,
choose either:

• All Users if you want all users of the type specified in Scope to be able to use the section,
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• Specific Groups if you want to restrict the section's visibility to specific groups (within that user
type).

In this case, select the groups which will able to use this section.
10. Click Create.

Edit the Default My Work Page
You can customize and setup My Work page for all the users. Admin users can access it from Admin  >
Preferences > My Work > Default My Work Setup.

You can drag and drop the various blocks from the dashboard builder drop-down in the right hand side.

Following options are available in the drop down:

• All: This option displays all the blocks that are available.

• My Work : All the available blocks of My Work Section are displayed. Default blocks available are

• Approvals to follow up Displays the list of Documents and their current Approval status for
which the current User is set as their Approval Master

• My Approvals Displays the list of Documents waiting for approval decision from the current user.

• My Recently Handled Tasks Displays Tasks that the current user has completed in a given time.

• My Tasks Displays the pending Tasks, waiting to be handled by the current User.

• My Todo list Displays a merged overview of all Task and Approvals for the current User.
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This block has the following configurable parameters which are all enabled by default:

• Show Tasks: Displays all the pending tasks.
• Show Approvals: Displays all the pending approvals.
• Categorize by Time: You can specify if the block should have categories by time or no

categories.
• Maximum Height: Specify in Pixels or in percentage and by default has no value.

Note:  My Work  section can only be added once to the Dashboard.

• Layout: You can drag the layout blocks to customize the look of the dashboard. This is similar
to the customizing your search results dashboard. Read more about layouts at Configuring the
Search Dashboard Layout and Blocks on page 247

• General

• Discussions Widget: You can add this to view the current discussions you are part of. You may
choose to display Project or Task or Document discussions or all the discussions. You can
enable Always show Mobile View to view discussions in a compact format.

• Rich Text Block: You can add a block of text and also display the translations of the text in the
languages of your choice.

• Counter: You can specify a Saved Search and the results of the search will be counted in the
Counter. Read more here Building a Search Based Counter on page 248

• Image Spinner: Read more about this block Image Spinner on page 253
• My Work (Custom)

This section contains all defined custom My Work Sections of the system.

Menu Options in My Work Page
You can perform actions in the My Work page using the menu options

• Undo / Redo: To perform Undo / Redo actions in the My Work page.

• Show simplified My Work page: Enable this toggle in the Edit My Work Setup to display the My Work
page with no links to Project and Document details page.

• Reset to Default: Admin users or the user can revert the My Work page to default settings by
clicking this button.

• Save: Any changes done will be saved.

Tip:  To make the page mobile friendly, define minimum widths on columns to ensure that the columns
will reflow to a new row and fit horizontally.

Edit My Work Page for a User
Admin user can set up a customized My Work dashboard to any user.

Note:  When a user has no custom setup he/she will see the company My Work setup or Default My
Work setup.

Set up a custom My Work setup for the user, follow the steps below:
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1. Click Admin > Users > My Work Setup tab.
2. Click on Setup Custom My Work to edit and configure a dashboard for the particular user.
3. You can customize the My Work dashboard as described here Edit the Default My Work Page on page

129
4. Click Save to make changes.

Similarly a customized My Work page can be set up for a Company's user. Read more about it here Set
up My Work page on page 267.

3.4.8.  Dashboard

Admin users can view the global list of dashboards by navigating from Preferences > Dashboards.
These dashboards can be used as:

• Menu Items
• Start Page
• Landing Page of a Project or Default landing page of all projects
• My Work

Create Dashboard
You can create a dashboard by clicking on Create Dashboard option. To know more about Dashboard
Configuration, read Dashboard Builder on page 132.

Note:  You can find five example dashboards in the list of dashboards. Use Save As option to make use
of these dashboards. Note that every time the database script are run the dashboards are overwritten.

Dashboard Functions
Dashboards can be created for either simply viewing some information or for editing the data that is
shown or to create a new project.

Import/Export of Global Dashboards
You can import or export one or selected dashboards from the list of Global Dashboard(s).

To export, select the dashboards and select Export. This generates an XML/Zip containing the full
configuration of the Dashboard that can be used to migrate the Dashboard configuration to another
WebCenter Instance.

To Import a dashboard, select Import from Admin > Preferences > Dashboards. Choose the XML file
containing the Dashboards and click Import..

View History
You can view the Dashboard Created, Dashboard Deleted and Dashboard Changed events when you
click on this option. You can filter based on the date of the event or the event itself or by the last name
of the user who made the change. History results can also be sorted in chronological order or by the
type of notification or the user last name.

Note:  Dashboard Changed event does not capture any changes made within the widgets in the
dashboard.
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Delete Dashboards
You can delete a dashboard by selecting from the list and clicking on Delete Dashboard(s) option.

System History Logs
All Dashboard related events like

• Dashboard Created
• Dashboard Deleted and
• Dashboard  Changed

are recorded and stored in System History. Read this page on how to access the records

Dashboard Builder

Dashboard Name
Dashboard Name is a mandatory field in the dashboard. Ensure that the name provided is unique.

Note:  If Dashboard is named WELCOME then it is loaded in the Welcome page and any dashboard
named CONTACT is loaded on the Contact page.

Context
You can create Dashboards in the context of where it appears, like

• Project
• Document
• Task/Approval
• My Work
• Unspecified

There is an option to change the context of the Dashboard that you are building. Based on the context
selected for the dashboard, the gallery is updated with different blocks.

Dashboard Functions
• Edit Form: Makes it possible to edit. Make sure to add a save button to be able to save the changes.
• View (default): Shows information about a Project or Document or Task.
• Creation Form:  Only available for Projects. You can build a form to create a project from Dashboard.

Styling and Layout
There are two layouts available in Dashboard, namely:

• Default where the blocks are shown in a list
• Scrollable Columns where they allow you to scroll every column separately

You can set the background color of the dashboard. All layout blocks have the Spacing and/or Padding
parameter, which allows you to create visually appealing dashboards.

Conditional Formatting
When the dashboards are created in Project, Task or Document context, the rendering can be
formatted using conditions. This works exactly similar to Search Results Formatting and can be read
here. Options available for conditional formatting depends upon the context of the dashboard.
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Note:  This option is not visible when the dashboard is created for unspecified context and in scrollable
columns.

Duplicate Blocks
Dashboard blocks can be easily duplicated in the dashboard builder by clicking on the duplicate icon in
the top-right of the block. This feature is useful, when you have a block that is already configured and a
similar block as the existing block has to be created.
 

 

Duplicating also works on all the layout blocks. When layout blocks are duplicated, all the blocks in that
particular layout block are duplicated. This allows for fast layout creation in the dashboard.

Drag and Drop
You can now easily configure the dashboard with simple drag and drop operations. Columns can also
be rearranged or new columns can also be created with drag and drop.

Dashboard Context Simulator
You can view the Dashboard for a selected Project, Document or Task with this option.
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In the Dashboard Context Simulator option when

• Project is selected, drop-down lists all the projects from which you can select the project.
• Document is selected, drop down list all the projects in the system from which you can select the

document.
• Task is selected, drop down list all the projects in the system from which you can select the task.

Note:  This option is not visible when the dashboard is created for unspecified context.

Bulk configuration of blocks
You can select multiple blocks and apply changes to them at once using this option. Select the blocks
by clicking on the selection icon in the block and perform Styling and Configuration actions once.
Options that can be configured may vary depending on the blocks chosen.

 

 

Delete Blocks

You can delete any block in the dashboard by clicking the (delete) icon on the right top corner of the
block and the block is removed from the dashboard.

Gallery Panel Actions
You can add gallery blocks into the dashboard by clicking on the +. You also have Undo and Redo action
in the panel along with save. You can select the ellipsis to view the Dashboard Settings or make a copy
of this dashboard using Save As option.
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You can view any dashboard when it is built using the preview  icon in the bottom left corner. In
the preview mode, you have the gear icon which returns back to the dashboard builder.

Dashboards Shortcuts
Dashboard Editor Keyboard Shortcuts

• Ctrl + s: Save the dashboard
• Ctrl + z: Undo
• Ctrl + y: Redo
• Ctrl + click: Multi select blocks
• Shift + click: Multi select blocks
• Delete/backspace: Remove all selected blocks
• Ctrl + g: Open the gallery. You can now directly start searching for blocks, press tab to select a block

in the gallery, and press enter to add the block to the top of the dashboard.
• Ctrl + e: Toggle between edit mode and preview mode

• Esc: Close the gallery

Dashboard Gallery
Gallery consists of all the blocks that can be added to make a dashboard. It is located in the left side on
the Dashboard configuration page. You can open the gallery by hovering on the +.

This lists all the available blocks and it varies upon the context of the dashboard created.

General
This comprises of the blocks which are available irrespective of the context of the Dashboard.

• Counter: You can specify a Saved Search and the results of the search will be counted in the
Counter.

• Dashboard Block: To reuse a configuration in different dashboards in the current dashboard.

Note:  Use this option sparingly, as this might slower the speed at which the dashboard is rendered.

• Discussions: To view the current discussions you are part of. You may choose to display Project or
Task or Document discussions or all the discussions.

• Image Spinner: Read more about this block Image Spinner on page 253
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• My ToDo feed: To show your Tasks and Approvals in a custom way based on the dashboard context.
For example, you can create a dashboard for Task and Approvals for Todo items or in a Project
dashboard to show pending tasks. Read More here.

• My Todo list Displays a merged overview of all Task and Approvals for the current User.

This block has the following configurable parameters which are all enabled by default:

• Show Tasks: Displays all the pending tasks.
• Show Approvals: Displays all the pending approvals.
• Categorize by Time: You can specify if the block should have categories by time or no

categories.
• Maximum Height: Specify in Pixels or in percentage and by default has no value.

• Rich Text Block: You can add a block of text and also display the translations of the text in the
languages of your choice.

• Viewer Block: You can add this block to view the viewable files in the Dashboard itself. Read more .
• Saved Search: To show a Saved Search where the context of the Dashboard is used to resolve the

smartnames of the Saved Search.
• Selection Details: To show a Dashboard for each selected item in the Search Results
• Text Content Block: Add this block shows a Text or Table (wcc or wtc) document from the

Packaging Content Module in a Document Dashboard. You can both view and edit the Text and Table
Content in the Text Content Block.

• Button Block : Add Button block when you want to link a button in the dashboard to an action. You
can read about the Button block here.

• Content Sheet Block: Enables you to easily compare the contents of an artwork with content sheet
or two versions of the Artwork. Read detailed information about Content Sheet here.

Layout
You can use combinations of list, left side panel, column layouts and collapsible section to present
your blocks in the dashboard. Drag and drop the Layout blocks into your canvas to create a interactive
dashboards. To Configure your layout blocks available in dashboards:

• Select List Layout for a vertical list of blocks and Column Layout for a horizontal arrangement.
Spacing between these blocks can be specified and Padding can be specified for each direction
independently.

• Select Left Side Panel Layout to present info in a left side Column Layout with an embedded List
layout. This pre-defined layout can be modified to suit your needs.

• Select Collapsible Section to present info which can also be hidden and expand one or more blocks
based on the requirements.

• Select Column Layout to display blocks in configurable columns. When the user adds a Column
Layout to the dashboard, the layout is preconfigured with 2 columns and padding can be specified
for each direction independently.

• Select Menu Layout to show your Dashboard content by linking to other dashboards or to other
blocks. Detailed information of Menu layout can be read here and you can read about how to use a
Menu layout to create a project here.

Context based blocks
Dashboard can be created for different contexts like Project, Document or Task and Approvals. There
is also an option to create Dashboards with no specified content called Unspecified. The blocks
available in the gallery show information based on the context selected for the dashboard. All the fields
which can be searched in a Project/Document/Task/Approval Search are available as separate blocks.
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It is possible to configure conditional formatting on these blocks which behaves the same as in Search.
Some of the blocks available are

• Thumbnail block: shows the thumbnail of the Project or Document
• Project Attributes, Document attributes, Task specifications: these blocks show a view of the

attributes category of the Project, Document or Task in read-only mode.
• Approval setup : shows the approval setup of a Document. This block is available only for document

context.

Action Buttons
Document Actions:This block is available in Document and Task/Approval context.

Use this block to show Document Actions which are configured in the menu builder or in the block
itself. All actions which are available on Document Search Results are available in this block.

Task Actions: The block is available in Task/Approval context. You have two options namely:

• Execute Task: opens the Task Execution Page
• Go to Project: opens the Project

Approval Buttons This block is available only for Document and Task and Approval dashboards. You can
configure approve, reject and comment buttons.

Viewer Block

The Viewer block is available for Document and Task and Approval Dashboards.

You can configure the Viewer block with the following parameters:

• Height: Specify the height of the widget in px (pixel) or in % (percentage).

• Make Collapsible: Enable this to allow the block to be collapsible.

The viewer block shows basic text selection when the block is used in a search or in combination with a
saved search block.

For Graphic files a limited number of tools are available in the viewer:

• Zoom to fit
• Rotate View and
• Current page number/ total number of pages

For documents with multiple pages, the block shows the current page and the total number of pages.

You can navigate to the previous or next page with the back and forward buttons, when the text search
matches are on multiple pages.

Content Sheet Block
Content sheet block in Dashboard, enables to view and compare the content sheets easily. Content
Sheets are typically created as a collection of all the elements required within the artwork as
document references. You can read more about Product Content sheet here.

A Content Sheet block shows the selected document references in a predefined layout.

Content sheet block can be configured to show the referenced contents of a component or an artwork
document. The contents are shown in multiple tabs namely, Text, Table, Images, Symbol and Barcode
with default tab as Text content. In the Text Content tab, Master and Translation texts are shown along
with the Reference scope.
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Configuration of the Block

• Show All Document References
• Show All Reference Filters

Comparison of Different elements

You can compare any of the two different

• content sheets or
• versions of the same artworks or
• artworks which has the same attributes
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When you choose to compare a document with another document, the Delta column shows the status
whether the contents have Changed or Removed  or Added.

The differences are shown specifically in each of the content for changes as follows

• Text: Color coded highlights on the exact location of the change on the text content itself for each
of the language present.

• Table:Status to indicate a table has changed or not.

• Images: Change of values to the EXTERNAL_IMAGE_PATH are shown.

• Symbols: Change of values to the SYMBOL_NAME are shown.

• Barcode:Change of values to the BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are shown.

Note:  EXTERNAL_IMAGE_PATH , SYMBOL_NAME, BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are all hard coded attributes.

Apart from the changed and unchanged statuses, the content Removed from the Source document
and content Added to the source document are shown specifically in the each of the tabs.

Menu Layout
A new layout option has been introduced that makes dashboards more interactive and visually
appealing. User Interface can be designed to alternate between views within the same context, in the
same dashboard.
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Tabs can be added either to top or left or in the bottom. Above screen shots example shows tabs added
with all the three options.

Configuration of Menu Layout

The Menu Layout blocks configuration consists of buttons and a content block which are linked to each
other and it can be used to control the content of a block with buttons. The buttons are automatically
linked to the content block when adding the Menu Layout to the Dashboard. You can create Projects
within Menu layout. Read more about it here.

Note:  When there are multiple Menu layouts added within the same Dashboard, change the name of
the content blocks so that it is easier to recognize them in the configuration panel.

Button Block
Button block is available In the Dashboard Builder of a My Work, Search or Global Dashboard and shows
a button with a text and/or an icon.

Configuration of Button Block

This block is versatile and can be configured for various uses with the following parameters:

• Labels and Icons which are customizable.

• Link to: Specify where the button has to be linked to. Depending on the option linked, further
configuration options are shown. Buttons blocks can be linked to

• Dashboard : Choose from the existing Dashboards available in the drop down or create a new
dashboard. You have the option to show the configured Dashboard in the Current window or
New Browser Tab or Pop up or in Menu Layout.

• Saved Search:  Choose from the existing Global Saved searches available in the drop down and
you can further specify to open either in the same Window or in a New Browser tab.

• Create Project : Choose either a Project or Template available in the drop down, based on which
a new Project is created. See how to create a project in Dashboard using Create Project option.

• Download Document: You can create a link to a document, that can be downloaded from a
specific Project.

• URL where you can specify an URL to be opened either in the Current Window or a New browser
tab.

Styling options available for Button block
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This block can be customized with various styling options available like Background Color, Use
Contrast color for text or Custom Text Colors based on your preference.

Button blocks can be rendered either as Text or Icon or Icon and Text . Along with this you can also
choose the Alignment Border, Border Color, Size and Padding (slider bar) for the Button block.

The block itself can be made to render in various sizing options like small, medium, large or extra large
based on your requirements.

Button block can be used in multitude of ways and one them is detailed here.

How to Configure My ToDo feed

My ToDo feed has the following configurable parameters:

• Show Tasks/Approvals: These two parameters define the items that are visible in the list.

• Task Dashboard/Document Dashboard: The configured dashboards are used to show the entries
of the todo list. It is possible to select a different dashboard for tasks than for documents.

Note:  Use context specific information blocks to view your tasks and approvals along with Action
buttons to perform actions your Todo items.

• Padding: Spacing between the cards and the border/frame of the block can be set and adjusted

• Spacing: spacing between two cards can be set and adjusted. When you view this block in the
dashboard, you can perform the following actions

• Refresh: To update the information.

• Filter: To filter the items that are visible in the Block.

The Tasks and Documents that are shown in the My Todo Feed are the same as in the My Todo List
block.

Project Creation from Dashboard
Dashboards are more interactive to edit the data which can be saved and have forms where input
can be added. Project creation has been incorporated to enable easier collection of information with
specific action driven pages in Dashboard.

Admin users can now choose the Dashboard function as a Creation Form in the Project context. Then
an option is available to add a Save and Cancel button.

 

 

You can create customized Projects from an existing Project or a Template which are available in the
drop down. Or when no Project or Template is selected, a blank project is created.

Save and Cancel buttons can be formatted with various configuration parameters available for the
blocks.

Creating Project from Button Block
Here is an example of a Project created from Button block.
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You can configure a Button block to open a Dashboard and the Dashboard can be further configured to
open a project creation form as shown in the image below.
 

 

To use the Button with a Project Creation dashboard, follow the steps below.

1. Create a Dashboard with Project as Context.
2. Choose the Function as Creation Form.
3. Choose the Project or Template that you wish to create the Project from.
4. You can optionally choose to navigate to the new Project when it is created or open in the same

browser window.
5. Choose your Styling, Padding, Background color options for the Creation form
6. You can add the Document Sources from which document can be added for the project created.
7. Now create another Dashboard with any context that you need and choose the Button Block and link

it to the dashboard created earlier.
8. Save the Dashboard.

Creating Projects from Menu Layout
Similarly in the Menu Layout, you can create a Dashboard as stated above. Select the Button block in
the Menu Layout (with Bottom or Top or Left option).

Below screenshot shows project created from Dashboard.
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Configuring list of Documents as Tables

Configure list of Documents as a Table
Dashboards can be configured and customized to show the list of Documents in different Table layouts
like List or Grid layouts. This functionality works only with Document Reference Attributes in Project
or Document contexts and with Documents and Document Reference Specifications in Tasks and
Approvals Context in Dashboards.

An Administrator user can configure a list of documents for any of the Project or Document or Task
information fields in dashboards as a table.

A Display Style option allows you to configure the list for the Information field as either a

• Simple Text: Shows only the name for the list of documents
• List Layout: Shows as table with the information shown in columns
• List Layout, with no headers: Shows as table with no headers
• Grid Layout, Thumbnail on Top: Shows list as blocks with thumbnails at the top
• Grid Layout, Thumbnail Left: Shows list as blocks with thumbnails to the left
• Card Layout: Shows the list as cards

When any option other than Simple Text is chosen for Display style, the below options are available.

• Configure Columns allows to configure the information in columns. Read in detail here
• Conditional Formatting allows you to set conditions based styles for display of the information.
• Configure Sources :allows you to configure Drop zones and Buttons for adding documents. Read in

detail here.
• More options open a popup where you can choose the layout options (similar to search results

Layout)

View and Edit Lists in Dashboard

Dashboards are enabled to show preconfigured lists ( like in Attribute Category page) and it can also be
made editable. This allows using the Dashboard as an input page with restricted values and also to save
the values from the dashboard.

Admin users can set this up in Dashboards with attributes that has list configured in Project or
Document or Task Dashboards where each of the attributes can be linked to a single list or column
combination.

To set up a list in Dashboard, follow all steps as provided here and add it to the configured attribute
category for the Project or Document or the Task that you wish to add the Dashboard.

Functionalities like distinct values, filtering of linked attributes, anomaly handling, and task
specifications are available in Dashboards as well.

Options available in the Configure List window like

• Allow other values
• Autoselect Matching Values when other values are filled out outside of Attributes page (e.g.

Workflow)

are also applied in Dashboards.

Project Dashboards setup with attributes that has lists configured, can be used as a landing page
to choose values from the dropdown in Projects, where the attribute category contains the same
attributes.
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Similarly with Tasks and Document Dashboards, the same attributes have to be present in the
Attribute Category of the Project, where the Task is executed or the Document that is present.

Note:  Excel based lists are not compatible with Dashboards

Document Sources for Dashboards

You can create specified areas in Dashboard that can be configured to drop the documents, like for
example for Project Creation. You can configure document sources for the field when the layout option
chosen is not Simple Text. You can either have a Drop Zone or a Button configured as a document
source. You can select one of the type of Document Source in the dropdown and add or delete the
document source.

You can configure the document sources in the Dashboard with the Configure Actions & Sources
option.

Live preview of the configuration of the Configure Sources are reflected at the top of the window in
the preview area.

Buttons

Buttons can be configured with one of the following ways given below.
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• Browse: Allows you to upload files from your system and you can specify the file extensions, along
with the Document Template and folder.

• Saved Search: Allows you to choose files from the Saved Search results where the name of the
Saved Search is shown in the pop up. Operations like Copy or Use by Reference are possible on the
document and you can specify the Document Template  and folder. When the saved search with
SmartNames are chosen, the SmartNames are resolved and rendered.

• Asset Management Connection: Allows you to select one of the configured asset management
connection from the Connection drop down and update the connection details like the Folder,
Popup Title, Button Label. Currently WebCenter and MediaBeacon connections are supported.

Note:  This option is available with advanced connect license only.

Drop Zones

Drop zones are designated locations in the Dashboard where you can add Documents to Projects or
Tasks  either from a Saved Search or by uploading the document. You can add a document from a
Saved Search or upload the document. The documents from the saved search can be dragged and
dropped into the Drop zone configured.

Note:  Document Sources option where you can create a Drop Zone or a Button are only available when
the Dashboard Function is set to Edit Form or Creation Form
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Drop zones can be presented with multiple versatile styling options in the dashboard. Extensive
Layout options, Spacing (Automatic/Compact/Wide), customizable label field, and the Icons can be
configured.

 

 

The added items can be shown as a table or the number of documents added can be shown in counter.

 

 

You can configure the Drop zone to add the document from either of the options below

• Saved Search: Documents from the saved search can be dragged and dropped into a drop zone
configured to create a new project. The dropped documents are copied to the Document list. You
can also specify the operations on the document namely whether it is copied or used by reference.
Apart from this, you can also specify the document template and the folder.

• Upload: Add the document from the system. You can specify the following parameters for the
uploaded documents namely allowed file extensions, Document Template or Folder.

If there are multiple dropzone sources configured, then the dropzone are showed next to each other.
For both types of sources, it is possible to configure a custom translatable label and the order of the
buttons/dropzones.

Inline Document Actions

The inline actions that can be performed on the document sources can be configured in this tab for a
document list block. Live preview is updated to reflect the changes done and most document actions
are available.
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Each document action is shown in a row and can be set to either Visible or Visible on hover.

Uploading a new version of the document

You can upload new versions of the documents to the editable dashboard blocks with a configurable
button, provided you have the Update permissions on the document.
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You can configure the document sources of the attribute dashboard block, either by

• adding the upload new version button to the document row (hover action) or
• in the dropzone

Unsaved changes on the previous version are also applied on the new Document Version.

Note:  Currently new version upload is not supported for page list documents and version comments is
required for all uploaded documents.

Remove

You can configure a remove button for the documents added. This button removes the document
from the document reference, but does not delete the document from the project. Similarly when the
remove button is used when uploading the document, it allows to cancel the ongoing upload of the new
version.

Configure Columns

You can configure the visible information of the table in the Configure Columns pop up window.
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You can order the columns by entering the value in the Order field and enter customized column names
in the Label field. You can also set visibility of the field as Available or Visible. Fields that are allowed to
be edited, have the Editable check box next to it.

Configuration field shows if any additional configuration is present for the specific column. You can
also add or delete a column.

3.5.  Reports

You can derive a Report of selected parameters of a document derived by querying the database. You
can produce Tables, Pie Chart and Bar Chart in these reports and output them in PDF, DOCX, XML,
XLS, CSV, TXT, RTF and HTML formats. This feature uses the Jasper Reporting engine to create these
reports. You can customize the terminology, look, logo’s and the parameters.

Use Reports to:

• calculate averages and compare actuals to targets (KPI’s).
• create charts, such as Bar Chart and Pie Chart.
• to create a general report and related sub-reports.

The report is created based on a report template. There are built-in reporting templates available to
admin users. However, you can upload custom reporting templates as a JRXML file or as a ZIP file. If
you would like to add supporting files such as images and stylesheets, you can create a ZIP with the
JRXML file, images and stylesheets.

Using WebCenter Reports, you have the:

• Ability to calculate averages and compare actuals to targets (KPI’s).
• Ability to create charts, such as Bar Chart and Pie Chart.
• Freedom on terminology, look, logo’s, amount of detail required to be displayed.
• Choice of report output to PDF, DOCX, XML, XLS, XLSX, CSV, TXT, RTF and HTML.
• Ability to create one PDF with a general report and iterate over a set of sub-reports

Note:

• You can create these reporting definition templates in iReport. Read more technical details about
this in: Custom Reporting.

• You need database access to derive these reports and if you are using WebCenter as a SaaS
customer, you cannot generate these reports yourself.

• If a report is generated for a template containing background image in the DOCX format, then the
output will not have the background image.

You can access these reporting templates in Admin > Preferences > Reports.

System History Logs
All Report related events like

• Report created

• Report deleted and

• Report changed
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are recorded and stored in System History. Read this page on how to access the records.

3.5.1.  Accessing WebCenter Reports

The WebCenter Reports feature can be accessed by an Admin or member of the Admin group.

1. Log in to WebCenter as an Admin user.
2. Click Admin > Preferences > Reports.
3. The Reports page appears with the list of available reports.

This page displays the report name, report actions, report description, last modified and the user
who uploaded the report (Creator). The Reports page also displays Upload Report, Download
Report, Update Report and Delete Report buttons.

Note:  The built-in reports cannot be deleted.

4. Click the desired report name to go to report details page, where you can run the report.

3.5.2.  Types of Reports Available

The WebCenter Reports comes with two default reports. The default reports have a typical WebCenter
look. However the report definitions can be downloaded and changed in iReport to a different look.

Note:  Reporting is a separate license in WebCenter. Without this license you can only run the default
reports.

The default reports provided are as follows:

• Approval Statistic (built-in) report: This report is on duration of approvals. This report has lots of
parameters to filter the report on customers, duration and influence on what is shown in the report
and how it is displayed.
 

 

• Task Management (built-in) report: This report is on the duration of tasks. This report comes
with many parameters, for example to filter on a task type (showing all CAD Design tasks and
disregarding all other tasks).
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• Attribute Category (Built In) Report: Built-in reports are available for Attribute Category in both
PDF and Excel formats.

By default, these reports are not enabled in the Project's or Document's Attributes page. To enable
built-in reports follow the below configuration:

1. Download one of the built-in the reports

• Sample Attribute Category Excel – built-in report template for XLSX format
• Sample Attribute Category PDF - built-in report template for PDF format

2. Upload a new report as Default Attribute Category Report. You can also rename the report in
the name of the attribute category for which report has to be generated.

Download the built-in report and upload new report as name Default Attribute Category Report or
name the report exactly as the Attribute Category in the required Project or Document for which
report is generated.

To get a specific project or document attribute category as a built-in report, upload the template
ZIP file with the report name same as the project or the document attribute category name. Report
name can also contain optional sux.

Example: If the attribute category name is – Doc Attr Category, then there can be multiple
reports with different names such as Doc Attr Category_PDF, Doc Attr Category_Excel, Doc Attr
Category_CSV.

Note:  To change the template, download the Jasper Report template, update using Jasper Studio
and upload back to WebCenter.

You can also create a custom report using iReport tool. To create a new custom report, you can start
from a blank template, use the template provided by Esko, or just modify the built-in reports. Upload
these to WebCenter and then let WebCenter run the report. One report design is typically used over and
over again, for example to create a weekly or monthly report.

Note:  To learn how to create such reports, read the CustomReport.doc document.
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3.5.3.  Configuring a Report

To configure a WebCenter Report:

1. Click on the desired report name link on the Reports page.
2. In the Reports Details page that appears, specify the Report parameters.

This can be very simple or very complex depending on the amount of parameters foreseen by the
report design. Most often, the time span on which to calculate the report is a parameter. But equally
so the report could accept a customer ID (a drop down of customers will be shown) or an option to
show more or less detail or what type of charts to use.

The mandatory fields (parameters) are marked by an *.
3. Under Report Output:

a. Click the Upload Report to Project check box, if you want to upload the generated report
directly to the required project folder. When it is not selected, the report is generated on the
User Interface.

b. Specify the report Document Name and output Format. By default PDF is the output format.

Note:  XHTML format is not available if the Upload Report to Project option is selected.

4. In Report is visible for groups, select or enter the name of the groups that can run this report. To
remove a selected group, click the minus sign in front of its name.

5. In case the jrxml defines projectId as a parameter (with uiTypeID set to PROJECT), an additional
Project Report checkbox appears on the report details page. In case this option is enabled, this
report will only be used as a project report.
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You can also set which roles in the project(s) can run this report (in addition to the groups you
defined). This way it is possible to create a report that can only be run by the CSR or the SALES
person but not by other people (for example suppliers and other external people).

In Report is visible for roles, select or enter the name of the roles that can run this report. To
remove a selected role, click the minus sign in front of its name.

6. Click the Save button, to save the parameters. The next time you want to run this report, you can
use the same parameters. If you want to run the same report with two sets of saved parameters you
need to upload the report definition twice.

3.5.4.  Running a Report

To run a WebCenter Report:

1. Click on the desired report name link on the Reports page.
2. In the Reports Details page that appears, specify the Report parameters.

This can be very simple or very complex depending on the amount of parameters foreseen by the
report design. Most often, the time span on which to calculate the report is a parameter. But equally
so the report could accept a customer ID (a drop down of customers will be shown) or an option to
show more or less detail or what type of charts to use.

The mandatory fields (parameters) are marked by an *.
3. Click the Run Now button. The report is generated as per your specification. The Report

Successfully created message appears in the Reports Details page.

Note:  It is recommended to run Find Lost Documents built in report during off peak hours, as it can
utilize lot of system resources.

Built In Reports
Built In reports are system reports which can be usually accessed only by Administrators.
Administrators can view the report but it is not possible to update, delete or download the built-in
reports.

To view the built in reports, navigate to Preferences > Reports. Click on the report name to view the
report details page. Administrators can modify the Report Name, Description and select Groups which
can be provided access to run the report manually.

Groups which has permissions assigned, can access the reports from Search  > Reports page.

Find Lost Documents Report
A lost document is a document in the project for which no files are found on the File Store. Either the
file has been removed from the File Store or the document is of the URL type.

The Administrators can run this report in the reports page by selecting the Find Lost Documents.

On running the report, the page displays an overview of Lost Documents. Number of lost documents
count is indicated at the top of the page.

Note:  Run this report during the off peak hours, as it utilizes a lot of system resources and may slow
down the WebCenter Application.
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The Lost Document report is displayed in a tabular form in which the following details of each
document is shown:

• Document Name
• Document ID
• Version ID
• Version Number
• File Number

The user can go to the Document Details page by clicking on a Document Name.

Document Project History Report
WebCenter has a built-in report for Project History Report. You can run this report from the Reports
and select Project History Report.

On execution, Search Projects History page is displayed with an overview of projects. Administrator
users can see all the projects, while the other users can see projects they manage only.

Search History Project is displayed in a list with a sequence number, along with

• Project Name
• Description
• Project Status
• Project Manager
• Creation Date
• Modification Date

To view a project history of any project, click the Project Name. You can filter the results on Manager
Last Name, Manager Group Name or Modified date or Project Status. You can also restrict the number
of records displayed in a page.

The order of the results can be changed by clicking on a column header in the results table or by
changing the Sort By option in the filter section. Select Print to print the report.

Sample Attribute Category Report
This is an built-in report that can be run by the admin users.

By running the report, you can download the list of all the attributes and its values along with the
document references. This report can be run for both project attribute category or document attribute
category.

There are two Sample Attribute Category built in reports based on the way it can be exported:

• Sample Attribute Category PDF : Best suited to get the reports in the pdf format along with
thumbnails for reference documents

• Sample Attribute Category Excel: Best suited to get the reports in sheets separately for each
document type

To generate this report for the first time:

1. Navigate to Reports  >  Sample Attribute Category (PDF / Excel).
2. Run Report page is opened.
3. You can select Upload Report to Project option and specify the project name, document name and

folder in which the report has to be uploaded.

The report is generated in the format selected.

How to get the Attributes Report in the Attributes Page
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Download Sample Attribute Category Excel/PDF (built-in) report from the Reports page. Upload it as
a new report with the name as Default Attribute Category Report to get the Attribute Report icon in
the Attributes page of all the documents and projects which has attribute category specified.

Note:  Attributes Reports can be accessed by any user based on the Reports permissions.

In case you want only specific Project/Document Attribute Category to get built-in report, upload
the template ZIP file with report name same as the Project/Document Attribute Category name. The
Report name can also contain optional sux.

This report will show the label of the Attributes as defined in the Create New Attribute page and also
the last modified date of the attribute. If SmartName or internationalization is used for the attributes,
or the attributes is of Document Reference type, then only the attribute names are shown.

Example : If the attribute category name is Attribute1, then the uploaded report should be named as
Attribute1XXX

Attributes page in the Project/ Document with the specified Attribute Category will have the
Attribute Report icon.

Note:  If you want to change the template of the report, then download the Jasper Report template.
Update the reports using Jasper Studio and upload back to WebCenter.

3.5.5.  Managing Reports

The Reports page also helps you in managing the existing reports. You can Download Report, Update
Report and Delete Report using the inline buttons.

Note:  The built-in reports cannot be deleted.

 

 

3.6.  CHILI

You can edit your documents online using WebCenter - CHILI Publish integration.

3.6.1.  Configure WebCenter-CHILI Server Connection

Administrator users can configure the CHILI server connection by navigating to Chili  > CHILI Setup .

In the Chili Setup page, the following fields must be specified:

• Name : Used to identify the CHILI setup
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• Address to the CHILI server URL example: http://chili01/CHILI/main.asmx

• CHILI Share example: \\chili01\chilishare

• CHILI Environment Name – name of the CHILI environment

• User login/ User Password – user login and password (defined within the CHILI environment)

• You can choose to select the following optional fields

• Use HTML5 Editor, to open the CHILI documents in HTML5 Editor.

• CHILI View in side by side Preview mode to open the side by side view (Document Attribute
Category and CHILI view side by side) from thumbnail. View in Preview Mode. When this option
is enabled,Show Content based side by side Preview option is visible to show PCM -optimized
view when enabled.

Users can also view the Attributes and the Chili document side by side in the Preview tab( which
can be customized ) and this option requires Packaging Content Management and Chili license.

• Trim leading and trailing spaces from text before applying to CHILI Variable to remove any
extra spaces present in the text

• Exit CHILI side by side Preview after saving a new version When this option is selected, the
CHILI Side-by-Side Preview is closed and return to the previous page on saving the CHILI
document as a new version.

Note:  Users can also view the Attributes and the Chili document side by side in the Preview
tab( which can be customized ) and this option requires Packaging Content Management and Chili
license.

On Save, the configuration is validated and stored in the WebCenter.

On the page, you also find a drop down Edit Alternative CHILI Setup: : Choose the CHILI setup from
the drop down of the configured CHILI setup instances. There is an additional option to Create New
Setup. You can setup multiple CHILI servers with this option and it is also possible to connect to the
same server with different settings.

Note:  This is required only if multiple CHILI servers are to be setup.

Chili Preview
You can preview the CHILI documents and edit its content when the  View in Preview mode is enabled
in the CHILI setup.

When you click on the thumbnail of any CHILI document, you can preview the chili document along
with all the referenced contents and attributes (optionally) for the document side by side with the CHILI
editor. Preview of the document is exited or reloaded based on the selection made for the Exit CHILI
side by side Preview after saving a new version option in the CHILI Setup configuration.

You can also show values of a pre-configured document dashboard in the content block.

Following are the the hardcoded dashboard names.

• CHILI_SIMPLE_ATTRIBUTES: To render the attributes of CHILI document
• CHILI_TEXT_DETAILS: To render additional text details
• CHILI_IMAGE_DETAILS: To render image details

Note:  This functionality is available with PCM license only.
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3.6.2.  Upload a CHILI Package

In the Document Types page, a new type “CHILI” will be added. This document type will only be visible if
the right license is purchased.

A CHILI Package has the .zip extension. When uploading a zip file in the single document upload page,
you will now get the possibility to select “CHILI Package” as Document Type. If you upload the CHILI
package with the extension .chp, it will be automatically recognized as a CHILI package, without having
to select it. However, this is not an ocial CHILI extension. It is a way to make the upload go easier (e.g.
it can be used for multiple file upload).

3.6.3.  Locking behavior

When a user is editing a CHILI document in the editor, the document will be locked automatically. The
document can be unlocked only manually, by saving a new version or by just exiting the editor without
saving your changes as a draft. When the editor is opened in read-only mode, however, the document
will remain unlocked.

When a user has no editing rights and has no specific workspace assigned, the document will be
opened in read-only mode. The editor will also be opened in read-only mode when the document is
locked by another user or if it’s not the latest version of the document. In the read-only mode, the file
can still be viewed, but no changes can be made. The save buttons are not shown, but approval buttons
will still be shown to approver if an approval cycle is ongoing.

The CHILI administrator is able to set up a customized read-only view. WebCenter will look for a
workspace named “Read-Only” on the CHILI server. Only if that workspace is not found, the default
CHILI read-only mode will be loaded.

Note: Draft versions are saved as long as the document is locked. When the document is unlocked, the
draft version will be removed. To reset the document, the user can simply remove the lock and start the
editor again. To save the changes permanently, the user will have to save the document as new version.

3.6.4.  Download CHILI Documents

A user may want (or be allowed by the Administrator) to download different kinds of output of a CHILI
document. Some will want to download the original CHILI package or the CHILI XML, while others want
download a PDF file. An artwork creator will want the XML to update the master Illustrator document.

When the user wants to download a CHILI document, a page with the available formats will be shown.
Users can have different permissions for different download formats. The ‘CHILI Package’ format is the
default option in places where an explicit choice of a target Download Format is not available. If a user
has none of the available Download Formats enabled for CHILI document type, he will not be able to
download a CHILI document from within any Project.

The different download types are also supported in the SDK. A new parameter was introduced for the
DownloadDocument.jsp SDK call

downloadtype: Name of the download format to download. If it is not specified, the default download
type will be used.
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Example:

http://mywebcenter.mycompany.com/WebCenter_Inst/DownloadDocument.jsp?
username=myusername&password=YWJjZGVm&docversionid=00002_0000000018&downloadtype=PDF

Note:  When a document is being edited (has a draft version), the downloaded version will not contain
the changes of the draft.

Setup of different download types for a CHILI WCR Document

In order to maintain a highly secure environment – enabling/disabling CHILI Download Formats is only
available for an Administrator user and is done for individual User/Group at a single moment. User
settings can be derived from a sum of Groups Download settings for all the Groups that the User is a
member of.

When a new Download Type is defined on the system level it is initially disabled for all Users and Groups
in the system.

There are two levels of enabling or disabling CHILI download types. You can either do this system wide
or per user/group.

If you want to disable or enable a download type system wide, you can go to the page “Admin > CHILI >
CHILI Download Types”, where you have a checkbox with the available Download types. A default setup
will have three download types pre-installed which are all enabled by default:

• Chili Package
• CHILI XML
• PDF

For the PDF output, PDF Export Settings named 'Default' must be defined at the CHILI server. An
additional column is displayed at the 'CHILI download types' page with the name and availability check
(icon) of the PDF Export Settings at the CHILI server.

If you want to set it per user or group, go to the user or group section and click on the user/group you
want to give download rights. Then go to the download tab. You will see that the section CHILI Package
is added, where all download types that are enabled system wide can be enabled or disabled (disabled
by default) for that user or group.

For a user, if you click on “Use Group Permissions”, the CHILI download types are also updated with
those of the groups the user is in.

3.6.5.  Dynamically assign workspaces and constraints to CHILI Documents

CHILI workspaces can be assigned dynamically by matching workspace names with role names. When
a user is assigned to a role in the project the CHILI document is in, WebCenter will look if the CHILI
server has a workspace with the name of that role and assign that workspace upon loading the editor.
E.g. If the user has the roles “Approver and the CHILI server has a workspace “Approver”, the CHILI
editor will be opened in workspace “Approver”.

If no workspace was assigned to the user, and that user has edit rights, WebCenter will look for the
workspace name “Default” and assign it to the user. If the workspace “Default” was not found, the editor
will open in real-only mode. If a user has multiple workspace/constraint matches, the user will have to
select a workspace before the editor opens.
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Note: For linked documents, the available workspaces are accumulated.

3.6.6.  Loading Assets into the CHILI Editor

An asset is a WebCenter document that is uploaded in the project document library. At the Project/
Template > Configure > Document Templates page, an administrator user can select a project or a
template to serve as a document library.

For the CHILI document, documents from the document libraries of all projects the current document
version is linked to can be used as assets. The documents/folders will be filtered out by the WebCenter
security settings. In case of a project document library, the user must have download rights for the
document/folder, to be able to use it as an asset. There are no restrictions on using documents from a
template document library.

The external assets panel shows a tree structure, where each project/template represents a top level
folder. For each document/asset a thumbnail is shown.

To set this up, the CHILI administrator has to add an "External Assets" panel within the workspace and
leaves point the "Directory List URL" and "Asset List URL" to the WebCenter SDK with the following calls.

Directory List URL:

http(s)://<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDirectoryList.jsp;jsessionid=
%qs_sessionid%?docversionid=%qs_docversionid%

Asset List URL:

http(s)://<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDocumentList.jsp;jsessionid=
%qs_sessionid%?folderid=%id%&documentid=%qs_documentid%

Note:  We don't support "Search URL" and "Post URL" options. Note that these calls can also be used for
image variables pointing to external assets.

3.7.  Project Management for Administrators

Most Project Management tasks in WebCenter will be carried out by dedicated members with the
Project Manager role.

However, Administrator users have some additional options: they can view and edit all Projects, create
project and document Templates, and Find Locked Documents in the system, so they can reset them.

3.7.1.  Projects

The Project Management page (Admin > Project Management > Projects) lets members of the Admins
group manage all projects in WebCenter.
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For more information about managing projects, see the WebCenter User Guide.

3.7.2.  Project Templates

Members of the Admins group can create and configure project Templates. Those are pre-configured
projects that Project Managers use to quickly and easily create new projects.

You can manage all project templates from WebCenter's Templates Management page (Admin >
Project Management > Templates).

• Click Create a new template in the header to create a new project template.

Note:  You can also save a project as a template.

• Click the name of an existing template to edit it.
• To delete a template, select it in the list and click Delete in the actions menu. Click OK to confirm

the deletion.

Note:

If you try to delete a template with a custom document creation setting and if this template is being
used by other projects / templates, you will get an error message.

Go to the relevant projects/templates configuration tab and select another template before trying
to delete.

System History Logs
All Project/Template related events like

• Project/Template created
• Project/Template deleted
• Project/Template imported
• Project/Template restored

are recorded and stored in System History. Read this page on how to access the records.

Create a Template from Scratch
1. Click Admin > Project Management > Templates, then Create a new template.
2. In the Create a new template page, select Start from a Blank Template and click Continue.
3. Enter the Template Name and optionally a Description.
4. To use a custom thumbnail, select Specify New Thumbnail and Browse for it.

To use the default thumbnail, leave that choice selected.
5. Click Finish.

Your template is created. You can now define Attributes, Upload a document to the template, Add
project members.

Create a Template from a Project Template
1. Click Admin > Project Management > Templates, then Create a new template.
2. In the Create a new template page, select Use a Project Template and click Continue.
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3. Select the Template to use and click Continue.

Tip:

• Use the filter to only show certain templates. For Project Manager users and Project Creator
users with limited visibility only the templates applicable are shown.

• Click a template to view its details in another window. Click Close Window to return to the
Create a new template page when you are done looking at the template details.

4. Enter the Template Name and optionally a Description.
5. Choose the Thumbnail to use:

• To use a new thumbnail, select Specify New Thumbnail and Browse for it.
• To use the default thumbnail, leave that choice selected.
• To keep the thumbnail of the project template you are using, select Use Template Thumbnail.

6. You can Invite Members and also create a new user to the project. To do this, Select New Project
Members drop down and scroll down to Create and Invite New User.

7. Click Finish.

Your template is created. You can now define attributes, upload a document to the template, Add
project members.

Note:

• The project template is created with the same folder structure, documents, characteristics,
attributes, discussions, members, and security as in the original template.

• Any documents in the template are copied into the new template as new standalone documents,
even if they were linked documents in the template.

• Any documents in the template are copied into the new template as new standalone documents,
even if they were linked documents in the template.

Save a Project as a Template
1. Create the project as desired, or open an existing project.
2. On the Project Details page, click More actions  and Save as Template.
3. Enter the name of the template and a description in the appropriate fields.

To use a custom thumbnail, click Specify New Thumbnail and enter the complete path and filename
in the associated field or Browse for it. To use the default thumbnail, leave that choice selected.

4. Click Finish.

The template is created.

Configure Project Creation Terminology
It is possible to change the terminology used for project creation so that the Project Creation page
talks about "Designs" instead of "Documents", or "Client" instead of "Customer", for example...

You can achieve this by customizing the terminology in the attribute category of the project or
template used as a basis for project creation.

You need to:
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1. Make an attribute category with custom project creation terminology.

Attention:  Your custom terms will not be automatically translated, and will show as you
enter them for all languages in which you run WebCenter.

2. Make a project template (or a project that will be used to create other projects) using that attribute
category.

Users creating projects from this project template will see your custom terminology on the Project
Creation page.

Configure Customized Document Rendering in projects
You can configure the Upload Document section, when a new project is created from an existing
project or a project template. Ensure that the upload document is enabled in the Project Source or
Project Template.

To customize the upload document section in the Project Creation form, navigate to Projects >
Configure > Document Rendering in the Project Source or Project template.

You can read on how to customize at Create an Advanced Table Rendering on page 376.

3.7.3.  Document Templates

As an Admin, you can create and configure Document Templates. These templates will serve as
"dummy" documents (placeholders) that have a document type, file format, and attributes already
specified. This information will be useful to real-life projects.

Those document templates will be used by Project Managers / other users to create document
placeholders for future project documents.

For example:

1. You (the Admin) create a Document Library Project containing the document templates, and project
templates referring to that document library (see Create Document Templates on page 162).

2. When creating a project from one of these project templates, the Project Manager will create
placeholders from the document templates, to mark where the project deliverables should go.

3. When using the Upload function, a project member (with the Add right) can also create a
placeholder from a document template, to indicate the characteristics (document type, file format,
and attributes) of the final document to be uploaded.

Note:  This is only possible through the normal WebCenter upload (see Uploading a Document
via Upload on page 591 and Copy / Create Multiple Documents on page 595), not the Java
applet upload or when uploading documents from other applications like Automation Engine and
ArtiosCAD.

Create Document Templates
1. Create a Project Template that will contain all your document templates (this will be your Document

Library).

Having all the document templates in one location makes them easier to manage, and saves disk
space.

2. If desired, create a folder to contain your document templates.
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Note:  If the project in which placeholders are created contains a folder with the same name, that
folder will be used as default destination for the placeholders.

3. To create document templates:
a) Upload a document of the right file format into the Document Library.

You can use any document type (enabled in the Preferences) except Page Lists.
b) Define attributes for your document template: choose an Attribute category and fill in default

attributes values.

Note:  When users will create documents from this document template, they will inherit these
attributes (and default values).

c) Repeat for all document templates you want to create.

Tip:

• If you want a document template to always be used when creating placeholders of a certain file
type, call it Default.<extension>, using the extension of that file type.

For example, call it Default.pdf so it is always used when users create .pdf placeholders (in
projects using document templates from the Document Library).

• You can also create a generic document template called Default (without the extension), that
will be used automatically for file types who don't have a Default.<extension> template
associated.

For example if a user wants to create a .png placeholder but there is no Default.png
document template in your Document Library, then the Default template will be used.

4. Create a Project Template for each kind of project that will be required by Project Managers.
5. In each of these Templates configure the Document Library as follows:

a) In the Project Details page, Configure > Document Templates.
b) Select Project or Template and select your document template library from the drop-down.
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c) If your document library contains ARD files, and you want to use them to run ArtiosCAD

standards, select either:

• Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard,

• Run the ARD as a standard when the IsStandard attribute is set to 1 if you only want to use
some ARD document templates to run CAD standards.

These ARD document templates must have the IsStandard attribute assigned, with the
default value set to 1.

Select Never run the ARD as a standard if you are not working with CAD standards.
d) Click Save.

Projects created from one of those project templates will keep the project template's link to the
document library.

Project Members can then create placeholders from the document templates in the document library.

Note:

If you know that the Project Managers will always use the same set of placeholders in all their projects,
you can also:

1. Create a document library Project Template.
2. Add Document Templates to the Project.
3. Go to Project Details > ConfigureDocument Templates and select the same Project in the

Templates list.
4. Project Managers can create projects directly from this Template to have the Document Templates

as placeholders.

Note that this approach is less flexible!

3.7.4.  Project Creation Settings

As an Admin user, you can configure the Project Creation Settings for a project or template. You can
find these settings in the project or template's Configure section, under Project Creation. These
settings define what is displayed on the Project Creation Page when you create a new project from
this project or template.

First of all, you can choose whether you want to Use Auto Naming and define the naming scheme.

Furthermore, you can choose what features are displayed on the Project Creation Page. You can
choose the following options:

• Set Project Manager: Show/hide the project manager selection on the project creation page. If
you hide it, the project manager will be the same as used in the template or parent project. If you
choose to show this section, it will default to the person creating the project.

• Set Status: Show/hide the project status selection on the project creation page. If you hide the
project status, the new project will be created using the first available active project status.

• Set Customer: Show/hide the customer selection. You can make this a required field. Hide this field
to use the customer set in the source project or template.
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• Set Description: Show/hide the description field. You can make this as a required field.
• Set Due Date: Show/hide the due date selection. You can make this as a required field.
• Upload Documents: Show/hide the documents section. You can make this section required, so that

the project creator has to add at least one document.

Note:  You can configure the document upload section in the source project or the project
template. Refer to Configure Customized Document Rendering in projects

• Assign Roles: Show/hide the role assignment section. You can decide for each role whether it is
required to assign a group or user to it and/or whether you can assign multiple users or groups to
this role.

• Invite other members: Show/hide the members section to enable/disable adding additional
members to the project.

Note:  When the Admin Users or the User creators assign Roles, deactivated users are shown in
the drop down who can be activated and added to the project. User creators have access to only
activate the users they created, whereas admin users can activate any deactivated users.

• Set Attributes: Show/hide the attributes section. You can show or hide the creation view of the
project attributes of the source template or project.

• Select Thumbnail: Show/hide the project thumbnail section. If you hide this section, the thumbnail
of the source project or template will be used.

• Set Planning (Tasks): Show/hide the task planning section. You can make these fields required.
• Default Planning Method: You can set the default planning method to Forward or Backward. Even

if the Set Planning section is not displayed, the setting you choose here will be used for the new
project.

3.7.5.  Document Creation Settings

As an Admin user, you can configure the Document Creation settings for a project or template. You can
find these settings in the project or template's Configure section, under the Document Creation tab.

When a project manager creates a project based on a template or an existing project, you can add
Documents using the Default options or Custom options.

You can create a custom document creation set up in your template. In this setup, for each row in the
configuration, a link is added to the specified section in the same order.

• Default

The default document creation options will be:

• Browse
• Copy
• New (when a template library is configured)

Note:  New document creation is only possible if a Document Template library is linked in this
template.Read more in: Create Document Templates on page 162.

• Another Template's Document Creation Setup

Use this to copy a setup from a template with a custom document creation set up.
• Custom
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When you select this, you will see a list of customizable options:

Source Where the document will be sourced from.

Label The link description. You can create a custom label, such as Upload a
graphic file.

• Standard

• Simple

• Translated

Details Additional information such as:

• Allowed Extensions

• Document Template Selector

Here you can select the already specified document templates. Read
also:Document Templates on page 162

Operation The operation depends upon the Source button. For example, if you have
chosen Project+Folder, the operations would be Copy, Move or Link the
document

Sections The configured upload source is made available in these sections. By default,
all the options will be available and enabled. You can deselect the sections to
disable some of the locations.

• the Project Creation Documents

• the Project Creation Bill of Materials

• Bill of Materials

• Upload (Copy or Create Multiple Documents)

Note:  You can also drag and drop multiple files onto an Upload button.

Target
Folder

The destination folder

To add a new source type, click Add Document Source. The document sources in the list can be
deleted by clicking the delete icon.

You can configure:

• a simple Browse link for the user to upload a document.

Note:  You can also drag and drop multiple files to the upload button.

• Document Templates from the template library. This will serve as a place holder with pre-
configured settings such as attribute categories. Read more about templates in Document
Templates on page 162.

• Current Project
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• Saved Search: Use this option to allow the user to select a file from a saved search. When the user
clicks the document reference as a link (with a custom label), saved search results will appear in a
pop-up with all the configured options.

• Asset Management System: Use this to allow selecting a file from the configured Asset
Management Systems. Read more in Configure Asset Management Connections on page 425

If you want to delete a template with a custom document creation setting, make sure that it is not
being used by other projects/templates for document creation. If it is being used, you have to select
another template in the relevant projects/templates before attempting deletion.

3.7.6.  Document Types

As an Admin user, you can configure settings for each of the Document Types for a project or template
in Configure > Document Types. These settings define what happens when you add documents to your
project.

The settings are organized per Document Type. Per type you can set the following options:

• Automatic Document Naming: Use this setting to enable/disable autonaming for a specific
document type. Choose None to disable autonaming. Choose Default to use the system wide
autonaming settings or choose Custom to enter a specifc naming scheme for this project or
template.

• Default Attribute Category: Use this setting to assign an attribute category to a specific document
type. Choose None to not use a default attribute category. Choose Default to use the system wide
settings or choose Custom to select a specific attribute category.

• Start Task for new Documents: Use this setting to start a task of the specified type when adding
a document to the project. The task is automatically started, assigned to the uploader and the
uploaded file is linked to the task. Choose None to not start a task upon upload. Choose Default to
use the system wide settings or choose Custom to select a specific task type.

• Start Task for new Versions: Use this setting to start a task of the specified type when adding a
new versions of a document to the project. Choose None to not start a task upon upload. Choose
Default to use the system wide settings or choose Custom to select a specific task type.

3.7.7.  Create Project Thumbnails Automatically from Documents

As an Admin user, you can configure a setup to create automatic thumbnails from the document
images.

When a new graphics or CHILI document is being uploaded to a Project or Template, the user will have
an option to check if the document image needs to be taken as the Project Thumbnail.

If this option is checked, the Project thumbnail will be set as the document image after checking and
registering.

1. Create a text Attribute called Make Project Thumbnail.
2. Set Values to Restricted Set.

Create the check box by entering Yes and No as values of the restricted set. The values are case
sensitive.

3. Create an Attribute Category and include Make Project Thumbnail  in the attribute.
4. Create a Project Template.
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5. In the project template, go to Configure > Document Types.
6. Specify the Default Attribute Category as the Project thumbnail Attribute category for the desired

document types.
The user has to select Make Project Thumbnail during the upload of documents to use this feature.

 

 

Note:  When multiple documents in a project have the attribute MAKE PROJECT THUMBNAIL set,
each upload overwrites the previous thumbnail in the natural sequence they happen. In case of
multi-document upload at the same time, thumbnail can be set from any of the document based on
the sequence they are returned from OBGE.

If the documents are published from Automation Engine, (when the view files are generated on AE
and not on the OBGE), then the project thumbnail will not change.

Changing the project thumbnail on upload is guaranteed to work, only if the upload is through
WebCenter.

3.7.8.  Deleted Projects and Templates

Admin users can view the list of deleted projects or templates in the system by navigating to Project
Management > Deleted Projects and Templates.

The list is by default sorted by modification date showing the most recent deleted project first but
sort can be performed on any other columns as well. The filter section at the top allows searching
for particular projects. You can click on the project name to see the history of the deleted project/
template containing all the events logged during the life cycle of the project/template, for example who
deleted the project. The deleted projects and templates are only shown until the cleanup tool is run.

3.7.9.  Project Statuses

The Project Status feature allows you to review the current project standing. This feature can be
accessed by an Admin user or a member of the Admin group, Project Managers and an User.

An administrator can add statuses in WebCenter. This works similar to task statuses (whereas the
statuses are not shared). A status has a name, an icon and a type. The types are Non-active, Active,
Archived and Completed. The WebCenter has the functionality to limit the actions possible in not-
active and completed projects. It is most typical to add active statuses, for example: Briefing, Design,
Prepress, Printing. An administrator can limit the statuses for a project and this can be done for every
project individually.

The project status is displayed in the project header (and in available other locations such as search):

Note:  This can be set as read only. Read more atPrevent direct changes to Project Status on page 177
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The Project Manager can perform following:

• Set the Project Status.
• View Project Status.
• Search Project Status and Filter projects based on Project Status.

An administrator can limit the statuses for a project and this can be done for every project separately.
Go to a project or a template as an administrator and click on the Configure tab. By using Add Project
Statuses and Remove Project statuses (select with the check boxes and take remove from the action
drop down), you can get a specific set of statuses.

An Administrator can link milestones to project statuses to see the timeline of projects in a calendar
view by setting up a date/time attribute for project statuses. Each active status can have a date/time
attribute linked and the same date/time attribute can be used multiple times with different offsets.
The linked date indicates the intended end of the project phase, but will not trigger an automatic
project status change. The actual date will depend on the related attribute value in the project context.

The administrator can decide the sequence of the statuses. This sequence is purely used for sorting.
When the projects are sorted based on Project Status, this is the sequence used. The sequence is
system wide.

Apart from showing the Project Status in many project overview pages (and also in the search results),
the project statuses can be used in the Workflows. For example: To decide different operations or
assignees depending on the current project status.

Note:  By using the Set Project Status node in Workflow, you can set the status for the current project.

In the following example, let us consider five statuses allowed for this project. The Project Statuses
are set as 01 - Briefing, 02 - Concept, 03 - Artwork, 04 - Prepress and 05 - Closure. The WebCenter
has many more statuses, but only these statuses are allowed for this project. The statuses are in this
sequence in the entire system.

Note:  You can only decide per project whether you can have these statuses, but you cannot change
the sequence of the statuses per project.
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A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. Archive Project status is visible to users based on the setting specified by the
Administrator in the Security Preference.

Read more on Project status as Archived here.

On archiving the Project, the project is excluded in the Project list and is not shown in the My Projects
or Project I Manage menu items. The Project as well as the Tasks and Documents within the project
does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

Viewing a List of Project Statuses
The available Project Statuses can be viewed in the Project Status page. In the Project Status page,
you can add, edit or delete the Project Status. You can also choose or add an icon, add a custom color
for the Project Status and decide the sequence of the statuses. When you use custom colors, text
colors on the Project status is automatically adjusted to make it visible.

To view Project status, navigate from Admin > Project Management > Project Status. The Project
Status page appears.
 

170



3WebCenter

 

System History Logs
All Project Status related events like

• Project Status created

• Project Status deleted and

• Project Status changed

are recorded and stored in System History. Read this page on how to access the records.

Adding a Project Status
You can add a new Project Status through the Project Status page. You can also choose or add an icon,
a color for Project Status and decide the sequence of the statuses.

1. Click the Add Status button on the Project Status page.
2. In the New Status page, type the Name of the status and select the Project Status type.

You can add multiple statuses at a time. When the new status is marked as Active, it is added just
behind the previous active status. When the new status is marked as Non Active or Completed, it is
added at the end of the Project Statuses list with no rules applied.

 

171



3 WebCenter

 
3. Click the Save button to make changes. The Project Status page appears with the new status.

Note:  The new status will get a default color and no icon added to it. This can be changed in Project
Status page.

 Editing a Project Status
You can edit the existing or newly added Project Statuses through the Project Status page. In the
Project Status page, you can change the Name, Language key, Sequence number, Add Icon and Set
Color.
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Type the sequence number in the Display Order column to change the sequence number. The change
in sequence number appears only after saving the changes.

The language string key has to be added to the XML formatted language key file (wcstrings_<2
character ISO language code>.xml for English: wcstrings_en.xml) for all used languages. By default the
language (en) has to be added.

Note:  The language key field is not mandatory. If you want all languages to follow the same names (Not
translated stage names), you leave the language key field empty.

Type the Name of the Project Status to change the Project Status name and click the Save to make
changes.

The new status will be set to Esko Green as default color. You can select a Color for a dropdown for
each project status. This color will be used in the calendar-view of the project overview.

Note:  You cannot add your own new color.

Once you select the required color from the drop down list, click the Save button to make changes.
Here, the Color is changed to Red.
 

173



3 WebCenter

 

You can change an icon for the exisiting Project Status in the Project Status page. The Project Status
icon can selected from the Icon Gallery or you can also upload an icon. WebCenter allows JPG, JPEG,
GIF, BMP and PNG files types as icons.

Note:  The UI is optimized for an icon height of 16 pixels. Icons will be placed in overviews without any
scaling.

Click the Select Icon button, to select the required icon from Icon Gallery.

In the Icon Gallery window, select an icon via the radio button and click the OK button. The gallery
allows filtering of icons by its name.
 

 

Click the Browse button to upload an icon of your choice. The icons can be re-used for other statuses.

Note:  You can change the icon of the built-in Project Statuses. When no icon is set, the name of the
status is used instead.

 Deleting a Project Status
You can delete a Project Status and this status will be marked as deleted/obsolete in the WebCenter
database. When a project status is marked as deleted, it will no longer appear in any of the locations
where a Project status can be selected. The Projects and Templates having the deleted status will still
keep this status. You can however no longer change projects to the deleted status. To delete a Project
Status,

1. Select the required Project Status and click on Delete in the Actions menu.
2. Click the OK button to confirm the deletion.

Customizing a Project Status
An Administrator can set allowed statuses for Templates or for Projects. By doing this an Administrator
can limit the number of Project Statuses to be used for a specific project. When adding a new project
status to the system, this status will be also added to all projects and templates. When a project is
created from a template or from another project, it inherits the allowed statuses from its source. This
happens only once and does not happen when the template changes later.

1. Log in to WebCenter as an Admin user.
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2. Click the Admin > Project Management and select Projects or Templates.
3. Click the required Project or Template link from the list.
4. Click the Configure > Project Statuses. This displays a table with the current allowed statuses for

this Template or Project.
5. Select the required Project Status from the list and then click the Add Project Statuses link.

Note:  By default a blank Project will get the list of all statuses as allowed statuses.

6. Click the Save button to make changes.

Note:  The Project Status cannot be re-ordered here, the order is inherited from the system order.

You can remove allowed statuses for a template or project by selecting the status and select Remove
from the Actions menu.

 Searching based on a Project Status
You can search for projects based on their Project Status. Choose Search from the menu bar and
select Project or Tasks and Approvals. On the (advanced) Project Search page and the Task Search
page, the list box will contain the list of all the Project Statuses.

In addition to all individual project statuses, the list also contains the following:

• Show All (default): show all projects (or tasks of all projects).
• Show All Active: show only projects or tasks of projects with an active status.
• Show All Not Active: show only projects or tasks of projects with a non-active status.
• Show All Completed.

 

 

You can also search on Project Status Started, Project Status Due,Project Status Completed, Project
Status Duration, and Project Status Time Left  in the Project Search page.
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Filtering based on Project Status
In Favorite Projects, Projects I Manage, and in Projects I am Invited to, you can filter on all Project
Statuses individually. You can also use the filters to look for a combination of statuses: Show All, Show
All Active, Show All Not Active, Show All Completed.

Archiving Projects

Project Status –Archived
A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. The visibility of Archived projects depends on the setting chosen by the Admin
user in the Security Preferences. Admin user has an option to allow non-admin users to view the
archived projects.

Visibility of Archived Projects
Archived projects are visible to Admin users by default. Visibility to archived projects for other users
are set optionally by the Admin users in the Admin  > preferences > Security Page. Enabling Allow
non-administrators to see Archived Projects option makes the Projects in Archived status visible.

Note:  Changing the option triggers search index re-crawl and that may interfere with Search Results
on Archived projects until the recrawl is complete.

When this option is not selected by the Admin user in the security preferences, changing the status by
the Project Manager (who is not an Admin user) to Archived restricts the access to view the project for
all users in the project including the Project Manager.

Once the project is archived, the project is excluded in the Project list and hence is not shown in the My
Projects or Project I Manage menu items. The Project as well as the Tasks and Documents within the
project does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

Project Status –Set Status to Archived
When the Project is set to a project status, which is of Project status Type Archived, the project is no
longer visible to anyone except Admin user unless enabled by Admin user.

Project Status Filter
Admin users can now set the Project Status type to Archived. From the WebCenter 20 onwards, Project
status can be filtered/ searched as Active or Completed or Non-Active or Archived.

Setting a Project Status to Active or Non Active
An Administrator can set a project to Active by giving it an Active status. Whether a status is active or
not is determined when the status is added.

If a project has been set to a Non Active status, by default the permissions for all members are masked
with the View and Download permissions, so that these two permissions are still enabled if and only if
they were enabled already, while all other permissions are disabled.
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However, whether certain actions can still be performed in non-active projects, also depends on
the security settings for the system. An Admin user can change these settings on the Security page
(Preferences > Security). It is possible to allow or disallow changing attributes, changing members and
document operations in inactive projects.

Prevent direct changes to Project Status

As an Admin user, you can prevent project status changes by the project manager. When this option is
enabled, the project status becomes read-only in the header of a Project.

To prevent direct change to Project status, navigate to Projects > Configure > Project Statuses in the
Project template and disable the option Project Status can be modified by Project Manager. All the
projects (also previously) created from the template will adhere to this setting.

By default, the option is checked in the template, and allows Project Managers to change the Project
Status.

However, the Project status can still be changed:

• when a task is completed and the task is configured to change the project status on

completion

• when a workflow node changes the Project Status

• by admins via an SDK call changing the project status
• by admins in a saved search allowing to change the project status.

• if the project is not created from a project template.

3.7.10.  JavaScript Rule Action

Admin Users can use the JavaScript Rule Actions to execute JavaScript from a rule without a
workflow. In the JavaScript Rule Actions you can Add a rule, Edit or delete the rules.

System History Logs
All JavaScript Rule Action related events like

• JavaScript Rule Action Created

• JavaScript Rule Action Deleted

• JavaScript Rule Action Changed

are recorded and stored in System History. Read this page on how to access the records.

You can read more about API's for WebCenter here.

Add JavaScript Rule Action
You can customize Rules to perform specific actions. This can be done by adding rules which are
written and executed in JavaScript.

To add a rule in JavaScript:

1. Click Admin > Project Management > Add JavaScript Action Rule .
2. A Edit JavaScript Rule Action window is opened on selecting this option.
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3. Enter the name for the rule, description and the script. Save the Rule to view the list of JavaScript
Rules.

4. To edit an existing rule, double-click on the JavaScript Rule Action  from the list. To delete the rule,
click once to enable the delete icon on the row selected.

View JavaScript Rule Action

1. Click Admin > Project Management > Find Locked Documents.
2. Either filter for users by entering (part of) their last name in the Search users by last name field, or

click Go right away to see all locked documents.
3. Select the document(s) to unlock by selecting the corresponding boxes.
4. Click Unlock checked items.

3.7.11.  Delete View Files

View files (that make files viewable in the WebCenter Viewer) take a certain amount of disk space. If
necessary, Admin users can delete those view files.

Note:  You can only delete view files per project (for all of the project's documents at once), not per
document.

1. Use the Search to find the projects whose view files you want to delete.
2. Select the projects whose view files you want to delete, and click Delete View Files in the actions

menu .

Confirm your choice by clicking OK.

Note:  When deleting view files, Viewer annotations, document metadata and thumbnails are kept.

You can see that the view files have been deleted on each document's Documents Details page.

 

 

Regenerate View Files
Users can regenerate documents' view files as needed provided that:

• they have the View permission on those documents,

• those documents' view files can be regenerated.
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Note:

Most view files can be regenerated, except for:

• page lists coming from Automation Engine,

• documents uploaded via Automation Engine with the Upload only view files option.

If you need to regenerate the view files:

1. Go into the project whose view files you deleted.
2. Select the documents for which you want to regenerate view files.
3. Click View and Annotate in the actions menu.

3.7.12.  Configure a Landing Page for a Role

Administrators can configure the start page of a Project per Role in the Project Template. This means
that when a particular Role-User come into the Project Details, he or she will see the specified Landing
Page first. This feature allows you to configure different start pages for different types of users(Roles).

To configure Landing Page per Role:

• Go to Project Template > Details > Configure > Landing Page section. Click New Landing Page.

• Specify the Role and the Landing Page. Choose from the following pages.

Options Description

Documents Specify the folder in the Details section.

Attributes Specify the Attribute Category View in the
Details section.

Note:  If you leave this section empty, the user
will see the Default View.

Saved Search Specify the name of the Saved Search in
Details.

Note:  The Role-user will be directed to the
Saved Search which is plugged into the User's
Project Details menu.

Approval Page Details section is read-only.

Tasks Details section is read-only.
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Options Description

Bill of Materials Details section is read-only.

Dashboard Choose the dashboard that you require as
landing page. You can also create a new
dashboard from this drop down.

• The Landing Page configuration is copied when you copy a Template or Project.
• When you export your template, the landing page configuration is included in the XML.

3.7.13.  Configure Rules in a Project

What is a Rule?
You can configure a Rule to execute specific Actions based on one or more Trigger events. The Rule
sets reside in Project Templates and will be applicable in all Projects created from them, including the
previously created ones. This administrator feature lets you establish communication between Child
and Parent Projects or between any two Projects. See an example use case at the end of this chapter.

Note:

You need the WebCenter Task Management Advanced or WebCenter Life Cycle Management license
to be able to define Rules.

To set up Rules, go to Project Template > Configure > Rules Setuptab.

Note:  Although Rules are configured within a Project Template, you can create Rules that are
triggered after the project is created from the template.

Triggers
A Trigger is an event that happens in the system (for example, the Child Project Status changes to
Completed). A successful Trigger condition will execute a Task based Action.

You can specify multiple triggers and actions in a Rule. When one Trigger event(as specified in the
Rule) happens, the system evaluates the Rule and executes the corresponding Action(s).

See the supported Triggers below:

• Project Status Change: The Action is executed when the Project Status changes.

• Project Attribute Change: The Action is executed when the specified Project Attribute changes.
You can specify the attribute from a drop-down.

• Project Due Date Change: Any change in the Project Due Date will trigger the specified Action.

• Date/Time Reached trigger lets you define an exact time stamp to execute the Rule. When the
server time passes the Trigger time, the Rule will be executed. There are 2 options:

• Specific Date: the actions will be executed on the specific date and time
• Date in Project + Offset: the actions will be executed on the selected Project Due Date or Date/

Time attribute plus or minus an offset of days and/or hours.

Note:  The calculation is done in working days/hours.
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Actions
• Start Task: This action launches a Task in the same Project where the Rule is configured. Specify

the Task by selecting it from the drop-down.

• Execute Javascript: This action launches a specified JavaScript Rule Action. You can specify one
from the Javascript Rule Actions configured in the system.

It is possible to configure multiple actions by clicking on the ‘+’ sign. Use ‘x’ to remove existing actions.

Example

See the example of a Project Template's Rule below. This Rule gets executed when the specified
Date/Time Reached.

 

 

The Javascript Rule Actions are configured in Admin > Project Management > JavaScript Rule
Actions. See the example script below.

var children = API.getProject().getChildProjects(); if(children.length >
                    0){ var atRisk = false; var inDelay = false; for(var i = 0;
                    i<children.length; i++){ var child = children[i];
 if(child.getStatusName() !=
                    'Completed'){ atRisk = true; } else if(child.getStatusName() ==
 'Non-active'){
                    inDelay = true; } } if(atRisk){ API.getProject().getAttribute("mvbe
 Campaign
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                    State").setValue('At risk'); } else if(inDelay){
                    API.getProject().getAttribute("mvbe Campaign State").setValue('In
 delay'); }
                    else { API.getProject().getAttribute("mvbe Campaign
 State").setValue('On
                    schedule'); } } 

Two days before the milestone, this Rule will get executed. Depending on the child Projects'
statuses, the Program Project's status will be updated.

3.8.  Advanced Search Setups in WebCenter

3.8.1.  Advanced Searching

There are advanced search features using which you can design and create dedicated search pages.
You can:

• Save a Search with advanced settings.
• Find assets which were stored in WebCenter with certain Attributes or with a certain project

criteria. This will help you to:

• Find, collect and download pictures for a certain product line. You can also send these as
download links.

• Search according to criteria to find required Packaging types: for example Carton Boxes.
• Search based on Project Status. For example, you can find all projects with a status Initial

design. Display the Project Status as text, icon, color or both. Select your Project Status setting
as Show Color Label to get the project status bar in your search.

• Perform bulk operations.
• Alter the column order in the View column and search based on Projects or Documents or Tasks and

Approvals and choose to not show the same parameter in the search results.
• Refine Search Results using a search parameter panel. Using this, users can limit the list of items

to be searched.
• Define the sequence of columns in results. Alter the column order in the View column and search

based on Projects or Documents or Tasks and Approvals and choose not to show the Project Name
or Document Name or Task and Approval name in the search results.

• Create dedicated Global Saved Searches for Users. Global Saved Searches are accessible to
all users and hence advanced search option access can be given judiciously to users. You can
customize these as Asset Browsers which can be incorporated into the menu.

• Create Saved Searches with Projects Calendar View on page 203.
• You can search by selecting multiple options in drop downs or even type the text to search.
• If an action has been done as delegate of another user, it is shown in the corresponding field in

search results. For example, in the field created by for a task search.
• Click on any of the gear icon in the date/time fields to Show Time except for attributes and search

is either sorted or filtered on this. For Project Status, gear option gives the configuration options
like Automatic or Label and Icon, Only Icon, Only Label, and Color Label. For Pending Approvers,
gear option gives configuration option to Show Assignee details (original Group /Role).
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System History Logs
All Saved Search related events like

• Saved Search created
• Saved Search deleted and

• Saved Search changed

are recorded and stored in System History. Read this page on how to access the records.

3.8.2.  Creating Advanced Saved Searches

Normal and keyword searches may be saved for future use as a Saved Search and can be plugged into
menu items (of the main menu or Project details menu), My Work and as a document source during
project creation and in document referencing.

To access saved searches, click Search > Saved Searches. Shown below is a sample Saved Searches
page.

Searches can be saved as:

• a Personal  search visible only to the individual user.

• a Global  search visible to all WebCenter users.

Note:

1. For each Global Saved Search, an Administrator can determine a set of Groups/Companies/
Locations whose members can view this Saved Search.

2. It is not possible to set Visibility for Personal Saved Searches.

Saved Searches can be configured with advanced Drilldowns and extensive and visually enhanced
Dashboards. You can plug these

• To execute a Saved Search, simply click its name from the Saved Searches page. Or select it from
the Search window in the menu bar.
 

 
•

To edit a saved search, click Edit Search.
•

To Make Search Personal, click 
• To Make Search Global, click 

Smart Names  enabled Searches do not have the Make Search Personal option.
•

To create Global Saved Searches dedicated to a company or group, click  Edit Visibility link.
In the next window, select the Available Groups, Available Companies/Locations to whom you
want to give the exclusive visibility. In this case, if you assign the visibility to a group, a company or
location, the search will be visible to either the group or the company or both.
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Note:

If you select a company without specifying any of its locations, all the company locations will be
able to access the saved search.

If you remove the Available Groups/Companies /Locations, the visibility settings will be modified.

• To delete saved searches, select them and click Delete. Use Select All and click Delete to delete all
of them.

Search Panel Design
The saved searches can be setup for Projects, Documents and Tasks and Approvals. These saved
searches can be edited by an administrator. The administrator decides for each saved search (and for
each operation) whether these operations are allowed or not.

All users can design searches via the Search Results options. However, administrators get an extra
check box Search Panel Design.

In the Search page:

1. Select the Search Panel Design Options. The Visibility, Label, Row, Column will appear in the
search page.

Additionally, the check boxes in the View column will become drop downs when enabling this
option.
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Here:

Column Description

Visibility Determines whether the criterion will appear in the saved search top panel.
The available values are Hidden, Available and Visible.

Label A label is the name of the criteria as it needs to appear. A label can be given
regardless of the setting of visibility. The label will automatically applied
to the column header in list layout and will be visible in grid layout too. If
the field is left empty then, the label will be the same as the criteria and not
different to other localized languages.

Row and
Column

Position where the criteria will appear. Row and column are filled in
automatically but can be changed by the user. The second criteria can
have the same values for row and column. For example: If the Project Name
criteria has the value Row 1 and column is 2, the criteria will appear in column
two of the UI.

For example; when the Visibility is set to Visible for Approval Completed, the following results page
appears.
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When your users use this search (for example as an asset browser), they can use the design panel to
further refine the criteria. You can now

Set up first visible Column in Search Result
In WebCenter 20.0, you can configure any searchable field as the first column of the Search Results
other than the name of the Project/Document/Task. In fact, you can choose to hide the Name column
and/or choose any another column as the first column. Inline actions are shown on top of the first
column.

Note:  In Card Layout header, Focus Layout header and Selection section, some of the fields like
calendar view, text statements, rich text attributes, project/approval/task statuses, users/groups and
company /locations are not supported.

Internationalize Labels for Search
Search labels can be also be translated to other languages. To find or create new translated labels,
select the blue global icon in the Search Panel Design options. A Find or Create Translated Labels
window is opened.

You could find translations for search labels or create a new label in the language you want it
translated.

186



3WebCenter

Find or Create Translated labels on page 307

Setting Search Result Layout Options
You can configure advanced searches for Projects, Documents and Tasks and Approvals. Using Show
Result Layout Options, you can configure the search results interface for the users. You can also
enhance these searches with Dashboards to display the search results in a graph/chart/counters.

The available options are different depending on whether it is a Project / Document / Task search.
Some of the options available commonly are

• You can use Use a custom Search Title to modify or rename the Search Title while viewing the
results. The custom search title field is translatable which is indicated with the blue globe icon.

• Limit cell height ( expand by request) which is enabled by default limits the height of the results
shown. You can turn off this option to view all the content of the cells.

• You can get the Larger Thumbnail on Hover in the search results page by hovering on the search
result row. Optionally you can also disable this action. You can also enable the larger thumbnail on
click for which a button is displayed in the right corner of the image.

• You may choose to hide the button to show/ hide the thumbnail in the results by choosing Show
"Hide Thumbnail" Button.

• You also have an option to choose whether the thumbnail display will be as per the Default (User
Preferences) or Show Thumbnail  or Hide Thumbnail. This option is available for only Projects and
Documents search.

• You can alter the Column order and select whether or not you want to make fields visible in the View
column. This allows you to order the results based on some fields, and display entirely different
search fields/columns in the result page.

You can also hide the first field namely Project Name or Document Name or Name ( for Tasks and
Approvals Search) by unchecking it.

• Enable 'Show as Grid/List/Cards' Button to show this button for Documents and Projects Search
results.

• Choose the units to be used when exporting to Excel in the Save Search Results option. You choose
to export the results in either Metric, Imperial or Use User Preferences. You can also configure the
order of search results. Read more about Configured Order on page 195

• Choose whether to Show clear this form button in the search results layout.
• Allow Changing Attribute Category, where-in the Change Attribute Category will show up in the

actions bar for Projects and Document Searches.
• Enable/disable the Table Bulk Actions per saved search. You can check the Show Bulk Edit Actions

for fields marked as editable. In List layout in Search Results page, you can still access bulk editing
by clicking on the pencil icon (inline) in the column header.

• Display Labels in grid layout.
• Setup Show Drilldown using a Saved Search.
• You can enable or disable Save this Search, Save Search Results and Search buttons to customize

your searches.

Configuring Initial Search Results Style
For Document and Project searches, you can also configure Initial Search Results Style. Select from:

• Default (determined by the User's Preferences)
• List
• Grid
• Card
• Focus Layout
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The selected view style will be applied on the Search Results page instead of the default user
preference.

Note:  Users can change the view of the search results by clicking the Show as Grid/List/Cards/Focus
buttons if these are not disabled.

Project Search Layout Options
To select your options for project, go to Search > Projects > Show Result Layout Options > You can
choose to:

• Remove the links to Hide Thumbnail, Show as Grid and also Save Search Results.
• Choose the units to be used when exporting to Excel in the Save Search Results option. You choose

to export the results in either Metric, Imperial or Use User Preferences. You can also configure the
order of search results. Read more about Configured Order

• Choose whether to Show clear this form button in the search results layout.

• Display the Project Status as text, icon, color or both. Select your Project Status setting as Show
Color Label to get the project status bar in your search.

• Allow Changing Attribute Category, where-in the Change Attribute Category will show up in the
actions drop-down.

• Display Labels in grid layout.
• Setup advanced options like Search Results Dashboard and Show Drilldown using a Saved Search.

Document Search Layout Options
In Document searches, you can configure Individual Result Actions and Display options. To allow an
operation or a display option, keep it enabled.
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Enable Show Cart to show the cart with the selected documents. You can perform actions such as
create a project or clear from cart.

You can also set up document searches as Asset Browsers.
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Note:  Add to Cart allows you to add documents to the cart.

If the option Show Cart is enabled in a Saved Search, the cart will be displayed in all the locations
where the Saved Search is used.

• Saved Search configured in My work, Document Details and Project Details

 

 
• Cart will not appear in Searches used as Document Source.

Tasks and Approvals Search Result Layout options
Navigate to Search > Tasks and Approvals  > Show Result Layout Options.

You can also configure Individual Result Actions .

 

 

Custom Actions in Search

When you configure custom Action buttons for Searches. You can enable or disable those actions in
specific Saved Searches.

This can be done by defining a Tag for the Action defined in the custom menu.

To have Custom Actions in Saved Searches:

• Create Custom Search Actions

• Specify a Tag for the custom Search Action. Save the menu and apply to the User(s).

• Create a Search. In Result Layout options, enable Custom Actions and specify it with the exact
Tag.
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• In the Search Results page, you will be able to see the custom Action that you configured.

Persistent Search Results
Search Results selection is persistent and the selection is kept while you remain on the Search Results
page. You can navigate to another page of the search results, or re-sort, or filter from the design panel,
or use facets, or add available columns,and so on. The selection is available while you remain on the
same WebCenter page and do not execute any other actions on the selection.

The number of items selected is indicated in a counter in the header. You can view the thumbnails of
the selection by clicking the counter. Next to the thumbnail, it is also possible to view either the

• Document Name and Project Name for Document
• Project Name and Project Description for Projects
• Task Name and Project Name for tasks ( only available if a search dashboard is configured)

The items are added in the persistent selection section as in the order in which you select the items.
So, when you select a new item to be added to the persistent selection, it is added to the top of the list.
When multiple items are selected, the items are added and ordered the same way as they were on the
page.

Each item can be removed individually from the Selection or you can remove all.

Focus Layout
Focus layout option shows results of Document, Project or Task and Approval Search. Focus layout
provides a better visual representation and an immersive experience of the images in the search
results.

When Focus Layout is used to display the Search Results, the results page displays a single item at
a time. You can select the viewed result with the check box in the top left. In the top right, you can
navigate through the results or can go directly to a result by providing the number. The selected
search results can be viewed when the selection counter in the header is expanded. Read more about
Persistent Search Results on page 191 .

When enabling the Focus layout, dashboard can be created newly or can be selected from the existing
dashboards.

Note:  When a Task Search results are viewed with Focus layout, the Dashboard existing in the
respective Task Type is shown if it exists or else the dashboard specified for focus layout is
considered.
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Focus layout utilities the full screen for a single search result, allowing you to view the individual search
result items without opening a Document details or the Viewer window.

This can be combined with persistent selection and Viewer dashboard block, to click through a set of
search results and decide which ones to include and which ones to omit for a specific operation.

Focus Layout is enabled by default for Document searches, whereas for the Project and Task and
Approval search, it has to be specifically enabled by the Admin user.

Individual Result Actions

You can configure standard document operations like  in the document or Task
and Approval Search Results page. For example, from this page, you can send download links for the
selected documents.

Note:  In Tasks and Approvals Search Result page, the Document actions are only available for
approvals. The actions apply to the document on which the approval is setup.

There are two options to configure namely Default and Custom.

• Admin users can see the check boxes available in the Default (from Menu) like Approve, Reject,
Comment, View and annotate, Define Document Attributes, Lock and so on

You can navigate from go to Search > Documents and click on the Show Result Layout Options link.

Select the option you require to be displayed in your search result.
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By default, the operations selected in the image are enabled for Document search whereas for Task
and Approval search, the options Approve, Reject and Comment are only enabled. You can also add
Custom actions. Read more on configuring custom actions here.

• When you choose the type as Custom, then you further configure icon and color for each of the
action. You can also select the style as either Icon or Icon and Label.
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Note:  You can configure the search results layout options for:

• Document Search Results
• Saved Searches used in custom project/document menu items
• Saved search based My Work page

These actions will not work in the Saved Searches used as document sources in Project Creation and
Document References.

Show Additional Project Search Criteria
You can use the Show Additional Project Search Criteria option as a advanced search for Documents,
Tasks and Approvals in saved searches.
 

 

After selecting Show Project Search Criteria option, the following options appear:

Using these you can search on project features when searching for Documents or Tasks and
Approvals. Any of the project property or attribute can be used as a search criterion for Document
searching and for Task and Approvals searching.
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For example, you can search for the tasks in projects of a certain customer and what is the progress
currently going on for a customer. You can also use the Project start date, completed date etc to arrive
at the duration and filter on the other fields.

Configured Order
The order of columns for search results saved to excel files are now configurable by the admin user.

To enable this, choose the Configured Order in the Use following column order when exporting drop-
down.
 

 

When you choose this option, the order of the columns in the excel file saved is the same, as the order
of the columns in the Search Results page. This configuration is the default for all the new searches.

Note:  All the saved searches that were created in WebCenter Versions 16.1 or earlier will have Use
System Order by default and their order can be reconfigured.

Define Search Result Options
You can define which fields needs to be displayed for each search result. By entering numbers, you
can change the sequence of the columns or the sequence of the information in the grid cells. You can
choose to make the view of the field in the results either Available, Visible or Hidden

Note:  When you enter an existing number, all others shift to upward numbers. In case of list layout,
this information will be displayed in columns.

 

195



3 WebCenter

 

Note:

Click on any of the Gear icon to Show Time for the date / time fields. For Project Status, Gear icon
gives the configuration options like Automatic or Label and Icon, Only Icon, Only Label, and Color
Label. For Pending Approvers, Gear icon allows you to configure Show assignee details (original
Group /Role).

 

 

In case of grid layout, this information will be displayed in each cell either below the thumbnail or to the
right of the thumbnail.
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In case of card layout, the information will be displayed on the back of the card, which can be viewed on
clicking the card.

 

 

Link Visibility of Available filters and Columns
In the Result layout options page, Link visibility of Available filters and columns option is available.
When this option is enabled, and both the design panel item and the column are set up as being
Available for a certain field, making one of them visible will make the other one visible as well. Hiding
the field in design panel or column will cause both of them to be hidden. When a column is configured
as visible or hidden instead of available, showing or hiding a filter in the design panel from the search
results page will not affect the columns shown.
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Note:

In List view, a + icon appears on the right side of the table.

In Grid and Card view, a “More…” link is shown to add or remove information.

Set Attribute Value on a Search Result
The administrator can set the attribute columns to be editable when you run a search. By this, the user
can then select a number of projects or documents (depending on the type of search).

The administrator needs to determine what columns can be edited. This is done in the Search
definition panel.
 

 

In the above example, the administrator has selected Trademark and Brand attributes to be editable.
When you save and run the search, the attribute columns which are set editable will appear with a
pencil icon.
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Select a number of projects or documents and click on the Edit button. A dialog box appears asking
for a value. These values adapts to the type of the attribute. When the value is provided and Start is
clicked, you will see feedback about the progress and success of the operation.
 

 

Note:  When the attribute could not be set on a project or document, the feedback shows a failure icon
and gives the reason (No permission to set attribute, project is non-active, etc).

By clicking on Advanced, the dialog changes to accept different values for each project or document.
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Note:  Here, failure happens per item. So when selecting 20 items and the first fails, the rest is still
attempted.

Sorting Search Results
You can sort the search results in the List / Grid view based on sort-enabled search columns.

In the List Layout:

You can click on the primary sort field header  /  to switch between ascending and descending. All
sortable fields will have the sort icon next to their header text.

To change the primary sort field, click on the sort icon next to it.

• Up arrow  in the column header indicates that the results are sorted on this field in ascending

order. To sort the results in the reverse order, click .

• Down arrow  indicates that results are sorted on this field in descending order. To reverse the

order,click .

In the Grid Layout:
If the search results are in the grid layout, you will see a drop down with sortable fields instead of the
sort icons.
 

 
For example, sorting by Name / Reversed Name will make the name field in the ascending or
descending order.
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Note:

The configured sort fields will be applicable in both the grid and list layouts.

You can navigate to the page number you want by typing the page number in the footer. If there is only
one page to show the results, then there is no footer shown.

Task and Approval Search
In the Tasks and Approvals search you can

• Configure a search for Tasks and / or Approvals by choosing whether you want to search All
Approvals or All Manual Tasks or All Workflow Tasks from the Type drop down. You can also
choose any of the manual tasks or workflow tasks from the drop down or a combination of all the
above.

• search for Task Description or Task Type Description in their respective fields. There is also an
option to search on the Status of the Approvals or Tasks or a combination using multi-select.

• search for Task Created or Task Estimated or Task Created By or Approvals by Approval Master or
Stage Approval Status or Final Approval Status.

• Search on any Specification. Select any of the Specification from the drop-down to refine your
search.

• Filter the Specifications based on a Task Type. To filter, select a Task Type and enable Filter task
specifications by selected Task Type option.

• search tasks based on the document uploaded within the tasks or search for the document to
approve for approvals.

•  
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How to find the duration taken and time left for Tasks and Approvals
You can search to find the duration taken for Tasks (both Manual and Workflow) and also for Approvals.
You can choose/ filter the search with the following fields

• Started: Start date of the Task or Approval

• Due: Due date of the Task or Approval
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• Completed: date the task or approval was completed

• Duration: the time (duration) between the start date and the completed date. When the task is still
ongoing, it is the time between the start date and the current time.

• Time Left: the time between the due and the completed. When the task or approval is yet to be
completed, this is the time between the due date and the completion date.

When the time left is a positive number, then the due date is not reached yet. If it the search yields time
left as a negative number, then the task or the approval is overdue.

Note:

1. Both Duration and the Time Left do not consider weekends(Saturday and Sunday). You can also
switch the weekend days to Friday and Saturday.

2. You can configure to get either the time in days or in hours.

Reporting on Approvals
The main use case for approval search is reporting. In the search, you can find all the pending, and also
all completed approvals. Approvals can be searched for each Approver in an approval stage.

For example, if a user and a group have to approve then two rows are displayed, each with details about
who (of the group) completed the approval, and whether it was rejected or approved, and the duration.
This is very useful information for reporting purposes.

3.8.3.  Projects Calendar View

What is Project Calendar View?
The Calendar View is another feature of project search. Status changes in the project history are
displayed as project stages in a calendar. The picture below shows an example.

This creates a quick dashboard overview of your projects and helps you to prioritise which projects
need your attention.

Why should you use Project Calendar view
• To show the Actual Vs Planned status of the project
• View the Project status of the child projects as a drill down
• Due dates are set up as attributes which you can configure at the Project page
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To view the project feedback, project status history option must be enabled in Admin > Preferences >
Notifications > Include in Project History. Enable Project Status change. Click Save.

Note:

1. Calender View is enabled for Projects in List Mode only
2. To be able to use some of the calendar view functionality, you need the Lifecycle management

license.

You can view the status of the projects along with the labels in the search results. This view also shows
the planned vs actual status of the project status.

How Can you Set Up a Search with the Calendar View?
1. Go to Search > Projects.
2. Select the View check box Project Calendar to view in the Search results page.
3. Click on the gear icon to open the Configuration options for the Project Calendar. You can configure

the Project Calendar options to display your project status in a dynamic way. Configuration options
allow you to choose multiple options, which can provide information on the current status of your
projects and predict the future state. You can set the status based on the task completions or on
the date of the project statuses. Read more on Set up a Search with a Project Calendar on page
205.
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4. Specify the width (in pixels) for the calendar column (minimum is 200px but you get better results
with 500px). Decide whether to also show the project status icon (which will then appear at the left
of the calendar).

5. Click Search to view the Project Calendar.

Note that the calendar is displayed in the column defined for the project status. By changing the
column order for this column, you will move the calendar in the search result. In most cases the best
result is obtained, if the calendar is the last column and if there are not too many preceding columns.

Set up a Search with a Project Calendar
To set up a Saved search with Project Calendar option, in the search page.

1. Click on the gear icon in the Project Calendar row to open Configuration Options
2. Choose the options from Show Calendar View Containing  drop down options.

Options in the drop down are

• History: shows past statuses (history)

• History and Planning based on Project Status Due Dates: shows past statuses, planning based
on the milestones that are linked to the project status and the originally planned timeline (in
gray)

• History and Predictions based on Tasks shows past statuses, predictions based on the tasks

• History and Planning based on Tasks shows past statuses, due dates based on the tasks or the
lead time depending on which one is the latest.

• History, Predictions and Planning based on Tasks shows past statuses, due dates based on the
tasks or lead time and the originally planned time line (in gray).

Note:  The last three options are available with the task management license only.

3. You can select the Apply Forward Planning to calculate Predictions option, when you choose the
History Predictions and Planning based on Tasks or History Predictions based on Tasks. In such a
case, forward planning is done based on the start date and the next due dates are calculated based
on lead times.
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When this option is not chosen, then backward planning is done where the due date is considered
and the other due dates are calculated backwards based on lead times given.

4. Select Show Project Due Date to display the project due date in the search results.
5. Specify the Calendar Column Width  in the box for the calendar column (minimum is 200px but you

get better results with 500px).
6. Labels Shown on Project Status Bars gives options to display the labels in the Project Calendar

view. You can choose the labels to display Label shown on Project Status Bars from the drop down
list as one of the below:

• Number of Project Status
• Number in order of Appearance
• No label or
• Status Name configured

7. Select Search to view the search results.

In the Search Results page, Project Statuses of the project is shown over timelines.

 

 

The timeline can contain 2 bars:

• Actual: Displays the actual state of the project now.

For values in the past this bar will always be there and will show the Project Status History.
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For values in the future it can also show predictions based on tasks. Predictions based on tasks show
the due dates of the tasks or the lead time depending on which one is the latest or which one is first
when using forward planning. When calculating the date with lead times, week days are taken into
account.

• Plan: Shows the planned project status of this project.

Planning based on tasks shows the due dates of tasks that have an effect on the project status.

Planning based on milestones shows the values of date attributes in the project that are linked to the
project statuses.

Using the Basic Calendar View
In the basic Show Calendar View only 1 line is displayed and it stops at the vertical ‘today’ line.

• The vertical black line is always on ‘today’. So the current status of the project can be seen from the
color where the black line cuts through the status line.
 

 

• You can zoom the calendar view with the + and – buttons or with the scroll wheel. This changes the
time scale from months to weeks to days or reversely.

• You can pan the calendar view by using the arrows (just before the + and – icons) or by dragging also.
• Clicking the magnifier icon resets the view.
• The colors are as defined in the project status setup. (Admin/Project Management/Project

Statuses).
• The number displayed corresponds to the project status index (same statuses have the same

number in all projects).
• The small red vertical line indicates the project due date (if set).
• The color changes on the date where the project actually changed status.
• You can hover over any of the status blocks to get more information (name of the status, start and

end date, status type, calculated delay).

 

 

Using the Calendar View with Predictions

Note:  Calendar view with prediction is only available if the user has the task management license.

In order to use this feature, your projects must have Tasks configured to set Project statuses.

• The first part of the project line (till today) works as in the basic view.

207



3 WebCenter

• The second part (after today) shows a prediction of the project based on the project tasks
(rescheduled based on their current status). The estimated due date is based on the task
predecessors, task due date and lead time.

• A lighter version of the project status color is used to draw this part of the bar. For each project
status, it will look for a task completing this project status. Then it will determine from predecessor
logic which tasks need to be completed to complete this task, and how much time this will take in
total. For not started statuses, this will be the length of the block. For started statuses, it will first
subtract what is already consumed and only add the remainder (potentially nothing) to the block.
This way the time line is extended.

Using the Calendar View with Planning
When using this view, you will see 2 lines for each project, a colored line and a grey line.

• The colored line behaves identical to the ‘calendar view with predictions’.
• This grey line shows the planned project time line based on the project tasks. For each project

status, it will look for a task which completes this project status and for this task, it will take the
due date. This will determine the end date for the grey block of this project status (the begin date is
simply the end date of the previous status).

Notes:

• Subtasks are left out of the calculation.
• In case multiple tasks are set the same project status, one (merged) stage is shown only. This

situation is best avoided.
• In case no project status history is available, nothing is shown.
• ‘Completed’ Project Statuses are not shown in the calendar view. When a project has been put to

completed, and was started again later, there will be a gap in the history bar.

Project Status History Settings
In order to be able to show the project feedback, the project status history option must be turned on.

When loading the page, the following tests are made:

• If the global settings for the 'Project status change' include in project history is turned off, a
message box with a clear message is shown.

• If project specific settings for the 'Project status change' include in project history is turned off for
some projects (and the global settings is on), a warning icon with a clear tooltip message is shown
next to the project name.

3.8.4.  Search on Project Duration

Duration Reporting for a project
You can search for projects based on the Start date, Due date, Completed date, Duration and Time Left
of the project. You can save the searches and add it to the dashboard to have an instant view of the
progress of all the current projects.
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Field Name What it means

Started The start date of a project is the first time the project was set in an active
status.

Completed The last date the project was set in a completed status

Due The due date is shown in the project details.

Duration The time between the start date and the completed date. Only active statuses
are considered to calculate the duration of the project.

When the project is not completed, the duration is the time between the start
date and the current date/time.

Time Left This is the time between the actual completion date and the Due Date. When
there is no due date, the time left is not shown as it is not relevant.

When the project is in progress, the Time Left is the time between the due date
and the current date. When the current date/time is still before the due date, the
project is not overdue.

In this case, the time left is a positive number, indicating that there is still time
remaining before we reach the due date.

When the current time is after the due date, the project is overdue. In this case,
the time left is a negative number, indicating how much the project is overdue.

How to find Project Status Duration
You can also find the Duration metrics on the time spent in a given stage of the project. Projects
statuses can reoccur multiple times and you can compute the duration of time in each of the given
status.

 

 

Field Name What it means

Project Status Started The start date of a project Status is the first time the project was set in the
selected status.
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Field Name What it means

Project Status
Completed

The completed date of a project Status is the last time the project was in
the chosen status before it was changed to a new status.

Project Status
Duration

The project status duration is the time that the project spent in the selected
status. It is the sum total of all the time the project was in a particular
status. When the project went into the selected status multiple times, the
duration is the accumulated time the project spent in the selected status.

In this field, you can filter on the duration in days of the selected status.

Project Status Time
left

It is the time the project was in the Project Status. When there is no due
date, the time left is not shown as it is not relevant.

When the project is still ongoing, the Time Left is the time between the
current date with the Project Status Due. When the current time is before
the Project Status Due, the project is not overdue yet.

When the current date is after the Project Status Due, the project is
overdue. In this case, the time left is a negative number, indicating how
many days the project status is overdue.

For example: Let us assume that

Day 1:Jan 01 00:00 till Jan 02 00:00 => Project was in StatusA.

Day 2: Jan 02 00:00 till Jan 03 00:00 => Project was in StatusB.

Day 3: Jan 03 00:00 till Jan 04 00:00 => Project was in StatusA.

Project Status Started of StatusA is Jan 01 00:00 (first time project was in StatusA)

Project Status Completed of StatusA is Jan 04 00:00 (last time project was in StatusA)

Duration of StatusA is 2 days and Status B is 1 day

3.8.5.  Asset Browser

Asset browser is a user-friendly feature to search and find assets in a large collection of WebCenter
assets. You can customize the Asset Browser into the WebCenter Menu for easy access. In addition,
you can create more than one Asset Browsers in the same WebCenter with different names for
different sets of users for easy browsing.

For example, a project manager can benefit from an Asset Browser which will collect Project
Templates and a printer will benefit from one that points to finished Projects which are ready to be
printed.

You can create a menu item which can be named “Assets” or “Repository” or simply “Search” or
“Browse”. This menu will be linked to a highly configured Global Saved Search which will function as
your Asset Browser. One Asset Browser can be linked to one Attribute Category as in saved searches.
However, this Attribute Category can have multiple Cascading Dropdowns resulting in multiple
independent trees in the same asset browser. Read more in about Saving Searches as Asset Browser in
Setting Up an Asset Browser on page 212.

A customized graphical Asset Browser will help you to visually browse through projects and graphical
assets previously stored in WebCenter. To achieve this, you need to classify assets using custom
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attributes with graphical icons(Attribute Value Images). Read more about graphical labeling of
attributes in Setting Up a Graphical Asset Browser on page 217

You can set up a graphical browser or a tree browser and both. Technically, the Asset Browser has
all the features of Saved searches which is enhanced with Tree and Graphical browsing through
Cascading Attributes. Read more about Cascading Attributes in Lists on page 348

What You Need to Know about Asset Browsing

Concepts Used in this Section

Concept Definition

Asset Any digital file including pictures, graphics (PDF,
Illustrator, ...) and Oce documents stored in the
WebCenter. For example a piece of packaging
design that is uploaded to WebCenter.

Asset Browser A user-friendly way to find assets in a large
repository. Read more in Asset Browser on page
210

Repository A part of WebCenter which is considered to
contain assets. WebCenter as a whole is a
repository but by filtering you can pin-point to the
specific section of the repository. You can achieve
this by filtering on:

• certain document types
• range of projects based on project

characteristics or naming conventions
• both documents and project range.

Saved Search Highly configurable Saved Searches from
WebCenter 12 onwards. Read more in the following
sections from the WebCenter User Guide.
Advanced Searching on page 182

Tree browser This tree is built based on your Cascading
Attributes which you can put in the left panel to
browse through the assets.

Search Parameter Panel A panel appearing at the top of the search results
of Asset Browser which you can use to further
refine your search.

Organizing Assets in WebCenter

You can use the Asset Browser to its full extent by organizing Assets in WebCenter. You can upload the
assets in bulk during the early stage of the WebCenter deployment which will grow with new designs
and documents. For conducting effective search via an asset browser, you need to specify Attributes
(metadata) for your assets while uploading them to WebCenter. You need to:

• define Attributes.

• assign those attributes to Attribute Categories
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• assign the right attributes from this Attribute Category to the assets(documents) while uploading.

From WebCenter 12 onwards, you can assign these Attribute categories automatically to uploaded
documents. This is done by:

• using default Attribute Categories using Document Types.
• using document templates with Attribute categories

Read more about this in Autonaming Projects / Documents on page 467

When you store assets in specific projects you should ideally:

• have at least one project template created for projects specifically meant to store assets. This
helps in setting up Security, Roles, Autonames and default Attribute Categories which will aid in
better organization.

• not store too many documents in one WebCenter Project. Since Projects only have one level of
folders, project browsing gets slow when there are too many documents or too many folders in the
project.  Asset Browsing will be easier when they are stored with pre-determined metadata in a set
of projects.

Note:  You do not have to specifically create “asset projects”.  It is possible to design an Asset Browser
for entire WebCenter site.

Creating Asset Browsers

Setting Up an Asset Browser

1. Save a Search using your own search settings.
Asset Browser is essentially a highly configured Saved Document Search. Therefore, the features
of Saved Searches are available in the Asset Browser. You can:

• Set the Saved search to be Global or Personal as an administrator.

Note:  You should use the Global setting for Asset Browsers. Personal searches does not serve
the Asset Browsing function since they can only be used by admins who create them.

• Filter on almost any property or attribute of documents in advanced ways.
• Define a drill-down (parameter) panel to appear at the top of the search results.
• Assign the saved search to a menu item.
• Assign which document properties or attributes will be displayed in the search results and in

what sequence.
• Set the sorting order of the results.
• Set a preference on how many search results will appear per search result page.
• Define what operations can be done in the saved search results.
• Define layout settings of the search results (grid versus list, number of results, thumbnails or no

thumbnails).

 

Read more in the following sections from the WebCenter User Guide.

Advanced Searching on page 182
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To Save a Search on page 562

To Search Content

 
2. Add Cascading Attributes to the Saved Search. You need to follow the steps below.

a) Log in as an administrator
b) Create Cascading Attributes. Read more in Lists on page 348. Create an attribute category with

these Cascading attributes with which you want to customize browsing and displaying.
c) Go to Search > Saved Searches. Choose and edit the Saved Search from the previous step. If

you did not save the Search, go to Search > Documents and restore the previous settings (within
the same session) or start over.

d) Click on the Attributes link. Add the Attributes from the Attribute Category that you want to
assign to this search.

Note:  Only the Cascading attributes from theAttribute Category are available for tree browsing
in Asset Browser.

:  Avoid Using the same Attribute in different lists used in the same Asset Browser as it leads to
unpredictable results.

e) Enable Search Panel Design. In the Search Panel Design, you should set these attributes to be
Visible/Available

Tip:  The tree view in the Asset Browser requires the attributes to be set to Visible or Available
in the Search Panel Design.

You will have a top panel with Visible/Available Attributes to refine the search. Selecting a value for
one Attribute will limit the values for other Attributes.

Note:  If the Attributes appear but not as dropdowns, check whether the Attribute Category is
correctly configured. Assign it to a document to test whether the cascading effect works.

3. Create a Browsing Tree using Cascading Dropdowns.
A cascading attribute can be shown as a tree or as a set of mutually dependant attribute dropdowns
where choice of one from a dropdown limits the choice available in other dropdowns.
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You can choose from any of these two options or both views together. Read below some remarks
about these options.

• The tree view takes more space and loads slower
• The tree view allows multiple selection
• The tree view can be restricted using the depth parameter

• Dropdowns in the top panel can also be restricted

• The tree view can be shown in a graphic way (using thumbnails). This takes even more
space on the screen but creates a beautiful user experience provided you have good image
representations.

a) Go to Search > Saved Searches. Choose and edit the Saved Search from Step 1. If you did not
save the Search, go to Search > Documents and restore the previous settings (within the same
session) or start with a new Search.

b) Click on Show Result Layout Options. This opens a panel with additional options.
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c) Enter the list names that you have configured in the Listmanager project.

Note:  You can add lists to the tree panel by clicking on Add List or remove them by clicking on
the – icon. Use the arrows in the second column to move the lists up or down.

d) Set the properties for each list. These properties are applicable when a left tree panel is
selected.

Depth If you leave it empty, all the columns
from lists.xml will be available.

If you need four columns out of five
columns from your lists.xml, enter 4
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Height You can set a maximum height for the
tree here.

If you leave it empty, the tree will take as
much space as it requires.

If the tree height is bigger than your
entry in this setting, a scroll bar will
appear.

Note:  You can enter 1000 pixels or less
for the best user experience. However,
it can vary depending on the size of the
user monitor.

e) Set the browsing style for Tree browsing and Image browsing by modifying the following fields.

Tree panel width Default Tree panel width is 300 pixels
which you can increase or decrease
depending on your requirements.

Image Area Style For a browsing tree at the left hand side,
choose Left panel only (no images)

If you want to browse through an image
panel at the top, choose Top panel only
(no tree to the left)

If you want both tree browsing and
image browsing, choose Left panel and
image panel

Allow Changing Image Area Style via
Dropdown

If you want the user to change the
browsing style, enable this option.

4. Save/Run this search.
If you have save it as a global saved search, all WebCenter users can run this asset browser from
their saved search lists or from the menu if you have customized a menu item for this Asset
Browser.

Note:

You can restrict access to the Asset Browser by:

• deleting Saved Searches item from the Search menu for the restricted Users.

• deleting the menu item assigned for the Asset Browser.

When you run the search, you will get a tree in the search results. This tree will have branches
according to the columns in the lists (Cascading Attributes). You can see in the screenshot below:

• 1. The user can choose from three options. This is only available when you have enabled Allow
Changing Image Area Style via Dropdown. See the explanation above.

• Show left Panel
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• Show Image Panel

• Show left and image(top) panel

• 2. Tree Panel. This shows the information from the lists

• 3. Search Parameter Panel where you can refine your search using Attributes or document
properties.

• 4. Image Panel
• 5. Search Results

 

 

Setting Up a Graphical Asset Browser
As already mentioned, the tree panel to the left can be replaced with a panel of images at the top.
Alternatively, you can choose to have both at the same time which will give you synchronized results.

These images are a representation of the attributes and you can also configure an image label for an
attribute.

1. Create images for each value of Attributes and lists.
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Note:

• For the best user experience, use .jpg images. It does recognize .gif,.jpeg and .png.
• The name of the Attribute  (or lists) and the image should be entirely the same including the

case of the letters. Extensions should be specified in lower case.

• The images appear as 100x100 pixels.  If you add images exactly of this size, best performance is
assured. If the sizes vary, it will be adjusted to fit into 100x100 appearance. Therefore, the image
appearance will vary depending on your browser's capacity to scale images.

 

 
2. Add these images to WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom

\AttributeValueImages.
If more than one WebCenter instance is used, you have to copy this setup to each instance.
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Note:

Make sure that you have an image for each list used. In the above example screenshots above, this is
Brand.jpg, Packaging.jpg and no image attached with Product.

Use a .jpg for the lists since list images will be frequently used. As mentioned earlier, WebCenter is
optimized for .jpg. When some attribute value has no fitting image, the list image will be shown instead.

Removing the Search Button from the Asset Browser

If you keep the Search in the asset browser, for every search modification in the Asset Browser, you
have to click it to refresh the results. You can remove this button from the Asset Browser to improve
the user experience.

By removing the Search button, you can:

• save on screen space in the Asset Browser
• any change in the search criteria from the browsing tree or the search panel will update the results.

You can accomplish this by editing the Saved Search created for the Asset Browser:

1. Go to Search > Saved Searches > Edit Search
2. On the right hand side of the page, click on Show Result Layout Options
3. Disable the Show Search Button option.
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Customizing the User Menu with the Asset Browser

Assigning a Menu Item for the Asset Browser
You can create and assign a Menu Item for easy access to your Asset Browser. The procedure is
similiar to assigning a menu item for Saved Searches. Read Add Custom Menu Items on page 1068 from
WebCenter Customization Guide for details

1. Go to Admin > Preferences > Menus. Download the XML file or create a new XML file and add the
following code under the NON_ADMIN.

<menuitem>
<name>AssetDemo</name>
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<labeltag>Asset Browser</labeltag>
<url>dosavedsearch.jsp?searchName=AssetDemo</url>
</menuitem>

2. Assign the scope of this menu to the (set of) users or to a Company/Location. Read more in Add
Custom Menu Items on page 1068

3. Save this XML and upload as a new menu.

This results in the following Menu Item named Asset Browser. The search results are directly avaiable
by clicking on this item. The name of the page is the same as the name of the Saved Search. In this
example, the page appears as AssetDemo instead of “Search Results”

 

 

.

Assigning Submenus to Dedicated Asset Browsers
You can customize your Asset Browser further by creating submenus for different asset browsers with
a more dedicated and simplified user interface. This will help you to navigate easily between the asset
browsers( saved searches. You do this by adding a submenu to the asset browser’s menu item which is
explained in Assigning a Menu Item for the Asset Browser on page 220.

1. Set up dedicated Asset Browsers for your assets. These are Saved Searches called Brands and
Packaging in this example.

2. Update the XML file with the similiar fragment as in the example below. You can see that there are
submenus for the set of Asset Browsers created in the previous step.

<menuitem>
<name>Asset Browser</name>
<url>dosavedsearch.jsp?searchName=AssetDemo&amp;actionMenu=Asset Browser</url>
<labeltag>Assets</labeltag>
<menuitem>
<name>Brands</name>
<labeltag>Brands</labeltag>
 <url>dosavedsearch.jsp?searchName=Brands&amp;actionMenu=Asset Browser</url>
</menuitem> 
<menuitem>
<name>Packaging Types</name>
<labeltag>Packaging Types</labeltag> 
<url>dosavedsearch.jsp?searchName=Packaging&amp;actionMenu=Asset Browser</url>
</menuitem>
</menuitem>
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Note:

• This will result in submenu which folds out and permanent links on the top left below the main
menu bar.  The second one is caused by &amp;actionMenu=Asset Browser.

• Check the spelling as every character is important.

• This code addition is not necessary if you use one menu item for a single Asset Browser alone.
Example in Assigning a Menu Item for the Asset Browser on page 220.

3. Upload this XML to a new menu or update a previous menu in Admin > Preferences > Menus
4. Assign this menu to a set of Users or a User. You can also assign a menu item to a

Company/Location. This versatility helps you to restrict the access to specific Groups and Users.

Clicking on Brands under Assets will bring you to the saved search called Brands. You can save this
with simpler settings or with a graphical asset browser according to your preference. It is possible to
give different names to the Saved Searches and the submenu items.

Advanced Options in Asset Browser

Configuring the Cart in the Asset browser
You can configure the Cart in the Asset Browser which can assemble the assets selected from the
Asset Browser. From the Cart, you can:

• start the viewer
• download the assets
• start a new project with these assets
• modify the assets.

You can do several rounds of searching and browsing to add documents one by one to the Cart and
then proceed with the actions listed above. The Cart has to be configured by the administrator while
determining the settings of the Asset Browser (the Saved Search).

1. In the Search Settings, click on Show Result Layout Options which will open the Advanced
Functions.

2. Enable Show Cart.
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3. Save the search.

The next time you access the Asset Browser, the Cart will appear within a few seconds. You can now
add your selections to the cart.

 

 

Read more about using the Cart in Using the Cart from the Asset Browser on page 567 .
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Configure Project Creation from the Asset Browser
Your Packaging Projects often involve modification of existing packaging or creation of new packaging
with recurring elements. You can use a project template for these recurring elements. Asset Browser
will help you to browse for these templates and existing packaging projects while setting up new
Projects. You can either collect the relevant items to the Cart and start a new Project directly or start
Project creation from the action list menu. Follow the steps below to configure this feature.

1. In the Search Settings, click onShow Result Layout Options which will open the Advanced
Functions.

2. Enable Show Project Creation Link.

This will add a link to the search results action buttons (Create project from selected) and to the
Cart CartCreate project from cart.

3. You can choose the template for the project creation from Asset Browser. For this, enable the Fixed
Template option and select the template from the dropdown list.

Option Result

Fixed Template Select the template from the dropdown list.

Template from Characteristics Path You have to specify the path. For example,
projects\modificationTemplates.

Note:  Follow the correct spelling and letter
case.

Note:  Projects can have multiple
characteristics. The same template can
appear in multiple asset browsers together
with other sets of templates.

No Template Specified This will result in the standard project
creation user interface.

4. Save the search under the same name.

You can either use Create Project from Selected link or Create Project from Cart to create projects
from your selected assets(either from the selection or from the Cart. This will lead to project creation
user interface depending on the template choice made in the steps above. When creating the project,
the selected assets will be copied to the new project.
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Tips and Tricks

Tip:

In certain cases you might want to have your assets attached with different Attribute Categories to be
shown in your Asset Browser. For instance, when you have graphical designs attached to one Attribute
Category and photographs attached to another Attribute Category. If you want your Asset Browser
to show these two types of assets, you can create a third Attribute Category combining these two
Attribute Categories. You can create your Asset Browser attached with this Attribute Category. You
can refine your Search Results from the Browsing Tree or using Search Panel.

It is a good practise to name this combined Attribute Category with the name of the Asset Browser for
future reference. However, this is not mandatory.

Remarks
• You can use any quicker browsers like Google Chrome, Edge and Firefox on Windows PC and Safari

or Firefox on Mac.
• If the same value for an attribute exists in different Attribute Categories, the image label will be the

same in the Asset Browser. For example if you have attribute named "lemon flavor" for Brand A and
Brand B, you cannot have two different images for Brand A and Brand B.

• You cannot search for empty attributes. If you are doing a complex search with multiple
checkboxes from the browsing tree with one of them without a value, the Asset browser does not
give intuitive results.

• Attribute values or list names should not contain disallowed characters for the Windows Operating
system file names when setting up a Graphical Asset Browsing. Avoid the double quote as well.

Troubleshooting

Problem: The asset browser works fine on on WebCenter Instance but not on another
WebCenter Instance

• You need to copy all of the setup to each WebCenter Instance:

• Migrate the ListManager Project or Template.
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• copy the images to webinstance\custom\AttributeValueImages  

Problem: You get a message box with “No Search Panel Exists for attribute xxx”
The chosen attribute is not set to Available or Visible in the Search Panel Design.

3.8.6.  How to Search for Document Reference Attributes

1. To search for document references, click on:

• the attributes link from the Search Projects  /Search Documents page.
• the task specifications link from the Search Tasks and Approvals page.

You will get the Search Attributes / Search Specifications page.
2. Choose your Attribute Category with the reference to the document you are looking for.

 

 
3. For each of your Document Reference Attributes, you can specify the search criteria as:
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Options Description

Empty to search for projects / documents where the
document reference attribute has no document
attached to it.

 

 

Matches to search for a specific document by its name.

Note:  supports wild cards and special
characters

Select to select a specific Document from a specific
Project folder.

This option gives you a Select Document
Reference pop-up where you can specify:

• a Project
• the Folder
• the Document
• a single Version or a Revision. If you specify

a revision, all the versions of this revision
will become selected. The default is Any
version.

Note:  You can select the Project and Folder
to specify the location of the document.
But the search will locate all the versions
of the same document located in different
projects as well.

 Search for Reference Documents

Use Reference field to search on all document reference attributes or specifications in the Project /
Task and Approval searches.

You cannot make it viewable or sort on this field. If you want to make the referenced documents visible
you will need to do this by making specific document reference attributes visible.

Note:  It is not possible to search with Empty option.

It is recommended to use the SmartName Document Version ID rather than the SmartName Document
Name. The Document Version ID SmartName uniquely identifies the document version, when it is
searched in the Matched mode.
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Searching for Reference and Reference By
Use Reference field to search on all document reference attributes in the Document search.

When using the Referenced by, the resulting Documents will only contain a specific Document if the
latest version of said Document is referenced by the selected Document (Version).

You cannot make it viewable or sort on this field. If you want to make the referenced documents visible
you will need to do this by making specific document reference attributes visible.

Note:  It is not possible to search with Empty option.

It is recommended to use the SmartName Document Version ID rather than the SmartName Document
Name. The Document Version ID SmartName uniquely identifies the document version, when it is
searched in the Matched mode.

You can search or create saved searches for Documents with reference attributes. You can search for a
specific document used as a reference either by name or its project and location.

In both the Reference and Referenced by options, you can use

• Select/Matches: to search for the documents that are referencing a given document (version)

• Select/Matches (any level): to search for the documents that are referenced by a given
document(version)

Find an example below where both options are explained.

The arrows show the relation between the documents (E.g. Doc4 has a document reference to Doc2)

Reference

• Select “Doc1” in this field and it will return Doc2.
• Select (any level) “Doc1” and it will return Doc2 and Doc4.

Reference by

• Select “Doc4” this will return: Doc2 and Doc5.
• Select (any level) “Doc4” this will return: Doc1, Doc2, Doc3 and Doc5.

Both the Reference and Referenced by support “Any level” searching for Document References. It is
possible to turn the “Any level” searching off in the search crawler settings.

When using the Referenced by, the resulting Documents will only contain a specific Document if the
latest version of said Document is referenced by the selected Document (Version).
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E.g. Document A references both Document B (version 1) and Document C (version 1 whilst latest
version is version 2) => when searching for “Referenced by” Documents of Document A only Document
B will be found.

3.8.7.  Searching Documents

In Search for Documents page, you can filter the search to a specific document type. When a
document type is selected from the drop down, all additional parameters configured for the selected
document type becomes visible.

Search Documents by Version Count and Approval Version Count
As a Project Manager or Admin user, you may want to find the number of versions of a Document
existing in WebCenter (Version Count) or want to filter for certain count of Document versions on which
approval cycle has started at least once ( Approval Version Count).

To search the Version Count or Approval Version Count in the Document Search,

• check the field in the view and specify the column order
• enter the criteria in the respective field along with filtering conditions like greater than, equal to or

lesser than for Version Count and with filtering conditions like greater than, equal to, and variance
for Approval Version Count.

Search results shows the Documents along with the number of versions and number of approval cycles.

Searching on Documents

Search by Document Size
Users can search for documents which are of a certain size range using Version Size.

Version size will only show the size of the version of the document shown in the results. The size of the
previous version of the document is not shown.

The Version Size criterion is available for all document types. You can search, sort and facet on the size
of the document version (in bytes).

Search by Document Created Date
You can search the documents based on the creation date in a range or in the specified previous
number of days and make it hidden or visible or available in the results.

Folder Search
You can search for the folders and it is described in detail here.

Live Text in Document
You can search for a text within a pdf document or a AI file using this Live Text in Document. This field
is available for search, based on the setting in the Search Crawler configuration set by the Admin user.
This search does not find results for the text present within an Image or outlined text.
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When the search results are shown as a Focus layout with a viewer block, the matches for the searched
text are highlighted in the document. You can navigate through the matches to see where the searched
text occurs. The number of instances of the text occurring in the document are shown in the header.

Note:  This field does not support right to left text used in languages like Hebrew, Arabic.

 

 

You can navigate through the matches to see where the searched text occurs.

 

 

The number of instances of the text occurring in the document are shown in the header. When multiple
pages contain a match for the searched text, it is indicated with an asterisk and navigating through the
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matches will also navigate through the different pages. By hovering over an arrow, you can also see the
number of pages containing a match.

Search for Live Text in Document only works on left to right text. For example, text in Arabic or Hebrew
are not supported yet.

Search Document by Reasons for Rejection
You can search on documents for Reasons for Rejection. You can either search for the current version
of a document or search for all versions of the document.

Both the fields has 3 modes and a text field where you can enter any text. You can search for:

• Both Category and Reason (default)
• Only Category
• Only Reason

When searching in Both Category and Reason, this specific reason can be found by using the same
format as shown in the search results: “reason (category)” or “reason” (if there is no category).

Note:  The results are sorted on the Category and then on Reason. Reasons without a category are
displayed after all the reasons that have a category.

Document Duration
Duration Metrics for a document are related to the Approval cycle(s) on the document.

 

 

Some of the fields you can use to know the metrics of a document approval are

• Start date which is the start date of the approval cycle of the document

• Due date which is the due date of the approval cycle of the document

• Completion date which is the date and time the document reached an approved status

• Approval Duration is the time between the start date and the completion date when the documents
are already approved. When the document is not approved yet, it is the time from the start date
until the current date and time.
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• Time Left is the time in days that is still left until the due date. When the documents are approved
before the due date, the Time Left is positive and shows the number of days it is ahead of schedule,
whereas when the document is approved after the due date, the Time Left is the number of days
the approval was overdue. When the document is not yet approved, this is the time between the
current date and the due date.

Searching for Text Content Document

Search and Select Text Content in Search Menu
To search for Text Content, go to Search >  Documents > Search for > Text Content.

 

 

You can search based on the Text Content Criteria such as:
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• Element Type: To search for a document based on its Element Type, select it in this field. Smart
Names are available when Enable SmartNames is selected. Read more in: Element Types.

• Document Status: To search documents based on its status, select the status (Draft  / Signed Off)
from the drop-down.

• Statements' criteria: These fields allow you to select and search based on:

• Language of the Text Element. For example, select English - United States to search
for Master statements in English (US).

• Whether the Element is a Translation or Master. It can be specified in the Translation drop-
down.

• The directionality of the text will be based on the language selected. You can search both
Master and Translation languages for right to left languages like Arabic or Hebrew.

Note:  You can also leave these fields blank. If the language field is blank, all languages (both
Master and Translated) are searched for.

• Actual Text from statements: Type the word you want to search in the Text field.

• Text Element Status: Click ... and select the status from the drop- down. For example, you can
search for Signed-off statements with a particular text piece.

• Modified: Specify the time line you wish to search for like today, yesterday or last month etc .

• A combination of Text Statements' criteria

You can add new rows for additional search criteria by clicking +. When you have multiple rows,
you can use either AND or OR operation to refine the Search.

You can also ignore the search criteria mentioned and only display the results by choosing 
icon or you can choose the Any option to show results of text documents in any of the status.

In the example screen shot, the Search will find all Master Statements with Nutrients in its
content AND with French- France as Translation.

Configuring Text Content Documents Search Results
The Search Results page shows all Text Content Documents that match the specified criteria. Each
statement row selected to View is represented as a single column in the Results.
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Note:  You can save Text Document Searches in Excel. The document statuses are not included in the
Excel export.

Search Results Options
To customize the Search Results, select your criteria in the Search Result Options fields. The
Document Nameis selected by default but can also be removed by unchecking the box. Read in:Search
Result Options on page 557.

Search Panel Design
As an Admin, you can setup a Text Content Search with a Design Panel just like other document saved
searches. The users can select individual text statement criteria in the Panel to filter the search
results.

Note:  When smartname is selected for the language field, to view each resolved language in a
separate column in the Search Results page, select the view as visible.

 

 

Note:

• If no Statement language is selected from the language drop down, you will not be able to view it as
a separate column. The results will then match Text statements of any language.

• If the language chosen for the text has the directionality right to left or a custom font, then the text
is also rendered right to left or in the custom font in the search results.

Saved Search for Text Content Search
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To view My Saved Searches, go to Search > Saved Searches, you can view the saved search in the table
under Text Document Searches. Saved Search for Text Content Document behaves exactly like any
other document saved in the WebCenter.

Note:  Only an Admin can modify the visibility of a Global Search.

Search Document by Folder
You can now search and display the folder where a document resides. Folder Search is useful to set
up searches, to find certain types of assets. For example, when you have to search for pack shots in a
certain folder in the project. You can either select the root folder, or search with the name of the sub-
folder.

There is a new filter on the document search where you can specify the folder to look for. You can
either search in the root folder or the name specified.

You can facet the search results for folders in three ways namely:

• Grouped by Folder Name

When searching the system for documents, you can group all the folders by name when you facet on
the results.
 

 

• Individual Folders

When searching the system for documents, you can have the folders shown individually when you facet
on the results. In this case, the project name will be appended because you can have multiple folders
with the same name in different projects.

• Project Context
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When searching for documents and faceting on the folders within a project context, this facet option
will mimic the folder structure of the project, meaning all folders are listed, even when they are empty,
and the ordering is the same as on the project documents page.

Search on non Latest version of the document
In WebCenter 18.1.1, we added a new option to search index documents which are referenced to earlier
versions.

To enable this feature, Admin users must select Index all currently referenced Document Versions in
the Search Crawler Setup page. The index is rebuilt wherever the option selection is changed in the
setup.

This option is only useful, when you have the older versions of the documents which are referenced
and it would occur when a document reference with the "Selected Version" option is used.

When this option is turned on, the Document search setup page has a new field, Version Used In.

 

 

Following are the options that can be chosen when you search for a document based on the version
used.

• Project is the default option selected and the search returns versions of the documents that are
linked into a project or are the latest version of a document revision.

• Document Reference only option limits the search to referenced document versions that are not
the latest in any Project or Revision.

• Document Reference or Project returns any version in a project or referenced by any other
document.

Note:  Only versions referenced from a document reference in Documents are taken into account
and not if a version is referenced from a document reference in a project.

Search on Approval Status
You can search for more than one Approval Status by selecting multiple statuses in the Approval
Status field and you can also search on Approval status completed field.

With the Approval Status field you can also search for documents where the approval is stopped or not
set up yet.
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3.8.8.  Search on Pending Approvers

Pending Approvers
You can make the Pending Approvers column visible. This column shows all the approvers who still
need to approve. You can also sort, facet, and filter on Pending Approver. There is a configurable
option to show the assignee details of the Pending Approver.
 

 

Display User

To enable the navigation and filtering for specified approver(s) easier, you can choose to configure this
fields results. You can choose to show the pending approver(s) field in the Search results page either as
Name or Avatar and Name or Avatar only.

3.8.9.  Searching for Parent or Child Projects

It is possible to search for Projects which are related in a Campaign or Program. This is very useful in
creating Saved Searches that can be used in the context of a Program or Campaign.

It is also possible to use these Project criteria in the Document and Task searches.
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You can use the fields: Parent Projects or Child Projects to specify a name criterion.

Tip:  Use SmartNames to use Saved Searches in the context of a Program or Project. If you set the
Parent Project as the [Project id], your results will list all the Child projects of the current project. See
more in: SmartNames in Search on page 238

Note:

• The search results depend on the view permissions of the user.
• It is possible to save the Parent and/or Child Projects in Search results to Excel if that option is

selected.

If you specify the Parent Projects field as campaign_, the search will look for Projects with a
Parent Project with “campaign_”.

Searching in Parent Projects
When you are searching for Projects who has a certain Parent, you have three options:

• Search only in Direct Parent Projects: Use this option if you want to search in Projects that are one
level higher in the Program structure.

• Search in all Parent Projects: This option lets you search in all Parent Projects directly above and in
all higher levels in the Program structure

• No Parent Projects: Use this when you have to search in Projects that are at the top of the Program
structure, or the Projects which do not have parents.

Searching in Child Projects
When you are searching for Projects with certain child Projects, you have three options:

• Search only in Direct Child Projects to search in Projects that are one level below in the Program
structure. The second(and deeper) level Projects will not be considered in this search.

• Search in all Child Projects lets you search in all Child Projects from all levels.

• No Child Projects: Use this when you have to search for Projects that do not have Child Projects.

3.8.10.  SmartNames in Search

Administrators can create Saved Searches with SmartNames. SmartNames are variables that will
refer to a value when placed in the right context.

Read about the SmartName here.

Note:  These searches will resolve only in the context of the Project / Document and will not be useful
as a general search.

When you plug in these searches into a project / document, these SmartNames will resolve with
values retrieved from that context. For example, if you create a saved search for finding the related
projects, your users will be able to view the search results within a project tab. Read more in: Use Case:
SmartName Search to find Related Projects.
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You can also use SmartName searches as the document sources in Document Reference Attributes and
Project Creation.

These SmartName searches will display different results in different projects/documents as the
context of the SmartName changes.

Using SmartNames in Saved Searches
A SmartName is a variable that will refer to a value when placed in the right context (For example,
within a project or in the context of a document).

To create a SmartName powered search:

1. Go to Search > Documents or Search > Projects or Search > Tasks.
2. Enable SmartName.

 

 

All your search fields will display the SmartNames  icon.
3. Click on the  icon in the field where you want the SmartName configured.

For example, Project Name can indicate the group of projects it belongs to. In this case click  in
the Project Name field.

4. In the SmartName dialog, choose the SmartName.

 

 
5. Save the search. Your SmartName search will appear in the list of Saved Searches.

Note:  SmartName enabled searches can be saved only as global searches. These searches will be
visible only to the ADMINS group. You can change the visibility of the search by clicking the Edit
visibility button. Read more in Creating Advanced Saved Searches on page 183.
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You can plug these searches into the relevant projects where the SmartName will get resolved. Your
search results will then list the results based on the context.

Note:  If a SmartName gets resolved into multiple values (a multi-value Project Attribute), your
search criteria will be all of those separated by the OR separator.

Remember:  If you execute a SmartName search from the saved searches page, you will not get
valid results.

Save as Global when SmartName Context is enabled

Note:  SmartName enabled searches can be saved only as global searches. These searches will be
visible only to the ADMINS group. You can change the visibility of the search by clicking the Edit
visibility button. Read more in Creating Advanced Saved Searches on page 183.

Use Case: SmartName Search to find Related Projects
When you have a group of Projects under a Packaging Project / Program, your projects share
attributes. You can use these common parameters (in the search) to display the related projects /
documents. This is also useful when you have derived-projects created using the Create Project node.

Depending on your business needs, you can customize a SmartName powered search and plug this as a
tab in the projects details page. For example, you can display all the derived-projects in one tab and all
the related projects in another by plugging in SmartName saved searches in these custom tabs.

Tip:  You can configure this as a dedicated menu item for the Project Details / Document Details page.

SmartName Searches in Project Details / Document Details

To use your SmartName powered searches as a dedicated tab of the Project / Document details page,
create a custom menu item.

You can link this custom tab to a saved search with SmartNames.The SmartNames will resolve to
values derived from the current Project (for Project Details Menu Items) or Project and Document (for
Document Details Menu Items) context.

The user / group / company with this menu will have a custom tab displaying the search results based
on the SmartName criteria.

Use a SmartName Saved Search as a Document Source
You can create custom Document Sources using dedicated SmartName searches. You can use these
as sources in:

• Project Templates with Document Creation Settings on page 165.
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• Documents or Projects assigned with Document Reference Attributes

When the user uses this source during Project creation or to add documents to a task within the
Project, the Saved Search configured as the document source is executed from the current Project /
Document context.

Setting up a SmartName Saved Search as a Document Source

1. Go to Search > Documents.
2. Enable SmartName.

All your search fields will have a SmartNames  icon next to it.
3. Click on the attributes link.
4. Click the  icon next to the attribute from your attribute category.

As an example, if you want to setup a document source for a Customer, from the library of your CAD
files:

• specify the customer related attributes as the SmartName search criteria.

 

 

Tip:  Configure Search Layout options to get an advanced layout.

The selected attribute(s) will appear in the search form.

Tip:  The above example will work only in a document assigned with a document reference attribute
(category). If you would use this as a document source in project creation, use the [Box Brands
(Project)] as the SmartName.

5. Save the search.

Tip:  If you want to limit the scope of the search within a library of documents (a repository project),
specify the project name as another criteria.
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You can add this search as a document source in:

• Document Creation Settings on page 165 of Projects / Templates.

• Document sources in Document References on page 363

When the user clicks a custom link to add a document as a document reference, the result will be a pop-
up with the saved search results. You can configure the search result layout settings to configure the
features in the document source pop-up.

 

 

3.8.11.  Drilldown Searches

You can use Project search based drilldowns to set up a:

• Drill-down into all levels of Projects. This feature allows the Program Manager to explore project
data beyond the overview. If you have a nested structure (Project / Grouping / SKU / Components) in
your Program, an expand button lets you access the next level.

• Drill-down into Components (documents) or Tasks

Use Case: Program Search
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1. The parent Search with Programs. This example shows a Search Results Dashboard on page 244
with counters.

2. The second level of Drilldown which executes the Saved Search specified in the parent search. This
search contains a Dashboard with a Facet Graph.Configuring a Drill down Search on page 243

3. The third level of Saved Search with a Document Search.
4. The expand button to execute the drilldown.

Configuring a Drill down Search
To create a drill down view, you need a Project Search or Document Search with the Drill down option
turned on. As a result, the parent search will have an expand button in every row of the results table.

When you click on the expand, it will execute the Saved Search or display the associated child Projects
or Documents in the Search Results page.

Note:  Drilldown expand buttons are only shown in the List view of the Search results.

1. To set up a Search to show a drilldown of child Projects or related documents:
a) Search for your Programs (Parent Projects) or Documents.
b) Enable Show Drilldown using Saved Search in the Show Results Layout Options.
c) Save the search with all the advanced settings you want. Read more in:Creating Advanced Saved

Searches on page 183
2. To create multiple levels of Drilldown searches:

a) Create Searches for all your sub-levels and save them. Optionally, configure Dashboards.
b) Specify the Search Criteria for your parent search.
c) Enable Show Drilldown using Saved Search and specify a Saved Search from the drop-down.
d) Create further levels using the same steps.
To configure the layout of the drilldown in the search results, choose any of the three options for
the Layout, Selection and Actions. Read more about it here.
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Note:

• The Dashboard Facets will display the data based on the specified Saved Search. Clicking on a
Facet(Graph/List/Counter) section will refine the search results of child search.

• It is recommended to use Document Version ID SmartName than the Document Name
SmartName, since Document id is unique.

3.8.12.  Search Results Dashboard

WebCenter search dashboard organizes and create a visual representation of your data along with
tables. It is built using a set of smaller components (blocks) with specific information. The admin has to
configure each of these blocks in a Saved Search.

You can decide the layout and configure it with the components that suit your user's interest. To
configure a Search Results Dashboard, you can simply drag each component into your canvas from a
gallery. You will have live editable preview as you configure each of the dashboard component. Each of
these components can accommodate specific settings and search criteria.

All the search-specific blocks like facets, results table, asset browser, cart, design panel will show a
preview with real data instead of just a placeholder. When editing the configuration or dragging in new
blocks, the search will rerun to load the new data and the preview will be updated.

You can configure Dashboards with Project/Document/Task and Approvals searches.

Once setup, you can use Dashboards on your user pages such as:

• My Work

• Menu

• Project Details with context aware SmartNames

• Drill-down overviews of Projects/Programs

• Asset Browsers
 

244



3WebCenter

 

Note:  Live preview is not available when the dashboard is configured with SmartNames in it.

Types of Dashboard Blocks

Dashboard Blocks
A Dashboard consists of several building blocks that can show information as graphs, counters or
tables. These are interactive and you can use it to refine the displayed data. You can configure several
such Blocks in a Dashboard.
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Type of Blocks

General • Rich Text Block

• Selection Panel

• Counter

Layout • Collapsible Section

• Column Layout

• Left Side Panel Layout

• List Layout

Search
Facets

• Facet Bar Chart

• Facet Counter Bar

• Facet Donuts Chart

• Facet Horizontal Bar Chart

• Facet List

• Facet Pie Chart

Search
General

• Search Details

• Search Design Panel

• Cart
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• Asset Browser Side Panel

• Asset Browser Image Panel

Configuring the Search Dashboard Layout and Blocks
To configure a Dashboard, you can utilize any of the building blocks depending on your requirements.
You can make a visual representation of your search results using various faceting blocks. You can see
how your configuration will look like when you start building your Dashboard live.

• From the Project/Document/Task and Approvals Search page, click on Search Results Dashboard.
It opens up a canvas with a gallery on the left hand side. The gallery displays all the available blocks.

Tip:  Search Result Dashboard now supports Internationalization. You can define translations for
Block titles, Counter Labels and Rich Text fields.

• Arrange your Layout blocks.
a) Drag Layout blocks into your canvas. You can use combinations of list, left side panel, column

layouts and collapsible section to present your blocks.

• Select List Layout for a vertical list of blocks and Column Layout for a horizontal
arrangement.

• Select Left Side Panel Layout to present information in a left side Column Layout. This pre-
defined layout can be modified to suit your needs.

• Select Collapsible Section to present info which can also be hidden and expand one or more
blocks based on the requirements.

• Select Column Layout to display blocks in configurable columns. When the user adds a
Column Layout to the dashboard, the layout is preconfigured with 2 columns.

b) Add Rich Text Blocks to add any Text message/ information to your users.
• Determine the dimensions of your Layout blocks

a) Specify Spacing to define space between Layouts. This is optional and use it if you want to
separate the layout blocks.

b) To style your Column Layout, you define the width, minimum width and maximum width of
individual columns. If you leave the Width as empty, the columns will fill according to the
available space.

c) Fill each of these Layout blocks with the Search and Facet type of blocks.
• Configure the Facet blocks. To configure a Facet Graph, List or Counter Bar, specify the Facet field

(Search criterion) to facet on and the maximum number of facets to be displayed.
Read more about Facet fields in: Facet Settings.
a) Drag your Facets into the Layout block.
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b) For any Facet block, you can select the Type from Bar Chart, Horizontal Bar Chart, List, Donut

Chart, Counter Bar and Pie Chart (default).
c) Use Customize Value Order and ColorsCustomize Labels and Colors on page 249 to configure

custom labels and color definitions for Facet Graphs, Facet Lists, and Facet Counter Bars.
d) Specify the dimensions of your graph or chart (width and height). This is an optional step and if

the sizes are not specified the graph fits to the available space.
e) For Facet Counter Bars ( Facet and Search Based Counters ), you can specify the Style to adjust

the display size.
f) Optionally, specify a Block Title and enable Show Block Title and Border. This will enable a color

picker from which you can specify the Border color.

You can add Search Results, Search Panel, Cart Asset Browser Side Panel and Image Panel to your
Dashboard layouts.

Building a Search Based Counter
You can use a Counter block to display the total count of a Saved search.

To configure counters for your dashboard follow the steps below:

• Specify a Global Saved Search. In the counter display, the dashboard will show the count of this
particular search.
You can use a SmartName based search in a counter. If the SmartName cannot be resolved, the
counter will show a -.

• Add a Label. If you did not specify a label, the counter displays the Saved Search's name.
• Specify a Background Color.

The default color is green and you can change the color by typing a hex value or picking a color using
the color-picker.

• Select a Style from the drop-down: Extra small, Small, Small Left Aligned, Default, Default Left
Aligned, Large, Large Left Aligned and Large No Label.
You can configure several of these counters in a column layout to create an interesting overview.
Read more in: Program Dashboard with a Drill-down View on page 483.

248



3WebCenter

Note:  Enable or disable the Run Search on Click. This option is enabled by default. If this option is
on, you can click the counter to view the search results in the current window.

Customize Labels and Colors

How to Customize Labels and Value in Search Results
This option enables to configure the labels and color definitions for the Facet Counter Bars, Facet
Graphs and Facet Lists.

When any facet block is configured, there is an option to Customize Labels and Colors to modify the
labels and colors for the values selected. This can be used for string and status fields.

Note:  Date and user fields cannot have custom values. For example, if you are configuring Roles in a
facet list, then this option is not visible.

If this option is enabled, a new section appears in the configuration panel. A table is displayed in which
custom labels and color definitions can be configured. Click Add Value and a new row is added to this
configuration table.

To Add Value
To customize the labels and colors for the facet values, you can either select the values from the drop-
down list, input fields or even a range of values based on the facet chosen. For each value, a custom
label and color can be defined in the row. You can reorder rows by drag and drop. To delete the row, you
can click delete button at the end of the row.

Faceted fields like project status, approval status that have predefined colors that denotes a status, do
not allow color customization.

Enable Only display currently defined custom values and order to restrict the display of only the
customized values. In that case, the option Maximum number of facet values is ignored and Number
of values  field and the corresponding drop down becomes invisible.

Facet Settings
Facet blocks (see Types of Dashboard Blocks on page 245) allow you to visually represent your
specified search field (Facet). You can use the cascading drop-downs of available fields to specify the
Facet.

The Number of Facets (Number of Values) field determines the maximum number of facet values
displayed in the graph/ chart/counter bar/list. The facets with the most number of results get priority
in the chart/graph/list/counter bar display.

Facet Settings- Project Search Fields
1. Project Information has the following fields in the drop-down:

• Attribute Category
• Completed
• Created (date)
• Customer/Location (company/location)
• Due (date)
• Manager Location (company/location)
• Modified (date)
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• Project Creator
• Project Manager
• Project Template
• Project Status
• Salesperson
• Started
• Time Left

2. To facet on a Role, select it from the Roles drop-down.
3. To facet on an Attribute, specify it from the Attributes drop-down (Text attributes, Text restricted

set attributes, Numeric and Date Attributes).
4. You can facet on the Project Status Duration, Project Status Started, Project Status Completed,

Project Status Due Date and Project Status Time Left. You can read about it here.

Facet Settings- Document Search Fields
1. Document Information Facet has the following criteria:

• Approval Completed
• Approval Due
• Approval Duration
• Approval Started
• Approval Status (status only)
• Approval Status Completed
• Approval Time Left
• Approval Version Count
• Attribute Category
• Author’s Location (company/location)
• Created
• Current Approval Stage
• Folder
• Modified (date)
• Pending Approvers
• Version author
• Version Count
• Version Size
• Note:  When you select Version Count, you can specify the range of the values and customize

the label names and the display colors.

2. Document Attributes:  You can specify the attribute from the Attributes drop-down with Text
attributes, Text restricted set attributes, Numeric attributes and Date attributes.

When you choose numeric attributes, range of values has to specified and labels can be customized
for display. The range and the label are displayed in the same order.

3. Specific Document Information You can also add specific document meta data based on the
document type searched for and display in the search dashboard. When you search for text content
documents, you can show for Document Status and Element Type.

Facet Settings- Task and Approval Search Fields
1. Task Information Facet can be of the following criteria:

• Approval Master
• Assigned To
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• Assignee’s Location (company/location)
• Completed (date)
• Completed by
• Due
• Duration
• Final Approval Status
• Modified (date)
• Reason(s) for Rejection
• Stage Approval Status
• Started
• Status
• Task Created (date)
• Task Created by
• Task Estimated
• Time Left
• Type

2. You can also Facet on Task Specifications. The Specifications (Numeric, Text, Text restricted set
and Date) are listed in the adjacent drop-down.

Note:

• When you select a Date criterion, you can specify the time in the past or future days, weeks and
months when applicable.

Facet Search: Viewing Search Results

Facet List
A Facet List presents the search information in a List. All possible values for the faceted field ( the
search criterion specified) are presented in a list form in the descending order of the number of
occurrences (displayed in the list as a badge).
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Facet Graphs
Facet Graphs present the data based on the Facet Field as a graph like bar or vertical bar chart or as
donut chart or pie chart. All possible values will be presented as separate sections in the graph. There
is priority for the values with the number of occurrences if there is a specified value for the Facet Field.
Read in Facet Settings on page 249.
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Facet Counter Bar
The Facet Counter Bar lists the number of occurrences of the faceted field in a horizontal bar and
similar to the Facet List, the counters appear in the descending order.

You can specify the Style to adjust the alignment and size of the counter bar.

Note:  The number of values of the faceted field is restricted by the maximum values set in the
Dashboard Facet settings.

Refining Search Results using AND/OR Operations
To refine the search results to one particular value (of the Field/Criterion), simply click on the item (or
section) in the List. The results will be refined and you will see 'x’ icon to deselect. You can either use 'x'
or click on the value again to deselect it.

By default, this is an OR operation. To display a results of all the selected 'values' of a particular Field,
you can simply click on all of them and switch the operation to AND.

When you click on a list/counter/graph item or section, by default, search uses an OR operation to
refine the results. For Facet Fields (Attributes/Specifications/Roles), you can switch to the AND
operation to combine these sections.

Note:

• The Information Fields (Project, Task and Document information) do not show an operator.

• The Date and Time Fields show only OR operator.

Important:  Clicking on a section would automatically update your search results if the Show Search
Button option is turned off. If this option is on, you have to select a section and then click Search.

Default Colors
If you are faceting on project statuses or document approval statuses, the appropriate colors are used
for the count badges, graph sections and counters.

Image Spinner
Image Spinner allows you to display selected images in a Dashboard. This can be a display of your
relevant artworks or any relevant images.

See the settings of this block below:

• Saved Search: Select a global saved search of graphical documents (pdf, ai, png, jpg, jpeg). The
first 25 images will be displayed in the image spinner.

Note:  It is possible to use a SmartName based Search. However, make sure that these
SmartNames are resolvable to prevent an empty image spinner block.

• Horizontal & Vertical resolution of the images: Specify a resolution value for the image. The value
can range from 1 pixel to 5000 pixels.

• Scale image to width of block (Default option): When this option is on, the images are always
completely visible. If the option is off, the images are shown according to their size.

• Seconds: Specify the duration of display for each image in seconds in this field.
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3.8.13.  Search Results Formatting

Search Result Formatting framework makes it simple to present result data in an attractive and clearly
communicating form.
 

 

Admin users can setup Search Results Formatting by navigating from the Search setup page for
Projects or Documents or Task and Approval Searches.

This opens a pop-up with two tabs, namely Fields and Row/Card. The default selected tab is Fields.

Choose the Row/Card to set up a styling rule in the Search results or you can set up the rules specific
to each field by using the Field tab.

1. Select Add Rule to add a new rule to the field chosen with a defined condition.

This adds a row to the table and allows selecting:

• A Condition
• An Operator
• A Value
• A Style
• Apply to Fields (only for Fields tab)

The first three columns determine when the rule for styling should be applied.

Rules created can be reordered by drag and drop and the order determines the required sequence.
2. Select a field based on which you want to create the rule for styling from the Condition drop down.

The list displayed may vary based on whether it is a Project or Task and Approval or Document
Search.
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Document search will have fields related to Document Information like Approval Completion Date,
Document Name, Description, Last version Comments  along with Document Attributes, Project
Information related fields, Roles and so on.

3. Based on the field chosen for the Condition, relevant operators are available in the Operator drop
down. For example if any date related field is chosen for Condition, then the operator will have
options like Is after, Is empty, Is Before and so on.

4. Again based on the operator used, only the relevant fields are shown. If the Condition field is a date
and if the operator chosen is Is after, then the relevant date fields are shown in the drop down with
an offset option.

5. In the Style field, you can either Create New Style or Import an existing style with the saved
searches. If you want to create a new style, click on Create New Style to open the pop up window.
Styles can also be imported from another saved search for consistency and eciency.

You can edit an existing style by clicking on the edit icon and click OK to make the changes to the
same style or you can Save as New Style.
 

 
6. Choose the field from the drop down for which you want to set up a Style chosen or created in

the Apply to Fields. You can choose more than one field per row or can create multiple rows for
different conditions or operators.

7. For the Row/Card, follow the steps from 1 to 5 to set up a style for the search results.

Styles thus created are available per saved search.

Create New Style
You can create new styles to apply it on either selected fields or the complete row in the search results.
Click on Create New Style to open a pop up window.
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1. Style Name is a required field by default. You can provide a unique name to the style you are
creating.

2. Select the background color for the style from the color picker tool.
3. Select Use Background Color Label in the check box to use a background color only for the label.

This option is only available for field styles.
4. Choose a text color for the style from the color picker tool.
5. You can either choose No border or Right or Left border for the field or the rows of search results.
6. Specify whether you want to have Both Icon and Value or Only Icon or Only Value to be displayed

for the fields in the search result. If you choose any of the icon options then another drop down in
displayed with the available icons. When an icon is chosen, you get additional options to choose
the color and the Icon Size also. In case you choose Value Only or Icon and Value option, you get an
additional field for entering a Fixed Text which will be displayed in the field.

Import Styles
You can select the Import Styles to reuse any existing style in the saved searches.
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1. On selecting this option, you get a drop down of all the available saved searches with styles. Choose
the saved search which has the requisite style.

2. You will get an additional drop down to choose from all the styles already created in this Saved
Search. Styles available for field is displayed when you choose this option in the Fields tab and
styles available for rows are displayed when you choose this option in the Row/ Card tab.

3.8.14.  Setting Up Project Operations in Saved Searches
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Updating Due date, Manager or Status
The Project Manager, Due date and Project status properties can be modified from Project search
results or a saved Project search results.

Note:

All actions are restricted to current permissions on the individual projects involved.

 

 

1. In the main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Enable the Editable check-boxes for Project Status, Due and/or Project Manager.

Use the Editable column to enable bulk operations on projects. You can modify the following
parameters of several projects at once:

• Due date

• Project Manager

• Project Status

• Attribute Category or Project members/permissions

• Project Role assignments

The bulk operations can be done from the Search Results page or from Saved Search Results page.
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Note:  These bulk operations are always limited to current permissions on the projects involved.

When you enable the Editable items, you get an Edit  button next to the selected items in the
View List.

4. Now Save the Search or click Search.

 

 

Note:  For each Editable item, a corresponding option will be created in the table actions bar.

Updating Attribute Category or Project Member / Permissions
You can setup Project Search Results to allow bulk updating of:

• the Project Attribute Category
• Project Members
• Project Permissions

1. In the main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Click Show Result Layout Options to see advanced search options.
4. Enable Allow Changing Attribute Category and / or Allow Changing Project Members.
5. Now Save the Search as Global.

Updating Roles
1. In the main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Add one or more Role Search Criteria by clicking the Add Role Search Criterion link.
4. Enable the Editable check-boxes for the role or roles that you want to make editable.
5. Save the Search as Global.

Detach Child Projects
You can configure Detach Child Project(s) operation in a Saved Search. Program Managers can use
this in a contextual Saved Search configured in the Parent Project's details. The use case is that the
Project or Program Manager can select existing Child Projects displayed in the search tab and detach
them from the Parent Project.

Note:  The action is only available to the users with Change Permissions of the parent and child
project.

• Create a global Saved Search to search on child Projects. Enable the Search Result Layout option
Allow Detaching Child Projects.

• Apply the Saved Search into the Project Details menu of the Parent Project Manager.
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• To detach child Projects, go to the Child Projects tab with the saved search, select child Projects
and click Detach Child Project(s).

3.9.  Inline Editing

Inline Editing allows you to directly edit a Project or a Document or a Task in Search Results page or
Dashboards for editable fields. Editable fields have a pencil icon next to it on hover, indicating that it is
possible to edit that field.

When a field in Search or in Dashboard is set as editable and if you have the necessary rights, you can
edit the field. The changes are applied to the corresponding Project, Document, or Task.

List of editable Fields in Search Results page or in Dashboards for Project, Documents and Tasks can
be checked here.

For example, to re-assign a task in your Search Result page, there is no need to go to the Task
execution page to change the assignee and go back to your search, you can just directly edit it.

 

 

Conditional Formatting for Editable fields

You can edit a field inline in Search Results page or in the Dashboard which has some conditional
formatting set. If the field is a Restricted set or Project Status or Task status or a dropdown that is
connected to a list, the values in the drop down are shown with the conditional formatting applied on it.

For example, there is conditional formatting set to show the values as progress bar.
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Live Preview

Preview of any editing done to is shown both for editable and non-editable information. When editing
a value, preview of changes is shown in all the instances of the field within the same Dashboard and
across all locations in WebCenter.

For example, when the Project status is edited in a list, all other instances of project status (of the
same project) is also updated simultaneously in the Dashboard.

Similarly, when a Project name is changed, then it has a cascading effect on the child projects or
parents' projects. The same applies to Document Name changes, where the change is also affected
across all versions of the document and wherever the document may reside like a Document reference
or a Task.

When the Conditional formatting rules are edited, the changes are visible in the Dashboard
simultaneously. This could be helpful for Project status and Task Status based Dashboards.

Some of the fields where the live preview do not reflect immediately are

• Project Calendar or Project or Task Approval due date which reflects in milestones
• Auto naming of the Project or Document
• Rules triggered based on events

Rich Text fields

Rich Text fields are also editable inline. Select the text in a rich text field to open the rich text panel.
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3.9.1.  Configuring Editable Fields

Configuration of Editable Fields in Search Results

To make a field editable, enable the editable option in the Search Results Options for a Search.
Editable fields for Projects or Documents or Tasks and Approvals varies as per the context.

 

 

Configuration of Editable Fields and Required fields in Dashoard

When you configure any type of Dashboard ( Project, Task or Document), in the Configuration panel,
select the Editable option.
 

 

Enabling Mandatory fields in the Dashboard forms

As Dashboards can be used to create input forms and some fields can be made as required fields while
designing the form itself. For example, Project Manager field in a Project Creation form or an attribute
value in an attribute-based form.Inputs for the required fields are validated on save.

You can select Required option to make the dashboard block as a mandatory field. An error message is
shown when any of the mandatory field is not filled along with the fields not filled in.

Configuration of Bulk Editing

Admin user has to select the Show Bulk Edit Actions for fields marked as Editable option in the Table
Bulk Actions in Search Result Layout Options.
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Note:  Pencil icon in the header to bulk edit is available for whichever field has been chosen as Editable
irrespective of the above option selection.

3.9.2.  Inline and Form Editing for Projects, Tasks and Documents

Inline Editing in Projects
Project fields that are editable are Project Name, Description, Attributes, Role, Due, Sales Person,
Project Manager, Project Status.

Inline Editing in Documents
Document fields that are editable are Document Name, Description, and Attributes.

Note:  Editing Attributes in both Projects and Documents has two preconditions. Firstly the user
must have the editing permission for the Attribute values and the Attributes should be present in the
Attribute Category of the Project or Document respectively. Document References are editable in Edit
form Dashboards only.

Inline Editing in Tasks
Task fields that are enabled for inline editing in Dashboard and Search Results are Name, Description,
Due, Task Estimated, Task Status, Task Specifications, Assigned to (not applicable for Approvals and
only to Project members with permissions),  Documents (in Edit form Dashboards only).

Note:  Specifications are only editable, if they are in the Task Type of the Task and if the user has the
right to edit the specification values.

3.9.3.  Shortcuts in Inline Editing

Inline editing can be performed by using shortcut keys easily. Click on the first field that you want to
edit and after that you can continue editing using only the keyboard.

When you are not inline editing and the mouse points to one of the things you could potentially edit, you
can use the following:
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• Arrow Key Right: To navigate to the next inline editing input in the same Dashboard or same Search
results row.

• Arrow Key Left: Navigate back to the previous inline editing input in the same Sashboard or Search
results row.

• Arrow Key Down: For list layout, cursor moves to the next inline editing input in the same column
(inside the same table) and for non-list layout (Grid layout, dashboard…), does the same as Arrow
Key Right.

• Arrow Key Up: For list layout, cursor moves to the previous inline editing input in the same column
(inside the same table) and for non-list layout,does the same as arrow key left.

• ENTER: Enter inline editing mode for the selected field.

While you are actually inline editing, you can use :

• Tab : To Save and go to the next input
• Enter: Save and do the same as Arrow Key Down afterward and Ctrl+Enter Only for multiline fields

(Description, Rich text attributes)
• Escape: Cancel and keep the focus on the current item.

When you are in a dropdown:

• Arrow Key Down : Go to the next element in the dropdown.
• Arrow Key Up: Go to the previous element in the dropdown.
• Enter: Select the element and close the dropdown if only one value can be selected for this field.
• Escape: Close the dropdown.

Note:  Tab is a general shortcut in browsers, that is used in Search Results or Dashboard page to go to
the next input or link.

3.10.  Managing Companies

Entering Company and Location information lets you further refine projects and users when they are
created.

System History Logs
All Companies related events like

• Companies Created
• Companies Deleted and
• Companies Changed

are recorded and stored in System History. Read this page on how to access the  records

3.10.1.  Create a New Company

1. Click Admin > Companies > New Company.
2. Enter the information about the new company (Company Short Name, Company Legal Name,

Phone...).

Fields with asterisks next to them are required to have information in them.
3. Do you want the users of this company to see custom menus instead of the default WebCenter

menus?
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Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. See Menus  on page 107.

Note:  Users linked to a company will always see the menu assigned to the company, when the
Default menu is assigned to them as a user.

• If yes, choose the menu to assign to the company in Menu.
• If no, leave Default in Menu.

4. Click Create.

A status message saying the company was created successfully appears at the bottom of the page.
You can create an additional company by filling out the form again and pressing Create.

3.10.2.  Edit a Company

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Click the name of the company to change.

This opens the Edit Company page.
4. In the Name and Menu tab, you can change:

• the Company Short Name,
• the Company Legal Name,
• the Menu that the users of this company will see (see Menus  on page 107 for information about

menus).

Click Save to save your changes before switching to another tab.
5. In the Locations tab, you can edit the company's location(s):

• click a location to edit its details (Location Name, City, Country...),
• to delete a location, select it and click Delete Location(s) in the actions menu,
• to add a location, click the New Location link and fill in the new location's details.

6. In the My Work Setup tab, you can change what the company users will see on their My Work
page. Click on Setup Custom My Work  to customize the My Work page displayed for the selected
company's users. Else the default My Work page is displayed for the users.

Read more on how to set up My Work page for Companies here Set up My Work page on page 267.

3.10.3.  Merge Companies

You can merge two or more companies using the Merge Companies option in Admin > Companies.

1. Select the source company / companies which has to be merged.
2. Choose the Merge Companies field, to open the Merge Selected Companies pop-up window.
3. Choose the target the company from theMerge to Company drop down.

A warning message will be displayed when the source company / companies has one or more
locations in common with the target Company. The source company locations will be renamed to
<location_name>_<company_legal_name>.
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4. Click OK to merge the companies.

3.10.4.  Delete a Company

If the company you delete has users assigned to any of its locations, WebCenter issues a dependencies
warning.

You must reassign the users to another location or delete the users before you can delete the company.
There is no dependency check if there are no users assigned to any location.

If the company is only assigned as a customer, it will be deleted when you confirm the deletion.

Note:  Attempting to delete multiple companies will stop on the first company that has dependencies.
To delete the rest of the companies, reselect them and delete them.

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Select the checkbox of the company to delete.
4. Click Delete Company in the actions menu.
5. Click OK to confirm the deletion. The company is deleted.

3.10.5.  Add Locations New

Context for the current task

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Click the name of the company for which you want to add a location.
4. Click the Locations tab. The current locations for the company are displayed.
5. Click New Location at right.
6. Enter the appropriate information and click Add Location. The new location is created.

All Location related events like

• Location created

• Location merged

• Location deleted and

• Location changed

are recorded and stored in System History. Read this page on how to access the records.

3.10.6.  Edit a Location

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies. Click the name of the company for

which you want to edit a location.
3. Click Locations on the menu. The current locations are displayed.
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In the location list, you can merge the two or more locations of the same company. Read how to
Merge Locations on page 267 here.

4. Click the name of the location to edit.
5. Change the information as desired and click Change. The information is changed and a

confirmation message appears.

3.10.7.  Merge Locations

You can merge two or more locations of a company using the Merge Locations option.

1. Navigate to Locations tab in Company details page, to view the locations of a company.
2. In the location list, select the source location(s) that you want to merge.
3. Choose Merge Locations to merge the selected location(s) to a target location.
4. In the Merge Selected Locations pop up window, choose the target location from the Merge to

Location drop down and select OK to merge.

3.10.8.  Set up My Work page

Admin users can set up customized My Work page for all users in a company.

1. Navigate to Companies and select the company for which you want to set up My Work page.
2. In the company details page, open My Work Setup tab.
3. Click on  Setup My work to open the My Work page in edit mode. If it is al
4. Follow the steps given here Edit the Default My Work Page on page 129 and Save.

3.10.9.  Delete a Location

If the location you delete still has users assigned to it, WebCenter issues a dependencies warning. You
must reassign the users to another location or delete the users before you can delete the location.

Attempting to delete multiple locations will stop on the first location that has dependencies. To delete
the rest of the locations, reselect them and delete them.

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies. Click the name of the company for

which you want to edit a location.
3. Click Locations on the menu. The current locations are displayed.
4. Select the location(s) to delete by selecting the checkbox next to the name.
5. Click Delete Location(s) in the actions menu.
6. Click OK to confirm the deletion.
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3.11.  Managing Users

3.11.1.  Licensing and Users

WebCenter supports two types of licensing models. You can have counted licenses in the Named User
License Model on page 270 or Concurrent License Model on page 268 where you can have licenses
that are taken up during a log-in sessions.

Concurrent License Model
In this model, you can create as many users as you want. The number of users who may use the system
at the same time is determined by your Concurrent Licenses. The licensing model distinguishes
between three types of users: guaranteed users, concurrent users, and editor users.

Types of Users in Concurrent License Model
Guaranteed users

A guaranteed user can always access WebCenter, regardless of how many concurrent users are
logged on at the time.

Concurrent users

Any other user who does not have guaranteed access can log on to WebCenter as long as the
maximum number of concurrent users are not exceeded.

You can assign guaranteed sessions to users, even without having the WebCenter Integration User
licenses and all guaranteed sessions are taken from the pool of concurrent licenses.

Note:

For every three guaranteed users you create, one concurrent user license is blocked permanently.

For example, if you have 25 concurrent licenses for 100 non-guaranteed (concurrent) users, 25
concurrent users can log in at any time.

If you give 25 users guaranteed access, these users will take up 8 concurrent licenses. This means
that only 17 concurrent users (out of 100) can log in simultaneously, because 8 concurrent licenses
would be permanently blocked by those 25 guaranteed users (25 x 0.333 = 8.333).

Editor users

These are ArtiosCAD Enterprise users. They have guaranteed access but do not take away concurrent
licenses.

You will have a fixed number of editor users, determined by the license you have purchased. When that
number is reached, you cannot set more users to be editor users.

Generally, your system will either have guaranteed and concurrent users, or editor users.
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If you have editor and concurrent users, and all your concurrent access licenses are in use, a
concurrent user will not be able to access WebCenter, even if you have editor licenses left (a
concurrent user cannot use an editor license to log in).

Integration Sessions

For your integration sessions (e.g. for the SDK or Automation Engine), you can allow Multiple Open
Sessions (for SDK or Automation Engine) for a User.

Each of your workflow connections connected through tunnel clients will block one integration
session license.

When all the Integration Licenses are utilized for integration sessions ( for SDK or Automation Engine),
then the concurrent license pool is used to allow further integration sessions. In such a case, one
concurrent license is blocked for every three integration sessions.

Advance SSO
The Advanced Single SIGN ON is also a license for the concurrent license model. From WebCenter 18.1,
license file received will have the Advanced SSO feature by default.

Mutiple Guaranteed Sessions
You can allow multiple open sessions (such as the SDK user or Automation Engine user) as guaranteed
sessions for a User. However, every three such sessions will block a concurrent license reducing the
number of available concurrent access.

Workflow Connections
Your workflow connections connected through tunnel clients will block one concurrent license each.

What if the user limit is exceeded?
When the limit of users with concurrent access is reached, no concurrent user may log in until another
user logs out.

To prevent users from blocking access for others, there is a configurable time limit of 30 minutes of
inactivity. After any users (guaranteed or not) have been inactive for that amount of time, they are
logged out automatically, thereby allowing other users to log in.

Note:  The Admin user can always log in, even if the user limit is reached.

Check the Licensing Status
1. Click Admin and navigate to Users. To see the users who are currently logged in, click on the eye

icon.

You can filter on the Active users or currently logged in users.

Users who simply close browser windows do not actually log off until their sessions expire due to
inactivity (usually after 30 minutes). Users should always click Log Off when they are done using
WebCenter.

Note:  To forcibly log off a non-guaranteed user to make more concurrent licenses available, click
Log user off next to that user’s licensing status. Use this with caution as it may result in data loss. It
would be prudent to try contacting the user in question before using this command.

2. The Users page also shows this table, where the utilization of different licenses are detailed.
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• Concurrent Users: all users logged in currently apart from Guaranteed access users.

• Editor Users: the sum of Guaranteed Access (GA) users on the system.

• Integration user sessions: sum of all the reserved integration sessions and the number of
workflow connections made.

Note:  When the Guaranteed Access users and integration sessions and workflow connections
licenses are exceeded then, they utlilize concurrent licenses in a factor of three items using one
concurrent license.

If the number of available licenses reaches a specific threshold, it is displayed in red to indicate the
license pool is depleted. The following threshold is effective per license type:

• Concurrent Licenses: 5
• Editor Users: N/A
• Integration Sessions: N/A

If a license violation is effective, (no more free license to allow log in) a warning icon appears next to
the appropriate license type and the Remaining count value are shown in the next column.

Named User License Model
A Named User License is an exclusive licensure of rights assigned to a single software user. This
License model lets you pay for the number of users you want to create in WebCenter. This means that
the purchased number of licenses (per type of users) limit the number of users that can be created.

You can view the number of licenses per user type on the Admin > Users page.

Types of Users (Named User Licensing Model)

Regular Users
These are the users who use the non-admin pages of WebCenter. The WebCenter Regular user limit
determines how many regular users can be created in the system.

Project Creator
These are regular users but can also additionally create projects. They have no other rights on the
project after creation. When the licenses of regular users are exhausted, the project creator licenses
can be used for regular licenses.

Example:
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When you have to create regular users and the number of regular users licenses has been used up, you
can use the remaining Project creator license for these extra users.
 

 

Note:  You can hover over the warning symbol to see the number of Project Creator Licenses used for
Regular Users.

When there is no license for Regular Users, the licenses for Project Creator and Regular users are
combined in the overview page.

Admin or Project Manager Users
These are users who will function as Administrators or Project Managers. The WebCenter Admin/PM
user limit (as per your license pack) determines the maximum number of Admin and Project Manager
users in the system.

Integration Users
For your integration use cases (e.g. for the SDK or Automation Engine), you can allow Multiple Open
Sessions for a user. The maximum allowed guaranteed sessions is determined by the WebCenter SDK
session limit module.

Named users have guaranteed sessions and is determined by the WebCenter SDK session limit
module. You can allow Multiple Open Sessions (for SDK or Automation Engine) for such a user.

The session limit licenses can be split over multiple users (without an upper limit), but the total number
of guaranteed sessions cannot exceed the WebCenter SDK session limit.

Each of your workflow connections connected through tunnel clients will block one integration session
license.

Note:  There is an upper limit for the number of simultaneous sessions (maximum 5) for Admin /
Project Managers and Regular Users.

What if the user limit is exceeded?
When adding more sessions to an Integration user, the system checks your session limit to see if this is
feasible.

When the number of licenses available reaches a specific threshold, then it is indicated in red color.
Threshold for concurrent users are fixed at five whereas for Editor Users or Integration sessions the
threshold is not applicable.

You cannot create a new User of a Type when the limit has been reached. The limit also applies when
you try to change a Regular User to Admin or Project Manager. You will get a License Violation error if
the limit has been reached.
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Note:

• Check the Troubleshooting Tool if you run into License limit related errors. This page has a License
Check[WCR121_TST_700] test with more details about the current status.

• The System Administrator (ADMIN) can always login to verify and correct licensing issues.

Check the Named User Licensing Status

1. Click Admin to open the Users page.To see the users who are currently logged in, click on the eye
icon. You can filter on the Active Users or the current users logged in.

2. Users page lists the number of Purchased, Assigned and Remaining license per user type. You can
expand the Assigned column to view the details of the available licenses vs used at the moment.

 

 

• Admin/Project Manager Users (Assigned) is the number of Admin Users and Project Managers
licenses utilized from the license type.

• Project Creator Users/Regular Users (Assigned) is the number of Project Creator Users and
Regular Users licenses utilized from the license type.

Note:  In case the regular users licenses are exhausted, then Project Creator Users licenses are
used instead of regular users.

• Integration Sessions (Assigned) is the sum of all the guaranteed sessions and workflow
connections licenses utilized from the license type.

If the number of available licenses reaches a specific threshold, it is displayed in red to indicate the
license pool is depleted. The following threshold is effective per license type:

• Admin/Project Manager Users: 1
• Project Creator Users and Regular Users: 10
• Integration Sessions: N/A

If a license violation is effective (no more free license to allow log in). appears next to the
appropriate license type and the Remaining is shown in the Remaining column.
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The following default users are not counted against the Purchased licenses.

1. ADMIN – the admin user, user with user name “ADMIN”
2. CADX user
3. CLEANUP user
4. WORKFLOW USER

3.11.2.  Users, Groups and Roles

Basic concepts
Access to projects and documents is controlled by user and group permissions.

User

Everyone who logs in to WebCenter is a user. Users log in using a username and password assigned to
them by an Administrator.

Group

A Group is a logical set of users connected by a common element of your choosing, such as function
or location. You can assign tasks to groups, you can set up groups as approvers or even as project
managers.

Role

A Role is a placeholder object that project managers can use in their projects or templates to set
up approvals, assign tasks to, use in workflows, etc., without being forced to use specific users and
groups just yet. Upon project creation, or even later in the process, the project manager can assign
the role(s) to the actual user(s) and/or group(s). This provides more flexbility in setting up templates/
projects.

Default users

One user, admin, and two groups, Admins and Users, are created by default in WebCenter. Members of
the Admins group are WebCenter system administrators and can perform any function.

3.11.3.  Create a User

1. Click Admin > Users > New User.

Step 1: User Info in the Create New User wizard appears.
2. Type the basic user information into the appropriate fields (Username, First Name, Last Name...).

Note:  Required fields are indicated with an asterisk *.

3. Do you want to use LDAP authentication (single sign-on) for this user?

• If yes, enable the Use LDAP to Authenticate User option. This will allow the user to use his
regular Windows network user name and password to log on to WebCenter.

• If no, provide the user’s initial Password and confirm it.

Enable the option Require the user to change the password at first login to force the user to
choose a new password when they first log on to the system.

4. Do you want this user to see custom menus instead of the default WebCenter menus?
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Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. See Menus  on page 107.

• If yes, choose the menu to assign to the user in User Menu.
• If no, leave Default in User Menu.

5. Does the user need guaranteed access?

• If yes, enable the option User Has Guaranteed Access or is an ArtiosCAD Enterprise User.

Note:  You can also use this option to make editor users, if you license allows it (see Licensing
and Users on page 268).

• If no, leave the option disabled and proceed to the next step.

For more information on guaranteed access and its licensing implications, see Licensing and Users
on page 268.

6. Does the user need multiple open sessions with guaranteed access?

• If yes, enable the option Allow Multiple Guaranteed Sessions.

Note:  You can allow multiple open sessions (such as the SDK user or Automation Engine user)
as guaranteed sessions for a User. However, every three such sessions will block a concurrent
license reducing the number of available concurrent access.(see Licensing and Users on page
268).

7. Does the user need special permissions in WebCenter?

If the user needs... Select the option...

no special permissions Normal User

Project Manager permissions, but only for
projects and users belonging to his or her own
company

Project Manager with Limited Visibility of
Companies and Groups

Project Manager permissions on the complete
system

Project Manager with Full Visibility

Project Creator with permission on the
complete system

Project Creator with Full Visibility

Project Creator permissions in restricted
mode

Project Creator with Limited Visibility

8. Does the user need the ability to create new task types in WebCenter? (only if the user is a Project
Manager)

• If yes, enable the option User Can Create Task Type.
• If no, leave the option disabled and proceed to the next step.

9. Does the user need the ability to create new users? (only if the user is a Project Manager)

• If yes, enable the option User Can Create User, then click Continue.
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Note:  A Project Manager creating users will have less options than an Admin: for example he /
she will not be able to give the new user LDAP (network) sign-on or guaranteed access.

• If no, click Continue.

Tip:  You can keep track of users created by other users: the Owner column of the Users page
shows who created each user.

10. In Step 2: Assign to a Company, optionally select a company to which you want to assign the user.
Note that this can be very important to filter the content and users the new user will be able to see.

11. If you:

• are creating a Normal User or a Project Manager with Full Visibility, the wizard is complete.
Click Finish to create the user.

• are creating a Project Manager with Limited Visibility, click Continue and proceed to the next
step.

12. In Step 3: Assign Visible Companies, select the companies that this user should be able to see,
then click Continue.

The selection you make here filters the list of users in the next step so that this Project Manager
can never see users from the companies you did not select in this step. By default, only the
company of the Project Manager himself (the one you selected in the previous step) will be selected.

13. In Step 4: Assign Visible Groups, select the groups the user should be able to see, then click Finish.

Only groups containing members that belong to one of the companies you assigned in the previous
step will show up in the list. In addition, some groups may be set to be visible to all users (such as
the ADMINS group).

3.11.4.  Editing Users and their Preferences

Edit a User
1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.

The Profile page appears.
3. Make the required changes:

To edit the user's... You should...

User info (including
authentication details)

edit the fields on the Profile Page.

Read also Edit User Authentication Settings on page 276.

Menu choose a different menu in the User Menu list.

User Type select the appropriate role from the options:

• Normal User

• Project Creator
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To edit the user's... You should...

• Project Manager

Visibility Select the visibility for the user from the options:

• Limited Visibility of Companies and Groups

• Full Visibility

Privileges Also specify if:

• User Can create Task Type

• User Can Create User

• User Has Guaranteed Access or is an ArtiosCAD Enterprise User

Company or Location 1. Click the Company/Location link at the bottom of the Profile
page.

2. Select a new company and click Finish.

Visible Companies or
Locations (only applies
to Project Managers and
Project Creators with
Limited Visibility)

1. Click the Visible Companies or Visible Locations links.
2. Make a selection of visible locations and/or companies and click

Finish.

Allow Multiple Sessions

The licensing and users
overview page will
explicitly show the
number of guaranteed
sessions and the number
of licenses blocked.

Enable this option to allow the user to login concurrently multiple
times.

Tip:  Use this if you have heavy SDK integration with simultaneous
tasks. This is also useful if you have a lot of shared users (e.g. for an
external company).

• Specify the Maximum Open Sessions  allowed for the user.

Note:  This has an impact on your concurrent licenses. Every three
such sessions take up one concurrent license. For example, if your
integration user has 30 sessions, this will take up 10 concurrent
licenses. Do not use this option for normal users.

The admin users have the same number of multiple sessions as any
other user. You can change this by setting a different Maximum Open
Sessions.

4. Click Change to confirm.

Edit User Authentication Settings
An Administrator or a Project manager with rights can manage the SSO authentication details at the
user  profile page.
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Go to Admin > Users. Select the User and go to the Profile page.

 

 

Authentication:

This section lists the available and disabled authentication types. You can allow / deny the User
authenticating with any of the Single Sign-On Instances.

Read also Single Sign-On Settings on page 444.

Link Authentication:

To allow a User to authenticate via a link, configure  Token Authentication on page 446 and allow this
type of authentication in the User profile page.

Note:  You need to disable all the other types of authentication to make the link authentication active.

Click Mail Login Link to send this link to the user.

Whenever the token-authenticated user receives a notification with a link, the link contains a token
to authenticate without user credentials. This permits the users added to the approval cycle to log in
using the approval links from the notification mails.

Change the Password for a User
1. Click Admin.
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The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Password tab.
4. Type a new Password and Confirm it.
5. Click Change to save the changes.

Change a User’s License Status
1. Click Admin.

The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Select or deselect the User has guaranteed access option and click Change.

Note:  Changing users’ licensing is effective immediately.

Alternatively, to change many users’ licensing status in a single operation:

1. Select the users on the User page.
2. In the actions menu, click Grant Guaranteed Access or Remove Guaranteed Access as desired.

Set the Preferences for a User
1. Click Admin.

The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Preferences tab.
4. Configure the Preferences as needed. For more information on the settings and options, see

General Preferences on page 89.

Copy Preferences to Users
Use this to quickly copy previously defined preferences to one or several users.

1. Click Admin.

The Users page appears.
2. Select the user(s) whose preferences you want to change and select Apply Preferences in the

actions menu.
3. In the Apply Preferences popup, select the preferences to change, and deselect the preferences to

keep.

Other Preferences are the user preferences not mentioned above (for example: show thumbnails or
not, search results layout, etc.).

4. Select who you want to copy the preferences from: in Take Preferences From, select another user,
or select Default to use the default settings for the preferences you selected.

5. Click OK.
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Edit a User's Group Memberships
1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.

The Profile page appears.
3. Click the Groups tab.
4. To add the user to one or more groups, select those groups (use Ctrl+click to multiple-select) in the

Available Groups list and click the >> button.
5. To remove the user from one or more groups, select those groups in the Current Groups list (use

Ctrl+click to multiple-select) and click the << button.

The changes are effective immediately.

Set Available Download Formats for a User
1. Click Admin.

The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Download tab.
4. Select or deselect the download formats you want to enable.

Note:  User permissions for download formats take precedence over group permissions for
download formats.

5. Click Change.

Note:

Alternatively, you can click Use Group Permissions to make the user inherit the download formats from
his or her group membership(s).

3.11.5.  Deactivating Users

An administrator user or a project manager with create user rights user can deactivate users. You
may want to use this feature when you no longer need a user in the system or when you are inviting an
external collaborator to an approval cycle temporarily. You can also do this when you need to free up
named user licenses.

Deactivated users cannot log in, become project members or stay as task assignees. This means that
you cannot start a task or an approval cycle that has a deactivated user as its assignee or approver
respectively.

The deactivated users are still in the Users list with a clearly marked Deactivated label. This allows
you to keep track of what they did or reactivate them if there is a need. Click Deactivate User(s) after
selecting the users you may want to delete.
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Note:

• A project manager with create user rights can only deactivate the users he created.
• The user deactivation and activation events are logged in the User Management History.
• Admin User or PM users with Create User rights can deactivate users in bulk in the Users overview

page, by selecting the users and clicking Deactivate user(s).

The deactivated users will not receive notification or overdue e-mails even if they are included among
the expected recipients of a Notification message (for example, deactivated Project members).

Deactivate Users
You can deactivate users either manually or automatically after a specified duration.

• To deactivate a user manually:
a) Go to Admin > Users > User > Profile page.
b) Disable the Active User option.

You will see a message warning you about pending approvals or tasks or if the user is currently
logged in. To know more details about the pending work, click on the displayed message.

c) Save.
As soon as you save, the deactivation happens even if the user is logged in or has pending work.

Note:  It is not possible to deactivate:

• the built-in users (ADMIN, CADX, WORKFLOW, CLEANUP) that don’t take up any licenses.
• the currently logged in user.

Warning:  The manually deactivated users can be reactivated only after 24 hours.

• To set up automatic deactivation,
a) Go to Admin > Users > User > Profile page.
b) Select from the following options and save.

Options Description

Deactivate after X working days Specify the number of working days from the
current date.

You will see a message with the predicted date
of deactivation.

Deactivate at a specified date Pick a date using the date picker.

Note:  You can only set this up for active users.

No automatic deactivation The default option.

The automatic deactivation happens on the calculated/specified date after 23:59:59 server time.
• To create deactivated users, disable the Active User option in the user creation form. For example,

you could create a deactivated user as a Template user.
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Tip:  You can create deactivated users with different deactivation dates as template users. Use
these as template users to create different types of approver users(with varying deactivation
periods).

Reactivate Users
To reactivate users, use any of the two ways listed below.

• From the User Profile page, enable the Active User option.
• Select deactivated user(s)in the Admin > Users page and click the Activate User(s) action button.

Warning:  The manually deactivated users can be reactivated only after 24 hours.

3.11.6.  Delete a User

When deleting a user, WebCenter checks for dependencies, such as being a Project Manager or being
an Approval User on an ongoing Approval Cycle, before deleting the user.

If there are dependencies, WebCenter asks you whether you want to view them (with links so you can
remedy the dependencies) or cancel the deletion.

Note:  Attempting to delete multiple users will stop on the first user that has dependencies. To delete
the rest of the users, reselect them and delete them.

1. Click Admin.
2. Select the checkbox next to the name of the user to be deleted. To delete more than one user at a

time, select additional checkboxes of users to delete.
3. Click Delete User(s) in the actions menu.
4. Click OK to confirm the deletion.
5. If there is a Delete Dependency confirmation, choose the desired option and click OK.

Users cannot be deleted until any dependency issues have been resolved.

3.11.7.  Create and Invite a User from the Approval Page

Project Managers can create and invite users in the context of an approval page. This allows you (as a
Project Manager) to add an external reviewer to the Approval cycle. If the user is not in the system, you
can add a new user and invite him or her from the approval page. It is possible to create and add users
from any approval page(document's, project's or folder's).

Note:  These users will be created as Regular Users. The only exception is when an Administrator user
creates a user using an Admin User as the Approval User Template.

If you have used up all your Regular User licenses, you will not be able to Create and Invite User from
the approval page. Read about Named User License model in Licensing and Users on page 268.

• Click Add Approver > Create and Invite New User.
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User Info in the Create and Invite New User wizard appears.
• Type the user's e-mail address. The fields (Username, First Name and Last Name will be filled in

automatically from the e-mail address. You can change these fields, if necessary.

• Username is filled with the part before @ of the e-mail address.
• First Name is taken as the part before the last dot.
• Last name is filled with all characters after the last dot (or all the characters before @ if no dots

are present).
• Optionally, assign to a Company and Location. Note that this can be very important to filter the

content and users the new user will be able to see.
• If you want the user to log in with a link sent from the approval page, follow the process below:

a) Set up a Token based single sign-on instance and keep it active.
b) Specify a User as Approval User Template. Also remember to allow link authentication in the

user profile.

To allow a User to authenticate via a link, configure  Token Authentication on page 446 and allow
this type of authentication in the User profile page.

Note:  You need to disable all the other types of authentication to make the link authentication
active.

Whenever the token-authenticated user receives a notification with a link, the link contains a
token to authenticate without user credentials. This permits the users added to the approval
cycle to log in using the approval links from the notification mails.

• If your default approval user template  has no Token Authentication setup or you have not defined
a user as the template, you need to specify and confirm a password in the Create and Invite User
wizard.

• If there are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
a Role field.

• Click Create and Invite User.

A new user is created and invited to the Project. You will be able to see this user in the Approvers list as
well as in the Users list.

• If you enabled link authentication, the user will log on to the system using a link from the
notification e-mail. The user will be able to see and approve the document/folder or project.

• If you specified a password, the user would need to know the password to be able to log in.

3.11.8.  Managing User Memberships in Projects

View a User’s Project Memberships
1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.

The list of project for the user is displayed. You can filter the list of projects if needed, using the
Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the
filter criteria and click Go.
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Note:  This does not show Projects for which the user is the Project Manager or those Projects in
which the user is a member by means of belonging to an invited Group.

4. You may uninvite the user from any of the Projects shown in this list by selecting the Project(s), and
clicking Uninvite in the actions menu. The user must not be an Approver in an active Approval Cycle.

Invite a User to Multiple Projects
1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.
4. Click Invite to Projects.
5. Select the projects you want to invite the user to, and click Continue.
6. Select the permissions the user needs in the project and click Finish.

Uninvite Users from Multiple Projects

Note:  If the user is an Approver in an ongoing Approval Cycle in a selected Project, the entire removal
action is canceled. You must stop the Approval Cycle and then perform the removal.

1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.

The list of project for the user is displayed. You can filter the list of projects if needed, using the
Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the
filter criteria and click Go.

4. Select the Projects you want to uninvite the user from.
5. Click Uninvite in the actions menu.
6. Click OK to confirm.

3.11.9.  Login Tracking

To get a simple overview of User Logins for a specified time period, click the Admin > Users > Login
Tracking option.

• Specify the time units ( Detail Overview in days / hours / weeks).

The overview table will display the time in the units you specified here.

• Select the View as graph / table.

• Select the time period by specifying the dates.

• Click Search.

You can use Save to Excel to export the login overview. You can view more details by clicking on Switch
to Advanced View. Read in Advanced Login Tracking on page 284.

Read also Failed Logins on page 284 and License Usage on page 284
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Failed Logins
Failed Logins column gives the count of the number of login attempts that were denied because of
insucient licenses. This count is measured during the period you specified.

License Usage
In the Login Tracking page, you can see the statistics regarding:

• used and free editor licenses
• used and free concurrent licenses

for the specified time period. You will see a warning next to the progress bar if there was at least one
Failed Login due to shortage of licenses.

Advanced Login Tracking

The advanced page shows a list of individual User sessions (or Failed login attempts) that were active
during the specified time period.

To view the successful login details, select Show Login Sessions. You can view the failed logins by
opting to Show Failed Logins.

Use the custom filtering to limit the information to what you are looking for. For successful login
sessions you can filter on:

• Single Sign-On Instance
• Login Method
• Logout Method
• User : You can type the

• User Name
• First Name
• Last Name

of the target User.
• Company
• Location: Use this filter to view the login statistics associated with one Company and in a specific

location

Note:  To show the system user sessions ((“SYSTEM” and “CADX”), enable the option Show sessions
from system users. This option is turned off by default.

If you are viewing Failed Logins, you can filter on:

• Single Sign-On Instance
• Login Method
• Login Failure Cause
• User Type any of the following:

• User Name
• First Name
• Last Name

To see login attempts from unregistered users, enable Show anonymous login attempts.
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Tip:

Use Sort by to sort the table based on the selected column.

To export the table as a .XLS file, click Export to Excel link.

3.11.10.  Delegation

Delegation is the assignment of responsibility or privileges to another user to complete his / her work.

For example, when a Project Manager (P1) has planned a personal time off and wants to delegate his
user account to another Project Manger (P2). In this case, the P1 is the delegator and P2 acts as a
delegate of P1. P2 can perform and manage the work on behalf of P1.

You can configure a delegate for a specified time period or permanently. Actions performed by the
delegate P2 will be tracked in the respective project history.

Delegation can be done only to users who are in the same hierarchy or above. An admin user can
delegate only to another admin user and not to a normal user. Potential Delegates as per the User
Access Level are

User Access Level Can delegate to

Admin User Admin only

Project Manager (with Limited and full visibility ) Project Manager or Admin User

Normal User Normal User or Project Manager or Admin User

Delegation Restrictions
To ensure that your user(s) delegate to a limited list of users, you can use the Delegation Restrictions
either as a system wide settings Delegation Preferences- System Wide on page 101 or per user.

The Administrators can specify the user level setting which overrides the system wide settings in that
case. Admin users can place restrictions on delegation for a specific user based on various factors like

• System Default
• No Delegation is possible if you choose this option. This prevents your users from delegating their

work.
• All Visible Users allows to delegate any user who are visible in his or her list.
• Only Users in the same allows you to restrict the choice to delegate, within the same company or

location or group.

For example, you can specify that delegation is restricted within the members of a Company. This
would mean that you cannot pick a user who is not part of the same Company as your delegate.

• Any of the following Users or Groups allows you to choose the delegates from a group(s) or any
users with the Add button.

Note:  All the delegation restrictions are copied when the option Delegation Restrictions is
selected in Apply Preferences.

Your user's Delegation
As an Admin user or as a Project Manager who has a set of users, you can view, create or modify the
delegation setup of your users. To do that, use the Users > Profile > Delegation page.
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When a user assigns a delegate, the delegate can perform all the work actions. The delegate has to log-
in on behalf of the delegator, to perform the tasks, approvals and permission settings.

Note:

1. You cannot delegate a deactivated user's work or delegate to a deactivated user.
2. A user can be the delegate to more than one user but cannot be logged in as more than one

delegate at the same time.
3. Delegation works only in one level. The work delegated to a user cannot be delegated to his

delegates.

Setting up Delegation for your Users
As an Admin user or as a Project Manager who has a set of users, you can view, create or modify the
delegation setup of your users. To do that, use the Users > Profile > Delegation page.

1. If you are an owner of users, go to My WebCenter > My Users > *Name* > Delegation page. As an
administrator, you can use the Admin > Users > *Name* > Profile > Delegation page.

2. To add one or more delegates for your user, select a user from the drop-down and click Add
Delegate.

3. Optionally, if you an admin and like to configure a specific restriction for a user or to add a custom
list of users and group as potential delegates, you can edit the Delegation Restrictions. If you do
not edit this field, the global Delegation Restrictions setting will apply.

You can revert to the global setting by selecting System Default.

The My Delegates section of your user will list the delegates authorized to act on his or her behalf. You
can add new delegates here.

Add Delegate
You can delegate your work to a specific user or users. Follow the steps below to add delegates.

1. To add one or more delegates, go to My WebCenter > My Delegates.
2. Select a user from the drop-down and click Add Delegate.

To inform your colleague about the delegation, enable the Notify new/modified delegates option.
3. If this is a temporary delegation until your return to work, specify a Start Date and an End Date.

There is also a comment field to leave your notes.
If you leave the End Date empty, the colleague can act as your permanent delegate.

My WebCenter > My Delegates page lists all your delegates and the respective time periods for which
the delegations remain active.

Note:  You can modify the delegation fields or delete a delegate from My WebCenter > My Delegates
page.
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3.12.  Managing Groups

3.12.1.  Create a New Group

1. Click Admin > Groups > New Group.
2. Enter the name of the group.
3. Choose who will be able to see this group: All Project Managers, Administrators Only, or Selected

Project Managers.
4. Click Continue.
5. In Step 2: Select Group Members, select the members of the group by checking the checkboxes to

the left of their names.
6. Is this new group visible to every Project Manager or only to Administrators:

• If yes, click Finish. The group is created.
• If no, click Continue. The, in Step 3: Assign group visibility to project manager(s), select the

Project Managers that can see this group and click Finish.

Project Managers with Full Visibility are unavailable, as they can see all groups. By default, group
members can see the group but you can still de-select the group members so that they don't
know this group exists.

3.12.2.  Add Users to a Group

1. Click Admin > Groups.
2. Click the name of the group to edit. Click Add Users.

When adding new members to a Group, you can filter on First Name, Last Name, User Name, Email
of the User, Name or the legal name or the Company of the user or the Location of the User. You can

add all active members in one go using Select All Active Users ( ) option.

Attention:  Members of the Admins group can perform any task and are not bound by any
security restrictions and hence it is important to cautious when adding users to groups.
Deactivated Users  can be activated and added to the group by the admin users.

The list of users who are currently not members of the group is displayed.
3. Select the user(s) to add to the group.
4. Click Finish.

3.12.3.  Remove Users from a Group

1. Click Admin > Groups.
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2. Click the group to edit.
3. Select the user(s) to remove from the group.
4. Click Remove in the actions menu.
5. Click OK.

3.12.4.  Copy or Move Users Between Groups

1. Click Admin > Groups.
2. Click the group to edit.
3. Select the users to copy from the group.
4. In the actions menu, click:

• Copy users if you want to copy users from one group to another.
• Move users if you want to move users from one group to another.

5. Either filter or click Go to show the list of groups.
6. Select the new group(s) into which the users will be copied or moved.
7. Click Finish.

3.12.5.  Rename a Group

1. Click Admin > Groups.
2. Click the group to edit.

The ADMINS and USERS groups cannot be renamed.
3. Enter the new name of the group in the Group Name field and click anywhere else on the page.
4. Click OK.

3.12.6.  Change the Group Visibility

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the Visibility tab.
4. Select the desired visibility choice: All Project Managers/Creators, Administrators Only, or

Selected Project Managers/Creators.
5. Depending on your visibility choice, proceed as follows:

• If you chose Selected Project Managers/Creators, you will be prompted to select the individual
Project Managers who should be able to see this group. Click Change when you have made your
selection.

• If you chose one of the other options, go directly to the next step in this procedure.
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6. Click OK.

3.12.7.  Set Group Download Formats

Configure the available download formats in WebCenter Preferences (Admin > Preferences >
Download Formats) before setting group download permissions.

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the Download tab.
4. Select or deselect the download formats you want to enable.

Note:  User permissions for download formats take precedence over group permissions for
download formats.

5. Select or deselect checkboxes to grant or deny permissions as desired.
6. Click Change.

3.12.8.  View Group History

Actions performed in the group including its creation, are recorded in the History tab of the group. You
can access this from Admin > Groups. Now, select and open the Group for which you want to view the
history and navigate to the History tab.

You can view the following actions in the History tab.

• Group Created
• Group Information changed ( Renaming of the group/ changes to visibility setting of the Group)
• User added or removed from the group
• Group View Rights changed (changes to the list of Project Manager’s/ Project Creators who can

view the Group)
• Group Manager Changed

Note:  When the Group is deleted, you can view the event history in Admin > Group > View History. 
This page lists the events of all the groups and it can be filtered on date and users.

3.12.9.  Setting Group Notifications

As an administrator or a Group manager, you can set up notifications individually for every group
member or to a single group e-mail address.

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the General tab.
4. Select your preferred way of sending notifications or disable them altogether.
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• Send notifications to everyone in the group: When this option is selected, a group event will
trigger notifications to all of the group members' e-mail addresses according to the individual
language settings.

• Send notifications to a group e-mail address. Specify the following info:

• Group e-mail address

• Group-email language

If this option is chosen, a single e-mail notification is sent to the specified Group e-mail address.
• Do not send notifications to this group: Select this to deactivate email notifications altogether.

5. Click Save.

3.12.10.  Managing Group Memberships in Projects

View a Group’s Project Memberships
1. Click Admin > Groups.
2. Click the group to edit.
3. Click Projects.

Invite a Group to Multiple Projects
1. Click Admin > Groups.
2. Click the name of the desired group.
3. Click Projects.
4. Click Invite to projects.
5. Either filter or click Go to show the list of all projects to which this group is not invited.
6. Select the projects to which the group is being invited.
7. Click Continue.
8. Set the project permissions that this group will have in the projects to which it is being invited. The

same permissions will apply to each project.
9. Click Finish.

Uninvite Groups from Multiple Projects
If a user in the group is an Approver in an ongoing Approval Cycle in a selected Project, the entire
removal action is cancelled. You must stop the Approval Cycle first, and then perform the removal.

1. Click Admin > Groups.
2. Click the name of the desired group.
3. Click Projects.
4. Either filter or click Go to show the list of all Projects to which this group is invited.
5. Select those Projects from which the group is to be uninvited.
6. Click Uninvite in the actions menu.
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7. Click OK to confirm the removal.

3.12.11.  Overview of My Group's Tasks

My Group's Tasks lets the Group Manager quickly view the tasks assigned to their group or group
members. It also allows to assign, re-assign, or distribute the tasks among the group members.

If a group member is ill or not available, the Group Manager can re-assign the task to an other group
member. A Group Manager can also monitor the progress on a selected Group or Group Member. Using
the filter options, the Group Manager can have a quick overview of the workload.

Group Task Manager
Every department has a Department Manager. In WebCenter Department Manager are referrred to as
Group Manager. A group can have any number of Group Managers including 0. Group Manager is always
part of a group.

A Group Manager likes to view the tasks assigned to a selected group or group members, which will
assist him in distributing the tasks and also get a quick view on the current status of a task.

The My Group's Tasks feature allows Group Managers to:

• View task assignments for a selected group and the workload overview.
• View tasks assigned to a group member and the workload overview.
• Re-assign any task assigned to a group member.
• Review the task overview filtering on status and due date.

Assigning a Group Manager
The My Group's Task page can only be accessed by a Group Manager. Only a member of ADMINS can
turn a group member into a Group Manager.

1. Log in to WebCenter as an Admin user.
2. Click Admin > Groups > Groups.
3. Search for the required Group Name or click the Group Name from the list available.
4. Select the Group Manager check box for the desired group member.

You can assign multiple Group Managers to one group. The same user can also be Group Manager to
multiple groups.

Using My Group's Tasks
To access My Group's Tasks feature, log in as Group Manager. Click My WebCenter > My Group's Tasks
to view the Group Tasks for Group page.

Viewing Task Assignments
You can view the tasks assigned to a selected group and also for a group member within the group.

1. The task list for assigned group appears.
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Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. In the Tasks assigned to drop-down list box, select the group or group member for whom you want
view the task assigned.

3. A task list assigned to the selected group or group member appears. Also in the list are:

• Task Name
• Project Name
• Assigned to
• Status
• Lead Time
• Due Date
• Created Date
• Started Date
• Estimated Date
• Task Documents

Viewing a Workload Overview
During editing/re-assigning, the Group Manager can have an overview of number of tasks assigned and
how many are overdue. The Task Count is the number of assignments assigned to a group member. The
Task Count displayed is based on the filtering criteria and tasks with past due-date always appears.
The non-active projects do not appear and are not counted.

1. The task list for assigned group appears.

Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. The workload overview appears for the selected group.
 

 
If the task is past the due date, it appears in red.

292



3WebCenter

Reassigning a Task
A Group Manager can re-assign a task to a group or a group member. A task can be re-assigned only to
a group member within the same Group. In addition to this when the task is reassigned, the WebCenter
UI displays the previous assignee in Previous column.

1. Note:  Ensure to log in as Group Manager.

1. The task list for assigned group appears.

Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. Select the new assignee in the Assigned to drop-down list box. This list contains group and group
members name.

3. WebCenter shows changed tasks with a yellow background indicating the change.

Note:  Even if a task is not initially assigned to a group, the Group Manager has all the rights to re-
assign the task to a group member.

4. Click Save to commit the changes.

Filtering Based on Task Status and Due Date
A Group Manager manages multiple tasks at a time and this might lead to delay. Using the Search
Tasks Status, one can see tasks in a more specific status.

For example, you can filter the tasks which are in Completed or In Progress status. By filtering the
task, a Group Manager need not re-assign completed tasks or tasks which cannot start because a
predecessor is not complete.

Similarly the tasks can also be filtered by Due Date. This gives a Group Manager a quick view of the task
for the required time line. Using this information Group Manager can view what is due this week or this
month to make the required planning.

1. Note:  Ensure to log in as Group Manager.

1. The task list for assigned group appears.

Note:  If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

2. In the Search Tasks Status drop-down list, select the desired task status.
3. In Due Date, select the required due date and then click Go.

Note:  To set the Due Date filtering, setting a task status filter is not necessary. The Due Date
changes to completion date, if the task status is filtered to completed.

The following are the default due dates settings available:

• All
• Today
• Next 3 days
• Next week
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• Next 2 weeks
• Next month
• Next 3 months
• Overdue
• Week overdue, all the tasks which are overdue for less than five days.

Filtering Based on Column
By clicking a column header, the Group Manager can view tasks for a selected group in ascending or
descending order.

For example, if Due Date is selected then the tasks for the selected group appears with the earliest
due date. Similarly if Due Date is clicked again, then the tasks for the selected group appears with the
latest due date.

1. Log in as Group Manager.
2. The task list for assigned group appears.

Note:  If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

3. Click a column header, for example Due Date, to sort on this column.
The sorting is indicated by an arrow. For example, if Due Date is selected then it would appear as:
 

 

3.13.  Managing Roles

3.13.1.  Roles

A Role is an assignment that you can create in WebCenter to be used later on in Projects. You
can assign a Role to Project Templates, Projects, Tasks and Approvals. You can set up project
permissions, approval settings and tasks for a Role within a project or template.

You can assign these Roles to real users and groups when needed. When you assign a Role to a real
User or Group, you are assigning the Role's settings.

You can create versatile Project Templates using Roles which will help you to reduce the number of
Project Templates.

Roles are created as global. This helps the Project Managers (or Selected Project Managers)to use
the Roles effectively in individual projects and templates. You can invite these Roles as in the case of
Users and Groups.
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Roles are effective after real members (Groups, Users) are assigned into each of the Roles. A project
Role assignee will be treated like a standard project member. Once you assign the Role to a project,
these take over the role’s security setup, approval setup and task assignments.

• the notifications will be sent out correctly
• the task will be shown in the respective members' to-do list
• the necessary access rights will be assigned to the members to perform the task (depending on the

Role)
• the approval notifications will be sent out correctly.

You can employ multiple assignments of a single Role. For example, you can invite a "Designer" Role
to all the Projects requiring a designer either after creating a Project or via the Project Template with
assigned Roles.

You can use Roles:

• To combine with Workflows:

The tasks assigned to Roles will be picked up by the users or groups who are assigned to these
Roles either at the beginning or later during the project execution. The project manager can decide
who will get assigned to the Roles. Since WebCenter keeps track of Role assignments:

• the notifications will be sent out correctly
• the task will be shown in the respective members' to-do list
• the necessary access rights will be assigned to the members to perform the task (depending on

the Role)
• the approval notifications will be sent out correctly.

• In Project Templates:

Features associated with Roles will be inherited from Project Templates during project creation.
Adding Roles (instead of user Groups or individual Users) to your Project templates makes them
more versatile.

Note:  Although the Roles are defined for entire WebCenter, the assignment of Roles is done per
project and is independent of the User. Therefore, you can assign the same user or group to a
"Designer" Role in one project and restrict the access for the same User/Group in other projects.

Read more in Creating a Role on page 295

3.13.2.  Creating a Role

1. Click Admin > Roles > New Role.
2. Specify the name of the Role
3. Determine the visibility of the Role by selecting from All Project Managers, Administrators, or

Selected Project Managers. Click Continue
Subsequent step depends on whether you selected Selected Project Managers visibility in this
step.

Choice Steps

Selected Project Managers You should select which Project Mangers are
allowed to see the Role
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Choice Steps

All other The New Role is created.

You can view these roles in the list of Project Members even after being resolved.
4. Assign a Viewer Workspace from one of the existing workspace available in the drop down or you

can create a new workspace for the role created.

3.13.3.  Editing Role details

1. Go to Admin > Roles. You can see the list of available Roles, where the Role names are visible as
links in this tab. To edit any Role details, click on the Role Name and this will lead you to the tab
named General of Role Management page.

2. You can change the name of the Role in the General tab. Edit the name of the role in the Role Name
field and click anywhere else on the page to save the change or click on Save.

3. You can also assign a new workspace from the drop down available in the Viewer Workspace field
or change the workspace present. It is also possible to edit or delete the workspace present by
selecting the gear icon.Click on save for the changes to be effected.

3.13.4.  Changing the Role Visibility

1. Go to Admin > Roles . This will lead you to the tab named General of Role Management page. You
can see the list of available Roles in this tab.

2. Click on the name of the Role (visible as a link) for which you want to change the Visibility.
3. Go to the Visibility tab and change the visibility.

You will have to choose from three Visibility choices: All Project Managers, Administrators Only
and Selected Project Managers.

Options Description

Selected Project Managers / Creators You will be prompted to select the individual
Project Managers or Project Creators. Click
Change when you have made your selection.

All Project Managers/ Creators and
Administrators Only

You will be asked to confirm the selection.
Click OK.

3.13.5.  Deleting Roles

1. Go to Admin > Roles. This will lead you to the tab named General of Role Management page. You can
see the list of available Roles in this tab.

2. Select the Roles from the list of Roles by toggling the respective check boxes.

3. Click on Actions > Delete Role(s) from the list header.
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Note:  You will be warned if this Role is associated with an existing Project or Approval cycle.

3.13.6.  Converting Empty Groups to Roles

Previous versions of WebCenter made use of empty Groups to create roles. From WebCenter 12
onwards this is replaced by Roles. However, you can also convert any empty Group that serves as Role
into a full fledged Role. This will ensure that any reference to such empty Groups will be retained and
shifted to the new Role that is created during this process.  

To convert an empty group to a role you need to follow these steps:  

1. Go to Admin > Groups.
2. Select those Groups which you need to convert into Roles.

You can use Show filter to filter out all the non-empty groups.
3. Go to Actions menu. Select Convert Group to Role action link in to execute the conversion into a

Role.

You will be re-directed to a page detailing how many of the selected empty groups were converted
and how many were not.

Note:  The conversion can fail when:

• a non-empty group is selected for conversion. Only empty groups can be converted into roles.

• a role with the same name as the selected empty group exists. Role names must be unique.

 

3.13.7.  Delegating Roles: Setting up Roles to Assign Roles

Project Managers and Project members (with permissions) can assign a Role within their Projects. The
Project Manager or Member can do this from the Manage Roles page.

1. Click Admin > Roles.
2. Select the Role you want to assign permissions to.
3. Click the General tab.
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4. Click on the Roles can invite following roles link. This will open Manageable Roles page.

Role can invite the following roles drop down will contain all the Roles present in the system.
 

 

Role can invite the following roles list depends on the visibility rules. See below.

Admin and PM with
full visibility

PM with limited visibility Normal user

All Users and Groups Visible Users and Groups • Users from his own
company (all locations).

• Users and Groups present
in the same Project
(through individual or role
assignments).

• Groups the user is
member of.

5. Save.
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After setting up this configuration, the Project Member in that specific Role can invite other Roles.

The same Project Member in different Roles can have individual configurations in Role can invite
the following roles list. In this scenario, the list of Roles that this Member can assign will be the sum
of these individual lists.

3.13.8.  View Roles History

You can view the changes that are made to the Roles in the History tab. You can access this in the.
Admin > Roles. Now, select and open the Role for which you want to view the history and navigate to
the History tab.

• Role Created
• Role Information Changed (renaming of the Role/ changes to visibility setting of the Role)
• Role View Rights changed (changes to the list of PM’s/ Project Creators who can view the Role
• Group Converted to Role. History of the group is transferred here and all details can be viewed now

in the Role History

Note:  When the Role itself is deleted, you can view the event history in Admin > Roles > View History. 
This page lists the events of all the roles and it can be filtered on date and users.

3.14.  Discussions

Discussions helps users to communicate with each other better and enables to seamlessly interact at
various levels like project, document or at task level. Discussions facilitates WebCenter users to have
conversations, which facilitates collaboration and faster decision making.

You can start a discussions in WebCenter, in a Project, Task or at a Document level.

You can view the conversations in the Project or Task or at the  Document level in the Discussions
Tab. Discussions can be with all the members or private conversations with few or one member of the
project.

Admin users have permission to view, edit the members, and delete the messages or the discussions
itself in any of the project, or task or document. Admin Users, Project Managers of the Project where
the discussion is in and the owners of the Discussion can make the discussion read only.

All members of the Project can start a new discussion. Read more on how to start a discussion or post
a message in a discussion Start a New Discussion on page 837.

3.14.1.  Global Discussions

Admin users can communicate to all the users in the WebCenter using Global discussions. It is an one-
way communication and can also be made read-only. By default, global discussions are for everyone
but admin users can also restrict the audience by selecting the targeted users, roles or groups.

You can start a global discussion on either My Discussions page or in the Discussions widget on My
Work page. Based on the setup of notifications, a notification is sent when a discussion is started or a
message is posted.
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Note:  You can use the  read-only toggle button, to make an existing discussion read only.

3.14.2.  Enabling Discussions in Task Type

To start Discussion in a Task, Task Type chosen for the task should have the field Allow Discussions
enabled. Either Admin users or Project Managers with Create Task Type  permission can do so. Refer
to the steps here to create a task type Create a Task Type on page 845.

To Enable Discussions in a Task:

1. Open any Task Type and enable Allow Discussions in the Discussions tab.
2. You can choose the Discussion contexts from the drop down list.

• Current Task : Discussions are created in the current task and are visible in the task.

• Parent Workflow: Discussions created on the tasks of the parent workflow are visible in all the
tasks of the parent and the child workflows.

• Root Workflow: Discussions created on the task of the root workflow are visible in all the tasks
of the related workflows or the workflow with this setting.

• Project: Discussions created in the task are Project Discussions and are visible in the task.
3. Choose Show Discussions of Documents linked to the Task to view the discussions that happen at

the document linked to this task.

Note:  Once the task is completed, discussions are in read-only mode.

3.14.3.  Copying Discussions from Project / Template

As an Admin user, you can create default templates of discussions and messages which are inherited
to projects that are created from the template.

The discussions can be copied optionally, when a new project is created from another project.

Note:  Notifications are not sent for discussion events triggered on a project template level.

Copying Discussions from the Project Template
When you create a Project based on a template, the new project is created with the discussions that
were defined in the template. This will also include the users and messages in every discussion that is
copied.

All Project, Document and Task Discussions from the source Template/Project are included in the
target project.

Copying Discussions from another Project
Project Manager users can specify to Copy Discussions, when a new project is created from Copy
Project from another Project option.
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Note:  When Copy Discussions is enabled, Project discussions will be copied to the newly created
project. Document and Task discussion will be copied, if the Including Documents and Copy Tasks
options are also selected.

3.14.4.  Deleting a Discussion or message

Admin users have the option to delete some of the discussions and messages that may not be required
or redundant. For security reasons, this option is available only for Admin users and Project Managers.

1. To delete, open the discussion and click the delete button in the Action bar.
2. To delete a message, hover over the message and click the delete button.

Tip:  Depending on the notifications set up for discussions, an email notification is sent when a
message or a discussion is deleted. You can set up notifications when a member is added or deleted
from a discussion. Project history is updated when any changes are made to an existing Discussion
or a message in the Discussion.

3.15.  Project and Document Characteristics

Characteristics are descriptive tags that can be assigned to projects or documents to make them
easier to find.
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Characteristics are hierarchical. This means there can be different levels of characteristics for various
product lines so that you can drill down through the information to find the exact characteristic desired
when searching the database.

For example, you could create a master characteristic for Electronics, and then various sub-
characteristics for types of appliances, entertainment equipment, or computers, and so forth. They
are presented in a tree format - main categories with expandable branches. The characteristics tree
configures the available characteristic names as well as how they are organized.

System History Logs
All Characteristics related events like

• Characteristics Created

• Characteristics Deleted and

• Characteristics Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 439

3.15.1.  Create a Characteristic

1. Click Admin > Characteristics
2. Do you want to add a primary characteristic (a main category) or a secondary characteristic?

• To add a primary characteristic, select the option button next to Root at the top of the tree and
then click New Characteristic.

• To add a secondary characteristic, select the option button for the characteristic under which to
add the new one, and then click New Characteristic.

There can be up to 17 levels of characteristics or at most 256 characters for the entire
characteristics path from the root characteristic to the deepest-level characteristic.

3. Enter the name of the characteristic in the Name field.
4. Click Create. The new characteristic appears in the list.

3.15.2.  Edit or Delete a Characteristic

When deleting a characteristic, WebCenter checks if the characteristic or any of its child
characteristics are assigned to any Projects or documents. If such a dependency is found, you are
prompted to remove the dependency and delete anyway, or cancel the deletion.

1. Click Admin > Characteristics
2. Do one of the following:

• To edit a characteristic, click its name in the tree structure. Type a new name in the Edit
Characteristic page and click Change to confirm.

• To delete a characteristic, select it in the tree and click the Delete Characteristic link.
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If there are no dependencies, it is deleted immediately. Note that any sub-characteristics of the
selected characteristic will also be deleted.

3.15.3.  Export/Import Characteristics

When exporting a project or project template, the project characteristics are exported along with
other project information. Upon import, the characteristics are restored on the target system. When
the characteristic does not exist on the target system, it gets created automatically.

• In the source location, to Export Characteristics, go to Admin  > Projects.

Select the Projects that you would like to export. Click Exportto start a download of a XML fie
containing the characteristics.

Save this on your computer

• In the target location, to import Characteristics, go to Admin  > Projects > .

Select Import from File and choose the XML file which was downloaded earlier.

3.16.  Project and Document Attributes

Basic concepts
Attributes are a way to assign user-configurable fields and their values to documents and projects.
They can be:

• Prompted so that the user has to set a value each time it is used,

• Calculated from an ArtiosCAD formula,

• restricted to a group of preset values (a Restricted Set).

The Restricted Sets must exist before you can use them when creating an attribute.

Attribute Categories group attributes together for convenience. An attribute must be put into an
attribute category before it can be used; however, the same attribute can be in multiple categories.

You must create an Attribute Category before adding attributes to it.

3.16.1.  Restricted Sets

Create a Restricted Set
1. Click Admin > Attributes > Restricted Sets > New Restricted Set.
2. Enter information in the fields as appropriate:

• Name: the name of the Restricted Set, up to 35 characters.
• Type: the data type of the Restricted Set. There are eight allowed types: Area, Date and Time,

Distance, Float, Integer, Text, Text (Right to Left), Volume, and Weight.

A Float is a number containing a decimal point and an Integer is a whole number.
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The labels in parentheses after the name of the type indicate the units of measurement used in
Imperial and Metric systems.

• Value: an entry for the restricted set. Text values can be up to 255 characters long.

Click Add to add the value to the set and clear the Value field. Enter as many values as desired,
clicking Add after each one.

Tip:

You can sort the Values list using  and , or click the Sort button to sort it alphabetically
(for Text Type Restricted Sets).

You can also select one or more values and click Remove to remove them.

3. Click Create to create the Restricted Set.

Edit a Restricted Set
1. Click Admin > Attributes > Restricted Sets.
2. Either filter or click Go to show the restricted sets.
3. Click the name of the restricted set to edit.
4. Change the name, or add and remove values as desired. You cannot change the type.

Note:  If you remove a value, the next time you access a project using the deleted value, you will be
prompted to change it.

5. Click Change to make the changes.

Delete a Restricted Set
WebCenter checks if a Restricted Set is being used before deleting it. If it is in use, you will be
prompted to either clear the restricted set from the attribute using it, or to cancel the deletion.

1. Click Admin > Attributes > Restricted Sets.
2. Either filter or click Go to show the restricted sets.
3. Select the checkbox of the restricted set to delete and click Delete Restricted Set(s) in the actions

menu.
4. Click OK when asked to confirm the deletion.
5. If the restricted set is not being used, it is deleted immediately.

Export / Import Restricted Sets
You can Export and Import restricted sets .

• To export, go toAdmin > Attributes > Restricted Sets:
a) Click on the Import link.
b) Browse to a previously saved XML file.
c) Select Actions > Export.

This will start a download of an XML containing the Restricted Set.
d) Save this on your computer.
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• To import, go toAdmin > Attributes > Restricted Sets:
a) Select the Restricted Set to export.
b) Select Actions > Export.
c) Click the Import button.

If the restricted set exists, it will be overwritten with the new values. If it does not exist, it will be
created.

Note:  This is similar to exporting / importing attribute categories and task types. The exported
category will contain the exported restricted sets in the same XML file. While Importing this in a new
system, the restricted sets and attribute categories will be created.

System History Logs

All Restricted Set related events like

• Restricted Set created

• Restricted Set deleted and

• Restricted Set changed

are recorded and stored in System History. Read this page on how to access the records.

3.16.2.  Attributes

Create an Attribute
1. Click Admin > Attributes > New Attribute.
2. Enter information in the fields as appropriate:

In the field... Fill in the...

Name name of the attribute (for example, Billable).

Label text of the label which has to be displayed. To get the translated
text of the label in the other languages chosen, select the blue
icon to open Find or Create Translated labels on page 307.

Description description of the attribute contents (for example, Indicates
whether work on this project should be billed
by finance).

Type the type of the attribute. You can select from the drop down.
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In the field... Fill in the...

Document References are attribute-links pointing to different
document sources. When you select this option, you will have
more options. Read more in Create a Document Reference
Attribute on page 364.

Floats are numbers containing a decimal point (e.g. 3.1415)
and integers are whole numbers (e.g. 42).

Date and Time attribute added in the project attribute category
allows to link a date/time to the project status.

Text ( Right to Left) attribute allows text to be written right to
left always and this feature is available in 18.0.1 onwards.

Rich Text attribute type allows you in entering long and/or rich
text. You can:

• add set of least 16 different colors.
• set the text bold and italic.
• use bulleted and numbered lists.
• Heading up to four levels and also add tables.

In the Preview you will see the Rich Text editor. Click the Show
Rich Text Controls link to view the broad pallet of text options.
The Project Managers with change properties rights can add
content from a document to the Rich text editor window.
Here, the text (also Chinese, special characters), font types,
bullet types, color, tables and headings are preserved. From
WebCenter 18.0.1, there is also an option to change the text
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In the field... Fill in the...

direction using the buttons  (right to left or left to
right).

Values choose either:

• Prompted if you want to allow the user to enter any value.

• Calculated if you want to use an ArtiosCAD formula to
calculate the attribute value (enter the ArtiosCAD formula in
the field).

Note:  You should set Calculated attributes to read-only
as their values are automatically updated from ArtiosCAD
and should not be changed by WebCenter users. To set the
value of the calculated attributes during upload, ensure that
you have a default attribute category with the calculated
attributes for the ArtiosCAD documents.

• Restricted Set to limit the possible values.

Note:

To choose a Restricted Set, it must be created before defining
the attribute (see Create a Restricted Set on page 303).

Make sure that the Type of the Restricted Set is the same as the
attribute type.

Note:  For Document Reference attributes, you will have only
Prompted as the value.

3. Select Attribute is also a task specification if you want to be able to use the attribute as a task
specification.

For more information about task specifications, see Basic Concepts of Task Management on page
842".

4. Click Create.

Find or Create Translated labels

Where will you find this option
This option may be found, when you

• Create an Attribute or a document reference
• Create or edit a Search using Search Panel Design

How to Create new translated label
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You can either search for translations or create a new label in the language you require.

Edit an Attribute
1. Click Admin > Attributes
2. Click the attribute to edit.
3. Edit the attribute as desired (change the Name, Description...).

Note:  You cannot change the attribute type.

4. Click Change to make the changes.

Copy and Paste Attributes
Attributes can be easily copied between attribute categories between two views in the same
categories or between attribute categories and task type specifications. This can be done within the
same WebCenter system or between different WebCenter systems.

To copy your selection of attributes in any view to the clipboard by either using keyboard shortcuts like
Ctrl/Cmd+C, Ctrl/Cmd+X, Ctrl/Cmd+V, or by using a context menu (right click).

Note:  Copy and paste of attributes is possible only in Grid Layout and this feature is not supported in
the Header view of the Attribute Category.

When pasting the content in a cell, all settings including labels, rules, styles, document reference
rendering configurations and lists are copied.

There can be conflicts detected when you paste the copied cells into another location. Following are
the possibilities that may arise:

Conflict Detected Action that can be performed

Target cells are already occupied Choose to overwrite or cancel the operation

Copied cells are already existing in the new
location

Choose to replace the existing one or skip the
conflicting cells or cancel the operation

When the copied attribute has rules / styles that
are already existing in the new location

Choose to

• overwrite the rule/ style
• keep both the rules/ styles. Copied rules/styles

gets a number added to its name
• Use the existing rules/Styles or
• cancel the operation

When a list entry is already assigned to a
different set of attributes in the destination
category

Choose to

• overwrite the list
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Conflict Detected Action that can be performed
• keep both the lists
• merge values or
• cancel the operation

When the copied Form property (Task execution
or project creation view) already exists in the
destination

Choose to

• overwrite the selection
• Skip the action

Note:  When a form property is placed in a view
where it cannot be placed, it will be ignored

System History Logs
All Attribute related events like

• Attribute Created

• Attribute Deleted and

• Attribute Changed

are recorded and stored in the System History. Read this page on how to access the records System
History on page 439

Delete an Attribute
When deleting an attribute, WebCenter checks if the attribute or any of its child attributes are used in
any projects. If it is, you are prompted to remove it from the project and delete anyway, or cancel the
deletion.

1. Click Admin > Attributes
2. Select the attribute to delete and click Delete Attribute(s) in the actions menu.

If the attribute is not being used, it is deleted immediately.

3.16.3.  Attribute Categories

An attribute category is a set of attributes which are used together and is a way to apply attributes to a
project or a document.

Attribute categories contain:

• attributes you selected
• lay-out elements (ruler, table, spacer, title)
• styling
• custom labels
• rules
•
• buttons (potentially automatically executed on events)
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System History Logs
All Attribute Category related events like

• Attribute Category Created
• Attribute Category Deleted and
• Attribute Category  Changed

are recorded and stored in the System History. Read this page on how to access the recordsSystem
History on page 439

Create an Attribute Category
1. Click Admin > Attributes > Attribute Categories > New Category.
2. Enter the name of the Attribute Category to create, for example Shipping Instructions.
3. Click Create.

Once you have created the attribute category, you can add attributes to it, define views, etc.

To do this, click the Attribute category was created successfully. Edit ... link (see Add Attributes to an
Attribute Category on page 310 for details).

Rename an Attribute Category
1. Click Admin > Attributes > Attribute Categories.
2. Click the attribute category to rename.
3. Type the new name in the Edit Category page.
4. Click Save.

Note:  Click Save As Copy if you want to duplicate the attribute category under the new name, while
keeping the original category as it was.

Add Attributes to an Attribute Category
1. Click Admin > Attributes > Attribute Categories.

The Edit Category page shows two columns: the available attributes (that you can add to the
category) at left, and the attributes that are already in the category at right.

2. To add attributes to a category or remove them from it, use the chevron (<< or >>) buttons to move
them between the two columns.

Note:

Moving attributes between columns takes effect immediately.

Attributes you have added to the category have an * in the left column.

Tip:  Use the search field to filter the available attributes list, and the  and  buttons to
change the order of the attributes in the category.

You can see a Preview of your attributes under the columns.
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3. Click Save when you are done.

Attributes Views
You can use different layouts for the same Attribute Category in different locations or pages by
creating custom Attribute Views. A View created for a particular context can have custom layout for
that context. This way, different places in the user interface can show different levels of details of the
attributes.

For example, you can choose to show very few attributes during Document upload using a Creation
View. See more examples below.

You can use special Attribute Views such as Project Creation Form view to create request forms in
WebCenter. You can completely customize these forms with your business terms without any default
terminology from the application.

You can have multiple views for an Attribute Category. Essentially, these are subsets of the category
with different layouts (if you have configured it that way).

You can configure the following views:

• Default view: used in project attribute details page and document attribute details page. You
cannot delete this view.

• Creation view: used in the project creation and upload document pages.
• Header view: used in the headers of project details pages and document details pages
• BOM view: used in the Bill of Materials tab of projects
• Task Type views: For each task type you can define a view which will be used in the task execution

page for documents attached to this task.
• Viewer Views
• Project Creation Form View
• Task Execution View (for Task Specifications)

Default View
When adding attributes to a category, only the Default View of the category exists at first (you can add
other views). The Default View is the view that will be shown in the project or document details (on the
Attributes page).
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Note:

• Users can edit attributes in the default view if they have Change Properties right on the project (for
project attributes) or on the folder containing the document (for document attributes).

• When editing attributes, they must fill in attributes that are required (they have a red *).

• They cannot edit attributes that the Admin made Read Only.

Creation View
If you have added a Creation View of the attributes, users see it when they:

• create a project with attributes,
• create a document placeholder from a document template with attributes,
• upload one or multiple documents with attributes.

 

 

Note:

• If you haven't added a creation view, users will see the default view instead when performing those
tasks.

• When editing attributes, users must fill in attributes that are required (they have a red *). They will
not be able to create the project / document placeholder if they don't!

Users cannot edit attributes that the Admin made Read Only.
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Header View
If you have added a Header View of the attributes, users see it in the header of the project or document
details page.

 

 

Note:

• If you haven't added a header view, users will not see attributes in the project or document header.

• Users cannot edit attributes in the header view.

Task Type View
If you have added a Task Type View of the attributes, users see it on the task details page for
documents attached to a task of that specific task type.

Viewer View
You can create dedicated views to allow your users to view the active document's attribute category in
the Viewer.

If you have configured your attribute category with such Views, your users can view this in the
Attributes widget.

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageId=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change a reference from the Viewer and save this configuration.

Note:  Only the users with Project / Folder level Change Properties permissions can change and save
attributes from the attributes widget.

Read also: Add Viewer Views on page 314.

Add Attributes Views

• To add a creation view:
a) Click Add Creation View in the Edit Category page.

The attributes in the category are copied from the default view to the creation view.
b) Use << to remove any attributes you don't want to show in the creation view.
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Note:

You cannot add attributes to the creation view if they are not already in the default view.

To add more attributes to the creation view, switch the Current View to Default, add the
attributes, then switch it back to Creation.

c) Use a grid layout if desired (see Use a Grid Layout on page 322 for more information).
• To add a header view:

a) Click Add Header View in the Edit Category page.

The attributes in the category are not copied from the default view to the header view.
b) Use >> to add attributes to the header view.

Note:

You cannot add attributes to the header view if they are not already in the default view.

To add more attributes to the header view, switch the Current View to Default, add the
attributes, then switch it back to Header.

Note:  You cannot use a grid layout for the header view.

c) Click Save to save all your views.

Add Viewer Views
You can create dedicated views to allow your users to view the active document's attribute category in
the Viewer.

If you have configured your attribute category with such Views, your users can view this in the
Attributes widget.

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageId=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change a reference from the Viewer and save this configuration.

Note:  Only the users with Project / Folder level Change Properties permissions can change and save
attributes from the attributes widget.

To create a Viewer View:

• Click Add View in the Edit Category page.
You will get a pop-up to type in the view name.

• Type the name of the View. You can create a general Viewer view for all users or views dedicated to
a particular role / group.

You can create the following views:

• Viewer for a general Viewer view of the attributes.
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• Viewer [Role] with the specific role name as a sux. This view will be visible in the
Attributes widget of the Viewer when a member of that role opens the document.

• Viewer [Group] with the specific group name as a sux. This view will be visible when a
member of that group opens the document.

Note:  It is important that you name your views exactly as above

You will be switched to the newly created view. All your attributes from the default view will be
copied into the new one.

• Use << to remove any attributes you don't want to show in the Viewer view.

Note:

You cannot add attributes to these views if they are not already in the default view. If you need more
attributes in the Viewer view:

1. Select the Default view in the Current View drop down.
2. Add attributes.
3. Switch to the Viewer view in the Current View drop down.

The attributes added to Viewer, Viewer [Role] or Viewer [Group] will be visible in the
Viewer.

• If your Viewer view is for document reference attributes, create specific source and rendering
configurations.

• Save.

If your Attribute Category View(s)
are...

and your User Role / Group is... The Viewer will have...

Only Default Any No widget

Viewer None Viewer View

Viewer, Viewer Designer None Viewer View

Viewer, Viewer Designer Designer Viewer Designer View

Viewer, Viewer Designer, Viewer
Legal

Legal Viewer Legal View

Viewer, Viewer Designer, Viewer
Legal

Designer and Legal Viewer Designer View / Viewer
Legal View + selector to switch
between the Views

Viewer, Viewer Designer, Viewer
Legal

Marketing Viewer View

Viewing Attributes on page 744

Edit the Terminology for Project Creation
It is possible to change the terminology used for project creation so that the Project Creation page
talks about "Designs" instead of "Documents", or "Roles" instead of "Placeholder Groups", for example...

315



3 WebCenter

You can achieve this by customizing the terminology in the attribute category of the project or
template used as a basis for project creation.

You need to:

1. Click the attribute category to use on the Attribute Categories page.
2. Add a Creation or Header view to your attribute category and click Save.
3. Click Edit Terminology.
4. In the Edit Terminology pop-up, fill in the custom terms you want use instead of the default project

creation terms.

For example, fill in Designs in the Documents field if you want to show "Designs" instead of
"Documents" on the project creation page.

Any field left blank will still use the default term.

 

 

Attention:  Your custom terms will not be automatically translated, and will show as you
enter them for all languages in which you run WebCenter.

5. Optionally, you can specify Section Sequence if you want to alter the order of the sections. To
do that alter the sequence of the GABDM (General Details, Attributes, Bill Of Materials, Docs,
Members) in the way you want.

• The system does not accept wrong combinations such as other letters, too many letters or
repetitions.
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• If less letters are given, the system will order these sections first and then put the others in the
normal sequence.

• Section sequence is not applicable to project creation view since it displays the attribute
category

In the Task Specifications of a Task Type, it’s also possible to edit terminology, though more limited;
it is not possible to change the section sequence. The edit terminology link is available in the
Default view and the task execution view

If you configure the Project Creation form to have less sections than GABDM, these are simply
taken out. For example, if you specify GABDM, but have configured the Project creation with no
Documents section, you will have the following in that order:

• General details
• Attributes
• Bill of Materials
• Members

Project Creation Form View
You can fully customize your Project Creation form in WebCenter. This way you can have a uniform
customized look for the entire project creation form. You can combine attributes with project
properties in an Attribute Category with a Project Creation Form View.

When you add this special view, this category will load default Project Creation Properties just like
attributes in their default order ( as in a default Project Form).

See the example screenshot to see the default Project Form.
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The following Project Properties are available in this view and you can customize all of them. The
fields from all sections are included in this view but without section titles (Members, Bill of Materials,
Documents).

• Template selector on top of the Project Creation form
• ProjectName
• Requestor
• Project Manager
• Thumbnail
• Customer
• Planning (backward or forward)
• LastTaskEnds (Date for Planning)
• Status
• Description
• Location
• Members
• Bill of Materials
• Documents

 

 

In the attribute selector pane, you will see both the attributes and the project properties. You can use
the selector to toggle between Attributes and Project Properties.

When the Attribute Category (with Project Creation View) is assigned to the Template or the Project,
the new custom form fields will appear during project creation.

Notes
Use caution when customizing Project Property fields:

• When you remove ProjectName from the Attribute Category View, make sure that you have
configured Autonaming in the Project Template.
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• Make sure that Project Details  >  Configuration >  Project Creation page is in line with your Project
Creation view:
 

 

• The required fields should be configured as Visible. Read more in: Project Creation Settings on
page 164

• Make sure that the Set Attributes is enabled. If this field is disabled, the Project Creation Form
will not load (when using Project Creation Form view).

• If some fields are disabled in this page, but added to the Project Creation Form view, they are not
available during project creation.

• Planning fields are available only when the Project / Template has tasks. Also if the label of the field
LastTaskEnds is not custom, the value will change to “First Task Starts” when planning is set to
Forward.

• The Requestor field is available when there is a REQUESTOR role.

Add Project Creation Form View

Create the Attribute Category  that you want to assign to the Project or Template from which your users
will create Projects.

To modify the Project Creation Form, you have to Add Project Creation View to this Attribute Category.

To add a Project Creation Form view:

• Click Add Project Creation View in the Edit Category page.

The existing attributes (if any) and all default Project Properties are added to this view.
• Use << to remove any Project Properties or Attributes you don't want to show in the Project

Creation Form. Read the notes in: Project Creation Form View on page 317 before you do this step.

You can also drag these Project properties and place them between the Attributes in the Attribute
Category. When you remove properties, they don't appear in the Project Creation Form.
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Note:

You cannot add attributes to this creation view if they are not already in the default view.

To add more attributes to the creation view, switch to the Default view, add the attributes and
switch back to Project Creation Form View.

• Use a grid layout if desired (see Use a Grid Layout on page 322 for more information). Grid layout
gives you the possibility to customize your Project Properties with advanced features.

Keep the following in mind when customizing Properties:

• You can show and hide fields or sections based on attribute values
• You cannot specify them as Read-Only or Required
• You can customize the label or image including their position (left or top).
• You can add Style to these Properties
• You can define the Column Span for them.

• Save.

When Project Creation Form View is defined in a Project's or Template's Attribute Category, the custom
view is loaded when a user creates a Project (based on that Project or Template). When this view is
loaded, the whole page will look like one continuous form. See the result of the example configuration:
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Configuring Preview for Attribute Category

Preview the Attributes in the document
You can view the preview of any documents in the Preview tab of the document, which is enabled by
default to all users.

When you navigate to the Preview tab of the document, a dashboard is loaded with two blocks
displayed side by side, namely

1. Attributes block on the left side and
2. Preview block on the right side

Configure Preview Block
To configure the preview block to render, following attributes have to be created and configured:

Create Attributes For

PREVIEW_TYPE This text type attribute is to specify which type of preview user wants
to see. It can hold value from a restricted set, which contains values
CHILIPreview and StaticPreview.

PREVIEW_DOCUMENT This document reference type of the attribute can hold a single HTML or
Chili document to create preview.

LOCALE_# Attributes to specify the locale index to prepare locale mapping for
the languages. Create as many Locale attributes as per the number of
languages you require.

In the Preview > Attributes , choose either of the following:

• CHILI Preview: This preview is applicable for Chili documents. When you enable this option, Chili
viewer loads in the Preview block.
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Note:  You can view the Attributes and the Chili document in the preview mode, only if the option is
enabled in the Chili set up. Read about Chili Setup here. Admin user has to add the menu option for
the required user groups.

• Static Preview: When this type is selected then the Preview block loads a HTML file and the values
can be simultaneously updated.

Update Preview Block with Attribute values change
When any update is made to the attributes, the matching text/image placeholders in the preview block
are updated in real time.

You can update the values for the Chili document along with the attributes and save either as new
version of the document or retain it as a draft.

Delete an Attribute Category
WebCenter checks if an Attribute Category is being used before deleting it. If it is in use, you will be
prompted to either clear the category from the projects or documents using it and delete the category,
or to cancel the deletion.

1. Click Admin > Attributes > Attribute Categories.
2. Select the attribute category to delete and click Delete Category in the actions menu.

If the attribute category is not being used, it is deleted immediately.

Use a Grid Layout
Adding a grid layout to your attribute category allows you to customize the way your attributes will be
shown to users.

It also provides more advanced features, like making an attribute required (users have to fill it in) or
read only.

1. Click Use Grid Layout in the Edit Category page.

This shows extra options and buttons on top of your attributes column, and a Details table at right,
containing information and extra options for the selected attribute.
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2. Select Alternating background if you want your rows to have an alternating background color.
3. Select Show also Attribute types and Restricted Set Types if you want the types of the attributes /

attributes restricted sets to be displayed after each attribute (like Business Unit in the example
above).

When checked, pages having this attribute category or task specification layout will not keep the
session alive. This allows you to fill out long forms without having to log in repeatedly.

4. Optionally enable Keep Session Alive when user is inactive to avoid getting timed out when there
are signs of inactivity.

As long as the user is working on the form, the session will be kept alive. However, if the browser
detects that the user in inactive, it stops keeping the session alive. When this flag is turned on, the
session will be kept alive even if the user is inactive.

5. Add or remove columns and rows as desired:

•
Click  to add a row at the bottom of the table.

•
Select a row and click  to insert another row before it.

•
Select a row and click  to remove it.

•
Click  to add a column at the right of the table.

•
Select a column and click  to insert another column before it.

•
Select a column and click  to remove it.

Note:

6. If you want an attribute to be displayed across several columns, select it and enter the desired
number of columns in Span Columns in the Details table.
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7. You have the option to have a cell to span over multiple rows. You can increase or decrease the row

in the Row Span. You can increase or decrease the row span for cells to have better layout.
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8. Format your grid as desired:

•
To add a Title row, click  then fill in the Title, choose the number of Columns to span and the
title Style in the pop-up that opens.

•
To add a Spacer bar, click  then fill in the bar's Height and Color in the pop-up that opens.

Note:

• You can use color names or hexadecimal codes.
• If you don't enter a Height, the bar will have a default height.

• If you don't enter a Color, the bar will be white.

•
To add a Ruler, click  then choose the number of Columns to span and fill in the Height and
Color in the pop-up that opens.
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•
To add a Header Bar, click .

The example below has a Header Bar on top (showing Name, Value and Type), then a Title
(Packaging information), a blue Spacer bar, and a black Ruler after two attributes.

 

 

Note:  You can edit the formatting (color, height...) in the Details table at right when you select the
cell.

9. You can change how an attribute will appear to the user by giving it a Label (in the Details table).
For example, you could use a label to show Manufactured in: instead of Country. This is
particularly useful if the users are not familiar with your attributes, or if you are using generic
attributes for different purposes.

If you set the labels on top for at least an entire column, you will have a nice form layout.
10. Select the Position of the Label as either Left or Top.

By default, the Label will be placed on the left side in the grid. But you can place it on top of the
value to modify the form appearance.

A single cell will contain both the Label and the Value. Within this cell, you can manage alignment
via the style options.

 

 
11. If you are using Date time Attribute, then you have an option to hide the time and display only the

date by checking the box Hide Time.
12. You can also format individual attribute cells using Styles (see Define Styles on page 327).
13. If you are using Date time Attribute, then you have an option to hide the time and display only the

date by checking the box Hide Time.
14. If desired, change the visibility of individual attributes: select a cell and choose the Visibility

parameter to use:

• Choose Editable if you want the users (with the right permissions) to be able to edit this
attribute.

• Choose Required if you want to make it mandatory for users (with the right permissions) to fill in
this attribute.
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If a user doesn't fill in a Required attribute during project creation for example, he / she will not
be able to save the project.

• Choose Read Only if you don't want any user to be able to edit this attribute.
• Choose Hidden if you don't want to show this attribute to users. The values will be deleted in this

case.
• Choose Hidden (Keep Values) if you don't want to show this attribute to users but keep the

value.

Note:  You can also use visibility Rules to determine when an attribute will be hidden / required /
read only... See Set Visibility on page 328.

15. Click Save when you are done.

Define Styles
Define styles to further customize your attributes layout.

1. Select the cell of the attribute to customize.

This show the Details table at right.
2. Click Add Style to define a custom style.

Note:  You can also use one of the predefined styles (WebCenter Attribute or WebCenter Title) if
you want your attributes to have the default WebCenter look.

3. Define your style: enter a Style Name, a Background Color (use the color name or the hexadecimal
code), choose a Font Family, Font Style, Font Weight, Font Size, Font Color.

 

 

You can fix the Column width of the first column to keep the titles aligned.

Set the Column width lower than what you want as there is some margin for the columns. The total
table takes the full width of the allowed/available space (depending on the browser). Therefore
fixing the width of one column has an effect on the other columns.
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Tip:  Do not fix the width of all columns as it will lead to unpredictable results.

Click OK to update the style for the attribute..

You can see your style applied to the attribute cell in the Preview.

To apply it to another attribute cell, select the cell then select the style in the Details table.

You can edit or delete the style using the links in the Details table.

Set Style based on Rules

You can define styles for Attributes based on the rules set up.

This allows flexibility to display different styles based on the parameters defined in the rule. Rules can
be set up with JavaScript or an Attribute value for both Styles and Visibility Rules. Style rules can be
set up in the same way as visibility rules, except for the then and else section, where styles should be
selected instead of visibility.

For example,

if (return att["Attribute1"] + att["current"] + att["Attribute3"] < 100) then the cell
 is green, else, the cell is red.

Note:  You can create a rule based on the value of the Current Attribute. In a style rule, Current
Attribute is used to actually execute.

Note:  Once you have defined a style in the Default view, you can use it in the Creation view, and vice-
versa.

Set Visibility
If you want an attribute to be hidden or required or read only, depending on a condition, you should
define a visibility rule for this attribute.

A rule makes the visibility of an attribute depend on one or more other attributes or a JavaScript
snippet.

1. Select the cell of the attribute for which you need a visibility rule.

This show the Details table at right.
2. Click Add Rule to define a new visibility rule.
3. In the Edit Rule pop-up that opens, give your rule a name (choose a name that indicates what the

rule does).
 

 

328



3WebCenter

4. Define your rule.

For example, you want the attribute Number of samples to only be visible (and filled in) if the
Sample Needed attribute is set to Yes.

a) You need to first define the condition: If The value of attribute Samples Needed = Yes.
b) Then define what happens when this condition is fulfilled: The cell is: Required.
c) Then define what happens when it is not fulfilled: Else, the cell is Hidden.

 

 
5. You can edit the Visibility rules and Styles rules based on Java Script rules. Instead of choosing an

attribute value, you can add a JavaScript code snippet to create a rule for visibility or styles. This
allows more flexibility and can have customized rules apart from the attribute values. Read more on
how to set Edit Styles / Visibility based on Java Script rules You can also add chain rules for styles,
where the conditions can be linked based on rules. Read more about Chained rules.

6. Click OK when you are done defining your rule.

The Preview is updated to reflect the result of your rule.

Note:

The Preview is interactive: in the example above, you can choose Yes for the Samples Needed
attributes in the Preview, and see the Number of samples attribute displayed.

You can choose No (or nothing at all) and have that attribute hidden.

To apply the rule to another attribute cell, select the cell then select the rule in the Details table.

You can edit or delete the rule using the links in the Details table.

Note:  Once you have defined a rule in the Default view, you can use it in the Creation view, and vice-
versa.
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Note:

You can create more complex rules by clicking the And link to add more conditions.

Choose AND if both conditions should be fulfilled, or OR if at least one of them should.

 

 

You can define very complex rules if necessary.

In the example below, a warning message is made visible (but read only) when somebody requests more
than 10000 samples or asks for more than 4 spot colors.

The warning message itself can be a title or an attribute (that you can use in several attribute
categories).

 

 

Note:  You can add styles to based on the result of your rules set. Read for detailed explanationRules for
Style and Visibility

Style Rule based on Attribute Value

For example, If <Attribute Value (choose from the drop down) = X > then the style = (Style Name A, else
Style Name B) where Style Name A and Style Name B are predefined

330



3WebCenter

Change Cell Details for Multiple Cells

In the grid layout, when you click on a non-empty cell, details are shown to the right of the grid. You
can change the details of multiple attributes by choosing the cells using CTRL /CMD and SHIFT keys or
selecting individual attributes holding the CTRL key.

When multiple attributes are selected, only the details that are relevant for the selected cells are
shown.

When the values of all the selected attributes are the same for an option, it is displayed in the details. A
blank value is shown if the selected cells have different values. When selecting a value, and it is applied
to all the selected cells.

Enhancing Attributes with Advanced Features from Grid Layout
You can enhance the attributes from the Grid layout view. You can restrict values to available
cascading attributes, create multi-value attributes, add label images and add HTML help to the
attributes.

• Click Use Grid Layout in the Edit Category page.
• You can add LookUp Attributes on page 332 button next to your Attributes in your form.
• Click on any of the attributes. Its details will appear on the right side.

 

 
• Label Image: You can add a representative image as a label image. Read more in Create Image Label

for an Attribute on page 338.
• Restrict Values: You can restrict values to list containing Cascading Dropdowns as columns and

select their rendering.
You can also create check boxes, radio buttons and image selectors for text type list attributes.

• Allow Multiple Values: You can allow more than one value to an attribute. Read more in Create a
Multi-Value Attribute on page 340.

• Info Page: You can provide additional information in an HTML page. Read more in Create HTML
Information for an Attribute on page 341.
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LookUp Attributes
You can use LookUpattributes button to fill multiple attribute fields based on one or more input
attributes without a cascading dropdown. You can configure the list in the details of this button. You do
not have to restrict individual attribute values to a list when using this button.

You can create a better user experience with this feature if a lot of properties must be loaded for
something already well-known / unique. The typical example is loading product details or component
details when you enter the product code. In this case, when you type the code and click the button, you
will get all its details filled.

When you have partial / non-unique information, use Cascading Dropdowns.

1. Create and add attributes to an Attribute Category.
2. Select your attribute in the Grid Layout.
3.

Click on the LookUpAttributes  button to add it next to the selected attribute.
You will see the Button details in the Details of selected cell table.

 

 
4. Modify the button's details.

• You can specify the Label text you want to display next to your button.
• Pick a Style for the button to change its look.

Note:  If you choose Hidden, you can Execute the button :

• On Save

• On Load

• On Change of Attribute where you need to specify the attribute

• Select a list.
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Note:  You can use the lists created on the WebCenter database. Cascading dropdowns placed on
Web Server are not supported.

• Set Function to LookUpAttributes.
• Add one or more Input Attributes. Select the attribute from a list of attributes in your category

and match it to the right list Column. Click on Add Input Attribute to add more.
• Enable Exact to only allow exact matches. For example, if the input attribute is country name

and if you type Belg, you can get Belgium if the Exact  is off. If this is on, you will find country
details only if you type Belgium entirely.

• Add all the Output Attributes. Select the attribute from a list of attributes in your category and
match it to the right list Column. Click on Add Output Attribute to add more. This will correct
your (typed) input attributes to the ocial value. If you type Belg and click the button, the entry
value will be Belgium. This will also add the other details associated with this attribute.

5. You can now test the button and save.

Check Unique Values
This feature allows you to create a unique name for a component. It helps to create names which are
different from existing names.

However, this is not useful if you are creating pure numbers (where you expect auto-numbering). Use
auto-numbering in such cases.

Note:

This function does not guarantee that the values are unique throughout the system.

1. Create and add attributes to an Attribute Category.
2. Select your attribute cell in the Grid Layout.

Note:  This function does not work for date attributes or rich text attributes. You will be warned if
you use any of these types.

3.
Click on the Add button  icon to add it next to the selected attribute.
You will see the Button details in the Details of selected cell table.
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4. Modify the button's details.

• You can specify the Label text you want to display next to your attribute.
• Pick a Style for the button to change its look.
• Set Function to CheckUniqueValue.

5. Now save.

Note:  This function is dicult to test via the preview because the checks are done based on the
current project, document or task. In the preview, you have no document, project or task.

In a project attribute category, it checks whether the filled out value already exists for another project
in the system. If yes, you will be warned that it is not unique. The function will force you to choose
another value before you can save the attributes or create the project (during project creation).

In a document attribute category, it checks whether the filled out value already exists for another
document in the system.

Note:  This function does not check the versions of the current document. So multiple versions of the
same document may share the same attribute value.

In a task type, it checks whether the filled out value already exists for another task of any task type.

Note:

This verification happens when you click the button or when you save the checked attribute. This
check will not happen if you change the attribute in any of following ways:

• via a system integration (WebCenter SDK)
• via Automation Engine
• when changing a group of attribute values via the project saved search operations
• when setting the attribute via a workflow
• when setting the attribute via ArtiosCAD

The check button must be in the visible view. This way you can have a check which only happens during
creation or in a task type view.

Note:  A unique value for a task does not guarantee that this value does not exist for a project. So this
function is not of use while using automatically set project attribute values from task specifications.

Create JavaScript Button
A JavaScript button allows you to create a powerful additional functionality within a WebCenter form.

Warning:  This is an advanced feature and we recommend that only Esko solution architects
and advanced administrators use this.

Use this to:

• execute a calculation within the form
• copy information from a project to a document created in the project
• automatically fill out values for attributes (which are specified as read-only)
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Note:

The JavaScript operation is done within the form. However, this may not be automatic in all cases. For
example, when you copy project attribute values to documents, the JavaScript execution happens
once. When the project attribute is changed, the document attribute will not be synchronized until the
button is clicked again. This avoids issues related to full synchronization.

Read JavaScript examples in the Esko Knowledge Base Article.

 

 

In the screen shot, you can see a simple script in the JavaScript Code field.

docref[“Document Reference Attribute Name”] could be used to access the attributes of a referenced
Document.

• Do not return a value but set the value of att[‘MyAttribute’]
• All attribute names must be surrounded by single quotes
• All attribute names are case sensitive
• Use the attribute name. This can be different from the attribute label visible in the form
• The property att is case sensitive.

• Technical info: att is an associative JavaScript array containing a copy of the current values for all
placed attributes. At the end of the execution, (only) the changed values are copied back into the
form.

Note:

• Use this only if you know JavaScript and its use. Consult your Esko Solution Architect in case you
need JavaScript operations.

• The function is protected against misuse by only allowing to change attributes contained in the
current attribute category. This also shows message boxes. The function cannot change any other
data in WebCenter (for example it cannot execute web calls).
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Advanced JS Button features

JavaScript Buttons can be programmed to access attributes of the referenced Document.

• docref[“Document Reference Attribute Name”] could be used to access the attributes of the
Attribute Category of a referenced Document.

This operator returns a JavaScript object with following properties:

count 

Number of documents referenced by the selected Document Reference

docbyname(“Name of the Document”) or docbypos(Position of the
                    document)

Returns a JavaScript object representing the Attribute Category of the selected Document.

Properties of the Attribute Category object of the selected Document:

Property Description

att[“attribute name”] Get the value of the specified attribute.

setatt(“attribute name”, “value”) Set the value of the specified attribute

prop[“reference property name”] Get the value of the referenced property

setprop(“reference property name”,
“value”)

Set the value of the referenced property

For example, the sample scripts below, shows how to push an attribute value to an attribute in the
attribute category of all the referenced documents.

All the documents being referenced, are gathered using docref["docRef"] and stored in the boxes
variable.

The for loop iterates over all these documents and for every document it updates the "Price" attribute in
the attribute category.
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• Another operator that was introduced for this functionality is “parent”. It allows you to work with the
parent Attribute Category (Category from where current Document is being referenced).

It returns a similar JavaScript object as "docref" with the following properties:

Property Description

att[“attribute name”] Get the value of the specified attribute.

setatt(“attribute name”, “value”) Set the value of the specified attribute

docref[“Document Reference Attribute
Name”

allows to go to the Attribute Category of a referenced
Document

parent allows to go to the parent Attribute Category (Category
from where current Document is being referenced

For example, the sample script below shows how to push an attribute value to a parent attribute
category.

Using both operators in combination makes it possible to iterate over the whole tree of Attribute
Categories of referenced Documents.

Note:

1. It is not possible to change the value of Document reference attributes
2. It is not possible to access / change attributes that are not loaded on the page at the time the

JavaScript Button is executed.
3. The expected result of the JavaScript logic should not be dependent on the order in which the

JavaScript Buttons are executed.

You can access some basic information about the Referenced Document as follows

Property Retuns the referenced document's

docRef.docposition Document position

docRef.docname Document name

docRef.docid Document id

337



3 WebCenter

Property Retuns the referenced document's

docRef.docdescription Description of the document

docRef.docversion Number/index of the document version, not its ID (1st version -> 1, 2nd
version -> 2, ...)

docRef.projectid ID of the project, where the referenced document resides. (Helpful to
find if the referenced document is linked to more projects)

docRef.projectname Name of the project with docRef.projectid ID. Note this information
might not be available in some cases and can return an empty String.

You cannot change the properties of a referenced document by assigning it a new value within
JavaScript button script. They are read-only values.

Create Image Label for an Attribute
You can create Project request forms or Order forms with graphical labels by setting image labels
for specific Attributes in an Attribute Category. You can use this feature to make the form visually
attractive and user friendly. In addition, you can add graphical (packaging) symbols and warnings to aid
the user while filling in the forms.

1. Add the label images to the following folder on the WebServer: WebCenter\WebServer\tomcat
\webapps\WebCenter_Inst\custom\AttributeLabelImages.
Create a new folder custom if it does not exist yet and create a folder named
AttributeLabelImages under this folder.

Note:

• For the best user experience, use .jpg images. It does recognize .gif,.jpeg and .png.

2. Open your Attribute Category and select the Attribute  for which you want to give an image label.
3. In the cell details, enter the correct image name including the extension in the Label Image field

and save your attribute category.
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Note:  The image name is case sensitive.

You can see image labels appearing instead of attribute names in the forms.

 

 

Tip:  In case you wish to display a check box for the attribute, make sure you use an attribute with a
restricted set containing only the values Yes and No.

Note:  You can either have a text label or an image label, but not both.
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Create a Multi-Value Attribute
There are situations when you are creating a new Project or filling in a Form, more than one value
needs to be added as an attribute. For example, if you are producing a packaging that is intended for
more than one market, you need to specify those markets as values in the respective attribute field.
You can use a multi-value attribute for this purpose.

• Open your Attribute Category and select the Attribute  for which you want to give more than one
values.

• In the Details for the selected cell table (in the Grid layout ), enable Allow Multiple values.

 

 

In your Project (as a form), you will have the particular attribute with an option to select more than one
(or all) values in its response field. See an example below.
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Note:

Simple text attributes were limited to 255 characters until WebCenter 14. There is no character
limitation from WebCenter 14 onwards. This allows for unlimited attribute values for a single multi-
value attribute.

Create HTML Information for an Attribute
When you design Project request forms or new Order forms, you might want to provide additional
information to the user who is filling in the information.

From WebCenter 12 onwards you can provide additional information as HTML help or information. This
is especially useful when technical fields need to be supported with extended HTML help.

There will be an information  icon that is added next to the attribute name or attribute image label.
When the user clicks on this icon, a pop-up HTML page with the information will appear.

1. Create an HTML file with the additional information you want to provide along with the attribute.
You can create textual information as well as images to explain the attribute.

2. Place this HTML file in the AttributeHelp folder ( WebCenter\WebServer\tomcat\webapps
\WebCenter_Inst\custom\AttributesHelp ).

3. Open the Attribute category and select the attribute for which you want to provide HTML help or
information.

4. In the cell details, enter the correct file name (of the HTML file) in the Info Page field and save your
Attribute Category.
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If you have an HTML information page linked to an attribute, you can see an information icon next to

the attribute in the form that you created. When you click on the information , you can see a pop-up
window with the information to help the User.
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Check box, Radio button and Image selector in your Attribute Category

You can decide the rendering of choices for a restricted set (text) and for list attributes (text). The
default rendering is a drop down with the options. You can show the options as :

• simple radio buttons or check boxes
• radio buttons or check boxes with images

This allows your users to see the options more clearly than in the case of a drop down.

Create Radio buttons and Check boxes

When you have a few options as the value for an attribute, you can present the options via radio
buttons or check boxes instead of a drop down.

Note:  Avoid doing this when you have a lot of options to select from. The form will load slow.

1. Create and add attributes to an Attribute Category.
2. Select your attribute in the Grid Layout.

An item Restrict Values will be visible in the Details section.
3. Select the Rendering as Radio / Checkboxes.
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In the Attribute Category Preview, you will see a set of checkboxes or radio buttons depending on
the items in the restricted set or valid items in the list column.

You will get Radio buttons for a single-value attribute.
 

 

You will have check boxes for a multi-value attribute. Select the Allow Multiple Values option for
this.
 

 

Note:

This is optimized for non-cascading type of restricted sets. You may also use them for cascading
dropdowns with limited values. Avoid using it when more than two attributes cascade.

Do not use this option for lists with thousands of rows.

4. Select the Column numbers, Alignment and the Label position.
You get the best user experience when the number of columns equals the number of allowed values
or one of its dividers. If you restrict it to one column, you will get a vertical array.
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By default the columns will be aligned as per the Distribute over Width option. You can choose to
align to the left or right depending on the appearance you prefer.

Create Image Selectors

You can use images just like Radio/Check boxes.

1. Create and add attributes to an Attribute Category.
2. Select your attribute in the Grid Layout.

An item Restrict Values will be visible in the Details section.

 

 
3. Select the Rendering as Images.

• The images must be placed on webinstance\custom\AttributeValueImages. You can
use the same images used in the Asset Browser as selectors.

Note:  The image names are case sensitive.

Tip:  You can create Push Through Configurations to access the AttributeValueImages,
AttributeLabelImages and AttributesHelp on the Web Server. This way your users do not have to
access the web server to customize the attributes.

• Height of Images:

You can resize the images by adjusting the height. By default, resizing is always done
proportionally and to 100 pixels. You can get high quality images when you create images with
the sizing specified here.

• Height of Cell:

345



3 WebCenter

The grid of images can take a lot of screen space. If you want to limit the space use and use
a scroll bar, limit the height of the cell. In this setting, the cell will have a fixed height and a
scrollbar when the needed size to show all images extends to given height.

• Image Type:

You can choose the Image Type as automatic to display any of the image types. However, we
recommend that you select an Image Type in this field.

 

 

Troubleshooting

• When you do not see any images at all : Verify the path where the images are located. If you have
multiple web server instances, you must have the images on each instance (or at least on the
instance where you try).

Note:  Do not put your images for image selectors in the AttributeLabelImages folder.

Check the extension of the images.

Note:  The name and the extension are case sensitive.

• When some images are missing:

Verify if there are any special characters. Avoid all the special characters (comma, %, …etc) except
space.

Check leading and trailing spaces and number of spaces in the names.

Restrict Attribute Values to Previously Selected Values
To setup a practical way to make a final selection from a previously made/calculated list of candidates,
a new function has been introduced.

It applies to attribute categories or task specifications with a grid-layout having a first multi-value
attribute (attribute A) and a second simple text, non-restricted set attribute (attribute B).

The result is Attribute B is restricted to the selected values of attribute A

This can be set up only by administrators and used by all users who can edit attributes.

Usage:

Select Attribute B in the grid layout. In the cell details, set the Restrict Values selector on Attribute.
This will display a dropdown with candidates for attribute B (this list is all plain-text multi-value
attributes).
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Select one of the candidates. This results in a behavior as shown in the below example: Final Country
(which is attribute B) is restricted to the selected values for Possible Country.

 

 

Details/Limitations:

• This function only works in grid layout
• Attribute A and B must both be plain text attributes. Attribute A can be a restricted set or a plain

text attribute (typically linked to a cascading dropdown).
• Attribute A must be multi-select
• Attribute B cannot be a restricted set or linked to a cascading dropdown
• Attribute B can still be multi-value, so you can select multiple values from the selected values of

attribute A
• In search, attribute B is NOT shown as a dropdown, so it behaves as a simple text
• The dropdown only appears when the attribute is editable, else the selected value(s) is/are simply

displayed as for a plain text attribute
• Auto-select: When attribute A has only 1 value selected, this value is automatically selected for

attribute B.
• Auto-deselect: When attribute B has a value and attribute A’s values are changed so that the value

for attribute B is no longer a selected value for attribute A, the value for attribute B will be de-
selected. In case attribute B is multi-value, this logic is applied to each value separately.

• It is allowed that attribute A is itself restricted by yet another attribute.
• This function works identically for task specifications
• It is allowed to set visibility rules on both attribute A and attribute B
• When attribute A is taken away from the attribute category or if it is deleted from the system,

attribute B becomes a plain text attribute. All set values are however remembered (even if they are
multi-value, they will be displayed in their base form “value 1 | value 2”).
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• When no values are selected for attribute A, nothing is displayed for attribute B (no empty dropdown
either).

3.16.4.  Lists

Cascading Dropdowns contain a set of dependent attributes. The choice of one attribute limits the
choice of other attributes in these Dropdowns.

These attributes will be visible as a drop down while building your forms and projects. This allows you to
customize and build intelligent forms. Using these, you can:

• retrieve relationships among values (for example, brand-sub brand roles).
• auto-fill the values depending on the relationship (if you select a brand, a brand description will be

filled in).
• do smart filtering (if you select a brand, you can filter the products that are available under the

brand).
• use in advanced searching (Asset Browsing). Read more in Asset Browser on page 210.
• Look Up attribute values buttons in attribute categories and task type specification forms.

You can create Cascading dropdowns as:

• Lists on page 348 based on WebCenter Database.
• Cascading Dropdowns based on Excel sheets placed on the web server.

Note:  We recommend that you reconfigure the attribute categories and task types to use the
database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

Lists
Lists contain a set of dependent attributes imported into WebCenter. The Lists data is added to the
WebCenter database and maintained in a WebCenter Project or Template. Therefore, you can modify
this data from WebCenter interface.

Also, you can control the access to this data by setting project permissions.

Note:  This works in the same way as the List Data imported from Excel sheets. However, you can use
larger data sets with these Database Lists. Read more about Lists from Excel sheets in Cascading
Dropdowns from Excel Sheet on page 355

Adding a new List

• Upload your Excel (either .xls or .xlsx) or XML document to a project or template named
ListManager. If this project does not exist yet, create a new project named ListManager.
In this project, you can create folders for different departments, setup approval cycles to approve
your lists before it is fully configured.

Note:  If you are uploading your lists to the ListManager template, only your administrators can see
the lists.

• Go to the Admin > Attributes > Lists page.
• Click New List.

You will see the New List configuration page.
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• General List Information: Specify the List Name and a Description
• Input Source Properties:

• Specify the Input Source Type. It can be either Excel or XML document. The Select Document
drop down will list the Excel or XML files uploaded to the ListManager project.

• Excel: Select the input Excel file from the Input Source Type drop down. Specify the Sheet
Name of the Excel sheet containing the List data.

• XML : Select the input XML from the drop down and specify the XML Main Node.

a) You may enable the Flush existing list data before updating the list option to clear the old data
from the List before updating with new data.
With this option on, whenever you upload a new version of the Excel / XML input document, the
data from the List will get deleted before the List data gets updated.

b) You can enable the Database user name and password are required when deleting data from
list as a security measure.
If you have enabled this, you have to specify a database user who has the permission to change
the database schema. The database SA (System Administrator) user can also change the
schema.

Important:  We recommend that you enable this option to avoid accidental deletion of Lists and
List Data.

• Log File Folder: Select this from the drop down listing the folders in the ListManager project.
This folder will contain the log files associated with individual Lists. The respective log files gets
updated when you add or modify List data. You can also set permissions for this folder so that only
your administrators can access the logs.

• Database info:

• Create new database table for storing the data: Select this when you want a new database
table for your list.

When this is selected, a WebCenter database table is created whenever you create a new List.
You need to specify the database user credentials to be able create new database tables.

Note:

If you check the Use the built-in 'webcenter' database user account to create the database
table, the SA user has to give the database Create Table rights to the default 'webcenter' user
account. In this case, you do not have to specify the database SA user credentials for creating
new list tables.

• Use an existing database table for storing the data:

Specify an existing table in the WebCenter database for storing the List data. The columns
in this database table and your List need to match. You do not have to specify database user
credentials to use an existing table for creating lists.

• List Properties: You can configure your Input Columns  in the List Properties table.

• Specify the columns relevant for the List here by selecting or deselecting.

By default, the column names of the database table will be the same as the input column names.
You may also change the Column names.
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Note:  The List column names should be unique.

• You can select a particular column as Unique Identifier. When you enable this, each value in this
List column has to be unique (for example, Product Names). It is possible to select more columns
as Unique Identifiers ( for example, Product Name-Product Variant combination).

Tip:

If you have selected more than one Unique Identifier columns, the combination of the values in
these columns have to be unique. For example, in the case of Product-Variant combinations, you
can have the same Product name repeated for each of its Variants.

Note:  When you are updating the list, make sure that the new data matches the Unique
Identifier column. If the new data does not match the identifier values, new rows will be created.
This does not apply if you have enabled the Flush existing list data before updating the list
option.

• Click Create List.

The Lists are displayed in the Lists overview page. Clicking on a specific List will lead to the List Details
page. You can inspect your List data here.

Note:  If you update the source XML or Excel document, the List Data will get updated.

Purging Lists

The document linked to a list can have newer versions created. When there are more than thirty
thousand (30000) new versions of the document that is linked to the list, the older versions of the list
up-to 20000 ( that is 1 to 20000 ) are purged. This is to make space for the newer versions to be stored.

Note:  Document versions can be linked into different projects. When purging, WebCenter will check if
any of the purged versions of the document is linked into a project. Documents versions that are linked
into a project are not purged.

Inspecting List Data

• Go to the Admin > Attributes > Lists page.
The Lists overview page displays all the existing Lists. The source document and the creator's name
is also listed in this page.

• Click on the name of the List you want to inspect.
• In the List Details on page 350 page, click Show List Data to see all of your list data.

You can filter on a list column with a specific value to make the inspection easier.
• Click Return to List Overview to return to the general Lists overview page.

List Details

The List Details page contains an overview of the following :

• General List information
• Input source properties:

350



3WebCenter

Use the Excel/XML Document link is to view the document’s action history.

You can also access the Log file from the respective link.

• List properties

You can:

• inspect a list's data  by clicking on Show List Data

• delete a list or its data

Unique Identifier

You can select a particular column as Unique Identifier. When you enable this, each value in this List
column has to be unique (for example, Product Names). It is possible to select more columns as Unique
Identifiers ( for example, Product Name-Product Variant combination).

Tip:

If you have selected more than one Unique Identifier columns, the combination of the values in these
columns have to be unique. For example, in the case of Product-Variant combinations, you can have
the same Product name repeated for each of its Variants.

Note:  When you are updating the list, make sure that the new data matches the Unique Identifier
column. If the new data does not match the identifier values, new rows will be created. This does not
apply if you have enabled the Flush existing list data before updating the list option.

Deleting a List or List Data
You can remove an existing List completely from the system or remove only the List data.

1. Go to the Admin > Attributes > Lists page.
2. Click on the List Name from the Lists table.

This will lead you to the List configuration page.
3. Choose either the Delete List Data option or Delete List option.
4. Enter the  Database User name and Password if required.

If you are deleting one of the Lists, you always have to enter the database user credentials.

Note:  If you are deleting the List Data, you have to enter the credentials only if the Database user
name and password are required when deleting data from list option was enabled while creating
the List.

5. Click Delete List or Delete List Data to confirm.

Note:

The deletion does not check if the List being deleted is in use by any of the attribute categories. This
will result in malfunctioning of the features using that attribute category.

To restore the affected attribute category, create a List with the same name as the deleted List.

To restore your deleted List Data, update the corresponding input file in the Listmanager project with a
new version.

351



3 WebCenter

Using Lists as Cascading Dropdowns
You can use Lists in the same way as the cascading dropdowns from Excel sheets.

1. Add and configure your List.
Go to Attributes > Attribute Categories or Task type specification form and click on any text
attribute field.

Note:

• Make sure you are in Grid Layout.

• Bring a text attribute into one of the cells.

• Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the
restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists based on the web server (if any) and the database lists as lists. These are now available for use
in your Projects and Forms

Note:  You cannot re-use a column of a list in more than one attributes belonging to one attribute
category. You can replicate the list temporarily to add the same column to another attribute of the
same attribute category.

2. Do this for multiple attributes that are required and you will see the cascading behavior.
When you select a value for one attribute, the other attribute values are restricted to what is
allowed according to the List data.

Replicate List Data in an Attribute Category
If you have to use the same list data multiple times for multiple attributes, you can copy the list to these
attributes. If you need two bar code selectors for your packaging component, you will need two fields in
the form with the same drop down.

1. Add and configure your List.
2. In the Admin mode, go to Attributes > Attribute Categories or Task type specification form and

click on any text attribute field.
An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists based on the web server (if any) and the database lists as lists. These are now available for use
in your Projects and Forms

3. Select the List from the Lists drop down. Click Copy List.

This way, you will get a second cascading drop down configuration without duplicating the data
on the database. You will get a new entry in the list drop down with the same list name with (2) as
sux. You can do this multiple times and the sux changes accordingly.

4. Add more attributes to the category and select values from the replicated Lists.

Note:  These copies are only available in the attribute categories where the List was replicated.
If you save the attribute category without linking any attributes to the copied Lists, they will be
removed.
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Configuring List Columns in an Attribute Category
You can customize the list columns in an attribute without changing the database list. You can:

• change the order of the columns in the cascading drop down. You can create cascading drop downs
with different column ordering using the same database lists.

• allow other values in the list.

1. Add and configure your List.
Go to Attributes > Attribute Categories or Task type specification form and click on any text
attribute field.

Note:

• Make sure you are in Grid Layout.

• Bring a text attribute into one of the cells.

• Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the
restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists here.
 

 
2. Click on the Configure List link.
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3. In the resulting dialog, you can use the arrows to change the order of the columns in the cascading

drop downs.

Tip:  You can configure the list column order to create a cascading tree in search results for your
asset browser. In the example above, you can change the Region to a higher level using the arrow
to move up.

4. By default, the cascading attribute values are corrected when one of the corresponding values
change. Disable the Correct the previous entries when a selection is not valid option if you do not
want your cascade to correct entries automatically.
This allows you to select combinations that are not present in the referenced list.

5. You can also specify whether the attribute values restricted to a list column should be allowed to
have non-list values. Enable Allow Other Values to do so.

• If you have turned the Allow Other Values option off, only the list column values can be selected
as a value. This means that if you have an empty field, you cannot type anything there.

• If the Allow Other Values option is on, you can type in an attribute value. The other attributes in
the same cascade will not be filtered to the new value until you save the attributes.

Note:  This configuration is attribute category specific. So the column in the database list
remain the same.

• If the Allow Other Values option is on for a multi-value attribute, you can click on the Other Value
link on the top to enter a non-list value. As a result, you will get an additional row to enter the
new value. You can create multiple rows this way.
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6. Optionally, enable Autoselect matching values when other values are filled out outside of

attributes page (e.g. workflow). This checkbox is off by default.

When this option is on, if one value was filled out by a workflow or elsewhere, the entire cascading
will be executed in the attribute page.

If the option is off, cascading will only occur when changes are done by a user in the attributes
page.

Cascading Dropdowns from Excel Sheet

Installing Cascading Dropdowns from Excel Sheet
You can create Cascading Dropdowns by following the steps below.

Note:  We recommend that you reconfigure the attribute categories and task types to use the
database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

1. Go to WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom. Create a
folder named excel under the custom folder if it is not present.
Only for WebCenter 10.2 users: go to webapp\javascript\cascading dropdowns and copy the two
javascript files to webapp\javascript. We recommend that these two files are backed up.

2. You need to place an XML file named lists.xml and the excel file (with your attributes to be
imported) in the excel folder.
You will find an example XML file called lists.xml and excel sheets in the excel folder under
webapp\custom_example.
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3. Adapt lists.xml according to your requirements, within the structure given in the example file.
See an example below:

<lists> <list> <name>Countries and
                        Managers</name> <file>CountryList.xls</file>
                        <type>Excel</type> <sheet>Country</sheet>
                        <column><columnName>CountryName</columnName></column>
                        <column><columnName>CountryCode</columnName></column>
                        <column><columnName>Region</columnName></column>
                        <column><columnName>CountryManager</columnName></column>
                        <column><columnName>RegionManager</columnName></column>
                        </list> <list> <name>Countries</name>
                        <file>CountryList.xls</file>
                        <type>Excel</type> <sheet>Country</sheet>
                        <column><columnName>CountryName</columnName></column>
                        <column><columnName>CountryCode</columnName></column>
                        </list> </lists>

Note:

• <lists>: This tag is obligatory in this code. You can specify the rest of the details regarding
the importing attribute list under <list> tag. In the above example, two attribute lists are
being imported.

• <name>: You can specify the name of the list which should appear among the WebCenter
attribute lists after this tag. There are two lists in the above example. The lists are named
Countries and Managers and Countries. These names appear in as List names in the
Restrict Values option.

• <file>: You should indicate the file name (including the .xls extension) after this tag. In the
above example, it is CountryList.xls and this file is placed along with lists.xml in the
custom folder.

• <type>: This should be Excel.

• <sheet>: Here you should specify the name of the work sheet in the excel file. Please avoid
special characters and spaces in the sheet name. The sheet name in the above example is
Country. You can make more than one lists from one sheet.

Remember:

You cannot make one list from the columns placed in different sheets.

As shown in the example, you can make two lists from the same excel sheet or from different
sheets in the same excel file.

• <column>: Each column in the excel sheet should be specified separately under the <column>
tag for each of the lists. In the example, five columns are specified under the list named
Countries and Managers and two columns under the list named Countries. The data
from the specified columns will be imported into WebCenter attribute categories.

• <columnName>: You should indicate name of the column here. Excel files get column names
from the values placed in the first row. Please avoid special characters in the column names.

4. Save and close the lists.xml file.
Make sure that your XML is XML-compliant and in the right folder (excel).
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5. Login to WebCenter as an admin. In the attribute category definition (Attributes > Attribute
Categories and in Grid Layout), click on a text attribute (not on a restricted set).

A Restrict Values item will be visible in the Details section. This shows a dropdown with the lists you
have configured in lists.xml.

These lists will have the values from the columns of the excel sheet.

Note:  If you are uninstalling WebCenter, the custom folder should be backed up and placed
back in the same location as before to restore the Cascading Dropdown functionality in the
new installation. If this folder or one of the files is missing, you will lose the installed Cascading
Dropdowns.

Using Excel based Cascading Dropdowns
The cascading attributes that have been imported will be visible in the attribute category definition.
You can see a dropdown with the lists you have configured in lists.xml here. These dropdowns are
filtered to the row combinations from Excel worksheets.

An example use case is when you want to you use all your brands and sub-brands and the respective
managers to be filled in to the project or for when you choose a product. If you have an excel file with
the information that needs to be imported into WebCenter, you can import this by following the steps
described in Installing Cascading Dropdowns from Excel Sheet on page 355

1. Create an Excel file with Column Names in the first row and fill the columns with your brand
related information that needs to be in the WebCenter Cascading Attributes.

Note:

• Please note that the columns that should be part of one list should be placed in one Excel Sheet.
It is not possible to make one list out of the data placed in different sheets.

• The Cascading Dropdowns are filtered to the row combinations from the specified worksheet.
The linking of row combinations is currently only possible for the columns placed in one Excel
sheet.

• We recommend you delete the first empty lines at the bottom of the Excel sheet to avoid the
Excel driver picking up completely empty lines and producing them as valid combinations.

• Make sure you save the Excel file as a .xls and not as a .xlsx file.

• The current driver for Excel sheets does not support Asian characters. Installing another driver
can help solving this problem, but Esko does not have an out-of-the-box recommendation at this
time.
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2. Adapt lists.xml according to the information from the Excel file. Save and close the file.

The Excel file and the XML file should be placed in the folder named excel. See the location of the
folder below.

<lists> <list> <name>Esko Brands and
                            Managers</name>
                            <file>ESKO_Records.xls</file>
                            <type>Excel</type> <sheet>Esko</sheet>
                            <column><columnName>Brand</columnName></column>
                            <column><columnName>Category</columnName></column>
                            <column><columnName>ProductManager</columnName></column>
                            <column><columnName>Director</columnName></column>
                            <column><columnName>SeniorVP</columnName></column>
                            </list> <list> <name>Esko Group</name>
                            <file>ESKO_Records.xls</file>
                            <type>Excel</type> <sheet>Esko</sheet>
                            <column><columnName>Group</columnName></column>
                            <column><columnName>Ecosystem</columnName></column>
                            </list> </lists>

See more on installation of this feature in Installing Cascading Dropdowns from Excel Sheet on page
355

Note:  You can define more than one lists using columns from a single Excel sheet.

In the Admin mode, go to Attributes > Attribute Categories and click on any text attribute field.
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Note:

• Make sure you are in Grid Layout.

• Bring a text attribute into one of the cells.

• Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the
restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists Esko Brands and Managers and Esko Group as lists. These are now available for use in your
Projects and Fo.rms

 

 
3. Create attribute categories which contains the product and brand specific information and save it.

a) Create specific attributes. Select the type as text if you want to have Cascading Dropdowns in
the Details. Read more about creating attributes in Create an Attribute on page 305
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b) Create/edit attribute category. Bring these attributes to this category in the Grid layout. In
this example, an attribute category is created with Esko brand related attributes. See the
screenshot below.

c) Select the List  and Column in the Restrict Values Section for each of the attributes that needs
to contain Cascading Dropdowns. List indicates the list names given in the lists.xml file and
Column indicates the column names in the Excel sheets associated with that list.

d) You can have more than one values in the attribute fields by enabling Allow Multiple Values. In
the above example when a product has to be associated with more thane one Ecosystems, you
can enable Allow Multiple Values with more than one Ecosystems.

When you have defined attribute category with lists and columns, you will have Dropdowns available
in each of the fields and it will respect the row combinations of Excel values. Therefore, when you
select one value in a specific attribute field, the related information will be smartly filtered and
automatically filled in if there is only one possible value left for those attribute fields.

The dropdowns interact in such a way that only those values are shown which are linked to the
already chosen values for other columns. This will be a very handy feature when complicated forms
have to be filled in.

In the example here, you can see that when WebCenter is selected, all the associated information is
filled in from the same list. The associated data come from the columns of the list Esko Brands
and Managers.

Note:

If you would like smart filtering and automatic fill in, the columns have to be specified in the same
list in lists.xml.

If you want independent columns with all values irrespective of the selection, define separate lists.
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Note:

You can apply rules to these lists to induce advanced customization. For example. you can set
one attribute (Brand description) to be read-only. As a consequence when you select the attribute
Brand(editable), the brand description (read-only) will be automatically filled in.

 

4. Apply the attribute category with embedded lists containing imported information to any related
project or documents. You can also use these attributes to build Asset Browsers. Read more in Lists
on page 348

Note:  Cascading dropdowns are used in setting up an Asset Browser. Read more in

Troubleshooting

When a column contains lots of numbers, non-numbers are no longer appears in the
dropdown and the numbers are displayed with .0 after them

This is caused by the excel reader (which is a piece of Microsoft code) trying to figure out the data type
in the column. It does not work according to the formatting type and therefore changing the formatting
would not solve the problem. So if half (approximately) of the values are numbers, it interprets them
as numbers and dumps all the rest. We are looking for a solution by enforcing the numbers to be
interpreted as text.  

To work around this problem, you can do add space to each value to make it pure text. The procedure to
do this automatically is detailed below.

1. Make a new column.
2. Copy the header from the original column to this new column.
3. Change the original column name.
4. In the new column, set the value for the first (non-header) row to CONCATENATE(“ “,X2). Here, X is

the new column with the original data.
5. Copy this to all rows (select the cells from the just entered cell all the way down and do a Ctrl-D.
6. Save your file and close it
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The Restrict values choice does not appear in the cell details while selecting a cell in
the Attribute Category layout

You need to make sure that you:

• are in the Grid layout

• choose the right Attribute Type for the selected cell. It should be text (simple, not rich text) type.

• did not choose a Restricted Set.

If all the above settings are correct and you do not have the Restrict Values option, you have to check
the configuration of the lists.xml. If WebCenter fails to find a lists.xml, it assumes that there are no lists
and therefore does not show the Restrict Values option. The most likely cause is that lists.xml is not at
the right location.

It should be placed under WebCenter\WebServer\tomcat\webapps\WebCenter_Inst
\custom|custom.

Check also the access rights to see if the access to read the xml is given.

The problem could arise if your lists.xml is not well-formed (not a valid xml). To check this, open the file
in your browser. If you get a message  "The XML page cannot be displayed", it indicates that your XML is
not valid.  

I get an error message in the Attribute Category layout
You will get an indication about what is going wrong by reading the error message. Most errors look
like:

• Cannot read list Project Code

• error:

• java.sql.SQLException: [Microsoft][ODBC Excel Driver] Cannot open database '(unknown)'.  It may
not be a database that your application recognizes, or the file may be corrupt. xxx\custom\excel
\Products.xls

Check whether:

• the Excel file is open. You can check it by opening it yourself . If it is opened by someone else, Excel
warns you about it.

Note:  You need to close it after you open the Excel file. If you leave it open, it might result in the
error described above.

• Check the location of the Excel file.

• Cross check the name of the Excel file with the one from the error message.
• Check for any typing errors in lists.xml.

I get an error message “List xxx is no longer configured”.
This means that the attribute category points to a list which is no longer configured correctly in XML
filec(lists.xml). In this situation, all dropdowns will be replaced by simple text fields.

The dropdowns do not appear during project creation, document upload or attribute
editing

Open the Attribute category layout as admin and see whether you get an error message. This situation
points to the removal of lists.xml or one of its items.
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After a re-install my Cascading dropdowns no longer appear.
If you are uninstalling WebCenter, the custom folder should be backed up and placed back in the same
location as before to restore the Cascading Dropdown functionality in the new installation. If this folder
or one of the files is missing, you will lose the installed Cascading Dropdowns.

Why Use Database Lists instead of Web Server Lists?

Database Lists Web Server Lists

Higher Security : These are maintained in the
protected WebCenter database.

You need advanced setup through IIS
configuration to prevent security breach.

Reliability : Existing database drivers are reliable. The Excel reading driver is system dependent.
This limits access to one reader at a time.

Scalable The scalability is poor.

Easy Update Dicult to update configurations. When you
update, you have to save your custom Lists folder
separately

Easy administration:You can manage these
via the WebCenter interface. Even non-
administrators can update the master data if the
administrators allow this.

Administration only via the web server.

Faster data loading: The attribute category
loads information bit by bit ensuring a better user
experience.

Excel based lists are loaded entirely when the
form is loaded. This slows down the form data
loading.

Unlimited List Size:We have tested the Lists with
up to 200,000 rows of data.

There is also a limitation to the size of the data
(maximum of 15000 rows in the Excel sheet). The
driver used is limited to 64K rows which would
make a product list with 100,000 products non-
practical.

Support for .xlsx files Only .xls files are supported.

Important:

WebCenter 14 is a 64-bit system using only 64-bit drivers. In order to continue using the web server
based cascading dropdowns, you have to install this 64-bit driver. Read more info on Esko Knowledge
Base.

3.16.5.  Document References

You can make use of Document References to specify product and its components or master-child
relationships. Using this feature, you can create an attribute link to refer to a document that is located
within another project or a document library.

The document reference attribute behaves like a normal attribute which can be added into any
attribute categories. However, you can configure them to provide document sources for your projects.
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For example, when you are re-using your existing marketing statements or claims for individual
packaging projects, you can store them in a library and use document references in your future
projects to link to them.

Both Projects and Documents can have document references. You can also create and use document
reference task specifications.

You can:

• configure the document reference links to access specific projects designed as document libraries,
or to access saved searches or asset browsers.

• store your text statements in a library project. Using document references, you can link to relevant
text statements from each of your individual packaging artwork.

• configure the file types of documents for these links. You can link a 3D file to one or more CAD files
as document references where the reference links are configured to add only .ARD files.

• configure a document reference attribute to point to multiple documents.
• refer to a CAD overlay from the Graphic file for 3D viewing. Read more in https://wiki.esko.com/

pages/viewpage.action?pageId=170043393.

 

 

It is possible to specify attributes specific to the document reference attribute links. For example,
your packaging project for a box can have a document reference link to an artwork PDF. The specific
barcode can be linked to this document reference via a reference category.

Note:  You will see warnings when deleting a document that is referenced elsewhere in WebCenter.

Create a Document Reference Attribute
Creating a document reference attribute is similar to creating an attribute.

1. Click Admin > Attributes > New Attribute.
2. Enter information in the fields as appropriate:
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In the field... Fill in the...

Name name of the document reference attribute

Label text of the label which has to be displayed. To get the translated
text of the label in the other languages chosen, select the blue
icon to open Find or Create Translated labels on page 307

Description description of the attribute contents (for example, link to
the CAD shape document).

Type select document reference as the type.

Document References are attribute-links pointing to different
document sources. When you select this option, you will have
additional options.

Values will be set to Prompted by default.
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In the field... Fill in the...

Versions and Revisions Use this field to point to the exact version of the document you
need as the document reference link. This is especially useful
when you want to point to an approved version. By default, it
points to the latest version, but you can set this to:

• Latest Version: When you select this, the document
reference link will be updated to the latest version of the
document.

Note:  When you update the referred document, the
document link will point to the latest version regardless of
the Change Properties permissions in the Project > Security
tab.

• Selected Version: Use this setting if your document
reference link should point to a certain version always. In this
case, the document reference will not be updated to point
to the latest version when a new version of the reference
document is uploaded.

• Selected Revision: When you choose this, the document
reference will always point to the latest version of the
selected revision.

Note:  When you update the referred document, the link will
source the latest version of the selected revision regardless
of the Change Properties permissions in the Security tab.

Reference Category To apply a reference category to the document reference,
select from the drop down listing all the attribute categories.

Note:  Rich text attributes and document reference attributes
cannot be used as reference attributes.

You can use a reference category (which is an attribute
category) to assign certain attributes to the document
reference link. This is very useful when the property is not
linked to the product or the component specifically. You can
use reference categories to specify properties of the reference
links.

3. Select Attribute is also a task specification if you want to be able to use the attribute as a task
specification.

For more information about task specifications, see Basic Concepts of Task Management on page
842".

4. Click Create.
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Document Versions and Revisions
Use this field to point to the exact version of the document you need as the document reference link.
This is especially useful when you want to point to an approved version. By default, it points to the
latest version, but you can set this to:

• Latest Version: When you select this, the document reference link will be updated to the latest
version of the document.

Note:  When you update the referred document, the document link will point to the latest version
regardless of the Change Properties permissions in the Project > Security tab.

• Selected Version: Use this setting if your document reference link should point to a certain version
always. In this case, the document reference will not be updated to point to the latest version when
a new version of the reference document is uploaded.

• Selected Revision: When you choose this, the document reference will always point to the latest
version of the selected revision.

Note:  When you update the referred document, the link will source the latest version of the
selected revision regardless of the Change Properties permissions in the Security tab.

Note:

When you upload a new version or revision of the reference document, your Preferences > Security
settings will over-write the above settings.

• When the Allow changing attributes of approved documents option is turned off, the document
references (as project attributes or task specifications) will not be updated to point to the latest
versions.

• If the setting Allow changing attributes of inactive projects is turned off, the document references
of such projects will not get updated to the latest revision / version.

Reference Category
You can use a reference category (which is an attribute category) to assign certain attributes to
the document reference link. This is very useful when the property is not linked to the product or the
component specifically. You can use reference categories to specify properties of the reference links.

For example, you can:

• define the position of a text fragment (document reference link) in an artwork.
• size of a barcode on a box. The barcode is the document referenced in the box and the size of the

barcode is an attribute of the document reference link.

Note:  This feature is only available with the Lifecycle Management License.

To apply a reference category to the document reference, select from the drop down listing all the
attribute categories.

Note:  Rich text attributes and document reference attributes cannot be used as reference
attributes.
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Deleting Documents used as Document References
• When you try to delete documents (or document versions) being used as references elsewhere, you

will get a warning message with a list of projects / documents / tasks where it is being used as a
reference.

When you confirm the deletion, the documents / version will be deleted.

Note:  However, you cannot delete documents when the Preferences > Security settings are turned
off:

• When the Allow changing attributes of approved documents option is turned off as a security
setting, the documents / versions referenced as project attributes or task specifications cannot
be deleted.

You will get an error message and a list of  projects / documents / tasks where the document or
version is being used.

• If the setting Allow changing attributes of inactive projects is turned off as a security measure,
the documents / versions referenced in those projects cannot be deleted.

You will get an error message listing the occurrences where the document is being referenced.

Edit a Document Reference Attribute
1. Click Admin > Attributes
2. Click the attribute to edit.
3. Edit the attribute as desired. You can change the Name, Description, Versions and Revisions,

Reference Category and Attribute is also a task specification.
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4. Click Change to make the changes.

Attention:  When you edit the versions and revisions settings, the changes will not be
reflected in the existing document references. The changes are updated for the future uses of
the edited attribute.

Copying Document Reference Attributes from source Project or Template
When a project is created from an existing project or a template, the Document Reference Attributes
that are copied from the template or the source project are copied into the documents in the newly
created project. Documents that are local to the source project or template is local to the newly
created project as well.

When a project is copied or created along with the documents,

• The documents are copied to the new project and the document reference attribute values of the
documents point to the original documents.

• For all document reference project attributes, the referenced document is copied to the new
project and attribute points to the new document, which is local to the new project.

• Remote documents in the template/source project remain remote in the new project with no
change to corresponding document reference.
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Any document reference attributes which are referenced to documents when copied to the target
project while creating a new project from a source project are remapped to the new project as local.
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Documents added to the document references through the Link in the current project document
source, will be also remapped to the document references to the new project created.

Note:  When you copy a project without the documents, all the document references point to the
source project or its referenced project.

Upload a New Version

You can upload a new version to an existing document only once. This restriction helps to ensure
multiple versions of the same documents are not uploaded accidentally.

Delete a Document Reference Attribute
1. Click Admin > Attributes
2. Select the attribute to delete and click Delete Attribute(s) in the actions menu.

If the attribute is not being used, it is deleted immediately.
3. If the document reference is being used elsewhere, you will be asked to confirm the deletion.

Choose from:

• clear the attribute from the Project(s), Document(s), Document Reference Attribute(s) or
Category(s): When you select this option, your document reference attributes and its values are
deleted from the projects / documents / where it is being used. However, the original document
or its attributes are not deleted.

• Cancel deletion.

Document References in an Attribute Category
You can set up the document references with advanced options in the attribute category grid layout
page.

Document reference attributes appear just like the other attributes in this page.

Read Configure a Document Reference Attribute in a Category on page 371.

Document References in One Column

Note:  You need the Life cycle management license to place and edit the document references with its
advanced features. If you do not have this, the list layout is the only available option. In the list layout,
you will have a simple preview:

• multiple values are always supported
• default style
• drop down rendering when multiple values are added (when editable)
• document references are always rendered as a set of hyperlink read-only.

Configure a Document Reference Attribute in a Category
You need to use the Grid Layout for the advanced features associated with the document reference
attributes within the cell of an attribute category.

• To add document reference attributes to a category or remove them from it, use the chevron (<< or
>>) buttons to move them between the two columns.
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You can see a Preview of your attributes under the columns.
• When you add a document reference attribute, you can setup advanced options in the details table:

 

 
• Check Allow Multiple values to allow the reference to multiple documents. This feature is detailed

in Create a Multi-Value Attribute on page 340
• Reference Category is a read only field which refers to properties specific to this document

reference link.
This field is set during the creation of the document reference attribute. You can specify an
attribute category for each document reference attribute to define the properties of the reference /
link. Read more in Reference Category on page 367.

• Version Mode refers to the document version you are referencing to. This field is also set during the
creation of the document reference attribute. Read Document Versions and Revisions on page 367.

• Document Source: You can configure different types of document sources for a customized
document reference link.
a) Click Edit Configuration.

You can configure your document sources in the Edit Document Source Configuration pop-up.
b) Click Add document source to add more document sources for this Document Reference

Attribute.
c) If you have different attribute views, you can setup different source configurations.
Read more in:

• Adding Document Sources for a Document Reference Attribute on page 373.

• Document Sources for Different Attribute Views on page 374.
• Rendering: You can setup a Simple or advanced Table display of the document reference links in a

Project / Template / Forms.

If you select your rendering as: The result will be...

Simple  

 

• The document references will have:

• the document name as a hyperlink. Click
this link to open the document in a new
tab.

• a thumbnail. Click on the thumbnail to
open the document in the Viewer.

• a delete button
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If you select your rendering as: The result will be...
• up/down arrow to re-order the document

list.

Table An advanced table depending on your
configuration. For example, you can configure
editable attributes into your table.

Read more details in: Create an Advanced Table
Rendering on page 376

• Save the attribute category.

A user with attribute update permissions can:

• delete a document from the list of document references.
• add a document. The document sources as configured will be available as a header to the simple /

table rendering.

Note:

1. If allow multiple values is turned off, document source links will appear next to the added
document in the same row.

2. Without the necessary upload rights to the folders of the project, a user cannot add documents
to them.

• change the order of the referenced document.

Adding Document Sources for a Document Reference Attribute

You can configure your document sources (such as a Project/template which serves as a library of
assets, a Saved search of your assets, or your document templates) in the Grid layout. Your configured
sources will appear in the places (such as templates or forms you have designed) where you set the
document reference categories.
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You can configure:

• a simple Browse link for the user to upload a document.

Note:  You can also drag and drop multiple files to the upload button.

• Document Templates from the template library. This will serve as a place holder with pre-
configured settings such as attribute categories. Read more about templates in Document
Templates on page 162.

• Current Project
• Saved Search: Use this option to allow the user to select a file from a saved search. When the user

clicks the document reference as a link (with a custom label), saved search results will appear in a
pop-up with all the configured options.

• Asset Management System: Use this to allow selecting a file from the configured Asset
Management Systems. Read more in Configure Asset Management Connections on page 425

You can specify settings for your users:

• the Label
• the Details such as:

• the document template library

• the name of the saved search
• allowed file extensions
• copy operation

• the type of operation depending on the document source. You can allow the users to:

• copy
• link
• move
• use by reference
• Create Assembly

• Target folder: Every document source must have at least one target location selected.

Add and Replace options as targets are available for all the document sources.

• Add target is used when you are uploading a new document or moving or copying or referencing
an existing document with a Document source and adding it to a Documents table.

• Replace target is used when an existing document is replaced by a new document (uploaded or
already existing) within a Documents table.

.

Options are similar to the Project / Template document creation settings.

Tip:  You can setup different configurations for different attribute views.

Document Sources for Different Attribute Views
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There is always one document source configuration assigned to a document reference attribute
in a category depending upon the view. In the default view, the name of this configuration will be
"AttributeName"_Default.

You can create dedicated document sources for custom attribute views. When you are in a custom
view, click Create Configuration for the Current View to create a custom document source.

You will get an Edit Document Sources Configuration pop-up with a copy of the default setup.

Create a new setup for the current view and click OK. To revert to the default, click Return to Default
View Configuration.

Note:  Return to Default View Configuration will delete the current configuration and restore the
default.

 

 

In other views, the configuration name can be:

• "AttributeName"_Default if the configuration in the current view is inherited from the
default view.

• "AttributeName"_ViewName if the view has its own configuration. If the configuration is
shared with another view, ViewName can be from the other view.

Asset Management Connection as a Document Source for Document Reference

You can select Asset Management System as a Document Source. You can further add specific details
from what has to be fetched from the asset management system by selecting Configure which opens
the Asset Management Configuration window.

Following information has to be specified for the Configuration

• Choose either a Workspace that should be opened or workflow that should be called in the Asset
Management.

• When Workspace is selected: Choose the Name Space and Parameter from the drop down and
value can be keyed in or filled using SmartNames
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• When Workflow is selected: Parameters should be added to the request, and values can be
keyed in or filled using SmartNames

Note:  This setup can be exported for reuse or another setup can be imported from file.

Create an Advanced Table Rendering

Adding an advanced table of document references allows you to customize the way your document will
be shown to users when they are applied (For example, in a template).

It also allows you to configure advanced features such as making an attribute of the document
required or read only.

Note:  The document reference attributes will inherit the style specified in the attribute category.
This style is further expanded to the individual document's attributes as well.

• Click Use Grid Layout in the Edit Category page. Add your document reference attributes.

 

 
• Select the Rendering as Table in the grid layout.

In the Edit Render Configuration dialog, you can set up the advanced rendering.

Note:  You can create custom tables  for your different views.

• Enable Hide Header if you do not want a header row in the document references table. The labels
will be displayed in line for each document.

• Enable Allow Bulk Operations when any action performed on the document reference is also
cascaded to all the references which are made to that particular document reference. Actions
performed on the document reference could be to

• Remove a Referenced document which removes all the document references in the tree
structure

• Replace and Undo
• Getting document to Local and Undo action
• Upload a new version and/or edit a text statement
• Update to the latest version

• Enable Limit Bulk Operations to Document References with matching Operations configured,
when you want to perform bulk operations on document rows which are filtered based on document
sources and actions configured for them. Read more about bulk operations.

User is informed about the number of rows the bulk operation will be really performed (after
filtering) in the specific bulk operation modal dialog.
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• Enable Open Links in new Tab , to open any link in the document reference in a new tab.
• Click Add Column to add more columns to the table.

The rows in the Edit Render Configuration pop-up correspond to your document reference
columns.

 

 
• Select Type as Document Name which is a mandatory field. In the Details section, you can disable:

• Show Document Source
• Show Document Description
• Show Folder
• Show Document Template
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Your rendering will have a hyperlink to the document depending on the user permissions. These
options are additional details added to the document and can be viewed only when a new document
is added.

 

 

The name will not be a hyperlink for users without document view permissions.
• Depending on how your document properties should be rendered, configure the table columns. You

can create custom Labels for your selections. The properties will be displayed as read-only.

Choose Document
PropertyDetails as...

The result in the rendering table will be...

• Description

• VersionRevision

• VersionAuthor

• Project

• ApprovalStatus

• ApprovalStage

• ModifiedDate

• Thumbnail

Tip:

• Create custom labels

• Specify the pixels for
your thumbnail.

• Check the box Allow
uploading a new Version
button

The selected document properties will appear in the table
header with the custom label. For example:

• the current Approval Stage of the document. The user can
click to access the approval pop-up.

• Clickable thumbnail of the document with the default
(50x50) or specified pixels.

• Upload New Version  if you have the rights to upload will
be available in theVersion column.

• You can configure document actions in the table rendering of the document references.

The actions will appear next to the documents listed in the table only when it is relevant.
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Choose Document Actions as... The result in the rendering table will be...

• View

• Open in 3D

• Open in ArtiosCAD

• Download

• Upload New Version

• Update to Latest Version

• A 3D  button will be available only when
there is an existing 3D perspective.

• Open in ArtiosCAD option will be available
for CAD files. Clicking on it will open the CAD
document as set up in the preferences

• Download option will be available when the
user has download permission.

• Upload New Version: This is available when
the user has the rights to upload new version.

Note:  The Upload New Version  button
can also be placed in the Version column by
checking the Allow uploading a new version
check box.

• Update to Latest Version: Allows user to
update to the latest version

Note:

• If you change the attribute values during the upload of a new version, these are only applied on
the new version of the document. The previous version will have the old attribute values.

• If a document version is linked in multiple projects, all linked projects will get the new document
version.

• If the configured columns do not fit in the table, the table will assign each column its minimum
width and show a horizontal scroll bar.

• Configure how your Document attributes should be displayed. Select the relevant attribute from
the drop down as a specific column (with a custom Label) in your table.
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Specify the Visibility of the
attribute as...

The result in the rendering table will be...

• Editable if you want the
users (with the right
permissions) to be able
to edit this attribute.

• Required if you want
to make it mandatory
for users (with the right
permissions) to fill in this
attribute.

• Read Only if you don't
want any user to be able
to edit this attribute.

• The selected document attributes will be displayed in the
table header and its values in the respective columns.
 

 

• The users can type in the values for the editable attributes.
 

 

Note:  You can configure the Visibility also at the attribute
level. If your settings differ, the most restrictive setting will be
applied.

Tip:  Click add column and select another attribute to have more attributes listed in your table.

Tip:

You can configure a project's document reference attributes to be non-editable and still allow the
user to edit the attributes of the documents referenced.

Your user can do this from the project's attribute category tab.

Tip:

Optionally, you can setup the Project > Notifications > Project Attribute/Category change to
receive notifications about document references.

Reference category changes will be notified according to the Project > Notifications > Document
Attribute/Category change settings.

•
Configure Expand Attributes  / Collapse Attributes  button for your document references.
This allows you to expand or collapse the document attributes of your references.

Tip:  You can configure different expand attributes settings for different views. Specify the view
name here.
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Note:

The check box Use Creation View for new Documents is switched on by default. As a result, you will
get the creation view whenever you use Upload/ Browse, Copy or New regardless of the view you
are creating the rendering for. If this option is disabled, you will see the specific view or the default
view.

When you save the view will change to the specified or default view depending on the configuration.

Edit the Visibility as... The result in the rendering table will be...

• read-only

• editable

Note:  The user needs Change
properties right to edit attribute
values.

Click  to expand the document attributes (which
may also be document references):

Tip:  Keep this editable, if your users have to edit
the document reference's attributes.

When the document attributes are expanded, you

can use  to collapse them.

 

 
• Select the relevant reference properties and specify if you want it to be Read-only / Editable /

Required / Hidden.

Reference properties are attributes (reference category )of the document reference link. You can
select one of them from the attribute drop down in the Details cell.

 

 

Note:  Reference Property field is only available when a reference category is specified for the
document reference.
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Specify the Visibility of the
reference category attribute as...

The result in the rendering table will be...

• Editable if you want the users
(with the right permissions) to be
able to edit this attribute.

• Required if you want to make it
mandatory for users (with the
right permissions) to fill in this
attribute.

• Read Only if you do not want
any user to be able to edit this
attribute.

• The reference attributes will be displayed in the
table header and its values in the respective
columns.

• The users can type in the values for the editable
attributes.

Hidden if you want to specify a
Reference Property, but do not want
to show it in the table.

Note:  This option is specific to
Reference Properties.

• No visible reference attributes in the table

• The values (of the reference attributes) are
retained when you duplicate or replace a
document reference.

Note:

Choose Collapse check box when you choose Document Property, Reference Property, Reference
Property Filter, Document Attribute, Project Property, Project Attribute, Master Text, Translation
Text, Text Language Flags fields for Type, to expand or collapse the column while rendering in the
table.

 

 
• You can allow the users to move a referenced document into the current project. To set this up,

create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
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You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.
 

 

The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see  indicating remote project.
• When you are creating a Copy Sheet using Text Document References, you can configure text

related data to the table. Read more in: Create a Table Rendering for Text Documents on page 389
• To configure the rendering with Project related parameters, choose from
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• Project Property
• Project Attribute

Read more details in: Project Properties in Advanced Table Rendering on page 387
• Optionally, add:

a) a Numbering column.
b) Up / Down arrows to let the users change the sequence.
c) Duplicate button which allows the user to duplicate a reference along with its properties. Read

more in: Duplicate a Document Reference on page 385.
d) Replace button which allows the user to replace a document reference. Read more: Replace a

Document Reference on page 386.
e) a Delete Button to let the users delete the document references from the table.
f) Row Selector to let the users select single or multiple documents. Using this, user can select

multiple documents from the document table and perform document actions on them.
• Save the configuration by clicking OK. To revert from this configuration, click Revert to WebCenter

Default Configuration.
• Save the Attribute Category.

If the logged in user does not have permissions to view the document, the document table will have
(based on the configuration):

1. Document name with !. The user will see a warning message.
2. Editable reference properties displayed in the specified columns
3. Up /Down arrows
4. Delete button
5. Numbering (“#”)

Note:  If the settings are not editable, the document table will have the document name and its
sequence number.

Advanced Table Rendering for Custom Views
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Note:

You can create dedicated table (of document references) for custom attribute views. When you are in a
custom view,  click Create Configuration for the Current View to create a custom table.

You will get an Edit Render Configuration pop-up with a copy of the default setup.

 

 

Create a new setup for the current view and click OK. To revert to the default, click Return to
WebCenter Default Configuration.

Note:  Return to WebCenter Default Configuration will delete the current configuration and restore
the default.

In other views, the configuration name can be:

• "AttributeName"_Default if the configuration in the current view is inherited from the default view.

• "AttributeName"_ViewName if the view has its own configuration. If the configuration is shared
with another view, ViewName can be from the other view.

Duplicate a Document Reference
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You can configure a Duplicate option in your document reference table. When the user duplicates a
reference, a new row of document reference will be created. The duplicated document will have the
same content, document attributes and reference category as the previous one.

In the case of Text Document, Content file, then each element status in the file will be reset to draft.

Note:  Only users who are Project managers, Administrators or with Change Properties rights can
replace the document reference.

When you configure a Duplicate button, it will allow the users:

• to duplicate a document row with Copy and New as document sources.

The duplicate documents are created in the current Project where the copied or newly created
documents are stored.

Tip:

• The document will be named as [FileName] [Duplicate] [1], [FileName]
[Duplicate] [2], etc.

• Use the Rename document action to change the document name.

You cannot duplicate a document reference if the document source is:

• Browse / Link / Use by Reference / Remote.

Behavior while duplicating document and its reference properties:

• If Allow multiple values is turned off in the attribute category, the duplicate will replace the original
instead of adding a new document reference.

• The duplicated document will have the same Attribute category including the child document
references. The Reference categories and its settings are copied at parent and child levels.

• The duplicated row inherits the entire hierarchy (if any) of the parent row including the attribute
values.

• It is possible to duplicate a newly created document row.

Replace a Document Reference

You can configure a Replace option in your document reference table. When you replace the old
reference, the new document reference will have the same reference category as the old one.

Note:  Project managers, Administrators or users with Change Properties rights can replace the
document reference.
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When you configure a Replace button, it allow the you to

• replace the document via any of the configured document sources (upload, browse, etc.). If you do
not select any option, the first source is taken as the default.

• Undo the action before saving the new document reference.

This document has its own Attribute Category but will keep the same Reference Category as the old
reference.

You can also select compact rendering option for this button.

Project Properties in Advanced Table Rendering

You can configure the document's Project related details in the document reference rendering.

Project Property
If you select Project Property as the Type, you can specify the following parameters of the document's
host Project in the document rendering.

• Project Property

• Project Name
• Project Due Date
• Project Status. You can choose to:

• Show Label and Icon
• Show Only Label
• Show Color Label
• Show Only Icon

• Project Attribute: Specify the attribute that you want to show from the drop-down.

Bulk Operations on Document references

A single document can be referenced multiple-times from various Projects /Document Attribute
Details, Project Creation Form or Task Execution Page.

To speed up and improve working in such a situation, you can perform the bulk operations on the
documents referenced by a document reference attributes.

When you perform the following actions on a document references,

• Remove a document from a document reference attribute
• Replace a document referenced by a document reference attribute
• Make a document referenced by a document reference attribute local to the current project
• Update the reference of a document to refer to the latest version of the document (available only for

“Selected version/revision” document reference types)
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you can choose to perform only on the selected document or on all the documents it is referenced
to. By all documents it is referenced, means a search is performed in the document reference tree
structure for affected documents including the document references with bulk operations turned off.

Note:  Bulk operations are not performed in

• BOM Documents
• Read-only and hidden document references

You can also enable the option Limit Bulk Operations to Document References with matching
Operations configured in the Edit Render Configuration in Attributes Category page. When the option
is chosen, document rows to be modified by any of supported bulk operations are in addition filtered
based on document sources and actions configured for them. Only document rows where the bulk
operation can be performed directly are filtered and are modified by the bulk operation.

Creating a Copy Sheet

Copy sheet is a term used to describe all the content together which are attached to a particular
artwork or printed item. A copy sheet containing aggregated content helps you to:

• validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.

• review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

• track the content on an artwork.
• easily reuse existing approved content
• configure separate permissions and approval system for each text document.

Tip:

By configuring Document Rendering for Text documents, you can attach copy sheets to Tasks. When
you configure Workflows with manual tasks for editing or approving, the users can work on the copy
sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

• the languages. To view a particular translation corresponding to a master, just select that language
in the filter drop down.

• the Instance Sequence. See more in: Dynamic Content documentation

• the option to replace a text document with another

• the button to duplicate a document with the same reference attributes

• advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.
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Note:

The text document references are used when you import Dynamic Content into WebCenter. Read about
this in: Import Dynamic Text on page 926.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip:  You can configure the copy sheet with different Attribute Views to provide custom views to
your users. For example, a content collator and Translation Language Editors can have different
custom views of the same text document reference category.

Note:  You can also add the languages by clicking on the  displayed in the text statement. On

deletion of a language, the  icon is again displayed to enable adding back the language. You can
configure the corresponding attribute category to display the languages one by one in a table.

 

 

Adding or removing Master or Translation languages from a Project Attribute Category page or
Project Creation page or Document Attributes, or in a Task execution pages behaves differently now.

Adding any of the available languages is possible based on permissions on all text content in the
page including documents that are from other than current project.

Similarly, it is possible to remove the language when it is added recently but not saved

• Even when text content document is referenced from other than the current project
• Even if it is not empty

• Even if you do not have permission to remove languages

Create a Table Rendering for Text Documents

You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option."

1. Create a Table Rendering.
2. In the Edit Rendering Configuration pop-up:
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Configure The result in the rendering table will be...

Master Text or Translation
Text

Master Text Statement or the Translation Text is shown in
a text widget along with its content in the edit field and all
related text content actions.

Note:  The Visibility should be specified as Editable if you
want your users to edit the text. One or more columns can be
configured for the Master or Translations of the Master Text.

Master and Translation languages will either appear in a drop
down or you can choose Show Side by Side view.

You can also restrict the languages that will appear in the
drop down, by mentioning the languages ( pipe separated)
specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

Note:  The master and translation languages are populated
from the project attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.

Tip:

You can specify a default language code for Text statements. The selected language will be the
default in the document reference table. If default language is not specified, the first language from
the language drop down is selected as the default. WebCenter also supports right to left languages
like Arabic and Hebrew for text content.

3. Specify the width for Master Text and Translation Text.By default, the width of every column is set
to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.
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Tip:

To change the width of the columns, specify pixels or a percentage (of the width of the table).
If the label of the column is too big for the width specified, the column width will be bigger to
accommodate this.

 

 

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons
buttons and are active by default.

• Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the
content. Green for approved, red for rejected, blue for pending approval and grey for draft.

• Inheritance Button Shows the inheritance icon when active.

• Comments Button Shows the comments icon button when active.

• Approval Info Button Shows the approval info button when active.

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options “Ellipsis” button will also not be visible.

4. Configure the display of Text Language Flags. You can configure the Display as Show only Flags or
Show Flags and Languages.
These flags will be based on the Project Language Attributes.
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• In the copy sheet view, all the newly created text documents will have the current Project's 
Language attributes as flags. You can read about how to customize flags for languages here.

• All the sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the
available flags.You can add or delete flags in this view.

5. You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
 

 

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.
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The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see  indicating remote project.
6. If you are configuring Local / Remote button to allow copying of documents, ensure that you have

enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval status is retained as it is.

7. Define adequate permissions to view and edit Text Statements.
Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

• Visibility should be specified as Editable.

• If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

• The user should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 504.

Tip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

• Change Properties

• Start/Stop Approval

• Upload new version

• Change Task

• Download

• View

• Add

Note:  The Text widgets, related languages and statuses are rendered only for Text Document
References.
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How to Create a Functioning Document Reference System
You can make use of Document References to specify product and its components or master-child
relationships. Using this feature, you can create an attribute link to refer to a document that is located
within another project or a document library.

This advanced feature allows you to create a system of references (like a "hanger" for your related
assets) to keep a product and its parts together even when they are not located together. For example,
the CAD file, the artwork, the die and its leaflet. For a display, its language variants, parts and artwork
together.
 

 

To create such document reference system, you need:

• Reusable components stored in the form of libraries
• Document Templates
• Version / Revision aware Document Reference Attributes and other Attributes
• Attribute Categories with your document reference attributes and other types of attributes

Follow the steps below to create an advanced document reference system.

1. Create WebCenter Projects as Libraries and organize your assets in them.
Examples for your libraries

• Structural design files for your packaging shapes
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• Graphical design files from the creative agency

• Standard design elements such as your brand logo, company logo etc.
• Symbols such as recycle symbols, warning symbols, Quality Symbols etc.

 

 

• Text Content Documents
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• Barcodes

To organize further, you can create advanced saved searches or SmartName searches.
2. Create your Attributes and Attribute Categories for the specification / packaging request.

For example, Production quantities, count, budget, material type, ink coverage, color, language
variants, Barcode etc. Read:

• Create a Document Reference Attribute on page 364

• Reference Category on page 367
3. Create Document Templates with Attributes.

Your Project Managers can use Document Templates on page 162 as document placeholders for
future project documents.

 

 

Note:  Link to the document templates in document creation settings of the Project Template.

4. Create your document reference attributes and enable advanced features in grid layout.
a) Select document reference as the attribute type. reference category attribute (such as count)

of the link. Read: Create a Document Reference Attribute on page 364.

Examples:

• Specify the version / revision of the document it should refer to.

• Specify a reference category if you have properties that are specific to a document
reference link. For example, count.

b) Add the document reference attribute to an attribute category.

• You can make the attribute read-only / editable / required by setting the visibility.

• You can create a document reference where the user can add multiple documents by
enabling allow multiple values.

• You can use all the advanced features available in the grid layout.
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c) Configure the document sources for the references. Choose the operation (copy, link, move, or

use by reference). Read more in: Adding Document Sources for a Document Reference Attribute
on page 373
The document references will be shown as links in the final rendering as per the document
sources settings you configure here.
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• Create a custom label such as Select CAD from Library.

• Specify the source of the document. For example, a saved search.
 

 

• Specify the type of operation you would like your user to do. You can configure copy, link,
move or use by reference.

d) Configure how the documents should be listed and whether the users can modify some of the
document properties. To do this, create an advanced table rendering.

5. Create Project Templates and apply the document reference attributes and other attributes in an
attribute category.
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• 1. CAD documents are rendered in a Table configuration. The header contains custom labeled
document sources. You have editable reference properties such as offsets configured in the
table.

• 2. The customized add ink link will take you to the inks library to choose your inks for the
current project.

• 3. The configured Add icons link will take you to a saved search. This document reference
attribute is rendered as Simple. Therefore, the references appear as a list.

You can have documents stored in the local folder or referred in document reference links.
However, the user gets the view of both the local and referenced documents together.

Referenced Property Filter
Reference Property Filter (RPF) is a restricted view of the reference property attribute category. It
filters the attributes that are both part of the Reference property Attribute Category and the Project
Attribute Category. For example,
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Multiple products or artworks can reuse the same content like text, recipes, images and so on. To
specify the context of using the content as reference, you have to filter the context, in which the
content sheet can be used in the artwork. To know more about Product Content Sheet, read Product
Content Sheet on page 1035.

Configuring Reference Property Filter

Reference Property Filter is available only, when a reference property attribute category is defined
for the Document Reference Attribute. It will show the attributes in the reference property attribute
category which are also present in the Project Attribute Category of the document or in a Document
Attribute Category and have values.
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This configuration is used to display the column of the reference
properties which defines the reference property filter of the document

reference.

Note:

It is important add the values as attributes in the Project or Document to render the same in the
Reference Property Filter.

In the above image Scope Flavor and Scope Outputs are the Reference property Filters and the values
Chocolate, Apple+ Lime Twist or multipack are the attributes defined in the attribute category of the
project.

Reference property is allowed to have the values only from the project attribute category.

Viewing Reference Property Filter
Reference Property Filter can be viewed in the Attributes tab of a Project or Document.
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In the render configuration for the header row, the details and the label are not applicable and the width
is always set to auto. You can collapse or expand the columns to view.

Copy Document References
You can create new projects from the template projects with an option to copy all the document
references along with them. You have both the option to copy only the local references or copy all the
references in multiple levels.

You can use this also in Task Specifications, "Documents" section of Project Creation page and Task
Execution page.

While copying, along with the documents all the attributes including their values are also copied.

To enable copying of the Document Reference Attributes, the Document sources in the Attribute
Category of the document has to be configured.
 

 

Only the following document sources can be configured for Copy Action:

• Document Template (New)

• Saved Search

• Copy from Project
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There are three options to copy that you can configure namely:

• Basic Copy – Only the selected document is copied to the destination project. Document references
of the newly created (copied) documents are set to reference the same documents as the original/
source document(s).

• Copy with Local References– Selected document and all documents referenced by it that are from
the same source project are copied to the destination project.

•Copy with All References Selected document with all document it references are copied to the
destination project, irrespective of the project it is located.

Note:  Copy Actions are not supported in BOM documents tables/sections and also when copying a
document from Documents page in Project Details.

3.17.  Create Assembly documents using Document
References

Assembly document is a component document that consists of a bunch of document references
namely a structured document (a 3D model of a product with defined printable parts as attribute values
to that document) and graphical references to the artworks required, that can be viewed and edited
in the WebCenter Viewer.This is one of the critical and most important step in the process of creating
and viewing pack shots in WebCenter.

Follow the steps below to Create Assembly:

1. Create a Saved Search for collada files( structured documents). Collada files should contain the
printable parts referenced ( added to it).

2. Create an attribute category representing the assembly called DEFAULT ASSEMBLY CATEGORY.
3. DEFAULT ASSEMBLY CATEGORY should have two Document reference attributes namely

a. CAD_REFERENCE attribute that can contain only one document.
b. GRAPHICS_REFERENCE should have a reference Category, e.g CAD_REFERENCE_PROPERTIES,

that contains the following attributes. These attributes should also be added in the rendering
configuration.

a. CAD_PRINTABLE_PART
b. CAD_PRINTABLE_PART_SIDE
c. CAD_PRINTABLE_PART_NAME
d. CAD_FINISHING_PROFILE

GRAPHICS_REFERENCE should be configured to accept more than one document as it can
contain references to the multiple labels ( like front, back, top) required for the structured
document.

Using the specified Attributes and Attribute Categories, users with Add and Change Properties
permissions can create an assembly file from a structural file. Upon selecting the Structure
document, an Assembly document is created, containing the selected Structure Document in the
CAD_REFERENCE attribute, and placeholders for graphics documents in the GRAPHICS_REFERENCE
attribute, based on the printable parts of the Structure document. Before submitting the form, you are
already able to replace these placeholders with the actual artwork.
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Default Assembly Category has a Saved Search configured as a Document source with Create
Assembly as an operation.

Create Assembly document operation can be used in all places, where Saved Search is used as
a document source within a Documents table. You can set a different default target folder for
Placeholder documents and Graphic documents when you are configuring the document source of the
(document reference) attribute.
 

 

3.18.  CAD Options

Use the CAD menu to set options related to working with ArtiosCAD.

WebCenter allows you to:

• create a CAD document from a standard directly WebCenter

• view the CAD documents with folding angles in 3D

• view CAD documents in the Viewer
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• search for CAD documents

3.18.1.  CAD Download Format

Synchronize with Defaults
WebCenter administrators can download ArtiosCAD files in different formats as specified in Defaults
of the ArtiosCAD instance running on the Application Server.

On the CAD > CAD Download Formats page, you can enable or disable download formats for all users.

Click the Synchronize button to import the settings from ArtiosCAD Defaults. A successful status
message should appear after a few moments, and the list of formats is populated. Select the formats
you want to make available for the users.

Note:  The three native ArtiosCAD formats (ARD, MFG and ACD) do not require any configuration.

Download formats and users
User and group permissions for the download formats are set in Users > select user > Download and
Groups > select group > Download, respectively. You must set permissions on the formats before
users can download documents.

Note:  Members of the Admins group are granted all download format permissions by default, and the
Change and Use Group Permissions buttons are unavailable when attempting to change permissions
for those users.

Non-cached ArtiosCAD Download formats
The WebCenter configuration has been extended with an option to not cache specific download
formats to support dynamic ArtiosCAD download formats.

Currently, the CAD Download Formats for a given document version are by default generated and
cached in the system when first downloaded by a user. Subsequent users downloading the same
download format get the same cached file. The caching behavior is controlled for every CAD document
type and download format.

Examples of dynamic download formats where turning caching off could be needed are Bill of Materials
reports and reports that are based on meta-data that can be edited directly in WebCenter.

To turn off the caching for a given document type and download format:

1. Go to Admin > CAD > CAD Download Formats.
2. Go to the respective document type and download format and unselect the respective check box.
3. Save the changes to disable the caching and delete any cached data for the selected download type

and document format system wide.

There is no Cache option for the ArtiosCAD format (native document) as this format is always available.

3.18.2.  Boards

The CAD > Boards page shows the types of boards that can be used for CAD designs (paper, corrugated
board, folding carton...).
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These boards are defined in ArtiosCAD. They cannot be edited, created or deleted from WebCenter.
However, you can set the boards' default location(s) and use them in a Restricted Set.

Assigning a Board to a Company or Location
You can assign a specific board to a Company, or a Location of that company.

1. In the CAD > Boards page, browse the Boards tree to find the board you are interested in.
2. Click that board to show the Edit Default Locations for board ... page.

Note:  You can only assign boards to companies/locations, not boards folders.

3. On that page, select the companies/locations to associate with this board, and click Finish.

Tip:  If you want to assign this board to all companies/locations, select the checkbox next to
Company at the top.

The users in these companies/locations will see the board as default.

Creating a Boards Restricted Set
You can create a Restricted Set of boards, so that users can pick from a short list of relevant boards
when creating a design.

To do this, click Create Boards in Restricted Set, then add boards to the Restricted Set as explained in
Create a Restricted Set on page 303.

Note:  The data Type is always Text in a boards Restricted Set.

3.18.3.  Run a CAD Standard from WebCenter

A CAD standard is a default ArtiosCAD document, to be customized with parameters supplied by
the user to make a design. This will be a 2D design, that can be made 3D if the standard has fold
information.

In WebCenter, an ARD document template is used as the CAD standard, and attributes are used as the
parameters needed to make the design.

In practice, you create a new document from the ARD document template, filling in the template's
attributes' values to give your parameters.

CAD Standard Configuration
You need to:

1. Set up an attribute category containing the attributes necessary to create the design, and their
default values.

2. Set up a document template with this attribute category.
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Create an Attribute Category
You will need to create attributes that match the CAD standard's parameters in ArtiosCAD. They must
have the same name as the corresponding parameters, and any parameter required in ArtiosCAD must
translate into a Required attribute in WebCenter.

Generally, you will use at least BOARD (this is always Required), and mostly L (length), W (width) and D
(depth).

BOARD parameter: Creating different board attributes will allow the usage of different board restricted
sets. Attributes will be selected by WebCenter, if the name of the attribute starts with “BOARD”.

Other parameters are less standardized. You need the person who built the standard to clearly indicate
which parameters are needed.

Here is an overview table of the attributes you will probably need the most:

Attribute Use case Values

BOARD The type of board to use for the
design.

Used for every CAD standard (this is a
Required attribute).

A Restricted Set of Text type.

Set your desired values in the
Restricted Set.

L, W and D Length, Width and Depth.

Used for most CAD standards.

Prompted values (the user
can set what he/she wants) of
Distance(in,mm), Distance(in,m) or
Float type.

ISSTANDARD To indicate if an ARD document
template should be used to run CAD
standards or not.

• ARD document templates to be
used for CAD standards should
have YES as ISSTANDARD value.

• ARD document templates NOT to
be used for CAD standards should
have NO as ISSTANDARD value.

This should be a Hidden attribute.

A Restricted Set of Text type.

The values in the Restricted Set must
be YES and NO.

UNITS To set units other than the user's
default units.

If no unit is set, the standard will be
run in the units set in My WebCenter >
My Preferences by the user.

A Restricted Set of Text type.

The values in the Restricted Set must
be mm and in.

Note:  Value of the Units attribute is
not considered when using distance
attributes for L,W and D.

ISCORRUGATED To indicate whether the resulting
design should be corrugated.

A Restricted Set of Text type.

407



3 WebCenter

Attribute Use case Values

If this attribute is not present, the
design is understood NOT to be
corrugated.

The values in the Restricted Set must
be true and false.

GRAIN To indicate the direction of the flute/
grain of the design being created by
running the standard.

A Restricted Set of Text type. The
supported values for this attribute are
Horizontal, Vertical and Standard.

If the value chosen is Standard, then
the created design will have the same
flute/grain direction as the Standard
that is being used.

If no value is mentioned, then vertical
is taken as default.

SIDE To indicate the print side of the
design that is created by running the
standard.

A Restricted Set of Text type. The
supported values for this attribute
are Inside, Outside and Standard. If
the value chosen is Standard, then
the design created will have the same
print side as the standard that is being
used.

If no value is mentioned, then the print
side will be Outside.

1. Create the Restricted Sets needed by your attributes as listed in the table above.
See Create a Restricted Set on page 303 for details.

2. Create your attributes (the ones listed in the table above as applicable, and any other attribute you
may need to run your particular CAD standards).
Assign the relevant Restricted Sets to your attributes. See Create an Attribute on page 305 for
details.

3. Create an attribute category containing all the attributes you have just created.
4. Add a Creation View to your attribute category and click Use Grid Layout.

a) Make the BOARD attribute Required.
b) If you are using the ISSTANDARD attribute, make it Hidden.
c) Change the Visibility of your other attributes as desired.

Tip:  You can add use a Label to change how your attributes appear to the user (for example, you
can show the L attribute as Length).

Note:

If you want to work with several CAD standards, you can either reuse this attribute category for more
designs, or create more attribute categories.

Create an ARD Document Template
You now need to set up an ARD document template using the attribute category you just created.
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For this, you need to use an ARD document corresponding to the CAD standard in ArtiosCAD (same
default design).

1. Set up your Document Library as explained in Create Document Templates on page 162.
2. Upload your ARD file into the Document Library.
3. Link the attribute category you just created to this ARD file.
4. Point to the Document Library in:

• existing projects in which you want to create a design from a CAD standard,
• project templates that will be used to create projects with designs from CAD standards.

See Create Document Templates on page 162 for details.

Run a Standard in an Existing Project
To create a design from a CAD standard in an existing project:

1. If your project isn't already linked to the Document Library:
a) In the Project Details page, click Configure then Document Templates.
b) Select Template, then select your document library in the list.

 

 
c) Under When the document library contains ARD files..., select either:

Note:  Run a Standard option for CAD documents is available with WebCenter Life cycle
Management license.

• Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard

• Run the ARD as a standard when the IsStandard attribute is set to 1 if you only want to use
some ARD document templates to run CAD standards.

These ARD document templates must have the ISSTANDARD attribute assigned, with the
default value set to YES (see Create an Attribute Category on page 407).
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d) Click Save.
2. Create a design from your ARD document template:

a) Click the Upload button.
b) Select New in the Source list and select your ARD document template.
c) Fill in the Attributes as desired.

For example, specify the BOARD to use, and the L (length), W (width) and D (depth) of the design.
d) Click Upload.

Note:  This is only possible through the normal WebCenter upload (see Uploading a Document
via Upload on page 591 and Copy / Create Multiple Documents on page 595), not the Java
applet upload or when uploading documents from other applications like Automation Engine and
ArtiosCAD.

Your design is created. You can click its thumbnail to view it in the Viewer.

Run a Standard at Project Creation
To create a design from a CAD standard when creating a project from a project template:

1. If your project template isn't already linked to the Document Library:
a) In the Project Details page, click Configure then Document Templates.
b) Select Template, then select your document library in the list.
c) Under When the document library contains ARD files..., select either:

Note:  Run a Standard option for CAD documents is available with WebCenter Life cycle
Management license.

• Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard

• Run the ARD as a standard when the IsStandard attribute is set to 1 if you only want to use
some ARD document templates to run CAD standards.

These ARD document templates must have the ISSTANDARD attribute assigned, with the
default value set to YES (see Create an Attribute Category on page 407).

d) Click Save.
2. When creating a project from your project template:

a) Click New in the Documents section of the Create Project page.
b) Select your ARD document template from the pop-up and click OK.
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Tip:

If you have many ARD document templates, use the Filter field to filter them alphabetically on
the file name.

You can also filter them based on document characteristics if you have created a custom
project creation page to do so (see Create a Project and Run a CAD Standard on page 1073 in the
Customization Guide).

c) Fill in the attributes to use in the Documents section.
For example, specify the BOARD to use, and the L (length), W (width) and D (depth) of the design.

d) Fill in the rest of the project settings as desired and click Create Project.

Your project containing your design is created.

3.18.4.  Canvas related Attribute Categories

A document reference attribute and two attribute categories are created by default in WebCenter
during the installation or upgrade.

These will create a document reference system to contain different Canvas parts saved to WebCenter:

• The default document reference attribute named as CANVAS PARTS.

• This default empty CANVAS REFERENCE CATEGORY. This category will contain the reference
attributes associated with the CANVAS PARTS attribute.

• The default DEFAULT CANVAS CATEGORY will contain the the CANVAS PARTS. This allows the
ArtiosCAD Enterprise client to save managed parts as individual document reference values.

Note:

During an update, these attributes will get created if they do not exist yet.
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3.19.  WebCenter Configuration

The Configuration menu contains entries for configuring e-mail notifications, LDAP authentication,
push-through folders, BackStage / Automation Engine Approval clients, the System Info page, etc.

3.19.1.  Configure E-Mail

You can set up e-mail configuration using the Admin module. All changes to the setup are effective
immediately.

1. Click Admin > Configuration > E-Mail Environment Setup.
 

 
2. Provide the required e-mail settings:

Configuration Option Description

E-Mail Service Protocol Set to the SMTP protocol.

E-Mail functionality
enabled

To enable/disable e-mail functionality.

E-Mail debugging output
in log

To enable/disable e-mail debugging output in log files.

E-Mail Service Host Address for the preferred mail server that will act as the server for
dispatching e-mail notifications.

E-Mail Service Port
Number

Port number on which the e-mail server is listening for incoming e-
mails.

Outgoing E-Mail
Notifications "FROM"
Address

Supply a valid e-mail address. This will be used as the "From" e-
mail header for every e-mail sent by the system. This information
is important for returning undelivered mail (the filled-in address
should belong to the administrator, since he will most likely be
addressed with undelivered mail for troubleshooting).
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Configuration Option Description

E-Mail Session
Authentication

Select this option if the mail server connection session should be
authenticated using a username and password.

E-Mail Service Username Mail account user name when authentication is required.

E-Mail Service Password Mail account password when authentication is required. The
password is stored in encrypted format.

3. Click Send Testing E-Mail.
4. Edit the contents of the test e-mail if required.
5. Click Send E-Mail.

A response will appear stating whether or not the e-mail could be sent successfully. There are 3
possible outcomes of the e-mail environment testing page:

• Test E-Mail Sent: The environment is set up correctly.

• JMS System Error: Communication with the JBoss proprietary messaging framework failed. An
administrator should check the JBoss server configuration and/or log files for possible causes.

• Mail Server Connection Error: The connection to the specified mail server did not succeed.
Either the data the administrator supplied on the e-mail environment setup page was
incorrect, or the mail server is currently down. An administrator should either check the e-mail
environment settings for possible misspellings or contact the mail provider as to the status of
the mail server.

6. If necessary, return to the configuration page and correct the settings.

Note:  System History Logs All changes/events in this page are recorded and stored in the System
History page for Administrator users. Read this page on how to access the records.

3.19.2.  Configure Search Crawler Setup

You can change the Search Crawler Setup from Admin > Configuration > Search Crawler Setup. All
the below mentioned actions can only be performed by the Admin users.

1. Enable Rebuild Index on Restart option to allow or disallow rebuilding the index upon search
crawler restart (default is enabled).

2. Enable Index Document Revisions to index all the Document Revisions. If this is not enabled, only
the Latest Version for every Document is indexed. If this option is enabled, users can search for the
revisions on the Document Search page.

3. To skip the indexing of Workflow Tasks, you can disable Index Workflow Tasks. Changing this
option will trigger re-indexing. When this option is disabled, you cannot search for workflows in the
Task Search.

4. Enable Index Any level Document Reference  to search the entire Document referenced within
WebCenter and return in the search result when the document search is executed.

5. Enable Index all currently referenced Document Versions to add the earlier versions of the
referenced document to the search index. The index will be rebuilt once this option has been
changed in the setup.
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6. Enable Index all currently referenced Document Versions to add the earlier versions of the
referenced document to the search index. The index will be rebuilt once this option has been
changed in the setup.

Status

Last crawl activity shows the date and time of the last search crawl activity and Crawl Tasks
Waiting shows the pending crawl tasks.

Note:  System History Logs All changes/events in this page are recorded and stored in the System
History page for Administrator users. Read this page on how to access the records.

Index Live Text in Documents

Search Crawler Setup in the configuration menu has an option choose whether to Index Live Text in
Documents or not. This allows enabling or disabling of Document Content indexing which is disabled
by default.

Changing the state of the option, results in a full re-indexing of the document content. In such a case,
Documents are not re-indexed but only the document content is re-indexed which means Document
Search will find all results while the document content indexing is ongoing.

Note:  When the option is turned off, the search index with document content is cleared to save space.

3.19.3.  Configure External Web Connections

An external web connection is a connection to some data in an external system (usually a MIS
system). The MIS system calculates the data (for example the cost/price information for an order) and
WebCenter retrieves this data through the external web connection and displays it on a WebCenter
page.

After configuring the external web connection, you can choose to add a link to it in a WebCenter top-
level menu, project menu or a My Work section. See the Customization Guide for more details.

System History Logs
All External Web Connection events like

• External Web Connection Created
• External Web Connection Deleted and
• External Web Connections Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 439

Create an External Web Connection
1. Go to Admin > Configuration > External Web Connections.
2. Click the New External Web Connection link in the External Web Connections page.
3. Enter the Name to give your external web connection.
4. Enter the URL of the data you want to retrieve in your external system. This needs to be accessible

by either the WebCenter Application Server or Web Server.
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You can use SmartNames in the URL. The supported SmartNames are:

• all basic project properties (see List of Available SmartNames on page 454),

• all project attributes,

• Requestor SmartNames ([Requestor UserName], [Requestor Location], etc…). Here,
Requestor indicates the user who is logged in.

These SmartNames will be resolved when activating the connection, depending on the context.
This means that for example:

• if you are using the [Requestor UserName] SmartName, it will be resolved to the name
of the user currently logged in to WebCenter (the one clicking the link to the external web
connection).

• if you are using the [Project Name] SmartName, it will be resolved to the name of the
current project.

So if you are using an order ID as project name and you want to connect to an external system
containing information about that order ID, whose URL is http://ExternalSystem/
OrderInformation.jsp, then you can use http://ExternalSystem/
OrderInformation.jsp?orderID=[Project Name] as URL here.

This will be resolved to for example: http://ExternalSystem/OrderInformation.jsp?
orderID=Order_83289.

Note:  When using SmartNames, you should take into account where the connection will be used
from (where in WebCenter it will be integrated).

• You can use user-related SmartNames (such as [Requestor UserName]) if the connection is
to be added to a top-level menu or a My Work section.

• You can use user-related and project-related SmartNames (such as [Project Name]) if the
connection is to be added to a project menu.

See the Customization Guide for information about integrating a link to an external web connection
into the WebCenter user interface.

5. In Type, select if your external system outputs HTML or XML.

Note:  If your external system outputs XML, you will need an XSL (eXtensible Stylesheet Language)
file to transform this to HTML and display it in WebCenter. Your WebCenter installation comes with
an example XSL file, that you can customize.

See the Customization Guide for more details.

6. Click the Test button to test the connection to your external system.
You should see a green check mark if the connection is successful.
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Note:  The test button will only check whether or not the main URL is reachable. It will not take into
account any SmartName used to pass on parameters, as SmartNames have to be resolved from a
specific context in WebCenter.

In the example above, the test will try to connect to http://ExternalSystem/
OrderInformation.jsp, and not to http://ExternalSystem/
OrderInformation.jsp?orderID=[Project Name].

Edit an External Web Connection
• To edit an external web connection, click its name in the External Web Connections page.

Attention:  If you change the name of a connection here, you will also need to change it in
the customization files used to integrate a link to this connection into the WebCenter user
interface!

See the Customization Guide for more details.

Make Direct External Web Calls
You can directly call to a service instead of adding the External web calls to the menu or Homepage
Sections. This can be done with the call:

GetExternalWebInfo.jsp

The call takes the same parameters as the previously mentioned calls. For example, this call can be
used in a javascript button in the Attribute Category (using CustomFormExtensions).

Example: A SOAP call made out of JavaScript .This function could be added in
CustomFormExtensions.js

soap: function(att) { 
 var extWebConn = ”SOAPService”; // name of connection
 
 var attr1 = att[‘attr1’];
 var attr2 = att[‘attr2’];
 var attr3 = att[‘attr3’];
 
 var body = "<?xml version=\"1.0\" encoding=\"utf-8\" standalone=\"no\"?>"
 + "<soap:Envelope schema_params> 
  + "  <soap:Body>" 
  + "    <Operation xmlns=\"http://tempuri.org/\">" 
  + "      <Request>"
  + "     <data>" 
  + "     <attr1>"+ attr1+"</ attr1>" 
  + "     <attr2>"+ attr2+"</ attr2>" 
  + "     <attr3>"+ attr3+"</ attr3>" 
  + "     </data>" 
  + "      </Request>" 
  + "    </ Operation >"
  + "  </soap:Body>" 
  + "</soap:Envelope>";
 
var formData = new FormData();
 formData.append("externalwebconfigname", extWebConn);
 formData.append("requestbody", body);
 formData.append("requestmethod", "POST");
 formData.append("requestheader", 
"Content-type:text/xml; charset=utf-8");
 formData.append("requestheader", 
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"SOAPAction:http://tempuri.org/CalculateNewQuote");
 formData.append("responsetype", "application/xml");
 formData.append("callfromwebserver", "1");

 $.ajax({
  url: "GetExternalWebInfo.jsp",
  dataType : "xml",
  type: 'POST',
  enctype: 'multipart/form-data',
  cache: false,
  processData: false,
  contentType: false,
  data: formData,
  async: false
 })
 .done(_.bind(function(data){
  // Read and handle data
 }, this))
 .fail(_.bind(function(err, status, errStr){
    alert("Request failed: " + errStr);
 }, this));
}

Add Parameters to a direct call dynamically
Parameters cannot be always resolved by SmartNames. For example, when we make a calculation with
attributes and need to pass this as a parameter.

To resolve this use the parameter requestparams. The content of this parameter will be
appended to the URL called by the server. The content of the parameter should have the format
param1=value1&param2=value2&…

Note that URL encoding should be used when appending to the external web connection URL.

If ExternalWebConfig has URL https://www.google.com/, then 
GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig
&requestparams=q%3Dtest  (URL encoded “q=test”)
 will resolve to https://www.google.com/?q=test

Change Request Method
It is possible to call a service both with the GET or with the POST method. The default method will be
GET.

To choose the request method, add a parameter requestmethod which can have a value GET or POST.
For example

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&method=POST

The parameter is available for GetExternalWebInfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp

Change Response Type
It is possible to have another result than HTML. To do that, you will have to pass which response type
you want. This can be done by adding a parameter reponsetype. The response type has to be a valid
MIME type. For example,

GetExternalWebInfo.jsp?
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ExternalWebConfigName=ExternalWebConfig3
&responsetype=application/json

The parameter is available for GetExternalWebInfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

Add Request Headers
It might be required to add request headers to some calls. It is possible to pass these headers along.
This can be done by adding one or multiple instances of the parameter requestheader.

These have to be in the following format: <request_name>:<request_value

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&requestheader=Cache-Control:No-Cache
&requestheader=Pragma:No-Cache
&requestheader=Expires:0

The parameter is available for GetExternalWebInfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

Add Request Body
For some calls, it might be required to add a request body to the call. It is possible to pass this body
along.

This can be done by adding the parameter requestbody, with the needed request body as value.

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&requestbody= <soap:Envelope …>…</soap:Envelope>

The parameter is available for GetExternalWebInfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

Delete an External Web Connection
• To delete one or more external web connections, select it/them on the External Web Connections

page and select Delete External Web Connection(s) in the action menu.

Attention:  Deleting a connection that is in use will break the pages that use that
connection. The system will show an error message on these pages.

3.19.4.  Configure Workflow Connections

With a workflow connection, creating a project in WebCenter can automatically create a linked job in
Automation Engine or any JDF-enabled workflow.

This way, the project files can automatically be copied into the workflow job (if desired), and the job
parameters can be defined from WebCenter, based on project information and attributes.

This means that:

• WebCenter can act as the single interface for your customers, CSR and sales,
• all the data collected through WebCenter is available for workflow automation.
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You can also define when the project will synchronize with the workflow job automatically, and if the
WebCenter Project Manager can synchronize them manually.

You can also use a workflow connection to save documents (only approved documents or all
documents) and the XML metadata about the documents and project to a network folder. This allows
you to archive your documents and metadata externally.

To Configure a Workflow Connection
1. Create a connection.
2. Add that connection in a project template.
3. Define when the workflow jobs created will be automatically synchronized to the linked WebCenter

projects.

Workflow Connections
Use Workflow Connections to synchronise your WebCenter Projects/Documents information with
Automation Engine and other third party workflow systems. You can send a JDF file containing
information about WebCenter project/document to Automation Engine or other systems. In
Automation Engine, this will result in an updated Job or a new Job.

In addition, you can use Workflow Connections to submit external workflows. For example, using this
connection, the Submit Workflow node can execute external workflows on your workflow systems.

You can also use Push Through Folders to integrate with such systems. However, these folders copy
the WebCenter documents to the specified destination.

When syncing with Automation Engine Jobs, the Workflow Connections map:

• Project / Document attributes to Automation Engine Job Setup parameters including the customer
details.

• Documents to Automation Engine job documents.

System History Logs

All Workflow Connections related events like

• Workflow Connections created

• Workflow Connections deleted and

• Workflow Connections changed

are recorded and stored in System History. Read this page on how to access the records.

JDF Service

Use JDF Service connection to export your projects as JDF files and automatically create jobs in your
Automation Engine. In this case, projects and documents will be communicated to Automation Engine
using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.

ZIP Folder

Enter the address of the network folder to use for archiving your documents and metadata. This must
be in an accessible network share, in UNC format.

419



3 WebCenter

Note:  The ZIP file generated will contain:

• [documentversion_id].[extension]: the archived document,

• [documentversion_id].[extension].xml: the XML file containing the metadata of the
archived document,

where [documentversion_id] is a unique number corresponding to that version of the document
and [extension] is the file extension of the original document.

JMF Service

A JMF Service is a service to which the JDF tickets can be posted encapsulated in JMF messages.

Setting up a JMF Service:

JDF Hot Folder

When your WebCenter drops a JDF file into the Hot Folder that is shared between WebCenter and
Automation Engine, the Automation engine processes it. When processing is finished, it writes the
result into the output folder associated with the JDF Hot Folder.

Note:  This must be in an accessible network share, in UNC format (for example\\MyWorkflowServer
\MyJobContainer\HotFolder).

Attention:  The JDF hotfolder does not support the execution of external workflows. The
Submit Workflow node in WebCenter workflows will fail when a Hot Folder is chosen for the
connection.

Create a Workflow Connection
• Click Admin > Configuration > Workflow Connections.

The Workflow Connections page appears, listing the workflow connections already created (if any).
• Click New Workflow Connection.
• Enter a Configuration Name.
• Select your Connection type. Here you can choose JDF Service / Zip Folder or both:

420



3WebCenter

Options Description

To export your projects as JDF files (and
automatically create jobs in your workflow
system from your projects)...

Use JDF Service connection to export your
projects as JDF files and automatically create
jobs in your Automation Engine. In this case,
projects and documents will be communicated
to Automation Engine using JDF tickets. Also,
you can execute a workflow in Automation
Engine using this setup. Read more.

To automatically archive your documents and
metadata (as a ZIP file) in a network folder...

Enter the address of the network folder to use
for archiving your documents and metadata.
This must be in an accessible network share, in
UNC format.

Note:  The ZIP file generated will contain:

• [documentversion_id].
[extension]: the archived document,

• [documentversion_id].
[extension].xml: the XML file
containing the metadata of the archived
document,

where [documentversion_id] is a unique
number corresponding to that version of
the document and [extension] is the file
extension of the original document.

• JDF Service:

Use JDF Service connection to export your projects as JDF files and automatically create jobs in
your Automation Engine. In this case, projects and documents will be communicated to Automation
Engine using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.

a)

If your JDF Service is... Follow this procedure...

JMF Service

Note:  You need JMF Service to connect to
Automation Engine if it is not in the same LAN
or not publicly available.

 

 

You can setup a JMF connection following the
steps below:
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If your JDF Service is... Follow this procedure...
1. Select whether your Automation Engine is:

• in the same LAN or publicly available.
• connected through the Approval

and Tunnel Client. Read in Configure
Workflow Approval and Tunnel Clients on
page 432

2. If your Automation Engine connection is:

• in the same LAN / public, specify
either the host address (e.g.:
192.168.1.1.1) or the host name
(aeserver.brand.com).

• via an Approval and Tunnel Client, select
the client from the drop-down.

3. Click Generate URL. The URL field above will
be filled in automatically.

Warning:  A Workflow Connection
connected through an Approval and
Tunnel Client will block one concurrent
license.

JDF HotFolder Select this option if your JDF tickets should be
placed in a shared Hot folder.

1. In the UNC field that appears, enter the
address of your workflow's JDF hot folders
(in which to place the JDF file).

This must be in an accessible network
share, in UNC format (for example\
\MyWorkflowServer\MyJobContainer
\HotFolder).

 

 
2. Click Test.

• Enable the Active Connection option to activate this workflow connection.
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Note:

If you disable this option, there will be no synchronization between WebCenter and your workflow
system, but the connection data will be saved, so you can reactivate it later.

• Click Create.

Edit a Workflow Connection
1. On the Workflow Connections page, click the name of a workflow connection.
2. Change the workflow connection's settings as desired.
3. Click Save.

Delete a Workflow Connection
1. On the Workflow Connections page, select the workflow connection(s) to delete.
2. Click Delete Configuration(s) in the actions menu.

Add a Workflow Connection to a Project / Template
Once you have created a workflow connection, you need to add it to project templates that Projects
Managers will use to create projects. You can also add the connection to individual projects if desired.

1. On the Project Details page of the project or template, go to Configure > Workflow Connection.
2. Select Connect this project to a workflow.

This shows extra options.
3. In the Workflow Connection list, choose the workflow connection you defined.
4. Select Allow manual synchronization by the Project Manager if you want Project Managers to be

able to synchronize the workflow job to the project on demand.

If you select this, Project Managers will have an extra action on the Project Details page:
synchronize with workflow.

Note:  Whether you enable manual synchronization by Project Managers or not, the workflow job
will be automatically synchronized with the project when certain events occur (see Define When the
Project and Workflow Synchronize on page 424).

5. Define when to automatically synchronize the workflow job to the project:

• select Synchronize on all statuses to synchronize whenever the project status changes,
• select Only synchronize on a completed status to only synchronize when the project has a

completed status.

Note:  There can be more than one completed project status defined in the system.

Note:  Make sure you have selected Project status change as event that will trigger an automatic
synchronization (see Define When the Project and Workflow Synchronize on page 424).

6. Select Copy documents when synchronizing if you want the project's documents to be copied to
the workflow job.
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Note:  When you are using a workflow connection that automatically archives your documents and
metadata in a network folder (see Create a Workflow Connection on page 420), Copy documents
when synchronizing is always selected.

You can also choose to copy Only approved documents, or Only documents in (a certain) folder
(select the project folder containing the documents to copy). This will work even you rename the
folder later. If you try to delete the folder, you will get a warning.

7. Define Additional Settings for the workflow job.

In Automation Engine, you can see these settings in the Job Setup. See the Automation Engine
documentation for more information.

Note:

You can use SmartNames to define those Additional Settings.

Click the Insert SmartName  button and select a SmartName in the list that appears next to the
button. SmartNames are shown between brackets, like [Project Name].

This list contains general project information ([Project Name], [Project ID], [Customer Name]...),
and all the attributes defined in WebCenter. The attributes don't need to have been added to the
project to be available here.

You can use several SmartNames if desired, or a combination of SmartNames and text, for example
WebCenter_[Project Name]_[Customer Name].

a) Fill in the job's Order ID. This is mandatory as it allows WebCenter and Automation Engine to
identify the job.

We recommend you use the [AE_OrderID] SmartName (corresponding to the WebCenter
AE_OrderID attribute created automatically when you created the workflow connection) for the
job Order ID.

b) Fill in the job's Suborder ID if needed (this is optional).

We recommend you use the [AE_SubOrderID] SmartName (corresponding to the WebCenter
AE_SubOrderID attribute created automatically when creating the workflow connection) for
this.

c) If you want to use a Automation Engine job template when creating the job (so that some of the
Job Setup information is already defined), define the template to use in Template Name.

Attention:

If using SmartNames, make sure that they resolve to an existing Automation Engine job
name.

SmartNames are resolved when the job is created via the JDF Hot Folder.

8. Click Save.

Define When the Project and Workflow Synchronize
Once you have created a workflow connection and added it to project templates, you need to define
what events will trigger an automatic synchronization between the workflow job(s)/network folders and
the WebCenter project(s).
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You can set this for your whole WebCenter system, but you can also overrule in specific projects or
templates.

System-Wide

1. Go to Admin > Preferences > Notifications.

The Notifications page has a column called Synchronize with Workflow.
2. Select the events that will trigger an automatic synchronization.

This means that when one of the events you selected occurs in a project, and the project is
connected to another system, the synchronization will take place.

For example, if you select Upload new document, the workflow job created will be synchronized to
reflect the project when a user uploads a new document into the project.

3. Click Save.

At the Project/Template Level

1. Go to the project or template's Notifications tab.
You can only do this as an Admin user.

2. Select the events that will trigger an automatic synchronization in the Synchronize with Workflow
column.

When one of the events you selected occurs in a project, and the project is connected to another
system, the synchronization will take place.

3. Click Save.

3.19.5.  Configure Asset Management Connections

Asset Management Connections
You can configure Asset Management Connections to connect to external digital asset management
(DAM) system (for example, MediaBeacon or another WebCenter system. When you have successfully
configured a connection, your users can use it as a source for assets. You can also push a new version
of an asset (or a new asset) back to the external DAM. This feature allows you to keep your repositories
in an external system.

Once configured, these Asset Management connections can serve as Document Sources in
WebCenter.

Configuration
To create a new Asset Management connection,

1. Go to the Admin > Configure > Asset Management Connections page.

If you already have Asset Management Connections, they will be listed in this page. To edit a
connection, simply click on the name of the connection.

2. Click New MediaBeacon Connection or New WebCenter Connection or New ESKO Cloud
Connection.

3. Name, a unique name for the connection
4. Specify / edit:
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• Name, a unique name for the connection

• URL and the API key for a MediaBeacon connection or URL, User name and Password for
WebCenter connection.

To create a new New Esko Cloud Connection, follow the steps here.
5. After specifying the parameters, click Test Connection. Select Create to finalist and create the

connection.

Upload from external Asset Management connection

When successfully configured, you can use these connections as custom Document Creation
sources. When a DAM is used as a source, the user is able to select documents (with meta data) from a
MediaBeacon workspace or a WebCenter Saved Search.

These configurations allow you to push a new version of a document to the asset management system
using a workflow node. Specify the Asset Management connection and a mapping between the
WebCenter attributes and the meta-data of the external system, the node can be used in a workflow.

You can view the Asset management connection details in the Document information in WebCenter. In
the Document Details  > Document Informationtab, view:

• Asset Management Origin – The name of the Asset Management Connection used to import the
document (+ link).

• Asset Management Document ID – The ID of the original document that resides on the external
asset management system.

System History Logs
All connection related events like

• Asset Management Connection Created

• Asset Management Connection Deleted

• Asset Management Connection Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 439

Esko Cloud
Esko Cloud is a cloud server environment in which all the Esko's cloud applications are deployed.
Dedicated services are made available which provides functionality to other applications for instance,
like WebCenter.

To connect to the cloud, the (service) URL needs to be provided together with the cloud token. The
token is used to authenticate the person/system that makes the request.

In WebCenter context, you can connect to cloud for

• Color

Note:  To know more about setting an Esko cloud account read here.

• Archiving of documents

For the color specific functionality, WebCenter connects to the Color service. The cloud stores colors/
inks and color/ink books. We refer to these as Colors and Color Books. The colors and color books
can be uploaded to the cloud by the Color Pilot. WebCenter can read the colors and color books by
connecting to the Color Microservice.
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Esko Cloud Account Creation
To connect to Esko cloud, an account has to exist in the Esko cloud. Most organizations may
require only one Esko Cloud Account, however multiple Esko Cloud Accounts can be maintained for
independent environments for segregation of data.

Follow the steps below to create an account with Esko cloud.

1. An Esko id is required to create an Esko cloud account which is provided for every customer.
2. Create an Esko Cloud account in this URL https://approve.next.dev.cloudi.city/

createNewAccount.html.
3. Cloud Account name can be given as required and the Cloud account number is auto generated.

Note:  Creating a site within a cloud account is optional for Color and Archiving services.

4. On creation of the Esko Cloud Account, you are auto navigated to the My Network page.

Select Add Equipment Network option to create Equipment in My Network Page.
5. Click on the Equipment folder and select Add Equipment. Select WebCenter as the Equipment

Type and add an Equipment Name. An Equipment ID is generated.

Equipment ID in the cloud account is required to enable connection to either Color Service or
Archiving service from WebCenter.

Configure Esko Cloud Connection in WebCenter
An Admin user can setup the connection to the ESKO cloud. ESKO Cloud Connection can be set up for
Archiving or Color service. To begin with, navigate to Asset Management Connections  page and select
New ESKO Cloud Connection.

Follow the steps below to configure the ESKO Cloud Connection in WebCenter.

1. Select New ESKO Cloud Connection to open the connection Details page.
2. Enter the Name of the Connection. This is a mandatory field to be entered.
3. Enter the URL of the Connection. This is a mandatory field to be entered.
4. Enter the Cloud Token. This is a mandatory field to be entered.
5. Choose the Cloud Service as either Archiving or Color. This is a mandatory field to be selected

and by default Archiving is chosen. In case the Cloud Service chosen is Color, additional steps are
required and are mentioned here.

6. Enter the Repository ID and Equipment. This is a mandatory field to be entered for Archiving only.
Repository ID will contain the ESKO cloud repository and the Equipment would hold the name of the
equipment created in the Esko Cloud.

7. Now you can test the connection with Test Connection before you Create.

Configure Color in Esko Cloud
A connection to the Esko cloud account can be established by the WebCenter Admin user in the Asset
Management Connections page, where the connection information is configured.

Setup of the connection to the Esko cloud with choosing the service as Color is the first step in the
Cloud Trace Solution from ESKO.

To begin with, enter the name, URL, Cloud token for the Esko Color cloud. On choosing the service as
color in the New ESKO cloud connection, additional fields are shown.
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• Deployment Package: Import Assets while setting- up the Color Trace solution for the first time in
WebCenter. These assets are part of the Deployment Package. Read more about it here.

• Color Information: Import Color Books into WebCenter for the first time when setting up the color
service. There is also an option to Force Update Color Books based on the requirements to update
the colors.

• Automatically Update Color Books every day: Select this option to update your Color books daily.

• Details: Expand to view the color books available at any point along with the last updated time. Also
information on the number of color books and colors processed during the last update including the
details of the number of color books that were updated or skipped or failed or obsolete is shown.

• Connection Status: Displays the status of the connection as Connected or Not Connected. Before
connecting for the first time, you can check whether all information provided is correct by clicking
on Test Connection. Select Create on save the information provided and create a new color service
Esko cloud connection.

• Connected When the Cloud Service can be reached, and the validation of the token was
successful

• Connection Failed When the import was not completed or the token could not be validated.

Deployment Package

While setting up the Esko Cloud connection for Color service, the required WebCenter assets are
imported as Deployment package. This is installed once initially using Import Assets option to setup
the Color Trace solution in WebCenter and later these assets can be updated whenever required using
Check for Updates option.

Note:  Subsequent Color Service setups does not require Deployment Package to be downloaded but
only updated if required.

Deployment Package comprises of WebCenter Projects and and Templates, Dashboards, Saved
Searches, Categories, Restricted Sets, Groups and Roles.

 

 

1. Project and Templates: Projects that are required to setup the Color Trace solution in WebCenter
are

• #COLOR TEMPLATE :Template project where utility documents are placed. It also can configure
the landing page for the “#COLOR LIBRARY” project. This contains the following documents

1. #COLOR TEMPLATE: Template document for creating a new color document. Any document
2. #COLOR THUMBNAIL: Document used to create the color document thumbnail (SVG)
3. #COLOR CONDITIONS.xls : Excel sheet containing valid values for the condition parameters

(For example: printing technique, substrate, ink type and finishing)
4. #COLOR ColorCertJob.ccj: Document that carries the category #COLOR ColorCertJob
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• #COLOR LIBRARY: Project where the documents representing colors are created. In this
project, each folder represents a color book and each document is a colors in the books. Meta-
data information of the color is added to the document attributes

• #COLOR PALETTES: Project that serves as library for the palettes

• #COLOR PALETTES TEMPLATE: Template for #ColorPalette Projects

• #COLOR COLORCERT RULES LIBRARY: Library for the Color Cert Rules documents

• #COLOR COLORCERT RULES TEMPLATE: Template for #Color Cert Rules library

• #COLOR ColorCertJob: Attribute Category to hold attribute values for the ColorCert Job

• #Color PROFILES
2. Categories Attribute categories for representing Color Palette or the Color or the conditions for

printing .
3. Groups and Roles :For Admins for various purposes and others Users.
4. Restricted Sets: Consists of two restricted sets for Master/Dependent color and Color status
5. Saved Searches:Are available to access the color information as and when required.
6. Dashboards:  To view the metrics of Colors, color books, Palettes, Rules profiles that are available.

3.19.6.  Assisted QA

WebCenter Viewer now allows integration with third party external web QA (quality assurance) tools
namely InformaIT and TVT for additional comparison features. You can configure a connection
between the Comparison tool with WebCenter by navigation to Admin  > Configuration >  Assisted QA.

When the graphic documents ( PDF's and Adobe Illustrator documents ) are compared in WebCenter
Viewer, additional buttons are enabled if any external QA tools are connected. Once the comparison
session in the external tool is completed, reports and annotations are stored back into the WebCenter.
You can read about how to configure an external tool here.

You can read more about how it renders in the viewer here in the User documentation.

Navigation From other Menu locations

You can configure QA tools as Custom Action Buttons in the Menu Builder to make it available other
than the Viewer. This can be added to all pages(locations) where the list of Documents are shown.

System History Logs
All Assisted QA Tool connection related events like

• Assisted QA Tool Created

• Assisted QA Tool Deleted

• Assisted QA Tool Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 439
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Configuring Assisted QA
As an Admin user, you can navigate to the configuring page from Configuration > Assisted QA Tools
> New QA Tool. Depending on the QA Tool to be added, the configuration options may vary. Currently
options are available to add InformaIT and TVT.

Navigate to Configuration  > Assisted QA Tools page to add a new QA tool or edit the details of already
configured connection.

The parameters required for connection are:

1. Name: An unique name for the connection.
2. Provider: Choose the QA Tool that you want to connect to.
3. URL: URL to the QA Tool to be added
4. Provider specific information:

a. InformaIT:

• User Group Add the User group in the InformaIT. By default, the “CC Users”is given

• Compare Type: Choose the type of compare you wish to use the connection for, either Text
or Graphic or Hard Copy.

• Configuration ID: Enter the corresponding configured id in InformaIT
b. TVT

• User Name

• Password

• Options : Choose from a set of options (type of document) defined and available in
dropdown.

• Create Audit Trail Report:Select this check box for a second report to be saved to
WebCenter

• Open TVT locally : Select this check box to open TVT on the application installed on the
local machine instead of a new tab

5. Report Location: Location to upload the external pdf report from the selected QA Tool after
comparing the documents

• Project Root Folder: Root folder of the project where the document resides

• Folder of Current Document: Same folder as the original document

• Custom Folder  Choose the folder where you want the report from the QA tool to be saved.
Specify the location in the Target Folder field.

• You can add a sux for the report name in the Report Name Sux field for the external report
which is imported.
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You can now Test Connection and then Create the connection. There is also an option to Delete this
connection in the Assited QA Tools page.

3.19.7.  Configure Push-Through Configurations for Workflow Folders

About Workflow Folders

What is a workflow folder?
When creating a folder the Project Manager can define it as a workflow folder, using a push-through
configuration defined by the Admin.

Any file that is uploaded into this folder will be automatically copied to a location defined in the
configuration. For this reason, workflow folders are sometimes also referred to as “push-through
folders”.

Workflow folders are particularly useful when that other location is a hot folder of a workflow system
such as Nexus, Automation Engine or Odystar, so that the file will automatically be processed by the
workflow system.

Note:  The Configuration for workflow folders needs to be defined by an Administrator.

Project Managers can then select one of the defined configurations when they create a new folder.

Recognizing workflow folders
Workflow folders have a yellow icon with an arrow on it.

 

 

The files in a workflow folder have two extra icons:

• The first  shows whether the copy of the file was successful or not.
• The second  is a button to copy the file again to the location defined in the configuration.

System History Logs
All Push Thorough Configuration related events like

• Push Through Configuration created
• Push Through Configuration deleted and
• Push Through Configuration changed

are recorded and stored in System History. Read this page on how to access the records.
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Delete Push-Through Configurations
1. Click Admin > Configuration > Push Through Configurations.
2. Select the configuration you want to delete.
3. Click Delete Configuration in the actions menu.
4. Click OK to confirm.

3.19.8.  Configure Workflow Approval and Tunnel Clients

When WebCenter and Automation Engine are not on the same LAN, this workflow approval and tunnel
client will establish a bi-directional communication.

Note:  The Automation Engine Pilot needs to have the workflow approval client credentials to send
messages to WebCenter.

This is configured through Admin > Configuration > Workflow Approval Clients in WebCenter, and, in
the case of Automation Engine, in Tools > Configuration > Web Sites in the Automation Engine Pilot.

Attention:

Configure the WebCenter account first so that it can be tested from within the workflow
approval server.

WebCenter and the workflow approval server must use the same user name and password!

This is completely separate from a normal WebCenter user. Workflow approval clients may not log in to
WebCenter.

Two manual configuration steps must also be performed outside of WebCenter to ensure proper
communication between the workflow approval client and WebCenter systems that are not on the
same LAN.

System History Logs

All Workflow Approval and Tunnel Client related events like

• Workflow Approval and Tunnel Client created

• Workflow Approval and Tunnel Client deleted and

• Workflow Approval and Tunnel Client changed

are recorded and stored in System History. Read this page on how to access the records.

Create a Push-Through Configuration
1. Click Admin > Configuration > Push-Through Configurations.

The Push Through Configurations page appears, listing the push through configurations already
created (if any).

2. Click New Push Through Configuration to add a new configuration.
3. Enter a Configuration Name.
4. In the Destination UNC field, type the path to the target folder in UNC format (for example \

\MyWorkflowServer\Container_Data\WebCenter).
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5. Choose a File Naming option:

• Document name: documents copied to the destination folder will keep their original WebCenter
name.

• [Project_name]_[Document_name]: the copied documents will get a file name consisting of
the project name, an underscore and the original document name.

• [Customer_name]_[Project_name]_[Document_name]: the copied documents will get a file
name consisting of the Customer name, an underscore, the project name, another underscore
and finally the original document name.

6. Choose the Workflow Type to enable additional integration functionality:

• Automation Engine,
• Nexus,
• Odystar.

7. Enable the Active Configuration option to activate the push-through mechanism for this
configuration.

If you disable this option, files will no longer be copied, but the configuration data will be saved, so
you can reactivate it later.

8. Click Create.

Create a Workflow Approval and Tunnel Client
1. Click Admin > Configuration > Workflow Approval and Tunnel Clients.
2. Click New Workflow Approval and Tunnel Client.
3. Enter the User Name and Password for the workflow approval client user.
4. Click Create.

Note:  If you have several Automation Engine, Nexus, or Odystar sites communicating with WebCenter,
you need to create a separate Workflow Approval Client for each site.

Change the Password for a Workflow Approval and Tunnel Client
1. Click Admin > Configuration > Workflow Approval Clients.
2. Click Change Password link next to the name of the client user.
3. Change the password and click Change.

Delete a Workflow Approval and Tunnel Client
1. Click Admin > Configuration > Workflow Approval Clients.
2. Select the client.
3. Click Delete Client(s) in the actions menu.
4. Click OK to confirm.

Configure the Workflow Approval and Tunnel Client Software
Configure the access to WebCenter in the client application for your workflow server.
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For instructions, please consult the documentation of your workflow server (Automation Engine,
Nexus or Odystar).

3.19.9.  Upload Saved Search Results Template

You can upload an Excel file (.xls) to be used as template when users download search results to Excel
files.

Note:  This will only be used when downloading the results of global saved searches (you can upload
one template per global saved search).

1. Go to Admin > Configuration > Upload Saved Search Results Template.
2. Browse to the Excel file to use as a template for a saved search.

Note:  Name it exactly as the saved search you want to use it for (ignoring the extension)!

3. If you want to update an existing template file (uploaded with the same name), select Overwrite if
template file already exists.

4. Click Upload.

When downloading search results using that template, you will find the results data in a sheet called
“Search Results”.

Note:

You can upload a template containing charts and additional sheets referencing the main “Search
Results” data sheet (for example through Pivot tables).

In this case, remember to put referencing elements to “auto-update on open” to update the sheet
automatically when the Excel document is opened.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.19.10.  View System Information

The System Info page lists various system statistics. Click Admin > Configuration > System Info to
view the system statistics and properties.
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3.19.11.  Troubleshooting Tool

If you experience some problems with WebCenter, or if you want some real-time information on your
WebCenter system, you can run the Troubleshooting Tool. To do this, you can either:

• Go to Admin > Configuration > Troubleshooting Tool in the WebCenter user interface.
• Go to http(s)://<server>/<instance>/tstools/index.html in your web browser.

Note:

• You can run the tool from this web page even if your WebCenter server is not running (some
tests will fail if WebCenter is not running).

• When running this tool as a non-Admin user, you can only execute simple tests (advanced tests
require Admin access).

• You can execute all troubleshooting tests from localhost without the need to log in as an
administrator. This can be done by accessing the Web Server machine and navigating to: http://
localhost:8081/<instance>/tstools/index.html.

The tool starts automatically. For each test, the tool gives a status and some extra information. You can
use this information to troubleshoot your WebCenter installation and, if you cannot solve the problem,
to call Esko customer support.
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Test status Meaning

OK The test was executed and everything works as
expected.

BAD The test was executed, it could be working, but
something requires attention.

FAILED The test failed. Is is very likely that there is
something wrong with the system.

SKIPPED The test wasn’t executed due to a lack of rights
(you didn't log in as an Admin user) or because a
previous (related) test failed.

Workflow Troubleshooting
If you run the test on the Workflow Engine at the Troubleshooting Tools page, it will result in :

• OK if the Workflow Engine is running
• Bad if the Workflow Engine is still starting up
• Failed if the Workflow Engine is not running.

You can also see the Workflow Database states such as :

• The total number of running workflows in the Workflow Engine
• The total number of tokens in these workflows
• The total number of triggers in these workflows
• The total number of wait triggers in these workflows

When you have a problem workflow, click on the Details section to know more about the specific tasks
and projects creating issues. You will also see a tip describing how to resolve the problem.

Read https://wiki.esko.com/pages/viewpage.action?pageId=170037353.

3.19.12.  Workflow Engine

Use the WebCenter Workflow Engine page when the workflows get stuck, fail to complete or when a
workflow loops cause the system to crash. This is a convenient way to troubleshoot workflows.

Note:  Since version 14, this component runs as a background process of JBoss running the workflows
in WebCenter. For versions before WebCenter 14, the Workflow Engine runs along with the JBoss.
Because of this, you have to restart the JBoss to restart the Workflow Engine.

To see the status of the Workflow Engine, go to Admin > Configuration > Workflow Engine.

• Started when the Workflow Engine is running (green)
• Starting when the Workflow Engine is still starting up (orange)
• Stopped when the Workflow Engine is not running (red)

To change the status, use the following controls:

• Restart
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• Start
• Stop

This page also displays the data on:

• • The total number of running workflows in the Workflow Engine
• The total number of tokens in these workflows
• The total number of triggers in these workflows
• The total number of wait triggers in these workflows
• The number of workflow events per second: This is the average number of Workflow Events

per second generated by the Workflow Engine within the past 20 seconds.
• The workflow engine queues (Queue Name) and their sizes:

• Internal Event Processing Queue
• Workflow Step Processing Queue
• Trigger Processing Queue

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.19.13.  Cleanup Tool

When objects are deleted, they remain in the database marked as “Deleted”. To permanently clear this
data, an off-line tool is used which can be scheduled for a time when the server load is low.

The Clean Up tool has to be run by System Administrator with operating system access to the
WebCenter Application server. To run the tool at regular intervals, the Windows Task Scheduler can be
used.

Running the Cleanup tool
• On the WebCenter Application Server operating system, navigate to

<WebCenter_install_directory> \ApplicationServer\Cleanup.
• Execute the batch script ‘cleanup.bat’ (either by double clicking or executing in a command prompt).

This will connect to WebCenter and instruct it to scan through the database and purge obsolete
records.

The clean-up tool produces progress feedback in the displayed command prompt and also stores it in
the log file. To view the log, go to:

• <WebCenter_install_directory> \ApplicationServer\Cleanup\logs
\cleanup.log

Inspecting Cleanup Tool Status from browser
You (Admin) can view the status in the Admin > Configuration > Cleanup Tool page. The following
states are possible:
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• Running. You can stop the tool by clicking the Stop button. You will be asked to confirm your stop
action.

• Stopping – a stop request was submitted to the server, but the cleanup tool is not yet stopped. In
this state, you cannot execute any aciton.

• Stopped

If the status is Stopped, you will be able to:

1. Specify the Minimal age of items to clean (in hours). The default is 0 hours.
2. Start the cleanup tool by clicking the Start button. If you Start the process, you will be asked

to confirm your start action. As soon as the cleanup tool starts up, the status will change to
Running.

Altering ProfileDefaults
You can prevent Stopping or Starting the Cleanup tool from browser.

• To prevent Stopping the Cleanup tool from browser, change the ProfileDefaults record
WC_CLEANUP_ENABLE_STOPPING to “0” by either of the following methods:

• Use the URL:

<WebCenterInstance>/siteconfig.jsp?key= WC_CLEANUP_ENABLE_STOPPING &value=0

• or directly by a SQL script.

• To prevent Starting the cleanup tool from the browser, set the ProfileDefaults record
WC_CLEANUP_ENABLE_STARTING to 0. You can use either of the following:

• Use the URL:

<WebCenterInstance>/siteconfig.jsp?key= WC_CLEANUP_ENABLE_STARTING &value=0

• or directly by a SQL script.

Note:

Once set, the value can no longer be changed from the siteconfig.jsp, but only altered in the database
directly. This allows eciently blocking these features from being executed from the browser.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

3.19.14.  Site Service

View Log Files
Go to Admin > Configuration > Site Service to:

• see system settings (click Show Site Defaults),

• set the maximum number of days to retain log files:

You can specify the Max Age of JBoss Log Files field as the number of days you want to retain the
logs.

438



3WebCenter

Important:  If you set a very high number of days, it will affect your hard drive disk space over time.
You have to watch the disk space and delete the log files manually.

• download JBoss and Tomcat log files.

3.19.15.  System History

WebCenter system configuration changes can be viewed in one location by Administrators. Navigate to
Admin > Configuration > System History and view the following information:

• Event Date
• Type of the event
• User who made the change
• comment (system generated )
• Change comment (provided by the user)

The events can be filtered and viewed based on the date, the operator or the delegate or the event
type.

You can choose to view all the events or can specifically choose the events in which you are interested.
By default, the first 200 records matching the filter and sorting option are shown, however, this can be
increased or decreased, and it is possible to print the results matching the filter.

Events are tracked in the following pages in WebCenter
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Each of the page has different set of events captured and stored in history based on the nature of the
event.

3.19.16.  Authentication

Single Sign-on allows you to use a centralized system for authentication. For instance, you can use a
single credential on many systems including WebCenter.

You can configure:

• a single set of credentials for all systems (like LDAP)
• free access to WebCenter without a separate login page.

The two previously existing authentication mechanisms (LDAP and simple password authentication)
have been modified adding extra flexibility. You can either make all users authenticate with LDAP by
default or configure multiple LDAP servers.

Note:

You need a WebCenter Advanced License to configure more than a simple password authentication
and one LDAP server.

Table: Single Sign On Definitions

Single Sign-On System The system providing authentication, (e.g.
yammer, SAML, LDAP)

System Administrator The administrator who deals with WebCenter
from both an application point view and from an IT
(operating system and database) point of view.

Administrator WebCenter Administrator

SSO plug-in (SSOP) The full deployment of an integration with a Single
Sign-On system. Will also be used as synonym for
the implementation of the Java 'ServiceProvider'
concept. The Service Provider is in fact part of the
deployment of the plug-in.

Single Sign-On Instance configuration Defines an Instance and its place (priority and
availability) in the system.

Plug-in specific Instance configuration Part of the instance configuration that may differ
depending on the plug-in.

Single Sign-On Instance A plug-in can have multiple instances. Its behavior
is determined by the plug-in and the instance
configuration.

User Configuration Configuration information for a specific user

Instance Specific User Configuration The user configuration dependent on the SSO
instance.
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Note:  This configuration is dependent on the
instance and not the plug-in.

Standard Login Page Instance The standard login page.

Custom Login Behavior Instance The alternate page (or dialog) when a user is not
authenticated.

Default Single Sign - On Instance The instance that will be selected by default.

User Has access to WebCenter after login.

Database Relational database. The primary location for
persisting data in WebCenter.

Add a plug-in to the system
You can add plug-ins that are not WebCenter standard by placing a set of .jar files in
<installation_root>/ApplicationServer/JBoss/sso-plugins folder.

These files contain the plug-in implementation and the associated libraries. To remove a plug-in, you
have to stop the application server. Restart the application server after replacing the .jar files.

Note:

1. You do not have to restart any of the WebCenter servers after installing a new plug-in.
2. When an Application Server is being updated, any existing SAML plugin version that might have

been there already when updating is replaced with the latest version provided by the WebCenter
installer.

Add a Single Sign-On Instance
1. From the Configuration > Authentication (SSO) page, click on the New SSO Instance link.

Note:  You cannot have more than one basic authentication.

2. Give the new Instance a Name.
3. Select the Plug-in from the drop down.

The Plug-in drop down will display all the SSO Plug-ins available in that particular WebCenter.
4. Click Create.

When the instance is created successfully, you will return to the Single Sign-On Instances list. The new
instance is also displayed as the last instance.

Manage Instances
Go to Configuration > Authentication (SSO) to get an overview of the configured Single Sign-On
Instances.

Enabling the Allow Project Managers to change their users' access to SSO instances option will allow
the Project Managers to modify their users authentication settings at the user  profile page.
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When this is disabled, Project Managers will be prevented from changing their user’s access to SSO
instances. The PMs will not be able to see the Authentication drop downs to the user’s profile. In
addition, the disabled instances will be hidden.

 

 

Name: Name of the Single Sign-On Instance. Will be used for display in multiple places.

Plug-in: Name of the plug-in to which the Single Sign On Instance belong.

Password Recheck: Whether a particular instance supports password re-entry (upon submitting
approval) or not.

• Yes  or No : if the system supports password re-entry
• N/A: indicates that the information is currently not available. For example, if the instance is not

enabled or fails to load.

ID: the internal ID. As an administrator, you can use this while addressing an SSO provider directly. For
example, when redirecting from an external system.

Priority: determines the order in which the Instances are attempted for authentication. Also
determines the display order in several places (user settings and log-in page).

Enabled: indicates whether the instance is operational. You have to enable an instance to use it for
authentication. The options to change Instance specific user settings is only available for the enabled
Instances.

Listed: indicates that an explicit log-in button will be available when the Instance is enabled.

Try Next: when this is enabled, the next Instance will be tried after the default log-in fails. The log-in
attempts will stop at the first enabled Single Sign-On Instance when the Try Next option is disabled.

Configure: displays the Edit links to configure the plug-in specific instance configuration.

Default: you can configure whether a user is allowed to or denied from using an Instance. You can allow
some users to authenticate at a specific Instance. The default can be changed in the user specific
configuration.

Delete: use the Delete link to delete an Instance.

Configure a Single Sign On Instance
To access the Single Sign On Instance configuration page, click the configure link from the instances
row.

1. Go to the Configuration > Authentication (SSO) page. You will see the overview table of the
configured Single Sign-On Instances.

2. Click Edit link in the row corresponding to the Instance to be configured.
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This opens a plug-in specific configuration of an existing Single Sign On Instance.

Note:  You cannot edit the Basic Password configuration.

3. Modify the configuration details.
4. Save.

To make it active, you need to check the enabled option. To make it listed on the login page, enable
listed. When you create a new User, the login options are determined by the status in the default
column.

If an instance is in the denied status for a user, he/she will not get that option listed on the login
page. The status specified in this page becomes the default in the user profile page.

Single Sign-On Settings
You can view the Single Sign On settings specific to your User account in the My WebCenter > My
Password page. This page will display the Single Sign On Instances that are enabled for your User
account.

You may modify configuration details of the Single Sign On Instance depending on your permissions to
do so. If you have permission to modify, all your values will be saved.

Note:  User specific settings are possible when the Single Sign On Instance supports user specific
configuration.

Configure LDAP(S)
LDAP

LDAP (Lightweight Directory Access Protocol) is an application protocol for querying and modifying
directory services running over TCP/IP.

In the context of WebCenter, it allows you to let users sign on to WebCenter with the same user name
and password they use to log on to the corporate network.

LDAPS

LDAPS is the more secure variant of the protocol, and it uses SSL connections instead of plain (i.e.
Unprotected) connections. It requires you to install certificates on the server, as described in Install
Certificates for LDAPS on the Application Server on page 62.

While logged in to the WebCenter web interface as an administrator:

1. From the Configuration > Authentication (SSO) page, click on the New SSO Instance link.
2. Give the new Instance a Name and select the Plug-in as LDAP password authentication.
3. Click Create.

A new LDAP instance will be created.
4. In the overview table of the configured Single Sign-On Instances, click Edit link corresponding to

the LDAP instance.
5. Modify the configuration details.
6. Enter the name or IP address of the LDAP Server.

Example: esko.com.
7. Type the User Distinguished Name (DN).
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Example: CN=BG System,OU=Users,OU=Gent,OU=Belgium,OU=Locations,DC=esko,DC=com.

8. Provide the Password for the user you specified in the User Distinguished Name field in the
previous step, and confirm it.

9. Enable the option Use secure connection (LDAPS) to encrypt all communication between
WebCenter and the LDAP server.

10. You can specify additional elements in the Advanced settings field. For example, you can change
the default port that is used in the case of LDAP over SSL. Use the various lookup keys to match the
LDAP field against the WebCenter properties and then change the default LDAP keys. See below:

Options Description

ssl.port Default LDAP secure connection port

The default value is 636.

lookup.userinitials AD path used for LDAP login name lockup.

The default value is sAMAccountName.

lookup.firstname First name key

givenName (default)

lookup.lastname Last name key

sn (default)

lookup.mailid Mail id key

mail (default)

lookup.phonenumber Phone Number key

telephoneNumber (default)

lookup.mobilenumber Mobile Number key

mobile (default)

lookup.title Maps to the Function in WebCenter

title (default)

autoupdate Enable this to look up user info and to update
during log in (values: 0 or 1). Specify the value
as 1

The default is 0.

enforce Enable this to make the user info read only for
the user (values: 0 or 1).

The default is 0.

11. Click Save to save the setup.

Note:  Every time you change a setting on the LDAP Setup page, you must re-enter the full LDAP
credentials.
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Single Sign On Log-in types
You will have different SSO login behavior depending upon the configuration and priority of the Single
Sign On Instances.

• Standard Login Page Instance (SLPI):

This will show the login page when not logged in. LDAP and plain password authentication are
examples.

• Custom Login Behavior Instance (CLBI):

CLBI might redirect you to a portal or show a dialog. SAML is an example of the CLBI type.

WebCenter 14.0.1 supports the SAML plug-in. Using this plug-in, WebCenter can communicate over
the SAML 2.0 protocol with Shibboleth, PingFederate and Active Directory Federation Services
(ADFS). WebCenter users can authenticate using their company-wide account. This will provide
seamless access to WebCenter.

Note:

You need WebCenter advanced license to enable this feature.

The plug-in supports the following SAML 2.0 profiles:

• SP POST – IdP POST
• Unsolicited SSO (SP POST – IdP HTTP Redirect)

Note:  SAML Artifact binding is not yet supported

Important:  We recommend that you contact Esko solution architects for configuring the SAML plug-
in.

You can also access the login page by directly navigating to login.jsp. The different login behaviors can
again be triggered if the buttons for the wanted instances are listed on the login page.

A plug-in may override the logout behavior. For example, logging out may lead you to a portal.

Single Sign on Passwords on Approval
When the Require password for approvals/rejections setting is enabled, your user is required to provide
his password during approval. This depends on the Single Sign On Instance used by the user.

When the Instance supports this setting, the password is the same as the one required for the Single
Sign On authentication.

 Token Authentication
You can use Token based authentication to grant access to WebCenter without user credentials. For
instance, you can grant access to the document approval page for approval actions using a document
link.

• Token: A token is a piece of string that encodes various user data ( username, expiration date,
signature, etc.) which acts as a substitute for credentials.

• TokenAuth: The WebCenter SSO plugin that is able to generate such tokens for WebCenter users
and authenticate users based on these tokens. This is installed during WebCenter installation.:

To allow Token based authentication, follow the steps below
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1. Add a Single Sign-On Instance on page 442 specifying a Token Authentication plugin.
2. Configure a Single Sign On Instance on page 443. Make sure that the instance is in the Allow status.

 

 
3. Specify the Enable link expiration and Validity parameters and Save.

The Enable Link Expiration is on by default and the Validity is set to 60 days. This means that all the
links sent to authenticate using this instance will be expired after the validity period.

4. To send a login link to a User, click Mail Login Link from the User Profile page. The user can click on
this link to login.
 

 

The default landing page is the My Work page. If the token is expired, the user will see the Login
page with an error.

Whenever the token-authenticated user receives a notification with a link, the link contains a token
to authenticate without user credentials. This permits the users added to the approval cycle to log in
using the approval links from the notification mails.

.

SAML Authentication
The SAML plugin will make it possible for WebCenter to communicate over the SAML 2.0 protocol
with Federated Identity Provider Services such as Shibboleth, PingFederate and Active Directory
Federation Services. This allows the users to authenticate through a Single Sign On (SSO) mechanism
with WebCenter using their federated identity.

The configuration page of an instance of the SAML 2.0 (v1) plugin consists initially out of four sections:

• SAML Profile – Used to specify which SAML profile to use.

• Identity Provider Details – Used to specify and submit metadata of the Identity Provider, as well as
configuring general customer specific settings.

• Identity Provider Metadata:Update the URL to the meta data of the IdP or alternatively upload a
file containing the information.

• Identity Provider Entity ID: Specify the ID to be selected from the metadata
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• Links WebCenter Username to : specify the field where WebCenter will look for the User
name in the response. It can either be Subject Name ID or the Attribute where you specify the
Attribute Name.

• On error URL : specify the URL where the user will be redirected when error occurs in the
authentication process

• On Logout URL:specify the URL where the user will be redirected during the Logout process

• WebCenter Service Provider Details

• Entity Id: This id will be auto generated when you save this page. By Default it points to the
current WebCenter Instance.

• Assertion Consumer URL : This URL will be auto generated when you save this page.

• Name Id Format: Specify the format of Name Id of the subject.

• Formatting: Select Use URL Parameters if URL parameters has to be used in Assertion
Consumer Service URL.

Example:

https://domain.com/WebCenter_Inst/sso.wcr?ssoiid=00002_0000000004

Or:

https://domain.com/WebCenter_Inst/sso.wcr/00002_0000000004/end.wcr

• Signing: If the request has to signed, upload the signing certificate.

To be able to sign these outgoing authentication requests, WebCenter needs a private key and
its corresponding certificate. These can be uploaded in a Java keystore in the “SP Keystore”
field. This field appears along with the “Keystore Password”, the “Key Alias” and the “Key
Password” fields when the “Sign Authentication Requests” option is enabled.

• User Action Digital Signature: By selecting this option, you can use your SAML for credential
validation, when Approving Documents or for completion of Tasks.

• User Provisioning: Enable the option Allow User Creation on First Login to create new user in
WebCenter.

Following SAML attributes are required for the new user creation.

• Authorization: Select Synchronize User Groups on login to synchronize the user membership
with the groups when the user log-ins to WebCenter.
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• Save the changes and enable the SSO Instance in Single Sign-On Instances page.

Now the IdP details from the URL or the uploaded file is displayed.

Check the information updated by clicking on WebCenter Service Provider Metadata which is used
to display the Service Provider metadata of WebCenter. This information can now be shared with
the Identity provider.

How to Login to WebCenter when the Single Sign On is broken
You can access WebCenter overriding the Single Sign On configuration in emergency situations. This
can happen when the configured external system is down or when a mistake occurs leading to a broken
configuration.

Use basic password authentication locally from the web server to gain access to WebCenter.

Note:

• You need direct access to the web server operating system to execute this.
• You have to remember a basic authentication password of a WebCenter Admin user. Or you should

have enabled Forgot Password feature.

System History Logs
All Single Sign on related events like

• Single Sign on Instance created
• Single Sign on Instance deleted and
• Single Sign on Instance changed

are recorded and stored in System History. Read this page on how to access the records

3.20.  Configure Microsoft Oce Files for Viewing

You can view Microsoft Oce documents (and other file types) in WebCenter (16.1 onwards). This
feature requires configuration where you should specify the file extensions and corresponding OBGE
Workflow tickets.

Read in Configure Viewable Other File Types.

3.20.1.  Steps to Configure Viewable Other Files

1. Modify: WebCenter_Instance/custom/customizationConfig.xml.

Inside this configuration file, add a 'SupportedViewableOther' section. Within that tag, you can
place multiple instances of the extension tag, where you can define the file extension and the value
for ViewGenerationTicket (which refers to a Ticket on the OBGE).

<SupportedViewableOther>
                                                  <extension value=".doc"
                                                 
 ViewGenerationTicket="MSOffice_to_SVG"/>
                                                  <extension value=".docx"
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 ViewGenerationTicket="MSOffice_to_SVG "/>
                                                  <extension value=".ppt"
                                                 
 ViewGenerationTicket="MSOffice_to_Pixel"/>
                                                  <extension value=".pptx"
                                                 
 ViewGenerationTicket="MSOffice_to_Pixel"/>
                                                  <extension value=".xls"
                                                 
 ViewGenerationTicket="MSOffice_to_SVG"/>
                                                  <extension value=".xlsx"
                                                 
 ViewGenerationTicket="MSOffice_to_SVG"/>
                                                  </SupportedViewableOther>

Note:

WebCenter allows deployment of multiple web instances on one server and the configuration of
customizationconfig.xml is done per instance. However, the Workflow Engine and Dashboards are
shared across all instances. To make sure the settings work in a Workflow and in Dashboards, add
the following to the customizationconfig.xml file:

 <MainInstance
                                                  value="true"/>

This should only be added to one WebCenter Instance. If it is added to multiple instances, these
configurations will overwrite each other. If it is not present in any instance, the extension list will be
ignored in Workflows and Dashboards.

2. You need to create Custom Workflow Tickets (with a ScriptRunner Node) for OBGE according to the
mapping made in the customizationconfig.xml. See the examples for such Workflow Tickets in
Recommendations and Examples on page 451.

• The ScriptRunner node should refer to the right server (can be the OBGE itself) where the right
conversion Script is located.

Read more in:Pixel Based Viewing Vs SVG Viewing on page 450

3.20.2.  Pixel Based Viewing Vs SVG Viewing

You can view documents in pixel based or vector based formats depending on the view files that are
generated (as specified in the configuration.

Pixel based viewing
Use the pixel based setup if you need the graphical compare and channel information for the
documents. This setup will not render sharp text or text extraction.

To enable pixel based viewing, we propose the following structure in the OBGE Workflow Ticket:

• A Scriptrunner node to convert Other document to a viewable type, e.g. PDF.
• A Select Document node to select the generated document.
• A Prepare for Viewing node to generate the pixel-based view files.
• AScriptrunner node to remove the temporary files created in the first step.

See Recommendations and Examples on page 451.
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Vector based viewing
A vector based setup will enable you to extract text and view sharp text in deep zoom viewing.
However, the graphical compare and channel information are deactivated in this setup.

To enable vector based viewing, we propose the following structure in the OBGE Ticket:

• ConfigureScriptrunner node to convert Other documents to SVG files.

• For single page documents, an SVG should go straight into the Job folder, which is passed as a
parameter to the script.

• For multi-page documents, an SVG for each page should go into a sub-directory of the Job Folder
with the page number as folder.

• We recommend generating a thumbnail for each page in the Script file. These need to go in the
same folder as the SVG file. The following files are needed:

1. <Document_name>.JPG, which is 200x200 pixels
2. <Document_name>_50.JPG, which is 50x50 pixels
3. <Document_name>_100.JPG, which is 100x100 pixels

See Recommendations and Examples on page 451.

3.20.3.  Recommendations and Examples

The setups detailed below will create 'viewable files' in two steps. The Microsoft Oce documents will
be converted to PDF. In the next step, the PDF documents will be converted into SVG view files or pixel
based view files.

We recommend LibreOce to convert the document to a PDF. This will just execute a “Save as PDF” on
the document. You can use MS Oce which requires licensed MS Oce to be present on the server.

The recommended solutions given below refers to the Tickets and Scripts given in the example folder.

Note:  Remember to fill out the file paths mentioned in each of these Scripts.

See this KB Artcle for example scripts and tickets.

3.21.  Connecting to Automation Engine

You can connect to your or a client's Automation Engine from WebCenter. Using this connection, you
can:

• send files
• push metadata
• launch a workflow

To establish a successful connection, you need to configure both the Automation Engine and the
WebCenter settings.

Read about configuring the Automation Engine here.

You can connect to Automation Engine:
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• in the same LAN or publicly available through an Automation Engine Host Address

Tip:  The Host Address may look like '192.168.1.1' or 'aeserver.brand.com'.

• via a tunnel when not publicly available or not in the same LAN. Read in: Create a Tunnel between
WebCenter and Automation Engine on page 452

3.21.1.  Create a Tunnel between WebCenter and Automation Engine

When the Automation Engine is not situated in the same LAN and not available publicly, you need a
tunnel to send exchange workflow commands and data between WebCenter and Automation Engine.
To create such a tunnel, follow the steps below:

Web

1. Create a Workflow approval and tunnel client.

When WebCenter and Automation Engine are not on the same LAN, this workflow approval and
tunnel client will establish a bi-directional communication.

Note:  The Automation Engine Pilot needs to have the workflow approval client credentials to send
messages to WebCenter.

2. Enter the Workflow approval and tunnel client credentials in the Automation Engine configure tool.

Fill out the client Name and Password and click the Check Connection button. This will check if the
user can log on successfully.

3. Save this configuration.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it
again in order to see the updated list of WebCenter sites in your tickets.

4. Optionally, you can check the connection between Automation Engine and WebCenter from the
admin > configurations > workflow and tunnel clients page. Click theStart Monitoring link to see if
the connection is active.

5. Click Admin > Configuration > Workflow Connections.

The Workflow Connections page appears, listing the workflow connections already created (if any).
6. Click New Workflow Connection.
7. Enter a Configuration Name.
8. Select the Connection type as JDF Service.
9. Now, specify the JDF Service as JMF service.

Note:  You need JMF Service to connect to Automation Engine if it is not in the same LAN or not
publicly available.
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10. Specify that your Automation Engine is connected via the Approval and Tunnel Client created in

step2. Select the Approval and Tunnel Client from the drop-down and click Generate URL.

Warning:  A Workflow Connection connected through an Approval and Tunnel Client will
block one concurrent license.

11. Enable the Active Connection option to activate this workflow connection.

Note:

If you disable this option, there will be no synchronization between WebCenter and your workflow
system, but the connection data will be saved, so you can reactivate it later.

12. Click Create.

3.22.  SmartNames

A SmartName is a variable that refers to a value that is resolved according to the context, for example
[Project Creation Date] refers to the creation date of the current project. It is a placeholder
value for a property which will be replaced with an actual value when placed in the right context.

You can use SmartNames in different pages in WebCenter. They are displayed between square
brackets.

 

 

You can also combine them with plain text.

 

 

Using SmartNames to specify a setting ensures that you can use the existing information without
having to remember it and thereby reducing errors.

453



3 WebCenter

For example, if you use [Parent Project Name], the smartname will resolve to the name of the existing
Parent project(s) taking the current Project as the search context.

3.22.1.  Using a SmartName

You can use SmartNames anytime you see the SmartName symbol  in a text field.

1. Click .
2. In the Select to append a SmartName field or Insert a SmartName dialog, select the desired

SmartName using one of the following methods:
a) During the autoname generation, browse to the desired SmartName in the Select to append a

SmartName field and select.
Alternatively, you can also double-click the SmartName.

b) In the Search using SmartNames, you can scroll in the main sections list and double-click on the
desired SmartName.
You can also search for a SmartName.

• The search field has support for AND and OR operators.
• Spaces can be used and will act as AND operators.
• Semicolons can be used and will act as OR operators.
• You can place your search term inside double quotes (") when an exact match is required.

Tip:

• You can type the first letters of the SmartName you are looking for to show it in the list.

3.22.2.  List of Available SmartNames

The following is the list of available SmartNames

Section SmartName Available Workflow Search AutoName

Attributes

(Document)

All WebCenter attributes are
available in both Workflow and
search

# #

Attributes (Project) All WebCenter attributes are
available in both Workflow and
search

# #

[Document Description] #

[Document Extension] #

[Document ID] #

[Document Name] # #

[Document Version ID] # #

Document

[Document Version Number] #
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Section SmartName Available Workflow Search AutoName

[Input Document Version Ids] #

[All Document Version IDs of
Document]

#

[All except Latest Document Version
ID]

#

[Document Version Revision] #

[Document Version Project] #

Other List # #

[Customer Legal Name] #

[Customer Location] # #

[Customer Name] # #

[Customer ShortName] # #

[Due Date] #

[Project Description] #

[Project ID] # #

[Project Name] # #

[Project Manager] #

[Project Manager Name] # #

[Project Manager Location] # #

[Project Manager Location Code] # #

[Project Manager Last Name] # #

[Project Name] # #

[Project Template Name] # #

[Parent Project ID] #

[Customer Location Code] #

[Salesperson] #

Project

[Project Creation Date] #

Specifications All WebCenter Specification
available only in Workflow

#

Task [Workflow ID] #

[Content Status] #

[Element Type] #

Text/Table Content

[Language Status] #
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Section SmartName Available Workflow Search AutoName

[Master Languages] #

[Text Content Value] #

[Table Content Value] #

[Translation Languages] #

[Current Date] #

[Project Due Date] #

[workflow Due Date] #

Dates

[workflow Start Date] #

[Requestor User Name] # #

[Requestor First Name] #

[Requestor Last Name] # #

[Requestor Location] # #

[Requestor Company] # #

User

[Requestor Company Location
Code]

# #

[Project Manger (E-mail) #

[Sales Person (E-Mail)] #

Email

Workflow Task Owner (E-Mail)] #

Groups All Groups available in WebCenter #

Roles All Roles available in WebCenter #

Users All Users available in WebCenter #

Iteration Iterator Value #

Note:  The EditField SmartName can be used only in the Sux.

3.23.  Bill of Materials

3.23.1.  What is a Bill of Materials?

A Bill of Materials (or “BOM”) is a list of all parts and assemblies required to build a complete shippable
product. It shows what will be created and delivered during a project.
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In WebCenter, this is a list of documents representing the deliverables. The documents can be actual
production files or placeholder documents.

3.23.2.  Enabling the Bill of Materials Feature

By default, the Bill of Materials functionality is disabled for the entire WebCenter system. This means
that Bill of Materials features will not be visible.

To enable it, do the following:

1. Go to Admin > Preferences > General.
2. Under Bill of Materials, select the Use Bill of Materials option.
3. Click Save.

3.23.3.  Viewing a Project's Bill of Materials

Every project has a Bill of Materials, which is by default empty.

If the Bill of Materials feature is enabled, you will see a Bill of Materials tab on your Project Details page.
The tab header indicates how many documents are linked to the Bill of Materials.

Note:

You will only see the document(s) in the Bill of Materials (and their attributes) if you are either:

• an Administrator,
• the Project Manager,
• invited to the Project, with view permissions on all documents in the Bill of Materials.

Otherwise, you will see a message stating that you don't have permissions to view the document(s) in
the Bill of Materials.
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When clicking this tab, you see the documents in the Bill of Materials, with information about the
documents (folder, version, approval cycle, tasks...) and their Count. This indicates how many copies of
that document are required for that project's Bill of Materials.

Note:  The count is specific for a document within a project. This means that the same document can
be linked in multiple projects with a different count.

If a document has an attribute category assigned, you will see a + button. Click it to show its attributes
(in list view), and click - to hide them again. To show/hide the attributes of all documents in the BOM,
click + or – in the header of the table.

Tip:  By default, the “Default” view for the attribute category is displayed, but if the attribute category
has a view called “BOM”, this view is shown.

3.23.4.  Editing the Bill of Materials

Who Can Edit the Bill of Materials?
Administrators and the Project Manager can always change the Bill of Materials. Other members can
be allowed to change it, if they have the Change BOM permission. This permission can be set on the
project’s Security page (see Project and Document Security on page 832 in the User Guide).

Note:  You can only set the Change BOM permission at the Project level, not at the folder level.

If a user can change the attributes on the attributes page, he/she can also change them on the Bill of
Materials page.
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Table: Permissions on Bill of Materials Documents

Administrators Project Managers Users with Change
BOM Permission

Users without
Change BOM
Permission

Can add/remove
documents to/
from the BOM in
active projects

YES YES YES NO

Can add/remove
documents to/
from the BOM in
inactive projects

YES YES NO NO

Can change the
count of BOM
documents

YES YES YES NO

Adding Documents to the Bill of Materials
You can only add documents to the Bill of Materials if:

• you are an Administrator,
• you are the Project Manager,
• you have Add and Change BOM permissions on the Project.

Adding Documents to the Bill of Materials at Project Creation
If you want Project Managers to be able to already add documents to the Bill of Materials when creating
a Project, do the following:

1. As an Administrator, go to the Project or Template that Project Managers will use to create
Projects, and click the Configure tab then Project Creation.

Tip:  Use a Project or Template that contains a Bill of Materials with documents if you want Project
Managers to have the option to copy these documents into their new Project's Bill of Materials.

2. Select the Show check box for the Change Bill of Materials option.

If you want Project Managers to have to add at least one document to the BOM when creating the
Project, also select the Required check box.

Click Change.
3. When a Project Manager creates a Project from that Project or Template, he/she will see a Bill Of

Materials section on the Project creation page.

• when creating the Project from a Template, that section will contain the documents in the
Template's Bill of Materials.

• when creating the Project from a Project, he/she will have to choose whether to copy the
documents from that Project's Bill of Materials into the new Project's Bill of Materials.

To copy them, the Project Manager should select including BOM in the Copy setup from an
existing project pop-up.
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Note:  A Project Manager will not see a Bill Of Materials section on the Project creation page when
creating a blank Project.

4. The Project Manager can still edit the Bill of Materials while creating the Project. He/she can:

• add documents using the Upload, Copy and New links,
• remove documents by clicking the - buttons in their rows,
• change the Count of Bill of Materials documents,
• edit the documents' attributes (by clicking + and filling them in).

Add Documents from the Bill of Materials Tab
From the Project's Bill of Materials tab, you can:

• Upload a new document from your computer or network.
• Copy a document from another Project.
• Create a placeholder document from a document template.
• Add a document already in the Project to the Bill of Materials.

Upload a Document from your Computer or Network

To upload a document into your Project's Bill of Materials:

1. Click Upload at the bottom of the Bill of Materials tab.
2. Click the Browse button and browse to your document.
3. If desired, select a document template to use for your document.

Note:  This is only available if the Project has been created from a Project/template containing
document templates, or if the Project itself has document templates configured.

The template you choose will determine what attributes are associated with the document.

If you don't select a document template, the document will have the attribute category associated
with its document type in the Configure > Document Creation tab of the Project (see Document
Types on page 167).

4. Fill in the attributes associated with the document (at least the required ones).
5. If desired, enter a new Name and a Description for your document.

Note:  If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

6. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.
7. Choose where to upload the document (in the Project's Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you
selected.

8. Click Save.
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Copy a Document from Another Project

To copy a document from another project into your Project's Bill of Materials:

1. Click Copy at the bottom of the Bill of Materials tab.
2. Select a Project (or start typing a Project name) in the second drop-down list.
3. Select a document in that Project (or start typing a document name) in the third drop-down list.
4. If desired, select a document template to use for your document.

Note:  This is only available if the Project has been created from a Project/template containing
document templates, or if the Project itself has document templates configured.

The template you choose will determine what attributes are associated with the document.

If you don't select a document template, the document will have the attribute category associated
with its document type in the Configure > Document Creation tab of the Project (see Document
Types on page 167).

5. Fill in the attributes associated with the document (at least the required ones).
6. If desired, enter a new Name and a Description for your document.

Note:  If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

7. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.
8. Choose where to upload the document (in the Project's Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you
selected.

9. Click Save.

Create a Placeholder Document from a Document Template

To create a placeholder document from a document template:

Note:  This is only available if the project has been created from a project/template containing
document templates.

1. Click New at the bottom of the Bill of Materials tab.
2. In the pop-up that opens, select the document template to use and click OK.

The template you choose will determine what attributes are associated with the document.
3. Fill in the attributes associated with the document (at least the required ones).
4. If desired, enter a new Name and a Description for your document.

Note:  If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

5. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.
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6. Choose where to upload the document (in the Project's Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you
selected.

7. Click Save.

Add a Document Already in the Project to the Bill of Materials

To add a document already in the Project to the Bill of Materials:

1. Click Add to Bill of Materials at the bottom of the Bill of Materials tab.
2. Select the Project document to add to the Bill of Materials.
3. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.
4. Click Save.

Tip:  In the Project's Documents tab, documents that are in the Bill of Materials have a BOM icon  You
can click this icon to see the Bill of Materials.

Add Documents from the Documents Tab

You can add documents that are already in the Project to the Project's Bill of Materials.

To do this, select the document(s) to add and click Actions > Add to Bill of Materials. This adds the
document to the Bill of Materials with a count of 1.

Add Documents from the Upload Page

You can also add a document to a Project's Bill of Materials while uploading a document using the
Upload button. You just need to select Add to Bill of Materials and specify a Count (see Uploading a
Document via Upload on page 591).

Note:

You can only do this if:

• you are an Administrator,
• you are the Project Manager,
• you have the Change BOM permission.

Add Documents from a Workflow

You can add documents to the Bill of Materials automatically using the workflow's Add to Bill of
Materials task.

In the task's Parameters, you can set the documents' Count.

Tip:  You can use a SmartName (for example a document or project attribute) to set the count.
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Here is an example workflow using the Add to Bill of Materials task:

 

 

Tip:  You can use the Select Document task to select all the documents in the BOM (select the
Documents in the Bill of Materials option in the Parameters).

Add Documents from Automation Engine
You can add documents to a WebCenter Project's Bill of Materials using the Automation Engine Publish
on WebCenter task (from Automation Engine 12.1).

When you publish an Automation Engine Product to WebCenter, the Product Properties and
Product/Product Part Parameters will be taken as WebCenter attributes.

If there are existing WebCenter attributes with corresponding names, their values will be updated
during publishing.

The following Product (Part) properties and Product (Part) Parameters are synchronized with
WebCenter attributes:

Automation Engine Properties/Parameter WebCenter Attribute (Internal name)

Product Customer Reference ae.p.cusref

Product Custom Field 1 ae.p.category1

Product Custom Field 2 ae.p.category2

Product Custom Field 3 ae.p.category3

Product Internal ID ae.p.id

Product ID ae.p.prodid

Product Name ae.p.name

Product Description ae.p.desc

Product Part Internal ID ae.ppid

Part Default Angle ae.pp.defaultangle

Part Default Dotshape ae.pp.defaultdotshape
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Automation Engine Properties/Parameter WebCenter Attribute (Internal name)

Part URL ae.pp.url

Part Default Ruling ae.pp.defaultruling

Part Preferred InkBook ae.pp.preferredinkbook

Part Preferred InkBook UI ae.pp.preferredinkbookui

Part Internal ID ae.pp.id

Part Custom Field 3 ae.pp.category3

Part Custom Field 2 ae.pp.category2

Part File ae.pp.file

Part Status ae.pp.status

Part Status Nickname ae.pp.status_nickname

Part Status User ae.pp.status_user

Part Status Notes ae.pp.status_notes

Part Status Date ae.pp.status_date

Part Folder ae.pp.folder

Part Custom Field 1 ae.pp.category1

Part Name ae.pp.name

Part Inks ae.pp.inks

Part Barcodes ae.pp.barcodes

Product Customer Name ae.c.name

Product Customer Description ae.c.desc

Product Customer ID ae.c.id

MyProductParameter1 ae.p.par.MyProductParameter1

MyProductPartParameter2 ae.pp.par.MyProductPartParameter1

When a Product or Product Part is published, corresponding WebCenter documents are automatically
added to the Bill Of Materials of the Project.

The Product Amount for the Job (if given) becomes the Count property of the Bill of Materials.

Removing Documents from the Bill of Materials
To remove a document from the Bill of Materials, select it in the Bill of Materials tab and click Actions >
Delete from Bill of Materials.

Note:  Removing a document from a Project (or moving it outside that Project) removes it from the
Project's Bill of Materials as well.

3.23.5.  How to Search for a Bill of Materials
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Search for Projects that have a Bill of Materials
When searching for Projects using the normal search, you can specify that you only want to see
Projects that have a Bill of Materials. To do this, select Only Projects with Bill of Materials in the Bill of
Materials option.

Viewing the Bill of Materials in a Project Search
When searching for Projects, you can view a summary of the Bill of Materials documents per approval
status for each Project found.

To do this, just select the View (List) option for Bill of Materials on the Search For Projects page. See
Search Result Options on page 557 in the User Guide for more information about displaying search
results.

 

 

In the Bill of Materials column on the Search Results page, you can view the number of:

•  approved documents,

•  force approved documents,

•
 rejected documents,

•  force rejected documents,

•  documents waiting for approval,

•  documents with a paused approval setup,

•  documents without an approval setup,

•  (all) documents,

... in each Project's Bill of Materials.
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Tip:  Click one of the approval statuses' icons (for example pending ) to show the BOM documents
with this status.

3.23.6.  How to See if a Document is Part of a Bill of Materials

In the Project's Documents tab, documents that are part of the Bill of Materials have a BOM icon .
You can click that icon to go to the Project’s Bill of Materials page.

On the Document Details page, the BOM icon  indicates whether the document is a part of a Bill of
Materials. You can also click that icon to go to the Project’s Bill of Materials page.

Note:  A document can be part of more than one Project's Bill of Materials (if it is linked into multiple
Projects).

3.23.7.  Bill of Materials History

You can see all changes made to your Project's Bill of Materials in the Project History.

You can see for example:

• new documents added to the Bill of Materials,
• documents removed from the Bill of Materials,
• changes to a document's count.

3.23.8.  Email Notifications for Bill of Materials Changes

To send email notifications when something has changed in your Bill of Materials:

1. In your Project, go to the Notifications tab and select who to Notify by E-Mail in the Bill of Materials
Changed row.

2. Click Save.

The recipients will get emails when:

• a document is added to the Bill of Materials,
• a document is removed from the Bill of Materials,
• a document's count is changed.

3.23.9.  Working on the Bill of Materials from ArtiosCAD Enterprise

With ArtiosCAD Enterprise, you can see all your Projects and (ArtiosCAD) documents from WebCenter.

If you open a document in ArtiosCAD Enterprise, you can go to the Project’s Bill of Materials and see a
list of all the Bill of Materials documents.

Note:  You need ArtiosCAD Enterprise 12.1 to work with WebCenter Bills of Materials.
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In ArtiosCAD Enterprise, you can:

• change the count of ArtiosCAD files in the Bill of Materials,

• add a document revision (A, B, C...) to an ArtiosCAD file (this is shown in the Version column of the
Bill Of Materials tab, and in the document's Action History),

Note:  When you work with revisions on a Bill of Materials document, the latest version within a
revision is the version in the Bill of Materials.

• add a print item to an ArtiosCAD file (this is shown in a separate column in the Bill Of Materials tab),

• change the order of the Bill of Materials documents.

Once you click OK, this is updated in WebCenter.

Note:  You cannot add a document revision or a print item to an ArtiosCAD file, or change the order of
the Bill of Materials documents from WebCenter.

3.24.  Autonaming

3.24.1.  Autonaming Projects / Documents

An administrator can configure a setup for automatically naming the projects and documents. You can
specify the rules for both Project and Document Autonaming.

Note:  By default, this feature is not enabled.

Autonaming Structure
An Autoname consists of a Prefix, Sux and Counter Length.

A Counter keeps track of the count when a new project is created or when a new document is
uploaded. The Counter Length is the fixed length of the Counter.

For example; If the Prefix is begin_, Sux is _end and the Counter Length  is set to 4, then the
Autoname will be begin_0001_end. The next one will be begin_0002_end.
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Note:

The Project / Document Autonames are generated during the Project creation or Document
submission.

Note:

• The Prefix field cannot be empty. The Prefix and Sux fields are limited to 150 characters for
Counter Length field is 20.

• If the counter length is 0 or left empty, no numeric part will be added to the Autoname. The
maximum characters for Counter Length is set to 20.

Autonaming Projects
You can configure Autonaming for Projects in the following ways:

• Systemwide Project Autonaming on page 468

• Autonaming in Projects / Templates on page 468

Systemwide Project Autonaming
You as an administrator can enable/disable systemwide Project Autonaming.

1. Log in to WebCenter as an Admin user.
2. Click Admin > Preferences > General. The General page appears.
3. In the  Project Autoname Generation section, specify appropriate Prefix, Sux and Counter

Length.
Click  to select required SmartNames. The EditField SmartName can used only in the Sux.

Enable Use Automatic Naming for Creation of Blank Projects to apply the autoname generation
settings for projects created from a blank template.

4. Click Save to make the changes.

Autonaming in Projects / Templates
Use template based Autonaming setup to apply automatic naming to the Projects created from a
Template or another Project.

Note:  If you setup Autonaming in an existing template, only the future Projects will be named
automatically.

Note:  When you setup Autonaming in a template, only the future projects will be named automatically.
It does not alter the existing Projects created from the same template.
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1. Log in to WebCenter as an Admin user.
2. Click Admin > Project Management > Projects or Templates.
3. Choose the Project or Template and go toConfigure > Project Creation tab. Enable the Use

Automatic Naming option. Then select:

• Use Custom Automatic Naming to specify an automatic naming setup just for this Project or
Template.

• Use Default Automatic Naming, if you have configured Systemwide Project Autonaming.

You can apply the same settings by selecting the Use Default Automatic Naming option.
4. If you select the Use Custom Automatic Naming option, you have to enter the text boxes with

appropriate Prefix, Sux and the Counter Length.

Note:  Click  to select required SmartNames. The EditField SmartName can be used only in the
Sux.

5. Click Change to make the changes.

Systemwide Autonaming for Different Document Types
The administrator can set up the document Automatic Document Naming settings per Document Type
in the following ways:

• System-Wide Document Autonaming on page 469

• Template/Project-based Document Autonaming on page 470

System-Wide Document Autonaming
The administrator can set up the document Automatic Document Naming settings per Document
Type.

The options available are None or Custom Automatic Naming options. The Custom option allows you to
customize the required autoname setup.

The option Apply Automatic Naming to Documents in Blank Projects allows you to setup autoname
generation for blank documents also. The Apply Default Attribute Categories to Documents in Blank
Project option allows you to add the default attribute category to documents which exits in blank
projects. For example: If you upload abc.ard file and the Prefix is [FolderName] the Counter Length is
set to 4 and the Sux is empty, then the autoname will generated as DESIGN_0001.ard.

Using the Scope of the Counter option the administrator can specify whether the counter will
continue counting system wide, or whether it will reset for every project.If the option Reset per
Project is selected then, autoname will be generated as begin_0001_end and next document will be
begin_0002_end and so on.

If System wide Counter is selected and files already exists, autoname will be generated as
begin_0098_end and next can be begin_0112_end. The counter here depends on the number of files
which are uploaded to the system and not on each of the project.

1. Log in to WebCenter as an Admin user.
2. Click Admin > Preferences > Document Types. The Document Types page appears.

• Select the Apply Automatic Naming for Creation of Blank Projects check box to apply the
autonaming setup to the Projects created from blank template.
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3. Set the corresponding Automatic Document Naming field to Custom.. Read more in:Document
Type Preferences on page 105
a) Specify a Prefix, Sux and the Counter Length. Read also: Autonaming Structure on page 467
b) Specify the Scope of the Counter.
c) Optionally, you can enable File Extension Specific Counter for autonaming. This will make sure

that you have different counters for different types of documents.

If the option Reset per Project is selected, the Autonaming will be reset in every project and the
counter depends on the documents uploaded to any single Project.

If System wide Counter is selected, the Autoname will be generated counting the existing files (for
example: begin_0098_end). The counter here depends on the number of files which are uploaded to
the system and not on each of the project.

Note:  Click  to select required SmartNames. The EditField SmartName can used only in the Sux.

If you upload abc.ard file to the folder Design where the Prefix is [FolderName], the Counter Length
is set to 4 and the Sux is empty, the name of the document would be DESIGN_0001.ard.

4. Click Save to make the changes.

Template/Project-based Document Autonaming
• Template/Project-based document autonaming: The administrator can set up the document auto

name settings per document type on the Document Types page. The Document Types page allows
to enable/disable specific document types and is extended to also have a section for setting auto
naming details per document type. The administrator can specify Prefix, Sux and Length for each
of the Document Types available.

Note:

Only newly uploaded documents will have the correct auto naming settings applied to them.

When the option Apply automatic naming to Documents in Blank Projects is selected, the default
settings will be used when uploading documents in projects which are created without a template.

 

 

Using the Scope of the Counter option the administrator can specify whether the counter will
continue counting system wide, or whether it will reset for every project.

If the option Reset per Project is selected then, autoname will be generated as begin_0001_end and
next document will be begin_0002_end and so on.

If System wide Counter is selected and files already exists, autoname will be generated as
begin_0098_end and next can be begin_0111_end. The counter here depends on the number of files
which are uploaded to the system and not on each of the project .

The SmartName [Project Attribute] and [Document Attribute] contains an extra option. When
selecting these options, an extra drop-down appears to select the attribute. It is advised to set
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such attributes required in the creation view of the attribute category, else this part of the name
will remain blank.

Note:  Changing or modifying the attribute value after creation of the project or document will not
change the existing name.

1. Log in to WebCenter as an Admin user.
2. Click Admin > Project Management > Templates. The list of available templates appears in the

Template Management page.
3. Click one of the required templates and then click Configure > Document Creation. The Document

Types page appears.
4. Select the required Document type and then in the Automatic Document Naming section choose

between None, Default or Custom options.
a) If you select the None option, the autonaming option is not selected.
b) If you select the Default option, the setting as per System wide Document Auto Naming

Settings are taken into consideration.
c) If you select the Custom option, you can enter the text boxes with appropriate Prefix, Sux and

the Counter Length. The Scope of the Counter specifies whether you want the counter to work
on all the documents in the system, or only to work on the documents of the project when a new
document is created.

Note:  Click  to select required SmartNames. The EditField SmartName can used only in the
Sux.

The SmartName [Project Attribute] and [Document Attribute] contains an extra option. When
selecting these options, an extra drop-down appears in which an administrator can select a
required attribute.

5. Click Save to make the changes.

Note:  When the Document Autonaming settings for a Template are changed, these are not applied to
all projects already created from this template.

Using SmartNames in Autonaming
You can use SmartNames to set the prefix and sux in AutoNaming.

The SmartNames list contains general Project information and all the Attributes defined in the system.
You can use several SmartNames or a combination of SmartNames and free text.

Note:  To know more on configuring project information see Project and Document Attributes on page
303.

• Click the Insert SmartName button  and select a SmartName from the list that appears next to the
button.
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If you select:

• [Project Attribute],
• [Document Attribute],
• or [Project Creation Date],

you will get another Select to append a SmartName field in which you can select a required
attribute.

See below some examples of SmartNames in Autoname Generation:

 

 

The result will be, for example: Chicago_23.12.12_0001_printpromotion.

 

 

The result will be, for example: CAD_0001_printpromotion_Chicago.

Note:

• The [EditField] SmartName can used only in the Sux and if required, the administrator can edit
this field. If the [Edit Field] is empty, then it is not replaced by any text, but left blank.

• Ensure that you do not use square brackets [ ] for other fields. The system will take it as a
SmartName.

• You can use several SmartNames if desired, or a combination of SmartNames and text.
• If a SmartName is selected and if it is empty or not found, the field will be blank in the Autoname.
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3.25.  Program Management

3.25.1.  Introduction

Many Brand Owners are tackling large, complex packaging programs (campaigns) which span across
packaging ideation to delivery of individual packaging to specific markets. Typically these efforts
involve several parallel and sequential projects. While a packaging project involves dealing with a
relatively short-term objective, a Packaging Program (Campaign) is much more complex and deals with
several short-term and long term objectives and requires a large pool of resources.

Accomplishing a program’s objectives involve planning and conducting a number of related projects,
multiple work streams with their own requirements and planning, the results of which are components
of the overall outcome.
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3.25.2.  Program Management Related Components

WebCenter has features to specify components, create a group of projects in a Program hierarchy and
modify them as needed.

WebCenter Program management offers:

• Component definition and approval

• Creation of Child Projects under the hood of a Program

• Ability to attach (and remove) existing projects into a Program

• Communication between the Program and its Projects.

• Features to support multiple levels: for example, a Project/ Grouping /SKU/Component.

• Shared Projects and Components among different Programs
• A Program Overview with drill-down  and Dashboard. The program overview will provide the status

and risk indicators.

Definition and Approval of Components
Program planning may require multiple iterations and produce multiple work products and
components. As a first step, you need a Program (Parent Project) setup which describes the outline,
rationale, launch criteria, important dates and involved regions and suppliers. The second part deals
with the individual or child projects within the Program which are entirely dependent on the products
and component planning.

Defining Products and Components in the Briefing Phase
To start a Program with new Products and Components, the Program Manager can use a placeholder
document(Document Templates on page 162). To define existing components, just refer to them
as Document References on page 363 or copy them to the current scenario. You can source the
components from existing libraries, contextual saved searches, or from a previous program.

If you have configured a duplicate action, the user can easily create a copy of the component (for
example, variants) including its meta-data and document references values.

See the example below. The following structure can be built into your Program Template using its
Attribute Category's document sources.
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For example, when you initiate a Program for multiple SKUs, you can use Document Templates for new
SKUs. The Products can keep common approved Components as document references. Using the
document reference table, you can:

• Define products and components along with their master-child relationships,
• Easily duplicate a Component with its meta-data
• Process them through an approval process if needed

 

 

See details about how to create Projects based on these documents in Adding/Creating Projects in a
Program on page 476.

 Create Components

To streamline your Program's product and component definition, follow the steps below:
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• Create an Attribute category for the Parent Project Template with document references and other
Attributes.

Note:  Read more about shared Attributes in: Create a Child Project on page 479.

• Add Document References to the Program Template's Attribute Category.

• Define Document Sources for your Documents

• Define how these documents should appear in the Template

• Configure duplicate option in the rendering of the document references

Adding/Creating Projects in a Program
Once you have defined a Program or Parent Project with components, you can add multiple Child
Projects as members in a few ways. You (as an admin user) need to configure actions in the menu for
any of these options to become available.

You can:

• Create Projects individually based on a Child Project Template.

This provides an interactive way of creating a child Project from the Program context. If you
have common Attributes configured in both the Program and Child Template, they can be shared
between the Parent and Child. For example, Program's Attributes such as milestones set in the
Program and Role setup.

The administrator has to configure a Create Child action for a Program Manager.

The Child Project Template can have Attributes and documents that are not shared with the
Program.

Note:  The Child Projects are independent WebCenter Projects that can have their own planning,
workflows, folder structure etc.

Read more in: Create a Child Project on page 479.

• Create Projects using a workflow.

You can use workflow to create multiple Child Projects in one go. You can either add this step into a
workflow or create a dedicated workflow action in Project details page.

Tip:  Create a custom workflow action for Project detail and apply it to the Program Manager's menu.
You can then select multiple documents and launch a workflow. You can use this more than once if
you want to launch your Program in waves.
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• Add an existing Project.

You can add existing Projects to a Program. For example, you may want to use an approved SKU-
project in a Program. The Attach action lets you select and add an existing Project as a child.

Read more details in: Attach Project Action in a Program on page 480
• Create a Sibling Project. Create sibling action allows you to copy the setup from your existing Child

Project to create exact replicas or variants with slight modifications. For instance, after creating
component Projects, you may see that you need an extra component with the same requirements.

It is possible to modify some Attributes after creation of a variant. Or you can disable copying of
some elements by unchecking them. The options are the same as in Create a Project Based on
Another Project on page 789

This action will be used when creating variants of the child project.

Note:  All these actions are configurable and you can configure the actions that are most relevant in
your Program-Project hierarchy.

Notes
• You need Change Property rights (in both levels) to establish a relationship between parent and

child.
• A project can have multiple children and can have multiple parents.
• All relationship changes are logged in the Project history.

Configure Create Child Action in Program's Details
As an Administrator user, you can customize the Project Details actions to include a Create Child
Project action.

• Go to Admin > Preferences > Menu > Actions > Project Details > Project Header.
• Select the Menu you want to edit.
• From the Action Gallery, drag the Create Child Project to one of the Custom boxes.
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Read more in: How to Create a Custom Action Button on page 121
• Edit the settings of this Action. You can customize this to suit your needs. See more in: Action

Settings on page 119.
 

 

We recommend that you do the following optional steps:

a) Select the users for whom you want to make this Action Visible To. In the example, this Action is
set only for Project Managers.
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b) Select a Child Project Template. This will be the Template that will be loaded when a Project
Manager (user) click on this action.

Note:  If a Template is not specified in this action, your user can:

• either select a Template that is available in the system
• or create a Project without a Template

c) Specify a Project Visibility characteristic.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics
for your custom menu items as well as the default ones.

2. Select the specific Characteristic in the Project Visibility field of the action. You can select
this from the drop down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.
• Save.

Create a Child Project

To create a new Project as a child project of a Program, you (admin) can configure a  Create Child
Action in the Program. Once configured, the Program Manager and the Project Members will be to
create Child Projects in your Program.

The Child Projects inherit the  attribute values, role assignments and company information from the
Program, and they can have their own set of attributes and workflows.

The Project creation uses the Template configured in the menu.

For example, if the custom action links the template “Child Project Template”, then this is used in
creating the child Project.

The child inherits most of the setup from the Template except the values of:

• Company / Location

• Attribute Values

• Role Assignment
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Note:

• The Attribute categories are inherited from the Template (used to create the child Project) and the
values of the common Attributes (present in both Parent and Child Templates) will be inherited from
the parent.

Note:

• If a common attribute has an empty value in the Parent, the value will be taken from the Child's
template.

• Similarly, the Roles are taken from the Template but the assignment of the Roles will be taken from
the Parent. If the Roles are not assigned in the parent, the assignment will be inherited from the
Template.

Caution:

If the Parent and the child Project's template have different role assignments, the
assignment of the parent project is taken.

• If a Template is not specified in this action, your user can:

• select a Template that is available in the system.
• or create a Project without a Template

You can have a document source with a SmartName search to point to the parent Project

Attach Project Action in a Program
To add Projects to a Program, you need a Saved Search configured in your Program to list 'related'
Projects.

The administrator can specify the Saved Search that should be used to search and find these possible
child projects.

To create a custom Link Existing Projects Action in the Project Details (of the Program), follow the
steps below:

1. Go to Admin > Preferences > Menu > Actions > Project Details > Project Header.
2. Select the Menu you want to edit.
3. From the Action Gallery, drag the Link Existing Project to one of the Custom boxes.

This Action is available in Project Search Results by default.
4. Edit the settings of this Action. You can customize this to suit your needs. See more in: Action

Settings on page 119.
a) Select the users for whom you want to make this Action Visible To. In the example, this Action is

set only for Project Managers.
b) Select a Saved Search. This will be the displayed in the pop-up to select a Project.

Specifying a Saved Search (for example, based on common attribute values) in the Attach action
allows you to configure a pop-up dialog with the most relevant projects.

c) Optionally, specify a Project Visibility characteristic. Select the specific Characteristic in the
Project Visibility field of the action.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.
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As an administrator, you can switch this on and off in the Project Details > Characteristics page.

In the Program's details, you can use this Action to select Projects (from a Saved Search) and add to the
Program.

Add Sibling Projects

If you want to clone a Child Project within the context of a Program, configure the Create Sibling
Project action in the Project details page.

You have to configure the action in the Child Project Details and make sure that it is applied to the
Project Managers' menu.

The cloned sibling will be a copy of the child Project from which the action was started and it will also
have the same Parent Project.

Notes
• If the child Project has multiple parents, the cloned Project inherits all the parents where the

Project Manager has “change property” permissions.
• In the original parent project, an entry in the action history is added to indicate that the new project

was added as a child.

Create a Sibling Project

1. Click the Create Sibling action button from a child Project of your Program.
2. In the Copy setup from an Existing Project pop-up, select what you want to copy (and deselect

what you don't want to copy).
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For Tasks, you can choose to copy the Tasks from the original Project or from another project by
typing in the template name. The default setting is to copy Tasks from the Project that is being
copied.

Click OK.
3. Fill in the new project's Details.
4. If desired, add Documents to the project.
5. Add Members to the project.
6. If the template has attributes defined, fill them in the Attributes section.
7. Click Create.

This brings you to the new project's details page.

Creating a project adds an event and this is stored in the Project History.

This event will add following information to the Project History:

• The Project/Template from which the new Project is created.
• The name.
• The Project Manager.
• The Salesperson (if there is any).
• The Customer (if there is any).
• The Location (if there is any).
• The description (if there is any).

Note:  When a project is created from a template or an existing project, then only the changes
(like deletion of attribute values or adding a new document) from the template or existing
project is logged in the events.

Remove Projects from a Program
You can configure and use Detach and Delete actions in a Program.

• If you want to remove child Projects permanently from the system, select them in the child Projects
tab of a Parent Project and click Delete action.

• To remove some child Projects from a Parent, use the Detach action. This action removes them
from the parent, but does not delete them from the system.

This is a configurable action that has to be set up in the Saved Search displaying child Projects. Read
more in: Detach Child Projects on page 259.

Detach Child Projects
You can configure Detach Child Project(s) operation in a Saved Search. Program Managers can use
this in a contextual Saved Search configured in the Parent Project's details. The use case is that the
Project or Program Manager can select existing Child Projects displayed in the search tab and detach
them from the Parent Project.

Note:  The action is only available to the users with Change Permissions of the parent and child
project.

• Create a global Saved Search to search on child Projects. Enable the Search Result Layout option
Allow Detaching Child Projects.
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• Apply the Saved Search into the Project Details menu of the Parent Project Manager.
• To detach child Projects, go to the Child Projects tab with the saved search, select child Projects

and click Detach Child Project(s).

Program Dashboard with a Drill-down View
You can also build different types of overview on on-going programs as a way to easily monitor
your Program and Projects. The solution allows you to build overviews at all levels of your Program
hierarchy.

The admin can create searches with any relevant criterion and use them in different levels of the
Project drilldown.

To build a high level overview, use the following advanced the Saved Search features:

• Drilldown

• Dashboard

The drill-down feature allows you to quickly access the specific Projects or Components that require
special attention.

Drilldowns
You can use Project search based drilldowns to set up a:

• Drill-down into all levels of Projects. This feature allows the Program Manager to explore project
data beyond the overview. If you have a nested structure (Project / Grouping / SKU / Components) in
your Program, an expand button lets you access the next level.

• Drill-down into Components (documents) or Tasks

Read more in: Configuring a Drill down Search on page 243

The example screenshot gives an overview where the Program Manager can quickly zoom into
Programs based on their status (which in turn is based on the status of their child Projects).
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1. The parent Search with Programs. This example shows a Search Results Dashboard on page 244
with counters.

2. The second level of Drilldown which executes the Saved Search specified in the parent search. This
search contains a Dashboard with a Facet Graph.Configuring a Drill down Search on page 243

3. The third level of Saved Search with a Document Search.
4. The expand button to execute the drilldown.

Dashboards
The interactive dashboards can be configured with:

• Counters.

You can, for example, build a diagnostic overview of the status of your Program using counters. You
can, for example, show the Project Statuses in these trac light counters ( at risk, in delay, or on
track). With a simple click on one of these counters, you can zoom into the relevant Projects.

In the example above, a click on the “On Track” counter will display the search results for specified
in the counter configuration. The status is only an example, you can build your counters based on
any relevant Attribute that you may want to monitor. Each counter has it's own saved search and
displays the count of the results.

Read more in: Building a Search Based Counter on page 248.
• Charts to visualize your Program data.

You can configure facet based Charts in dashboards and use them in your Program hierarchy to
visually display the Program data. The Charts(based on facets) shows the distribution of values.

A simple click on a chart section(value) will refine the results. In the screenshot, the counters
provide the most high level overview where as the first level drill-down displays a pie chart which
shows the distribution based on Project Status.

Overview from Programs and Projects
In addition to the overview of all Programs and their drilldowns, you can also configure contextual
saved searches for your Parent Project Details menu. If you are a Program Manager working in a
Program's details page, you may need direct access to the child Projects. Likewise, from each of the
Child Project, there should be access to the parent or Program.

To configure this:

1. Create a Saved Search for Parent Projects. Similarly, create another Saved Search for Child Projects
and plug this into the Parent's Project Details menu.

Tip:  Use SmartNames to use Saved Searches in the context of a Program or Project. If you set the
Parent Project as the [Project id], your results will list all the Child projects of the current project.
See more in: SmartNames in Search on page 238

2. Plug these searches into Project Details menu and apply it to the relevant users (Program Managers
and Project Managers).

Communication Channels-Rules
Since the projects are children or sub-projects of the overall program (campaign), there is a need for
communication among all levels, program to projects, projects to program and among projects. The
updates happening in a program have mutual consequences and therefore should be communicated in
both ways. You may want to setup the following channels:

• Alert the parent or a related project about a new deliverable
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• Alter the status of a related Project depending on another
• Notify Program when a child Project encounters change: a status update or metadata change.

Rules in Programs and Projects
The Administrator of the system can configure "actions" "triggered" by an "event". These are Rules that
can be specified in the Program/ Project's templates. Rules enable you to start tasks automatically
based on events in your project.

The triggered actions will be implemented in the Program or Project specified in the attached
"action"(Task based Action). You can use the JavaScript node in the Task to execute these actions.

The configuration of the Rules is based on Program/Project Template and therefore, once setup, can
be reused (or exported) in future Programs.

See some examples of Task based Actions below:

• If a child Project's status changes to Overdue, change the status of the Program to At Risk
• Change attribute values in a Program based on the values in the child Project
• Calculate task overdue status every hour and send reminders

The JavaScript node allows you to enables you to update crucial parameters of related Projects. See
details in the Workflow section.

Configure Rules in a Project

What is a Rule?
You can configure a Rule to execute specific Actions based on one or more Trigger events. The Rule
sets reside in Project Templates and will be applicable in all Projects created from them, including the
previously created ones. This administrator feature lets you establish communication between Child
and Parent Projects or between any two Projects. See an example use case at the end of this chapter.

Note:

You need the WebCenter Task Management Advanced or WebCenter Life Cycle Management license
to be able to define Rules.

To set up Rules, go to Project Template > Configure > Rules Setuptab.

Note:  Although Rules are configured within a Project Template, you can create Rules that are
triggered after the project is created from the template.

Triggers
A Trigger is an event that happens in the system (for example, the Child Project Status changes to
Completed). A successful Trigger condition will execute a Task based Action.

You can specify multiple triggers and actions in a Rule. When one Trigger event(as specified in the
Rule) happens, the system evaluates the Rule and executes the corresponding Action(s).

See the supported Triggers below:

• Project Status Change: The Action is executed when the Project Status changes.

• Project Attribute Change: The Action is executed when the specified Project Attribute changes.
You can specify the attribute from a drop-down.

• Project Due Date Change: Any change in the Project Due Date will trigger the specified Action.
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• Date/Time Reached trigger lets you define an exact time stamp to execute the Rule. When the
server time passes the Trigger time, the Rule will be executed. There are 2 options:

• Specific Date: the actions will be executed on the specific date and time
• Date in Project + Offset: the actions will be executed on the selected Project Due Date or Date/

Time attribute plus or minus an offset of days and/or hours.

Note:  The calculation is done in working days/hours.

Actions
• Start Task: This action launches a Task in the same Project where the Rule is configured. Specify

the Task by selecting it from the drop-down.

• Execute Javascript: This action launches a specified JavaScript Rule Action. You can specify one
from the Javascript Rule Actions configured in the system.

It is possible to configure multiple actions by clicking on the ‘+’ sign. Use ‘x’ to remove existing actions.

Example

See the example of a Project Template's Rule below. This Rule gets executed when the specified
Date/Time Reached.
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The Javascript Rule Actions are configured in Admin > Project Management > JavaScript Rule
Actions. See the example script below.

var children = API.getProject().getChildProjects(); if(children.length >
                    0){ var atRisk = false; var inDelay = false; for(var i = 0;
                    i<children.length; i++){ var child = children[i];
 if(child.getStatusName() !=
                    'Completed'){ atRisk = true; } else if(child.getStatusName() ==
 'Non-active'){
                    inDelay = true; } } if(atRisk){ API.getProject().getAttribute("mvbe
 Campaign
                    State").setValue('At risk'); } else if(inDelay){
                    API.getProject().getAttribute("mvbe Campaign State").setValue('In
 delay'); }
                    else { API.getProject().getAttribute("mvbe Campaign
 State").setValue('On
                    schedule'); } } 

Two days before the milestone, this Rule will get executed. Depending on the child Projects'
statuses, the Program Project's status will be updated.

3.26.  Color Trace Solution

Color Trace structures the collection of color specifications, communicates it automatically to the
supply chain and returns a scorecard of each job. Automation and standard procedures ensure that
reporting is created with integrity, scoring the actual production against realistic specifications.

This solution is built by integrating the capabilities of software and cloud applications including
Esko Cloud, PantoneLIVE, Color Pilot, WebCenter, WebCenter Connector (for Adobe Creative Cloud),
Automation Engine, ColorCert and ColorCert ScoreCard Server. Most parts of this solution are
automated with workflow tasks and has the flexibility to allow you to do custom updates as required.

Detailed description of WebCenter parts can be found in the following pages.

1. Configure Cloud Connection in WebCenter
2. Configure Color in WebCenter
3. Import Deployment Package
4. Workflow Nodes that perform various automated tasks for Color Trace in WebCenter

• Color Preflight

• Create ColorCert Job

• Save Document Colors in Attribute

• Create Graphics Placeholders on page 914
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3.27.  Packaging Content Management in WebCenter

3.27.1.  Introduction to Packaging Content Management in WebCenter

WebCenter Packaging Content Management offers a simplified platform for creating, translating,
approving and managing text / copy assets.

The Packaging Content Management module offers:

• a repository / library for your text content with GS1 tagging
• re-use of your content across multiple projects
• support for a translation based or single language workflow.
• export to and import from industry standard formats
• ability to view and edit your text in the context of your artwork in the WebCenter Viewer.
• a complete approval workflow
• established content rights facilitating the ownership at different stages

3.27.2.  Basic Concepts

Text Document and Text Elements

Text Content Document
The WebCenter Text Content Document (WebCenter Copy Content) is an XML file that contains:

• Text that goes on Artwork. This includes the master text and the translated versions.
• Approval states
• Clearly defined ownership rights
• Element Types

A Text Document is a WebCenter Document Type and can have:

• Revisioning
• The documents are housed in projects or libraries (for re-use)
• Attributes
• Can be streamed through a workflow
• Download rules
• Document references from other documents. For example an artwork can refer to various text

content documents.
• Text Content Template. Read about it here Text Document Template on page 491

Text Content Statement
A Text Content document has two elements: the Master text and its translated statements. When a
Text statement is specified as the Master, it needs to be approved before approving the translation.
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The Master and Translation Statements can be viewed together.

Text Content / Table Ownership via Permissions

Text Content Ownership
offers established ownership for different phases of the text and table creation and the approval
process. You have four default content permissions:

• Content Manager
• Editor
• Approver
• Add Language

These permissions, when mapped to the WebCenter roles, allows their assignees to perform specific
functions on the document.

Note:

• To configure these permissions, the project manager needs to assign at least the Content Manager
rights to a relevant Role.

For example, you can configure a Role, Marketing to have the Content Manager function.
• The Content Manager can then activate the Editor, Approver and Add Language permissions by

assigning them to relevant WebCenter roles.

If you do not assign a role to a specific permission, the specific permission will remain inactive for
the document.

• The permissions are set at each text/table document (.wcc or .wtc ) level and will be passed on
along with the document and its versions when copied or moved.

• It is not possible to add custom permissions.

Four Types of Permissions
1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process to
ensure accuracy and compliance. For example, the role Marketing could have this permission where
the Marketing has the responsibility of the packaging content. The Content Manager will manage
the Master and Translated statements.

Note:  The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note:  Content Manager Role cannot act as an Editor or Approver unless this permission is granted
to the same role.

2. EDITOR

The Content Manager typically assigns this right to the dedicated roles who will create, edit, revise
or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.
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Note:

• The Content Manager Role has to configure the list of translation languages to make use of
multiple language based Editor permissions.

• You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also be
configured per language. The approver puts the Text Statement to Signed-Off or Rejected state.

4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document. The
users can be assigned with permission to add only specific languages.

 

 

_REQUESTOR Role
To create new Text/Table Documents, edit, approve or to reuse content during the Project Creation
phase, you need to grant the relevant permissions to the _REQUESTOR role. You can give these
permissions in the libraries of Text/Table Document Templates, or Projects with approved Documents.
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Delegation of Approvals in Text Content and Tables
An user can delegate his WebCenter tasks to another user. The delegated user can perform all actions
on behalf of the delegator. When the delegate approves text or table content, the password validation
is done on the delegate's password.

When a user has logged in on behalf of another user, and approves any text or table content, the
same can be viewed by clicking Approval Info in the ellipsis. Alternatively, it can also be viewed in the
Document > Action History.

Text Document Template

Text Document Template
An Administrator or Project Manager can create Text Document Templates using which the users can
generate new text documents.

You can create a Text Document Template with pre-configured:

• Element Type
• Master and Translation Languages
• Approval Setup

These templates can be later reused as Document Sources.

Note:

It is not possible to create Text Documents without configuring the Document Templates and
Document Sources.

When configuring a text document reference for a Task / Project Template, you have the option to
specify document sources. These are buttons that will allow you to create, or link, or copy or reference
documents in their respective documents tables.

Text Content Validity
Text statements may get obsolete over a period of time and to avoid using the redundant statements,
set a validity date for the content. A warning message is given when the statements are no longer valid.

To set up the validity for Text content, add the Date time attribute EXPIRY_DATE to the Attribute
category of the content document.

A warning message is shown for a document as Expired,  when either of

• the current document or
• it's smart reference at any level has expired.
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For example, let us assume there are three documents named Doc1, Doc2, Doc3 and Doc1 references
Doc2 and Doc2 reference Doc3 .

In this case, Doc1 is considered as expired, if any of the documents out of Doc1, or Doc2, or Doc3 is
expired.

 Text Content Element Types

Text Content Element Type
WebCenter uses the Element Types concept and terminology from the GS1 standard to categorize
the Text Documents. The Text Content Element Type categorizes the documents and maps to the
WebCenter Content Types.

See the Element Type categorization below.
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It is possible to add custom Element Types other than GS1 types. Read more in Configure Element Types
as a List on page 499.

These are used when extracting Dynamic Content into WebCenter as well as exporting the artwork's
GS1 XML.

Text Content Translation
You can configure workflows to draft, translate and approve text in this module. To translate Text
Elements (statements), in a translation software that uses XLIFF content (e.g. Trados or SDL), you can
export them in XLIFF format. To do the review and final approval, you can import the translated content
back in the same format.

You can either:

• automate the export-import process using the Workflow nodes
• or use actions to manually export an XLIFF file and later import it back.

Note:

XLIFF is an industry standard format used in the industry to exchange data in a translation project.

Invariant Text Document
If translations are not required, the Content Manager can specify the Document as an invariant to avoid
translating a Master statement. For example, a Text Document containing the Brand name.
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You can set the Invariant status on a Text Document or Template.

Documents marked as invariant can have only one master language and are no longer considered as
invariant if there are more than one master language

Note:  Invariant content which existed prior to 18.1 and which has more than one master language will
become non-invariant.

See: Text Content Tab on page 993

Inherit Content
Whenever a new language is added to a Text content document, it is easy to follow the contents of
either the master or translation language that already has the content. This could also prove very
useful in cases where the two languages have mostly similar content like English-International and
English US.

To inherit content for the text statements in your document, Allow Inherit Content option has to be
chosen in the Configure Content in Text Information. When this option is enabled, you can choose to
either follow the Master Language or Default to the element type choice or choose None.

You can choose

• None to follow language, but no language is selected by default at the text content element level for
the newly added language.

• Default to follow the language in the language list. If no language is defined in the language list,
then None is selected at the element level. Language lists for Master and Translation languages are
configured initially when setting up the content management. To know more, read Configure Master
and Translation Language Lists and Attributes on page 501

• Master Language to follow the master language in the element widget.

Note:  Irrespective of the option chosen at the content configuration, you can still change the
option at the element level.

You can choose to inherit only the SmartText content, when you want to inherit the content
from another language. While inheriting, if the text in the source language contains plain text or
SmartName, then the text in the target language are cleared but still follows the source language. List
of allowed special characters are maintained in SMART_INHERIT_WHITELIST. Only the characters
mentioned in this list are allowed with the smarttext.

Note:  If the SMART_INHERIT_WHITELIST is not available, then the default whitelist is considered.

Text Approval
The Packaging Content Management module offers separate approval processes for the Master and
its translations. All the Approval information with regard to the Master and Translations stay within the
Text or Table Content Document.

Note:  This approval process is different from the regular WebCenter approval process.

The Approval process starts when a content Editor starts approval on a text statement or a table
element.
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When you have configured the right permissions, the users who has the Approver permission can
perform the approval actions. To automate the approval, you can configure manual tasks in a workflow
and assign them to the relevant Roles.

Once approved, the master and the translated text remain locked for the regular users.

Note:  Only the Content Manager has the rights to change the text element to draft.

The text element can be in one of the following states:

• Draft: The initial state of the Text Document where the content is still being worked on.
• Pending Sign-off: When drafting is complete, and the status is ready for its approval cycle. An

approver can review and approve or reject the document.
• Signed-off: When the approval cycle is completed and the content drafted in the document is

‘Signed Off'.
• Sign-off Rejected: When the approval cycle is completed and the content drafted in the document

is ‘Rejected'.

Note:  Approver will be requested to re- enter the password before approving or rejecting any text
content document, provided the option is enabled by the Admin user.

Approval Types
Content Managers can set up the Approval Type for Text Content Documents. There are three Approval
Types:

• Default: Only one member has to approve. For example, if the Approver permission is assigned to
two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member or
user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there is
an individual User, then he or she has to approve as well.

Dynamic Content in WebCenter

Dynamic Content- Linking with Adobe® Illustrator®

Esko's Dynamic Content for Adobe
®

 Illustrator
®

 brings the power of XML-based automation to Adobe
®

Illustrator
®

 CS5, CS5.1, CS6 and CS7 on Mac and Windows.

Dynamic Content helps designers to be more ecient and win client confidence by minimizing the
errors. By eliminating the process of copying and pasting the ‘revised text’, this minimises the errors.

In a typical case, the designer creates a design in Adobe Illustrator with “placeholders” for text
content. These are tagged with appropriate GS1 Element Types (Content Types). You (brand owner) can
process and approve the corresponding text content (with Element Type tagging) in WebCenter.

Dynamic Content can keep this link active and import the dynamically tagged content into Copy sheets.
The edited and approved content can be exported back in GS1 format.

Why Dynamic Content?

Esko Dynamic Content allows packaging designers to add externally maintained content elements such
as legal copy or nutritional information to a packaging design. This solves an increasingly common
problem in the designer's day to day work: human error in copied content.
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The ever growing number of stock keeping units that are brought onto the market by brand owners has
resulted in an explosive growth in the volume of artwork that needs to be created for all the packaging
of each unit. At the same time, the designs themselves become more and more complex in their
competition for the consumer's attention.

Many designs share pieces of content. Some content is mandatory, required by regulatory instances
such as the FDA, EMEA, or national bodies. Other content simply recurs on different variants of a
shared design.

The end result is the same: an increasing number of human interactions, often of the "copy-paste"
type, that at the same time increases the risk of errors slipping into the design. Errors in artwork are
wasteful, generating rework, delays in product launches and sometimes even requiring product recalls.

 

 

Benefits of Using Dynamic Content

The Dynamic Content plug-in helps automate the insertion and updating of externally maintained
content into a design. This prevents a number of common problems, and it saves valuable production
time by eliminating repetitive manual tasks.

Some typical problems prevented by a Dynamic Content workflow:

• Typing errors;
• Wrong versions of copy text or barcodes are used in the final design;
• Cut-and-paste errors (e.g. when copy text is provided in a Microsoft Word document or PDF, and the

designer has to manually copy this into the Illustrator document);
• Text overflows;
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• Shared elements on design variants are not synchronised.

Because Dynamic Content allows you to keep this mandatory or shared content separated from the
Illustrator document, it also eliminates repetitive and time consuming updates: simply modify the
external XML file to update the text, barcodes, and nutrition tables on the design. Review cycles have
never been this easy.

A Typical Workflow in Dynamic Content

A typical Dynamic Content-based design workflow includes an exchange of information between brand
owners and designers. Often, the content to be used in a design will change multiple times during the
design and production process, and it is in these cases that Dynamic Content will prove its worth.

A sample workflow for the use of Dynamic Content could be the following:

Stage Description

1 The brand owner’s marketing department draws up the text that needs to appear on the
packaging design. The text is entered into a PDF form or a content management system,
which can export an XML file.

2 The brand owner sends the PDF form or XML file containing the text to the designer.

3 The designer produces a packaging design in Adobe Illustrator and links the text elements
from the XML file to text objects in the Illustrator template. In the GS1 workflow, the
designer can generate the "Response" XML and send it back to the brand owner. This
Response message tells the brand owner what items were used in the artwork and how
many times.

4 Later, the brand owner makes changes to the text, produces a new XML file and sends this
to the designer.

5 The designer replaces the original XML file on his disk with the new version. Dynamic
Content automatically detects the changes, and immediately alerts the designer. It clearly
shows exactly what has changed, and where.

6 Based on the alerts displayed in Dynamic Content, the designer can very quickly accept
automatically updated text, or make any required formatting changes. There is no need for
copying, pasting, or any other manual and error-prone operations, and Dynamic Content
alerts the designer to problems such as text overflow.

7 Thanks to Dynamic Content, stages 4 - 6 can occur repeatedly without losing time or
introducing errors.

XML Basics

XML stands for Extensible Markup Language, and it is a markup language similar to HTML. However,
where HTML describes the layout of a web page, XML markup describes the contents and the structure
of a document.

Below is an example of a basic XML document:

<?xml version="1.0" encoding="UTF-8"?> 
<body> 
<p> This is a very cool product! </p> 
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</body>

XML documents are often used to exchange data or textual content.

In the context of the Dynamic Content plug-in, XML is a useful format because:

• it separates content- the text itself- from layout and presentation, which will be defined by
Illustrator text objects.

• it describes and contains the structure of the text that must be used on a design.

For more information on the XML format, please refer to the Appendix “An Introduction to XML”.

3.27.3.  Essential Configuration Steps to enable Packaging Content
Management

To setup the foundation of a working Content Management System follow the steps below:

1. Enable the Text Content Document Type. Optionally also specify the Language Editor and Approver
Prefixes.

2. Configure Packaging Content Management related attributes. You can migrate the essential
configuration into your WebCenter or do it as follows:
a) Configure Element Types
b) Configure Master and Translation Language Lists and Attributes on page 501
c) Configure Text Reference Attributes on page 501
d) Create Text Document References with Rendering
e) Configure Language Index Attributes. These will be used when you Import Dynamic Content.
f) How to Configure a Setup to Extract Images, Symbols and Graphics on page 525

Packaging Content Management

Note:  You need the Packaging Content Management license to be able to use this module.

Smart Role Names for Editors and Approvers
To work with language specific Smart Role Naming on page 508 specify your:

• Language Editor Role Prefix/ Language Editor Role Sux

• Language Approver Role Prefix /Language Approver Role Sux

• Add Language Role Prefix/ Add Language Role Sux

The specified prefixes and suxes are used automatically to create Role names specific for each
language in the Role Mapping >  Manage Permissions page.

If the Roles column in Manage Permissions is left blank, values in Language Editor Role Prefix,
Language Editor Role Sux, Language Approver Role Prefix,Language Approver Role Sux, , Add
Language Role Prefix and Add Language Role Sux are taken to calculate the role names for Editor,
Approver Text Content and Add Language permissions.

A change in a Text document creates a new document version. To allow or prevent the users from
creating new Revisions use the Revision Raise option:

Select Raise revision when Master Text Contents are updated to allow raising a Revision when master
text is updated.
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Select Never raise revision if master text changes should not be saved as a new Revision.

Note:  This setting is independent of the Allow raising Document Revision when uploading a new
Document Version setting.

Copy comments from a text document
Choose either to Keep Comments or Remove comments if state reverted to Draft or Remove
Comments always when copying a document.

You can choose the option Keep Comments to copy all the comments when copying a document.

Comments are cleared if the state of the element is changed to draft, when the option Remove
Comments if state reverted to Draft is chosen.

Similarly, all the comments in the elements are cleared while copying, when the option Remove
Comment always is chosen.

Note:  Same behavior is replicated in workflow when documents are copied using Copy/ Move
Document. Move document option does not respect this setting.

Configure Element Types as a List
You can categorize the packaging content using the Element Types list in WebCenter. You can use the
categorization from the GS1 / IPC standard or any other.

Note:

GS1 is an international non-profit association dedicated to the design and implementation of global
standards and solutions. The GS1 system of standards is the most widely used one in the packaging
supply chain standards system.

You can create a WebCenter List for configuring the Element types.

Note:  Only Administrators can configure Lists.

• Create and upload your Excel (either .xls or .xlsx) document containing the element types to a
project named List Manager.
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a) Add the following mandatory columns to your worksheet:

• ELEMENT_TYPES should contain the Element Type tags.

• HUMAN_READABLE_FORM with the Element Type names.

Note:  This will appear as the Element Type drop-down in the interface. For example, in the
Text Document Details on page 509 page.

b) Optionally, you can add an ELEMENT_CATEGORY column. This column can contain the
categories used to group Element Types.

c) Optionally, add the PCM_ELEMENT_TYPE_RESPONSIBLE (this name can be different) column.
This is column can have the Role names who would be responsible a particular Element Type.
For example, a role Legal would have the responsibility for the Element Type Consumer
Guarantee.

Tip:  In your Workflow configuration, you can look up in this list to find the Role matching a
particular Element Type. Read more in the Workflow section.

d) Add the Color column. Use this to specify the color coding for the Element Types.
If you have specified Red corresponding to Brand Name, your Text Document Thumbnail will be
color coded as Red.

• Create a List named ELEMENT_TYPES.

• When configured, the Element Types will appear as a drop down in Text Document Details page.

• If the Element Types are color coded using the Color column, you will see Text Document
Thumbnails in the system.

Configure Thumbnails for Text Documents
When you upload a Text Content Document, a thumbnail with it's name gets generated according to
the color code specified in the Element Types list.

If you update the color code of an Element Type in the List, the existing thumbnails will not be updated
immediately. Update the document's Element Type to generate a new thumbnail.
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If color code column is not defined, thumbnail will not have color code in it, but still Element Type will
be displayed.

Note:

If the Element Type name is longer than the thumbnail, it is truncated to fit in the thumbnail size.

Note:

Supported colors: green, blue, red, yellow, white, black, orange, cyan, magenta, pink, light gray and
dark gray. RGB colors (rgb(x,x,x)) are also accepted in the Element Types list.

Configure Text Reference Attributes
You need to create two attributes which are used in mapping the Dynamic Content data. When
Dynamic Content is imported, these are used to map the location and the instance sequence of the
text. These are later used in exporting the Content into GS1 format as well.

Note:  These are not visible to your users.

1. Create the following Attributes.

• INSTANCE_SEQUENCE This will be a reference attribute (of a text document reference) keeps
the instance sequence (a number) of the Text Statements.

• LOCATION_LIST This reference attribute stores the specific location of the Text Element on
the artwork for each dynamic Text Element.

• EXPECTED_NUMBER_OF_OCCURRENCES This reference attribute store the number of
expected occurrences of a particular content( image, text, table, Barcode in an artwork.

2. Create an Attribute Category which will be used as a Reference Category when configuring Text
Document References (Copy Sheet).

Note:  Specify the Visibility as Hidden (Keep Values).

Creating a Copy Sheet on page 388

When you are viewing an artwork document in the Viewer, the Text Documents are highlighted when
you click on them. The reference property Location_List is used in rendering this feature.

Add this reference category to Text Document attributes used in Copy Sheets.

Configure Master and Translation Language Lists and Attributes
You have to configure Master and Translation Lists for setting up the Packaging Content Management
module.

The master and translation languages can be added as WebCenter Lists and your users can easily
access and select the appropriate languages in the Attributes tab.

Note:  Only Administrators can configure Lists.

1. Create and upload your Excel (either .xls or .xlsx) documents to the ListManager project.
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a) Create the Master Language document in Excel. Add the following mandatory columns to your
worksheet:

• For example, English- United States.
• LANGUAGE_CODE: Specify the code of the languages that you want to include

• DESCRIPTOR: Describe the language code you specified

• FLAG_FILENAME: Specify the name of the image file which has the flag of the country the
language is used. For example fr-ca will have Canadian flag whereas fr-fr will have French
flag.

• LANGUAGE_INDEX: 1, 2, etc...

• DIRECTION: Specify if the language is written right to left or left to right. This ensures that
the cursor is placed appropriately.

• FONT_FAMILY:Specify the font family that you want to use for the language

Note:  Specify the name of the font family that you want to add as a customized font
for the PCM. To add a customized font in Packaging Content Management, follow
the steps given in the KB article https://wiki.esko.com/pages/viewpage.action?
spaceKey=KBAS&title=KB196429311%3A+WebCenter+-+How+to+support+custom+fonts+and
+languages.

And also add the fonts in the application server pcm/TablePreviews/custom/fonts
folder location.

• LANGUAGE_INDEX: This is the corresponding field to locale Sequence tag in GS1 XML
standard. This is used in Import Dynamic Content node to map the GS1 XML coming from
Dynamic Content.

• Note:

When you add a language code in these Lists, a corresponding flag image will be available
for you in the interface. The flags are installed in the WebCenter\WebServer\tomcat
\webapps\WebCenter_Inst\images\country_flags folder. When you add a custom
language to the Lists, place a corresponding flag image in this folder.

The flags are 16x16 in size. The subfolder WebCenter\WebServer\tomcat\webapps
\WebCenter_Inst\images\country_flags\big contains same flags in bigger
(32x32) sizes.

b) Create the Translation Language document in Excel. Add the following mandatory columns
specified in the Master text Language excel sheet.

2. Create Lists named MASTER_TEXT_LANGUAGE and TRANSLATION_TEXT_LANGUAGE.
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3. Create the following attributes in Admin > Attributes > Attributes

• MASTER_TEXT_LANGUAGE

• TRANSLATION_TEXT_LANGUAGE

These attributes define the languages that are used by the Text Content as part of the Project's
Attribute Category.

4. Create an Attribute Category and add the language attributes to it.
5. Restrict Values to the language lists. And specify the Column as Descriptor.

To select more than one language, you need to enable Allow Multiple Values.

These attributes has to be added to the Project's or Templates Attribute Category. The User can then
select the Master Language and Translation Languages according to that Project's needs.

Configure Language Index Attributes
To map the Language Index (Locale Index) from Dynamic Content, you can create attributes. These
attributes are needed when you configure Import Dynamic Content node in the workflow.
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Note:  Without setting these attributes, the import node will use default indices from the language
lists. We recommend that you create these attributes to be able to specify the language indices for
each project.

• Create the language attributes and add them to the Attribute Category.
See the example screen shot:
 

 
• Configure Restrict Values as a Language List to get the attribute selector drop down listing all

languages.
Use this in the Template that is used to import Dynamic Content and the workflow step Import
Dynamic Text on page 926.

3.27.4.  Managing Text Permissions

Ensure that:

• you have invited the right Roles in your Project or Template with the Text document.

• you have added the Master and Translation Languages to the Project's Attribute Category to
configure Language specific Editor and Approver permissions. It is important to do role mapping in
a smart way.

• you have enabled the right Preferences.
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If you are a Project Manager / Admin, you can manage and assign content permissions.

Note:

A user without any of these permissions can only view (depending on the view permissions) the text
content documents.

1. To manage Permissions, go to the Document details > Text Information > Role Mapping.

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

• Text Content

• Role Mapping

• Compare
2. Click on Manage Permissions. This will open up the Role Mapping page.
3. Click Add Permission. Repeat this for as many permissions as you want.

 

 
4. Choose the Content Permission from the drop-down listing:

• Content Manager

• Editor

• Approver
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• Add Language
5. For the Content Managers permission, define the appropriate Role.

Read about the permissions below:

1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process
to ensure accuracy and compliance. For example, the role Marketing could have this permission
where the Marketing has the responsibility of the packaging content. The Content Manager will
manage the Master and Translated statements.

Note:  The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note:  Content Manager Role cannot act as an Editor or Approver unless this permission is
granted to the same role.

2. EDITOR

The Content Manager typically assigns this right to the dedicated roles who will create, edit,
revise or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:

• The Content Manager Role has to configure the list of translation languages to make use of
multiple language based Editor permissions.

• You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also
be configured per language. The approver puts the Text Statement to Signed-Off or Rejected
state.

4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document.
The users can be assigned with permission to add only specific languages.
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Note:  You may choose to give more than one permission to a Role. For example, the Content
Manager can have Editor and Add Language permissions as well.

6. Define the Editor permission and assign it to a role. Select the corresponding Language from the
drop-down.
You can automatically create Editor and Approver Roles for all languages in one go. Read about
Smart Role Naming on page 508. To do this for the editor permission:
a) Make sure that the Admin preference section has the right Prefixes. Read here.
b) Next to the Editor permission, select All Other Languages.
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7. Define the Approver permission and assign it to a role.

Select All Other languages to create Approver roles with default names in one go.

Note:  You can configure Editors and Approvers individually for some languages and choose the
Smart Role Naming for the rest of the languages by selecting All Other languages.

8. To edit Content Permissions, click Manage Permissions and edit or change the assignment of a
permission.

• The Role Mapping page will list all the Content Permissions, respective languages, Roles and their
assignees (individual or Group).

The Roles will be clickable if they exist in the system and are invited to the Project.

• The Master Language of the Project will be highlighted in bold.

If you would like to give content editing and approving permission during Project Creation, assign
Editor and Approver permission to the _REQUESTOR role.

For example,if you assign Editor permission to the _REQUESTOR role, the Editor can draft the text
during project creation.

 

 

Warning:  During a Project's creation, you can assign another user as the Requester. If this
happens, the permissions defined for the _REQUESTOR role does not get transferred. In this
scenario, some updates done during the Project creation may be lost.

Smart Role Naming
When your content workflow contains translations into different languages, you can have Editor
and Approver permissions assigned to Roles (text authors/editors and approvers such as legal or
marketing) associated with these languages. To automate the naming of such Roles, you can specify
prefixes for these placeholder Roles.
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The names of the Roles will have the specified prefix and Sux (In the example screenshot, Language
Editor) and the respective language code.

Text Document Details
When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

• Text Content

• Role Mapping

• Compare
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3.27.5.  Creating a New Text Document

An Administrator or Project Manager can create Text Document Templates using which the users can
generate new text documents.

Note:

It is not possible to create Text Documents without configuring the Document Templates and
Document Sources.

When configuring a text document reference for a Task / Project Template, you have the option to
specify document sources. These are buttons that will allow you to create, or link, or copy or reference
documents in their respective documents tables.

1. Create a Project or Template to host all your Text Templates ( a Text Document Template library).
2. To create text document templates:

a) Upload Text Documents (.wcc) into this Project or Template. We recommend that you create
Templates per Element Type. This allows the users to create a new Text Document for each of
the Element Type.
Make sure that you have enabled the text document type in the Preferences section.

b) Go to Document Details > Text Information > Text Content tab of the Template and add the
corresponding Element Type to the template.

c) Also, specify Master and Translation languages for each template.
d) Specify the Approval Type as:

• Default:Even if one user approves, the document is approved.
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• One of Role: At least one user per role assigned should approve the text content document

• All of Role - One per Group: From every group, at least one user should approve
e) In the Role Mapping tab, assign the Content Permissions.
f) Repeat for all the text document templates you want to create.

Note:

• New documents created from this document template will inherit the settings.
• The approval cycle is different from other document Types. Read more about Text Document

Approval in our KB.

3. Create a Project Template for each kind of project that may be required by Project Managers.
4. In each of these Templates configure the Document Library as follows:

a) In the Project Details page, Configure > Document Templates.
b) Select Project or Template and select your document template library from the drop-down.

 

 
c) Click Save.
When creating a Project from this Template, the user can click New and select a Text Document
Template from the Templates library to create new documents.

5. Create an Attribute Category for your Template.
a) Add Language Attributes  and restrict them to Language Lists.
b) You need Document Reference Attributes. Create and add them to this Category.

6. To allow the user to create new documents from the Copy sheet (document references) attached to
this template, configure document sources for the individual reference attributes.

Tip:  Use a Saved Search configured to search for Table Templates as a document source for better
user experience. You can, for example, add a Search Panel.

The user will be able to add New Text Documents from Template > Attributes section when
creating a Project.
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3.27.6.  Creating a Copy Sheet

Copy sheet is a term used to describe all the content together which are attached to a particular
artwork or printed item. A copy sheet containing aggregated content helps you to:

• validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.

• review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

• track the content on an artwork.
• easily reuse existing approved content
• configure separate permissions and approval system for each text document.

Tip:

By configuring Document Rendering for Text documents, you can attach copy sheets to Tasks. When
you configure Workflows with manual tasks for editing or approving, the users can work on the copy
sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

• the languages. To view a particular translation corresponding to a master, just select that language
in the filter drop down.
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• the Instance Sequence. See more in: Dynamic Content documentation

• the option to replace a text document with another

• the button to duplicate a document with the same reference attributes

• advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.

Note:

The text document references are used when you import Dynamic Content into WebCenter. Read about
this in: Import Dynamic Text on page 926.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip:  You can configure the copy sheet with different Attribute Views to provide custom views to
your users. For example, a content collator and Translation Language Editors can have different
custom views of the same text document reference category.

Note:  You can also add the languages by clicking on the  displayed in the text statement. On

deletion of a language, the  icon is again displayed to enable adding back the language. You can
configure the corresponding attribute category to display the languages one by one in a table.

 

 

Adding or removing Master or Translation languages from a Project Attribute Category page or
Project Creation page or Document Attributes, or in a Task execution pages behaves differently now.

Adding any of the available languages is possible based on permissions on all text content in the
page including documents that are from other than current project.

Similarly, it is possible to remove the language when it is added recently but not saved

• Even when text content document is referenced from other than the current project
• Even if it is not empty

• Even if you do not have permission to remove languages

513

http://docs.esko.com/docs/en-us/dynamiccontent/18/userguide/home.html?q=en-us/common/dyc/concept/co_dyc_Introducing_DesignWizard.html


3 WebCenter

Create a Table Rendering for Text Documents
You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option."

1. Create a Table Rendering.
2. In the Edit Rendering Configuration pop-up:

Configure The result in the rendering table will be...

Master Text or Translation
Text

Master Text Statement or the Translation Text is shown in
a text widget along with its content in the edit field and all
related text content actions.

Note:  The Visibility should be specified as Editable if you
want your users to edit the text. One or more columns can be
configured for the Master or Translations of the Master Text.

Master and Translation languages will either appear in a drop
down or you can choose Show Side by Side view.

You can also restrict the languages that will appear in the
drop down, by mentioning the languages ( pipe separated)
specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

Note:  The master and translation languages are populated
from the project attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.

Tip:

You can specify a default language code for Text statements. The selected language will be the
default in the document reference table. If default language is not specified, the first language from
the language drop down is selected as the default. WebCenter also supports right to left languages
like Arabic and Hebrew for text content.

3. Specify the width for Master Text and Translation Text.By default, the width of every column is set
to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.
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Tip:

To change the width of the columns, specify pixels or a percentage (of the width of the table).
If the label of the column is too big for the width specified, the column width will be bigger to
accommodate this.

 

 

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons
buttons and are active by default.

• Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the
content. Green for approved, red for rejected, blue for pending approval and grey for draft.

• Inheritance Button Shows the inheritance icon when active.

• Comments Button Shows the comments icon button when active.

• Approval Info Button Shows the approval info button when active.

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options “Ellipsis” button will also not be visible.

4. Configure the display of Text Language Flags. You can configure the Display as Show only Flags or
Show Flags and Languages.
These flags will be based on the Project Language Attributes.
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• In the copy sheet view, all the newly created text documents will have the current Project's 
Language attributes as flags. You can read about how to customize flags for languages here.

• All the sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the
available flags.You can add or delete flags in this view.

5. You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
 

 

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.
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The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see  indicating remote project.
6. If you are configuring Local / Remote button to allow copying of documents, ensure that you have

enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval status is retained as it is.

7. Define adequate permissions to view and edit Text Statements.
Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

• Visibility should be specified as Editable.

• If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

• The user should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 504.

Tip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

• Change Properties

• Start/Stop Approval

• Upload new version

• Change Task

• Download

• View

• Add

Note:  The Text widgets, related languages and statuses are rendered only for Text Document
References.
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 Configuring Document Sources for Text Documents
You can configure your Document Sources (such as a Project/template which serves as a library of
Text Documents / Artworks), a Saved search of your Text Documents, or your Document Templates) in
the Grid layout of an Attribute Category or Project Template.

 

 

Your configured sources will appear in the places (such as templates or forms you have designed)
where you set the document reference categories. Read more in: Adding Document Sources for a
Document Reference Attribute on page 373.

Replace a Document Reference
You can configure a Replace option in your document reference table. When you replace the old
reference, the new document reference will have the same reference category as the old one.

Note:  Project managers, Administrators or users with Change Properties rights can replace the
document reference.

 

 

When you configure a Replace button, it allow the you to

• replace the document via any of the configured document sources (upload, browse, etc.). If you do
not select any option, the first source is taken as the default.

• Undo the action before saving the new document reference.

This document has its own Attribute Category but will keep the same Reference Category as the old
reference.

You can also select compact rendering option for this button.
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Duplicate a Document Reference
You can configure a Duplicate option in your document reference table. When the user duplicates a
reference, a new row of document reference will be created. The duplicated document will have the
same content, document attributes and reference category as the previous one.

In the case of Text Document, Content file, then each element status in the file will be reset to draft.

Note:  Only users who are Project managers, Administrators or with Change Properties rights can
replace the document reference.

When you configure a Duplicate button, it will allow the users:

• to duplicate a document row with Copy and New as document sources.

The duplicate documents are created in the current Project where the copied or newly created
documents are stored.

Tip:

• The document will be named as [FileName] [Duplicate] [1], [FileName]
[Duplicate] [2], etc.

• Use the Rename document action to change the document name.

You cannot duplicate a document reference if the document source is:

• Browse / Link / Use by Reference / Remote.

Behavior while duplicating document and its reference properties:

• If Allow multiple values is turned off in the attribute category, the duplicate will replace the original
instead of adding a new document reference.

• The duplicated document will have the same Attribute category including the child document
references. The Reference categories and its settings are copied at parent and child levels.

• The duplicated row inherits the entire hierarchy (if any) of the parent row including the attribute
values.
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• It is possible to duplicate a newly created document row.

3.27.7.  How to Configure a Setup to Extract Dynamic Content

This chapter provides an overview of what needs to be configured to have a functioning Content
Management setup in WebCenter.

To eciently manage the content, you need a setup that addresses the packaging content in the
context of packaging artwork. To create such a system you need:

• Reusable text documents stored in the form of libraries
• Text Document Templates
• Artwork libraries and Templates
• Attribute Categories with Languages to be attached to the Projects
• Copy Sheet or Text Document References attached to Artworks

The steps below describe how to create a setup to import Artwork templates from Adobe Illustrator
(With Dynamic Content) along with the Text Content mapped to a Copy Sheet.

Note:  This is an example configuration. Other than the essential steps, all other steps meant as
recommended, not mandatory.

Note:  To get you started, we have created a migration setup that you can import into your system and
start on it. See in: Knowledge Base article.

1. Follow the Essential steps  to configure the module.
2. Create Text Document Templates. You need these templates to create new Text Documents.

Important:  You can create Text Templates with all the necessary configuration automatically. This
is recommended if you require a large number of templates. Contact Esko Professional to configure
your Text Templates automatically.

You can now start using these templates to create new Text Content Documents.
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3. Create WebCenter Projects as Text Libraries and Artwork Libraries and organize your assets in

them.
Do this for:

• Text Content Documents,
• Artworks,
• and more...

See more examples here.

To organize further, you can create advanced Text Searches.
4. Create copy sheets. They are Attribute Categories with Text Document References.

a) Create your text document reference attributes and add them to an Attribute Category. You
can use the advanced features available in the grid layout.

b) Add the mandatory Reference Category to these document references. This is used in matching
the Artwork's Dynamic Content elements to text references.

c) Create a table rendering with text related options. You can configure Master and Translated Text
widgets for your copy sheet. You can use all the advanced features available in the grid layout.
Depending on the User's permission (Editor, Approver or Content Manager), they can do content
actions in this page.

• Make the attributes editable (the visibility setting) to allow for text editing.

• Allow adding multiple documents by enabling allow multiple values.
d) Configure the document sources. Choose the operation (copy, link, move, or use by reference).

Read more in: Adding Document Sources for a Document Reference Attribute on page 373
document sources settings you configure here will be rendered in the text document table.

• Create a custom label.

521



3 WebCenter

• Specify the source of the document. For example, a Saved search of text documents
for adding approved text. To create new text documents, the source will be Document
templates.

• Specify the type of operation: copy, move (move content to the local folder) or use by
reference (to use approved content from a library or saved search).

5. Create other attributes necessary for the document as per the requirement.
6. Create Import setup for Adobe Illustrator design files with Dynamic Content. This workflow will

map the content to the copy sheet attributes (text document references) created in the previous
step.
a) Create a Task Type for the import workflow.
b) Configure your workflow step to assign the Copy Sheet attribute category to
c) Create a step to extract the text content as Copy Sheet references of the artwork.
d) Configure the Import Dynamic Text on page 926 step with document reference and document

template mapping. Specify the reuse policy for partial matches in this step.
e) Route the workflow depending on the text document status.
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document Attribute Category to the artwork (parent). This 'copy
sheet' category contains the document reference attributes to which the text content will be
imported.

Note:  If this step is not in the workflow, the Import Dynamic Content will use the Project's
attribute as the default.

The category contains the Document Reference Attributes for:

• technical text statements,
• legal statements and
• marketing statements

to serve as the copy sheet template.
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2. The Import Dynamic Content step maps the various Element Types to appropriate document
reference attributes as configured.

3. The Select Children nodes select the text documents (technical, legal and marketing) separately.
These documents can be processed as separate text documents while keeping the link between
them and the artwork alive.

Later in the production process, you can supply the approved textual content in the form of an
XML file. Read in: Export to GS1 Format on page 921. Using the Esko Dynamic Content plug-in, the
designer can add the approved content to the Illustrator document.

7. Create Approval Workflows to assign Tasks for different approval stages.
When you have assigned Content Permissions and assigned them to Roles, the assignees can
manually go into each text document and approve it. However with a workflow, you can assign Tasks
with Text Documents to those Roles automatically.

Note:  You need to configure these Workflows according to your business needs.

Read more in the KB article:
8. Create other Workflows depending on your business needs.
9. Configure Project Templates to create projects to update or create new Artwork templates with

content.
a) Configure the Project Creation Form.
b) Invite Members (Roles and Groups) who will perform various tasks in the Project context.

These are important for activating the Content Permissions (from Document Templates). Read
more in: Managing Text Permissions on page 504

c) In Configure > Document Templates, link the text document templates to allow creating new text
documents.

d) Optionally create a custom setup for document sources in Configure > Document Creation.
e) Assign an Attribute Category. It should contain the following attributes and any other attribute

relevant to your Projects.

• MASTER_TEXT_LANGUAGE

• TRANSLATION_TEXT_LANGUAGE

Note:  The MASTER_TEXT_LANGUAGE and TRANSLATION_TEXT_LANGUAGE attribtues
determine the languages of the Text Content documents located in that Project.

• Language Index attributes.

Note:  If the Language Index values are not specified, the default values (from the Language
Lists) will be used as indices.

To determine the Master and Translation languages of a Project, you need to define these in the
Template > Attributes page.
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f) Add the Workflow Tasks to the Template. The workflow tasks configured for import and approval
are configured to launch right after the project creation.

3.27.8.  How to Configure a Setup to Extract Images, Symbols and Graphics

You need to create attributes which are used in mapping the Images, Symbols and Barcode to the
document templates. When images, symbols and Barcode are imported, these are used to map the
location. These are later used in exporting the content into GS1 format as well.

Note:  These are not visible to your users.

1. Create the following Attributes.
For Symbols

• SYMBOL_NAME: This is an attribute commonly used for storing the name of the symbol
present in the artwork.

For Images

• EXTERNAL_IMAGE_PATH: This is an attribute commonly used for storing the path of the
image present in the artwork.

Note:  If the incoming document is a chili document, ensure that the attribute
ARTWORK_VARIABLE is available.

For Barcodes

1. BARCODE_TYPE: This is an attribute for storing the type of Barcode present in the artwork.
2. BARCODE_BASECODE: This is an attribute for storing the base code of the Barcode present

in the artwork.
3. BARCODE_COMPOSITE_COMPONENT: This is an attribute to store the composite

component for GS1 Barcodes.
2. Include the above attributes as required in the Attribute Category of the Document Template /

Document.
3. Ensure the following attributes are part of Reference Property of the document references.

• INSTANCE_SEQUENCE :This will be a reference attribute for the document.

• LOCATION_LIST: This reference attribute stores the specific location of the document.

You can view the imported images, symbols, and graphics in the Attribute category for the document.

3.28.  Migrating your Data

As an Administrator, you can migrate your WebCenter data to a different WebCenter server, for
example, to:

• test a new version on a test server where you create new configurations. You can copy this to the
production server later.

• perform some tests on a test system with production data. You can export your production data (for
example a large number of groups with their visibility and download permissions) to the test system.
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• rapidly deploy a solution developed by Solution Architects.
• copy data between different WebCenter installations.
• migrate the data to a third party system to archive them.

Note:

Before migrating a configuration, you need to migrate Users:

• Create Users in the target system
• Optionally remove Users

3.28.1.  Migrating Self-contained Data

From WebCenter 16 onwards, you do can do self-contained migration of Projects / Templates and this
saves the effort of migrating items individually. When you migrate a Template or Project with the setup,
the items are exported and imported in the correct order.

It is also possible to migrate individual items to a target system. Read in: Migrating other Data on page
532.

Exporting Templates or Projects
You can export Projects / Templates along with it's Attribute Category, Task Types, Documents,
Members (Groups, Roles, Users), Folders, Lists, Characteristics, Permissions and other settings. It is a
self-contained export of all the items that are in a Project or Template.

You can choose whether you want to export the Projects with or without its Documents.

1. Go to Admin > Project Management > Templates / Projects.
2. Search for the required Templates or Projects. You can also select from the list.

•
 to export an XML file without the Documents. For e.g.

ExportedWebCenterProjects.xml

•  to export a ZIP file with its Documents. For e.g.
WebCenterDownload.zip

Note:  When lists are exported, it is exported in the zip file.

3. Save the XML or ZIP file generated to your computer or a network location.

The below items are included in the Project / Template Export XML / ZIP:

• Project Name, Due Date, Description, Project Status including icons, Project Manager (along with
Group)

• Customer, Document template project

Note:  The names are exported but the links are established only if they exist in the target system.

• Project Members: Groups and Roles
• Groups, Roles, along with their invitations and permissions: A merged list of all the Project Group

and Role members is exported. Read more inMigrating Groups / Roles on page 532
• Attribute Categories along with Attributes and their values: Reference Categories, their attributes

and their values. Restricted sets and lists are also included. Document Reference attribute values
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(both for Project and/or Document Attributes and/or Task Specifications) is exported along with
any additional Document Reference properties.

Note:

During the import, a search is made in the target Project for a Document with the same name as
the Document and Project on the system from where the Project was exported. If such a document
is found, the value of the Document Reference (including Document Reference properties) will be
restored. When a matching document is not found, a warning is displayed in the import feedback
page.

Irrespective of the version of the Document on the source,only the value in the latest version of the
the Document Reference attribute is updated on the target system.

• A merged list of Project Attribute Category and default Document Types Categories is exported.
Read more in:Migrating Attribute Categories on page 535

• Tasks (Sequence, Icons, Assignees, Allowed Assignees) and Task Types: See also: Migrating Task
Types on page 537

A merged list of Task Types along with icons of all Project Tasks and Tasks attached to Document
Types is exported.

• Folders and Permissions settings on Folders (for Groups and Roles) and Role Assignments
• Document Types settings:

• Autoname settings
• Task settings
• Attribute Category

• Project Creation: Creation form settings and Project Autoname settings
• Document Creation settings
• Document Sources (Global Saved Searches)
• Notifications
• Document templates

Note:  The library of templates should exist the target system.

• Approval Setup:

• Project
• Folder
• Document

• Thumbnails of Project, Folders and Documents

Note:  The Thumbnails are exported only when you include documents in the export.

• List of Documents and Folders
• Documents if the option Export with Documents is selected.
• Document Approval Status

Note:  You can export Approval Statuses this for archiving purposes. But you cannot import it to
another WebCenter.

Warning:  If you have turned on Add Approval Information to downloaded PDF turned on,
the approval details will be included in export and import.

• Documents added to Bill of Materials

Items not included in the export:

• Documents attached to Tasks

527



3 WebCenter

• Workflow Connection
• Users and Permissions
• If the company/location does not exist in the target location, then the company is not created.
• Submitted Document approval statuses
• Project, Task and Document Discussions

Importing Templates / Projects
When you import Templates or Projects:

• They will get created according to the contents of the import XML/ ZIP file.
• Documents will be added only if they do not exist in the target project. Upload will fail if a document

with the same name exists in the target project.

1. Go to Admin > Project Management > Templates or Projects.
2. Click Import from File on the Template Management page.
3. Click Choose File and then select the XML or ZIP file.
4. Click Import.

When you import self-contained XMLs and ZIP files, you will get an overview of the items in the file.
You can choose to import them all or select the items individually:

 

 

Tip:

The documents in the ZIP files will be imported by default.

If you don't want to import the documents, disable Import the Document(s) in the Project/
Template when importing Projects/Templates.

5. Uncheck the items you do not wish to import and click Import.
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The referenced objects will be imported first:

• Attribute Categories including the attributes and restricted sets will be imported. .

• Groups / Roles with their settings..

• Task Types.

Caution:  When you are importing a Workflow Task Type (during the export of a Project /
Template), objects referenced by the Task Types may not be linked properly. If you notice
an error, reimport the same Project and the links will be established correctly.

6. Select Enter Database Credentials to specify if the WebCenter Database has to create a table or
not. If yes, then the Database Username and Password has to be specified.

After importing these, the Project / Template with its setup will be imported. Check this list to see
what is included in the import.

The items that are not imported are listed below:

• User members and permissions
• Document Reference values
• Company / Location
• Document approval statuses
• Project and Document discussions

Exporting Saved Searches
You can export Saved Searches (Project, Task or Document) to in XML format.

Note:

Before migrating a configuration, you need to migrate Users:

• Create Users in the target system
• Optionally remove Users

Note:  When you intend to migrate Saved Searches, migrate the Projects / Templates first. This will
make sure that the search criteria (such as attributes or roles) exist in the target system.

1. Go to Admin > Search > Saved Searches. A list of Personal and Global Saved Searches is displayed.
2.

Select any of the items from Global list and click 
3. Save the XML file generated (ExportedSavedSearches.xml) to your computer or a network

location

Note:

• Only Global Saved Searches can be exported.

Export of a Saved Search contains:

• Basic properties of each selected Saved Search
• Search Criteria
• Search Visibility Settings
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• Referred Objects

• Groups, Roles, along with their invitations and permissions:
• Attribute Category used in Search along with their Attributes and values

Note:  Document Reference values and the Document sources (Saved Searches) are not included in
the export.

• Restricted Set
• Task Specifications specified in Search

Note:  The Specification Categories are not imported.

• Task Types along with its settings: See also: Migrating Task Types on page 537

Note:  The Task Status will not get imported

Export of a Saved Search does not contain:

• Company and Location Visibility settings
• Project Status
• Characteristics
• Lists

Note:  Text Document Search export will not include the Element Type and Language Lists.

Importing Saved Searches
For Importing Saved Searches, use the steps below.

Note:  You cannot import a Saved Search exported from a later version.

1. Admin > Search > Saved Searches >  Import from File
2. Click Choose File and select the XML file.
3. Click OK.

You will see a warning about items that already exist and will be overwritten.
4. Uncheck the appropriate items and click Import.

If you encounter issues during the import process (for example, a missing Restricted Set on the target
server), you see a warning.

See more details about the import of externally referred search criteria below:

In a Project Search the following Search criteria are imported:

• Roles: When a match is not found, an error message is displayed and the import fails.
• Attribute (general) and Attribute Category: When a match is not found, an error message is

displayed and the import fails.
• Restricted Set value type: When a match is not found, an error message is displayed and the import

fails.
• Document Reference: When a match is not found, you get a warning and a feedback message is

displayed.

The Project Search criterion entities that do not get imported are:

• Project Status: When a match is not found, you get a warning and a feedback message is displayed.
• Characteristic: When a match is not found, you get a warning and a feedback message is displayed.
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In a Document Search the Search criteria entities that get imported are:

• Search Layout- Show Project Creation Link: When a match is not found, you get a warning and a
feedback message is displayed.

In a Document Search, the Search criteria entities that do not get imported are:

• Element Type (Configurable Search field): When a match is not found, you get a warning.
• Language (Text Document): When a match is not found, you get a warning.
• Document Type specific metadata: When a match is not found, the import fails with an error

message.
• Lists: When a match is not found, you get a warning.

In a Task Search, the Search criteria entities that get imported are:

• Task Type: When a match is not found, you get a warning. Import fails if the criteria is used on Task
Specification selection page.

• Task Specification: When a match is not found, an error message is displayed and the import fails.
• Search Layout- Show Project Creation Link: When a match is not found, you get a warning and a

feedback message is displayed.

In a Task Search, the Search criteria entities that do not get imported are:

• Task Status: When a match is not found, you get a warning and a feedback message is displayed.
• Lists: When a match is not found, you get a warning and a feedback message is displayed.

Note:  Limitations:

• When you have Document Searches with Show Project Creation Link with Template from
Characteristics Path Layout, the search is imported but the option is not validated.

• Modified date related criteria does not consider the Time Zone difference into account.
• Referred Saved Searches (as a document source in a document reference) are not exported.

Importing and Exporting of Lists
In WebCenter 18.0.1, when a Project or a Template is exported, lists in the projects that are part of the
Attribute Categories or Task Types are also exported. A zip file containing List configuration and List
Documents are created along with the other project components.

WebCenter will now detect whether, if any of the exported objects is dependent on a List or not, and
export it in the zip file when the project is exported.

The exported zip file has:

• ListManager folder: Contains all the documents needed to reconstruct the List. This folder can
have multiple sub-folders exactly as in the source project.

• XML file: Contains all the information of the Task Types / Attribute Categories / Project (without
documents)

Note:  if more than one project is exported with documents, then a folder is created for each
project.

On importing of the project, one of the below options may occur.

• Check whether the list exists:

WebCenter will check whether the list already exists or not. This is done by using the name of the
imported list. If the List doesn’t yet exist, we will create a new List otherwise we will update an
existing List.
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Updating (overwriting) a List:

If the list preexists, WebCenter will check whether the table name used by the list matches the default
WebCenter List table name pattern (“WC_LIST…”).

If it does, the list is deleted and a new List is created with the specified configuration.

Note:  Import of the list may fail, if the lists are preexisting but unable to update to the current list
since the table names are not matching in the database.

• Creating new List: If the list is not available in the target project, then a new List is created with the
configuration found in the zip file.

3.28.2.  Migrating other Data

From WebCenter 16 onwards, you do can do self-contained migration of Projects / Templates and
individually migrate items.

Tip:  When you migrate a Template or Project with the setup, the items are exported and imported
in the correct order. We recommend that you do a Project or Template migration so that all items are
exported in the right order.

Migrating Groups / Roles
You can migrate your groups along with their visibility and download permissions to a target
WebCenter.

When importing Groups, the system will create Group(s) if it does not exist or update the Group when
the Group exists.

Export of Groups contains:

• Basic Information like:

• Group Name
• Visibility Type ( All Project Managers/Specific Project Managers/Admin)
• Members
• Group Task Manager

• Group email including the address and language settings
• Notification settings
• Roles

• Group is a Role setting
• Roles, role invitations and assignments

Export of Groups does not contain:

• Role can add another Role

Note:  All these will get exported when you do a self-contained migration.

• To Export:
a) Go to Admin > Groups > Groups. The Groups page appears.
b) Search for the required group name(s) or select from the list available and then click Export

Groups  in the Action Header.
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c) Save the XML file generated (ExportedWebCenterGroups.xml) to your computer or a
network location.
See a sample below:

<group_list>
 <group id="00002_0000000001">
  <deleted>0</deleted>
  <name>EA SPORTS</name>
  <empty_group>0</empty_group>
<notify_group>1</notify_group>
<group_email_address>email@test.com</group_email_address>
<group_email_language>fr</group_email_language>
  <group_vis_type>2</group_vis_type>
<is_role >0</is_role>
  <user_members>
   <user>
    <name>USER</name>
    <group_manager>0</group_manager>
   </user>
  </user_members>
  <PM_with_visibility>
   <user>
    <name>JT</name>
   </user>
  </PM_with_visibility>
  <download_group_permission_list>
   <download_group_permission_view>
    <group id="00002_0000000011">
     <deleted>0</deleted>
     <name>EA SPORTS</name>
     <group_vis_type>2</group_vis_type>
     <is_role>0</is_role>
    </group>
    <download_format id="00002_0000000001">
     <deleted>0</deleted>
     <name>Native</name>
     <short_name>Native</short_name>
     <doc_type_id>00001_0000000001</doc_type_id>
     <enabled>1</enabled>
    </download_format>
    <download_group_permission id="">
     <deleted>0</deleted>
     <group_id>00002_0000000011</group_id>
     <download_id>00002_0000000001</download_id>
     <granted>0</granted>
    </download_group_permission>
…

• To Import:
a) Go to Admin > Groups > Groups. The Groups page appears.
b) Click Import from XML on the Groups page.
c) Click Choose File and then select the XML file.
d) Click Import. After the import completes, you can see a basic Import Group Feedback.
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e) Click the Download Detailed Report in XML link to download a detailed report of the import.

Note:

• If there are no visibility settings in the XML, the imported Group(s) will be visible to All Project
Managers.

• The import will not create Users or Project Managers.

• The download permissions as specified in the Export XML will be granted to the Group(s).

Migrating Restricted Sets
The import of Restricted Sets will overwrite the existing ones with the same name. This is similar to all
other import functions.

Note:  When you export Attribute Categories it will contain the Restricted Sets belonging to that
Category.

• To Export:
a) Go toAdmin > Restricted Sets.
b) Select the Restricted Sets to export and go to Action Header  > Export .
c) Save the XML file generated (exportRestrictedSets.xml) to your computer or a network

location.
The export will contain the following details of the exported Restricted Sets:

• Name
• Units

Note:

If the existing Restricted Sets (on the target system) have a different attribute unit, the
import will not succeed in updating them.

• Values
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• To Import to the target system:
a) Go to Admin > Attributes > Restricted Sets.
b) Click Import on top right.
c) Click Choose File and then select the XML file from your export.
d) Click Import. After the import completes, you will see a basic Import Restricted Sets Feedback.
e) Click the Download Detailed Report in XML link to download a detailed report of the import.

Migrating Attribute Categories
The migration of Attribute Categories will create new Attributes and Attribute Categories if they are
not existing in the target system.

The Export / Import of Attribute Category contains:

• Basic info:

• Name
• Description
• Layout

• Views

• Attributes:

• List of Attributes
• Name of the Attribute
• Attribute Type
• Visibility settings
• Attribute Input Option: Prompted / Calculated / Restricted

• Attribute Values

• All Document Reference Attributes with settings:

• Bill Of Materials options
• Versions / Revisions settings
• Reference Category name and the Reference Category attributes

Tip:  Export your Document Sources before the export of the Categories.

The Export / Import of Attribute Category does not contain:

• Document Reference Attribute Values (Documents)
• Lists

Tip:  Export your Lists before the export of the Categories.

• To export Attribute Categories:
a) Go to Admin > Attributes > Attribute Categories.
b) Select the attribute categories to export and go to Action Header  > Export .
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Warning:  If your Attribute Categories were created in another version, it will ask you to
re-save the Category. The message will appear as:

The following Attribute Categories cannot be exported because
 they are outdated. Open each Category and resave.

You also have to re-save the Categories when some Attributes are updated since the last
Save.

c) Save the XML file generated (exportAttributeCategory.xml) to your computer or a
network location.
See a sample XML below:

<category_list>
<category id="00002_0000011548">
<deleted>0</deleted>
<name>Griet Category</name>
<description></description>
<category_XML>XML blob describing the layout of the attribute category for the
 different views</category_XML>
<!—Mapping between the attribute category and the attribute -->
<attribute_category_list>
<attribute_category id="00002_0000011549">
<deleted>0</deleted>
<attr_id>00002_0000000302</attr_id>
<category_id>00002_0000011548</category_id>
<display_order>1</display_order>
</attribute_category>
…
</attribute_category_list>

<!— List of attributes in the selected category -->
<attribute_list>
<attribute id="00002_0000000302">
<deleted>0</deleted>
<name>GrietAtt1</name>
<description></description>
<attribute_unit_id>00001_0000000001</attribute_unit_id>
<restricted_set_id></restricted_set_id>
<restricted_set_name></restricted_set_name>
<default_expression></default_expression>
<type>12</type>
<istask>0</istask>
<isdoc>1</isdoc>
<isproject>1</isproject>
</attribute>
… 
</attribute_list>
</category>

<!— List of the restricted sets used by the selected categories -->
<restricted_set_list>
<restricted_set id="00002_0000000001">
<deleted>0</deleted>
<name>Countries Imported</name>
<attribute_unit_id>00001_0000000001</attribute_unit_id>
<allow_manual>0</allow_manual>
<restricted_set_value_list>
<restricted_set_value id="00002_0000000004">
<deleted>0</deleted>
<restricted_set_id>00002_0000000001</restricted_set_id>
<value>Belgium</value>
</restricted_set_value>
…
</restricted_set_value_list>
</restricted_set>
</restricted_set_list>
</category_list>
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• To Import an Attribute Category:
a) Go to Admin > Attributes > Attribute Categories > Import.
b) Browse to the XML file that you saved during export and click Import.

Caution:

• When importing Attribute Categories, existing Categories with the same name are
overwritten. A warning message is displayed on the Import page.

• A warning message is displayed about the items that already exist.

c) Uncheck the items that you don't want to import and click Import.

Migrating Task Types
You can migrate your Task Types with its settings.

When Importing Task Types:

• the Task Types will be created with the settings mentioned in the XML file when they do not exist in
the target system. Dependencies to the task type including lists and categories are also imported.

If the document reference attributes of the imported categories/specifications have a reference
category, the reference category is also imported.

• If the imported Task Types do exist, they will be updated with the settings from import XML.

• To export Task Types:
a) Go to theTask Types > Types page. Select the Task Type(s) to export and click Export .
b) Save the XML file generated to your computer or a network location.

Export / Import of Task Types contain:

• Basic Settings
• Task Document's settings
• Discussions with Settings
• Checklist items with Settings
• Views
• Specifications:

• List and Order
• Names
• Type
• Grid Layout
• Visibility settings
• Input Option: Prompted / Calculated / Restricted

• Values

• Document Reference Specifications:

• Bill Of Materials options
• Versions / Revisions settings
• Reference Category name and the Reference Category attributes
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Tip:  Export your Document Sources before the export of the Categories.

• Workflow

• Task Status List with the icons ( 18.0.1 release onwards)
• Document Upload Settings

Export / Import of Task Types does not contain:

• Document Reference Values (Documents)
• To Import:

a) On the Task Types > Types > Import from XML
b) Click Choose File and then select the XML file that you saved during the export.
c) Click Import.
d) You are redirected to Import Dependencies screen, where all the imported contents are shown.

You have the option to overwrite the existing contents or uncheck the contents which you do not
wish to import.
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e) Select Enter Database Credentials to specify if the WebCenter Database has to create a table or

not. If yes, then the Database User name and Password has to be specified. Click OK for one of
the option.

f) On completion of import, WebCenter shows the list of all contents updated and newly created
with warnings.

Migrating Workflows
You can export a Workflow from a Task Type to an XML file and migrate it to another Task Type either
on the same system or a target system.

• To export:
a) On your Task Type's Workflow tab, click Export Workflow.
b) Save the XML file generated to your computer or a network location.

• To import:
a) On your Task Type's Workflow tab, click Import Workflow.
b) Browse to the XML file that you saved and click OK.
c) A note of caution asks you if you are sure that you want to overwrite the current Workflow. Click

OK.

Note:  You will get the following message:

Not all the items in the Workflow are available on this WebCenter
when the Task Types linked in the workflow are missing.

3.29.  Getting a list of existing projects

To get a list of existing projects based on given filter make a call to the following JSP page:

GetProjects.jsp

With parameters:

1. username
2. password
3. type

Parameter description:

• type: specifies category of projects to be listed. This field is mandatory. Supported values are:

1. my favorite projects
2. projects I am in

• name: limits returned projects to those having the specified string (name parameter) in its name.
It’s possible to use special characters like in WCR GUI filters and search fields. For example
specifying “name=Toy*project” returns both “Toyota project” and “Toy Story project” if they exists in
WCR database. This is not applicable when type parameter is set to ‘6’ (type=6). In that case the full
name of required project (not case sensitive) has to be specified. This field is optional.

• projectid: ID of project to be returned. Ignored unless type parameter is set to ‘6’.

This SDK call can be utilized by project managers (PMs) or administrators.
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If type parameter is set to ‘6’ (project by ID or name), one of projectid and/or name parameters has to
be specified. projectid parameter has precedence. In this mode name parameter has to contain a full
name of the wanted project without any special “searching” characters.

Example:

To get list of all favorite projects of currently logged in user (PM or admin) that have “Active” status set
use the following call.

http://mywebcenter.mycompany.com/WebCenter_Inst/GetProjects.jsp?
username=myusername&password=YWJjZGVm&type=1&statusname=Active

To find projects managed by logged in user that contain particular string (“001”) in their names use the
following URL. The example returns the first set (page) of 200 projects. If there are more you get the
rest by incrementing the curpage parameter value and calling the SDK again until it returns less than
200 records (projects) back. Note you can utilize sorting parameter to control what projects will be in
the first returned set (page).

http://mywebcenter.mycompany.com/WebCenter_Inst/GetProjects.jsp?
username=myusername&password=YWJjZGVm&type=3&name=*001*&curpage=1&pagesize=200

Returns:

Successful execution returns a list of projects conforming to given criteria(s). If a problem occurs,
appropriate error message is returned.

<get_project_list>Getting a list of existing projects on page 539
     <project_list> <project id="00002_0000000135">
     <deleted>0</deleted> <name>a05</name>
     <description/>
     <manager_id>00001_0000000001</manager_id>
     <manager_type>user</manager_type> <customer_id/>
     <location_id/> <salesperson_id/> <category_id/>
     <created_date>1236947156000</created_date>
     <modified_date>1434620655763</modified_date>
     <is_template>0</is_template> <characteristic_list/>
     <attribute_list/> <attribute_value_view_list/> <!—
     always empty # <folder_list/>
     <status_id>00001_0000000001</status_id>
     <due_date>0</due_date> <project_doc_list/>
     <project_creation_form>
     <project_name_show>SHOW</project_name_show>
     <project_manager_show>SHOW</project_manager_show>
     <customer_show>SHOW</customer_show>
     <description_show>SHOW</description_show>
     <due_date_show>SHOW</due_date_show>
     <upload_doc_show>SHOW</upload_doc_show>
     <replace_groups_show>SHOW</replace_groups_show>
     <invite_memebers_show>SHOW</invite_memebers_show>
     <set_attributes_show>SHOW</set_attributes_show>
     <set_thumbnails_show>SHOW</set_thumbnails_show>
     <set_planning_show>SHOW</set_planning_show>
     <set_status_show>SHOW</set_status_show>
     <default_planning_method>BACKWARD</default_planning_method>
     <bom_show>SHOW</bom_show> </project_creation_form>
     <autoname_option>2</autoname_option> <manager
     id="00001_0000000001"> <deleted>0</deleted>
     <name>ADMIN</name> <location_id/>
     <last_name>ADMIN</last_name> <first_name/>
     <email>admin@ad.min</email> <phone_number/>
     <mobile_number/> <function/>
     <is_project_manager>0</is_project_manager>
     <password_last_modified>-3600000</password_last_modified>
     <password_forced_expired>0</password_forced_expired>
     <deleted>0</deleted>
     <has_guaranteed_access>1</has_guaranteed_access>
     <max_sessions>-1</max_sessions>
     <ldap_user>0</ldap_user>
     <can_create_task_type>1</can_create_task_type>
     <can_create_user>0</can_create_user> <owner_id/>
     <n_consecutive_failed_logins>2</n_consecutive_failed_logins>
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     <user_profile id="00001_0000000001"/> </manager>
     <thumbnail_url>thumbnails/project.gif</thumbnail_url>
     <project_user_permission> <permission>
     <view>1</view> <add>1</add>
     <update>1</update> <delete>1</delete>
     <checkout>1</checkout> <download>1</download>
     <change_approval>1</change_approval>
     <change_task>1</change_task>
     <change_bom>1</change_bom>
     <can_manage_this_project>1</can_manage_this_project>
     </permission> </project_user_permission>
     <manager_locaiton id="00001_0000000001">
     <location_view id=""> <location id="">
     <deleted>0</deleted> <name/> <shortname/>
     <address1/> <address2/> <city/> <state/>
     <zip/> <country/> <phone/> <fax/>
     <company_id/> </location> <company id="">
     <deleted>0</deleted> <name/> <legal_name/>
     <type/> <menu/> </company> </location_view>
     </manager_locaiton> </project> <project
     id="00002_0000000290"> <deleted>0</deleted> … other
     project description </project> … more projects
     </project_list>
     <total_filter_projects>1</total_filter_projects>
     <total_projects>48</total_projects>
     </get_project_list> 
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4.  User Guide

4.1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

542



4WebCenter

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

4.2.  Getting Started with WebCenter

Use WebCenter to search for information and manage projects. Anyone can search for information,
but only Project Managers can manage projects. This document includes documentation for the most
common and often-used features, but you will find other features and abilities as you explore the site.

4.2.1.  Opening WebCenter

1. Open your web browser and navigate to http://yourservername/WebCenter_Inst or the URL that
your system administrator has provided.

Note:

• On a PC using Microsoft Windows, Microsoft Edge or Mozilla Firefox or Google Chrome are
supported for use with WebCenter.

• On Mac OS X, Safari, Mozilla Firefox and Google Chrome are supported for use with WebCenter.
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2. Once the page loads, enter your user name and password in the appropriate fields and click Log In.

Note:

If your administrator has enabled this, you can click the Forgot Password? link in the Log In page if
you can't remember your password.

Enter your Username or E-Mail address in the pop-up that opens, and click Request New Password.

You will then receive an e-mail with a temporary password and a link to the Log In page.

After logging in, you will be asked to change your password.

The start page defined by your administrator appears (this is generally your My Work page).

Note:  You can later change the contents of your start page.

 

 

4.2.2.  Understanding the WebCenter Page Layout

Header
The top right of the WebCenter page always shows:

• the name of the current user,
•

a  icon to go back to the user's start page,

•

a  Discussions icon which indicates the unread messages and redirect to My Discussions. You
can view all discussions related to Project or Document or Tasks that you are involved in. For more
details, refer to Discussions in WebCenter on page 837

•
the Cart ,
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•
Avatar  icon displays the user initials (first letter of first name and last name),or an image, if any
is uploaded in the User page.
 

 

• a link to the WebCenter Welcome page,

• Admin (if the user is a member of the Admins group),

• Contact,

• Logout.

Top Menu Bar
By default, the top menu bar contains the following menus: My Work, Projects, Task Types, Search,
My WebCenter, Create (if you are a Project Manager) and Upload (see The Default WebCenter Menus on
page 546 for more details). An administrator can customize the menus.

 

 

If you have the optional Task Management module and the User Can Create Task Type permission,
Task Types also appears in the top menu bar.

Documents Pages
Below is a sample of project's Documents page, in grid layout, for a user who is a Project Manager.

Area 1 is the project actions area, allowing you to perform actions on the whole project (for example,
mail a link to the project to a reviewer, add the project to your favorite projects...)
 

 

• Area 2 is the Project Details area, containing the project icon, the name and description of the
project, the project status...
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• Area 3 shows links to the project pages. For example, click Members to view the project members.
The page you are on is shown in bold.

• Areas 4 and 5 are part of the content pane, that changes depending on the project page you are on.
Here, on the Documents page, they show the project folders and documents.

• Area 4 is the Folders pane, showing the projects folders. Click a folder to see the documents it
contains.

• Area 5 is the document pane, that can show the documents in a list or grid view, with or without
thumbnails.

Notes
• To act on many documents at once, select their check boxes and then choose an action in the

Actions menu.

• To select all documents in the current folder, select the check box before the Documents header.

• To switch to a list layout, click Show as List.

• Hovering over a thumbnail shows a larger version of it in a pop-up window.

For Graphic documents viewable by the WebCenter Viewer, you can click the zoom icon to show
an even larger thumbnail (500 x 500 pixels). This is applied to all Graphic documents on which you
hover until the page is reloaded.

The pop-up window closes when you move the cursor off the thumbnail.

There is usually more than one way to accomplish a task by using a combination of menu entries,
action menus, and clicking status messages. Many methods will lead to the same result.

Note:  This layout is the default layout. However, your layout might be different depending on your
customization.

4.2.3.  The Default WebCenter Menus

My Work

What is displayed?
Your My Work page lists the documents waiting for your approval, as well as the Tasks assigned to you,
or to a group you are in.

Documents that are overdue have red due dates. Documents whose due dates are within the next day
have orange due dates, and documents that have far-off due dates have gray due dates. You can also
view the Discussions and messages in the discussions that you are part of, if you have chosen to view
discussion in My Work page.

Tip:

If you have a long list of items to attend to, use the filter options in each panel: for example you can
limit the display to items assigned directly to you (Me), to one of the groups you are in (A Group I Am In),
or both (Me or Group I Am In).

If you are an Approval Master, you can filter the approvals you need to follow up by status (for example,
to only show the approvals still Pending), by due date, etc.
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Working from My Work page
• Click a document name to go to the document, or click the project name to go to the project. Note

that the behavior may be different in case you are using a simplified My Work page.
• To load multiple documents into the Viewer, select their checkboxes and click View and Annotate

in the actions menu.

You may then navigate between the documents by using the controls in the Viewer header.
•

To approve, reject or comment multiple documents, select their checkboxes, and click ,  or

 (choose a status that applies to all the documents you selected).

In the pop-up that opens, enter your comment (if applicable) and your password (if required by your
server) and click Commit.

Note:  For Page List documents, the My Work page also displays the number of pages that have already
been approved, as well as the total number of pages.

Indirectly Assigned Group Tasks
If you are a Group Representative, you will be the preferred assignee when a Role is assigned to this
Group. So the related approvals and tasks appear in your  My Approvals or My Tasks sections on My
Work page.

When the Group Representative is absent, any of the Group Members can do the tasks on his or her
behalf. To do this,

1. Go to My Work > My Approvals > / > My Tasks.
2. Click on the drop down Documents waiting for Approval and select the Me Indirectly option.

When you select this an additional drop down On Behalf Of will be displayed.
3. Select the Representative on whose behalf you are approving the document or doing the task. All

Documents / Tasks to which he / she is assigned through a Role or on behalf of a Group are loaded
in this page.

You can now do the Approvals from the My Approvals section.

Note:

Project History will indicate that those Approvals / Tasks were executed on behalf of the Role that
is represented by the Group.

To know more about how to setup your My Work page, readMy Work Setup on page 548

547



4 WebCenter

My Work Setup
This is where you can customize your My Work page. To do this, click My Work > Edit My Work Setup.
Select the blocks you want to be displayed and drop it to My Work panel.

 

 

You can also select Show simplified My Work page (with no links to projects or documents) or you can
choose Reset to Default option. To know more about My Work page set up, read Edit the Default My
Work Page on page 129

Click Save when you are done.

Admin users can now create Dashboards with My Work context, which are suitable for all users. These
dashboards are visible in the gallery, My Work (custom) category.

You can drag the Dashboards block from the gallery to the My Work Dashboard. You can switch the
selected Dashboard to another Dashboard with the My Work context, in the configuration panel.
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Projects
The Projects menu contains the following menu items:

• Favorite Projects on page 549,

• Projects (shows all projects visible to your user),

• Projects I Am Invited to on page 550,

If you are a Project Manager, you can also see:

• Projects I Manage on page 549,

• Create Project.

Favorite Projects

Favorite Projects shows those projects for which you have clicked Add to Favorites in the project's
Actions menu.

The Favorite Projects' Actions menus contains Remove from Favorites, Add to Cart, and Update
Project(s).

• Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.

• To sort the list of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

• To view a project, click its name.

• Add to Favorites adds the selected projects to your list of Favorite Projects.

• The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to
projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

• Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

To remove a project from the Favorite Projects list, select it and click Remove from Favorites in the
Actions menu.

Projects I Manage

Projects I Manage shows those projects for which you are the Project Manager, or which are managed
by a group of which you are a member. It only appears in the menu if you are a Project Manager (either
individually or through your group memberships).

In the Actions menu are Delete, Update Project(s), Add to Favorites, Add to Cart and Change
Manager.

• Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.
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• To sort the list of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

• To view a project, click its name.
• Add to Favorites adds the selected projects to your list of Favorite Projects.
• The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to

projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

• Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

Delete deletes the selected projects.

To have somebody else manage one of your projects, select the project, click Change Manager in the
Actions menu, then select the new Project Manager and click Finish.

Projects I Am Invited to

Projects I am invited to shows all the projects of which you are an invited member.

In the Actions menu are Add to Favorites, Add to Cart, and Update Project(s).

• Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.

• To sort the list of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

• To view a project, click its name.
• Add to Favorites adds the selected projects to your list of Favorite Projects.
• The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to

projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

• Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

Task Types
You will only see this menu if you have the Task Management license. See Task Management in
WebCenter on page 841 for more information.

Search

Searching Content in WebCenter
When searching for projects or documents, you can use normal searching or keyword searching.

The normal method searches more fields than keyword searching, but keyword searching may be more
useful when you know less about the desired results.

Both are accessed by clicking Search in the main menu.
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Tip:

Keyword searching is also available in the header of every WebCenter page, at the top right under
Welcome, Contact, Logout... You can search for Projects, Documents or Saved Searches in this
search bar.

 

 

By combining with the OR keyword, you can also search for properties which are empty have a specific
value, EMPTY OR some value.

Normal Searching

1. In the Search menu, click Projects, Documents or Tasks and Approvals, depending on what you
want to search.

2. When using normal searching, you see multiple fields to fill in. Click Keyword Search to search on
keywords alone.

To switch from keyword to normal searching, click the More options link.
3. Enter search terms in the fields as desired.

Note:

• To search for Documents or Projects based on attributes:

• click the Attributes link,

• select the Attribute Category,

• specify the values of the Attributes you are searching for,

• and click Add to return to the Search page.

• To search for Documents or Projects based on characteristics:

• click Characteristics,

• select the desired items in the characteristics tree or Find more characteristics.

You can choose to search on any of or all of the items selected. Click Add to return to the
Search page.

Searching on attributes and characteristics is available only using normal searching.
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Tip:

You can search for documents based on their Approval Status: select either a single approval
status or:

• All Approved to select documents with any approved status (Approved, Approved with
comments, Force Approved or Force Approved with comments).

• All Rejected to select documents with any rejected status (Rejected or Force Rejected).

• All Completed to select documents with any approved or rejected status.

Tip:

You can search for document revisions. The revision field can be shown in the search results and
can be used to sort the results.

You can search for revisions only if your administrator has set this up for you. Read about this in
Configure Search Crawler Setup on page 413.

You can specify the revision you want to search for from the drop down. Select:

• Latest Revision to search the latest revision of the document you are searching for. Only the
latest revision will appear in the results. A document can appear multiple times in the search
results if multiple versions are linked to different projects.

Note:

The search results will show only the document revisions linked to at least one project. If a
version is linked to a project, all the revisions prior to that can be found in the search.

For example, a document has three revisions (Base- versions 1, 2 and 3; Revision A- versions 4,5
and 6 and Revision B-version7).

If the revision indexing is not enabled, the search will find only version 7 if this is the only version
linked to a project currently. When revisions are indexed, all the latest versions of the previous
revisions will appear in the search results. The search will find version 3 (Base), 6(A) and 7(B).

• All Revisions to display all revisions of the document.

• Base Revision to search for the first revision of the document.

• Specific Revision and specify the revision letter in the field.

Tip:

Searching based on Project Status:

You can specify Project Status as a criteria in Project Search. To do so, select the Project Status
from the drop down. Read more in:  Searching based on a Project Status on page 175

To type in a custom value (or to use wild cards /AND/ OR etc.) click the edit  button.
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Tip:  When you are searching for Tasks based on task specifications:

• click on the link Task Specifications and start typing the name of the specification

• or select from the drop down listing all specifications.

4. Use the Search Results Options to determine what you want to see in your search results and in what
order.

5. You can also:

• clear all fields: click Clear this form.
• save the search query for future use (see To Save a Search on page 562).

6. Click Search to search using the criteria you entered.

Note:  For normal searches, WebCenter searches all the fields available on the Search page. Each
document type in the Search for list has different searchable fields.

The Search Results page shows your results.

• You can view your Project search results in a List or a Grid or a Card, and choose to view the
thumbnails or not.

• Task and Approval Searches can be viewed only as a List

• Document searches can be viewed as Card or List or Grid.

 

 

When using Card search, you have a catalog like view of your Documents. To view the related

information, click .
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The number of items displayed in Card, List or Grid is set in Preferences.

Note:

It is possible to configure a specific Saved Search to always show up as card view in the Search
Results Layout options.

The Card style Search provides a new way of displaying Document Search results. The new Card
style is more image-centric and allows to hide additional metadata initially.

Note:  Search results display only projects or documents for which you have View permission.

Use Basic and Advanced Search Character

Basic Search
You can type in multiple words separated by spaces when searching and generally these words do not
need to be in a particular order. However, when in Document, Project, Template and Task names or
Attribute related fields, the order of the words is respected.

Remember:

If there are no search characters (* ? "), basic or advanced, the search adds stars (*) around every word.
The results will show anything that starts, ends or contains the word you are looking for. Text attributes
have an exception that the stars are not added automatically.

For example, if you search for box company, it will return results which include both words but it could
also find boxed instead of box.

The basic search characters *, ?, NOT, OR, AND, EMPTY ,"" are always available when searching.

Searching with NOT You can use either NOT myvalue or * NOT myvalue*

Search  AND /&& , OR /|| , NOT  operator  priority order

Note:  If you have a saved search before WebCenter 20, where you use a combination of AND, &&, OR, ||
or NOT without brackets in a single filter, then you might need to add brackets to get the same behavior
as before.

The new operator order is:

1. NOT
2. AND / multiple parts without operator (implicit AND)
3. OR

Example:

EMPTY OR “esko webcenter” NOT test AND production will become: (EMPTY OR (“esko webcenter” AND
(NOT test) AND production))

In the example, first the part with NOT is executed, then executes everything next to each other
(including AND, words, wildcards and parts surrounded by quotes) and combine those parts with AND.
Lastly both sides of the OR are compared, to return the documents that match any of the two sides.
Add brackets to influence the order of execution.

See other examples below:
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box company The search results will contain both box and company in no
specific order. The results may also contain boxed.

If you would like to search for a string with multiple words,
type them with a space in between them. The order is not
important. The search will return results containing both
words.

“box company” If you need the words to be exact (so not sub-strings) and to
be in a particular order, use "" around the words.

box comp* If you want to only find results for prefix or suxes, you can
use stars. The search will only look for the substrings for the
words where you added a *.

A search with box comp* will find "company" and "box" but will
not find "boxed".

com?any Use ? as a placeholder for an unknown character.

The search will not find substrings when you use ? .

A search with com?any will find "company".

box OR company If you don’t need the results to contain all words but want to
find results that contain any of them, use OR (uppercase!).

The example will find results that contain "box" or
"company" (or both).

box AND company Use AND to combine words in the search.

The example will find all results containing both "box" and
"company".

Note:  This is the default behaviour when you type in two
words together.

box NOT company Use *NOT to exclude results that contain the term after the
NOT from the results.

For example you want to find all documents containing box
but not company.

EMPTY You can search on the keyword EMPTY which allows you to
search for any documents, projects or tasks where some text
attribute or other text property is not filled in.

For example, to search for projects that are not created
from a template, search with keyword EMPTY on the Project
Template field.
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By combining with the OR
keyword, you can also search for properties which are empty
or have a specific value.

Advanced Search
If you want to perform a more precise search, enable Use Advanced Search Characters.

 

 

Note:

When using the advanced search characters, the search won't include the sub-strings. If you would like
sub-strings to be included, add *.

(box company) OR (apple raspberry) Use ( ) to group queries. This example search
will find all documents containing box and
company along with all documents with apple
and raspberry.

company~0.9 Use ~ after a word to find words which might
contain typing errors.

In the example, the search will find all words
that have a 90% match with "company". This will
also find "company" or "copany".

“company boxes”~3 Combine "" and ~ to search for words in a
particular order with some flexibility.

The example search will find "company" and
"boxes" in that order with up to 3 other words
between them. It will find “company that
produced boxes”.

Jean\-Luc or "Jean Luc" If you need to search for a special character,
you can use "" around it. You could also escape
the special character with the “\” character like:
Jean\-Luc.

box && company && does the same as AND, || does the same as
OR.

556



4WebCenter

When Advanced Search Character option is OFF
When the option Advanced Search Character is not chosen, the search will try to guess whether you
want to use a special search character or not.

For brackets for example, typing: Esko (Belgium) will still search for the text “Esko (Belgium)” (brackets
are interpreted as text).

However, searching for  (Esko (Belgium) OR Esko (Spain)) AND WebCenter will consider the first and
last brackets as special characters to group the OR while the other brackets are considered text.

Note:  When searching for Attribute values, the strict interpretation of Advanced Search Characters is
always on.

Search Result Options

Use the Search Results Options to determine what you want to see in your search results and in what
order.
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View
Select the information you want to see when viewing the results.

For example, when selecting Description, Created date and Project Manager (the Project Name is
always shown), your results are displayed as below.
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Note:

If the Administrator has enabled Editable items, you get an Edit  button next to the selected items
in the List View.

You can also show the time in the search results for the Project Due /Modified /Created dates by
enabling Show time in search results.

Column Order
Use the Column Order column to define how to display the information for each Project found: enter
numbers to order the columns (in List View) or the text under the project icon (in Grid View).

Note:  The first column is always the Project Name.

Sort
Use the Sort column to define how you want your results sorted. First click the check box of the first
sorting criterion, then the check box of the second, etc. WebCenter shows numbers indicating the
sorting order.

For example, if you want your results to be sorted first by Project Manager then by date created, first
click the Sort check box for Project Manager (this shows a 1 beside it), then the Sort check box for
Created (this shows a 2).

Read more about sorting in Sorting Search Results on page 200.

Order
The order column shows the sorting order (1, 2...) but also allows you to sort by ascending or
descending order.
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• Ascending order  sorts from A to Z (for alphabetical fields like Project Name) and from old to
new (for chronological fields like Created).

• Descending order  sorts from Z to A (for alphabetical fields) and from new to old (for
chronological fields).

Configuration Options
Display User

To enable the navigation and filtering for specified users in the search results, you can choose to
configure fields like Project Manager, Project Creator, Sales Person, Version Author, Pending
Approver in the Search Results Options. You can choose to show the results either as Name or Avatar
and Name or Avatar only.

 

 

Similarly for Task Status, you have an option to show the results as Label only or Icon only or Label and
Icon in the search results.

Sorting Search Results

You can sort the search results in the List / Grid view based on sort-enabled search columns.

In the List Layout:

You can click on the primary sort field header  /  to switch between ascending and descending. All
sortable fields will have the sort icon next to their header text.

To change the primary sort field, click on the sort icon next to it.

• Up arrow  in the column header indicates that the results are sorted on this field in ascending

order. To sort the results in the reverse order, click .

• Down arrow  indicates that results are sorted on this field in descending order. To reverse the

order,click .

In the Grid Layout:
If the search results are in the grid layout, you will see a drop down with sortable fields instead of the
sort icons.
 

560



4WebCenter

 
For example, sorting by Name / Reversed Name will make the name field in the ascending or
descending order.

Note:

The configured sort fields will be applicable in both the grid and list layouts.

You can navigate to the page number you want by typing the page number in the footer. If there is only
one page to show the results, then there is no footer shown.

Keyword Searching
You can use the Search setup page to search based on a vast array of parameters. However, it is also
possible to search using a single Keyword.

It is also possible to setup a Keyword search in the Search Panel. This is useful when you want to create
Saved Searches with a Keyword field.

• The easiest way to access the search is using the top right menu bar. Enter the terms to search in
this Keyword Search field.

Tip:

Keyword searching is also available in the header of every WebCenter page, at the top right under
Welcome, Contact, Logout... You can search for Projects, Documents or Saved Searches in this
search bar.

 

 

• Alternatively, in the Search menu, click Projects, Documents or Tasks, depending on what you
want to search. From the normal Search page, you can use either:

• the Keyword Search link.
• or the Keyword field.

• Click the link Try Keyword Search to get a simplified page.
a) When using keyword searching, you see the Keyword Search field.
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b) Type in your Keyword and click Search.

• For keyword search of projects, WebCenter searches the project name, project description,
project characteristics, the modification date, and text attributes.

• For keyword search of documents, WebCenter searches the document name, document
description, document characteristics, project names, approval status, and text attributes.

c) Click Search to search using the keyword(s) you entered.
• If you'd like to use SmartNames in the Keyword field or if you want to create a Search Panel with the

Keyword field, use the Normal Searching page.

The Search Results page shows your results. If you want to save the search, click Save Search As...

Alternatively, you can choose Save Results to Excel to download your search results in excel format.

You can choose your desired view of results by clicking Show as List,Show as Grid,Show Thumbnails
or Hide Thumbnails.

Note:  Search results display only projects or documents for which you have View permission.

Advanced Searches

Use the Search menu to search content in WebCenter. You can search for:

• Projects
• Documents including their revisions.
• Tasks
• Reports

You can create Saved Searches based on your chosen search criteria. If you are an administrator, you
can create advanced asset browsers this way. Read in Searching and Browsing Assets on page 564

To Save a Search

1. In the Search menu, click Projects, Documents or Tasks, depending on what you want to search.
2. Define your search criteria.

For more information, see Search on page 550.
3. Click Save Search As and the search results are downloaded in the excel format.

The Save Search page appears.

Alternatively, you can also Save Results to Excel .
4. Do one of the following:

• To create a new saved search, type a Name for the saved search.
• To update/change an existing saved search, select it from the Your previously saved searches

list.
5. Administrators have to select one of the following Search scope options (other users can only save

personal searches):

• Personal, if only you should be able to see this saved search.
• Global, if all users of the system should be able to see this saved search.

6. Click Save.
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You can read more about working with Saved Searches in Creating Advanced Saved Searches on
page 183.

After editing an existing Saved Search, click Save to update the search and Save As to create a new
Saved Search.

Downloading Search Results

You can download the results of your search as an Excel file (.xls).

1. In the Search Results page, click Save Search Results.
2. In the pop-up that opens, choose to Open the resulting Excel file in your spreadsheet application, or

Save it to your hard disk.
When the Save Search Results are generated to save in an Excel, a progress indicator is shown on
the button. This feature is currently not available in Safari Browser.

Creating Advanced Saved Searches

Normal and keyword searches may be saved for future use as a Saved Search and can be plugged into
menu items (of the main menu or Project details menu), My Work and as a document source during
project creation and in document referencing.

To access saved searches, click Search > Saved Searches. Shown below is a sample Saved Searches
page.

Searches can be saved as:

• a Personal  search visible only to the individual user.

• a Global  search visible to all WebCenter users.

Note:

1. For each Global Saved Search, an Administrator can determine a set of Groups/Companies/
Locations whose members can view this Saved Search.

2. It is not possible to set Visibility for Personal Saved Searches.

Saved Searches can be configured with advanced Drilldowns and extensive and visually enhanced
Dashboards. You can plug these

• To execute a Saved Search, simply click its name from the Saved Searches page. Or select it from
the Search window in the menu bar.
 

 
•

To edit a saved search, click Edit Search.
•

To Make Search Personal, click 
• To Make Search Global, click 

563



4 WebCenter

Smart Names  enabled Searches do not have the Make Search Personal option.
•

To create Global Saved Searches dedicated to a company or group, click  Edit Visibility link.
In the next window, select the Available Groups, Available Companies/Locations to whom you
want to give the exclusive visibility. In this case, if you assign the visibility to a group, a company or
location, the search will be visible to either the group or the company or both.

 

 

Note:

If you select a company without specifying any of its locations, all the company locations will be
able to access the saved search.

If you remove the Available Groups/Companies /Locations, the visibility settings will be modified.

• To delete saved searches, select them and click Delete. Use Select All and click Delete to delete all
of them.

Running Reports

You can run pre-configured reports from the Search menu if your Admin has given you access to these
reports (see the Administration Guide for more information).

Note:  This only includes system-wide reports. Project reports are available from within the project.

1. Go to Search > Reports.
2. Click on the desired report name on the Reports page.
3. If the report requires parameters, the Run Report page appears. Specify the report parameters (the

mandatory parameters are marked by an *) and click Run Now.

Searching and Browsing Assets

The asset browser is a user-friendly feature to search and find assets in a large collection of
WebCenter assets. The administrator can customize the Asset Browser into a Menu for easy access.
You can use the configured Asset Browser to browse for assets stored in the WebCenter.
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In the Asset Browser you can:

1. Select the browsing options in the Asset Browser. You can choose to see the left Panel (the
browsing tree) or the top panel (with images). You can also choose to have both options.

2. Browse the tree(s) on the left panel to select the items based on the visible attributes.
3. You can use the options in the Search Panel at the top to refine the Asset Browsing (Searching)

results in addition to the tree selection.
4. If you opted for the image panel, you can browse through the image representations.
5. Select the assets from the results to download or view them (by clicking the Actions menu).

You can select the assets and start actions directly from the action list menu if you have all the assets
that you need in one single page. You can download the assets, view them or start a new projects with
the selected assets from action list.

If the Cart is configured in the Asset Browser, you can use it to collect items from several rounds of
searching. You can then download or start with a new project from the Cart.

 
Tree Browsing in the Asset Browser

You can see an example for tree browsing in Asset Browser below.
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• There are different trees with multiple branches for each of these as well.
• If you want to select the sub-brands of Esko, select them one by one. In this example, DeskPack,

Dynamic Content, Studio and Visualizer are selected. Note that if you select the main branch, all
the sub-branches will be automatically included.

• Refine other criteria from other trees according to your needs.
• Click on Search to get the assets filtered to your criteria.

Note:  If the Search button is not available in your Asset Browser, your results will be automatically
set according to your modified criteria.

You can see your selection on the top left hand side.

Note:  You can change the result layout from card layout to grid or list layout by clicking on one of the
buttons at the bottom right.

Graphical Browsing in the Asset Browser

Graphical Browsing is possible when the administrator has configured the Attributes with associated
images. Image browsing is straightforward like tree browsing and an example is given below.
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• There are three lists (Brand, Packaging and Product) in this example. You have multiple Attributes
under each of these lists. For graphical Asset Browsing, you need images configured for the lists
and Attributes.
Administrator rights are necessary for adding images to Attributes and lists.

• To select sub-brands, click on the image representation. This will bring out the images representing
sub-brands on the top image pane. Note that if you select the main branch, all the sub-branches will
be automatically included as search criteria.

• Refine other criteria from other lists according to your needs. In this example all Attributes under
Packaging and Product are selected by selecting the list images.

You can use the triangular back  button to go back one step at a time.
• Click on Search to get the assets filtered to your selections.

Note:  If the Search button is not available in your Asset Browser, your results will be automatically
set according to your criteria.

Using the Cart from the Asset Browser

You can use the Cart in the Asset Browser to assemble the assets selected from the Asset Browser.
From the Cart, you can:

• start the viewer
• download the assets
• start a new project with these assets
• modify the assets.

You can do several rounds of searching and browsing to add documents one by one to the Cart and then
proceed with the actions listed above.

Note:  The Cart has to be configured by the administrator while determining the settings of the Asset
Browser (the Saved Search). Read more in Configuring the Cart in the Asset browser on page 222
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You can read more about Cart in Using the Cart on page 587

Creating a Project from the Asset Browser

Your Packaging Projects often involve modification of existing packaging or creation of new packaging
with recurring elements. You can use a template for the recurring elements. Asset Browser will help
you to browse for these templates and existing packaging projects. You can start creating a project
directly from the Asset Browser. You can do this by:

• using the Cart to collect items and starting a project using Create Project from Cart link.

• or by selecting the Create Project from Selected option from action list menu.

This will lead to the WebCenter project creation user interface.

Note:  The administrator has to enable project creation this in the Saved Search settings. Read more
in Configure Project Creation from the Asset Browser on page 224.

 Bulk Editing in Search Results

Fields selected as editable in the Search Results Options page during configuration are available in the
header of the Search Results page. You can also click on the pencil icon next to the field name in the
search results to perform bulk edit.

Note:  Only Admin Users or Project Managers can set the fields to Editable for Project searches
whereas all users can select for Document and Task and Approval Searches. Admin users can also
enable Bulk editing in the Search Results Layout option.

You can select the item(s) for bulk edit in the pop-up or select the pencil icon next to any of the editable
field(s) in the header and choose the change both for the field and the rows.

You can add/remove items in the selection, sort columns or move to a different page of the search
without losing the current selection. While selecting, filtering and sorting, you will see an upto date
preview of the changes done.

Note:  Inline editing of individual field is not possible when bulk editing is in progress.

A Warning is displayed, if the edit is not possible due to the permission not available for the user.

Fields editable in Search Results
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Search Results can be edited in Bulk by all the users (based on permissions) in Project or Document or
Tasks and Approval Search results. Only the Admin user can set certain fields like Task Specifications
and Attributes as Editable.

You can edit the following for

• Project Searches: Project Description, Project Status, Project Due date, Project Manager Project
Salesperson, Attributes

• Document Searches: Document Description, Attributes

• Task Searches: Task Description, Task Assignee, Task Due Date, Task Specifications, Task
Estimated Date, Task Status

Note:  Tasks that require password for completion cannot be done in bulk editing.

 

 

An example of re-assigning tasks in bulk is shown in the image above. You can select some tasks and
bulk change the assignee. For the tasks you selected, changes are shown immediately and warning
message is displayed when changes are not done.

 Bulk Operations in Saved Search
Updating Attribute Category, Project Member or Project Permissions in Bulk

You can change the Project Attribute Category of multiple projects from Project Search results in one
go. Also, you can add Project Members to multiple projects and set their permissions.

1. Go to Search >  Saved Searches. Select one or more projects from the Saved Search Results.
2. Select the Projects for which you want to change the Project Parameters.
3. Use the buttons Change Attribute Category or Manage Members/Permissions in the table header.
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• To change the Attribute Category, pick an attribute category from the list.
• To add a Project Member, first choose whether you want to add a User, Group or Role. After

that, select a user, group or role from the list, or start typing to find the one you want. Once you
have selected your desired new project member you can immediately modify the new member's
project permissions.

You can specify Custom folder permissions for inviting Project Members in the bulk operation.
Use Add folder link to add a new line. Specify a set of permissions for the folder by typing in
the folder name inside the provided edit field. Only the specified folders' permissions will be
changed. Permissions on folders that do not exist in a given Project will be skipped

You can take out the Root permissions from the list. If no Root is in this list but the member is
new to the project, he will only get view rights on the Root.

Note:  The selected User, Group or Role will be invited if it is not yet present in the Project.

4. Click Start and wait for the action to complete. You will be notified of any issues regarding the
operation.

5. Click Close to close the dialog. Your search results will automatically update.

Updating Role Members in Bulk

1. Go to Search >  Saved Searches. Select one or more projects from the Saved Search Results.
2. Select the Projects for which you want to change the Project Parameters.
3. Click the pencil icon for the Role you want. Or select the desired bulk action from the table header.

 

 

Assign Project Role Member dialog will open.
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4. In this window, you can Add members to role or Replace members of role.
5. Change the value of the desired parameter:

a) Select a User and/or Group to assign to the role.
b) You may add multiple assignments using the actions buttons.
c) Select whether to add the members to the group and replace the members.

If the members are replaced, all blocking tasks and approvals will be moved to the first of the
new members.

6. Click Start and wait for the action to complete.
The dialog will indicate which projects were successfully modified. It will also list all of the
problems.

7. Click Close to update your search results.

Searching on Documents

Search by Document Size
Users can search for documents which are of a certain size range using Version Size.

Version size will only show the size of the version of the document shown in the results. The size of the
previous version of the document is not shown.

The Version Size criterion is available for all document types. You can search, sort and facet on the size
of the document version (in bytes).

Search by Document Created Date
You can search the documents based on the creation date in a range or in the specified previous
number of days and make it hidden or visible or available in the results.

Folder Search
You can search for the folders and it is described in detail here.

Live Text in Document
You can search for a text within a pdf document or a AI file using this Live Text in Document. This field
is available for search, based on the setting in the Search Crawler configuration set by the Admin user.
This search does not find results for the text present within an Image or outlined text.

When the search results are shown as a Focus layout with a viewer block, the matches for the searched
text are highlighted in the document. You can navigate through the matches to see where the searched
text occurs. The number of instances of the text occurring in the document are shown in the header.

Note:  This field does not support right to left text used in languages like Hebrew, Arabic.
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You can navigate through the matches to see where the searched text occurs.

 

 

The number of instances of the text occurring in the document are shown in the header. When multiple
pages contain a match for the searched text, it is indicated with an asterisk and navigating through the
matches will also navigate through the different pages. By hovering over an arrow, you can also see the
number of pages containing a match.

Search for Live Text in Document only works on left to right text. For example, text in Arabic or Hebrew
are not supported yet.
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Searching for Text Content Document

Search and Select Text Content in Search Menu
To search for Text Content, go to Search >  Documents > Search for > Text Content.

 

 

You can search based on the Text Content Criteria such as:

• Element Type: To search for a document based on its Element Type, select it in this field. Smart
Names are available when Enable SmartNames is selected. Read more in: Element Types.

• Document Status: To search documents based on its status, select the status (Draft  / Signed Off)
from the drop-down.

• Statements' criteria: These fields allow you to select and search based on:
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• Language of the Text Element. For example, select English - United States to search
for Master statements in English (US).

• Whether the Element is a Translation or Master. It can be specified in the Translation drop-
down.

• The directionality of the text will be based on the language selected. You can search both
Master and Translation languages for right to left languages like Arabic or Hebrew.

Note:  You can also leave these fields blank. If the language field is blank, all languages (both
Master and Translated) are searched for.

• Actual Text from statements: Type the word you want to search in the Text field.

• Text Element Status: Click ... and select the status from the drop- down. For example, you can
search for Signed-off statements with a particular text piece.

• Modified: Specify the time line you wish to search for like today, yesterday or last month etc .

• A combination of Text Statements' criteria

You can add new rows for additional search criteria by clicking +. When you have multiple rows,
you can use either AND or OR operation to refine the Search.

You can also ignore the search criteria mentioned and only display the results by choosing 
icon or you can choose the Any option to show results of text documents in any of the status.

In the example screen shot, the Search will find all Master Statements with Nutrients in its
content AND with French- France as Translation.

Configuring Text Content Documents Search Results

The Search Results page shows all Text Content Documents that match the specified criteria. Each
statement row selected to View is represented as a single column in the Results.
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Note:  You can save Text Document Searches in Excel. The document statuses are not included in the
Excel export.

Search Results Options
To customize the Search Results, select your criteria in the Search Result Options fields. The
Document Nameis selected by default but can also be removed by unchecking the box. Read in:Search
Result Options on page 557.

Search Panel Design
As an Admin, you can setup a Text Content Search with a Design Panel just like other document saved
searches. The users can select individual text statement criteria in the Panel to filter the search
results.

Note:  When smartname is selected for the language field, to view each resolved language in a
separate column in the Search Results page, select the view as visible.

 

 

Note:

• If no Statement language is selected from the language drop down, you will not be able to view it as
a separate column. The results will then match Text statements of any language.

• If the language chosen for the text has the directionality right to left or a custom font, then the text
is also rendered right to left or in the custom font in the search results.

Saved Search for Text Content Search
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To view My Saved Searches, go to Search > Saved Searches, you can view the saved search in the table
under Text Document Searches. Saved Search for Text Content Document behaves exactly like any
other document saved in the WebCenter.

Note:  Only an Admin can modify the visibility of a Global Search.

Search Strings Examples
Shown below are different search phrases and their results. For more extensive help on searching,

click Help in the Search page.

Sample search string Results What it does not find

box box products

box company

box co. inc.

bottle holders

bo* box products

box company

box co. inc.

bottle holders

box NOT “box company” box products

box co. inc.

box company

bottle holders

box AND company box company box co. inc.

box products

bottle holders

“box company” OR “box co.” box company

box co. inc.

box products

bottle holders

box AND (products OR company) box company

box products

box co. inc.

bottle holders

* NOT *company* box products

box co. inc.

box company

My WebCenter
The My WebCenter menu contains items specifically related to your user.

My Profile
My Profile is where you set your name, your e-mail address, your phone numbers, your function, picture
and your company/location.
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User Avatar

You can choose to upload your picture or select one of your previously uploaded picture as an Avatar
which is reflected in all places in WebCenter like Dashboards, Discussions My Work and so on.

Note:  Your Administrator can also change your picture.

My Password
The Password field is where you change your password. Enter the new password in the Password and
Confirm Password fields and click Change. To set a blank password, enter nothing in the fields and
click Change.

Note:  This presents a security risk and is therefore not recommended.

If the Passwords must meet complexity requirements option is enabled by the Admin user, then your
WebCenter password:

• May not contain the user's username, first name, or last name
• Must be at least "X" characters, where the minimum password length "X" is defined by your Admin

user.
• Must contain characters from three of the following four categories:

• English uppercase characters (A through Z)
• English lowercase characters (a through z)
• Base 10 digits (0 through 9)
• Non-alphanumeric characters (for example: ! $ # %)

• Must be different from the previous " Number" password(s), where the number of previous
passwords is defined by your Admin user.

If the option is not enabled, then the only requirement is that the new password is not blank and not the
same as the previous password.

Single Sign-On Settings

You can view the Single Sign On settings specific to your User account in the My WebCenter > My
Password page. This page will display the Single Sign On Instances that are enabled for your User
account.

You may modify configuration details of the Single Sign On Instance depending on your permissions to
do so. If you have permission to modify, all your values will be saved.

Note:  User specific settings are possible when the Single Sign On Instance supports user specific
configuration.

My Preferences
In My Preferences you set the unit system used to display data, the language used, the display of
thumbnails, your start page, and the grid size for search results (for Esko ArtiosCAD and Graphics
documents) and discussions.

General
• Language sets the language used by the user interface.
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• Start Page sets the page that appears when you log on. You can, for example, select a Saved Search
with a visual Dashboard as the starting page.

• Units sets units for all measurements to either Metric (mm, cm, dm, m) or Imperial (in, ft, yd).

• Thumbnails: selecting Show thumbnails shows thumbnails in document lists by default.

• Cart: Clear Cart on Logout is always enabled by default. Disable this option if you want to access
Cart contents in future sessions.

• Your Browser Timezone shows the timezone used by your browser and WebCenter.

Project Lists
• Show ... Rows sets the number of projects displayed in the List layout.

Document Lists
• Default Layout sets the default view for document lists: Grid or List or Card layout.

• Show in Grid sets the number of documents displayed on a single page in the Grid layout (defined as
a number of Columns and Rows in the grid).

• Show in List sets the number of documents displayed on a single page in the List layout (defined as
a number of Rows in the list).

Search Results- All
Show in List sets the number of documents displayed on a single page in the Search results List layout
(defined as a number of Rows in the list).

Search Results- Documents
• Default Layout sets the default view for document Search results pages to Grid, List or Cards

layout.

• Show in Grid sets the number of documents displayed on a single page in the Search Results Grid
layout (defined as a number of Columns and Rows in the grid).

• Show Cardssets the number of the documents displayed in Card View on a single page in the
Search Results.

Search Results- Projects
• Default Layout sets the default view for project Search results pages to Grid or List layout.

• Show in Grid sets the number of projects displayed on a single page in the Search results Grid
layout (defined as a number of Columns and Rows in the grid).

Discussions
• Discussions per Page sets the number of discussion threads displayed per page on the

Discussions pages.

• Postings per Page sets the number of discussion posts displayed per page on a Discussions page.

Viewer

• Select your Viewer Type. You can set your preference to the HTML5 Viewer or keep at the default (
Java Viewer ).
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Note:  You can always switch to Java Viewer from HTML5 Viewer using the  button.

• Viewer and Workflow Applet: When opening a document in the Viewer or when creating a workflow,
WebCenter will download a Java applet to your computer.

From Java 1.7.0_21 (for Windows and Mac OS X 10.7 or later), you will get a security warning as the
one below when the applet is downloaded. This makes the WebCenter applet look like a security risk
for your computer.

 

 

You can adapt how this security warning will look like when downloading the applet. In Viewer and
Workflow Applet, choose either:

• Signed (sandboxed) if you want to run the applet in a strict sandboxed environment (with no
access to your computer's resources). As the applet is signed by Esko, the security warning
looks less threatening.
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Note:

As the applet is sandboxed, it will also show a warning when trying to print from the Viewer. You
will just need to click OK to be able to print.
 

 

• Signed (not sandboxed) if you want to run the applet without restricting it to a sandbox (the
applet can request additional access to your computer's resources). This means that you will not
get an additional warning when printing from the Viewer.

As the applet is signed by Esko, the security warning looks less threatening.

 

 

• Unsigned if you want to run the applet as a default unsigned applet. You will get the default
security warning that does not mention Esko, but the applet will be sandboxed. This means that
you will have an additional security warning when printing from the Viewer, as for the Signed
(sandboxed) applet.
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Tip:

By default, the applet is set to run as Signed (sandboxed). This will work fine for most users.

More frequent users may want to switch to the Signed (not sandboxed) option to avoid always
having to click an extra warning away when printing from the Viewer.

Mac OSX 10.6 users running Java 1.6.0 may also want to switch to the Signed (not sandboxed)
option to avoid getting a warning when closing the Viewer by clicking .

With the latest versions of Java 1.7 installed, most browsers block unsigned applets by default. In
this situation, it is recommended to use one of the signed settings instead.

• Viewer Style (Java Viewer) sets the Viewer mode as:

• Normal (Default): All HTML5 Viewer features are available in this mode.

• Restricted: In this mode, the user cannot access features such as Channels widget, CAD widget
and View widget.

The side panels displaying the widgets will be in a collapsed format by default.

• Advanced: In Java Viewer all features are activated.

• Viewer Workspace: Select any workspace from the drop down or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

• Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter viewer, when they are shared with a document to view or to approve.
Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.

• Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

• Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.

• Select Enabled if you want the users to be allowed to annotate approved documents.

• Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

• Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

• Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

• Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.

• Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note:  A document version is considered under approval as soon as an approval cycle is started
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Choose from the following settings:

• All Users: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

• All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

• All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

• Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

• Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.

• Specify the Viewer Quality as:

• Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

• Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Note:  This setting is applicable to both the HTML5 and Java Viewers.

• Settings for Automated Artwork

Note:  The below options are visible only when Automated Artwork license is enabled.

• Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

• Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note:  This option requires Packaging Content Management License.

• PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note:  This option requires the Packaging Content Management License.

• Log out user when inactive  Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

• Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.

• Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note:  Project Managers who can Force Approve or Force Reject is not considered an approver. They
can add annotations only if the setting is All Users.
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ArtiosCAD

To open your document in the ArtiosCAD desktop application directly from the WebCenter server, you
need to set the ArtiosCAD Preferences accordingly.

Open ArtiosCAD Documents
• No Application: This is the default Preference. When this is selected, you cannot open the

documents in the ArtiosCAD desktop applications.
• ArtiosCAD Standard Edition: Select this setting to be able to download ArtiosCAD documents and

open them in your ArtiosCAD desktop application.
• ArtiosCAD Enterprise Edition: Select this to open your ArtiosCAD documents in the installed

ArtiosCAD Enterprise Edition directly from WebCenter.

The documents will open in the managed mode allowing you to make modifications to the file and
update it without having to browse to the corresponding project and folder.

Note:  This option is only supported from ArtiosCAD Enterprise 14 onwards.

Document Upload Preferences
• Allow raising Document Revision when uploading a new Document Version: Enable this to allow

the users to raise the revision while uploading a new document version.
• Allow Instant uploading when selecting documents: X Choose this option to start uploading

documents immediately when they are selected, while the rest of the page is still being filled in or
other documents are still being selected.

•

Workflow Editor

By default, HTML5 is used as Workflow editor.

User Creation

To create a new approval User from an approval page quickly, you can select and apply a particular
user's settings as the Approval User Template.

Tip:  If you do not want to take up a license for a Template User, deactivate the user by unchecking the
Active User option in the Profile page.

It is possible to configure this at two levels.

• To specify a global template, go to Admin > Preferences > General > User Creation Preferences.
Select a particular user existing in the system as your Approval User Template.

This template will be set as the system wide approval user template. However, it is possible to
override this in My WebCenter > My Preferences > User Creation Preferences.

• To specify a template for a User who can create other users, go to My Preferences > User Creation
Preferences and specify an Approval User Template. You have the following options and your
choice will override the admin settings:

• Do No Use a Template
• Use Global Approval User Template to apply the user template specified in the Admin

Preferences.
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Note:  If you have not explicitly selected the Do not Use a Template option or has any other user
specified as the template, the global template will be applied by default.

• You can select a particular user as your template. In the drop-down you will see your own Users if
you are a Project Manager and all Users if you are an administrator.

The following Preferences and settings of the template are copied to the newly created user:

1. Preferences:

• Language

• Units

• Start Page

• User Menu

• My Work Setup

• Viewer Preferences

• Collada Viewer Preferences

• Workflow Editor Preferences

• Document Upload Preferences

• ArtiosCAD Preferences

• Download Formats(copied only if the user creating the new user is an Administrator)

• Group Memberships(copied only if the user creating the new user is an Administrator)

• Other Preferences are the user preferences not mentioned above (for example: show
thumbnails or not, search results layout, etc.).

2. The Authentication Settings (Deactivation, SSO, etc.)

My Locked Documents

My Locked Documents shows documents you have locked to indicate that you are currently working on
them. If other users try to download a locked document, they will have to confirm that they really want
to download a locked document.

Note:  In order to lock a document you need specific permissions.

Only the person who locked it, or the Project Manager, or a member of the Admins group can unlock a
locked document.

To unlock a locked document, select the checkbox to the left of its name and click Unlock. The
function Upload New Version of the document also unlocks the document.
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Note:

Unlocking a document without uploading a new version does not make any changes to the document.
In order to change it, you must lock it, download it, change it as desired, and upload it as a new version.

My Users
In case you are a project manager with Create User  rights, you can see the users that you have created
on the My Users page.

My Group's Tasks
In case you are the Group Task Manager for one or more groups, you can find the tasks assigned to your
group(s) on My Group's Tasks page.

My Group's Members
If you are a Group Manager of a specific Group (or multiple Groups), you can use My Group's Members to
manage your Group members.

Note:  The administrator has to give you the Group Manager permission to access the Group members.

• If you are the Group Manager for more than one group, specify the group by the Group Name. This
will allow you to see the members of the selected group.

• From this page, you can:

 

 

• Remove User(s) from the members of the group.

Note:  The group manager cannot remove himself / herself from the list.
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Remember:  If there are dependencies such as a pending approval associated with the member
being removed, the removal will not be effective. You will be warned about those dependencies
during your attempt to remove a member.

• Add Users to the group. Your permissions and visibility determine the potential users whom you
can add as the group members.

If you are a :

• Project Manager, your Visibility settings affect whom you can add as members.

• Normal User, you can add the Users associated with the same Company..

• Select from Notifications settings to Send notifications to a Group e-mail Address. You can set
the Group E-mail address  and the language to be used in the group Group E-mail Language by
selecting from the drop-down menu. All notification mails will be sent to this e-mail address.

My Delegates
If you have added delegates, you can view the delegates and the details of delegation on this page. See
below:

• The name of your delegate(s)
• The start and end date of your delegation(s).
• Permanently active delegation(s) which are the delegations without a specified end date.
• Comments
• An option to Delete the delegation in progress
• An option to notify new delegates. This option when checked notifies the delegate of any changes

you made to the relevant delegation.

Create
You can use this menu to create projects or users. You can only see it if you are a Project Manager. See
Project Management in WebCenter on page 784 for more information.

Upload
Use this menu to upload documents into any WebCenter project for which you have upload
permissions.

See Different Ways to Upload Documents on page 591 for more information.

4.2.4.  Filtering Content

As more information is managed over time by WebCenter, some pages can potentially show large
amounts of information. To reduce the time needed to show the page when it first loads, some pages
have a filter.

To use the filter, enter a search string with an asterisk either before it, surrounding it, or after it in the

Search field, and click . For example, on the Companies page, to only see those companies with the

word Containers in their name, enter *Containers* and click .
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When filtering users, use the last name of the user.

To show all the items, up to the truncation limit, click with nothing in the field.

Note:  The truncation limit prevents lists of thousands of items from impacting response time; if you
know in advance that your search will return that many items, refine it with the filter. The truncation
limit can be changed; contact Professional Services at your local Esko oce for more information.

4.2.5.  Using the Cart

My Cart is a dedicated placeholder for a single user to gather a specified set of Projects and
Documents. You can add them to the Cart from the Project or the Document Actions menu. The Cart
also lets you Mail link to, Mail Download LinkRemove or Download multiple items at once.

 

 

The contents of the Cart (the count is displayed next to the cart icon) are retained only for the current
login session by default.

Note:

Your Cart contents can now be saved. Your can disable the option Clear Cart on Logout in My
Preferences to save the Cart contents for future sessions.

 

 

Click Change in My Preferences to clear/save cart on logout.

The Cart contents can also be cleared by clicking Clear Cartoption on the top-right corner.

Note:

Downloading multiple documents at once or downloading projects requires having a decompression
utility, or operating system support for opening compressed archives.

Mac OS X, Microsoft Windows XP, and Microsoft Windows 2003 Server have built-in support for opening
compressed archives.

When e-mailing an object from the Cart, only a link to that object is placed in the body of the e-mail
message. The recipient must have a username and password for your WebCenter site, so he or she can
log in to the site and see the object after clicking the link.

Shown below is a sample Cart.
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You may start the Viewer on documents in the Cart by selecting the desired documents and selecting
View and Annotate or Compare in Viewer from the Actions menu.

4.3.  Working with Projects and Documents

This section contains information on using WebCenter from an everyday use (non-Project Manager’s)
perspective.

4.3.1.  View a Project

• To view a project, click its name in Search, Search Results, My Work, Favorite Projects, Projects I
Manage Projects I Am Invited to.

• Click an underlined item to see more information about that item.
• Click a folder name to open a folder.
• Click a document name to see the Document Details page.

By default, clicking the document name leads to the Document Action History page, but if you click
a different page, WebCenter associates that desired page with the document type for the duration
of the session.

• You can use the Actions menu to perform various actions, based on the security settings you have
in the project.

• To view a document in a project, you can either click its name on any of its Details pages, or you
can download it to your computer if you have download permission. If you click its name, it will be
handled by your browser’s default method for files of that type.

4.3.2.  Add Documents

One of the main functions of WebCenter is sharing documents between project members in a safe and
traceable way.
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How Documents are Organized
Any document in WebCenter is placed at least in one project. The same document can however be
used in different projects at the same time, and are called linked documents. Linked documents
are used, when the same design needs to be re-used and synchronized between projects. If
synchronization is not needed, it’s better to copy the document and each of the documents are placed
separately in WebCenter. The vast majority of documents are in just one project.

Projects are organized in folders. Documents are put into a folder or on the root folder of the project.

Note:

Currently, WebCenter only allows going one level deep. In most circumstances, this is not a real
limitation, unless you try putting too many documents into the same project. WebCenter is well
equipped to work with extreme amounts of projects so it’s better taking advantage of this than
creating projects with entire sub-projects put into a folder structure.

Note:

Document names within a project are unique. When trying to upload a second document with the same
name in a different folder of the same project, you will get an error message.

WebCenter is fully “version enabled”. This means that each document can have multiple versions. By
default, you’ll only see the latest version, but you can go back to previous versions. In addition, there is
an action history showing when versions are uploaded and what actions took place on these versions
(for example approval actions). The viewer also allows comparing versions graphically.

Document Types
The following document types can be uploaded in WebCenter:

Note:  You can hover on any viewable file to view the expanded thumbnail. You can further click on
theZoom icon on the right top corner to view a larger thumbnail.

• Graphic file: WebCenter supports most common graphic formats. PDF, PS, EPS, AI, AP, EPF, DCS,
PSD, CT, LP, TIF, TIFF, PAF, GRS, PNG and JPG will all be recognized.

After upload, WebCenter will calculate preview data for the WebCenter Viewer.

If you don't want this, you need to upload the graphic file as an “other” file type. Typical examples are
oce-based PDF files (manuals, quotes…) which are better viewed in Adobe Acrobat.

• LENX: LEN is a bitmap file format developed for Esko's Cyrel Digital Imager ("CDI"). LENX is a special
version of the LEN file format developed for Esko's CDI Crystal Imager series and Crystal screens.

Note:  You can also upload a ZIP file containing graphic files (a set of TIFF or LEN files, or LENX files
or a PDF, GRS or AP file with external images) as a "graphic file", and view it directly in the Viewer.

• ArtiosCAD: Native files of Esko ArtiosCAD. The standard extension
are .ARD(Design) , .A3D(3D), .MFG (Manufacturing) and .ACD(Canvas).

• Cape: Cape is a program to calculate pallets and truckloads. WebCenter allows two ways to upload
files from Cape:

• uploading a triplet of files (You need at least 2 files: the CLF and XML files. The report / diagram
file (usually a JPG) is optional).
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• uploading a single ZCP file.

When you have uploaded a ZCP file, check the Cape Information tab in the In the Document
details page to see the information from the XML document. To view the report / diagram file,
click on the document thumbnail.

• Collada: Collada is an interchange file format for interactive 3D applications. Regular Collada files
have .DAE extension, Zipped Collada files use .ZAE.

• Page List: a multi-page document that will be treated like a Page List in WebCenter. A Page List
represents an imposed multi-page document, the individual pages of which can be approved and
version-controlled separately in WebCenter.

• CHILI Package:

This is CHILI WebCenter document type. A CHILI Package version is linked to a native CHILI
document on the CHILI server. Read more about CHILI  on page 155 in Administrator Guide.

• Text Content

This Document Type is for Text Content in WebCenter. When Text Content Document Type is
enabled, a .wcc will be recognized as Text Document.

• Component: Component is an unique file type which has no physical presence but acts a
placeholder for all the documents related to the product. Read detailed about Component file type
Component File Type on page 590 here.

• Other: any other file. Mostly these are oce files like Microsoft Word, Excel, PowerPoint etc. Video
files must also be uploaded as "other".

• URL: Here you can enter a link to another document anywhere on the network or on the Internet.
WebCenter does nothing else than remembering this link and allowing to define attributes.

Component File Type
The Component document type in WebCenter is a document type for holding only a set of attributes.
This can represent a non-file packaging component like a Copy Sheet or a Barcode, an alternative to a
project or a placeholder document for holding a packaging specification.

For example a collection of all assets required for a Product Content Sheet(PCS), that includes images,
symbols, Barcode, text statements, CAD files, 3D, Collada files and so on.

The Component document type shares most properties with other document types, but there are a few
exceptions like

• This file type does not have a physical file and have zero size.
• Document type will change depending on the extension of the uploaded document, when a new

version is uploaded
• Opening a Component will open a view of the Default attribute category

To Create/ Upload a Component Document
In the Upload page, choose the file type Component to create a new component type document. When
the mandatory fields are filled, click Save to create a new Component document.

You can restrict the file that can be uploaded by specifying a file type for the first version.

When no extension is defined for the first version, the document type is changed according to the
extension of the uploaded document.

Opening a Component document will allow you to view or update the attributes of the document.

Search for Component Document type
Component file type is available in the Search for drop down selector in the Document Search page.
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The available criteria are the same as for the All selector, but the results are filtered with the
Component document type.

Different Ways to Upload Documents
There are multiple ways to upload documents to WebCenter:

• Upload via Upload Document: use this if you only have a single document to upload, or to upload
documents one by one.

• Upload via Upload Multiple Documents: use this to upload multiple files at once, if you do not want
(or are not able) to use a Java applet.

• Upload via Advanced Upload Applet: This opens a HTML5 applet allowing you to browse or drag-
and-drop multiple files. These files are all uploaded in one go.

• Upload from a workflow system: Automation Engine, Odystar and Nexus can also upload
documents to WebCenter.

In many cases, it is beneficial to upload graphic files using a workflow system, because:

• It is quicker and automated.

• The workflow system can do calculation in advance.

• You have better control over the generation of the view data (when using Automation Engine).

• Upload from ArtiosCAD. Use this to upload CAD files. You can only upload one document at a time
but you can make the project selection and document name automatic. This makes uploading a
one-click operation.

• Upload by Drag and Drop Documents can be uploaded to projects or one of the folders of the
project by dragging and dropping them from the user's file browser.

Uploading a Document via Upload

1. You can either go to the project/folder you want to upload the document into and click the

 button, or just click the Upload menu item from anywhere.
When instant upload is configured by an Admin user, and a file is chosen for upload, the upload of
the file starts immediately. You can view the progress of the upload and there is an option to pause
or stop the upload.
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Note:  You can also drag and drop multiple files into the upload button, with the above option
selected.

2. On the Upload page, select the Project and Folder you will upload the document into (if you
are already in the project/folder, those are filled in automatically, but you can still Change the
Destination).

Note:

You can also select:

• Upload Multiple Documents to use the HTML5 upload. Just drag and drop files to upload them.

• Copy/Create Multiple New Documents to add multiple documents at once (either from your
computer, from another project or from a template).

 

 
3. Select the document to upload as explained below.
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If you want to... do this...

Upload a document saved on your computer or
network.

Select Browse in the Source list and click the
Browse... button to open a browser dialog.

Note:

If you are uploading Cape files, you can upload a
single .zcp file.

If you are uploading a Page List document, you
must also specify the Name and Starting Index
of the Page List.

Attention:

Graphic files must be self-contained
and may not contain references
to external files such as fonts or
placed images. Make sure fonts are
embedded.

In case you upload native files (GRS
or PDF Native), you should use the
Automation Engine Publish on Web
task.

If you need to upload manually anyway,
first make a self-contained file with
Outright. You can also convert to PAF
and upload the PAF file.

Copy a document from another project. Select Copy in the Source list, then select the
project to copy the document from, and the
document to copy.

Add a link to a document. Select URL in the Source list and type in or
paste the URL to the document.

Create a document placeholder from a
document template.

Note:  This is only available if the project
has been created from a project/template
containing document templates.

Select New in the Source list, select the
document template to use in the pop-up, and
fill in any attributes that may be required.

Note:  The document template's document
type will be used for the document placeholder
(except if that document type cannot be
copied, like Page List).

See Document Templates on page 162 in the
Administration Guide for more information
about document templates, and Assigning
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If you want to... do this...
Document Attributes on page 608 for more
information about attributes.

4. If you browsed to a document, copied it from another project or created a placeholder from a
template, the Document Type and document Name are automatically detected.
You can still change them if needed (you cannot change the Document Type of a placeholder or a
copied document).

5. Enter a Description (optional but strongly advised).
6. If you want to add this document to the Project's Bill of Materials on page 456, select Add to BOM,

then enter the Count of this document (how many copies are needed for the BOM).

Note:

You can only do this if:

• you are an Administrator,
• you are the Project Manager,
• you have the Change BOM permission.

7. If the document has attributes, fill them in (at least the required ones).

Tip:  The document has the attribute category associated with its document type in the Configure >
Document Creation tab of the Project (see Document Types on page 167).

8. If you want to use the default approval settings of the project/folder for the document, select Apply
Default Approval Settings (this is not available for document URLs).

Note:

You can also:

• Set the approval Due Date (only if you have the Change Approval Setup permissions): enter a
date or pick one in the calendar, then choose an hour.

• Start the approval cycle.

9. Click the Upload button.
10. If you want to define approval settings specific to this document, click Setup document approval.

This will bring you to the Approval tab of the document details page.

If you have the task management license, you can also upload a document to a task in a project.

You can upload documents the same way as described and the document will immediately be linked to
the task.

Note:  TIFF and JPG bitmap files using indexed color spaces or RGB are not supported by the
WebCenter Viewer.

Note:  When you try uploading a document which already exists in the project, the upload of this
document will fail. You won’t get a new version. Use Upload new version instead.

The first time you save a project document, you enter all its database information. The next time you
work on that document, you can:
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• lock a document

• upload a new version or revision

It is up to you to decide if it is a draft, revision, or version according to your company’s best practices.
Some people publish minor changes as revisions and major changes as versions; others do the
opposite, and yet others just save drafts.

Copy / Create Multiple Documents

1. You can either go to the project/folder you want to upload the document into and click the

 button, or just click the Upload menu item from anywhere.
When instant upload is configured by an Admin user, and a file is chosen for upload, the upload of
the file starts immediately. You can view the progress of the upload and there is an option to pause
or stop the upload.
 

 

Note:  You can also drag and drop multiple files into the upload button, with the above option
selected.

2. On the Upload page, select the Project and Folder you will upload the document into (if you
are already in the project/folder, those are filled in automatically, but you can still Change the
Destination).

3. Click Copy/Create Multiple New Documents.

Note:  From this page, you can also click Upload Multiple Documents to use the HTML 5 Upload to
upload multiple documents.

4. Add a document as explained below.
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If you want to... do this...

1.

Upload a document saved on your computer or
network.

Click Upload then click the Choose File button
to open a browser dialog.

Note:  You cannot upload CAPE files, or upload
PDF files as page lists when uploading multiple
documents. Please use the normal Upload 
option for this.

2.

Copy a document from another project.
Click Copy, then select the project to copy the
document from, and the document to copy.

3.

Create a document placeholder from a
document template.

Note:  This is only available if the project
has been created from a project/template
containing document templates.

Click New, select the document template to
use in the pop-up, and fill in any attributes that
may be required.

To collapse a document's attributes, click the
square minus sign in front of the document.
To collapse all documents' attributes, click
Collapse All at the top of the page.

See Document Templates on page 162 in the
Administration Guide for more information
about document templates, and Assigning
Document Attributes on page 608 for more
information about attributes.

 

 
5. Repeat for each document you want to upload.

Note:  If you want to remove a document, click the delete button behind it.

6. If you want to use the default approval settings of the project/folder for these documents, select
Apply Default Approval Settings (they will not be applied to document URLs).
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Note:

You can also:

• Set the approval Due Date (only if you have the Change Approval Setup permissions): enter a
date or pick one in the calendar, then choose an hour.

• Start the approval cycle.

You cannot setup document-specific approval settings for several documents at once.

7. Click the Upload button.

Note:  When you try uploading a document which already exists in the project, the upload of this
document will fail. You won’t get a new version. Use Upload new version instead.

Upload Multiple Documents via the Upload Applet
You can Upload Multiple Documents  in two ways:

1. Click Projects on the Menu Header. Select the Project you want to upload the document to.
2. Click the  option. Select the Target Folder from the drop-down

menu.

• You can also select menu Upload and upload multiple documents. In this case, select the
Project  and the Folder you want to upload the documents to and click Upload Multiple
Documents.

3. You can either Select Files (one by one or by selecting a few) or drag-and-drop from any file browser
into the applet window.

You can change the destination Folder of each document if you want to.
4. If you want to use the default approval settings of the project / folder for these documents, select

Apply Default Approval Settings.

• Set the approval Due Date (only if you have the Change Approval Setup permissions): enter a
date or pick one in the calendar, then choose an hour.

• Start the approval cycle.

You cannot setup document-specific approval settings for several documents at once.
5. Click Upload.

The upload will start and you will see a progress window. Depending on how many files and how big they
are, this can take a while.

Note:  You cannot upload ZIP files, individual CAPE files, or upload PDF files as page lists with the
upload applet. Please use the normal Upload  option in the Project for this.

Note:  When you try uploading a document which already exists in the project, the upload of this
document will fail. You can, however, upload it as a new Version.
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Important:  If your Document Upload Preference is set to Java Applet, your applet will be Java based.
To change it go to My Preferences on page 577 and change the Multiple Document Upload Type to
HTML5.

Upload from a Workflow System
You can upload documents to WebCenter from:

• a Automation Engine workflow, using the Publish on Web task,

• an Odystar canvas, using the WebCenter Output gateway,

• a Nexus workflow, using the WebCenter Output activity.

Note:

You can also start an approval cycle on your uploaded document directly from the workflow. It uses is
the default approval cycle, inherited from the project or folder you upload the document into.

If you have the Change Approval Setup permission, you can also set the approval due date.

For details on how to upload documents from Automation Engine, Odystar or Nexus, please see the
corresponding user manuals.

Upload from ArtiosCAD
For details on how to upload documents from ArtiosCAD, please refer to the ArtiosCAD user manual.

Note:  You cannot start an approval cycle from ArtiosCAD.

Upload by Drag and Drop
You can upload documents by Drag and Drop. To do so, you can

1. Add a document into a project or folder by dragging from your browser.
2. Upload Files to (Project Name) window is opened along with the document that is dragged.
3. You can add more documents by dragging into this window or use Select Files to browse. Select

Upload to add the documents to the project.

4.3.3.  Working with Documents

Once a document has been uploaded to WebCenter, you perform a number of basic operations on it,
such as copying, deleting, updating or locking it, to ensure it completes its lifecycle within the system.

598



4WebCenter

Move a Document

Note:

When a document with approval settings is copied or moved to another project, the approval settings
are not copied or moved.

A document with a started approval cycle may not be moved or copied as a link until the approval cycle
is stopped.

A locked document cannot be moved.

1. Open the project and folder containing the document to copy and select it. If desired, select more
than one document by selecting their checkboxes.

2. Click More.... Select Move Document(s) from the drop-down menu.
3. Choose to either Move inside the current Project or Move to another Project.
4. Do one of the following:

If you chose to move the document Then you must...

in the same project, Select the folder into which to move the
document.

to another project, • Choose the project into which to move the
document.

• If that project has folders, choose the folder
into which to move the document.

5. Click Move.
 

 

Copy a Document
1. Open the project and folder containing the document to copy and select it. If desired, select more

than one document by selecting their checkboxes.
2. Click More.... Select Copy Document(s) from the drop-down menu.
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3. Choose to either Copy inside the current Project or Copy to other Project(s).
4. SelectCopy as Link to copy a link to the destination folder or project.

Note:  If you opt to Copy as Link, you will not be able to Rename Document or be able to Copy
Viewer Annotations.

5. Do one of the following:

If you chose to copy the document Then you must...

in the same project, Select the folder into which to move the
document, or provide a new name for the copy
in the Rename Document field.

to another project, • Choose the project into which to copy the
document.

• If that project has folders, choose the folder
into which to copy the document.

6. Click Copy

The document is now available in both the source and target projects.

Delete a Document

Note:  A document with a started Approval Cycle cannot be deleted. The Approval Cycle must be
stopped before you can delete the document.

A locked document cannot be deleted.

If a document is used for a document reference attribute, it cannot be deleted

1. Open the project and folder containing the document to delete and select it. If desired, select more
than one document by selecting their checkboxes.

2. Click Delete Document(s) in the Actions Header.
3. Click OK to confirm the deletion.

The selection is deleted. If any selection is a linked document, only the particular link that was selected
is deleted; other instances of the link are not deleted.

Lock a Document
Locked documents are documents you have flagged as being in use so that other users do not
download them and work on them at the same time.

1. Open the project and folder containing the document to lock.
2. Select the checkbox of the document to lock and click More....Select  Lock  from the drop-down

menu. To lock more than one document at a time, select more than document. You may not lock
URLs. The latest version of the document is selected for locking.

The document is now marked as locked . If other users try to download it, they will be asked to
confirm downloading a locked document.
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Unlock a Document
1. Click My WebCenter > My Locked Documents.
2. Select the document(s) to unlock.
3.

Click the Unlock  button. The document(s) will no longer be shown on the list.

Upload a New Version or Revision of a Document
1. Open the project and folder containing the document to which you will Upload New Version  or

Raise to Revision.
2. In the Documents list, either:

• Hover over the document link and click More or the Upload button toUpload New Version.
 

 
• click Upload New Version  in the Actions Header.

 

 

Make sure you use the buttons on the document's row.
3. Browse to select the new version of the document.

For document types that have more than one file, specify multiple files as needed. The filenames
can differ from the original file names, but they must of the same type (i.e. have the same
extension) as the original document.

Note:  By default, if the file name of the new version of the document is different from the filename
of the previous version, WebCenter will use the filename of the original or previous version when
you download the new version. This behavior can be changed; contact Professional Services for
assistance.
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4. In the Version comment field, enter your comments regarding the new version.
5. You can make the new version a Revision by enabling Raise to Revision A.

This is only available if the admin has enabled this for you.

Note:  The revisions will be denoted as A,B,C following the version number.

6. If this is a linked document, select the project(s) to check the document into.
7. When you upload a new version of a document which has an approval cycle ongoing, the approval

cycle stops automatically. If you want to have the approval cycle restart immediately, select Start
approval cycle on new document version.

8. If you have the Change Approval Setup permission, you can adjust the approval cycle's due date (in
the Specify New Due Date option).

Note:  If the document was in a staged approval cycle, where the cycle restarts from depends on
the When a new version is uploaded setting. See Define How to Handle a New Document Version on
page 815.

9. Click Finish.

Note:  To access a previous version of the document, click its number in the Version column on the
Action History page for that document.

Delete the Last Version of a Document
You can delete the last version of a multi-version document if:

• you are the Project Manager for the project containing that document, an Admin, or a project
member with Delete permission

• the project containing the document is active

• the document is not checked out by another user
• the document has more than one version

• On the Document Details page, click More Actions... then Delete Version.
 

 

Confirm your choice by clicking OK.
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Note:

If that document version is in a running approval cycle, WebCenter will show this message: There
is a running approval cycle on this document version. Are you sure you
want to delete this document version?

Clicking OK stops the approval cycle for that document version.

If the document came from Automation Engine, the Pilot will indicate the deletion.

If the deleted document version was linked in other projects, the link is updated (to link to the
previous document version)

The document record indicating the last version index is decreased by one.

Update a Document across Projects
If you have a document that is linked in many Projects, and upload a new version into only one Project,
the links in other Projects continue to reference the prior version.

Note:  Project Managers may update entire Projects at once, not just the contents of a single folder.

To update a document in a Project to ensure it references the latest version, do the following:

1. Open the project and folder containing the document to update.
2. Select the document to update. To update more than one document at a time, select as many as

desired.
3. Click Update from the More drop-down menu.

All documents in the folder that you selected for which you have Update permission are updated. A
list is shown of the updated document(s), the containing Project, the old version number, and the
new version number.

Open a Document
Opening a document means having WebCenter open the document using the document’s default
application as defined in the Web browser. You need View and Download permissions to Open the
document.

1. Navigate to the document by searching for the document and clicking its name in Search Results, or
by clicking its name in a project.

2. Click Open on the Document Actions Header.
3. The Open button has different behavior for different document types.

Document Type Behavior

CHILI Opens CHILI Viewer in new window

PDF Open button unavailable. Use Open in
Acrobat.

ArtiosCad Design,Manufacturing, Canvas or
3D

Open button unavailable. Use Open in
ArtiosCAD
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Document Type Behavior

Graphics Open button unavailable. Use View and
Annotate

Other (text,xml, MS Word, MS Excel...) If the browser has a plug-in for the document
format extension, it shows the contents
of the file in a new window. If no plug-in is
available, the document is downloaded.

Note:  You can hover on any viewable file to view the expanded thumbnail of the document. You can
further click on the Zoom icon on the right top corner to view a larger thumbnail.

Download a Document
1. Navigate to the document by searching for the document and clicking its name in Search Results, or

by clicking its name in a project.
2. In the Documentlist, either:

• Click Download in the Actions Header.
• Hover over the document link and click Download

 

 

• If it is an ArtiosCAD document, choose the format in which to download it and click Download.
You may only download in formats for which you have the Download permission.

• If it is a CHILI document, choose from the download options (CHILI Package, CHILI XML, PDF),
and click Download.

You can enable the notification for Document downloaded to keep track of who downloaded a
Document.

The document is downloaded and may be manipulated as desired.

Documents in Esko Cloud
It is now possible to store and retrieve documents from the Esko Cloud. This has been enabled with
the help of work flow nodes. This requires an Asset Management connection to be setup for Archiving
service.

Status of the document location is indicated in the document information with an icon.

Upload and Download from Esko Cloud
With an existing connection for Archiving, documents can be uploaded in a workflow using the Upload
to Asset Management System workflow node.

You can select the Only archive old Versions of a Document option to upload all the versions that are
no longer linked from within a Project in WebCenter. Uploaded documents have an indication in the
document header with a cloud icon and the document information tab has the cloud connection link
along with the external document id.
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You can select the Remove Document from Filestore after upload to Esko Cloud option to remove the
Document from the WebCenter Filestore after a successful upload to the Esko Cloud. After running
a Workflow with this option configured, the Document will still be useable in WebCenter. It is still
possible to download/generate view files for this Document, however the document data will be served
from the Esko Cloud. Read more about the work flow node here.

Restore from Esko cloud

You can restore the file back to WebCenter in a workflow using the work flow node Restore from Esko
cloud.

Choose the right archiving connection where the document is located and on execution the document
is back in the Filestore.

Download Multiple Documents
You can download several documents on a same page (in a Project or a Search Result page) in one go.

When you select multiple documents for download, WebCenter automatically adds them to a
compressed archive, and then the archive is downloaded (WebCenterDownload.zip).

To download multiple documents, do the following:

1. Select the checkboxes of the documents to download.
2. Click Download in the Actions Header.

Use a decompression utility to extract the documents from the archive. The documents are now on
the hard drive and may be manipulated as desired.

Note:  To download all of a project's documents, click More actions... then click Download in the
header of the Project Details page.

Download Documents from Multiple Locations
To conveniently download documents from several projects, you can use the Cart. You can add
documents to download to the cart as you are browsing the projects, then download them in a zip
archive when you are done.

1. For each document that you want to download, click Add to Cart in the Actions Header.
2. Click the Cart button in the top row menu or next to a document name to go to the Cart.
3. Select the checkboxes of the documents to download.
4. If you are downloading ArtiosCAD or CHILI documents, choose the format in which to download

them and click Download in the Actions Header. You may only download in those formats for
which you have permission, and you may only choose one download format for designs and one for
manufacturing files, respectively.

Use a decompression utility to extract the documents from the archive. The documents are now on
the hard drive and may be manipulated as desired.

Viewing and Printing a Document's Annotation Report
You can view the annotation report page with an overview of annotations done in a document without
opening the document in the viewer. To view the annotation report, go to:

• Document details > Annotations.
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Note:  This feature is only enabled for graphic files.

You can view all the details related to the annotations in this page. In addition, you can also filter based
on Review  status, User and Report style.

Click the Print link to print the Annotation Report.

Note:  The print layout will follow your annotation filters.

This feature only works correctly in browsers supporting the HTML5 Canvas feature.

Online Document Editing with CHILI

Open CHILI Document in Editor

When a user opens a document, it will be opened in the CHILI Editor. In the editor, the user will be able
to edit the parts of the document, based on Workspace and Constraints. Read also Dynamically assign
workspaces and constraints to CHILI Documents on page 158

In the header bar, some document information will be shown. Below, the buttons “Return”, “Save as
Draft” and “Save as New Version” are shown. If the user who opened the editor is an approver, he can
see the approval options and from there, he can do all available approval actions. When the user
approved/rejected the document, the action button list will be updated.

NOTE: “Save as Draft” button is only available if the current User has ‘CHECKOUT’ permission for the
CHILI document; “Save as New Version” button is only available if the current User has ‘ADD’ permission
for the CHILI document.

Save a CHILI Document

When a user saves his document as a draft, it will be saved on the CHILI server. When he then reopens
the document in the editor, the changes are still there. However, when downloading the document
from WebCenter, the changes will not be visible. They are only visible in the editor.

In the document details page (header), a warning should be shown that there is a draft version of the
document.

When a user saves his document as New Version, it will be saved on both the CHILI server and
WebCenter. The previous version will be restored to its original state in case there was a draft version.

When saving as a new version, a version comment is required. It is also possible to start approval and
set a due date. When saving a linked document, the user will also get the option to select in which
projects the document needs to be updated.

Using and Updating WebCenter Attributes from the CHILI editor

In a CHILI document, variables can be defined. Filling out those variables will change certain fields in
the document.

When loading the document in the CHILI editor, attributes can be pushed to the editor. If an attribute
in WebCenter (either project or document attribute, where document attribute gets priority) has the
same name as a variable in the CHILI document, the value in CHILI can automatically be filled out. The
user will be asked if he wants the variables to be updated when opening the editor on a clean document
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(without a draft version). After this, the user will always be able to synchronize the values on demand by
clicking the “load attribute values” button. This update button can be clicked at any time.

Note:  This panel and button will only be shown when there are actual matches between attributes and
variables.

When an attribute name and a variable name match, and that variable is edited, it is possible to save
these values back into the attribute category again when saving as a new version. When saving
the Document as a new version, a popup window will come in which the user can specify a version
comment and restart approval. In the same window you will have two check boxes to specify if you
want to update project and document attributes. Note that for linked documents, it is not possible to
save project attributes.

Note:  For a lot of the variable types, conversions are foreseen in WebCenter. However, there are some
limitations:

• There is no conversion between the WebCenter Rich Text Attributes and CHILI’s Formatted Text
variable.

• Multivalued Text attributes in WebCenter cannot be imported into the CHILI editor’s list variable.

Viewing References of a Document
If your current Document (including all versions of the Document) is being referenced in other
Documents, you can view the details in the References Tab.

This tab will list the Documents referencing the current Document Version as a Document Reference.

 

 

This tab provides a view of:

• the Documents in which they are referenced,
• the Projects in which those Documents reside,
• the Version
• and details on who Uploaded the Document (Version)
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If the document has additional versions and one or more of these are explicitly referenced, a checkbox
Show parent references for all versions will be displayed. Enable this to view a list for each version
that are referenced.

4.3.4.  Assigning Document Attributes

Attributes are a way to assign user-configurable fields and their values to documents and projects.
They can be restricted to a group of preset values, or can be prompted so that the user has to set a
value each time it is used.

Attributes need to have been created by an Administrator before you can use them (see the
Administration Guide for more information).

Assign Document Attributes
1. Open the project and folder containing the document to change and click its name.
2. Click Attributes.

 

 
3. Specify Attribute Category by selecting from Change Attribute Categorydrop-down. Click Save.
4. In the Attributes in Category page, fill in the desired values for the Attributes and click Save.

Change Document Attributes
1. Open the project and folder containing the document to change and click its name.
2. Click Attributes.
3. Change the Attributes values as desired and click Save. The values are changed.

Change an Attribute Category
Attribute Categories are related Attributes grouped together for convenience. If you change an
Attributes Category, the previous values are not saved.

1. Open the project and folder containing the document to change and click its name.
2. Click Attributes.
3. Click the Change Category link.
4. Select the new Attributes Category to use and click Save.
5. Enter the values for the new Attributes and click Save.
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Export Attributes to JDF
To make working with other systems easier, you can export and import document Attributes by using
JDF (Job Definition Format) files. You can export the Attributes, modify them in another system, and
then import their changed values back into WebCenter.

Note that you cannot add more Attributes to a document this way; this only lets you change the values
for existing Attributes.

Note:  Option to Import from or Export to JDF buttons are enabled only when Allow importing from/
exporting to JDF is enabled in the WebCenter Security Preferences by the Administrator users.

1. Navigate to the document with the Attributes to export.
2. Click Attributes.
3. Set the values for the Attributes as desired and click Save to set them. If they are already set as

desired, skip this step.
4. Click Export....

WebCenter automatically names the file <document name>_attrs.jdf. Any periods in the
document name will be converted to underscores.

5. Save the file in the desired location.

Import Attributes from JDF

Important:

If you want to import Attributes that are not generated by another WebCenter system, you should
generate a sample JDF file for the people using the other system to use as a reference, so that they
format their JDF file correctly.

The important lines are the ones similar to <eg:SmartName Name=”Attribute Name” Value=”Value”/
>; there must be a Value tag for each Name tag.

Note:  Option to Import from or Export to JDF buttons are enabled only when Allow importing from/
exporting to JDFis enabled in the WebCenter Security Preferences by the Administrator users.

To import a JDF file containing Attributes with changed values for a document, do the following:

1. Navigate to the document with the Attributes to import.
2. Click Attributes.
3. In the Import from JDF file field, enter the path and name of the file, or click Browse... and select it

that way.
4. Click Import.
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The values for existing Attributes are updated if necessary. If there are either too few or too many
Attributes defined in the file as compared to the document, WebCenter will mention it in a status
message.

4.3.5.  Viewing Document References of a Document

4.3.6.  Assigning Document Characteristics

Characteristics are descriptive tags that can be assigned to projects or documents to make them
easier to find.

Characteristics are hierarchical. This means there can be different levels of characteristics for various
product lines so that you can drill down through the information to find the exact characteristic desired
when searching the database.

Note:

Characteristics are linked to the document itself and not to a specific version.

So changing the characteristics of a linked document will affect all versions of the document, in all
projects that have the document linked (including inactive projects).

You can only assign characteristics to a document if:

• you are an Admin,
• you are the Project Manager,
• you have Change Properties rights for that document.

Important:  If the project is inactive, you will not be able to edit a document's characteristics if your
Admin has not enabled Allow changing attributes and characteristics of inactive projects in the
Preferences (see the Administration Guide for details).

1. Open the project and folder containing the document to change and click its name.
2. Click the Characteristics tab of the Document Details page.

You can also find CAD design Characteristics (associated to ARD files) in the Characteristics tab.

When using ArtiosCAD Enterprise, the CAD design Characteristics you assign in WebCenter will be
reflected back in ArtiosCAD.

3. Select the checkboxes of the desired Characteristics. The selected Characteristics will appear
in the list of Characteristics. Click the + plus sign next to a Characteristic to see its child
Characteristics.

4. Click Save. The selected Characteristics will be associated with the document.
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To remove Characteristics from a document, do the same as described above, but deselect the
checkboxes of the Characteristics to remove them from the list.

4.3.7.  Downloading a Project

Note:

Only those documents in a project for which you have Download permission are included when
downloading a project.

To download a project:

1. Open the project.
2. Add the project to the Cart by clicking Add to Cart on the Projects Header bar.

You can also select multiple projects in a project list and click Add to Cart in the Headerbar to
download them all at once.

3.
Click the Cart  button.

4. Select the project(s) to download and click Download in the Header bar.
5. If prompted, choose where to save the files and click Save.

The project is saved as a compressed ZIP archive with the same name as the project. Use the
decompression software of your choice to open it; some operating systems can open compressed
archives without the need for a separate program.

When downloading multiple projects, individual projects are compressed into their own archives and
then those archives are nested together in one master archive.

Your system may be configured to download and open the archive automatically, in which case you can
extract the files as desired.

4.3.8.  E-Mailing Links to Documents and Projects

You can send links to documents and Projects with any MAPI-compliant messaging program.

Note:

The recipient(s) must be able to log in to your WebCenter system and have the appropriate permissions
to view the Documents or Projects referenced by the links. You canMail link To single or multiple
Documents and Projects.

1. To Mail link To single Project or Document:
1. Navigate to the Document or Project.
2. Click Mail link To from the Project or Document details page.
2. To Mail link To Multiple Projects or Documents:
3. Select the Documents/Projects you want to send. Click Add to Cart  in the Document  or Project 

Header bar.

You can also add multiple documents or Projects to the cart. Simply repeat this step.
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4.
Click the Cart  button.

5. Select the Documents or Projects you want to send.
6. Click Mail link To in the Header bar.

 

 

A message opens containing links to the documents or Projects in the body of the e-mail.
7. Address the message as desired and send it as usual.

Tip:

To send only one message containing links to both Documents and Projects, leave both messages open
and cut and paste links between messages as desired.

4.3.9.  E-Mailing Links to Download Documents

You can send a link to download a certain document (or multiple documents) to non-WebCenter users.
This link will only enable the recipient to download one specific file and has a fixed validity (number of
days that the link is available).

To use this functionality, an Admin user first needs to enable it and set the validity for the download link
(see the Administration Guide for details).

This functionality is available to Project Members that have Download permission for a given Project
Document Version and to the Project Manager of the parent Project.

The following steps describe how to send a download link(s) to a non-WebCenter user:

1. Select the checkboxes of the document / documents to download.
2. Choose Mail Download Link from the  Header bar.

Your default e-mail client will open with an e-mail containing a link (URL) generated by WebCenter.
3. You can add a recipient and edit the content of the e-mail message.
4. Send your e-mail.
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Note:  You can also Mail Download Link from the pages below:

• My Cart
• Document Search Results
• Project Details documents
• BOM documents

• The recipient of the e-mail will be able to use the download link to download the file for as long
as the link is valid. In case the link is no longer valid, the recipient will be informed it has expired.

• When a recipient clicks a link that is invalid, expired or tampered with (for example if the URL
was changed), he/she will see a web page stating that the link is invalid.

4.3.10.  Viewing the Action History

The Action History page for a document shows all actions performed on the document such as version
Uploads and Approval Actions.

• To view the action history, click the Action History link on a document.

The page displays these document details:
 

 

• Version: An overview of document versions
• Event: An overview of:

• Details of Upload Document/Upload Document Version, Approval, Lock document...
• View Generation (for Graphics only) with a link to Show Task Details.
• Annotations which display date, time, user and annotation comments.

Note:  The document uploaded event also includes the description of the document. When a
document is copied from another project to the current project, the source project information
is also mentioned.

• Status displays the current status of the document (Approved, Rejected, Locked...) and their icons.
• Stage: displays the Approval stage
• Date displays both Date and Time of action performed.
• The User that uploaded the Document/Document Version.
• Comment: displays Version/Approval/Annotations comments.
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Note:  The Document Action History varies according to the document types. Some display page
information too.

The changes done to the attributes of a document when uploading the document are also tracked in
the project history (under the attribute changed event type)

You may print a printer-friendly report of the Details page by clicking Print in the header. A new page
will open showing the entire Action History which you can print using the browser’s Print command.

4.3.11.  Viewing ArtiosCAD meta-data

You can see the meta-data associated with the new ArtiosCAD Design (ARD) and Manufacturing (MFG)
documents uploaded via the WebCenter interface or via an ArtiosCAD Enterprise client version 14.0.2
(or later).

In the Design Information tab (for design files) or in the Manufacturing Information tab, you can see:

• the Grain / Flute Direction

• the Default Side for the Design (ARD) and Manufacturing (MFG) documents.
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Note:  You can also view the 3D Model of this document in the 3D View (Collada).

• the Die Side for the Manufacturing (MFG) documents.
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Note:

Older document versions or document versions uploaded from ArtiosCAD Enterprise client 14.0.1 or
earlier will not show these data.

4.3.12.  Viewing Project History

You can view the history of various events in the Project by navigating from View History page. You can
navigate from Project  > More > View History.

Any user with access to a Project, can see the events history of the particular project. Based on the
notifications setup for the project or the template for various events, records are added to the project
history.

Events are added when a Project was created and information like Project name, Project description,
customer, customer location and Project Manager of the project are logged.

Any change of the information status, due date, attribute, attribute category or permission changes
are also logged as events in the project history.
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You can filter or sort the events by the date, time, user, or event type. You can also print the View
History page.

4.3.13.  Running a Project Report

You can run pre-configured project reports from the projects you have access to if your Admin has
given you access to these reports (see the Administration Guide for more information).

Note:  This only includes project reports. System-wide reports are available from the Search menu.

1. In the project, go to More actions... > Run Project Report.
2. If you can run several reports for this project, select the desired report on the Run Report for

Project page.
3. If the report requires parameters, specify them (mandatory parameters are marked by an *) and

click the Run Now button.

4.4.  The WebCenter Viewers

4.4.1.  The Java Viewer

Opening a Document in the Java Viewer
To open a document in the Viewer:

1. Click the document's thumbnail or the  button.
You can do this from:

• the My Work page (under My Approval if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master),

• the Documents tab in the project,
• the header of the Document Details page.

2. If you see a security warning, you need to allow the Viewer applet to run on your computer.
Depending on what is set in the Preferences, you will see a different security warning:

• If you see...
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... you need to:

1. click I accept the risk and want to run this app,
2. optionally, click Do not show again for this app (if you don't want to see this security warning

the next time you open a document in the Viewer),
3. click Run.

Note:

You will also see a warning when trying to print from the Viewer. You will just need to click OK to
be able to print.
 

 

Note that due to a bug in Java 1.7.0_21, you need to leave Always allow this applet to
access the printer deselected or you will get a security error (Printing failed
java.lang.SecurityException: checkPrintJobAccess).
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• If you see...

 

 

... you need to:

1. optionally, click Do not show again for apps from the publisher and location above (if you
don't want to see this security warning the next time you open a document in the Viewer),

2. click Run.

Note:

You will also see a warning when trying to print from the Viewer. You will just need to click OK to
be able to print.

Note that due to a bug in Java 1.7.0_21, you need to leave Always allow this applet to
access the printer deselected or you will get a security error (Printing failed
java.lang.SecurityException: checkPrintJobAccess).

• If you see...
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... you need to:

1. click I accept the risk and want to run this app,
2. optionally, click Do not show again for this app (if you don't want to see this security warning

the next time you open a document in the Viewer),
3. click Run.

Note:

• You can only view the latest two versions of a document.
• If a document of type ArtiosCAD, Graphic File, or Other did not have view data generated when it

was uploaded, or does not have view data for some other reason, WebCenter will ask you to create
the view data when trying to view it. You must have Update permission on a document to generate
its view data after it is uploaded.

Viewer Samples

An ArtiosCAD workspace in the Viewer
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A Packed Archive Format (PAF) file containing both CAD and Graphics data
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A multi-page PDF file uploaded by BackStage / Automation Engine
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More Help with the Viewer

Help
To learn more about using the Viewer, click the question mark at the top right of the screen.

Note:  Some browsers consider the Help window to be a pop-up. Either turn off the browser’s pop-up
blocker or add the WebCenter Web server to the browser’s list of allowed sites.

Document types
For a Graphics document to show CAD data, it must reference the ArtiosCAD file. The Viewer does not
show graphics contained in an ArtiosCAD document.

For the Viewer to show multiple pages of a PDF file, it must have been uploaded as a Page List
document: either through the user interface with the Upload document feature, or uploaded to
WebCenter by Automation Engine.

For Page List documents, the Viewer offers a list of all the pages as a navigation aid, and a reader
spread mode to evaluate impositions.

Multiple documents
To view multiple documents at once, select their checkboxes, and click View and Annotate in the
Actions menu (inside a project or the Cart) or the  symbol at the top (on your My Work page).

Navigate between documents using the drop-down list box in the Document field or the navigation
arrows in the information bar across the top of the Viewer.

Zoom
To zoom in, click inside the document or draw a rectangle around the area to enlarge with the Zoom

tool .

To zoom out, hold down shift or ctrl while the Zoom tool is active. The symbol inside the magnifying
glass cursor will change from a plus sign to a minus sign.

To make the view scale to fit the space in the browser window, right-click the Zoom tool and select Fit
document in view.

Microsoft ISA Proxy server
If you will be using the Viewer through a Microsoft ISA proxy server using authentication in an HTTPS
session, use Java 1.4.2 on your machine, not Java 1.5.

To check the version of Java installed on your machine, double-click the Java applet in Control Panel
and click About.

If needed, download the J2SE Java Runtime Environment (JRE) 1.4.2 from the following URL: http://
java.sun.com/j2se/1.4.2/download.html.

You must be able to download and install Java applets automatically for the Viewer to work properly.
If Java is installed but a red X appears in the browser, consult your system administrator to see if a
firewall or proxy blocks Java downloads.
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Returning to WebCenter
To leave the Viewer and return to WebCenter, click the x at the top right of the Viewer next to the
question mark. Do not close the Web browser window by accident!

Viewing RIPped Data in the WebCenter Viewer
You can view RIPped data from Odystar or Nexus (TIF or LEN files) in the WebCenter Viewer. This allows
you to approve RIPped files in the powerful Viewer.

Workflow Overview

To make sure WebCenter recognizes your RIPped TIF and LEN files as digital film, use the following
workflow:

1. In Odystar or Nexus, set up a flow that contains the following stages:

• Split Pages, to split the pages of a multi-page PDF document;

• RIP, to RIP every page to separated TIF or LEN files;

• Compress, to gather the separations back into a ZIP file that WebCenter will recognize as digital
film;

• WebCenter Output, to upload the ZIP files into the WebCenter project of your choice.
2. Submit a PDF document to the flow.
3. Log on to WebCenter and navigate to the project you specified in the WebCenter Output stage of

your Odystar or Nexus flow.
4. Click a ZIP file in the document list to view the RIPped page in the WebCenter Viewer.
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Note:

Of course, you can build on this basic workflow to include approval, or even use workflow folders in
WebCenter to send PDF documents to Odystar or Nexus hot folders at the start of the flows.

Prepare the Odystar Canvas

• Set up the following Canvas:
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Table: Gateway details

Gateway Notes

Split Pages Splits the pages of submitted multipage PDF documents, so they
are sent to the RIP gateway page by page.

RIP RIPs the pages to TIF files.

Compress Collects the separated RIPped TIF or LEN data and gathers it in a
ZIP archive.

WebCenter Output Selects the ZIP file and uploads it to the desired WebCenter
Project.
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Prepare the Nexus Workflow

• Set up the following workflow:
 

 
 

 

Table: Activity details

Activity Notes

Split Pages Splits the pages of submitted multipage PDF documents, so they
are sent to the RIP gateway page by page.

Rasterise Separations RIPs the pages to TIF or LEN files.

Compress/Decompress
ZIP

Collects the separated RIPped TIF or LEN data and gathers it in a
ZIP archive.

WebCenter Output Selects the ZIP file and uploads it to the desired WebCenter
Project.

Submit Files and View
Once you have set up your Odystar or Nexus workflow, you can submit PDF documents.

The submitted documents will be RIPped and uploaded to WebCenter in the form of ZIP files, which can
be recognized by WebCenter as digital film files.
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Log on to WebCenter and navigate to the Project you selected as the upload destination in the
WebCenter Output gateway/activity. You should see the digital film files appearing in the document
list, with thumbnails being generated on the fly.

Click a document thumbnail to view it in the Viewer. Use the Viewer to zoom in, compare to previous
versions, annotate or approve the RIPped page.
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Combine with a Workflow Folder Configuration

You can combine the workflow to view RIPped data in the WebCenter Viewer with the workflow folder
feature, to create a user-friendly digital film viewing and approval solution.

Note:  Workflow folders are sometimes also referred to as “push-through folders”. More information
can be found in About Workflow Folders on page 431.

To achieve this, proceed as follows:

1. Log on as a WebCenter administrator, and in the Admin mode, go to Configuration > Push Through
Configuration.

2. To create a workflow folder, click New Push Through Configuration and, in the Destination UNC
field, specify the path to the Hot Folder of your Odystar or Nexus server that will be RIPping your
data.

Also, make sure you select the correct workflow type (Odystar, Nexus or Automation Engine) from
the corresponding list.

Note:  For detailed instructions on setting up workflow folders, see Configure Push-Through
Configurations for Workflow Folders on page 431 in the Administration Guide.

3. Create a new folder in your WebCenter project, and in the Folder Properties, select the Workflow
Folder (Advanced) option. Then select the push through configuration you just created.

4. Modify your Nexus or Odystar flow to include the WebCenter Input activity or gateway. Make
sure the settings point to the same Hot Folder you specified in the push through configuration in
WebCenter.

5. Upload a PDF document to the workflow folder in WebCenter.
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If you set up the whole workflow correctly, the files you upload will be copied to the Odystar or
Nexus hot folder, where they are picked up by the WebCenter Input. The flow will RIP the pages,
collect them into ZIP files and return them to the WebCenter project, where you can view and
approve them.

 

 
 

 

4.4.2.  The HTML5 Viewer

 About the HTML5 Viewer About the Viewer
The HTML5 Viewer is a fast and comprehensive viewing tool introduced in WebCenter 14.

From 14.1.1 onwards, the HTML5 Viewer is the default WebCenter Viewer. However, you may choose to
work with the Java Viewer (default) by changing it in the Viewer Preferences.
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What does the Share & Approve ViewerHTML5 Viewer offer you?
• Speed: fast viewing for Graphics and CAD files. High speed 3D viewing (14.1 and later).
• Compatibility: high speed performance on the new client browsers.

Browser Supported Version -
Windows OS

Supported Version-Mac OS

Microsoft Edge Latest -

Firefox 4.0 or higher 4.0 or higher

Chrome 5.0 or higher 5.0 or higher

Safari - 5.0 or higher

• Reliability: high accuracy in displaying your data.
• Detail: advanced zoom to see finest details, measuring exact distances. Fast zooming.
• Customizable widgets. You can even restrict access to certain features depending on the user

preferences.
• Keyboard shortcuts. To see all of them, press ?
• Easy access to help and knowledge base. Search in the Help widget or press F1 to access help.

Note:  The default Viewer in the WebCenter Viewer  on page 92s upto 14.1 will be the Java Viewer. You
can set the preferred Viewer as the HTML5 Viewer in the General or User Specific Preferences. Read
more in About Viewer Preferences.

Note:  The HTML5 ViewerShare & Approve Viewer does not offer live collaboration or working together
at the same time. You can use annotation threads for discussions.

  What is New in the Viewer 21.03
• Improved Component Widget that renders Assembly Documents
• Editing and Printing of Assembly documents from Viewer

The Simplified Viewer
Two types of desktop layouts can be viewed when you open the viewer in a normal browser: the HTML5
Normal Viewer and the Restricted (New Look)/ the Simplified Viewer. This new viewer presents a
cleaner, less complicated and clutter-free look.

Viewing Simplified Viewer
The leaner viewer offers easy navigation through some of these features:

• The Simplified Viewer comes with all the enhanced features available in the HTML5 Viewer.
• In the Simplified Viewer the side panels are collapsed by default. You can open the specific widgets

that you need.
• The new viewer allows you to resize the opened widgets (even as the side panels remain collapsed).
• With some configuration, it also allows each widget to be hidden.

Opening the Viewer in Simplified Mode
In Viewer Preferences, select the Restricted (New Look) as the Viewer Style to open the Simplified
Viewer layout. It is set to Normal by default.

This layout consists of four sections: center, top bar, right and left side panels:
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• The Information bar on the top consists details of the document, the user and buttons to execute
other actions The Information Bar on page 640

• Below the information bar, you have the top tool panel with all the toolbar components. Activating
these help you perform different functions on the document. Read more in: Top Tool Panel on page
646

• You have the View area in the center.
• The collapsible side panels contain the Viewer Widgets which are collapsed by default.

Ordering and Collapsing Widgets in the Side Panels
The widgets display document information and help perform different functions. To facilitate ease of
view, you can adjust them in many ways:

• Click the Widget Header to collapse or expand the widget.
• You can drag the widgets to either of the two side panels. The height of each widget is

automatically adapted by the side panels.
• The side bars do not disappear on collapsing but remain as a thin bar containing the widgets icons

that represent the widgets. Click the icon needed. It opens next to the side bar.

Note:  You can open only one widget per side bar at a time. If you click another icon on the same bar,
the first widget closes.

Collapsing and Resizing Side Panels
The side panels contain all the widgets and can be manipulated in different ways to maintain the leaner
look:

• Resize and collapse side panels by using the  or  Toggle Right/Left Side Bar. The side panel
becomes a thin bar containing only the icons.

• When you click the expand toggle, the panels expand to fit in both side panels and the viewport.
• To revert the side panels to their original size, click the toggle button.

Resizing Widgets in the Simplified Viewer
You can choose to have a full or partial view of the widgets when you:

• Resize opened widgets even when the side panels are collapsed
• Drag the widget borders horizontally or vertically. You can also resize by dragging the bottom

corner. The width and height are saved and the widget will retain these dimensions when you open
the viewer the next time.

• Restore the widget to its default size by double clicking the respective icon on the side panel.

Tools in Simplified Viewer
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The Simplified Viewer offers tools that are similar to the Normal Viewer:

• The Information Bar on page 640
 

 
• Top Tool Panel on page 646

 

 
• Use  or  to Toggle Side Panels.
• To open the widgets, click the corresponding icons:

•
 Navigator on page 672

•
 3D View on page 670

•
 View on page 674

•  Channels on page 684
•

 CAD on page 687
•

 Approval Details on page 668
•

 Info on page 673
•

 Help on page 690
•

 Document Select on page 662
•

 Attributes on page 683
•

 Annotation List on page 666

The Viewer Window
The HTML5 ViewerShare & Approve ViewerViewer comes with a number of powerful tools that make it
easy to navigate, view and compare your artwork and design files.

In the Viewer Window, you can:

• quickly scan for information regarding the active document. For example, you can view the
document size, resolution and the axes in the Info widget.

• inspect the document using the top tools and the Navigator widget. The channels of the document
will be visible in the Channels widget.

• compare the document to a reference selected via the Document select widget.
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• browse and inspect individual pages of your Page List using the Page List widget.

• view the approval details of your document.

• approve or reject your document

• view CAD design and CAD layout files. You can see the available layers in the CAD widget.

• view the annotations and comment on them. You can also annotate on your documents.

• view, compare, annotate and approve Page Lists and multi-page documents.

• view CAD Overlay referred in Graphics.

• view document attributes and document reference attributes, edit and save them.

• open the HTML5 Collada Viewer to view documents in 3D.Viewing 3D in the HTML5 Collada Viewer on
page 735
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1. The Information Bar
2. Top Tool Panel
3. Toggle Side Bar
4. Document Select
5. Attributes
6. Annotation List
7. Approval Details
8. The View area
9. 3D View
10. Navigator
11. View
12. Channels
13. CAD
14. Info
15. Help

See also: HTML5 Viewer video tutorial.

The Viewer Window Layout

The Viewer window will be in the desktop layout if it is opened in a HTML5 compatible desktop browser.

When you open the Viewer in a tablet or a smart phone, you will get a mobile optimized layout.

This example layout has:

1. the top panel containing the information bar and the top tool panel.
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2. the central panel where you will see the document / image being viewed.
3. the left sidebar
4. the right sidebar
5. collapsed widgets.
6. a modal widget

Customizing the Viewer Window Layout
You can customize your window to suit your needs. You can:

• click-drag:

• a widget to the center of the window (outside of the side panels).

This will make this widget a modal window. You can make a widget modal when you want this
to always appear in the Viewer even when the browser window becomes small. The widget will
remain modal even when you restart the Viewer.

• a widget up or down in the same panel.

• a widget from one panel to the other.

• collapse or expand a widget by clicking on its header. The sizes of the widgets in the side panel will
adjust according to its contents. The scroll bars will help you navigate within the widgets.

• adjust the width of the side panels by dragging the border line.
• use the Toggle Sidebar  option to collapse the sidebars.

Note:  Your layout settings will be saved for your next use.

See also The Viewer Window on page 636.

Note:  If your browser window becomes too small, the sidebars will be collapsed automatically. Make
your window larger to view the sidebars again. The modal widgets will stay in its location.

Opening a Document in the HTML5 Viewer
To View and Annotate in the HTML5 ViewerShare & Approve Viewer, you have to set your Viewer Type
in the Preferences.

• To open a document in the Viewer, click the document's thumbnail or the  button.
You can do this from:

• the My Work page (under My Approvals if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master)

• the Documents tab in the project
• the header of the Document Details page.
• the View and Annotate link in the Documents/Bill Of Material page

• To load multiple documents into the Viewer, select them and choose Actions > View and Annotate .
• To open a document in 3D, click  from the CAD  on page 687 widget or the Document Select 

widget. Read more in: Opening Documents in the 3D Viewer  on page 738 and Viewing 3D in the
HTML5 Collada Viewer on page 735.
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The Information Bar
The Information bar displays:

• The Project name
• The Document name
• The CAD info icon: If your CAD files were saved using ArtiosCAD 14.0.2 or newer, you will see CAD

info icons . The icons are:

• Grain/Flute direction (Horizontal or Vertical)
 

 
• Side (Inside or Outside)
• Die Side (Die Knife Side or Back Side, only for MFG files)

• The Version number and the Revision letter.

Note:

In Compare mode, the two document names and version (revision) details will be visible separated
by /.

 

 

• Show Annotations toggle button to make annotations visible in the document viewed.
• Switch to Edit Mode to enable editing in AI( Adobe Illustrator) or pdf documents and is present only

with the Automated Artwork license.
• The User Name

Note:  This will be used in Annotations and Approvals

• Configure Workspace to customize workspace according to the user preference or switch to
another workspace according to the user role. Read more about Workspace in Viewer here.

Note:  You can also switch between 'light' and 'dark' style viewers in the workspace configuration.

•

Page Navigator :

This is only available when a multi-page document is active.

Use this to navigate through the pages of open documents. Or navigate to a page by typing in the
number and pressing Enter.

Read also Viewing Multi-Page Documents and Page Lists on page 724
•

The Print  button. This opens the Print Dialog.
• The Reset  button. Use it to reset the layout of the viewer to the default.
•

The Show Keyboard Shortcuts button .

Click this or type in ? to see the keyboard shortcuts.
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•
To Display Help Pages  button to open help pages.

Tip:  To access online help, use the keyboard shortcut F1 or click .

•
The Close button . Use this to close the viewer and return to WebCenter. If changes have been
made to annotations or to the approval state, the user will be prompted to save or discard the
changes.

Viewer Workspace
A Viewer Workspace is a customizable set of tools and widgets for a user in the viewer. Every user has
a workspace assigned based on the role of the user in the project, a personal workspace or the system
default and same can be customised by the user in the Viewer.

Admin users can choose to change the default workspaces to show/hide more widgets and tools for
each User or Role. To make the change to the workspace in the Viewer, navigate to the  Information
Bar > Configure Workspace option.

Read more about Workspace configuration by Admin Users here.

Choosing a Workspace in Viewer
When the user is present in more than one role in any of the projects the document is present in, then
a drop- down with all the available user roles and its respective workspaces are available for selection.
You can choose the workspace you want to use in the Viewer.

Widgets and Tools Configuration
To customize a workspace as per your requirement, select the option Configure Workspace. A pop up
window is available to make changes to the workspace.
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Firstly choose the workspace that you wish to use and configure. You can also choose the Color Theme
of the viewer specific to the workspace.

Tools and Widgets set to Available or Visible for the workspace by the Admin user are shown. You can
further configure to suit your requirements.

• Visible: Check box is selected for for the tool or widget and is currently available in the viewer.

• Available: Check box with a dash or dot ( depending on the viewer). Tool or Widget is available but
unchecked and can be checked and added from the viewer.

• Hidden: These are not available in the Viewer Workspace at all and means it is a unselected by the
Administrator in the Setup.
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Any configuration changes made to a workspace does not have any impact on other users and are
saved only for the specific user. You can undo the changes made to your workspace by selecting Reset
Workspace.

The Information Bar
The Information bar displays:

• The Document name
•

Show Annotations 
• Name of the User logged in
•

Show/Hide Widgets &Tools   and option to switch between light and dark style viewers
• Reset Layout  button. Use it to reset the layout of the viewer to the default.
• Download button that allows you to download and save the document you are viewing.
• Download and Annotation & Approval Report button allows you to download reports of

Annotations and Approval made for this document. Read more on this in the inline help in Share &
Approve Application.

•
Print  button. This opens the Print dialog.

•
The Show Keyboard Shortcuts button .

Click this or type in ? to see the keyboard shortcuts.
•

To Display Help Pages  button to open help pages.

Note:  To access online help, use the keyboard shortcut F1 or click ?.

•
The Close button . Use this to close the viewer.

Print Dialog

Use the Print  to print:

• the current view
• the selected image area
• the annotation overview

When you click on the Print  button, the Print dialog opens. Specify your Print Type in this dialog.
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Print Current view (default): Select this option when you want the entire view area to be printed. Your
print preview will contain:

• all panels in the split view mode with borders
• visible ruler end point and read-outs
• annotation shapes and annotation note icons. The floating annotation text boxes are not printed.

The resulting Print preview changes the background color and the titles of the windows to white.

If only some of the channels are selected, select the Print only selected channels option. You will get
all the channels in the print, if this is unchecked.

Print Image area:

Choose this print mode to get a clean print of the current document page without the annotations,
visible ruler endpoints or ruler read-outs. When multiple windows are active, either the composite of all
the channels or the selected channels will be printed.

When you select this option, you have to specify the following Parameters:

• Resolution: Specify the resolution and resolution units (ppmm = pixels per millimeter, ppcm = pixels
per centimeter or ppi = pixels per inch) here. The default value is 150 ppi converted to ppmm.

• Print Current View : Enable this to print only the current view area. Do not check this when you
want the entire image to be printed.

By default, this remains unchecked.
• Print only selected channels: If only some of the channels are selected, select the option. You will

get all the channels in the print, if this is unchecked.

Print an overview of all the annotations:

If you use this option, you get the same result as from the WebCenter annotations printing. If the
viewer is in compare mode, choose to:
 

 

• Print annotations of the current document
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• Print annotations of the reference document

You will be prompted to save the annotations before printing. The unsaved annotations will not be
printed.

When you click Print in the dialog, a print preview will open in a new tab or window. Use the Print link
from this preview.

Note:  The paper size is not considered in this setting. This has to be specified in the print setting of
the browser.

Note:  Only Annotation Overview can be printed for video documents with annotations.
 

 

Viewer Workspace
A Viewer Workspace is a customizable set of tools and widgets for a user in the viewer. Every user is
assigned a default workspace and same can be changed or modified by the user in the Viewer.

Site Administrators can choose to change the default workspaces to show/hide more widgets and
tools for each User or Role. To make the change to the workspace in the Viewer, navigate to Viewer >
Information Bar > Show/Hide Widgets &Tools option.

When more than one user role is available, then a drop- down with all the available user roles are and its
respective workspace is available for selection.

The Viewer workspace(s) are available in the dropdown based on the User roles available at

1. Document level or
2. Folder level or Site level, If it is higher than the document level.

On selecting the option, Configure Workspace pop up is available to make changes to the workspace.

Each of the tool is either in Visible state, or Available or Hidden state.
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• Visible: Check box is selected for for the tool or widget and is currently available in the viewer.
• Available: Check box with a dash or dot ( depending on the viewer). tool or Widget is available but

unchecked and can be checked and added from the viewer.
• Hidden: Not available in the Viewer Workspace at all and means it is a unselected check box by the

Site Administrator in the Setup.

You can also choose the Color Theme of the viewer specific to the workspace in the Configure
Workspace pop up.

Top Tool Panel
The Top Tools Panel contains some of the Viewer's most used tools. They help you in document
interaction.

Navigation Tools
•

 Zoom tool
•

 Zoom in tool
•  Zoom out tool
• Zoom to 1:1 Pixel
• Zoom to Actual Size
•

 Fit Document in View tool
•  Pan tool

See Interactive Zooming on page 648 for more information.
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Orientation Tools
•

 Rotate view tool
•  Mirror view tool

See Rotate and Mirror on page 650.

Measure Tools
•

 Ruler tool to Measure Distances and Angles on page 650
•

 Measure Color Percentages on page 653 (densitometer) tool
•

 Check Bar Codes on page 656 tool
•

 Check Braille on page 654 (Powered by Global Vision) tool
•

 Caliper

Text
• Select Text
• Detect Font
• Check Font Sizes

3D Tool
• If you have opened a document in the HTML5 Collada Viewer once, the top tool panel will show an

Open 3D View  button.

Annotation Tools
•

 Hide Annotations on page 701 tool
•

 Add Annotation on page 690 tool
•

 Note Annotation on page 694 tool

See Annotating in the Viewer on page 690 for more information.

Page List Tools (only when viewing a page list / multi-page document)
•

 Reader Spread view

Read more in Reader Spread View on page 725
•   Arrows to navigate between pages or spreads
•

 Mark the active page. A yellow star indicates that the active page is marked.

 Clear Mark from the active page.

Compare Tools (only when comparing)
You can only see the Compare tools when you have two documents open to compare (see ).
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•
 View Current Version

•
 View Reference Version

•
View Both- Blinking

•
 View Both-Show on Top

•  View Both-Show Difference
•

 View Both- Side by Side

See Compare Documents in the Viewer on page 710 for more information.

Share Files
•

 Share for Viewing

Approval Tools (only when an Approval Cycle is set up)
The Approval tools are only available when an Approval Cycle  is set-up and you are an approver for the
document. The number of Approval tools may vary depending on the approval setup.

•  Approve
•  Reject
•

 Forward
•  Comment

If you are the Project Manager in WebCenter, you have tools to

•
 Force Approve

•
 Force Reject

See Approval on page 705 for more information.

Interactive Zooming

You can use the zoom tools from the Navigation Tools to view the fine details of your file.

Activating the zoom

Select the Zoom tool  to activate the zoom. Alternatively, activate the Zoom tool by pressing the Z
key.

When Zoom is activated, the mouse pointer changes to  icon. Use the following shortcuts to
effectively use the zoom function.

Click Zoom in by a factor of two

Right -click Zoom out by a factor of two

Alt + click Reverse the zoom to Zoom out 
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scroll Zoom in/out with the location of the mouse as center.

Tip:  Double-clicking on the zoom tool  will fit the document back to view from whatever zoom
factor it was in.

Zooming into a specific area
Use Click-drag action to zoom into a specific area to examine the finest details of your document.
When you hold the left mouse button and drag, a selection rectangle will appear. You can change the
size of the selection rectangle by dragging the mouse without releasing the left mouse button.

To move the selection rectangle around, hold the left mouse button and space bar while dragging.

When the left mouse button is released, the viewer zooms to fit this rectangle.

If you are zoomed in with a ratio 1:10 or more, each document pixel is displayed with a small border as a
grid. In compare modes, you will see the active document area as grid.

Zoom to 1:1 Pixel
When you have artwork with a defined resolution, you can use it to zoom to the image resolution.

• Right-click on and select from:

• Zoom to 1:1 Pixel: use this to view the image in its rasterized resolution.

• Zoom to Actual Size: use this to view your artwork or image in the size corresponding to the
printed size. You may need to set your monitor resolution to make this accurate.

Note:  When the monitor resolution is not set or when the image resolution is not set, the Viewer
takes 72ppi as default.

• Set Monitor Resolution: use this option to set your monitor resolution. Your set monitor
resolution will be stored in the Viewer.

• You can specify the resolution as a decimal number (e.g. 36.05 ppcm) or as a fraction in the
pixels / size format. Read more about this in the Knowledge Base article.

Note:  Your settings will be saved for your later use.

Using the Pan Tool

To pan the view, click the  Pan tool or activate the Pan tool by pressing the H key. The pan tool lets
you grab a location in the document and drag it to a new location.

Tip:

• You can pan the document by holding the space bar and dragging a line in the Viewer window. When
you release the space bar, it returns to the previous mode.

• For a single pan action, use the 
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Tip:

While panning, you can zoom in/out with the mouse point as the center in the following ways:

• double-click to zoom in
• right-click to zoom out
• scroll to zoom in/out

Using the Navigator
When you are zooming in the document, the navigator shows the highlight area as the zoomed area. To
pan the document, hold the mouse and drag this selected rectangle around. The central view port will
display the area correspondingly. Clicking outside the rectangle will move the rectangle to the clicked
point and update the current visible area.

When the zoom is not activated, you may use these short-cuts to work with the zoom.

Ctrl + / Cmd + Zoom in one step

Ctrl - / Cmd - Zoom out one step

Ctrl 0 / Cmd 0 Zoom to fit. This will adapt the zoom to fit the entire image in the current
window.

Double click the zoom tool Zoom to fit

Rotate and Mirror

You can rotate or mirror the document in view using the Orientation tools

•
 Rotate view: Rotates the current view by 90 degrees clockwise.

•  Mirror view: Mirrors the current view.

Use this to flip the document vertically from the center of the screen. If you are zoomed into an
area, the center of this area will be used as the reference.

Tip:  The shortcut Ctrl+M can be used to flip the view.

Measure Distances and Angles
The Ruler tool calculates the distance between any two points in the work area with a click-drag-
release action.

When you measure from one point to another, a line is drawn and you can see measurement
information such as:

• The starting location (X and Y).
• The angle measured relative to the axis (A).
• The total distance (D), the Horizontal Distance (W) and the Vertical Distance (H).

in a pop-up in the View.

Measuring the distance
1.

Select the  Ruler tool.
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2. Specify the measurements in the pop-up tool bar that appears below.

•
: Displays the Angle (A) and the Distance (D)

•
: Displays the starting and end location (X and Y)

•
: Displays the horizontal (W) and vertical (H) distances traveled from the x- and y-axes.

Note:  You can choose to display all of the measurements by selecting all of the above. If you select
just one, corresponding measurements will be displayed.

•
: Displays the Angle (A) positive upwards (Counter Clock Wise)

•
: Displays the Angle (A) positive downwards (Clock Wise)

•
: Changes the color of the Ruler line in the View

•
: Resets the color of the Ruler

3. Drag from the start to the end point.

An information pop-up located at the end point will display the measurements. The location  will
be visible at the start point.

You can drag the line to another point and the ruler will update its measurements. To move, drag the
start or end point to another location.

 

 

Note:  While viewing CAD data, then the Ruler will snap to the end points of most line segments in the
CAD drawing.
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Tip:  The Ruler tool can be combined with different view tools. You can for example indicate a certain
point, then change the view by zooming out, navigating, and then indicate the second measuring point.

To make an annotation from this pop-up, click on the Make Annotation option. You will get an arrow
annotation with the current measurements as its content.
 

 

Measure Screen Ruling

You can use the Screen Ruling and Angle   tool to measure the ruling and angle in digital film files.

Click  to activate the tool and then select a point in your file or drag it to measure within an area.
The measurements are shown in the Channels panel and in a pop-up near the point or area you
measured.

 

 

For each measured channel, you can see the lines per millimeter (lpmm) and the angle (degrees) of the
line in the pop-up. When there is no screen in a channel, the value will be blank.

You can change the units of the measurements from the information pop-up. Click the settings 
button and select your preferred units. Your units will revert to the User Preference settings when you
close the active session.
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To change the orientation of the angle to either clockwise (Screen Orientation CW) or counter
clockwise (Screen Orientation CCW).

To make an annotation from this pop-up, click on the Make Annotation  option. You will get a
rectangle annotation with the measurements as its content.

Measure Color Percentages

You can use the densitometer  tool to measure ink coverage at a certain point or at the selected
area.

Click in your file with the densitometer tool to measure the color percentages at a certain point, or drag
it to measure densities within an area. The densities are shown in the Channels panel and in a pop-up
near the location you measured.

 

 

You can also click the  tool button to make a measurement based on the current view. In this case,
the densities are only visible in the Channels panel.
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Note:

While viewing Digital Film files, you can change the units of the information pop-up. Click the Unit

Settings  button and select your preferred units. Your units will revert to the User Preference
settings when you close the active session.

To make an annotation from this pop-up, click on the Make Annotation  option. You will get a
rectangle annotation with the measurements as its content.

Check Braille

Check Braille  tool allows you to analyze and interpret the Braille text in the selected language.

Note:  The tool is visible only when the system has an Advanced Approval License.

Select the area around the Braille text with a click-drag-release action. You can also select the Braille

text area and click the  tool to interpret the selection. The result appears in The Channels Panel
and in a pop-up near the location you measured.

 

 

You can choose the language from the language list by clicking on the current language visible under
the braille tool.

Note:  By default, English is selected. See also:  Braille Languages Supported in the Viewer on page
655

The tool checks the validity according to the Marburg Medium Braille Specification. A green tick-mark
indicates a valid Braille. If the selected Braille contains at least one regional code that doesn’t pass
these checks, you will see a warning.
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Note:

The validation check has a Tolerance of +/- 0.1 mm and a dot diameter range of 1.3 – 1.6 mm. See details
below:

• 2.5 mm horizontal dot to dot
• 2.5 mm vertical dot to dot
• 6.0 mm from cell to cell
• 12.0 mm from cell to cell with single space in between
• 10.0 mm line spacing

When multiple lines are present in the Braille text, a line number in square brackets will be shown
before the text of each line. For example, [1] for the first line.

 

 

To make an annotation from this pop-up, click on the Make Annotation  option. You will get a
rectangle annotation with the measurements as its content.

 Braille Languages Supported in the Viewer

// 1: English

// 2: French

// 3: Polish

// 4: Portuguese

// 5: Russian

// 6: Spanish

// 7: Finnish

// 8: German

// 9: Italian

// 10: Latvian

// 11: Romanian

// 12: Slovene

// 13: Swedish

// 14: Hungarian

// 15: Dutch

// 16: Maltese

// 17: Danish

// 18: Greek

// 19: Bulgarian
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// 20: Czech

// 21: Estonian

// 22: Lithuanian

// 23: Irish (Gaelic)

// 24: Albanian

// 25: Basque (Spain)

// 26: Belarusian

// 27: Catalan (Spain)

// 28: Croatian

// 29: English (UK)

// 30: Faroses (Denmark)

// 31: French (Traditional)

// 32: Galician (Spain)

// 33: Greenlandic

// 34: Icelandic

// 35: Kazakh

// 36: Norwegian

// 37: Serbian

// 38: Slovakian

// 39: Turkish

// 40: Ukrainian

// 41: Uzbek

Check Bar Codes

Use the Check Bar Code  tool to analyze and interpret the Bar Code text in the selected language.

Select the area around the bar code with a click-drag-release using the left mouse button. You can also

select the area and click the  tool to check the bar code. The result appears in The Channels Panel
and in a pop-up near the bar code.

The following information will appear in a pop-up:

• Type: The bar code type

• Value: The encoded value

• Magnification: The bar code magnification in percentage (visible only when the value is not 100%).

• Bar Width Reduction: The line width compensation in mm. (visible when the value is not 0).
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Note:  The information will be displayed in the following order :

<Type>: <Value> <Magnification> % [<Bar Width Reduction> mm]

 

 

The tool is visible only when the system has an Advanced Approval License.

To make an annotation from this pop-up, click on the Make Annotation  option. You will get a
rectangle annotation with the measurements as its content.

Caliper

Use the Caliper   tool to measure and standardize the height or width of aligned objects in the
Viewer. For example, you can use this to check the text height in your artwork. You can create a Preset
to customize your Caliper to your standardization and compliance needs.

Click the Caliper  button from the Measure tools to activate the tool. You will get the Free style as
the default Caliper form. In the sub tool bar, you can:

• select the Style. Choose from the Style options:

• Free (Default)

• Fixed

• Preset

• specify the Gap Size which is the distance between the start and end lines. If your selected style is:

• Free, changing the Gap size will alter the end line.

• Fixed, the distance between the start and end lines update according the Gap size.

• Preset, the saved Gap size will be applied

• define the orientation as either vertical ( H) or horizontal ( W).

• Save the Gap size and orientation as a Preset. The saved Presets will be added to the Style drop
down. Use the Delete Gap option to delete the saved Presets.
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Free (Default option):

• Hold down the left or right mouse button to draw the start line and drag to the end line. Release the
mouse when the desired width or height is achieved.

• To adjust the height / width, simply drag the lines. You may also move the caliper form from one
location to another.

If the horizontal distance between two selected points is larger than the vertical distance, you will
get a vertical form to measure the width.

If the vertical distance measures more than the horizontal, you will get a horizontal form to measure
the height.

Note:  The Caliper tool will switch to horizontal or vertical orientation corresponding to the
direction of your mouse movement.

A pop up will display the current gap size and the X / Y coordinate of the end line. The information is
updated when you move the lines of the Caliper.

• You can Save/Delete the Gap size and the H / W as a Preset on your profile. This allows you to have
a customized Caliper form for your future use.

Fixed:
In this mode, you can specify a fixed Gap size. Use this when you want to standardize your artwork
object to a pre-determined size. For example, if you have a certain text height needed in the artwork,
specify that as the gap size and check the artwork text.

• Specify the Gap size.

• Use H or W button to fix the Caliper orientation.

Note:  When it is fixed, the your mouse movement will not alter the Caliper orientation.

• Hold down the left or right mouse button to draw the start line and the end line will be drawn
according to the Gap size.

• Click Save to create a Preset with the current measurements (the gap and the orientation).

Preset:
Select your saved Preset in the Style selector. Hold down the mouse to draw the lines with your preset
Gap size and Style.

Note:  In the Fixed and Preset mode, you can grab the start or end line to drag the form to another
position.

Press Esc to revert to initial state (no lines drawn).

Text Selection in Viewer

You can select the text in the document by clicking on Text Selection  button for any PDF, AI files and
documents with SVG perspective in the Viewer.

When you select the text, you can also
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• Search in text: Search for specific text in the sub toolbar of the text selection tool. The searched
text is highlighted which you can zoom to or navigate to the selected text using the previous and
next buttons in the sub toolbar.

•
Select all text: Select all the text statements in the document using the Select All . You can also
alternatively select all the text using Ctrl+A keys in the keyboard. Right click on the selected text to
either highlight the text or add an annotation or copy.

You also have an option to find the font and the font sizes used in the document.

• Detect Font : Click on this icon and then click on a selection of text to detect the font in the
selected text. A pop over is shown with the Font, Font Size, Selected text and an hyperlink to make
annotation.
 

 
• Check Font Sizes: Click on this icon and then select the font size using the text box or slider to

detect text which text is smaller than the selected font size.

Text Edit Mode

You can edit the text in the artwork document with the Switch to Edit Mode icon. This would be helpful
to correct or change the text instantly from the WebCenter Viewer.

Click on the Switch to Edit Mode  icon, to switch to edit mode. Following widgets are enabled when
you Switch to Edit mode.

• Annotation Widget
• Files marked for edit widget
• Actions widget
• Channels widget
• Navigator widget
• Info widget
• Help widget
• Zoom/Pan tools
• Rotate/Mirror tools
• Text Selection tools
• Switch back to view mode and save button

You can choose the files where the text has to be edited in bulk in Files Marked for Edit widget.

Layers

Graphic documents are usually created with layers and viewer has been enabled with a layers widget.
This widget is shown whenever there are layers present in the document opened.

In the Layers widget, all the layers of the opened document are listed.
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Note:  If no layers are defined in the document, the Layers widget is hidden.

Each Layer has an eye box to enable or disable the layer and you can choose the option All to see all the
layers present. You can enable or disable each layer by clicking on the eye box for that layer.

When only one layer is active, and if you choose to disables that layer, the next layer in the list is
enabled.

Layers

Graphic documents are usually created with layers and viewer has been enabled with a layers widget.
This widget is shown whenever there are layers present in the document opened.

In the Layers widget, all the layers of the opened document are listed.
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Note:  If no layers are defined in the document, the Layers widget is hidden.

Each Layer has an eye box to enable/disable the layer and you can choose the option All to see all the
layers present. You can enable or disable each layer by clicking on the eye box for that layer.

When only one layer is active, and if you choose to disables that layer, the next layer in the list is
enabled.

Printable layers are indicated with a tick mark against the layer in the widget. Layers can be filtered
based on the type namely Artwork Layers or Processing layers. Filtering on either of them enables all
the layers of that type.

Open 3D View

If you have opened a document in the HTML5 Collada Viewer once, the top tool panel will show an Open

3D View  button.

Click this to generate the 3D View.
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Finishing Profile

When you select the 3D button in the top bar, two new widgets appear namely

• Print Finishing
• Geometry

When your document is a PDF or AI Document, it is possible to simulate the Finishing effects in the
3D Viewer. To do that, the user can select a Finishing profile when a 3D structure is selected in the
Compare Widget.

The Finishing Profile is a file that can be exported by Studio. When stored in the same project as the
Graphic Document or in the StudioManager project, it will be possible to select it in the Viewer.

Note:  Generation of the Graphics with a Finishing Profile may take a while.

 2.5 D
You can preview your artwork with finishing effects without having a Collada file available. In the 
Document Select  Geometry widget in the viewer, you can navigate to  Structure Document  Shape 
option.

There is a built-in Structure Document curved sheet that is used to see how the artwork would render
in a 3D environment. You can change the angle of the curve as per requirement.
 

 

Click on the Open 3D viewUpdate 3D Model  button, to show a surface in the angle that was chosen.
The surface contains the graphic, which will follow the selected Finishing Profile.

Document Select
The Document Select panel allows you to select the Current view from the multiple files (documents or
document versions) loaded into the Viewer.

The panel will contain three document lists:

• Current
• Compare with
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• Structure Selector ( only available with Graphic Documents )

 

 

From the Current list, select the file you want to view. You can switch to different documents view from
this list.

You can also add new documents in both Current or Compare With to the list by clicking on Find More
Documents. This opens a Select Document pop up window. You can filter the document based on the
Document Name or Project Name.

Note:  If you do not want to compare documents or versions, leave the Compare with field empty.

Compare To
The Compare To list contains the possible reference documents. Select the reference document from
this list to compare to the Current.

When a reference document is selected from the Compare to list, the lower part of the panel will
display controls for adjusting Channel Matching, Orientation and Alignment.

Read Compare Documents in the Viewer for more details.

Selecting Documents
You can select the current and the reference versions using the two document selectors in the
Document Select panel.

Note:  The reference document type has to be the same as the active document type. For Example,
when a CAD document is active only other CAD documents can be selected as the reference.

The The Information Bar displays the selected active and reference document name and version.

The Viewer will start the last used compare mode except the Show Current and Show Reference
modes.

Selecting Multi-Page Documents
You can select the Current and Compare to pages using the two document selectors in the Document
Select panel.

While comparing multi-page documents, a Reset  button is enabled in the Document Select header.
If you have defined a special mapping for comparing pages of multi-page documents, you can use this
to reset the mapping. You have to specify whether to reset the mapping of the active page or for all
pages.
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Read also Channel Matching, Orientation and Alignment in Compare Mode.

Structure Document Selector
While viewing a graphic file with CAD reference, the Document Select widget will have:

• a Structure Document selector listing all the CAD documents and 3D Documents opened in the
Viewer and the CAD references associated with the graphics file.

If a Structure /CAD reference is found, you will see this in the document select panel with a link 
icon. You can select this to view together with the graphics document. If the graphics file does not
have a XMP link, you can use the document references feature to link them.

To remove the CAD link from the graphics file, click Turn off CAD Overlay in the CAD Overlay
selector and Save.

Read more in: Viewing CAD with Graphics.
• Open 3D View  button. Click this generate a 3D View.

Note:

The 3D button will be available in this widget only when it is possible to generate a 3D from the
current Graphics and the selected or referred CAD overlay.

Use Ctrl+S  to switch between Show Current and Show Reference compare modes

Multiple Documents Select option
You can view multiple documents one by one in the viewer. To view, select the multiple documents in
the Documents panel and click View and Annotate. In the Viewer, Document Select panel, you can
choose the documents in the Current and Compare to options.

You have the option to go the first document, previous document, next document or to the last
document chosen with the arrow keys.
 

 

Current selected Document Index displays the number of documents selected and the number of the
current document displayed.

Page List
The Page list panel will be available when you open multi-page or page list documents.

The Page list panel will be available when you open multi-page documents
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Here you can:

• see the thumbnails of all the pages. Each row will contain two thumbnails.
• configure size to Small Thumbnails, Medium Thumbnails or Large Thumbnails

• view a specific page by clicking the corresponding thumbnail. The thumbnail of the active page will
be highlighted.

• view the page name or folio for the thumbnails. This allows you to select a page corresponding to a
folio or page name.

• view which pages are annotated. These pages will have a note on the thumbnail.
• view the approval status of individual pages of a Page list. A blue circle indicates the pending

approvals on a page. Read also Approval in Page Lists on page 727.

Note:  You can define page by page approval in a page list. For a multi-page document, the approval
set-up is for the entire document.

• view the blank and empty pages as thumbnails. The blank pages of a page list will be displayed as
white thumbnails and the empty pages as crossed thumbnails.

Note:  You cannot view empty pages. You can view the blank pages, but you cannot annotate or
compare them.

Tip:  You can collapse other widgets to make more space for Page List panel while viewing large multi-
page or page list

Read also Viewing Multi-Page Documents and Page Lists on page 724

The page thumbnails of a page list or multi-page document are displayed according to the binding
type:

• Left edge binding: the first page and the odd numbered pages are displayed on the right. The even
numbered pages will be on the left.
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• Right edge binding : the first page and the odd numbered pages are displayed on the left. The even
numbered pages are displayed on the right.

 

 

Annotation List
The Annotation list panel provides a listed view of the existing annotations in the currently viewed
image. You can collapse this panel to hide the annotation list panel.

You can see them in the created or modified order depending on the setting and filters. Replies are
visible immediately below the corresponding annotation in the created/modified order.
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The Annotation list panel has tools to:

• Save annotations
• Step through annotations
• Reload :

You can Reload the annotations of the active image. This reloads all annotations without restarting
the viewer. You will be warned about unsaved annotations while reloading.

• Annotation Options
• Filter Annotations
• Create Custom filters for annotations

If you select an annotation either in the annotation list or in the viewport, this will be highlighted in the
annotation list. You will also see the possible options concerning the annotation and its replies.

Note:

The time will be displayed as 5h ago, yesterday, 2d ago... To see the exact time, hover over the
displayed time.

Note:  In video annotations, start time and end time of the annotation is displayed in the list.
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Tip:

If you click and hold the left mouse button on an annotation in the annotation list, the annotation
becomes highlighted in the view.

From within the Annotation list panel, you can:

•
Set Review State  of the annotation

•
Zoom to annotation 

• If you are the author you can perform more actions via More actions 

• Edit Annotation
• Duplicate Annotation

Use this to make a variation (e.g. correction) of an annotation made by another user.
• Save Annotation
• Delete Annotation

You can only delete comments that you have authored. All the replies to the deleted comments
will also be deleted, irrespective of the author.

• Filter annotations by User or Review State.
•

Click Edit Custom Filter to get the Custom Annotation Filter window.
•

Lock Filter by clicking the pin .

If you lock a custom filter, it stays active for other documents and consequent viewer sessions.

Approval Details
In Approval Details, you can see:

• the current approval status
• the approval actions
• approval info.

 

 

You can collapse/expand this widget and drag it around.

Content Widget
Artwork documents that contain Images, Symbols, Tables, Text Contents and Barcode as reference
documents can be viewed in the viewer. You can view all the above content or filter the specific
content to view in the Content Widget.
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If the artwork (AI or normalized pdf) contains location information for any of the dynamic elements,
then an annotation is shown around the dynamic element.

 

 

View and Filter Content
By default, when an artwork is viewed in the viewer, all the contents of the artwork are visible without
any filtering.

You can view all the content in the artwork or you can view and filter the contents based on

• Text Content
• Tables
• Images
• Symbols and
• Bar codes
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Note:  If there are no document references used in the artwork, then the content widget will not be
shown.

Map Locale to Languages
You can view the locale id present in the artwork and map it to the languages existing in the project.
If either the Project or the Document attribute category contains the hard-coded attributes
LOCALE_XX, then locale mapping will be automatically taken from these attributes. If no locale id are
mapped to languages in the project or document attributes, then user can manually assign the values
in the viewer.

Compare Artwork with the requirements.
Read more about it here.

3D View
The 3D View widget always shows the HTML5-version of the 3D viewer.

After the 3D generation, you can view the 3D mockups in this widget.
 

 
From within this widget, you can:

•
Open the 3D Viewer  in a new window

• close the 3D View widget.

3D Setup in Share & Approve Viewer
You can open any graphical document such as a pdf or an AI document in Viewer and view the
document in 3D. You can also view the 3D setup of a graphical document along with the structural
document (like Collada) by selecting the documents together from the same folder and clicking on
View and Annotate.

You can visualize the document with 3D features like transparency, reflection and using the mouse to
rotate, zoom in or zoom out.

Click the 3D toggle button to enable the 3D Setup  Widget, and save the settings.
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You can add the Shape, Finishing Profile and Substrate Color for the document viewed in the 3D Setup
Widget and preview the same in the viewer. The options available are:

• Shape: Choose one of the options in the drop down namely Flat sheet or Curved Sheet or Find
Documents in the folder.

• When the option Curved Sheet is chosen you can specify the angle of the curvature in degrees.

• Choose one of the printable parts.

• Substrate Color: Choose the color from the color palette depending on the substrate it is printed
on.

• Finishing Profile: Choose the profile from the drop down list to view your graphics document in the
chosen profile. You can also configure a Separation Mapping.

• Die Cut Control: Choose to show the Die cut lines in the 3D graphics document.

• Recto/Verso: Choose this option to view the text written or printed on the front side and on the
back side.

• Sheet Size: Choose the sheet size from the drop down.

• Graphics Rotation: Choose the Rotation angle from the drop down, if you want to rotate the
graphics on the 3D model.

You can choose Preview to view the settings instantly in the 3D Viewer. You can also Save Settings or
Remove Settings.

Save Settings and Remove Settings options are available for Approval Master and Editor Roles.
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How to Configure Custom finishing Profile
Esko Share & Approve viewer can visualize 3D simulations of specific finishing effects, such as varnish.
A Finishing Profile defines how the separations of a given PDF are mapped to these effects.

Share & Approve comes with nine default Finishing Profiles and each profile maps to the operations
that is suitable for the substrate.

Share & Approve allows you to use custom Finishing Profiles made by Esko Studio visualizer. You can
read more on how to use the Custom Finishing profile here.

How to Configure a Separation Mapping
When visualizing graphics in 3D in Share & Approve, users may select a Finishing Profile from a list of
defaults. This Finishing Profile maps separation names to the 3D effects. The list of default finishing
profiles available in the Share & Approve may not suce your requirements. When you want to add
your own custom Separation Mapping, follow the steps given in the Knowledge base article  here.

Note:  Ensure that other users have access to your separation mapping when saving the settings by
placing them in the same folder as the graphical document.

Navigator
When you open a document in the Viewer, you can view its thumbnail in the Navigator. This gives
an overview of the current view position. Use this widget to quickly navigate through the entire
document.

The navigator highlights the area visible in the view port with a dotted rectangle. If the zoom is not
active, the dotted rectangle will be around the entire document.
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When you are zooming in the document, the navigator shows the highlight area as the zoomed area. To
pan the document, hold the mouse and drag this selected rectangle around. The central view port will
display the area correspondingly. Clicking outside the rectangle will move the rectangle to the clicked
point and update the current visible area.

You can see the current zoom percentage at the slider bar located below the document thumbnail. You
can adjust the slider or click the + or - to adjust the zoom level.

Note:  By default, this widget is available on the right sidebar. You can drag this widget to the center or
to the other sidebar.

Info
This widget displays information about the document being viewed. You can see the following info:

• the size of the active document
• the size of the trim box of the current page
• the resolution of the active document. If you are in compare mode, it will display the resolutions of

the current and reference documents.
• the current mouse position in the document
• the current selection within the current page document when using measuring tools

In this widget you can change the units for resolution and measurements. To change, click  and
select your preferred units.

Note:

The changes made will be applied to all of the Viewer measurements for the current session:

• Offsets in Compare panel
• Information Pop-ups of all measurement tools and Caliper tools

Note:

The changes made from the info widget are applied only to your current session. The next time you
start the Viewer, the units will be reset to the WebCenter User settings.

Note:

To switch units for resolution and measurement, use shortcut keys. While switching, it takes the values
of the next unit from the drop down list.

• Ctrl+U to toggle the units for the sizes used in the Viewer.

• Ctrl+Shift+U  to toggle the units for the current resolution and screen ruling units.
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View
This widget contains advanced tools for view manipulation such as:

• changing the background color of the image or window
• view from the back
• highlighting overprint with colours
• viewing or hiding the trimbox (margins) and clipping to trim box
• viewing in inverse colors
• compensate distortion and scaling while viewing

Change Background Color of the Image or Window
You can use this tool to manipulate the view with a different background color other than white. This is
especially useful when you are evaluating an image that will be printed in a colored background.

When you click the Change Image or Window Background Color  tool, you will get an additional row
of tools in the View widget.

•
Change Image Background Color...

When you activate this option, you will get a color picker. Select the image background color and

click  to return.

Tip:  You can also click outside of this color picker to close the color picker and inspect the image
with the new background.

•
Change Window Background Color...

Select your color as described above and inspect the image with the new window color.
•

Change Both Image and Window Background Color...

When you activate this option, you will get a color picker to select a color for the image and window

background. Select the image background color and click the  to view the result.

Note:  Your color choices are remembered for your next session. When you enable the background
color options, the same colors will be available.
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•
Reset Background Colors

Note:  The Viewer retains the last used colors for your next session. However, if you select different
background colors for different pages or documents, those will be remembered only in the current
session.

To turn off the tool and view the image with white background, click the  again.

View from Back

Use the View from Back  to mirror the view. You can see the image from the back and the channel
sequence will be reversed.

This is a useful tool if you are inspecting an image to be printed on a transparent medium.

Set Overprint Highlight Color

The Set Overprint Highlight Color  lets you select a mask color to display in all areas where two or
more active channels are overlapping. This allows you to check if trapping is done correctly.

Click the  tool on or off to have the overprint color highlight on or off.
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Note:  Click Ctrl+H to switch between No Overprint display and Overprint display with the last selected
color

Invert View

Use the Invert View  option to invert the image or images being viewed. While comparing, if you
enable Invert View option, both the images will be inverted.

 

 

The orientation and alignment tools in the Document Select widget has Invert Reference Image
option. When this is enabled, the reference image will be inverted.

 

 

Note:  If you enable the Invert View option in the View widget after inverting the reference image, your
reference image will be displayed in the original state.

Show or Hide Margins (Trimbox)

The Show/Hide Margins(Trim Box)  option allows you to toggle the margin (trim box) lines on or off.

While viewing an image with trim box information, this option will display the trim box as colored
margin lines. If there is no trim box, the margin lines will follow the image outline (media box).
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Right-click on  for options:

• Show margins on current page

• Show margins on both pages in reader spread mode
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• Set margin (trim box) color sets the margin color for the current image while comparing two
images.

• Set reference margin (trim box) color sets the margin color for the reference image while
comparing two images.

• Set current and reference margin color sets the margin color for both images while comparing.
• Reset margin colors reverts to the viewers default margin color settings.

Clip Document to Margin

The Clip Document to Margin (Trim Box)  option limits the content to the trim box (margin).

Right-click on  to get more options:

• Clip Document to margin (trim box) in reader spread mode only prevents overlapping page
margins with image content in reader spread view mode. This option is useful while viewing multi-
page documents.

• Clip Document to margin (trim box)  clears the content outside the trim box. This is the same as a

simple click on the Clip document to margin  button.

Compensate Distortion and Scaling
Distortion is a technique used to pre-compensate graphics which will be printed with a non-uniform
printing technology. Distortion is typically done during the RIP'ping process. In some workflows scaling
is used in place of distortion to pre-compensate for distortion in printing process.

The Compensate Distortion  tool allows to compensate both distortion and scaling.

You can use this tool while comparing files with and without distortion or with different distortion
values.

Note:  This tool is available in the View widget only when the active or reference file has a distortion
and/or scale.

Hover on the tool to see the current distortion and scale values for the documents.

 

 

Use this tool to compensate:

• the distortion of the active and reference document when the documents only have distortion
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• the scale if the active documents only have scaling
• both the distortion and scale of the documents if the active documents have both.

To activate the tool, click on the Compensate Distortion tool.

 

 

You can:

• Compensate distortion only
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• Compensate scale only
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• Compensate both distortion and scale
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You can activate or deactivate one of these options by clicking on that option.

After the compensation of distortion or scale or both:

• the tool tip displays the updated distortion and scale information.
• the Info widget displays the updated resolution and size.

Attributes
If the document in the Viewer has an Attribute Category with a Viewer specific View, you will see the
Attributes widget in the Viewer.

Note:  If the document does not have any attribute category or an attribute category with Viewer
optimized view, you will not see this widget.

When you have multiple Views, they are listed alphabetically and the first applicable view is enabled by
default. You can:

•
Save Attributes  from this widget.

Note:  Only the users with Project / Folder level Change Properties permissions can change and
save attributes from the attributes widget.

If the user does not have permissions to edit the attributes, the editing and saving is disabled in the
widget
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Your unsaved changes will be notified with a Save attributes  warning. Click this to Save. When
the data is saved, you will see a notification.

.

•
Switch View  when you are a member of multiple Roles and/or Groups with dedicated Viewer
views. Refer this table.

Save your attribute changes before switching to another View. You will be warned if you try to
switch views without saving your changes.

 

 

Channels
The Channels panel shows the file’s channels and offers separation viewing possibilities.

 

 

Viewing Separations

Click the View channels in separate windows button  to switch to a tiled view of the individual
separations. The separations will be visible in the same order as in the channel list.

The composite view will always be shown as the first view followed by the visible channels in the

displayed order. Right-click  to choose from :
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• Automatic tiling
• Horizontal tiling
• Vertical tiling

Viewing and Hiding Channels
Channels Widget displays the channel list in the printing sequence. The first in the list is a channel All.
The list displays:

• activated channel  button
• channel swatch indicating the color of the channel. In the case of All, swatch box will be white.
• the channel name

for each channel.

Use  button next to the channel name to hide it.

Note:

By default all channels are enabled.

Viewing a single Channel

Right-click on the eye  button of a particular channel to view it as a single channel.

When all the channels are displayed, clicking on All will show only the first channel.

Tip:

Deselect the selected channel to select the next one. This allows stepping through the channels one by
one

From single channel viewing, click All to view all the channels.

Tip:

Alt + 1, Alt + 2 ..., Alt + 9 To select a particular channel in the sequence
(from channel 1 to channel 9)

Ctrl + Alt + 0, Ctrl + Alt + 1... Ctrl + Alt + 9 To select a particular channel in the sequence
(from channel 10 to channel 19)

Alt + N To view a single channel.

Use this to view the first channel when multiple
channels are displayed. Also use this to step to the
next channel while viewing a single channel.

Alt + A To view all channels.

Editing the Channel Color in the Viewer
Click the color swatch next to the channel name to open the Channel Colors window. You can redefine
the channel colors in the Viewer.

Original color definition: This section displays the name, the RGB values, the opacity and the color
swatch of the original channel color.
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You can redefine all these parameters in Display color definition.

 

 

Display color definition: This section allows you to edit the color. You can choose a new color from
the drop-down, edit the RGB values and make the color opaque. The color swatch will display the new
channel color.

The Revert button resets the color definition back to the original.

The left  and right  arrows let you to step through all the channels from within the dialog.

Note:  Editing color definitions in the viewer does not change the actual image file.

Viewing a Channel Opaque

Click on the Show Single Channel as Black  button to make the selected separation/channel
opaque.

Note:  This setting is remembered the next time you open the Viewer.

Right-click  to get the options:

• show single channel in channel color

In this setting, you see the separation in its original color.

• show single channel as black

You can view single channels in black instead of its defined display color.
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• show single channel as black with show all effect :

This eases the detection of areas with small dots by using black rather than a grey value for a
display pixel that represents a partially covered area in the channel.

 

 

Changing the Channel Order
Select the channel you want to move and click either Shift the active channel up  or Shift the active
channel down arrow. You may also drag a channel to a different position to change the order.

Moving the channels down will put them later in the printing sequence. This would cover the other
colors printed before.

Note:  This only changes the order in the Viewer and does not influence the actual printing sequence.

Reverting the Changes

Reset channel order and color definitions button  will undo all display color edits by default. Right-
click to specify :

• Reset channel order only

• Reset color definitions only

• Reset all channel information

CAD
The CAD  panel will have options depending on the file you opened in the Viewer.

While Viewing CAD files and Manufacturing Data
CAD panel contains a list of layers and classes. You can select the parts of the CAD data to be displayed
in the view. This panel is only available if the viewed document contains CAD data.
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When you open a CAD document in the Viewer, this panel displays:

• Layers list:

Here you can turn each CAD layer off so that it is hidden from the view. Only layers present in the
CAD data are shown in this list.

• Classes list:

Manufacturing data usually contains a number of one-up designs consisting of a number of layers.
These layers belong to a layer class. In the Classes list, you can turn off the layer classes.

• Click All Layers / All Classes to view or hide all data at once.

• Use the eye button  to select the layers or classes in view.

• Right-click on the eye  next to a layer or class to view just that one. All other layers / classes will
be hidden from the view.

Note:  The order of these layers and classes is defined in the CAD file.

CAD Options

 

 

You can choose to view or hide Nicks and Bridges in the CAD file :
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• Hide Bridges and Nicks or Show Bridges and Nicks

• Show Nicks

Enable this to view Nicks in the display. You can also see the size of the nicks

• Show Bridges

With this option, you can view the bridge-gaps.

• Show one-up names

While viewing manufacturing data, you can see the names of the One-ups using this option. This
option is turned off by default. This button is disabled when displaying a single design file.

While viewing CAD linked with Graphics
When a Graphics file with a reference CAD file is opened, the CAD line work is shown on top of the
graphics file in the view. You have also options in the CAD panel to:

•
View both Graphics and CAD data 

•
View Graphics only 

•
View CAD data only 

 

 
In CAD options, you can also set various degrees of dimming the graphics data to make the CAD data
more visible:

• Normal Graphics

• Lighten Graphics some

• Lighten Graphics more

Note:  When you re-open the viewer, CAD line work will be displayed on top of the graphics file. The
modes in the CAD widget are not persistent.

While viewing CAD in 3D
While viewing a CAD design file (or a graphic file with CAD reference ), the CAD widget will have an Open

3D View  button.

Click  to open the file in the HTML5 Collada Viewer. The 3D Viewer will open up in the 3D View widget.
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Note:

Once you have opened the file in 3D, the Open 3D View  button is added to the top tool panel.

Help
You can search for information in the Search Knowledge Base panel from within the Viewer window.

Tip:  To access online help, use the keyboard shortcut F1 or click .

Annotating in the Viewer
You can use the Viewer annotation tools to add annotations or comments to the Viewed image.

To add an annotation, Click on either the  Add Annotation on page 690 button or the  Note
Annotation on page 694 button.

Click the  to get a list of additional annotation options. If you select a different annotation type, this
button will change to the selected annotation type.

Add Annotation

•
Click the  Add Annotation button.
This opens a sub-menu of different annotation tool options. You can use these with a click-drag-
release action:

•
Rectangle Annotation Tool : Use this to select a rectangular area where you can annotate.

•
Oval Annotation Tool : Use this to select an oval area within the image.
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•
Freehand Annotation Tool : Use this to make a freehand marking within the image.

• Line Annotation Tool : Use this to make a line marking on the image.

• Arrow Annotation tool : Use this to create an arrow marking on the image. The arrow head
will be at the place where the mouse is released.

•
Highlight Annotation Tool : Use this to select an area and highlight it in transparent yellow
overprint.

•
New Global Rectangle : Click on this to create a rectangle annotation surrounding the
entire image without the dragging action. You may create multiple global rectangles.

You can also re size this global rectangle.

•
Change default annotation line color...

When you click this color block, a window opens from which you can select a new color. This new
preference is saved for all future annotations.

•
Reset default line color... 

When you reset the color, a message asks if you want to update all the annotations with this
color.

• From the  sub-menu, select the type of annotation.

The Viewer remembers the selected tool until another tool is selected.
• Optionally, change the color of the annotation line. Otherwise, the default color (red) will be used.

You can change the annotation line color from the annotation window as well.
• Click, drag and release within the image.

You can type and format your annotation in the Annotation Window on page 691. You may also
Change Color of the annotation.

• Enter your comment inside the annotation window and save. Read also Annotation Window on page
691.

Annotation Window

While creating an annotation, an annotation window appears where you can add comments.
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You can emphasize parts of the text using the formatting options. You may also undo and redo any
changes you made in the text.

You can also change the direction of the text based on the language used for annotations. For example,
you can use right to left or right to left buttons when working with languages like Arabic or Hebrew.

Tip:  You can move the window to move the annotation to a new position.

Annotation Pop-up

If you select an existing annotation, the corresponding annotation pop-up opens. The pop-up
contains :

• the type of annotation

• the annotation sequence number

• the annotator's name
• the annotation text
• the list of replies
• the list of review states

 

 

In the annotation pop-up you can:

• Pin the annotation pop-up.

By default, the annotation pop-ups are unpinned. Use the Pin icon to pin the annotation pop-up

to the location. To unpin, click on the Unpin  button. The setting you choose will be remembered.
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• Close the annotation.

•
Set the review state  of the annotation

Choose the review state from the sub-menu.

 

 

The annotation list panel will display the new review state including the name of the reviewer. Save
your changes after setting the review state.

•
Zoom to annotation 

• do more actions via Actions Menu 

• Edit annotation

• Delete the annotation

You can only delete comments that you have authored. All the replies to the deleted comments
will also be deleted, irrespective of the author.

• Duplicate the annotation

Use this to make a variation (e.g. correction) of an annotation made by another user.

• Save the annotation

Note:  Only the original author can edit, delete or save.

• Reply. Click on the Reply field to get a rich text editor and type in your reply. You can either Save or
Cancel the typed reply.

These replies are visible in the annotation window as well as in the Annotation List.

Tip:  Only two of the latest replies are visible in the window. Click Show x more replies to view the
rest of the replies. To view less replies, click on the Show less replies button.

Note:

In the Show only selected annotation setting, the annotation pop-ups of the selected ones are shown.

When this setting is turned off, select Show only selected annotation pop-up to view the selected
one's pop-up and all other annotation markings. This setting overrules the Pinning.

Read more in Annotation Options on page 697.
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Note Annotation

You can create a text annotation at any specific point on the image using the  Note Annotation
tool.

•
Select the  Note annotation tool
You can also set the color using :

• Change Default Note Annotation Color. The default is yellow.

When you click this color block, a window opens from which you can select a new color. This new
preference is saved for all future note annotations.

•
Reset Default Note Annotation Color

• Click on the point on the image where you want the note.
The Annotation Window on page 691 will appear where you can enter your note.

The annotation will be marked by a small note icon in the image.

Note:  When you select a note annotation, it will be displayed in inverted colors within the view.

Editing Annotations
You can edit or move the annotations in the Viewer.

• You can select your annotations by:

• grabbing the annotation shape. When you hover near an annotation shape, the mouse pointer
changes to a select arrow.

• selecting it in the Annotation List on page 666. T

Note:

When selected,

• the annotation is highlighted in the annotation list with a yellow background.
• the annotation shape border thickness becomes double.
• the annotation shape displays handles to enable resizing.
• the Note Annotation on page 694 color is inverted in the view area.

• a rectangle, line, arrow, oval and highlight annotations display anchor points.

• You can drag the annotation using the mouse.

• You can move a Note Annotation on page 694 or a Rectangle annotation by dragging it. When
you hover near a note annotation, the mouse pointer changes to a select arrow.

• To resize rectangle annotations, click the anchor point and drag either one of the four border
lines. You can also grab one of the four corners and resize with the help of a resize cursor. To
move a rectangle annotation, click and drag it to the new location.

Note:  Highlight annotations can be modified in the same way as Rectangle annotations.
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• To change an oval annotation shape, use any of the anchor points. Click and drag to move the
annotation.

• Hold and drag the end-points to modify line annotations or arrow annotations. You can also
select and drag the line or arrow to another location.

• Select and drag freehand annotations to change its location within the image. However, the size
and shape cannot be changed.

• You can use More actions > Edit annotation in the annotation window (or in the Annotation List on
page 666) to edit the annotation or reply text.

Note:  This is only possible if you are the author of the annotation/reply.

After editing, you can either Save or Cancel the text changes.

Linking Annotations
You can add multiple annotation areas to a single annotation note.

The linked annotations share the same text, sequence number, replies and review state. This helps you
to draw multiple areas to one single annotation.

1. Select the annotation to be linked with the new annotation shape.
2. Click on Add Annotation and choose the annotation shape.
3. Create the new annotation holding the Shift  key.

The new annotation is linked to the selected annotation. The new annotation will share the same
annotation pop-up. You can connect many locations in the same image to one annotation this way.

Duplicate Annotations

You can duplicate annotations that were created by you or another user.

•
To duplicate an annotation created by another user, click the Duplicate icon 

• To duplicate your own annotation, use More actions > Duplicate Annotation in the Annotation Pop-
up on page 692

The annotation (and any linked annotations) from which you duplicated will be made into a new
annotation thread with your name as the author and the current time. The text will be duplicated as
well.

The color of the duplicated annotation will be the your default color for that annotation type.

Delete Annotations

You can delete your own annotations using the delete key. You cannot delete replies to your
annotations this way.

You can also delete annotations using Annotation List > More actions > Delete Annotation. From the
Annotation Pop-up on page 692, use More actions > Delete annotation.

You have to confirm the deletion when you are deleting an annotation. However, if you are deleting
replies, a confirmation is not required.
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Save Annotations

Your annotations and changes to annotations are not automatically saved to the server.

If you

• create a new annotation
• add/edit a reply
• move the pop-up
• pin/unpin pop-up
• change the annotation color
• set a review state
• edit text
• delete an annotation or a reply

the Save in the Annotation List on page 666 warns that there are unsaved annotations (or unsaved
deletions). Save these annotations or changes by either clicking this icon, or by using the Save option
in the Annotation Pop-up on page 692.

 

 

A message will indicate that the messages were saved successfully.

Viewing Annotations

When you open an annotated document, the annotations will be visible on the document and the
Annotation List on page 666 widget.

If you select an annotation either in the annotation list or in the viewport, this will be highlighted in the
annotation list. You will also see the possible options concerning the annotation and its replies.
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Note:

The time will be displayed as 5h ago, yesterday, 2d ago... To see the exact time, hover over the
displayed time.

Note:  In video annotations, start time and end time of the annotation is displayed in the list.
 

 

Tip:

If you click and hold the left mouse button on an annotation in the annotation list, the annotation
becomes highlighted in the view.

Step Through Annotations

You can step through all the listed annotations using the button. By default it will step through each
annotation. After the last one, it will return to the first annotation again.

Tip:  Hold the Shift and click  to step backwards.

When you select an annotation, its comment window will appear.

You can set your preferred step through setting in Annotation Options on page 697. You can set your
preference as any of the four options available.

• Step by Thread: This is the default mode. Will step through each annotation, but not through the
replies to the annotations.

• Step by Decreasing Date: This mode will step through all annotation comments and replies sorted
according to their modification dates.

• Step by Thread - Fit View: Same as "by thread", but will zoom the view to fit the selected
annotation.

• Step by Area/Position - Fit View: Will step through all positions/areas of linked annotation and
zoom the view to fit the selected annotation part.

Annotation Options

Step through Options
You may choose to step through the annotation in any of the following ways.

• Step by Thread: This is the default mode. Will step through each annotation, but not through the
replies to the annotations.
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• Step by Decreasing Date: This mode will step through all annotation comments and replies sorted
according to their modification dates.

• Step by Thread - Fit View: Same as "by thread", but will zoom the view to fit the selected
annotation.

• Step by Area/Position - Fit View: Will step through all positions/areas of linked annotation and
zoom the view to fit the selected annotation part.

Show only Annotations
Use these two options to set the visibility of annotation and annotation pop-ups in the view. This helps
in simplifying the view by displaying only targeted annotations.

• Show only selected annotation: Only the selected annotation is shown in the View and the pop-up
appears when the annotation is selected.

In this setting you will see a warning.

Warning! Only the selected annotations is shown.

• Show Only Selected annotation pop-up

You can choose this option when the Show only selected annotation is unchecked.. All the
annotations will be in the View, but only the selected pop-up will be present in the view.

Note:  This setting overrules the Pinning.

• A warning message will indicate your current setting.

Warning! Only the pop-up of the selected annotation is shown.

Always show Annotation pop-ups
• Enable Always Show Annotation Pop-ups the Annotation List on page 666 settings. This setting is

persistent and will show the pop-ups when you reopen the Viewer.

When this setting is enabled, the Close button will not hide the pop-ups.

Show or hide sequence label on the annotation
Use this option to show or hide the sequence number of annotations.

Unlinked annotations with sequence label:
 

 

For linked annotations, the sequence number remains the same for all linked parts. A second number
after a hyphen indicates different annotation areas.
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Show or hide character and line count
You can track the exact number of characters and lines in the annotation texts using this option.

When you enable this, the character and line count will be shown in the Annotation pop-up and in
Annotation List panel.

 

 

To turn this off, disable this setting in the Annotation Options.

Fit View to the selected Annotation
Use this option to automatically fit the view and the zoom to the selected annotation. The Viewer will
remember this setting and will return to this view when you reopen.

Ordering the Annotations
You can order the annotations in the Annotation List in two ways:

• Ordered by creation date: All annotation comments and replies will be sorted according to their
creation dates.

• Ordered by modification date: All annotation comments and replies are sorted according to their
modification dates.

Filter Annotations

In the Annotation List on page 666, you can :

• filter annotations by user / author.

When you select a single author, only the annotation threads and replies made by this author is
displayed.

• filter annotations by its review state.

• Any Review State will select all where there is a review state on the main annotation or any of
the replies made.

• No Review State will select all where there is no review state on the main annotation. If the
review state is “None”, it will not be shown.

• Accepted will select all annotations and replies with Accepted review state.

• Rejected will select all annotation threads and replies where the review state is Rejected.

• Cancelled will select all annotation threads and replies where the review state is Cancelled.

• Completed will select all annotation threads and replies where the review state is Completed .
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• None will select all annotation threads and replies where the review state is None.

• You also can filter using :

• All Except Accepted

• All Except Rejected

• All Except Cancelled

• All Except Completed

• All Except None

• customize your own filter combining the author and review state. Read in Custom Filters for
Annotations on page 700.

Custom Filters for Annotations

Use custom filtering to create advanced filters.

Click the Custom Filter  button to enable this option.

 

 

In the custom annotation filter dialog, you can combine the basic Author and Review State filters with
a logical AND/OR operator.

Click Apply Filter to apply the changes and close the dialog. An active custom filter will show a
message Custom Filter Enabled in the normal filter.
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Locking the custom filter

Click the pin  button to lock the custom filter. If you lock a custom filter , it stays active for
other documents and consequent viewer sessions.

Note:  You can always switch back to the basic filter by selecting a value from the drop down.

Hide Annotations

To hide annotations, you can click  Hide annotations in the toolbar. You can view them again by
clicking on the same button.

Viewing Annotations in Compare

The annotations are hidden by default when comparing two documents. Set Show Annotations for:

• Current
• Reference

to display annotations from either the current or the reference version.

 

 

In Blinking compare mode, the annotations are hidden.

Note:

You can edit the annotations from the current document, but not from the reference document.

Viewing External Annotations

You can view annotation information in the Viewer even when the annotations are created by external
tools such as Global Vision nodes of Automation Engine.

 

 

The Global Vision nodes create these five different types of annotations in an Automation Engine
workflow:
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•
 Barcode Annotations

•
 Braille Annotations

•
 Spell Check Annotations

•
 Artwork Compare Annotations

•
 Text Compare Annotations.

The Viewer also supports:

•  Acrobat Annotations from Adobe Acrobat

•  Editor Annotations from the Esko editors

•
 External Annotations coming from an unknown external tool.

Note:  To view an external annotation in WebCenter Viewer, you have to ensure that the .xfdf files are
uploaded along with the pdf document.

When a document has Global Vision annotations, a group of buttons is shown in the Annotation Widget
of the Viewer. Select any of them to see their information.

There is also a button for  User Annotations. Learn more in Viewing Annotations on page 696.

Note:

• Global Vision annotation buttons are only active when the document contains such annotations.
• The other annotation buttons are only shown when the document contains such annotations.
• All these externally created annotations are read-only. You cannot reply to them.
• The Filter option is only displayed for user created annotations.

• You can view the Braille, Barcode and Spelling  annotations on a single document checked in
Automation Engine.
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• Artwork Compare and Text Compare annotations are available when you have compared

documents in Automation Engine.
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Creating User Annotations out of External Annotations

Creating User Annotations out of External Annotations
You can copy and create new User Annotations out of the external annotations that a document
contains. You can choose to create from any one or all the external annotations; with or without text.

Note:  You cannot create text annotations from Global Vision Artwork Compare Annotations.

To create such User Annotations:

•
Click  Create a User Annotation Here button on an external annotation thread. The annotation is
created.

•
Click  Create a Blank User Annotation Here button on an external annotation thread. The
annotation is copied, but without the text.

•
Click Create User Annotations From All Annotations button located on the Annotations
Widget, when filtering on a type of external annotation. This creates User Annotation out of all
currently displayed annotations.

•
Click Create Blank User Annotations From All Annotations on the Annotation Widget, when
filtering on a type of external annotation. This creates User Annotations out of all currently
displayed annotations but without the text.

The newly created annotations have the same properties and are shown in the User Annotations list.

 

 

Annotating in a Multi-page / Page List Document

While Viewing Multi-Page Documents and Page Lists on page 724, you can make annotations:

• on the active page
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• on the adjacent page
• across both pages

When you draw annotations in the non-active page area, a message will ask you to confirm if you
want to draw an annotation outside the current page. This warning does not appear when you draw an
annotation across both pages.

Note:  Reader Spread View on page 725 displays only the annotations from the currently active page.

Approval
You can evaluate and approve the documents in approval cycle from the Viewer using the approval
tools.

You can view the status of the approval in the viewer.

Clicking on any of the approval tools opens the approval pop-up.

• You may set a condition for your approval (if the approval cycle allows this). Select Set approval
condition and type in your condition.

 

 

• You can give a reason for your rejection in the text box.

 

 

For example, if you reject a document because of a specific image detail, use annotations and add
this as an approval comment.

• You may also just Comment without approving or rejecting. Then the status of the document is in
Pending, until you approve or reject it later.

• Commit button to save your approval or rejection and comments to the server.

The approval status will be displayed in the top toolbar in the place of Approval tools. This status will be
Pending if the Approval Cycle is still on-going.
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Remember:

If you are in the Compare mode, you can only do the approval actions on the current document page.

Read also Evaluate a Document in the Viewer on page 706

Evaluate a Document in the Viewer
When you evaluate a graphic file or a page list (see Document Types on page 589 for information about
the supported file types), you can first open it in the Viewer to look at it in detail. You can then approve,
reject, or share a document for approving or viewing or add a stage or comment it directly from the
Viewer.

1. Click the document's thumbnail or the  button.
You can do this from:

• the My Work page (under My Approval if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master),

• the Documents tab in the project,
• the header of the Document Details page.
• the viewer

2. In the top toolbar, click:

•  to approve the document,
•  to reject it,
•  to comment it,
•

to forward approval request
•

 to force approve it  if you are a Project Manager
•

 to force reject it  (if you are a Project Manager).

Alternatively these options are also available in the Approval Details widget. This is available
only if the user has Change Approval permissions.

Note:  You can view the status of the approval of the document in top tool bar.

3. In the pop-up that opens, do the following:

if you are... you can...

approving or force approving the document set a condition for your approval if the approval
cycle allows this (see Allow Conditional
Approval or Not on page 817): select Set
Approval Condition and type your condition in
the box.

rejecting or force rejecting the document type a reason for your rejection in the box.

commenting the document type your comment in the box.

706



4WebCenter

4. If the user has Change Approval permissions, then the user can access the Approval Setup in the

Approval details widget. Click to open the Document Approval Setup pop-up window. User can
perform all actions as specified in
Defining Approval Settings on page 809

5. It is possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
 

 
You can read about it in detail.

6. Enter your password, if your WebCenter server requires it.
In case, the approval cycle is completed and the document is in Approved state, then the user
cannot make any changes to the approval cycle from the viewer.

7. Click the Commit button.

A warning message is shown, if unsaved annotations are present, when you try to Approve / Reject
/Comment on a document.
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Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

• the Approval tab of the Document Details page,

• the Action History tab of the Document Details page,

• • the Java Viewer's Document History panel.

• the Approval Details panel.

To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.

Note:  If you cannot see My Recently Submitted Approvals, go to My Work and add it to your My Work
page.

Forwarding Approvals in Viewer

An Approver can forward the document for approval to another Approver/ (s) who may be registered or
an unregistered user(s) from the viewer itself. Forwarding option is enabled based on the preferences
set by the Site Administrator and also by the Approval Master.

You can view the Forward button in the document and selecting it opens a pop up box. You can select
the User from the list of approvers available or you can enter the email for which forward option is
enabled.

 

 

Option to Forward and remain as Approver or not

Approver has an additional option to forward the document for Approval and remain as Approver or can
forward the document and not remain as Approver.
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Forwarding Approvals from WebCenter Viewer

An Approver can forward a document for approval to another user(s) from the viewer itself. Forward
option is enabled based on the preferences set by the Administrator in the Security Preferences.

You can view the Forward button in the document and clicking it opens the Forward Approval
window. You can select the User(s) from the list of approvers available or you can enter the email id
(unregistered user) for which you wish to forward the document for approval.

 

 

Option to Forward and remain as Approver or not

Approve user has an additional option to forward the document for Approval and remain as Approver or
can forward the document and not remain as Approver.

Setup for Forwarding Approvals

An Approver can forward the document for approval to another Approver/ (s), who is(are) registered or
an unregistered user(s) from the viewer itself. Forwarding option is enabled based on the preferences
set by the Site Administrator and also by the Approval Master.

Forward Approvals setup by the Site Administrator
Site administrator can choose the following options in the Approval Preferences based on which
forwarding option is enabled in the Viewer.

• Don't Allow: Does not allow you to forward any documents by the Approvers.

• Allow Approval Forwarding to registered users: Allows forwarding only to the existing users.

• Allow Approval Forwarding to registered and unregistered users: Allows forwarding to both
existing and new users.

• Make your choice as default: You can select this box, to make any of the above options as
default except Don't Allow.
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Forward Settings by Approval Master
Approval Master can override the Approval preferences given for the current document setup or
choose to inherit the preferences from the folder setup. The options to modify Forward Approvals is
available in Setup Approval only, when the site administrator has not chosen Don't Allow.

Following options are available for the Approval Master to Forward Approvals

• Allow Approval Forwarding to registered users: Allows forwarding only to the existing users.

• Allow Approval Forwarding to registered and unregistered users: Allows forwarding to both
existing and new users.

• Don't Allow: Does not allow forwarding by any of the approvers.

When the Approval Setup is modified by the Approval Master, and approval stages already in progress
are not affected and only the stages setup after the changes are affected.

Option to forward an approval to other users are possible even as a Group member or a Role Member.

Forward to other Approvers when In Groups or Role

• When you are a part of a Group or a Role, and if the option to approve is "One of Group" or "One of
Role", then any of the member can forward for approval. In case of All of Role, then any member
of the role can forward the approval, and all role members along with the forwarded user have to
approve.

• When a Group is replaced with the forward, then only the Approver who is forwarding and the
forwarded approver can approve.

• When the Group still exists, the forwarded member and any one member of the group can still
approve .

• When the original approver is a group with 'All of Group', then along with members of the group, the
forwarded user also approves.

Compare Documents in the Viewer
You can compare two versions of a document or two documents in the Viewer. Use the different
comparison modes to have a close look at the differences between the two files. First, select the
documents to compare and then align them as required.

Once you have opened the documents to compare, there will be extra comparison modes buttons in
the Top Tool Panel on page 646, Channels on page 684, Orientation and Alignment and Annotation
List.

Click... to...

View Current Version 
view the current version (the file in the first document
selector). See: Show Current and Show Reference Modes
on page 719

View Reference Version 
view the reference version (the file you opened in the
second document selector ). See: Show Current and Show
Reference Modes on page 719

View Both - Blinking 
keep switching from the first to the second file rapidly.
Read details in View Both - Blinking on page 719

View both - Show on Top view both files on top of each other.
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Click... to...

Difference Compare Mode 
view both files on top of each other and highlight the
differences in red. Read more in: Difference Compare
Mode (View both highlight differences) on page 720

View both - side by side 
view both files side by side.

Note:  Comparison of 3D files are possible with all the options above except Difference Compare
Mode. You can read more on 3D compare at Comparing 3D documents on page 723

Note:  This feature is not available for video files.

Checklist for Approval in Viewer
You can set up validation fields which are to be filled mandatory, before the approval in the viewer.
To set up validation, ensure that you have assigned an attribute category with a Viewer view of a
document that contains required attributes.

In case, the validation fields are not filled, then you cannot approve the document, although comments
may be updated.

• The validation criteria may be set based on the role in which the user is approving. For example,
Artwork Designer Role may have to enter the answer for the question1 and 2, while Marketing Role
has to answer for question 3 and 4.

• If there is only a Viewer View, then the view is validated regardless of role. If there is a specific view
for the role, then that view is validated.

• If there are views for multiple roles that the user has, then the user approves on behalf of each of
the role and all the role views are validated.

• If there is no view for the role the user is approving, but there are views for other roles the user
could approve as, no validation is done.

Note:  Force Approve and Force Reject options override filling the mandatory fields.

Channel Matching in Compare Mode

Channel Matching in Compare
The Channel Matching influences the way differences in images are displayed while comparing them.
For example :

• differences in display color of the same channel in the current and reference document

• differences in ink names. For example, a design ink name could be different from its production ink
name.

When a Compare To (reference) document is selected, a message may prompt you to open the Channel
Matching Dialog on page 712. This happens only when there are unmatched channels in one of the
documents.

Alternatively, click on the Channel Matching  button to open the Channel Matching Dialog on page
712.
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Channel Matching Dialog

channel matching allows linking channels that have been changed in one of the documents/versions
while comparing. Channel matching can be done automatically or manually.

 

 

There are three settings:

• Match only if identical: Select this to match only the channels with identical names and display
colors.

• Ignore display RGB differences: Select this to match channels with matching names. This setting
ignores the display color differences.

• Also use smart name matching: Select this to match the channels with related names. For
example :

• when the names differ in the letter case (Magenta - magenta)
• when the names differ in color book specification ( 660 - Pantone 660 C and Cyan-Process Cyan )
• when the names are known abbreviations. Example C – Cyan

Note:  This setting ignores display color differences.

Note:  The selection of a particular channel matching setting applies only to the current document. To
make it default, enable the Make this setting the default  check box.

It is possible to edit channel definitions of the current image to match those of the reference image (or
vice versa). Read in Manual Channel Matching in the Viewer on page 713
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Manual Channel Matching in the Viewer

The Channel Matching Dialog on page 712 displays four channel columns listing:

• the Channels Current and the Channels Reference columns display the unmatched channels.

• the Current and the Reference columns represent the matched channels. Matched channels are
displayed next to each other.

1. Drag the channel to be matched from the Channels Current column to the Current.
2. Drag the corresponding channel from the Channels Reference column to the Reference.
3. Click on the Channel from which the definition has to be copied. The clicked channel will be

highlighted in the dialog. This indicates that the corresponding channel copies the definition of the
highlighted one.

 

 
4. Click Save Channel Matching. After saving, the modified channel is marked with an asterisk * next

to the name.

 

 

Note:

Channels displayed in bold in the matched columns cannot be unmatched.

If you manually move the channels from the matched lists to the unmatched lists, the channel
definitions are reset.
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Using Orientation Tools while Comparing
Use the Orientation tools to rotate, mirror or invert the reference document / version relatively to the
current document / version.
 

 

Use:

•
Rotate  to rotate the reference document.

•
Mirror   to mirror the reference document.

•
Invert to invert the reference document.

Tip:  Use this when comparing a positive and negative version of the same document.

Note:  The buttons indicate whether the rotation / mirroring / inverting of the reference document
is currently on or off.

Aligning Files

You will get Viewer tools to align files in the document select panel while:
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• comparing two graphics / CAD files.
• viewing a graphics file and a linked CAD Overlay. Read in: Aligning CAD overlay and Graphics on page

733.

 

 

You can align the current and reference files during compare using:

• auto-align

• anchor points

• corners, margins (Trim-boxes) or offset values.

Auto-aligning Files while Comparing (Graphics)

Auto Align  aligns the currently visible view of the two compared images automatically.

Tip:  Using this tool along with the zoom in function is a quick way to align the current and reference
images in the Viewer.

You can also use this to align the CAD overlay on the graphics correctly.

1. Select the files to compare from the documents.
2. Click Actions > Compare in Viewer.
3. Select the Current and Reference documents in the Document Select on page 662.

The viewer starts the last used Compare mode ( except the View Reference Version or View
Current Version modes ) with those documents.
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4.

Select your preferred Compare mode, for example, View both - side by side  view.
5.

Zoom-in to a specific area and use Auto-align .

Auto Align uses the currently visible view of the two compared images to attempt an automatic
alignment.

Note:  The offset values are filled in automatically.

Tip:

Using this tool repeatedly with one or more zoom-ins can be a very convenient and quick way to
align two images.
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Using Anchor Points

1. Select and load your documents to the Viewer.
2. Select the Current and Reference documents in the Document Select on page 662.

The viewer starts the last used Compare mode ( except the View Reference Version or View
Current Version modes ) with those documents.

Your document select panel will have Orientation and Alignment tools when you select two
documents to compare.

3.
Select your preferred Compare mode, for example, View both - side by side  view.

4.
Click on the Anchor Point Alignment  tool.
The Viewer will transform to the anchor point alignment mode. You can access the navigation and

orientation tools in the top panel. You can also use the Auto-align  function in combination
with the anchor points.

 

 

Note:  The active anchor can be recognized by the crosshair icon.

5. Select your anchor point in the reference document displayed in the middle.

• click to select a point.
• use the arrow keys to fine-tune your anchor points
• you can also drag the selected point to another location.

Note:  Use zoom tool to help you in finding the anchor point.

6. Check the result on the right pane. Click Align to confirm.

Tip:  If you click auto align after selecting the anchor points, it will start auto-aligning by moving the
reference .

The Viewer will return to its original state when you click Align/Cancel.

717



4 WebCenter

Aligning Graphic Files Using Corner, Trim box or Offset

You can use the Alignment tools to align two graphics files.

1.
You can align the files to compare using the Choose corner for alignment of the reference  

option. To specify the corner point for alignment, click  and select your reference corner from
the alignment drop-down.

 

 
2.

Click on the Use margins (trim boxes) for alignment  option to align the images relative to the
trim-boxes of the compared documents. When this option is not on, the alignment will be relative to
the document boundaries.

Note:  If the trim-box information is not included in the document XMP, the document boundary will
be used for aligning files.

When you do a specific corner alignment after clicking this option, the trim box alignment will be
remembered.

3. You can specify numbers in the Offset X and Y fields. This offset is added to the corner alignment.

Note:

If you are aligning two graphics files, the offset will be the distance between the current and the
reference according to the graphics coordinate system (positive horizontal is set to the right and
positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD overlay and the
graphics page using the CAD coordinate system (positive vertical pointing downwards).

While aligning two CAD files, the offset is the distance between the reference and the current
document page (in that order) according to the CAD coordinate system.

Aligning CAD files

• To open multiple CAD documents, select them and click Actions > Compare in Viewer.
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The documents will open in the compare mode. Read details in: Compare Documents in the Viewer
on page 710

•
Use the Rotate Reference  tool to rotate it with respect to the current document.

• Mirror Reference Image will flip your reference (from the centre of the view) with respect to the
current document.

• Use the anchor point alignment tool to align twoCAD files correctly.
a)

Click on the Anchor Point Alignment  tool.
The Viewer will transform to the anchor point alignment mode. You can access the navigation
and orientation tools in the top panel.

Note:  The active anchor can be recognized by the crosshair icon.

b) Select the anchor points in the current and referencedocuments. Use the arrow keys to fine-
tune your anchor points. You can also drag the selected point to a new location.

c) Click Align.
• Offset X,Y fields allow you to enter precise offsets for accurate alignment.

Note:

If you are aligning two graphics files, the offset will be the distance between the current and the
reference according to the graphics coordinate system (positive horizontal is set to the right and
positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD overlay and the
graphics page using the CAD coordinate system (positive vertical pointing downwards).

While aligning two CAD files, the offset is the distance between the reference and the current
document page (in that order) according to the CAD coordinate system.

Compare Modes

Show Current and Show Reference Modes

If you click the View Reference Version or View Current Version button, the tools update their
information accordingly. The annotations are also changed to the current document in view.

The Approval Details on page 668 will be updated as well. In the View Reference mode,you will still be
able to perform the approval actions of the current document.

View Both - Blinking

In this mode, you will see the two selected document pages rapidly one after the other.

• All annotations will be hidden
• Approval details will be unavailable
• If the channels are split in different views, in each view the documents will rapidly change.
• If measure tools are active, the information pop-up will be updated rapidly depending on the visible

page.
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View Both on Top

You can view the documents to be compared on top of each other in this mode. You will not see the
difference view in this mode.

Difference Compare Mode (View both highlight differences)

In Difference Compare Mode, you can view a combination of the current and the reference channels in
the same window. When you select this mode, you will see an additional tool bar.

 

 

Selecting the Compare color space
You can use compare color space tools to judge the nature of the differences between the compared
documents.

• Compare: Channels - This is the default mode. Use this to compare Channels one by one. The
added and subtracted content is displayed in highlight colors.

• Compare: HSV - This mode compares the HSV color of the two documents and you can see the
relative differences in a graded color overlay. The common parts among the compared documents
are shown in a neutral gray color.

The overlay color will be a grade of the selected "Subtracted" color with the strength depending of
the magnitude of the difference. Use this to compare documents where the channels are not the
same. For example, a CMYK document and a Pantone spot color document.

• Compare: Automatic - In this setting, Channels will be used as compare color space if the
definition of all the visible channels is the same in the two compared documents. If this is not the
case, HSV compare will be used.

Change the difference threshold
You can change the precision of difference detection using the slider tool. You can also enter a
percentage [0-100%] value. If the threshold is higher than 0 is set, you will see a message warning
about the hidden differences.

Note:

Your difference threshold will be saved for your next compare session.

Change Difference highlight colors
Depending on your documents to compare, you may want to change the highlight colors. You can do
this by clicking on the color block tool and selecting your preferred colors.

By default,

• the added channels and objects on common channels are displayed in blue to highlight the
differences. The left part of the color block button indicates this highlight color.

• the subtracted channels and deleted objects on common channels are displayed in red. The right
part of the color block button indicates this.
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You can:

• Change added highlight color

• Change subtracted highlight color

• Change both highlight colors

There is a button to reset the changed highlight colors back to red/blue.

Difference Compare Modes
You can select different compare modes for effective comparison of documents. These modes differ in
how they display the unchanged parts in the compared documents. Select from:

•
View both (default) 

This mode displays the unchanged image parts as it is in its normal colors and changes in its
highlight colors.

• Channels only present in the current version is indicated with a + after the channel name.

• Channels only present in the reference version is indicated with a - after the channel name.

 

 

•
View both - highlight difference 

This mode hides the unchanged parts. Select this to view unchanged image parts with lightened
colors. This way, you can spot the differences in a colorful image.
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•
View both - show difference 

The unchanged image parts are displayed in white. In this mode, you can see the differences in its
highlight colors and the rest of the image in white. This way, you can spot even small changes easily.

 

 

Note:  View Both on Top and Difference Compare Mode are not possible when comparing SVG files.

Compare Modes for different file types

Compare Modes Graphics SVG 3D

Current Document Possible Possible Possible

Reference Document Possible Possible Possible

Blinking Possible Possible Possible

Side by Side Possible Possible Possible

View Both on Top Possible Not possible Not possible
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Compare Modes Graphics SVG 3D

Difference Compare
Mode

Possible Not possible Not possible

Annotations in Compare Modes

By default, all annotations are hidden and you cannot make new annotations in compare modes.
However, in the annotation list, you can specify the Show annotations for: as either Current or
Reference. Select:

• Current to view and make annotations in the current document.

• Reference to view the annotations present in the reference document. You cannot draw new
annotations in the reference document.

Comparing 3D documents

You can compare the 3D view of two versions of the same document or reference to a 3D view of
another document. When a 3D file is selected as the Current version, the Document Selector Compare
To displays all the other files that have a 3D view to compare with.

Selecting one of the files as Reference Version will activate the side by side comparison of the 3D
views.

Following compare modes are available for 3D documents

• View Current Version

• View Reference Version

• View Both Blinking

• View Both Side by Side

When a Graphics file with 3D perspective is compared with :

• Another 3D Document

This can be another 3D file or a graphics file with a 3D perspective. Selecting one of the reference
versions in the difference selector activates the side by side comparison of the 3D views.

• Graphics file with a 3D perspective

If a graphics file with a 3D perspective is chosen as reference version, the default 2D compare mode
is used.

When in a 2D compare mode, clicking the 3D button enables the 3D version of that compare mode.

When in a 3D compare mode, clicking the 2D button enables the 2D version of that compare mode
and the Difference compare modes for 2D are available.

Lock Images to Compare

When you compare the 3D perspectives in the viewer, you can lock the view of both the Reference
Document or the Current version by enabling the Lock Movement tool.

One of the document is locked while you can rotate the other. The angle reset option synchronizes the
view of reference 3D object with respect to the current 3D object.
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Update View in Real Time
This option is enabled by default and you can view the current and the reference document aligned
with respect to the each other.

However, when the option is disabled, the viewer only synchronizes after the interaction has stopped.

Compare SVG Documents

You can compare two different SVG files or versions of the same file with each other or a SVG with a
graphic file. The supported compare modes are Blinking Mode and Side-by-Side.

Note:  The Channels Widget is hidden when SVG documents are opened.

External Comparison (QA) Tool in Viewer
WebCenter allows integration with third party external web QA (quality assurance) tools namely
InformaIT and TVT for additional comparison features. The connectivity to the external tools can be
created by the Admin user in the Assisted QA tools menu option where the Name and URL of the tool
must be entered along with tool specific information.

How to Access the QA Comparison Button(s) in the Viewer

When the graphic documents are compared in WebCenter Viewer, additional button(s) are enabled if
any external tools are connected. On click of the button, the viewer is connected to the external QA tool
in a new tab and the comparison is performed.

On completion of the comparison session in the external tool, the reports and annotations are stored
back into the WebCenter.

Reports from the QA Tool

The report is automatically imported in the same WebCenter project as the compared artworks.

Reports names are same as the document along with a sux string as defined by the Administrator
during the configuration of the connection to the QA Tool.

Annotations from the External Tool

After the report is generated of the compared documents, the annotations made are imported back to
the current document in WebCenter and the existing annotation in the document are overwritten.

Note:  Annotations can be viewed, when the external QA tool is accessed from the viewer.

Viewing Multi-Page Documents and Page Lists
The Viewer has a number of  features that make working with  Page List and Multi-page documents
intuitive:  like this Widget

• Reader Spread View
• Page List Widget

When you open a  Page List or  Multi-page document, the  Page List widget displays its pages as
thumbnails. You can switch the main view to a specific page by clicking on the corresponding page
thumbnail.

Special thumbnails are used for Blank and Empty (Non-available) and pages of a Page List. An empty
page cannot be selected as the active page.
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Note:  Blank and Empty page thumbnails are only available for Page Lists.

You can see the page name and folio of each page below its thumbnail. A yellow color bar below the
page thumbnail indicates the currently active page. The bar above the thumbnail contains the page
number (index) and icons to indicate the page's approval state. In addition to the icon, a color code
indicates the primary approval state.

Use the Viewer to compare, annotate, inspect and approve the pages.

Reader Spread View

The Reader Spread view  allows you to see pairs of pages from a multi-page or page list in the
Viewer. This enables you to visualize the document matching the appearance of the final document in
print.

Note:  Reader Spread View is not available in compare mode.

You can turn this on or off by clicking on the  button. You can use   arrows to navigate
between reader spreads.

When one of the two pages is absent, the active page is displayed with an empty area next to it.

Note:  Although you can view two pages at the same time, there can only be one active page. You can
make a page active by clicking on its thumbnail.

The pairs will be displayed according to its binding:

• Left edge binding: the first page and the odd numbered pages are displayed on the right. The even
numbered pages will be on the left.
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• Right edge binding : the first page and the odd numbered pages are displayed on the left. The even
numbered pages are displayed on the right.

 

 

Read also Marking Pages in a Page List on page 730

Comparing Multi-Page / Page Lists Document Pages
1. Load the Multi-page / Page List documents into the Viewer by selecting them and clicking Actions >

View and Annotate or Actions > Compare in Viewer.

Special thumbnails are used for Blank and Empty (Non-available) and pages of a Page List. An
empty page cannot be selected as the active page.
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Note:  Blank and Empty page thumbnails are only available for Page Lists.

2. Select specific pages in Current and Compare To document selectors.

The pages are grouped by document version. Use Hide all pages in the Current and Compare To
document selectors to have the display aggregated.

A dialog opens up where you can set your comparison mode.
3. In this dialog, define how the pages of the active document are mapped to the reference pages.

Click OK.

• Current page only : to map the current active page to the selected reference page. The other
pages will follow page number mapping.

• Current and following pages: to map the current active page to the selected reference page.
This mapping will be used for the next reference pages.

Note:  If there are no following reference pages, the last one will be set as the Compare To page.

• All pages: to map all pages of the two documents. The previous current pages will be mapped to
the respective reference pages.

Note:  If there are no previous reference pages, the first one will be set as the current page.

Any changes in the active page will lead to a corresponding change in the reference page (as
defined in the dialog). If you have not defined any comparison mode, the page numbers will be
mapped.

4. You can use the Compare mode tools to compare the details of the pages.

Approval in Page Lists
You can set up approval cycle on individual pages of a Page List. However, for multi-page documents,
the approval cycle is only possible for the entire document. You will see the approval tools when the
loaded document is in an approval cycle.
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Tip:  A color coded bar on the page thumbnails display the approval state of the document.

• Grey bar: no approval cycle
• Blue bar: pending approval
• Green bar: approved or force approved
• Red bar: rejected or force rejected

In addition, a blue circle at the bottom of the thumbnails informs you that you need to approve the
document.

Approval Details on page 668 widget will display the approval information regarding the active page.
The widget updates the information when you view a different page of a Page List. When an approval
status is submitted, the approval status will be updated for all visible pages.

Read also Evaluate a Page List in the Viewer on page 728

Evaluate a Page List in the Viewer
1. Navigate to the Page List in a Document list, and click on its thumbnail image. The Viewer opens,

displaying the Page List in the Page List widget.
2. In the Viewer tool bar, click:

•

 to approve the document,
•

 to reject it,
•

 to comment on it,
•

 to force approve it (if you are a Project Manager),
•

 to force reject it (if you are a Project Manager).
3. In the pop-up that opens, choose to approve / reject / comment the :

Options Description

Current Page  

 

Select this option when you intend to approve
only the active page.

Marked Pages  
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Options Description

 

You can mark pages while evaluating to do
approval actions in bulk.

Selected Pages You can approve / reject the selected pages in
one go by specifying them :

• as a page range
• or separated by commas

 

 
.

All Remaining Pages  

 

If you are clicking on the Approval tools from an
Approved /Rejected page, you will get an option
to approve / reject all the remaining pages.

a) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page
817): select Set approval condition
and type your condition in the box.

rejecting or force rejecting the page(s) type a reason for your rejection in the
box.

729



4 WebCenter

if you are... you can...

commenting the page(s) type your comment in the box.

b) Enter your password if your WebCenter server requires it.
c) Click the Commit button.

Marking Pages in a Page List
When you need to approve pages of a page list, you can first open it in the Viewer to inspect. You can
then mark the pages ready to be approved, rejected or commented. This allows you to do bulk approval
actions on marked pages.

Note:  You cannot mark pages in a multi-page document.

•
Select the page you want to mark and click on the  Mark button (from the Page list ) tools to
mark the active page. For more options, right-click :

• Mark
• Mark all pages
• Clear marks on all pages

• You can also right-click on any of the page thumbnails in the Page list widget to get the following
options :

• Mark / Clear Mark
• Mark all pages
• Clear marks on all pages

•
To clear the mark or marks, click on the  Clear Mark button For more options, right-click :

• Clear Mark
• Mark all pages
• Clear marks on all pages

Viewing CAD with Graphics
You can view a graphics document with its CAD overlay for reviewing purposes.

When you open a normalized graphics document (PDF) in the viewer, WebCenter will check the meta-
data (XMP) for a linked ArtiosCAD (ARD) resource.

Note:  This link between graphics and CAD can be made in a desktop application like DeskPack or
PackEdge. Here the relative orientation and offset is determined and saved together with the graphics
file meta data (XMP).

If a Structure /CAD reference is found, you will see this in the document select panel with a link 
icon. You can select this to view together with the graphics document. If the graphics file does not
have a XMP link, you can use the document references feature to link them.
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Linking a CAD with Graphics using Document References
You can assign a Document Reference Attribute in your graphics file to refer to a CAD Overlay. To use
this feature, you need a few Attributes with specific names. These are created automatically during
installation or update of your WebCenter.

• CAD_OFFSET_X (distance)

• CAD_OFFSET_Y (distance)

• CAD_ORIENTATION ( integer).

• CAD_REFERENCE (document reference)

• CAD_PRINTABLE_PART

• CAD_PRINTABLE_PART_SIDE

• CAD_FINISHING_PROFILE

• Add the CAD_REFERENCE attribute to a new category or an existing category. You can name this
category according to your needs.
a) Configure a document source for your CAD overlay files.

Read in: Adding Document Sources for a Document Reference Attribute on page 373.
 

 
• Assign this attribute category to a graphics file.
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Alternatively, configure document types in your Project/Template and assign your attribute
category containing CAD_REFERENCE as the default attribute category for graphics.

• Select or upload a CAD overlay file to the category of your graphics document.

 

 
• Open the Graphics file in the Viewer once the View files are prepared.

The Viewer will load the linked CAD reference in the CAD Overlay section of the Document Select
widget.

 

 

If the CAD reference is stored via a Document Reference Attribute, the user can alter and save the
CAD Overlay settings to the graphical document.

When a graphics document is opened with the CAD_REFERENCE attribute, you can Save  the
alignment changes made in the viewer.

Note:  You need the rights to change a document attribute to get the  option . The
administrator has to enable Document > Security Change properties option for you.

The Save  option is enabled when:
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• you change the alignment. For example, new offset values.
• you select a new CAD overlay.

If you select another CAD file as the overlay, the previous file (with link icon) is deleted from the
document selector. You will see the new overlay in the selector with an active link.

The new orientation and offset will be saved to the CAD_REFERENCE attribute of the graphical file.

 

 

To remove the CAD link from the graphics file, click Turn off CAD Overlay in the CAD Overlay
selector and Save.

Read also:

• Aligning CAD overlay and Graphics on page 733

• Viewing 3D in the HTML5 Collada Viewer on page 735

Aligning CAD overlay and Graphics

• To open multiple documents (both Graphical and CAD), select them and click Actions > View and
Annotate.
You will see a graphics document as the current document.

If the active document has a linked overlay, the Viewer will display this as the linked CAD overlay in
the document selector.
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• Select the corresponding CAD overlay from the CAD Overlay selector drop down. This drop down

will display all the available CAD files including the linked CAD files.
The Viewer will display the selected CAD file on top of the graphics file. The Orientation and
Alignment tools in this view allows you to position the overlay accurately on the graphics file.

•
Anchor Point alignment  for CAD overlay.

Note:  The respective buttons indicate whether the rotation / mirroring / inverting of the
reference document is currently on or off.

• Offset X,Y for CAD overlay
•

Use the Rotate CAD Overlay  tool to rotate the overlay to match the graphics correctly.
•

Mirror CAD Overlay   will flip your overlay with respect to the graphics document. This will show
you the opposite side of the CAD overlay. If the current view is the inside of a box, flipping will
display the outside view.

• Use the anchor point alignment tool to align the CAD overlay on graphics correctly.
a)

Click on the Anchor Point Alignment  tool.
The Viewer will transform to the anchor point alignment mode. You can access the navigation
and orientation tools in the top panel.
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Note:  The active anchor can be recognized by the crosshair icon.

b) Select the anchor points in the Graphics and CAD documents. Use the arrow keys to fine-tune
your anchor points. You can also drag the selected point to a new location.

c) Click Align.
• You can change the values in the Offset X,Y fields to be precise.

Note:

If you are aligning two graphics files, the offset will be the distance between the current and the
reference according to the graphics coordinate system (positive horizontal is set to the right and
positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD overlay and the
graphics page using the CAD coordinate system (positive vertical pointing downwards).

While aligning two CAD files, the offset is the distance between the reference and the current
document page (in that order) according to the CAD coordinate system.

• Save the alignment changes.
• After aligning the tools, you can generate a 3D. You can also use the tools in the CAD  on page 687

widget to further refine the display.

If you did not save the alignment changes before generating 3D, you will see a message:

Do you wish to change your CAD overlay alignment?

Click Save to generate 3D.

Viewing 3D in the HTML5 Collada Viewer
You can view 3D digital mockups in the HTML5 Collada Viewer. This is very useful when your browser
does not support Java Applet. You can set the 3D Viewer as the HTML5 Collada Viewer in the My
preferences.

This will help you to:

• Enhance artwork and shape approval with its 3D representation.
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• Communicate the final packaging in the most realistic form.
• Use WebCenter as an online medium to share 3D mockups.

Note:  The HTML5 based Collada Viewer does not offer the same rendering quality as the Java applet
Viewer for Collada files. The advanced material and lightning visualization is not yet available.

In the HTML5 Collada 3D Viewer, you can view the following:

• Collada. When you open Collada files, it will open the HTML5 3D Viewer if your Preferenceis set as
HTML5 Collada Viewer

• Aligned CAD and Graphics Viewing CAD with Graphics on page 730

• CAD Viewing CAD Design files as 3D

Browser Version Requirements

Browser Minimum version

Chrome (Desktop, Mobile) 30

Firefox (Desktop, Mobile) 4

Microsoft Edge (Desktop, Mobile) latest

Safari (Desktop) 6

Safari (Mobile (iOS)) 8 (iOS 8)

Generating a 3D View from a Graphics file with CAD reference
 

 

• Open a graphics file with a CAD reference. Align the CAD overlay correctly on the graphics file.
Read: Aligning CAD overlay and Graphics on page 733.

When you open a graphics file with a CAD reference in the Viewer, the document select panel will

show a  button.

Note:  The link between graphics and CAD can be made in a desktop application like DeskPack or
PackEdge or using document references. Aligning CAD overlay and Graphics on page 733
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• Click the Open 3D View  button.

The Viewer will open the 3D View widget with a message.

Loading the 3D model...

 

 

The 3D View widget always shows the HTML5-version of the 3D viewer.

After the 3D generation, you can view the 3D mockups in this widget.
 

 
From within this widget, you can:

•
Open the 3D Viewer  in a new window

• close the 3D View widget.
•

After the 3D perspective is generated, the Open 3D View  button is available in:

• the top tool panel
• the  CAD widget
• the Documents list and from all pages where the document operations area available.
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• To generate a 3D Perspective from the Document Details page, go to Document Information > More

Actions. Choose 3D View(Collada).
• To delete a 3D Perspective, go to Document Details > Document Information > More Actions.

Choose Remove 3D View.

Opening Documents in the 3D Viewer
Once you have a generated a 3D perspective by opening it in the HTML5 3D Collada Viewer, you can
open this again from different pages in WebCenter.

You can also generate a 3D Perspective from the Document Details page. To do this, go to Document
Information > More Actions and choose the 3D View(Collada) option.

You will have the Open 3D View  button next to the normal document operations. You will have this
option for:

• Graphics Files with aligned CAD reference
• ArtiosCAD Design and Canvas files
• ArtiosCAD 3D files

To open a 3D view, click  from:

• The Task execution page:

 

 
• The My Work  > My Approvals page:
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• The Document search results:

Note:  For this option to be available, enable Search > Documents > Show Result Layout Options >
Document Operations > View. Read more in: Document Operations in Search.

(if View is an enabled Document Operation in the search Result Layout Options) – grid and list view

 

 

Annotations and the 3D Viewer Positions
The 3D Viewer can remember its view position when you create annotations in the Graphics document.

Note:  The 3D view that will be remembered along with an annotation will be the view that is currently
on. For this feature to work, the 3D view widget has to be open in the Viewer.

• To save a camera position of the 3D viewer into an annotation:
a) Open the 3D View widget by clicking  button on the Top Tool Panel.
b) Add your Annotation in the view port and click Save. The view position in the 3D view is now

linked and saved with the annotation

Note:  You cannot add a 3D View position to replies or linked annotations.
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•

When a 3D view is saved to an annotation, use the  icon in the Annotation List widget to delete or
update the 3D view:
a) Select the saved annotation in the Annotation List.
b) Use the Update with current 3D view from the Actions List from the Annotation List widget

or the Annotation pop-up and save the annotation. You can also do this even when there is no
previous camera position saved in the annotation.

Note:  The 3D widget should be open to update or save a new 3D view.

c) Use Delete Current 3D View from the Actions List to delete the stored 3D position and save.

Viewing Component Document in the Viewer

A component is considered “viewable” once it meets the following conditions:

• Contains one or more document reference attribute

• The attributes contain in total at least a document

Viewable components can be opened in the viewer. The documents attached to the component are
loaded dynamically and are visible in the document selector.

If the documents attached to the component are not viewable, then opening the component in viewer
throws an error.

Component Widget
The component widget displays the configured document references on the component and the
documents that it contains.
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By clicking on a document in the tree structure, it becomes selected and behaves as if it would have
been selected in the document selector.

The component widget stays visible if the currently shown document is part of a component structure.

If the component has the CAD_REFERENCE attribute with at least one document, and the component
is the current selected page; then the 3D document present in the first row of that document reference
is shown in the viewport.

If the first document is not a 3D document, then the loading of the 3D documents fails in the viewport.

Combining 3D + graphics view
When the component is the active document then it shows the combination of all graphical files that
are linked to the same CAD_REFERENCE document as the component CAD_REFERENCE document. To
apply graphics to a 3D structure, see function WCR_HTML5Viewer_1935.

Following requirements must be met:

• Graphic files must be referenced from the component in a document reference attribute

• Graphic files must be linked to a structured 3D document with a specified printable part

• Both component and graphic document must point towards the same CAD_REFERENCE

This is useful to see multiple different graphical files being applied on the same 3D structure.

Viewing Assembly documents in the Viewer
Component documents can be opened in the viewer, if it has a document reference attribute
containing at least a single document. On opening a component document with reference, this widget
is populated and displays the attached documents.

The component widget displays the configured document references and the documents that it
contains. If the component document has a document reference namely, CAD_REFERENCE attribute
containing a 3D viewable file then it displays that 3D model when the component becomes the current
selected document.

The component widget stays visible if the currently shown document is part of a component structure.
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Assembly Documents in Component Widget

The Component Widget displays all the documents contained in the document references on the
component document attribute category.

When opening an Assembly document in the Component Widget, it has three sections namely:

• Structure : First document present in the CAD_REFERENCE attribute is shown and the graphic
document is referenced by the assembly (any document reference).

• Printable Parts: Printable parts associated with the structure document are listed and if any
graphical document is attached to the printable part, that document is shown along with the
printable part.

• Other Graphics Graphics documents in the component which are not associated to a printable part
are shown in other graphics section.
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A graphical document is associated to a printable part if the document.

• Contains the attribute CAD_REFERENCE, in which it references the structure document with the
name of the printable part filled out in reference property CAD_PRINTABLE_PART and the graphic
document is referenced by the assembly (any document reference) or

• Is referenced by the assembly’s GRAPHICS_REFERENCE attribute with the name of the printable
part filled out in Reference Property CAD_PRINTABLE_PART.

Assembly Properties
• Set Angle offset: To define an offset angle for the package to be in. On changing the value, the

angle is updated in the 3D view. Save the value if you wish it to be retained and on reloading the
offset angle is remembered. There are also options to

• Get from view: change the angle offset based on how the model is turned in the 3D view or
• Reset: Allows the offset to be changed to the original value and
• Save: Saves the value in the CAD_OFFSET_ANGLE attribute in the Assembly Document attribute

• Simulate View Preset

You change the values of the Angle and Elevation while creating packshots. When you change the
values of angle and elevation, the 3D viewer changes the camera to this position. You also have
additional options to

Note:  Values changed are not saved

• Get From View: Update the fields with the angle that the viewer is currently in
• Reset : Changes to the angle in which it initially opened

Editing Printable Part of the Structured Document

Printable Parts can be split in Front and Back side and can have different artworks on each side of the
Structure documents. If only one of the two sides is defined, the other side displays the back of the
selected side.

Click on the pencil icon on the printable part shown in the component widget and a pop up is visible.

You can attach or replace the graphics document for that printable part, as well as the Finishing
Profile.

Note:  Documents are attached for the printable part from the defined sources in the
GRAPHICS_REFERENCE attribute of the attribute category of the assembly. Only Saved Search and
Current project document sources and only Use by Reference operation are supported.

You can save the changes for it to take effect in the assembly document.

Also note that to edit a printable part, the assembly should have the GRAPHICS_REFERENCE attribute
with the following reference properties defined in the rendering configuration:

• CAD_PRINTABLE_PART,
• CAD_PRINTABLE_PART_SIDE,
• CAD_PRINTABLE_PART_NAME,
• CAD_FINISHING_PROFILE.

Also if the attribute Category view contains a "Viewer" view, this view should also contains this
attribute and reference properties.
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View Graphics with 3D
You can view graphics with 3D files in the viewer. For this link the 3D file to a Graphics Document.

To link the 3D document to a graphics document, use the steps as given in Linking a CAD with Graphics
using document references.

• Ensure the graphics file has the CAD_REFERENCE (Document Reference) Attribute.

• The document is opened in the viewer as a 2D document.
• When there are 3D files loaded in the Viewer, you can link a 3D file to the Graphic Document using

the Structure Document selector. Read more here Structure Document Selector on page 664

Viewing Attributes

If the document in the Viewer has an Attribute Category with a Viewer specific View, you will see the
Attributes widget in the Viewer.

The administrators can create such Viewer specific views. Read in: Add Viewer Views on page 314

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageId=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change a reference from the Viewer and save this configuration.

Note:  Only the users with Project / Folder level Change Properties permissions can change and save
attributes from the attributes widget.

If your document has document references attributes, you can view them from the Attributes widget.
You can also do the document operations specified while configuring the document sources for the
reference.

Note:  The administrators can create a Viewer view for the document reference attributes with
specific source and rendering configurations.

You can change a reference from the Viewer and save this configuration. This is only possible when you
haveChange Properties permissions.
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Video Support for files stored in MediaBeacon

Viewer supports video files from the Asset Management Connection, MediaBeacon. Video files can
be opened like any other document or image file in the project. You can select the video from the
document list in the Project Details tab and select View and Annotate. Videos files can be approved in
the workflow directly.

Note:  To set up MediaBeacon as the Asset Management connection, refer to Configure Asset
Management Connections on page 425

Note:  To import any file from the Asset Management, refer to Document Creation Settings on page 165

Viewing Videos

Opening Video in Viewer
You can open video files by either clicking on the document thumbnail in the document list or by
choosing View and Annotate for the selected video.

Video Toolbar
Toolbar for video viewer has specific video controls. Detailed description of the other tools can be read
at Top Tool Panel on page 646

Note:  Viewer displays the tools which are relevant for videos.

Controls to View Video and Advanced Video Settings

Select Button Performs

 or 

Play or Pause Depending on the video state the button
toggles to Play/Pause

 or 

Mute / Unmute Mute or Unmute the volume in the video. Use
the slider to increase or decrease the volume.

 

 

Timeline Slider Helps to slide through the video and displays
the total length of the video at the end. You can
slide forward to watch the video ahead.

745



4 WebCenter

Select Button Performs

Settings Videos can be set to play in Auto Play which
plays on opening of the viewer , or you can start
the video manually on opening. Loop  allows to
play the video in loop until manual intervention.
Speed can be chosen as .25x , .5x, Normal, 2x or
8x. Quality of the video display can be chosen if
the video has multiple display resolutions.

View Full View /
Exit Full View

Toggles to either view full screen or exits from
full screen

Note:  Alternatively use Esc key to exit full
screen

Options in Viewer for Video files
Following are the widget options available for video files

• Approval Details widget functions the same way to document approval. Refer to Evaluate a
Document in the Viewer on page 706

• Info  has the details of the document viewed. Refer to Info on page 673

• Help to learn more about the viewer.

• Key Frames refer to Keyframes on page 746

• Annotation List refer to Annotation List on page 666

Keyframes

Keyframes widget displays the preview of different frames at regular intervals from the video in
sequential order. This helps to easily navigate and locate any frame in the video. You can choose any
frame displayed to jump to that point in the video.
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Note:  If you are viewing an annotation and select a key frame that is outside the range of the
annotation, the annotation is deselected. If the key frame is inside the range of the annotation, the
annotation remains selected .

Annotations for Video

Add Annotations in a Video
A note or comment can be added to the video file as an Annotation. To add an annotation in a video file,
use the Add Annotation from the toolbar. For detailed information on Annotations, refer to Annotating
in the Viewer on page 690.

In video files, adding an annotation pauses the video. The Start Time and End Time of the annotation
is taken as the current time in the video. This can be edited manually by modifying the time and saving
the annotation.

Note:  Annotation List in videos also displays the start and end time of the Annotations.

Viewing Annotation
Annotations are displayed only when the current time in the video is within the specified start and end
time of the annotation. You can view all the annotation in the video file by selecting Annotation List.
Refer to Annotation List on page 666 for details.

Timeline Slider
The Timeline slider displays three indicators, representing the Start Time, Time within the Video and
the End Time.

You can also edit the Start Time  and End time by selecting the Annotation in the Annotation List by
dragging the Start and End time indicators in the Timeline Slider.

Colored markers in the timeline slider show all the available annotations in the video. These markers
are visible, only when no annotation is selected.

If the start and end time of the selected video are different, then the video is played in loop. To
continue playing the video, close the annotation pop up.

Note:  If the start and end time is same for an annotation, then the video is paused.

Unified Viewer

View 2D and 3D versions together
Viewer allows to view both the 2D and 3D perspectives in the center pane. You can use toggle buttons
to switch between 2D and 3D view. When you choose to view the 3D perspective in the center pane, 2D
perspective is displayed on the side panel and vice versa.

When 3D perspectives are opened in the viewer, all the other toolbar elements and other widgets are
collapsed in the viewer except for Document Selector and Approval Details.
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Using toggle buttons, you can simultaneously view both 2D and 3D in the center pane.

 

 

Limitations in the HTML5 Viewer

Following features are not available in the HTML5 Viewer yet:

• Advanced View features such as Seamless View or Advanced Flexo tools for screened data.
• Collaboration mode

See https://wiki.esko.com/display/KBA/KB90866114%3A+WebCenter+-+HTML5+Viewer+known
+limitations for a feature matrix.
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 About the HTML5 Viewer About the Viewer
The HTML5 Viewer is a fast and comprehensive viewing tool introduced in WebCenter 14.

From 14.1.1 onwards, the HTML5 Viewer is the default WebCenter Viewer. However, you may choose to
work with the Java Viewer (default) by changing it in the Viewer Preferences.

What does the Share & Approve ViewerHTML5 Viewer offer you?
• Speed: fast viewing for Graphics and CAD files. High speed 3D viewing (14.1 and later).
• Compatibility: high speed performance on the new client browsers.

Browser Supported Version -
Windows OS

Supported Version-Mac OS

Microsoft Edge Latest -

Firefox 4.0 or higher 4.0 or higher

Chrome 5.0 or higher 5.0 or higher

Safari - 5.0 or higher

• Reliability: high accuracy in displaying your data.

• Detail: advanced zoom to see finest details, measuring exact distances. Fast zooming.
• Customizable widgets. You can even restrict access to certain features depending on the user

preferences.
• Keyboard shortcuts. To see all of them, press ?

• Easy access to help and knowledge base. Search in the Help widget or press F1 to access help.

Note:  The default Viewer in the WebCenter Viewer  on page 92s upto 14.1 will be the Java Viewer. You
can set the preferred Viewer as the HTML5 Viewer in the General or User Specific Preferences. Read
more in About Viewer Preferences.

Note:  The HTML5 ViewerShare & Approve Viewer does not offer live collaboration or working together
at the same time. You can use annotation threads for discussions.

Using 3D file as 3D perspective
You can use any 3D file as a 3D perspective of a graphics file in the WebCenter viewer. You can also
view both the graphics document and the 3D file next to each other.

To view the files in the viewer, ensure there is a document reference attribute called CAD_REFERENCE
in the graphics document. Follow the steps below to open a structure document.

You can use the structure document in the Structure document selector.

After selecting a 3D Document as 3D perspective, save the link using the save button next to the
Structure Document Selector.

Note:  This is only possible if the Document has the Document Reference Attribute CAD_REFERENCE,
in which the link is stored.

If a printable part is selected and the alignment options are saved, then the 3D widget displays the 3D
shape along with the graphic file applied to the specified printable part.
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Note:  The printable part is saved in the document reference properties CAD_PRINTABLE_PART and
CAD_PRINTABLE_PART_SIDE of the CAD_REFERENCE attribute that points to the 3D file.

Viewer
• Select your Viewer Type. You can set your preference to the HTML5 Viewer or keep at the default (

Java Viewer ).

Note:  You can always switch to Java Viewer from HTML5 Viewer using the  button.

• Viewer and Workflow Applet: When opening a document in the Viewer or when creating a workflow,
WebCenter will download a Java applet to your computer.

From Java 1.7.0_21 (for Windows and Mac OS X 10.7 or later), you will get a security warning as the
one below when the applet is downloaded. This makes the WebCenter applet look like a security risk
for your computer.

 

 

You can adapt how this security warning will look like when downloading the applet. In Viewer and
Workflow Applet, choose either:

• Signed (sandboxed) if you want to run the applet in a strict sandboxed environment (with no
access to your computer's resources). As the applet is signed by Esko, the security warning
looks less threatening.
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Note:

As the applet is sandboxed, it will also show a warning when trying to print from the Viewer. You
will just need to click OK to be able to print.
 

 

• Signed (not sandboxed) if you want to run the applet without restricting it to a sandbox (the
applet can request additional access to your computer's resources). This means that you will not
get an additional warning when printing from the Viewer.

As the applet is signed by Esko, the security warning looks less threatening.
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• Unsigned if you want to run the applet as a default unsigned applet. You will get the default
security warning that does not mention Esko, but the applet will be sandboxed. This means that
you will have an additional security warning when printing from the Viewer, as for the Signed
(sandboxed) applet.

Tip:

By default, the applet is set to run as Signed (sandboxed). This will work fine for most users.

More frequent users may want to switch to the Signed (not sandboxed) option to avoid always
having to click an extra warning away when printing from the Viewer.

Mac OSX 10.6 users running Java 1.6.0 may also want to switch to the Signed (not sandboxed)
option to avoid getting a warning when closing the Viewer by clicking .

With the latest versions of Java 1.7 installed, most browsers block unsigned applets by default. In
this situation, it is recommended to use one of the signed settings instead.

• Viewer Style (Java Viewer) sets the Viewer mode as:

• Normal (Default): All HTML5 Viewer features are available in this mode.

• Restricted: In this mode, the user cannot access features such as Channels widget, CAD widget
and View widget.

The side panels displaying the widgets will be in a collapsed format by default.

• Advanced: In Java Viewer all features are activated.

• Viewer Workspace: Select any workspace from the drop down or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

• Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter viewer, when they are shared with a document to view or to approve.
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Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.

• Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

• Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.

• Select Enabled if you want the users to be allowed to annotate approved documents.

• Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

• Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

• Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

• Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.

• Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note:  A document version is considered under approval as soon as an approval cycle is started

Choose from the following settings:

• All Users: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

• All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

• All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

• Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

• Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.

• Specify the Viewer Quality as:

• Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

• Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Note:  This setting is applicable to both the HTML5 and Java Viewers.

• Settings for Automated Artwork
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Note:  The below options are visible only when Automated Artwork license is enabled.

• Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

• Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note:  This option requires Packaging Content Management License.

• PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note:  This option requires the Packaging Content Management License.

• Log out user when inactive  Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

• Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.

• Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note:  Project Managers who can Force Approve or Force Reject is not considered an approver. They
can add annotations only if the setting is All Users.

Editing Artwork in Viewer
Text within an Artwork may have to be edited or modified sometimes or a single word may have to be
replaced in multiple artworks to suit the current marketing campaign. In such instances, depending on
an Artwork designer to perform the change may delay the flow of work and add to the cost.

You can use the WebCenter Viewer to modify the artwork on the go and instantly save the changes to
the artwork. This saves time, effort and dependency on the artwork designer and thus reducing the
time taken from the ideation to the product on shelf.

Note:  Automated Artwork license is required for this functionality to be enabled in the Viewer.

To enable the edit mode for the document, Switch to Edit Mode in the Viewer.

Two new widgets are available in the Edit mode namely,

• Action List Widget

• Files Marked for Edit

Action Widget
You can view the AI (Adobe Illustrator document) or PDF document in the edit mode in Web Center
Viewer.

Action widget allows you to create an action list, which performs text replacement actions in the
document. The actionlist can be saved to execute on other documents or to do a bulk operation.
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Action lists can be created and saved within the same project as the document or in different projects.
Search and Replace Action is available. You can add a New Action or Execute Action or Clear Actions
List or Undo or Redo the previous operation.For each of the Action, edit or delete or reorder of the
action is possible.

Steps to create a New Action

You can search for (live) text phrases and replace them with another text phrase. Follow the steps given
below to create a new Action list:

1. Search Area: You can choose an area of the artwork where the text has to be searched for. You have
three options in the drop down namely

• All: All the textboxes in the artwork are included.

• Trimbox: Only textboxes within the trimbox of the artwork are included.

• Custom: Textboxes within the specified region which is indicated by x, y and width and height
are included.

Note:  Click the button to select an area on the artwork

2. Search For :Type the text which has to be searched for, in the artwork as specified in Search Area.
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3. Replace With: Type in the text to replace the matches with.
4. Overflow options: Sometimes the replaced text may be longer or shorter than the current text.

When the replaced text is longer then choose the overflow options to specify how the extra text
is shown in the artwork. For example, when the text "fresh apple" is replaced with "Juice and
sumptuous apple".

Overflow can be dealt with

• Vertical Overflow: When the text is longer than the original text, the textbox can overflow to the
bottom, top or in both directions.

• Horizontal Overflow: When the text is longer than the original text the textbox can overflow to
the left or right or in both directions.

• Max Width: The maximum width of the textbox. Should be set in order to use the horizontal
overflow.

5. Overflow Scope

• Selected Paragraph: Applies Overflow options to the whole textbox

• Selected Line(s): Applies to the selected lines only and the rest of the textbox remains
unchanged.

• Selected Text Fragment: Applies to the selected fragments of text and the rest of the textbox
remains unchanged

6. Verify number of Replacements: Select this check box to verify the expected number of
replacements. When there are less or more replacements than expected, the action will fail.

7. Save : You can save the Action created with the above steps as a Document in the current Project
or you can specify the name of the document and by default it is saved in the root folder of the
Project. The action list is saved as a document with a .pal extension.

8. You can choose to execute the action directly from this widget by selecting Execute Action and
Save the document.

When you want to run the Action List for multiple documents use the Files marked for Edit  Widget.
Switch back to view mode to navigate back to the original view.

Replace using text statements in Artwork

When a Text Content Search is configured in the General Preferences by the Admin user, the user can
only replace text with Text Statements. Click the button to select a Text Statement from the Saved
Search and select the correct translation of the text.

A saved search of text statements can be configured for the replacing the text in the Edit Mode in the
Action List widget. Read how here.
 

 

When a saved search is chosen, then the text cannot be replaced manually. When pcm setting is
configured it is only possible to select text from a saved search
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You can select multiple statements in any of the languages available for the statement, of which you
can then select a single text statement as a replacement for the text on the artwork. Click on the
document to switch.

After the search and replace of the text statement is performed and the modified artwork is saved, the
selected Text Statement document can be linked using the Document Reference Attribute configured
in the General Preferences.

Edit text in Bulk

The Files Marked for Edit Widget makes it possible to make small text changes on multiple Documents.

You can choose an Action (.pal file) which is created and saved in the Actions Widget.

758



4WebCenter

Select the Graphic files from your Project where you want to execute the Action list. Click submit
to execute the Action list (.pal file) on the selected files. A task is created in the project, where the
artwork and the action list are attached.

4.5.  Approving and Rejecting Documents

You can see documents waiting for your approval on the My Work page, under My Approvals.

Note:  If you cannot see My Approvals, go to My Work > Edit My Work Setup to add it to your My Work
page.

You can approve, reject or comment a document:

• from the My Work page,

• from the Viewer,

• from the document details page (Approval tab).

Note:  Project Managers have more options when approving or rejecting documents. They can Force
Approve or Force Reject a document. See Forcibly Accept or Reject Documents.

Approvals, rejections and comments are shown on the Action History page.

Note:  If you need to setup an approval cycle to have other users approve or reject a document, see
Defining Approval Settings on page 809.

4.5.1.  Evaluate a Document in the Viewer

When you evaluate a graphic file or a page list (see Document Types on page 589 for information about
the supported file types), you can first open it in the Viewer to look at it in detail. You can then approve,
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reject, or share a document for approving or viewing or add a stage or comment it directly from the
Viewer.

1. Click the document's thumbnail or the  button.
You can do this from:

• the My Work page (under My Approval if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master),

• the Documents tab in the project,
• the header of the Document Details page.
• the viewer

2. In the top toolbar, click:

•  to approve the document,
•  to reject it,
•  to comment it,
•

to forward approval request
•

 to force approve it  if you are a Project Manager
•

 to force reject it  (if you are a Project Manager).

Alternatively these options are also available in the Approval Details widget. This is available
only if the user has Change Approval permissions.

Note:  You can view the status of the approval of the document in top tool bar.

3. In the pop-up that opens, do the following:

if you are... you can...

approving or force approving the document set a condition for your approval if the approval
cycle allows this (see Allow Conditional
Approval or Not on page 817): select Set
Approval Condition and type your condition in
the box.

rejecting or force rejecting the document type a reason for your rejection in the box.

commenting the document type your comment in the box.

4. If the user has Change Approval permissions, then the user can access the Approval Setup in the

Approval details widget. Click to open the Document Approval Setup pop-up window. User can
perform all actions as specified in
Defining Approval Settings on page 809

5. It is possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
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You can read about it in detail.

6. Enter your password, if your WebCenter server requires it.
In case, the approval cycle is completed and the document is in Approved state, then the user
cannot make any changes to the approval cycle from the viewer.

7. Click the Commit button.

A warning message is shown, if unsaved annotations are present, when you try to Approve / Reject
/Comment on a document.

Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

• the Approval tab of the Document Details page,

• the Action History tab of the Document Details page,

• • the Java Viewer's Document History panel.

• the Approval Details panel.
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To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.

Note:  If you cannot see My Recently Submitted Approvals, go to My Work and add it to your My Work
page.

4.5.2.  Evaluate a Document in the Document Details Page

When you need to evaluate an oce file (like Microsoft Word, Excel, PowerPoint etc.), you can first
download it and open it in the corresponding application, then evaluate it from the My Work or the
Document Details page.

To approve, reject or comment a document from the Document Details page:

1. Go to the Approval tab.
2. Click:

•

 to approve the document,
•

 to reject it,
•

 to comment it,
•

 to force approve it (if you are a Project Manager),
•

 to force reject it (if you are a Project Manager).
3. In the pop-up that opens, do the following:

if you are... you can...

approving or force approving the document set a condition for your approval if the approval
cycle allows this (see Allow Conditional
Approval or Not on page 817): select Set
Approval Condition and type your condition in
the box.

rejecting or force rejecting the document type a reason for your rejection in the box.

commenting the document type your comment in the box.

4. It is possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
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You can read about it in detail.

5. Depending on your choice, click Commit Approval, Commit Rejection or Commit Comment.

Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

• the Approval tab of the Document Details page,

• the Action History tab of the Document Details page,

• • the Java Viewer's Document History panel.

• the Approval Details panel.

To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.
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Note:  If you cannot see My Recently Submitted Approvals, go to My Work and add it to your My Work
page.

4.5.3.  Evaluate Multiple Documents at Once

If you have several documents to approve or reject, and you have made the same decision about all of
them (you want to either accept them all or reject them all), you can do this in one operation.

1. Go to your My Work page.
2. In the My Approvals section, select the documents to approve or reject.

Tip:  To select all the documents at once, select the check box at the top of the documents list.

3. At the top of the document list, click:

•
 to approve the documents (you cannot use conditional approval on several documents at

once),
•

 to reject them,
•  to comment them.

Note:

• Use the buttons at the top of the list and not the ones beside a document, or you will only
approve / reject / comment that document.

• If you are not Project Manager for some of the documents you selected, Forced Approve and
Forced Reject are not available.

4. If you are commenting the document, type your comment in the pop-up's box.

If you are rejecting the document, you can enter a rejection reason in the pop-up's box.
5. It is possible to also Edit the approvers when the approval stage is in progress. When you click on

the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
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You can read about it in detail.

6. Depending on your choice, click Commit Approval, Commit Rejection or Commit Comment.

The status of the approval action is displayed, listing any documents that could not be updated.

Note:  You can also do this from within a project (in the Documents tab, select the project's
documents to approve or reject, then click Approve / Reject in the Actions menu).

4.5.4.  Sharing Documents from Viewer

WebCenter Viewer now allows documents to be shared to users who are both Registered and

Unregistered users using Share Viewer Link option.

Registered users are those who are already present in the WebCenter and unregistered users are not
part of WebCenter and can be provided temporary access to view the shared document.

When you click on Share Viewer Link option, a pop up window is opened. You can choose the users
whom you may want to share the document from the drop down.
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If you wish to share the document to other users, you can type in their email id in the users field and the
option to Add Unregistered User is enabled.

Note:  When a document is shared to an unregistered user, the email id is remembered and is available
in the drop down.

 

 

You can share the link to both registered and unregistered users at the same time. When you share,
an email is sent to the users with a link to the document and information about the Document name,
Version number and comment.

The validity of the link shared for unregistered users is based on the token authentication.

4.6.  Working with Page Lists

4.6.1.  About Page Lists

What is a Page List document?
Page Lists are a special type of multi-page PDF documents in WebCenter that represent imposed
books or magazines. As such they are an important tool for commercial printers.

Page Lists PDFs are generated in Automation Engine from FastImpose imposition files (*.imp), and
uploaded to WebCenter from the Automation Engine production server.

If you are not using a Automation Engine production server, you can also upload Page Lists using the
Upload feature in WebCenter. You cannot upload imposition files (*.imp).

Page List documents have two major advantages over other multi-page PDF files:

• You can upload either the complete document, or specific pages only (for example, pages 6-12);

• individual pages can be approved or rejected in WebCenter (for example, you can approve pages 3,
5 and 7-16 of a 16-page Page List).
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Note:  A multi-page PDF file can only be approved or rejected as a whole.

Working with Page Lists
Page List documents are displayed as a single document in document lists. Click the Page List name
to view its pages and details in the dedicated Page List views.

Tip:

Only FastImpose impositions are recognized as Page Lists in WebCenter. Multi-page files uploaded
from within WebCenter (except multi-page PDFs uploaded specifically as a page list), or from Odystar,
Nexus, or even other Automation Engine documents will never be treated as Page Lists. Instead, they
are considered regular multi-page PDF documents.

4.6.2.  Page List Views

When you want to examine, approve or reject a Page List, you have the choice of a number of views in
which to do so:

Page List

Displays the pages in the imposition in a table.

For every page, the Folio, Sheet Name, Sheet Side (for page lists uploaded from Automation Engine),
Thumbnail, Page Version, List Version, and Uploaded Date are displayed.

Finally, the approval status per page is listed, and pages that have annotations are marked with a post-
it icon.

 

 

Page Gallery

Displays the pages in the imposition in a gallery view. This gives you a quick overview of the approval
status of the different pages:
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•
Pages topped with a blue bar and  icon have not been approved or rejected yet;

•
Pages topped with a green bar and  icon have been approved;

•
Pages topped with a green bar and  icon have been approved with a condition;

•
Pages topped with a red bar and  icon have been rejected;

•
Pages topped with a green bar and  icon have been force approved;

•
Pages topped with a red bar and  icon have been force rejected.

Page List Information
Displays basic information about the Page List (number of pages, binding...). This information is
editable for documents that were uploaded using the WebCenter Upload feature.

4.6.3.  Page Lists in the Java Viewer

Page List-specific features
The Viewer has a number of features that make working with Page List documents even more intuitive:

• Reader spread mode

• Page List panel

• Show margins (Trim boxes) option
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Reader Spread view
Click the Toggle Reader Spread View button in the top toolbar to activate the Reader Spread view
mode.

Page List panel
Click the Display Page List Panel button in the top toolbar to display the Page List panel. This panel
shows thumbnails of all the pages in the Page List document. Click on a page in the panel to display it in
the viewer.

Tip:  You can dock and undock this panel to optimize your workspace in the Viewer.

Show Margins option
Click the Show Margins (Trim Boxes) button on the View toolbar on the right hand side of the Viewer to
display the trim boxes for the displayed page(s). Trim boxes are displayed in blue.

For more information, see the Viewer's online help.

4.6.4.  Notes on Page Lists and Approval Cycles

Page Properties

Index

Represents the sequential position of the page in the Page List.

Folio
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Represents the “name” of the page as it is used in FastImpose.

Page Version

Represents the version of the individual page in the Page List.

List Version
Represents the version of the complete Page List. The List Version is updated every time you upload a
new version of the imposition from Automation Engine.

Index versus Folio
For example, the page with Index 7 may have vii as its Folio, or the page with Index 1 may actually be
page 3 when the cover is not part of the imposition.

List Version versus Page Version
When new versions of a selection of pages are uploaded, the List Version number and the Page Version
number of the uploaded pages are incremented.

As a result, in very asynchronous workflows (e.g. magazine printing), you can easily have 15 Page List
Versions.

Every update to the Page List increments this version number. However, most of these updates will
only affect certain pages: their Page Version will be incremented.

By the time you reach Page List Version 15, many pages will be at version 3 or higher, but some will still
be at Page version 3.

Empty and blank pages
Empty pages are ignored for approval.

For example, if you upload a 32-page PDF file as a Page List, but change the Number of pages to 64
afterwards, creating 32 empty pages at the end of the Page List. These 32 empty pages are ignored -
you cannot approve or reject them.

Blank pages require approval. WebCenter detects when PDF pages have been added to the imposition
that have no visible content. The blank pages need to be approved just like any other pages.

When is a Cycle Finished?
The approval cycle's status is changed to Finished when any one of the following conditions are met:

• all Approvers have either approved or rejected it,

• the Project Manager or an Admin has Forced Approved or Forced Rejected it.

Note that in this case, the final status is Forced Approved or Forced Rejected instead of
Finished.

A finished approval cycle may not be stopped or started without uploading a new version of the
document.

These status rules apply to each individual page in the Page List.
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Only when all the pages in the Page List document have reached their Finished (or Forced) approval
status, will the Page List get the Finished status.

4.6.5.  Approve or Reject a Page List

To approve the pages in a Page List, you can choose from a number of different methods.

Use the Viewer
1. Navigate to the Page List in a Document list, and click on its thumbnail image. The Viewer opens,

displaying the Page List.
2. In the Viewer tool bar, click:

•

 to approve the document,
•

 to reject it,
•

 to comment on it,
•

 to force approve it (if you are a Project Manager),
•

 to force reject it (if you are a Project Manager).
3. In the pop-up that opens:

 

 
a) Choose to approve / reject / comment either the Current Page, the Selected Pages or All

Pages.
b) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page
817): select Set approval condition
and type your condition in the box.

rejecting or force rejecting the page(s) type a reason for your rejection in the
box.
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if you are... you can...

commenting the page(s) type your comment in the box.

c) Enter your password if your WebCenter server requires it.
d) Click the Commit button.

For more information, see Page Lists in the Java Viewer on page 768.

Use the Page Gallery View
1. Navigate to the Page List in a Document list and click on its name.

The Document Details page appears.
2. Select Page Gallery from the menu.
3. Select the pages you want to approve or reject and then click Approve Selected Pages or Reject

Selected Pages.

You can also choose to Approve All Pages or Reject All Pages.
4. In the pop-up that opens:

 

 
a) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page
817): select Set Approval Condition
and type your condition in the box.

rejecting or force rejecting the page(s) type a reason for your rejection in the
box.

commenting the page(s) type your comment in the box.

b) Enter your password if your WebCenter server requires it.
c) Click the Commit button.
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Use the Page List View
1. Navigate to the Page List in a Document list and click on its name.

The Document Details page appears.
2. Select Page List from the menu.
3. Select the pages you want to approve or reject and then click Approve Selected Pages or Reject

Selected Pages.

You can also choose to Approve All Pages or Reject All Pages.
4. In the pop-up that opens:

a) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page
817): select Set Approval Condition
and type your condition in the box.

rejecting or force rejecting the page(s) type a reason for your rejection in the
box.

commenting the page(s) type your comment in the box.

b) Enter your password if your WebCenter server requires it.
c) Click the Commit button.

4.6.6.  Uploading and Updating Page Lists

Requirements for Page Lists
Page Lists are supported in WebCenter from version 7.1 onwards.

To publish an imposition from Automation Engine to WebCenter, use the Publish Imposition on
WebCenter ticket.

WebCenter and Automation Engine must be in the same LAN, or use a Tunnel and Approval client.

Upload an Imposition as a Page List from Automation Engine
Only FastImpose impositions are recognized as Page Lists in WebCenter. Multi-page files uploaded
from within WebCenter (except multi-page PDFs uploaded specifically as a page list), or from Odystar,
Nexus, or even other Automation Engine documents will never be treated as Page Lists. Instead, they
are considered regular multi-page PDF documents.

Proceed as follows to upload an imposition file as a Page List from Automation Engine to WebCenter:

1. Start the Automation Engine Pilot and log on to the production server.
2. Browse to the FastImpose imposition file (*.imp) you want to upload, or create a new imposition in

the Pilot.
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3. Right-click the imposition and select New Task > Publish Imposition on WebCenter.

If the Publish Imposition on WebCenter task does not appear in the context menu, choose More
Tickets and select the task in the Select Ticket dialog.

4. Modify the settings for the Publish Imposition on WebCenter ticket (the first ticket in the chain) if
needed.

5. Modify the settings for the Send Book to WebCenter ticket (the second ticket in the chain):
a) On the Destination tab, select the WebCenter Site from the list.
b) Enter the Project, Folder, Document and Project Template names. You can use SmartMarks to

populate these fields.
c) Enter your User Name and Password for the selected WebCenter site.
d) Click the Approval tab and enable Approval if required.

6. Click the Launch button to upload the imposition to WebCenter.

Note:  This automatically adds the imposition to the Pilot's Pages view at the same time.

Upload an Imposition using the WebCenter Upload Feature
1. Either go to the project/folder you want to upload the document into and click the

 button, or just click the Upload menu from anywhere.
2. On the Upload page, select the Project and Folder you will upload the document into (if you

are already in the project/folder, those are filled in automatically, but you can still Change the
Destination).

3. Select Browse in the Source list and click the Browse... button to open a browser dialog and select
your file.

4. Select Page List in the Document Type list.
5. Type the index number of the first page in the file in the Index of First Page field.

For a new document, this will typically be 1, but it might not be, if you plan on adding additional
pages later, or if you are updating a selection of the pages in an existing Page List.

6. The document Name is automatically detected. You can still change it if needed.
7. Optionally, specify a Description for the document.
8. Click Upload.

The Page List is uploaded to WebCenter. You can still edit some properties of the Page List in the Page
Information view (such as the number of pages, the binding edge, etc.).

Update Pages in a Page List
You can update a specific page of range of pages in a Page List, either from Automation Engine or
through the Upload feature in WebCenter.

To Update One or More Pages from the Pilot

1. In the Automation Engine Pilot's Imposition Gallery, select the pages in the imposition that you
want to update.

2. Right-click one of the selected pages and re-launch the exact same Publish imposition on
WebCenter Chain ticket you used to upload the original Page List.
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To Update Individual Pages from WebCenter

1. Navigate to the folder in which the original Page List resides.
2. Click the name of the Page List to open the Document Details page for the Page List.
3. Click Page List to open the Page List view.
4. Click the Upload New Version link in the row corresponding to the page you want to update.
5. Browse for the PDF document containing the new version of the page you want to update and click

Finish to upload the new page.

The Index for First Page field is already filled in, because you are only updating a single page (at the
listed index).

To Update Multiple Pages from WebCenter

1. Navigate to the folder in which the original Page List resides.
2. Click the name of the Page List to open the Document Details page for the Page List.
3. Click Page List to open the Page List view.
4. Click the More Actions... button and select Upload New Version.
5. Browse for the PDF document containing the new versions of the pages you want to update.
6. Provide the Index of First Page information: pages from the new PDF you are uploading will update

the existing pages in the Page List starting at the Index you specify.

For example, if you upload a four-page PDF document to a 16-page Page List, and enter 5 as Index
of First Page, WebCenter will update pages 5, 6, 7 and 8 in the Page List with the newly uploaded
versions.

7. Click Finish.

4.7.  Working with 3D Files

With WebCenter, you can upload, view and approve 3D files. This is an option available with the
Advanced Approval module.

This is based on Esko’s Visualizer technology, and enables you to:

• Communicate the final packaging in all its realism to clients.
• Use WebCenter as an online medium to share 3D mockups.

• Enhance artwork and shape approval with its 3D representation.

4.7.1.  About 3D Files

WebCenter works with Collada (.dae) and Zipped Collada (.zae) 3D files.

Collada is an interchange file format for interactive 3D applications. It is an open standard based on
XML, managed by the Khronos Group (a not-for-profit technology consortium). For more information,
go to http://www.khronos.org/collada/.
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A Zipped Collada file is a zip file containing:

• a Collada file,
• a manifest.xml file with a specified format,
• optionally, other assets such as backgrounds.

Note:  WebCenter supports having a preview embedded in the archive file and extracting this
automatically as a default thumbnail.

4.7.2.  Creating and Exporting 3D Files

You can create Collada files from Studio Visualizer and / or ArtiosCAD.

In Visualizer
Studio Visualizer can build 3D models based on the following structural design file formats:

• ArtiosCAD *.ard files;
• Studio Toolkit for Flexibles *.bag files for flexible packaging such as bags and wrappers;
• Score! *.vlm files.
• Collada *.zae archives with arbitrary 3D shapes, with printable areas defined (if supplied by Esko

products). Collada archives created by non-Esko products can be used in Studio Visualizer but will
not have a printable area.

1. Open the artwork in Illustrator, ArtPro or PackEdge.
2. Place and align the structural design file.
3. Then choose Open in Visualizer from the File menu.
4. Set the Substrate material.
5. Edit your design as necessary:

• add process and / or spot colors,
• add special finishes,
• add an environment (background).

6. Export your 3D design to a Zipped Collada (.zae) file using the Export 3D file for Viewing option.

You can choose to Create a preview image file alongside the Collada file. This will be a .jpeg
thumbnail image.

Note:  If your model includes graphics, saving to .zae and not .dae ensures you have everything in
one file (WebCenter doesn't support using multiple files for one 3D design).

See the Visualizer manual or online help for more information.

In ArtiosCAD
Since ArtiosCAD 7.6, any 3D file can be output to Collada. The output includes the graphics, floor
shading etc.

Note:  This might require additional licensing.

1. Create your model using the ArtiosCAD 3D functionality.
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2. When it is ready, go to File > Outputs-3D > Collada to export it.

• Set the Graphics resolution.
• To export a thumbnail with the Collada file, choose either PNG or JPEG in the Include bitmaps as

option (you can select the Quality for JPEG).
• Save the file as a .ZAE file.

Note:  If your model includes graphics, saving to .zae and not a .dae ensures you have
everything in one file (WebCenter doesn't support using multiple files for one 3D design).

See the ArtiosCAD manual for more information.

4.7.3.  Uploading 3D Files to WebCenter

Collada (.dae) and Zipped Collada (.zae) files can be uploaded to WebCenter using the normal upload
functionality available within WebCenter, via Automation Engine or through the WebCenter SDK.

WebCenter automatically recognizes Collada files as the Collada document type.

Working with 2D and 3D Files
We advise using the same name for related 2D and 3D documents, and putting them in the same folder.

Creating a Thumbnail

By default, WebCenter shows the default Collada thumbnail for Collada files: .

To add your own thumbnail:

• use the Create a preview image file alongside when exporting the Collada file from Vizualiser (see
Creating a 3D File in Visualizer).

• choose either PNG or JPEG in the Include bitmaps as option when exporting the Collada file from
ArtiosCAD (see Creating a 3D File in ArtiosCAD).

• upload your own thumbnail in WebCenter:
a) in the Document Details, go to the Document Information tab,
b) click Thumbnail and upload your thumbnail image.

Note:  The best sizes for thumbnails in WebCenter are 100x100 and 200x200 pixels.

4.7.4.  Viewing 3D Files

Hyper realistic 3D viewing experience is now available in WebCenter. You can view 3D in Unified Viewer.

• the Java Collada Viewer
• the HTML5 Collada Viewer

• Click the thumbnail of a Collada file to open WebCenter's 3D Viewer. As a regular user, you need to
have both View and Download rights to use the Collada Viewer.
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Note:

If your Collada file contains a background environment (.env file), you will see it in the background.

WebCenter supports all the default Visualizer environments.

• The HTML5 3D Viewer launches much faster than the Java based Viewer and it works on mobile
devices. You can use your mouse or touch to perform actions. Read about HTML5 3D viewing in
Viewing 3D in the HTML5 Collada Viewer on page 735.

• Makes use of 3D capabilities that are built into modern browsers (WebGL) depending on your
browser.

• Supports the same lighting, print and finishing effects as Java version and the desktop Studio
application.

• For Collada files that are written in Studio, the Viewer will show the lighting environment as
configured there. For other Collada files, it will use a neutral photo studio lighting (different from
the Java-based Viewer).

System Requirements (Java 3D Viewer)

About System Requirements
The following system requirements only apply to the Java 3D Viewer. It is however recommended to
use the newer HTML5 3D Viewer (the default 3D Viewer since WebCenter 16.0), since this has better

778



4WebCenter

browser support and offers a better experience. The system requirements for using the HTML5 3D
Viewer are the same as WebCenter usage in general, no special additional requirements.

For PC Clients

System 32-bit or 64-bit

Memory 1GB RAM minimum, 4GB RAM recommended

Java version Java 1.5 or higher

Video card DirectX9 compatible 3D graphics board from ATI
or NVidia supporting fragment shaders and with
at least 256MB video memory.

For example:

• NVidia GeForce FX series, GeForce 6 series,
GeForce 7 series, GeForce 8 series, GeForce 9
series.

• ATI Radeon 9600, 9700, 9800, Radeon X series,
Radeon HD series.

Note:  ATI FireGL boards and Intel embedded
graphics are not supported!

For Mac Clients

System 32-bit or 64-bit

Memory 1GB RAM Minimum, 4GB RAM recommended

Java version Java 1.5 or higher

Video card For Intel Macs:

• NVidia GeForce
6600/6800/7300/7600/7800/8600/8800,
Quadro FX 4500/5600.

• ATI Radeon 9600/9700/9800, Radeon HD
2400/2600, X600/X800/X1600/X1900.

For PowerPC Macs:

• NVidia GeForce FX/6600/6800/7800.
• ATI Radeon 9600/9700/9800/X800/X1900.

For example: Power Mac G5, iMac G5, PowerBook
G4 (from 2004 or later).

Browser Limitations
The Collada 3D viewer is currently not supported for use on Firefox 4 for Mac and Chrome for Mac.
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With Firefox 3 for Mac there is a known problem when using tabs: when the Collada 3D viewer is open,
opening extra tabs will also display the Viewer image in those tabs.

4.7.5.  Using 3D file as 3D perspective

You can use any 3D file as a 3D perspective of a graphics file in the WebCenter viewer. You can also
view both the graphics document and the 3D file next to each other.

To view the files in the viewer, ensure there is a document reference attribute called CAD_REFERENCE
in the graphics document. Follow the steps below to open a structure document.

You can use the structure document in the Structure document selector.

After selecting a 3D Document as 3D perspective, save the link using the save button next to the
Structure Document Selector.

Note:  This is only possible if the Document has the Document Reference Attribute CAD_REFERENCE,
in which the link is stored.

If a printable part is selected and the alignment options are saved, then the 3D widget displays the 3D
shape along with the graphic file applied to the specified printable part.

Note:  The printable part is saved in the document reference properties CAD_PRINTABLE_PART and
CAD_PRINTABLE_PART_SIDE of the CAD_REFERENCE attribute that points to the 3D file.

4.7.6.  Approving 3D Files

Collada files can be approved like any other document in WebCenter. You can approve, reject or
comment a Collada file from:

• your My Work page,
• the project's Documents tab,
• the document's Approval tab,
• the 3D Viewer (at the bottom left of the window).

4.7.7.  Annotating in 3D Files

When the current document is a 3D file, the 2D annotations are created relative to the view port and
are shown in the annotation report. Adding an annotation is not possible during comparison of 3D
models or on 3D perspectives that are linked to graphic documents. When the annotation tool is active,
you

• Cannot move or rotate the 3D object. To rotate or move the 3D object, turn off the annotation tool.
• Add an annotation, the camera angle of the 3D model is linked to the 2D annotations. Selecting an

annotation, will result in the 3D model rotating to the same camera angle where the annotation was
added.

An annotation is only visible, when it is currently selected by the user from the widget.

You can read more on Annotations here Annotations and the 3D Viewer Positions on page 739
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4.8.  Working with ArtiosCAD Documents

You can open your document in the ArtiosCAD application directly from the WebCenter server.

Note:

This is possible if:

1. the document is recognized as any of the following types :

• Design: .ARD and other structural design formats supported by ArtiosCAD

• Manufacturing: .MFG and other structural manufacturing formats supported by ArtiosCAD

• 3D: .A3D
2. you have been granted rights to download the native ArtiosCAD files by the system administrator.
3. you have been given the download permission to the project folder where the document resides.

• From the Document Search Results page, you may see the Open in ArtiosCAD link even when
you do not have the download permission. When you attempt download, you will receive an error
message.

4. WebCenter Preferences > General Preferences > ArtiosCAD > Open ArtiosCAD documents is set to
either the ArtiosCAD Standard Edition or the ArtiosCAD Enterprise edition.

4.8.1.  Canvas

The ArtiosCAD Canvas type document is a container for designing multi-part displays. These individual
parts in the Canvas may differ in the board format.

The parts of a Canvas can be saved as separate design files into WebCenter and then referred in a
document reference attribute with the name Canvas Parts.

Note:  This document reference attribute is available in WebCenter by default. Read Canvas related
Attribute Categories on page 411

The Canvas document will also contain the meta-data about its parts.

Note:

• You cannot use the Canvas documents to run a Standard.
• A canvas document cannot be used to create 3D view with aligned graphics. However, you can view

the 2D model with aligned graphics in the Viewer.

Canvas Information Tab
The Document Details > Canvas Information page has four sub-tabs:

• Geometry tab containing:

• Detailed design information
• Dimensional details
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• Board and flute information,
• Print item details
• Design preview

• Parts tab displays the information regarding each part. The information displayed on this tab will
depend on whether these parts are managed by WebCenter or saved to WebCenter:

• the Part name as defined in ArtiosCAD

• the Document file name (when not managed in WebCenter) or a WebCenter document name if it
is managed in WebCenter.

If the current user has the rights to view the document, it will be displayed as a hyperlink to the
referenced document's details.

If the document is not found, you will see a warning listing the possible causes.

• the Project name if the document is managed (separately saved to WebCenter). This will be
displayed as a hyperlink to the referenced project's details.

If the project is not found, a warning will be shown hinting at possible causes.

If the part is not managed in WebCenter, the Project field will be empty.

• the Version number for the parts managed in WebCenter.

The number will be “0” for the documents not managed in WebCenter.

• the Board name

• the Board Description – details of the board assigned to this specific part.

• 2D View  tab shows a 2D view of the canvas file (default side)

• 3D View (Collada) tab shows the 3D view of the document with mouse controls.

Note:  If 3D view cannot be created, then an error message will be generated.

• 3D Model (VRML)  tab:

• When you click on this tab, a VRML file (extension .wrl) will open in the browser generating a 3D
view.

Note:  The browser needs a plug-in for VRML format (e.g. Cortona) to generate the 3D view of the
document. If this is absent, the browser will download the VRML file.
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Note:  The Canvas documents should have folding angles to be able to render them in 3D. You
will see an error message if this information is missing.

4.8.2.  Opening Documents in ArtiosCAD Standard Edition / Enterprise Edition

Set your My WebCenter > My Preferences > ArtiosCAD Preferences as either:

• ArtiosCAD Standard Edition to download an ArtiosCAD document from the WebCenter site and
open it in your ArtiosCAD desktop application.

• ArtiosCAD Enterprise Edition to open the document in the installed ArtiosCAD Enterprise Edition

1. You may open your design / manufacturing /3D file you want to edit in ArtiosCAD desktop
application from:

• the document details page using the Open in ArtiosCAD button.
•

the Project Details- Document Overview page, using the open  button.
•

the Task Execution – Documents section page, using the open  button.
•

the Document Search Results page, using the open  button shown next to the document
name from the list view / grid view, or when you hover over the document in card view.
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2. If your preference is set as ArtiosCAD Enterprise Edition, the system will launch the ArtiosCAD
Enterprise desktop application. To open documents in ArtiosCAD Enterprise edition, use the same
buttons as described. Also enter your login credentials for the WebCenter server.
The document will be loaded to the ArtiosCAD Enterprise workspace in manage document mode.
In this mode, you can publish the updated version to the same WebCenter project to which the
document belonged.

4.9.  Project Management in WebCenter

Users designated as Project Managers in their profile have a Projects I Manage link on their Projects
menu. In these projects, they have access to a number of additional features that allow them to
manage the projects.

Project Managers can:

• Create projects, either blank or from a Template.

• Invite members to the project and uninvite them.

• Create project folders and add documents.

• Set Characteristics and Attributes on the project and its documents.

• Forcibly Accept or Reject documents requiring Approval.

• Set the security on the project.

• Manage Roles in their project.

Note:  Only Project Managers who are members of the Admins group can save a project as a Template.
See the Administration Guide for more information.

Whenever a project is created, an event is logged in the audit trail and can be viewed in the project
history.

Basic information about the newly created project details like the  Project Name, Project Description,
Project Manager, project was created from template are all mandatorily recorded .

4.9.1.  Creating Projects and Folders

Project Managers and Project Creator users can create new projects from a project template, or from
an existing project. Project Manager users also have an option to create from zero and they can create
new folders inside projects they manage.

Project Creators have to necessarily assign a project manager for the projects they create.

Create a Project from Zero
1. Log in as a Project Manager or Project Creator.
2. In the Create or Projects menu, click Create Project.
3. Choose Start from a Blank Project in the Create list.
4. Fill in the new project's Details.

a) Enter the Name of the new project.
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b) If you are a Project Manager user, by default you are the Project Manager of the project you
created. If you are a Project Creator, you can make another user or user group as the Project
Manager for this project by selecting the user name or group name from the Project Manager
list.

c) To make the project active, leave the Status on Active.

Note:

If you are not sure that the project will be going forward (you need somebody else to decide
first), you can either:

• Make the project Non Active or On Hold,

• Make the project active (if you have the Task Management module), make the decider a
project member, and assign him/her a task to confirm/authorize the project as first project
task.

See Task Management in WebCenter on page 841 for more information about tasks.

d) If desired, specify a Customer for the project, and that customer's Location.
e) To use a custom thumbnail, click Change beside the default Thumbnail.

Select Specify New Thumbnail and enter the complete path and filename in the associated field
or Browse for it. To use the default thumbnail, leave that choice selected.

f) If desired, enter a project description in the Description field.
g) To specify an optional due date, click the calendar at the end of the Due Date field and select

the desired due date. To set the due time, click the drop-down list to the right of the calendar
control.

5. To add Documents to the project, click Add Item in the Documents section and either:

• Browse to the document to add,
• Copy a document from another project (select the project then the document to copy).

Tip:  Use the  icons to search for a project or document name.

You can then change the document's Name and add an optional Description.
6. Invite members to the project: select each member, role or group to invite in the Invite members

list

Note:  You can Create and Invite New User to the project from the Invite Members drop down list.

To remove a member, role or group, click the associated minus sign.
7. Click Create.

This brings you to the new project's details page.

Creating a project adds an event and this is stored in the Project History.

This event will add following information to the Project History:

• The Project/Template from which the new Project is created.
• The name.
• The Project Manager.
• The Salesperson (if there is any).
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• The Customer (if there is any).
• The Location (if there is any).
• The description (if there is any).

Note:  When a project is created from a template or an existing project, then only the changes
(like deletion of attribute values or adding a new document) from the template or existing
project is logged in the events.

Create a Project from a Template
1. Log in as a Project Manager or Project Creator.
2. In the Create or Projects menu, click Create Project.
3. Choose Use a Project Template in the Create list.
4. Select the Template from which you want to create the new project.

Tip:  To view the contents of a Template, click Show Details. This opens the Template in another
window. Explore the contents as desired and click Close Window to return to the Create Project
page.

Note:  Depending on the template you choose, the fields you need to fill in may vary.

5. Fill in the new project's Details and if the project is created by a Project Creator user, then the
Project Manager's name has to be filled in mandatorily.

6. If desired, add Documents to the project.
7. Add Members to the project.
8. If the template has attributes defined, fill them in the Attributes section.
9. Click Create.

This brings you to the new project's details page.

Creating a project adds an event and this is stored in the Project History.

This event will add following information to the Project History:

• The Project/Template from which the new Project is created.
• The name.
• The Project Manager.
• The Salesperson (if there is any).
• The Customer (if there is any).
• The Location (if there is any).
• The description (if there is any).

Note:  When a project is created from a template or an existing project, then only the changes
(like deletion of attribute values or adding a new document) from the template or existing
project is logged in the events.
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Note:

The project is created with the same folder structure, documents, discussions, characteristics,
attributes, landing page, members, and security as in the template.

Any documents in the template are copied into the new project as new standalone documents, even if
they were linked documents in the template.

The list of Approval Users is copied if it is applicable; if there are conflicts, a warning appears and you
will have to configure new approval settings.

Fill in the Project Details
In the Details section of the Create Project page:

1. Enter the Name of the new project.

If the option Use Automatic Naming is enabled, then the Name field is disabled.
2. When creating a project, you can choose another User/Group to be the Project Manager. Also, when

you copy from an existing project, you can also copy the Project Manager.
In such cases, you will not have visibility to the project once it is created.

3. To make the project active, leave the Status on Active.

Note:

If you are not sure that the project will be going forward (you need somebody else to decide first),
you can either:

• make the project Non Active or On Hold,

• (if you have the Task Management module) make the project active, make the decider a project
member, and assign him/her a task to confirm/authorize the project as first project task.

See Task Management in WebCenter on page 841 for more information about tasks.

4. If desired, specify a Customer for the project, and that customer's Location.
5. To use a custom thumbnail, click Change beside the default Thumbnail.

Select Specify New Thumbnail and enter the complete path and filename in the associated field or
Browse for it. To use the default thumbnail, leave that choice selected.

6. If desired, enter a project description in the Description field.
7. To specify an optional due date, click the calendar at the end of the Due Date field and select the

desired due date. To set the due time, click the drop-down list to the right of the calendar control.

Add Documents to the Project

1. To add Documents to the project, click Add Item in the Documents section of the Create Project
page and either:

• Browse to the document to add,
• Copy a document from another project (select the project then the document to copy).

Tip:  Use the  icons to search for a project or document name.
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• Create a document placeholder from a document template: select New in the Source list, select
the Document Template to use, and fill in any attributes that may be required.

Note:  This is only available if your Admin has defined document templates.

See Document Templates on page 162 in the Administration Guide for more information about
document templates, and Assigning Document Attributes on page 608 for more information
about attributes.

2. You can then change the document's Name and add an optional Description.

Add Project Members
In the Members section of the Create Project page, you can either:

• Invite members to the project: select each member or group to invite in the Invite members list.

To remove a member / group, click the associated minus sign.
• If the template / project you are copying from contains roles: you can assign user groups or

individual users.

You can see roles the template / original project contains, and are available for assignment at
project creation time, in the Members section.

• To assign a role to a user group:

1. Select that user group in the Group list.
2. Select who in the group will be the User / Assignee.

Note:  Leave the option Select User if you want any user of the group, or all of the group
users (depending on what was set when adding the role to the template / original project) to
be Approver / Task Assignee.

Note:

If you are using filtering (the role's name is the first word of the name of the group you want to
replace it with), you will only see the groups matching that filter in the Group list.

In the example below, the role is called Agency, and the list shows all groups starting with
Agency (followed by a space).

 

 

If no group matches the filter you will see the whole list of groups.

• To assign a role to an individual user:

1. Leave -Select Group- in the Group list.
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2. Select the individual user in the User / Assignee list.
3. Make sure Invite Group is deselected.

Note:  You can Create and Invite New User to the project from the Invite Members drop down
list.

• To assign a role to a group with a specific user as assignee:

1. Select a Group in the Group list.
2. Select the individual user that you want to be the assignee in the User / Assignee list.
3. Make sure the Invite Group checkbox is enabled.

• To assign several users and groups to the same role (this option may be enabled/disabled in the
parent project or template):

1. Select a user or group assignee you want to assign to the role.
2. In the Actions column, click the + icon to add another row for this role.
3. You can now assign the same role to multiple users and/or groups, using the + every time you

need to add a row and using - icon to remove a row.

You can also assign roles later if you don't have the user information ready.

Define Project Attributes

• If the template has attributes defined / you copied attributes from the existing project, you can still
edit them (if they are editable) in the Attributes section.

Attention:  Certain attributes can be required. Those have a red asterisk (*). If the
template / project you copied from contains required attributes, you cannot create the new
project without filling them in.

For more information about attributes, see Assigning Document Attributes on page 608.

Uploading documents in project creation

Create a Project Based on Another Project
1. Log in as a Project Manager or Project Creator.
2. In the Create or Projects menu, click Create Project.
3. Choose Copy setup from an Existing Project in the Create list.

Note:  This option is not available for Project Creator users

4. Select the Project to copy from.

Note:  You can only copy from projects you manage. If you are a project manager, you can also copy
a project from the project details More Actions... menu.

5. In the Copy setup from an Existing Project pop-up, select what you want to copy from the old
project into the new project (and deselect what you don't want to copy).
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For Tasks, you can choose to copy the Tasks from the original Template or from another Template
by typing in the template name. The default setting is to copy Tasks from the Project that is being
copied.

Click OK.
6. Fill in the new project's Details.
7. If desired, add Documents to the project.
8. Add Members to the project.
9. If the template has attributes defined, fill them in the Attributes section.
10. Click Create.

This brings you to the new project's details page.

Creating a project adds an event and this is stored in the Project History.

This event will add following information to the Project History:

• The Project/Template from which the new Project is created.
• The name.
• The Project Manager.
• The Salesperson (if there is any).
• The Customer (if there is any).
• The Location (if there is any).
• The description (if there is any).

Note:  When a project is created from a template or an existing project, then only the changes
(like deletion of attribute values or adding a new document) from the template or existing
project is logged in the events.
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Automatic Project Thumbnail Images from Documents
When a new graphics, ArtiosCAD or CHILI document is being uploaded to a Project or Template, the
user can have an option to check if the document image needs to be taken as the Project Thumbnail.

If this option is checked, the Project thumbnail will be set as the document image after checking and
registering.

You have to enable Make project thumbnail during the upload of documents to use this feature. You
can do so by setting up a document attribute with the exact name 'Make project thumbnail', using a
restricted set with values 'yes' and 'no' (to create a checkbox).

Note:

When a document with the Make project thumbnail attribute set to “yes” is moved or linked or copied to
another project, that project’s thumbnail will also be changed to the thumbnail of this document.

Remember:  This attribute has no effect when the document’s thumbnail is manually changed to
another thumbnail.

Notes on Thumbnail Images
When specifying a custom thumbnail, consider the following:

• WebCenter automatically scales the thumbnail as needed to two sizes depending on where it is
used. The larger size is 100 x 100 pixels; the smaller, 50 x 50 pixels.

• The maximum file size of a thumbnail is 1 million bytes, whether it is custom or generated. This limit
is configurable; contact Professional Services for more information.

Create Folders in a Project
You may only create one level of folders in a project under the Project Documents folder.

1. Log in as a Project Manager or Project Creator.
2. Open the project you manage which will contain the new folder.
3. If it is not selected already, click Documents on the Details menu.
4. In the Folders column at left, click Add Folder in the Actions menu.
5. Enter the name of the new folder in the Folder Name field.
6. Optionally, you can:

• Select Workflow Folder (Advanced) and select a workflow folder from the Configuration list.

This will turn the folder into to a Push Through Folder. A workflow folder automatically copies the
files uploaded into it to another folder (on the same or another server).

Typically this other folder is a hot folder for a workflow application such as BackStage /
Automation Engine, Nexus or Odystar.

• Click Specify New Thumbnail to use a custom thumbnail for the folder. Enter the complete path
and filename in the associated field, or Browse for it.

To use the default thumbnail, leave that choice selected.
7. Click Create.
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The folder is created. Project Manager can keep track of any changes made to the Project folders,
by enabling the notifications for Project Folder changed.

About Workflow Folders

What is a workflow folder?
When creating a folder the Project Manager can define it as a workflow folder, using a push-through
configuration defined by the Admin.

Any file that is uploaded into this folder will be automatically copied to a location defined in the
configuration. For this reason, workflow folders are sometimes also referred to as “push-through
folders”.

Workflow folders are particularly useful when that other location is a hot folder of a workflow system
such as Nexus, Automation Engine or Odystar, so that the file will automatically be processed by the
workflow system.

Note:  The Configuration for workflow folders needs to be defined by an Administrator.

Project Managers can then select one of the defined configurations when they create a new folder.

Recognizing workflow folders
Workflow folders have a yellow icon with an arrow on it.

 

 

The files in a workflow folder have two extra icons:

• The first  shows whether the copy of the file was successful or not.

• The second  is a button to copy the file again to the location defined in the configuration.

System History Logs
All Push Thorough Configuration related events like

• Push Through Configuration created

• Push Through Configuration deleted and

• Push Through Configuration changed

are recorded and stored in System History. Read this page on how to access the records.
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Project Creation from Dashboard
Dashboards are more interactive to edit the data which can be saved and have forms where input
can be added. Project creation has been incorporated to enable easier collection of information with
specific action driven pages in Dashboard.

Admin users can now choose the Dashboard function as a Creation Form in the Project context. Then
an option is available to add a Save and Cancel button.

 

 

You can create customized Projects from an existing Project or a Template which are available in the
drop down. Or when no Project or Template is selected, a blank project is created.

Save and Cancel buttons can be formatted with various configuration parameters available for the
blocks.

Creating Project from Button Block
Here is an example of a Project created from Button block.

You can configure a Button block to open a Dashboard and the Dashboard can be further configured to
open a project creation form as shown in the image below.
 

 

To use the Button with a Project Creation dashboard, follow the steps below.

1. Create a Dashboard with Project as Context.
2. Choose the Function as Creation Form.
3. Choose the Project or Template that you wish to create the Project from.
4. You can optionally choose to navigate to the new Project when it is created or open in the same

browser window.
5. Choose your Styling, Padding, Background color options for the Creation form
6. You can add the Document Sources from which document can be added for the project created.
7. Now create another Dashboard with any context that you need and choose the Button Block and link

it to the dashboard created earlier.
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8. Save the Dashboard.

Creating Projects from Menu Layout
Similarly in the Menu Layout, you can create a Dashboard as stated above. Select the Button block in
the Menu Layout (with Bottom or Top or Left option).

Below screenshot shows project created from Dashboard.

 

 

Synchronize the Project with a Workflow Job
If the Admin has defined a workflow connection, you can create projects that automatically create a
workflow job (see "Configure Workflow Connections" in the Administration Guide for more information).

The workflow jobs created will be automatically synchronized to the linked WebCenter projects when
certain events occur (as defined by the Admin).

However, if the Admin has enabled this possibility, you can also synchronize the workflow job to the
linked project (that you manage) whenever you need to.

•
To do this, click the synchronization  icon in the project header.

Create a Project from Automation Engine
With the Create WebCenter Project Automation Engine task, you can create an Automation Engine
Job and a corresponding project in WebCenter at the same time.

You can also retrieve information from WebCenter (Project Template, Customer Company...) and
associate it with the project you are creating, directly from Automation Engine.

This avoids double entries and duplication errors, and can be triggered from an MIS system for even
more automatization.

In this task:

1. Select your WebCenter Site (it must be defined in the Configure tool).
2. In the Site Logon area, fill in your WebCenter User Name and Password.

You can choose to type in your password (which is then Encrypted) or to Use SmartNames that
resolve into your password.
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Note:  The user you enter here must be a Project Manager in WebCenter to be able to create
projects.

3. Enter the Project Name and Project Description to give the new project.

Tip:  An interesting choice for the project name is the SmartName [JobName]. By selecting the job
name as SmartName for the project you can map the jobs in Automation Engine to the projects in
WebCenter.

4. In Project Manager Username, enter the user name of the WebCenter Project Manager that will
manage the newly created project.

Note:

• This user must already exist in WebCenter.

• This can be the same user as the one you logged on with, or a different one.

• The user you logged on with must have at least as much visibility in WebCenter as the Project
Manager you enter here.

5.
Click the Refresh  buttons.

6. The Project Template, Customer Company and Customer Location fields should now contain a list
of the WebCenter Project Templates / Customer Companies / Customer Locations visible to that
Project Manager.
Choose the Project Template, Customer Company and Customer Location of your choice.

7. Click Launch.

4.9.2.  Editing Projects

Project Managers can:

• edit the project's general information in the Project Details > Project Information page,

• add specific information to the project, like characteristics and attributes,

• update the links to documents in the Project,
• change the Project status.

Note:  Only Administrators can save Projects as a template, so that other Projects can be created
based on it. See the Administration Guide for more information.

Add a Salesperson
Project Managers can associate a Salesperson with the project. This can be any user in the system, but
has no specific rights in the project.

1. On the Project Details page, click Project Information.
2. Click Salesperson.
3. Select a salesperson and click Finish.
4. Click Save.
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Note:  The salesperson does not gain access to the project unless he/she is invited as a user,
Project Manager or is part of the Admins group.

It is possible to search for all projects associated with a certain salesperson across WebCenter.

Note:  Project Creator user can be set to a Salesperson after the project was created. This is
possible only if the Admin user has enabled Project Creator becomes Salesperson after Project
Creationoption in the Project Creation page.

View Project Source
Projects can be created in multiple ways, like from project template or from another project or a blank
project. When the projects are created from a template or from another project, some of the project
properties like the Documents, Tasks, Attributes, Characteristics, Discussions, Notifications,
Members can be copied to the new project.

In such cases, especially Tasks can be copied either from the project template or from the project
source.

Project Source is the existing project, which is used to create a new project.

Project Template will remain same for the existing project and any newly created project from the
existing project.

Project Template and Project Source information of a project is useful for the Project Managers and
Admin users to understand the origin of the tasks or documents or attributes.

Example

There are two projects and one template created. The name of the template is T1, the names of the
projects are P1 and P2. The projects are created in following order:

• P1 is created from T1
• P2 is created from P1

Following table shows the resulting values of the Project Template / Project source field

Project / Template Project Source Project Template

T1 None None

P1 T1 T1

P2 T1 P1

Whenever a project is created using an existing project, the new project created has the same
Project Template as that of the existing project.

To view the Project Source of any project :

• Navigate to Project Details page, click Project Information tab.

Specify Project Characteristics
1. Log in as a Project Manager or Project Creator.
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2. Open the Project whose Characteristics you want to specify.
3. Click Characteristics.
4. Select the checkboxes of the desired Characteristics. The selected Characteristics will appear

in the list of Characteristics. Click the + plus sign next to a Characteristic to see its children
Characteristics.

5. Click Change. The selected Characteristics will be associated with the Project.

To remove Characteristics from a Project, do the same as described above, but deselect the
checkboxes of the Characteristics to remove them from the list.

Specify Project Attributes
1. Log in as a user who is a Project Manager, or as a user who has the Change Properties permission

on the root level of the Project.
2. Open the Project whose Attributes you want to specify.
3. Click Attributes.
4. Choose the Attribute Category and click Change.
5. Set the values for the Attributes as desired and click Change.

The Attributes are assigned to the Project.

About Exporting and Importing Attributes
To make working with other systems easier, you can export and import project Attributes by using JDF
(Job Definition Format) files.

You can export the Attributes, modify them in another system, and then import their changed values
back into WebCenter.

Note:  You cannot add more Attributes to a project this way; this only lets you change the values for
existing Attributes.

Important:

If you want to import Attributes that are not generated by another WebCenter system, you should
generate a sample JDF file for the people using the other system to use as a reference, so that they
format their JDF file correctly.

The important lines are the ones similar to <eg:SmartName Name=”Attribute Name” Value=”Value”/
>; there must be a Value tag for each Name tag.

Note:  Option to Import from or Export to JDF buttons are enabled only when Allow importing from/
exporting to JDFis enabled in the WebCenter Security Preferences by the Administrator users.

Export Project Attributes
WebCenter automatically names the exported file <Project name>_attrs.jdf.

Note:  Any periods in the project name will be converted to underscores.

1. Log in as a Project Manager or Project Creator.
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2. Open the project with the attributes to export.
3. Click Attributes.
4. Click Export.
5. Click Save, browse to the desired location, and click Save.

Import Project Attributes
1. Log in as a Project Manager or Project Creator.
2. Navigate to the project with the attributes to import.
3. Click Attributes.
4. In the Import from JDF file field, enter the path and name of the file, or click Browse and select the

JDF file.
5. Click Import.

The values for existing attributes are updated if necessary.

Note:  If there are either too few or too many attributes defined in the file as compared to the
project, WebCenter will mention it in a status message.

Update a Project
If you have a document that is linked in many Projects, and upload a new version into only one Project,
the links in other Projects continue to reference the prior version.

1. Open the Project to update.
2. Click Update on the Project Actions menu.
3. All documents in the Project are updated.

A list is shown of the updated document(s), the containing Project, the old version number, and the
new version number.

Tip:  To update more than one Project at once, get a list of the Projects, select them, and click Update
Project(s) in the Actions menu.

Project Statuses
The Project Status feature allows you to review the current project standing. This feature can be
accessed by an Admin user or a member of the Admin group, Project Managers and an User.

An administrator can add statuses in WebCenter. This works similar to task statuses (whereas the
statuses are not shared). A status has a name, an icon and a type. The types are Non-active, Active,
Archived and Completed. The WebCenter has the functionality to limit the actions possible in not-
active and completed projects. It is most typical to add active statuses, for example: Briefing, Design,
Prepress, Printing. An administrator can limit the statuses for a project and this can be done for every
project individually.

The project status is displayed in the project header (and in available other locations such as search):

Note:  This can be set as read only. Read more atPrevent direct changes to Project Status on page 177
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The Project Manager can perform following:

• Set the Project Status.
• View Project Status.
• Search Project Status and Filter projects based on Project Status.

An administrator can limit the statuses for a project and this can be done for every project separately.
Go to a project or a template as an administrator and click on the Configure tab. By using Add Project
Statuses and Remove Project statuses (select with the check boxes and take remove from the action
drop down), you can get a specific set of statuses.

An Administrator can link milestones to project statuses to see the timeline of projects in a calendar
view by setting up a date/time attribute for project statuses. Each active status can have a date/time
attribute linked and the same date/time attribute can be used multiple times with different offsets.
The linked date indicates the intended end of the project phase, but will not trigger an automatic
project status change. The actual date will depend on the related attribute value in the project context.

The administrator can decide the sequence of the statuses. This sequence is purely used for sorting.
When the projects are sorted based on Project Status, this is the sequence used. The sequence is
system wide.

Apart from showing the Project Status in many project overview pages (and also in the search results),
the project statuses can be used in the Workflows. For example: To decide different operations or
assignees depending on the current project status.

Note:  By using the Set Project Status node in Workflow, you can set the status for the current project.

In the following example, let us consider five statuses allowed for this project. The Project Statuses
are set as 01 - Briefing, 02 - Concept, 03 - Artwork, 04 - Prepress and 05 - Closure. The WebCenter
has many more statuses, but only these statuses are allowed for this project. The statuses are in this
sequence in the entire system.

Note:  You can only decide per project whether you can have these statuses, but you cannot change
the sequence of the statuses per project.
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A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. Archive Project status is visible to users based on the setting specified by the
Administrator in the Security Preference.

Read more on Project status as Archived here.

On archiving the Project, the project is excluded in the Project list and is not shown in the My Projects
or Project I Manage menu items. The Project as well as the Tasks and Documents within the project
does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

Change the Project Status
A project can have different statuses. For example:

• Active
• Non Active
• Completed
• Archived

In additional to the standard statuses, custom statuses may have been defined by the system
administrator. A project or template can have its own specific set of available project statuses. Every
project requires at least one active status.

The project manager can set the project status from the project details header, or in the Status list on
the Project Information page.

When searching, you can search for all projects, or projects that have a specific status like Active,
Archived, Not Active, or Completed. It is also possible to search for All Active, All Not Active or All
Completed projects or All Archived, and this type of search would include different (custom) statuses
of the same type.

Displaying a Project Status
The Project Status can be viewed by an Administrator, Project Manager and a Project Member.
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The status of a WebCenter project is displayed in following ways:

• The status is displayed in the project header of each page of the project.
• The status is displayed in the columns of the project overview pages (Project I am Invited to,

Favorite Projects and Projects I Manage).
• The status is displayed in project search results if this column is requested to appear in the search

result.

If an icon is available, the Project Status is displayed as an icon with its status name. If no icon is
available, the project status is displayed as a name only. If the option hide thumbnails is active, only
the status name is shown. The icon is displayed in true size.

Customizing a Project Status
An Administrator can set allowed statuses for Templates or for Projects. By doing this an Administrator
can limit the number of Project Statuses to be used for a specific project. When adding a new project
status to the system, this status will be also added to all projects and templates. When a project is
created from a template or from another project, it inherits the allowed statuses from its source. This
happens only once and does not happen when the template changes later.

1. Log in to WebCenter as an Admin user.
2. Click the Admin > Project Management and select Projects or Templates.
3. Click the required Project or Template link from the list.
4. Click the Configure > Project Statuses. This displays a table with the current allowed statuses for

this Template or Project.
5. Select the required Project Status from the list and then click the Add Project Statuses link.

Note:  By default a blank Project will get the list of all statuses as allowed statuses.

6. Click the Save button to make changes.

Note:  The Project Status cannot be re-ordered here, the order is inherited from the system order.

You can remove allowed statuses for a template or project by selecting the status and select Remove
from the Actions menu.

 Set a Project Status using the User Interface

An Administrator or a Project Manager can set the Project Status for the current project using
WebCenter UI. A Project Status is changed by selecting a new project status from the status drop
down list in the header of the project pages. The drop down only contains the allowed statuses.
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 Set a Project Status when creating a Project

An Administrator or a Program Manger can set the Project Status while creating a new Project. When
creating a new project through the WebCenter User Interface, there will be a drop-down allowing to set
the project’s initial status. The drop-down will default to the first Active status.

Note:  The Completed statuses are not shown because you cannot create a Project in a completed
status. In case the Project is created from a Template (or a copy of another Project) it may be possible
that the Project Status field is hidden. If so, the newly created Project will get the first Active status.

 Searching based on a Project Status
You can search for projects based on their Project Status. Choose Search from the menu bar and
select Project or Tasks and Approvals. On the (advanced) Project Search page and the Task Search
page, the list box will contain the list of all the Project Statuses.

In addition to all individual project statuses, the list also contains the following:

• Show All (default): show all projects (or tasks of all projects).
• Show All Active: show only projects or tasks of projects with an active status.
• Show All Not Active: show only projects or tasks of projects with a non-active status.
• Show All Completed.

 

 

You can also search on Project Status Started, Project Status Due,Project Status Completed, Project
Status Duration, and Project Status Time Left  in the Project Search page.
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Filtering based on Project Status
In Favorite Projects, Projects I Manage, and in Projects I am Invited to, you can filter on all Project
Statuses individually. You can also use the filters to look for a combination of statuses: Show All, Show
All Active, Show All Not Active, Show All Completed.

Document creation settings in a project
In a project, go to the Configure > Document Creation to view the template from which the document
upload configuration is taken.

To change this, select the template from the drop down list. You will see a list of templates with a
custom document creation configuration. This will update the project document creation settings with
the selected template's settings.

4.9.3.  Managing Project Members and Permissions

Project Managers are responsible for managing who gets access to their Projects: they can add
members to a Project, remove members from a Project, and set their permissions.

Roles
Roles are created at a global level which the Project Managers (or the selected Project Managers) can
use in individual projects and templates. You can invite these Roles  just like Users and Groups.

Roles are effective after real members (Groups or/and Users) are assigned to each of the Roles. A
project Role assignee will be treated like a standard project member. Once you assign the Role to a
project, these take over the role’s security setup, approval setup and task assignments.

Multiple assignments of Roles are possible. For example, if you have a "Designer" Role, you can invite
this Role to all the Projects that require a designer either after creating a Project or via the Project
Template with assigned Roles.

Note:  You need administrator rights to create Roles. The visibility of the Roles can also be determined
by the administrators.

Read more about Roles in the WebCenter Administration Guide in Roles on page 294.
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Role Assignments in a Project
The Project Manager and all the Members of a project can view all existing Role assignments in a
project in the Project Members page.

Note:  You can filter on the Users, Roles and Groups in the Members tab. Alternatively you can search
using the Role name in the field.

Role members are displayed in the list as regular members under the Roles project member type
section.

You can see the Roles assigned to the Users and Groups in the Role Assignment column for user and
group project members.

Note:  When assigning users to a Role, the drop down also shows the deactivated users that you can
reactivate while assigning the role. Admin users can activate any users whereas Project Manager and
other users with Create User rights can only activate the users they created.

If a User is specified from the Group for a particular Role, this information is displayed next to the Role
reference in the Role Assignment column as [Assignee: USERNAME].

Managing Roles in a Project
If a project has at least one role among its members its Project Manager can access the Manage Roles
page to define role assignment within the project.  

1. Log in as a user who is a Project Manager.
2. Open the project for which you want to manage the roles.
3. Click the Members tab. A list of the current members is displayed.
4. Click Manage Roles link in the column header.
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Removing a Role Assignment
Each Role assignment is represented as a separate project member on the Members page. It can be
deleted from the project by uninviting it as in the case of removing a project member.

You can also remove the existing role assignments from the Manage Roles page.

Removing a Role from a Project
You can remove a Role from a project in the same way as removing a User or Group. By deleting the
entry for the User or Group with the Role combination, you can remove the Roles

Note:  When you have Roles assigned to Users or Groups, you have to delete the assignments (assigned
regular members) before being able to uninvite the Roles from the project.

1. Login as a Project Manger.
2. Open the Project from which you want to remove Roles.
3. Click Members.

A list of the current members is shown. If desired, use the filter to refine the list.
4. Select the Roles which need to be uninvited from the Project. Select the User or Group entries

assigned to these Roles to unassign them from this role, if the Roles are already assigned.
5. Click Remove from the Actions in the header.
6. Click OK to confirm the removal. The selected Role(s) and its assignments will be removed from the

Project.

Using Roles in Approval Setup
You can use Project Roles in approval directly as an Approval master and/or as an Approver.When
adding a Role to an Approval setup as an approver the user doing so has to choose between two
options for the  Type:

• One of Role: Only one of the role assignees needs to approve on behalf of the Role. This is the
default setting.

Tip:

It is possible to change Role assignments after starting the Approval cycle if you select One of Role
option. Use One of Role if there is only one role assignee.
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• All of role – One per Group: All of the User and Group Role assignees will replace the Role as
Approvers. When you choose this, for each Group, its representative Role assignee will become the
approver on behalf of the whole group.

• All of Role: When you select this, all the User and Group role assignees will replace the role as
Approvers. In this case all the members of the Role-Groups will become the approvers.

Note:  You cannot start an Approval cycle with unassigned Roles in the project. When the approval
cycle starts, all the Role- approvers are replaced as their assignees and the Roles will no longer be
visible in the Approval Setup.

If a Role is set as the Approval master, all the Role-assignees(Users and members of the Group)
become the real Approval masters.

Changing Role Assignments
From WebCenter 14 onwards, you can easily change Role assignments within a Project.

1. Go to Project > Members. Click on Manage Roles to get to the Role Management page. You can see
the list of Roles associated with the Project. You may also access this page from Project Creation
page.

In the Manage Roles page, you can see the existing Role assignments. You can change or remove
the existing Role assignments from here.

2. You can :

• add a Group to the Role
• create a new assignment for the existing Roles. Use the User/Assignee dropdown to choose

another User as the new Role assignee.
• add /delete members from the same Role. Use the + and - controls respectively.
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When an existing Role Assignment is changed, all the Role dependent Task and Approval
assignments will get transferred to the new Assignee. This transfer of assignments only happens if
the current Assignee loses access to the Project by getting unassigned from the Role.

In situations where a User or a Group is only invited to the Project via a Role Assignment, a Role
reassignment will result in that user's /group's removal from the project. Approval and Task related
dependencies are checked to prevent leaving the Project workflow in an inconsistent or blocked
state.

Delegating Roles
Go to the Manage Roles page. If you have been given permissions to assign Members of a Role or to
change Role assignments, it will be displayed.

If you do not have the permissions to manage any roles, a message will indicate this.

Add Members to a Project
Users and Groups need to be added to a project before they can access and use it.

1. Log in as a Project Manager or Project Creator.
2. Open the project to which you want to invite members.
3. Click Members.

A list of the current members is shown.
4. Click Add Members in the column header.
5. Add Project Members window is opened, where you can select and add new member to the project

from the New Project Members drop down.
6. Select the role for the newly added user from the Assign to Role and click Continue.

Note:  You can Create and Invite New User to the project from the New Project Members tab from
the drop down.

7. Set the project permissions as desired. These permissions apply to all members being added in this
step. Then click Finish.

A successful status message appears along with a list of suggested subsequent tasks.
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Note:

If the project already has any number of roles among its members a drop-down list containing these
roles is displayed at the top of the ‘New Member Selection’ step of the ‘Add Member to Project’ wizard.

By selecting a project role while specifying users/groups to be invited to the project the project
manager can at the same time assign the desired new members to the selected roles.

The Set Project Security for New Members step fills up the security matrix with the original setup of
the selected role.

Take into account that you cannot assign a role to another role in a project – any role objects selected
from the list of the desired new project members will be disregarded (they won’t even be invited to the
project) if a ‘role assignment’ is specified using the appropriate drop-down list while picking up new
project members.

By introducing roles than can be assigned to multiple user or group members it is now possible to have
a same user or group member invited into the project via different role assignments (i.e. Joe Designer
can be invited into a project both as assigned to DESIGNERS role and independently without any role
assignment). Every such combination of a member and its assignment is considered (and presented)
as a separate project member.

Remove Project Members

Note:  You may only remove Project members who are not Approvers in an active Approval Cycle.

1. Log in as a Project Manager or Project Creator.
2. Open the Project from which you want to remove members.
3. Click Members.

A list of the current members is shown. If desired, use the filter to refine the list.
4. Select the users, groups and roles to uninvite from the Project. In case you want to unassign a user

or group from a role, select the specific entry for this combination.
5. Click Remove in the actions menu.
6. Click OK to confirm the removal.

The member(s) are removed from the Project.

Note:  Project Manager can enable the Remove Project Members notifications to ensure an event is
saved in project history and also to notify involved people or other members of the project.

User, Group and Role Permissions in a Project
When a user is invited to a project several times (as an individual user through the Add Members
function, as part of a Group and/or as part of a Role), his/her permissions on the project are calculated
as follows:

• As a general rule, all permissions are added so that the user has the most permissions. For
example:

1. The user is invited to the project with the View and Download permissions.
2. He is added to a Role that has the Add permission on this project.
3. Then the user will have the View, Download and Add permissions on this project.
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• Exception 1: when a user is already invited directly (as an individual user) to a project, re-inviting
him/her through a Group doesn't change his/her permissions.

• Exception 2: when a user is only invited to a project through a Role or Group, you can change his/
her permissions when re-inviting him/her as an individual user. This allows you to either restrict
permissions for a specific user, or give him/her more access.

Note:

In this case, when inviting the user individually, his/her existing Group or Role permissions for
the project will be suggested, and you will see a warning explaining that changing the user's
permissions at that point may interfere with his/her ability to perform project tasks.

For example if the user has a "Designer" role, and you remove her Add permission, she won't be able
to upload designs to the project!

4.9.4.  ArtiosCAD Default Projects

You may see WebCenter projects with names starting with ACadDefaults_.

Do not modify these projects as they are automatically created by ArtiosCAD (and Cad-X) to store
defaults.

They are named with the following patterns:

• ACadDefaults_<version>_<language-code>_Shared, where <version> can be for
example 12.0 and <language_code> en.

These projects are created when you run the ArtiosCAD Defaults Installer. ArtiosCAD users should
have View and Download rights on these projects.

Do not delete these projects as this would take away some CAD functionality!

However, if you want to install new defaults, or in case the defaults installation was interrupted,
you will have to delete the corresponding ACadDefaults_ project before reinstalling the defaults
(which will create a new ACadDefaults_ project automatically in WebCenter).

• ACadDefaults_<version>_<language-code>_<login_name>, where <login_name> is
the login name of an ArtiosCAD Enterprise (and WebCenter) user.

These projects are created when a WebCenter user logs into ArtiosCAD and defines defaults to
work with. ArtiosCAD will update them automatically if that user changes his/her preferences (in
ArtiosCAD).

4.9.5.  Defining Approval Settings

Document, Folder and Project Approval Settings
You can define approval settings at the document, folder or project level. You can also define approval
settings on a number of documents in a folder or project.

Note:  Defining approval settings for a project (or folder) does not mean the project (or folder) itself
is being approved. Rather, it means that users adding documents to the project can use these pre-
defined settings to save time and reduce the chance for error.
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When you want to setup an approval cycle for a document, you can:

• define document-level approval settings, that will only be used for that document (Setup Approval
or Setup Staged Approval),

• load the enclosing folder's approval settings, if the document is in a folder that has approval
settings defined (Load Folder Approval Setup),

• load the project's approval settings, if it has approval settings defined (Load Project Approval
Setup),

• use the default approval settings for that document (Start Default Approval Cycle). Those are:
the enclosing folder's approval settings (if the document is in a folder with approval settings), or
otherwise the project's approval settings (if they are defined).

Exceptions
• URL documents may not have approval cycles.
• An approval cycle may not be started on documents in Templates.

• An approval cycle may not be started on linked documents.

Permissions Needed
• You need the Change Approval permission to create or edit an approval setup.

• You need the Start / Stop Approval permission to start or stop approval cycles. This is the same as
the Lock / Update permission.

The project manager and the administrator can always define / edit the approval settings (at the
project, folder and document level).

For more information about permissions, see Project and Document Security on page 832.

Simple Approval and Staged Approval

What is Simple Approval?
When a user or a number of users need to approve your document(s) in no particular order, you can use
simple approval.

All approvers are notified at the same time and get the same due date (if a due date is defined).

What is Staged Approval?
When your document(s) need(s) to be approved by several people or groups of people, in a sequential
order, you can use staged approval.

The staged approval cycle works with approval stages, and each stage only starts when the previous
stage is completed.

This allows you to be as close as possible to your company's real life approval process, while taking
advantage of WebCenter's automating and tracking capabilities.

For example, if a document needs to be approved by the marketing, finance, and legal departments,
you can use three approval stages.

• In the first stage one or several people from the marketing department can be asked to approve the
document.

• In the second stage the finance department can approve or reject the document,
• In the final stage the document is sent to the legal department for approval.
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Setting Up an Approval Cycle
WebCenter enables you to define a number of approval settings like who can approve the document? ,
when ( due date)? and what happens if the document is rejected? and so on to match your real-life
business process as closely as possible.

Note:

You need the Change Approval permission to create or edit an approval setup.

To get to the simple approval setup page (for a project, a folder or a document):

1. Go to the Approval tab:

For... click...

a project ... the project page's Approval tab.

Tip:

If your project has (sub)folders, go to the project page's
Documents tab first, and click the top-level folder at left (called
Project Documents).

This ensures you have selected the project, and not one of its
(sub)folders.

a folder ... the folder you want to define approval settings for on the
project page's Documents tab.

Then click the Approval tab.

a document ... the Document Details page's Approval tab.

Note:

You can also get to the Approval tab by:

• clicking Setup document approval right after uploading the
document to the project,

• clicking the Setup Approval Cycle link corresponding to the
document on the project's Documents tab.

several documents ... Actions > Setup Approval Cycle after selecting the
documents in the project or folder.

Note:  This will start the approval setup from zero, even if some
of the documents selected already have an approval setup.

2. Click Setup Approval.
You will see the Approval Setup page where you can configure a simple or staged approval.
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3. Define Settings such as the due date, approval policy for the new version, approval master and
notifications.

4. Click on the  Show Stage Configuration Details to set up conditional approval, document
rejection policy and annotation review requirements.
To set up a staged approval, you need to add an approval stage and specify stage specific
configuration and approvers.

5. Add Approvers on page 820
6. Save.

Note:

• You can only set up an approval cycle for a project/folder/document that does not already have a
started approval cycle.

Add an Approval Stage
Your approval cycle already has one approval stage by default.

1. Define Settings such as the due date, approval policy for the new version, approval master and
notifications.

2. Click Add Stage. Give the stage a name. The names are set by default as Stage 1, Stage 2, etc.
Users with change approval permissions, can change the stage name by changing the text in the
edit field.

3. Click on the  Show Stage Configuration Details and:
a) Decide to Allow conditional approval or not (see Allow Conditional Approval or Not on page

817).
b)
c) Define what to do when one user rejects the document (see Define How to Handle Document

Rejection).
d) Define annotation review requirements.

4. Add approvers to the stage (see Add Approvers on page 820).
5. Click Add Stage to add another stage.

Note:  This adds a stage after the last stage. To add a stage before the current stage, click Insert
Stage above the current stage instead.

6. Repeat steps 2 to 4 for each stage.
7. If necessary, you can drag a stage up or down to reorganize your stages.

To remove a stage, click the minus button in front of it.

Approval Cycle Settings
WebCenter allows you to define a number of approval settings (who is the master approver? when?
what happens when a new version is uploaded? who should be notified? etc.)

To define these, use the Settings section in the Approval Setup page.
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Set the Approval Due Date
For a simple approval, you can set a single due date, which is the same for all approvers. Choose how to
define the Due Date in Settings:

• Choose No Due Date if you do not need a due date for your approval cycle.

Note:  Approval cycles tend to take longer when they don't have a due date.

• Choose Fixed Due Dates if you want to give a fixed due date to your approval cycle.

Choose a due date from the calendar, or type it using the one of the following formats: 2 May,
2010, 5/2/2010 or 5/2, 2010.

Then choose a due hour from the list.

When there are multiple stages involved, then the Due Date Calculation can be done in multiple
ways. Read more about Due Date Calculation on page 815 here.

• Choose Lead Time to define how much time the approval cycle should take (as a maximum).

Define the Lead Time in Days and / or Hours. It is added to the date the cycle starts, to define the
cycle's due date. For example if the cycle starts on May 2nd and has a 2 days lead time, it is due to be
completed on May 4th.

Attention:  WebCenter only takes week days into account. So if you start the cycle on a
Friday with a 3 day lead time, it will be due the next Wednesday and not the next Monday. By
default, Saturday and Sunday is considered as weekend. However, it is possible to switch
the weekend days to Friday and Saturday. The due date calculation will ensure that the due
date will always be on a weekday.

• Choose Lead Time with Final Due Date to give your approvers a lead time and give a final due date
for the approval cycle.

If the document has to be re-uploaded and re-approved, it will be given the same lead time again.
The final version of the document has to be approved by the final due date.Link your Approval Due
Date to a Date/ Time Attribute on page 813

Link your Approval Due Date to a Date/ Time Attribute
WebCenter enables you to define Project (or Document) Statuses using Attributes (Date-Time
attribute). You can link your approval due dates to these Project or Document Milestones, if you have
the milestones specified.

If your Project's Attribute Category contains Date/Time Attributes, you can choose your approval due
dates based on them. You can use these Attributes in Project/Folder/Document approvals. The setting
also allows you to specify an offset value along with the attribute value. For example. “Final Approval
Date” – 2 days.

Date/ time Attributes can be used as the final approval date or as stage approval dates. If you change
the attribute value, the linked approval due dates are updated including that of any ongoing approval
cycles. A due date change will trigger a notification to the approvers, based on Notifications chosen.

1. In the settings section, choose the Due Date as either of the following options:

• No Due Date
• Fixed Due Date
• Lead Times
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• Lead Time with Final Due Date
2. If you select Fixed Due Date, you can specify the Due Date for each approval stage separately. You

can specify:

• a Specific Date. In this option, you can select a date from the calendar.
• or a Date in Project. This option lists the Date/Time Attributes, from which you can select. You

can specify an offset period in days and/ or hours. The offset is added or subtracted from the
Attribute value.

 

 
When you save, your approval due date is calculated using the date value given in the attribute and
the specified offset. See the example below:

 

 

Due Date can also be calculated for all the stages at once if Specific Due Date is chosen. Read
moreDue Date Calculation on page 815

3. If you selected Lead Time with Final Due Date, you can select the Date /Time attribute +/- Offset in
the Final Due Date drop down. The options are exactly the same as above.

Note:

• If you change your Approval Due Dates, the Milestones do not get updated.
• The Due Date calculations use only working days.
• if you change the attribute value after the completion of the stage, it has no impact on the Due Date

of the completed stage.
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Due Date Calculation
You can calculate the due dates for the different stages using the Due Date
Calculation option. Any calculation done on this page is applicable for all the stages.

• Give Each Stage___ Days and __ Hours: Specify the exact number of days and hours for each stage
in the approval cycle

• Shift Due Date with __Days and __ Hours: Shift the due dates specified as fixed or as a Date/ Time
attribute to the given number of days and hours

• Shift Due Dates to have Latest on: You can shift the due dates specified as fixed or as a Date/ Time
attribute to not exceed the number of days and hours

• Shift Due Date to have First on: You can shift the due dates specified as fixed or as a Date/ Time
attribute to have first on the number of days and hours

• Distribute Due Dates Evenly You can distribute the Due dates equally amongst all the stages by
choosing this option

Define How to Handle a New Document Version
When a document's approval cycle is started, and someone uploads a new version of that document,
the approval cycle may stop or restarted based on the option chosen in the workflow. You can define
what happens to the new version of the document.

• In the When a new version is uploaded setting, choose either:

• Approval Restarts from Beginning to restart the approval cycle from zero. People who already
approved / rejected the document will have to evaluate it again.

• Approval Restarts from Current Stage to keep the approval stages already completed (typically
approved) and restart the current stage. Approvers who already approved / rejected the
document in the current stage will have to evaluate it again.
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• Approval Continues to keep all the approval actions already done. Only approvers who rejected
the document earlier will reevaluate to check whether the reason for their rejection was
corrected.

Set the Approval Master
In the Approval Setup > Settings section:

• Choose the Approval Master. This can be:

• Me (the person currently editing the approval setup),
• the Project Manager,
• the document Uploader,
• any project member with View access to the document (users, groups and roles).

The approval master is the person who gets the approval follow-up under Approvals to Follow Up on
his My Work or in Dashboard pages.

Notifications are received by Approval master as an information only.

Approval Master can now Force Approve or Force Reject Approval stages. This is a configurable
option in Security Preferences. Admin users can configure the Force Approve and Force Reject to
be allowed by either

• Administrator, Project Manager and Approval Master or
• only Approval Master or
• Project Manager and Administrators

Set Up Approval Notifications
Notifications are email messages sent to users involved in an approval cycle when certain approval
events occur, like for example User Rejected Document, or Approval Cycle Finished and so on. You
can define the notifications that can be received and when in the Approval Setup > Settings section.

Note:  The system administrator must configure WebCenter to send e-mail for notifications to work.
Regardless of the e-mail configuration, the My Approvals section on the My Work page shows items
waiting for approval.

1. Choose the type of E-mail Notifications to use:

• No Notifications if you do no't want to notify any user of the progress of the approval cycle,
• Default Notifications if you want to use the project's or the folder's notifications (if the

document is in a folder with notifications defined, they will be used, otherwise the project's
notifications will be used),

• Custom Notifications if you want to select who to notify (only for this document).
2. If you have chosen Custom Notifications, define who to notify for each approval event:

• the Project Manager,
• the Involved People (the people who are involved in a particular event, for example when an

approval comment is posted, the Involved People are the document approvers).

Tip:  Click on Involved People to see a list of involved people for each event.

• the Project Members.
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Tip:  You can use the top check boxes to notify the Project Manager, the Involved People or the
Project Members of all approval events.

Approval Stage Configuration Details

You can access this by selecting the  icon on the approval stage header. This configuration is
required when your

• Document(s) need(s) to be approved by several people or groups of people, in a sequential order,
you can use staged approval

• The staged approval cycle works with approval stages, and each stage only starts when the
previous stage is finished

Allow Conditional Approval or Not
Use conditional approval to allow your approvers to give their approval on a certain condition (for
example, if a barcode in the document is corrected).

The conditions (like the comments and the reasons for rejection) will be shown in:

• the Approval tab of the Document Details page,

• the Action History tab of the Document Details page,

• the Document History in the Viewer.

• Decide to allow conditional approval or not.

Note:  This option is hidden if the administrators have turned off the Admin > Preferences >
Security Allow Conditional Approval option in Approval setup option.
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Note:

When working with an Automation Engine workflow, documents you approve conditionally in
WebCenter will go through the Approved with a Condition output of the Publish on Web task in your
Automation Engine workflow.

 

 

Use a Wait for Action (Checkpoint) task for those documents, so the Automation Engine operator can
fix them manually.

Allow Forward Approval Link
The option to Allow Forward Approval Link is enabled in Approval setup based on the system settings
by the Administrator users in the System Settings.

When the option is enabled, then either an Administrator user or Project Manager or any other user
with Change Approval permissions can then use this option to allow the approval to be forwarded as a
link.

This option is not visible if the Administrator has not enabled the option.

It is also possible that an Approver may want to forward the approval as an email link to other users. It
can either be a Registered user of WebCenter or an unregistered user. The approver who forwards, can
then choose to either be part of the approval cycle or not after forwarding.

Keep or Revoke Forward Approvals

Keep Forward Approvals
When Allow Forward Approval Link is selected for a stage, then the option to Keep Forwarded
Approval is available. The forwarded approvals for the current stage are retained when a new version
of the document is uploaded. If the forwarded users have already submitted their approval status, it is
also added to the new version based on the settings.

Revoke Forward Approvals
Any approval forwarded can be revoked by either the Administrator or the Project Manager(s) or the
user who forwarded the approval.

Inherit Previously Submitted Approvals
You can inherit the approvals done at a particular stage, if the same stage is restarted. The option is
available in the traditional approval as well as in the workflow driven approval. When an Approval Stage
is started, a check is made to know
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• If there are any already submitted Approvals on this document and
• Inherit Previously Submitted Approvals option is enabled.

Inheritance of the Approvals are done only if the previous approval state is either Approved or
Approved with Comments. Approvals in previous stages with status such as Rejected, Forced
Approved, Force Rejected or Force Approved with comments are not inherited.

Inheritance of an approval is done, irrespective of whether the user is still an Approver. We consider all
document versions except the deleted versions, when checking for approval statuses.

Note:

1. Notifications are not sent for inheritance of approvals but approvals are tracked in the Documents
Action history.

2. Approvals with conditions are considered as regular approvals, when they are inherited.
3. Version number of the document from where the approval is inherited is also mentioned in the

Approval set up.

Define How to Handle Document Rejection

• Define what to do when one user rejects the document:

• Choose Stop approval cycle immediately if you don't want to bother the rest of the approvers
with a document that will have to be corrected and re-approved anyway.

Note:

That document version gets rejected as final approval status.

The approval request is removed from the to-do list of the approvers who haven't evaluated the
document yet.

• Choose Stop approval cycle after every Approver decided, if you want to collect as many
opinions as possible before creating a new version (to increase the chances that the next
version will be approved).

Note:  That document version only gets the rejected status after all approvers have decided.
The approvers of the next stage(s) don't get an approval request for that version of the
document.

• Choose Continue approval cycle anyway if you want to use the current stage as a review

stage (the approvers are just expected to give their opinion on the document, but do not

have a veto power) and to only start the real approval in a later stage.

Require Review State on all Annotations
In the approval Setup, you can set up a mandatory review on all annotations using the Require review
state on all annotations before approving or rejecting option.

This forces all approvers to review annotations before submitting an approval status.

Note:  This only applies to viewable documents.

• Select No if you want all approvers to submit their Approval Status without the condition of
reviewing the annotations. This is the default setting.
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• Select Any Viewer when you want to enforce that all annotations should be reviewed by at least one
person before submitting the Approval status.
A warning message will appear when the Approver tries to submit the Approval status for the
document containing unreviewed annotations.

• Select Current Reviewer when the Approver needs to review all annotations before submitting an
Approval status.
A warning message will appear when the Approver tries to submit the Approval status for the
document containing annotations he did not review.

Note:

• The review status None will not be accepted as a valid review state.

• This setting is relevant while submitting an Approval Status from the Viewer and the other
WebCenter pages.

Add Approvers
You can add any member of the project as an Approver. You can also add user groups or roles Invited in
the Current Project as approvers.

 

 

• To add a project member as an approver, select him / her in the Add Approver drop-down. Repeat
for every user you want to add as approver.

• To add a role as an approver, select it in the Add Approver drop-down. After adding the Role, edit
the Type. Select from:

• One of Role if you want only one of the role assignees to approve on behalf of the role. This is the
default setting.

Tip:

It is possible to change Role assignments after starting the Approval cycle if you select One of
Role option. Use One of Role if there is only one role assignee.
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Note:

Make sure that the Role is assigned to at least one user/group before starting the approval cycle.

• All of Role - One per Group if you want all users and one (any) member per group assigned to the
role to approve the document.

• All of Role if you want all users and all members of groups assigned to the role to approve the
document.

All current assignees of a Role can see the approvals for their Role in their My Work > My
Approvals section.

• To add a group as an approver, select it in the Add Approver drop-down. After adding the group,
select either:

• One of Group if you want one (any) member of the group to be able to approve it for the whole
group. (The document will get the approved status once one group member approves it.)

A typical example would be a legal review, which is completed as soon as one member of the
legal department has approved the document.

• All of Group if you want all members of the group to approve the document. (The document will
get the approved status once all group members approve it.)

A typical example would be a management review, which is only completed after all members of
the management team have approved the document.

All the users of a particular group are listed individually in this drop-down. It is possible to select
one or members of the group by clicking on the listed members' name.

Note:  When adding a group as All of Group, the users who are group members when the approval
cycle is started become approvers. If you later add or remove users from the group, the list of
approvers is not updated.

• To add a non-member as an approver, select him / her in the Add Approver drop-down. This will
open the Invite Project Member dialog.
a) If there are Roles as members of the Project(with view rights to the folder or document where

the approval is being set up), it is mandatory to assign the user to a role. Select the Role in the
Assign to a Role field.

• To add a User who is not present in the system, click Create and Invite New User option from the
Add Approver drop-down. It is possible to set up a default approval user template(in preferences)
to apply to the newly created user.

Note:

• You need User Creation rights to be able to create and invite users.
• You can set up a default Approval User Template to automatically apply the User Preferences

and User Profile > Authentication settings. Read more in: User Creation on page 99

Read step by step instructions in: Create and Invite a User from the Approval Page on page 281

To remove an approver or a group, use the x sign in front of it.
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Create and Invite a User from the Approval Page
Project Managers can create and invite users in the context of an approval page. This allows you (as a
Project Manager) to add an external reviewer to the Approval cycle. If the user is not in the system, you
can add a new user and invite him or her from the approval page. It is possible to create and add users
from any approval page(document's, project's or folder's).

Note:  These users will be created as Regular Users. The only exception is when an Administrator user
creates a user using an Admin User as the Approval User Template.

If you have used up all your Regular User licenses, you will not be able to Create and Invite User from
the approval page. Read about Named User License model in Licensing and Users on page 268.

• Click Add Approver > Create and Invite New User.

User Info in the Create and Invite New User wizard appears.
• Type the user's e-mail address. The fields (Username, First Name and Last Name will be filled in

automatically from the e-mail address. You can change these fields, if necessary.

• Username is filled with the part before @ of the e-mail address.
• First Name is taken as the part before the last dot.
• Last name is filled with all characters after the last dot (or all the characters before @ if no dots

are present).
• Optionally, assign to a Company and Location. Note that this can be very important to filter the

content and users the new user will be able to see.
• If you want the user to log in with a link sent from the approval page, follow the process below:

a) Set up a Token based single sign-on instance and keep it active.
b) Specify a User as Approval User Template. Also remember to allow link authentication in the

user profile.

To allow a User to authenticate via a link, configure  Token Authentication on page 446 and allow
this type of authentication in the User profile page.

Note:  You need to disable all the other types of authentication to make the link authentication
active.

Whenever the token-authenticated user receives a notification with a link, the link contains a
token to authenticate without user credentials. This permits the users added to the approval
cycle to log in using the approval links from the notification mails.

• If your default approval user template  has no Token Authentication setup or you have not defined
a user as the template, you need to specify and confirm a password in the Create and Invite User
wizard.

• If there are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
a Role field.

• Click Create and Invite User.

A new user is created and invited to the Project. You will be able to see this user in the Approvers list as
well as in the Users list.

• If you enabled link authentication, the user will log on to the system using a link from the
notification e-mail. The user will be able to see and approve the document/folder or project.
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• If you specified a password, the user would need to know the password to be able to log in.

Add a Deactivated Approver
It is possible to invite deactivated users to the approvers list.

• To add a non-member as an approver, select him / her in the Add Approver drop-down.
This will open the Invite Project Member dialog. The dialog will warn you that you are activating the
user with this action.

• If there are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
a Role field.

• Click Invite to confirm that the member should be activated and invited.

Notes

• You won't be able to invite a user who has been deactivated within the past 24 hours. The users
automatically deactivated or created as deactivated users do not have this waiting period of 24
hours.

• To re-activate a Project member who is in the Project Members list, click on the name (in the Add
Approvers dialog) and in the prompted dialog, click Activate.

Save the Approval Cycle
• When you are finished with the setup, click Save.

Note:  If you were setting up an approval cycle for several documents and some of them already had
a started approval cycle, the approval setup will fail for these documents. You will see a list of failed
documents on the Multiple Document Approval Setup - Info page.

Tip:

From the same page, you can also:

• Revert the approval settings to the last saved version (when editing an existing approval cycle).
See also Editing Approval Settings on page 824.

• Clear the approval settings (so the project, folder or document has no approval cycle).

For a document, this also clears all settings inherited from the project or folder.

• Start the Approval Cycle (see also Start or Stop the Approval Cycle on page 823).

Start or Stop the Approval Cycle

Note:

You need the Start / Stop Approval permission to start or stop approval cycles. This is the same as the
Lock / Update permission.

• You can start the approval cycle from:

• the document list on the project page (in the Approval column),
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• the document details page's header,
• the Approval tab of the document details page,
• the upload page (click Start Approval Cycle right after uploading your document),
• your workflow system (select the Start Approval Cycle option before sending your document to

WebCenter).
• You can stop the approval cycle from:

• the header of the document details page,
• the Approval tab of the document details page.

Editing Approval Settings

Permissions Needed
You need the Change Approval permission to create or edit an approval setup.

Note:  When editing a folder or a project's approval settings, the new settings affects only the
documents added to the project / folder after the settings are changed.

Started and Stopped Cycles
You can edit the approval cycles while they are started. To edit an approval cycle that is already started,
you must first stop it. You can do this from:

• the header of the document details page,
• the Approval tab of the document details page.

Editing a Simple Approval Cycle
After stopping a simple approval cycle that was already started, you can only edit the approvers (you
can add or remove approvers, even if they have already approved or rejected the document).

You cannot change anything else (due date, conditional approval...).

Editing a Staged Approval Cycle
After stopping a staged approval cycle that was already started, what you can edit depends on the
stages' status. If a stage is:

• completed: you cannot edit any information or remove the stage.
• pending: you can only add or remove approvers (even if they have already approved or rejected the

document). You cannot change other information like due date, conditional approval or remove the
stage.

• not started yet: You can remove the stage, or add extra stages or change any other information.

Note:  You cannot change the Approval Master.

You can now add or replace or remove an approver(s) when the stage is still in progress. Read more
about it here.

Editing the Approval Cycle for Next Version
You can also choose to leave the current approval cycle as it is, and only edit the approval setup for the
next version of the document. To do this, click Edit Approval Setup for Next Version in the document
details page's Approval tab.
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Note:  If an approval cycle is finished, you cannot edit it. In this case, you can only edit the approval
setup for the next version of the document.

Role Selection while approving
In an approval cycle, a user is sometimes part of multiple roles, who are required to approve the
document. While approving or rejecting the document, the Approver can choose the approval for each
of the role he / she is part of.

For example, User A is part of Legal Asia, Legal Australia and also Legal South East Asia. When the
user approves the document, the user can choose the role for which the approval is made.

Project History and action history pages tracks the approvals with the detail of user roles or groups
specifically mentioned.

Note:  User can still approve on behalf of all the roles by choosing the option Default (All). This option
is not available if reasons for rejections are enabled, as the reasons can depend on the roles of the
Approver.

Following Up on Approvals
If you are an Approval Master, you will see the approval cycles you are responsible for under Approvals
to Follow Up on your My Work page. This section shows a summary of each document's approval cycle,
with all the necessary details (Approval Status, Document Version, Due Date...).

Note:  If you cannot see the Approvals to Follow Up section, go to My Work > Edit My Work Setup to
add it to your My Work page.

In this section, you can:

• Filter the documents:

• by status (Pending, Rejected, Approved or Approved with Comments),
• by date (Finished within last 14 days, last 7 days or last day).

• Sort the documents list (by Approval Status, Document Name, Due Date...).
• View the documents.
• Get to a document's details page.

When is an Approval Cycle Finished?
The approval cycle's status is changed to Finished when either:

• all approvers have approved or rejected it,

• the Project Manager or an admin has Forced Approved or Forced Rejected it (see Forcibly Accept or
Reject Documents on page 826).

Note that in this case, the final status is Forced Approved or Forced Rejected instead of Finished.
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A finished approval cycle may not be stopped or started without uploading a new version of the
document.

4.9.6.  Forcibly Accept or Reject Documents

Project Managers have two special approval status settings available: Forced Approved and Forced
Rejected (unless this is disallowed by the Administrator).

Using either force approval or force reject finishes the approval cycle so that other approval users may
not approve or reject the document.

4.9.7.  Delegation

Delegations allows the users you nominate to view, edit, approve, comment, discuss and even reject
documents on your behalf. Similar to having an assistant, another WebCenter user(s) chosen by you,
can respond to all your pending tasks, approvals in your absence for a period of time specified by you.
The delegation can be set up by any user based on permissions granted by the administrator.

Terminology used
• Delegate: A person to whom the work is delegated.
• Delegator: A person who is delegating his work to someone else.
• Active Delegation: Period during which the delegate can take up the work of the delegator.
• Start Date: Date on which the delegation becomes active.
• End Date: Date on which the delegation expires. When an end date is not specified, the delegation

will be permanently active until it is removed.

My Delegated work
Any user in WebCenter can delegate his or her actions to be performed by other users.

When you have active delegations assigned, you can view them when you log in to WebCenter. Work
delegated to you by other users are displayed as pop-up in the first screen. In case you have more
than one delegator, you can view the work delegated by each of the active delegator along with their
comments.

Note:  To get this as the log in screen, enable the option Show this information when logging in

Log-in as a Delegate
You can either choose to continue your work or can log in as a delegate and complete the work
assigned to your delegator. To perform the delegated work, choose Act as (Delegator). Then you are
logged in as the delegator in WebCenter and My Work page of the delegator is visible. You can now
perform all actions as the delegator.

You can also note that the avatar in the navigation pane is that of the delegator and there is a banner
indicating that You are logged in as delegate of (User Name of the Delegator).

Return to your own account
Choose Return to my account link in the banner or from the drop down option in the avatar to return
back to your WebCenter account.
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Execute Work as a Delegate

Viewing as a Delegate
When you log in on behalf of the delegator, you can view and perform all the work assigned to the
delegator, on top of that your menu will be updated to the menu of the delegator.

As a delegate, following actions can be performed

• Approvals

• Task Actions as a Delegate on page 827

• Document actions as a Delegate on page 827

• HTML5 viewer actions as a Delegate on page 827

• Text Actions as a Delegate on page 827

• Discussion actions as a Delegate on page 827

Approvals as a Delegate
Approving, rejecting or adding comments as a delegate is done similar to normal approvals. If the
delegator has rights to change or start the approval cycle, then delegate will also have the same rights
when logged in as delegator.

Note:  When you are acting as a delegate, enter your own password to approve or reject any
documents.

Task Actions as a Delegate
Whenever the delegate logs in as the delegator, he/she will have the same rights as the delegator. This
means that if the delegator is allowed to create new tasks, the delegate will be able to perform that
action.

Document actions as a Delegate
When you are logged in as the delegator, the same permissions as the delegator are given. The
document actions performed by the delegate clearly indicate the owner/ uploader. Delegator is the
owner of the document which is uploaded by the delegate, while logged in as the delegator. Similarly
when a delegate locks the documents, the delegator can unlock the documents.

HTML5 viewer actions as a Delegate
While access the WebCenter to perform actions for your delegator, delegate can access the HTML
viewer to view, annotate and approve the documents.

Text Actions as a Delegate
The delegate can log in as the delegator to approve, reject, comment or edit content of a Text Content
language element and perform other Text Content operations based on the PCM permission model.

Discussion actions as a Delegate
In discussions too, delegate has all the access as the Delegator and can execute all actions the
delegator can perform.

The actions done by the delegate are visible on the following places:
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Action by Delegate Displayed as

Creating a new Discussion Delegator is set as the Owner

Post a New Message author name of the message indicates that it is
posted by the delegate who was logged in as the
delegator.

Unread messages For the delegate: when logged for the first
time, messages not yet read by the delegator
are displayed. The unread messages reflect the
messages that are not yet read by the delegate
since the last login.

For the delegator, the unread messages are
shown as his previous log in.

Watch/ Unwatch a Discussion Any updates to Watchlist like adding a discussion
to a watchlist or removal done by the delegate are
applied to the delegator. When the Delegator logs
in again will have the same Watchlist as updated
by the delegate.

Online status • Delegate: Shown as logged in (If part of the
participant list)

• Delegator: Shown as oine

Quotes in Discussion When a user quotes a message posted by a
delegate, the author of the quoted message
indicates that it was originally posted by the
delegate himself.

Mention When the delegator is mentioned in any
discussion, the delegate will be notified, if the
notification forwarding for the delegate is turned
on.

Note:  You cannot mention a delegate if the user
is not already a part of the discussion.

Tracking of Delegate Actions

Actions Tracked in

Approval • Project History: "As Delegate of "column
• Document Actions History: "As Delegate of" column
• Approval Setup: In the "Last Submitted by" column in approval

setup and the User column in the comments pop-up, contains a
string with following format: "Delegate as Delegator

Create New Tasks Project History and Task Details pages

Complete a Task Project History and Task Execution pages

Check an item in the checklist
of a task

Task Execution and Task Details pages
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Actions Tracked in

All other events Project History

Document Upload Document Action History

• Uploader is the Delegate ( actual uploader)
• Owner of the document is the Delegator

Document Lock Document Action History

• Delegate can lock the document which can later be unlocked by
the delegator.

Document Annotations
including creating new
annotations, Removal
of annotations, reply to
annotations

Document action history

• When a new annotation is added to the document, the author of
the annotation is the delegate.

Add Delegate
You can delegate your work to a specific user or users. Follow the steps below to add delegates.

1. To add one or more delegates, go to My WebCenter > My Delegates.
2. Select a user from the drop-down and click Add Delegate.

To inform your colleague about the delegation, enable the Notify new/modified delegates option.
3. If this is a temporary delegation until your return to work, specify a Start Date and an End Date.

There is also a comment field to leave your notes.
If you leave the End Date empty, the colleague can act as your permanent delegate.

My WebCenter > My Delegates page lists all your delegates and the respective time periods for which
the delegations remain active.

Note:  You can modify the delegation fields or delete a delegate from My WebCenter > My Delegates
page.

Modify or Delete Delegate
You can delegate your work to a specific user or users and modify it at a later date. To modify the
existing delegation, follow the steps below.

1. Navigate to My WebCenter > My Delegates
2. You can modify the existing delegates by changing the start date and end date. You can also change

the notifications by checking the box to send.
3. Select Save to confirm the changes.

To delete a delegation, select the icon in the row for the respective user.
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Delegation Notifications

Notifications for Delegator
During the delegation period, some notifications can be received by the delegator and the delegate
based on the options chosen in the My Delegates page.

• To receive notification when you have delegated your work to another user, select Receive email
notifications during delegation period. This will ensure you receive all email notifications during
the delegation period.

Notifications for Delegate
• On Assignment of the Delegation, select the option Notify new/modified delegatesto send

notifications email to the delegate when added or modified.

• To receive notifications during the delegation Period, choose the option Forward my notifications.

4.9.8.  Search on Project Duration

Duration Reporting for a project
You can search for projects based on the Start date, Due date, Completed date, Duration and Time Left
of the project. You can save the searches and add it to the dashboard to have an instant view of the
progress of all the current projects.

Field Name What it means

Started The start date of a project is the first time the project was set in an active
status.

Completed The last date the project was set in a completed status

Due The due date is shown in the project details.

Duration The time between the start date and the completed date. Only active statuses
are considered to calculate the duration of the project.

When the project is not completed, the duration is the time between the start
date and the current date/time.

Time Left This is the time between the actual completion date and the Due Date. When
there is no due date, the time left is not shown as it is not relevant.

When the project is in progress, the Time Left is the time between the due date
and the current date. When the current date/time is still before the due date, the
project is not overdue.

In this case, the time left is a positive number, indicating that there is still time
remaining before we reach the due date.

When the current time is after the due date, the project is overdue. In this case,
the time left is a negative number, indicating how much the project is overdue.
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How to find Project Status Duration
You can also find the Duration metrics on the time spent in a given stage of the project. Projects
statuses can reoccur multiple times and you can compute the duration of time in each of the given
status.

 

 

Field Name What it means

Project Status Started The start date of a project Status is the first time the project was set in the
selected status.

Project Status
Completed

The completed date of a project Status is the last time the project was in
the chosen status before it was changed to a new status.

Project Status
Duration

The project status duration is the time that the project spent in the selected
status. It is the sum total of all the time the project was in a particular
status. When the project went into the selected status multiple times, the
duration is the accumulated time the project spent in the selected status.

In this field, you can filter on the duration in days of the selected status.

Project Status Time
left

It is the time the project was in the Project Status. When there is no due
date, the time left is not shown as it is not relevant.

When the project is still ongoing, the Time Left is the time between the
current date with the Project Status Due. When the current time is before
the Project Status Due, the project is not overdue yet.

When the current date is after the Project Status Due, the project is
overdue. In this case, the time left is a negative number, indicating how
many days the project status is overdue.

For example: Let us assume that

Day 1:Jan 01 00:00 till Jan 02 00:00 => Project was in StatusA.

Day 2: Jan 02 00:00 till Jan 03 00:00 => Project was in StatusB.

Day 3: Jan 03 00:00 till Jan 04 00:00 => Project was in StatusA.

Project Status Started of StatusA is Jan 01 00:00 (first time project was in StatusA)

Project Status Completed of StatusA is Jan 04 00:00 (last time project was in StatusA)
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Duration of StatusA is 2 days and Status B is 1 day

4.10.  Project and Document Security

Project Managers secure projects by setting permissions for users and groups on a project as a whole,
and on folders within the project. They can set and change permissions at any time.

Permission types
The permissions for folders and documents are:

• View: This permission allows viewing the project and the list of files and folders in the top level. All
users and groups invited to a project get the View permission automatically at the project level.
At the folder level, View allows a user to see that the folder exists. View permission is required
for a project or document to be listed in the Search results. It takes precedence over all other
permissions; if a user does not have View permission, nothing else is possible.

• Add: This permission allows adding a new document to a project or folder by using Add, Copy, Copy
as Link, or Move.

• Change Properties: This permission allows changing database information about a document
or project. Project Managers have implicit permission to change the database information about
projects they manage.

• Delete: This permission allows the removal of a document from a project or folder. This permission
is also needed to Move a document out of a project. Only Project Managers or members of the
Admins group may delete a project.

• Download: This permission allows downloading a project or document from the database to a user’s
computer. This is also required to open documents other than an Esko ArtiosCAD 2D or 3D view, or
those viewable in the WebCenter Viewer.

• Lock/update: This permission allows the locking of documents and the subsequent uploading of
new versions.

• Start/Stop Approval: This permission allows starting and stopping approval cycles.
• Change Approval: This permission allows the user to change the approval setup.
• Change Task: This permission is only available for WebCenter

setups including task management. It allows users to create and change tasks. You can only set this
permission at the project level, not at folder level.

• Change BOM: This permission allows the user to change the Bill of Materials (Administrators and
the Project Manager can always change the Bill of Materials). You can only set this permission
at the project level, not at folder level. See Who Can Edit the Bill of Materials? on page 458 in the
Administration Guide for more information.

How permissions are inherited
Documents that are not in a sub-folder inherit project permissions. By default, folder permissions are
inherited from the project, but they may be overridden by the Project Manager as desired.

If a user is invited to a project, and is also a member of an invited group, then group permissions for
that user are ignored, and only the individual permissions for that user are considered.

If a user is not invited to a project, but is a member of a group that is invited to the project, the group
permissions are used.

If the user belongs to more than one group that is invited to the project, the permissions are combined
and the user gets the most permissive security setting available.
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Permissions and groups: an example

For example, user USER1 is a member of GROUP1, GROUP2, and GROUP3. PROJECT1 has GROUP1 and
GROUP2 as invited members, and GROUP3 is not invited. GROUP1 has Change Properties granted
and GROUP2 has it denied, and it is not set for GROUP3 because GROUP3 is not an invited member.
USER1 is able to modify database information about PROJECT1 because it is granted through
GROUP1.

Project Managers and Admin group members
Members of the Admins group have full permission to access everything.

Project Managers have full permission within the projects they manage.

4.10.1.  Set Security on a Project

1. Log in as a Project Manager or Project Creator.
2. Open the project.

Note:  The project should have folders created and members invited already.

3. Click the Security tab.
 

 
4. To set/edit the project permissions: choose Project from the menu and check or uncheck the

desired permissions for specific users, user groups or roles.

When you first enter a project’s security menu, this menu is selected by default. Project level
security controls access to the project and whether the contents of the project documents folder
are visible and searchable. A checked item indicates a granted permission; no check indicates a
denied permission.

Note:  View is automatically granted upon invitation to a project. View permission to the root of a
project cannot be denied for an invited project member.

Tip:  To grant or deny all permissions, check or clear the Full Permission checkbox. The changes are
effective immediately.

5. Set folder level permissions:
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a) Click Folders.
b) Select the folder to change from the Permissions for folder list.
c) Check the checkbox in a column to grant it to the user, group or role in that row; clear the

checkbox to deny it. To revert to default project permissions, click Reset.

Tip:  To grant or deny all permissions, check or clear the Full Permission checkbox. The changes
are effective immediately.

6. Set the user specific permissions:
a) Choose Users.
b) Select the user whose permissions are to be modified in the Permissions for user list.
c) For Project and folder permissions, check the checkbox in a column to grant it to the user or

group in that row; clear the checkbox to deny it. To revert to default Project permissions, click
Reset.

Tip:  To grant or deny all permissions, check or clear the Full Permission checkbox. The changes
are effective immediately.

7. Set group level permissions:
a) Choose Groups.
b) Select the group whose permissions are to be modified in the Permissions for group list.
c) For Project and folder permissions, check the checkbox in a column to grant it to the user or

group in that row; clear the checkbox to deny it. To revert to default Project permissions, click
Reset.

Tip:  To grant or deny all permissions, check or clear the Full Permission checkbox. The changes
are effective immediately.

8. Set role level permissions:
a) Choose Roles.
b) Select the role of which you want to modify the permissions in the Permission for role list.
c) The changes you make in this section define what the default permssions to be used when you

assign a user or group to this specific role. Any changes made here will not affect users and/or
groups that have already been assigned to the role.

4.11.  Reassign a Project to Another Project Manager

Projects may be reassigned to other Project Managers as long as the current Project Manager is not an
Approver in ongoing Approval Cycles in that Project.

1. Log in as a Project Manager or Project Creator.
2. Open the project.
3. Click General Information.
4. Click Manager. WebCenter performs a dependencies check for the current Project Manager being

an Approver on ongoing Approval Cycles. If it finds any, click OK, stop the Approval Cycle(s), and
retry changing the Project Manager.

5. Assuming there are no dependencies, filter or click Go to generate a list of Project Managers.
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This list can also include user groups.
6. Click the name of the new Project Manager or group and click Finish. The new Project Manager’s

name will appear on the General Project Information page.

To reassign more than one Project to another Project Manager, generate a list of projects either
by searching or by using an item on the main Projects menu, and then click Change Manager in the
Actions menu. Filter or click Go! to show the list of Project Managers, select the desired Project
Manager, and click Finish.

Admins can change Project Managers for more than one project at a time using the Projects menu in
Project Management on the Admin menu.

While they can select projects with different Project Managers, they may only assign all the projects to
one Project Manager.

4.12.  Create a User

Attention:

As a Project Manager, you can only create other users if the Admin granted you the User Can
Create User privilege.

For more information about this privilege, see "Create a User" in the Administration Guide.

1. In the Create menu, click Create User.

Step 1: User Info in the Create New User wizard appears.
2. Type the basic user information into the appropriate fields (Username, First Name, Last Name...).

Note:  Required fields are indicated with an asterisk *.

3. Provide the user’s initial Password and confirm it.

Enable the option Require the user to change the password at first login to force the user to
choose a new password when they first log on to the system.

4. Do you want this user to see custom menus instead of the default WebCenter menus?
Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. For more information, see "Menus Preferences" in the Administration Guide.

• If yes, choose the menu to assign to the user in User Menu.
• If no, leave Default in User Menu.

5. Click Continue.
6. In Step 2: Assign to a Company, optionally select a company to which you want to assign the user.

Note that this can be very important to filter the content and users the new user will be able to see.
7. Click Finish.

Your user is created.
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4.13.  Editing Users and their Preferences

4.13.1.  Edit a User

1. In the My WebCenter menu, click My Users.

This shows all the users you have created.
2. On the My Users page, filter the list of users if desired, and click the username of the user to edit.

The Profile page appears.
3. Make the required changes:

To edit the user’s... You should...

user info edit the fields on the Profile page.

menu select a different User Menu.

Note:  Users linked to a company will always
see the menu assigned to the company, even
if they have a different menu assigned to them
individually.

company or location 1. Click the Company/Location link on the
Profile page.

2. Select a new company and click Finish.

4. Click Save to confirm.

4.13.2.  Change the Password for a User

1. In the My WebCenter menu, click My Users.

This shows all the users you have created.
2. On the My Users page, filter the list of users if desired, and click the username of the user to edit.
3. Click Password to show the Password page.
4. Type a new Password and confirm it.
5. Click Change to save the changes.

4.13.3.  Set the Preferences for a User

1. In the My WebCenter menu, click My Users.

This shows all the users you have created.
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2. On the My Users page, filter the list of users if desired, and click the username of the user to edit.
3. Click Preferences to show the Preferences page.
4. Configure the Preferences as needed. For more information on the settings and options, see

General Preferences in the Administration Guide.
5. Click Save to confirm.

4.13.4.  Copy Preferences to Users

Use this to quickly copy previously defined preferences to one or several users.

1. In the My WebCenter menu, click My Users.

This shows all the users you have created.
2. Select the user(s) whose preferences you want to change and select Apply Preferences in the

Actions menu.
3. In the Apply Preferences popup, select the preferences to change, and deselect the preferences to

keep.

Other Preferences are the user preferences not mentioned above (for example: show thumbnails or
not, search results layout, etc.).

4. Select who you want to copy the preferences from: in Take Preferences From, select another of
your users, or select Default to use the default settings for the preferences you selected.

5. Click OK.

4.14.  Discussions in WebCenter

You can start a discussion in WebCenter, in a Project, Task or at a Document level. It facilitates
members of the project to have conversations, which improves collaboration and faster decision
making.

You can view the conversations in the Project or Task or at the  Document level in the Discussions
Tab. Discussions can be with all the members or private conversations with few or one member of the
project.

You can view and respond to discussions on My Work and Search Results dashboard pages if enabled.
You can also view and respond to discussion pertaining to the document in the HTML Viewer.

4.14.1.  Start a New Discussion

New Discussions can be created in Projects, Documents or in Tasks that has discussions enabled. Any
user can create new discussions.

• To Start New Discussion in a Project:
a) Navigate to Project Details  > Discussions Tab. You can view the Discussions for Project,

Document and Task in separate sub tabs.
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b) In the Discussions panel, click  to Start New Discussion. A message panel is opened in which

you can enter a relevant subject.
c) Add the members to the Discussion by selecting from the drop down list in the Visible To. By

default, the discussions are visible to all members in the project including the Project Manager.
Refer to point 4 in the note below.

d) Write a relevant Subject line and type the message in the message panel and Post the message.
• To start a new discussion in a Task:

a) Ensure that the Task Type chosen for the task is enabled to have Discussions.
b) Navigate to Project Details > Task .
c) Click Discussions > Start a new discussion.
d) Add the members required for the Discussion by selecting from the drop down list in the Visible

To.  Refer to point 4 in the note below.
e) Type the message in the message box and Post the message. Now this message is visible in the

Discussions.
• To start a new discussion on Documents:

a) Navigate to Project Details > Documents
b) Click Discussions > Start a new discussion.
c) Add the members required for the Discussion from the drop down list in the Visible To. By

default, everyone allowed to view this document is part of the discussion on the document.
Refer to point 4 in the note below.
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d) Type the message in the message panel and Post the message. Now the discussion is visible in
the document to all the users who have permission to view the document.
Discussions on document can have members from other projects, if the document is part of
other projects.

Note:

1. Discussions can be deleted only by the Admin User or the Project Manager or the Discussion
Owner.

2. Project Manger can view all the private discussions in the Project or in the Documents or in tasks
within the project.

3. Any discussion can be made read-only either while creation or any time during the discussion by
the owner of the discussion or the Project Manager or the Admin user.

4. When a new Discussion is created, it is possible to have the default participant as the Discussion
creator which can later be edited to add the required members. This feature is enabled based
on the Admin User's choice in the Preference page. You can enable notifications when a new
member is added or deleted in a discussion.

4.14.2.  Post a Message in Discussion

Any user who is part of the discussion can post a message.

1. Go to the Discussions tab in Project.
2. Select the Discussion, where you want to add a message.
3. Enter the text in the Message box and click Post.

When hovering on any message, you can get an option to quote the post and to mark the message
as unread. Discussion owners, Project Managers and Admin Users will get an option to delete the
messages.

Tip:  Depending on the setting for Notifications in the Project, notifications are sent when:

• Discussion Started
• Discussion Deleted
• Discussion Message added
• Discussion Message deleted

Discussion editor is equipped to handle texts from languages which are written from right to left.
Enable the right to left or left to right buttons to change the direction of text.
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4.14.3.  Viewing Messages in Discussions tab

The Discussions tab label displays the numbers of Discussions and on hovering over the label you can
view the number of discussions in Project, Documents and Tasks.

Note:  When there are unread messages, the badge has a different color.

 

 

In the Discussions tab, you can view discussions filtered and displayed in four tabs on the left for All,
Project, Document and Task respectively. The Discussion with the most recent message is displayed
in the message box.
 

 

Menu Options in the Discussions Tab

Use To

Filter the discussions based on what you are watching, or marked as
unread or discussions started by you. You can choose one or more or
none of the options to filter.

Note:  You can also filter out using Show Only options. You can
filter out discussions based on what is being watched or unread or
direct discussions or discussion started by the user or as a direct
participant.
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Use To

Add a new Discussion

Watch all Discussions or reverse it.

Mark all the Discussions as read or reverse it.

Print the discussion which is currently visible.

Watch the current discussion. The discussion subject also displays
this icon to indicate the discussion is being watched.

View Participants in the current discussion in a sub tab with their
online status.

Note:  You can filter to view only direct Discussions.

Special characters in the Discussions

Use To

@ Mention a User, Group or Role in a message. The User, Group or Role
will get a notification of the mention in the message.

# Link to the Project or Document name mentioned

Discussions during Delegation
Users sometimes delegate their work to other users and in such circumstances the delegate can also
be part of discussions for the delegator. Read more about delegation here. Discussions Read-only

Admin Users, Project Managers of the Project where the discussion is in and the owners of the
Discussion can make the discussion read-only. In read-only mode, a normal user cannot add a new
messages or quote any message. The owner of the discussion also cannot add or edit the users in the
discussion nor delete the individual messages.

4.15.  Task Management in WebCenter

Task management adds a complete time perspective to your Projects. WebCenter facilitates
timeliness by adding extensive notifications on the tasks. The task searching and overview pages
facilitate follow-up, finding critical and overdue tasks and creating reports.

Task Management allows adding tasks to WebCenter Projects and assigning these tasks to Project
members.
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Tasks have due dates, start dates and estimated dates. Tasks also have a specification and a checklist.
In addition, you can link documents with tasks and organize a discussion forum around a task. Finally,
tasks have statuses.

Note:

Task Management is an optional feature of WebCenter. If you did not purchase the Task Management
license, you won’t be able to create tasks or task types and these features won’t appear in your user
interface.

4.15.1.  What You Can Do with Task Management

A task is work (or part of the work) that you assign to a project member with a specific due date. A
task has a name, a description, a status, due date, estimated date, starting date, a specification, a
checklist and a discussion forum. Use tasks to:

• assign human tasks to project members, groups or roles:

The assignees or group of assignees will get a notification by e-mail and via their To Do list. You can
describe the task via the task description (free text), the task specification (structured data) or via
the checklist.

You can restrict the task type to a dedicated Main Assignee.

• create task sequences:

You can connect the tasks in a way to launch the next task automatically on completion of the
preceding task. Alternatively, you may set a delay to start the task automatically. This feature allows
you to build automated workflows that flow from one project member to another.

You can also set the Project Status to be completed when the tasks are completed.

• monitor critical tasks:

Use the Gantt chart to view the tasks in their time line. You can monitor the status of the critical
tasks according the project delivery time line.

• project definition:

Define what parts constitute a project. These parts can be human tasks but can often also be
physical components to deliver, for example all the parts of a complex box. Each part can have
a different due date. You can use the specification to define length, width, depth or any other
parameter. You can upload the digital files representing this component to the task representing
this physical delivery.

• Create a project plan according to a project plan template. This allows making a plan with multiple
steps that are shifted in time. You can re-use timings from a previous project to create estimates
from where you can start refining.

• Keep track of quotes or projects in an initial state.

• Organize your own To Do list.

4.15.2.  Basic Concepts of Task Management

Task
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A task is a piece of work you assign to a project member to be done before a certain due date. A
task has a name, a description, a status, due date, estimated date, starting date, a specification, a
checklist and a discussion forum.

Only the name and due date are needed, the rest can be omitted if they are not interesting or needed.
Tasks have a task type.

A task lives in a project. A project can have multiple tasks but a task cannot be in more than one
project at the same time.

Task Type

Task types are templates for tasks. Task types are global for the WebCenter system. Each task follows
the task type from which it was created.

The task type contains:

• Estimated duration of the task.
• List of statuses for the task.
• Specifications. This is a set of parameters you want the task creator or assignee to enter into the

system (they can be required, in which case the task will not be completed if they are not filled in).
• Checklist. This is a set of items you want to assignee to check off before completing the task.

Optionally, the system can enforce this.
• Documents. This is a set of parameters that defines whether you can add or even have to add a

document.
• Discussions. You can allow to start a discussion in your task.
• Workflow. In this section you can create a complete workflow using different task types and other

nodes.

Specification
A parameter for a task. Specifications work much in the same way as attributes. The list of
specifications is determined by the task type.

Due Date

The date and time by when a task must be completed. Due dates are visible in all task overviews. Due
dates are mentioned clearly in the notifications sent to the person to whom the task is assigned.

If the task is not completed on the due date/time, the assignee will get a reminder. Tasks going
overdue are flagged in red in the task overviews and search results.

Estimated Date
The estimated date is a date and time filled in by the task assignee. It gives the best current
estimation of when the task will be finished.
Estimated dates are allowed to fall before or after the due date, but when they fall after the due
date, they will appear in red in the task overviews. Changing the estimated date will normally send a
notification to the Project Manager or task owner.

Started date
The date and time when the task changed status from Created to In Progress.

Assigned To

Tasks are assigned to project members. You can assign a task to one project member only (one user or
one role or group). You can also assign any task to yourself, which provides a way of notifying the other
project members that you will take responsibility for this task.
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Tasks can change assignees during their life cycle, in this way handing over the task or responsibility
from one person to another.

Allowed Assignee

You can restrict the tasks to have a pre-configured Allowed Assignee. This feature allows you to
restrict the tasks to a group or a role specified in the Project / Template as the only allowed assignee.

• You can specify a group or role as the allowed assignee of a task type. This allows you to restrict
the task assignment to a member of this particular group / role for all tasks derived from it.

• Alternatively, you can enable this feature in the task type and leave it unassigned (default to task
assignee). This allows you or the user to specify a particular group or role in the task.

Note:  This feature is restricted to administrator users.

Auto-delete

A task type can be configured with an option to automatically delete the task when it is completed
successfully. This option comes in handy when you want to keep the task overview page clean.

This is especially useful in the case of tasks specified in Rules. It is best to delete the Rule related
tasks automatically once they are executed.

Note:  The project history will keep a log of all the tasks that were created, started and completed
successfully. History will capture the task details at the time of task creation.

4.15.3.  Getting Started with Tasks

Create a Simple Task
The system comes with only one task type built in: Simple Task. This is a task with no document, no
specification, no checklist, and no estimated duration.

Use the Simple Task type to experiment with creating tasks before figuring out how to make task
types. Listed below is a procedure for getting started.

1. Open a project (or create one) and click Tasks.

Note:  If you don't have a Tasks tab, you probably do not have the Task Management license.

If this is a fresh project, an empty list of tasks appears.
2. Click Create New Task.
3. On the Create New Task page, select the Task Type. Since this is the first time you are using tasks,

select Simple Task from the Task Type list.
4. Assign the task to a project member or user group using the Assigned to list. For this first task,

select yourself.

Note:  If you assign a task to a user group in WebCenter, all members of this group will see the task
show up in their My Work pages, and they will all receive notification e-mails (if set up by your site
Administrator). Any member in the group can then take on the task and complete it.

5. Enter a Name and Description for the task. Fill in other fields as desired.
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6. Click Create.

You have created a simple task.

Use the Task List, Task Search and My Work Page
• Click Tasks to get an overview of the tasks in your Project.
• Create some additional tasks with different due dates and assignees. You’ll see a list of tasks

building up and you can start experimenting with the sorting options in the overview.
• Try a task search: click Search in the top menu, click Tasks and enter your search criteria.
• Now go to your My Work page. You’ll see all tasks assigned to you under My Tasks.

You’ll see the status and the due date. Due dates in the next 3 days will appear in orange and due
dates in the past will appear in red.

Completed tasks are shown under My Recently Handled Tasks.

Note:  If you cannot see My Tasks or My Recently Handled Tasks, go to My Work > Edit My Work
Setup to add them to your My Work page.

4.15.4.  Task Types

Use a Task Type to:

• Set up a template for a large number of tasks.

• Enforce structured specifications for tasks.

• Enforce a checklist for tasks.

• Add extra task statuses.

Note:  Task types can only be created by Project Managers with the User Can Create Task Type
permission, or by Admins.

The task types are also used in creating workflows in WebCenter. Read more in Workflows on page
894.

A Task Type can be either Manual or a Task Type with a Workflow. Both types can be added to a
workflow from the canvas.

The manual tasks require human intervention and they can be used as either individual tasks or as
workflow nodes.

Read also Task Types on page 962

Create a Task Type
Creating a task type demands some initial planning, certainly if you want to use specifications.

Attention:  All specifications you want to put in a task type must first be defined by an
Administrator.

To create a task type, do the following:

1. Click Task Types in the main menu bar. You will get an overview of the existing task types.
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Note:  If you cannot see Task Types in the main menu bar, you either do not have the User Can
Create Task Type permission set on your user profile, or you do not have the task management
license.

2. Click Add Task Type. This brings you to a wizard.
3. Enter a Name, an optional Description, Estimated Duration and Due Date Link. Click Create.

The Estimated Duration is used to calculate defaults for dates. We advise to only use the Estimated
Duration for tasks that really have a typical duration (overnight shipping, die creation…).

Due Date Link is an option to select a Date/Time Attribute, which can be set as the task due date.
You can also choose an offset value (plus or minus, in days and hours) to the attribute as due date.
The due date will always be in weekdays. Changing the attribute value in the project will change the
task due date.

Note:  By default, Saturday and Sunday is considered as weekend. However, it is possible to switch
the weekend days to Friday and Saturday. The due date calculation will ensure that the due date will
always be on a weekday. To enable this in your WebCenter system, contact an Esko Representative.

Enable Allow Changing Task Due Date Link  to allow users(with Change Task Permission only) to
change the attribute link in the tasks derived from this task type or can provide a fixed date/time as
task due date.

4. Optionally add Specifications and determine whether they are required.

Note:  If a specification is required, tasks of this type cannot be put In Progress before all required
specifications are filled out.

• If the Admin enabled Attribute is also a task specification when creating some attributes,
they will be in the specifications list. If desired, those can be used both as an attribute in your
projects, and as a specification for tasks.

You can then select Automatically update project attributes from task specifications so
that when the task assignee updates the specifications' values and completes the task, the
corresponding attributes' values are updated in the project.

• You can also select Assign roles from task specifications, if you want to use tasks created from
this task type to allow non-project managers to select users or groups (for example to invite
people, to assign tasks or approvals to users / groups).

See Example: Assign a Role using a Task on page 892 for more information.

Note:

You can also:

• Add Statuses to a newly created Task Type,

• Change settings related to task documents,

• Change settings related to task discussions.

• Add Custom Document Sources to the Tasks

Now that you have created a new task type, it is a good idea to try to create a task based on your new
task type.

Go inside a project, click Tasks > Create New Task, and follow the wizard.
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Save As Task Type

New Task Types from existing Task Types
You can utilize the existing Task Type by the option Save Copy As in the Task Type details page. You
can copy all the details of the existing task type and save it with a new name.

Note:  Users with permission to create task type can use this option.

System History Logs

All Task Type related events like

• Task Type General Info changed

• Task Type Specification changed

• Task Type Checklist changed

• Task Type Status changed

• Task Type Document changed

• Task Type Document Creation changed

• Task Type Document Rendering changed

• Task Type Discussion changed

• Task Type Workflow changed

• Task Type created

• Task Type deleted

are recorded and stored in System History. Read this page on how to access the records.

Edit a Task Type
1. Click Task Types on the main menu bar. You’ll get an overview of the existing task types.
2. Click the name of the task type. You’ll see an overview with the following tabs:

• General Info

• Specifications

• Checklist

• Status

• Documents

• Document Creation

• Discussions

• Workflow
3. Consult the following table to consider the impact of your changes to any existing tasks derived

from the task type:

847



4 WebCenter

If you change the task type's... Then...

Name Existing tasks derived from the type will display the new
task type name.

Icon Each task type can have an icon. This icon is used in the
Workflow canvas/gallery and is also used in the task list in
Projects. Click the Select Icon button to select a required
icon. You can also use filtering on the icon name. The files
with extensions jpg/jpeg, png, gif, bmp.

Dashboard Specify a Dashboard that can be used in

• ToDo Feed, or Selection Details blocks in Dashboards
for a visual representation of the Task and /or

• To view in Focus Layout for Task Search results.

Restrict Task to an Allowed
Assignee  option

In the General Info tab, you can enable the setting to
restrict task assignees to a particular role or group.

After enabling this option, you can:

• select an Allowed Assignee role or group.

• set Default to Task Assignee in the Allowed Assignee
field. Read more in: Restricting a Task to Project Roles
or Groups on page 863

Require Password to complete Task Enable this option in the task type, to get password
confirmation for the task completion. Tasks completed
with password re-entered, are specifically mentioned in
the project history.

Note:  Password requirement can be setup only for
manual tasks.

When this option is enabled, you can further specify

• Prompt for Password where only password is to be
provided

• Prompt for User name and Password where both User
name and password ha to be provided

• Prompt for username and password once, afterwards
only prompt for passwordwhere user name to be given
once and thereafter only the password to be provided

Perform full validation of Document
Attributes on User Task completion

Enable this option in the task type, to ensure that all the
mandatory values required in the task are all validated on
completion of the task.
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If you change the task type's... Then...

If all values are not found in either the task specification
or in task document then an error message is given.

Automatically delete Task when
successfully completed

This option, if enabled, automatically deletes the tasks
when they are completed successfully. This option comes
in handy when you want to keep the task overview page
clean.

This is especially useful in the case of tasks specified in
Rules where you do not want all the tasks in the Project's
tasks page.

Note:  The project history will keep a log of all the tasks
that were started and completed successfully.

Estimated Duration Existing tasks will not be changed in any way.

Specification Existing tasks derived from this type will be updated as
follows:

• If you add a specification, all tasks of this type will get
an extra specification.

• If you make an extra specification required, all tasks
not yet In Progress will enforce this specification.

Nothing will happen to tasks that are already In
Progress, or Completed, or any other state beyond
Created.

• If you delete a specification, it will be removed from
tasks not yet in progress. Information in there will be
lost. All other tasks will be kept intact.

• Read more in: Synchronizing Specifications with
Project Attributes on page 853

checklist items If you...

• Add checklist items: existing tasks derived from
this type and not yet completed will also get the new
checklist items. Completed tasks are not affected.

• Delete checklist items: they will be deleted from all
non-completed tasks. Information in these tasks will
be lost.

status If you...

• Add a status: it is added to all non-completed tasks.
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If you change the task type's... Then...

Note:  Tasks will not change status as a result of this.

• If you delete a status: it will not be applied to any
created tasks.

Document Creation Tasks created from this task type are presented with the
customized document upload options. Read the details
about this option in Document Creation Settings on page
165.

Each Task Type can have an icon. The Icon gallery stores icons for Task Types, Project Statuses and
WebCenter statuses.

You can add your own icons to this library as jpg/jpeg, png, gif or bmp images. The Project Statuses,
Task Statuses and Task Types can load icons from the icon gallery.

Icons between 15 and 30 pixels high and between 15 and 130 pixels wide appears without scaling.

The gallery allows filtering of icons by its name.

 

 

Task Specifications
Specifications work like Attributes and together in a Task Specification page, they act like an Attribute
Category. They are used for specifying tasks.

Note:  Specifications can be made by an Administrator or Project Managers with Create Task Type
permission.

System History Logs

All Specifications related events like
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• Specifications created

• Specifications deleted

• Specifications changed

are recorded and stored in System History. Read this page on how to access the records.

Create a New Task Specification

1. Go to Task Types > Specifications.

A list of specifications opens (this list can be empty if this is the first time you use specifications).
2. If your specification will be a restricted set (a drop-down list of items to select from), you need to

create this restricted set first. Click Restricted sets to do this.

Note:  The restricted sets are shared with the Attributes' restricted sets.

3. Click New Specification on the top right.
4. Enter information in the fields as appropriate:

In the field .. Fill In the ..

Name name of the attribute

(for example,Billable).

Description description of the attribute contents (for example, Indicates whether work
on this project should be billed by finance).

Type the type of the attribute. You can select from the drop down.

Document References are attribute-links pointing to different document
sources. When you select this option, you will have more options. Read
more in Create a Document Reference Attribute on page 364.

Floats are numbers containing a decimal point (e.g. 3.1415) and integers are
whole numbers (e.g. 42).

Rich Text attribute type allows you in entering long and/or rich text. You
can:

• add set of least 16 different colors.
• set the text bold and italic.
• use bullet and numbered lists.
• Heading up to four levels and also add tables.

In the Preview you will see the Rich Text editor. Click the Show Rich Text
Controls link to view the broad pallet of text options. The Project Managers
with change properties rights can add content from a document to the Rich
text editor window. Here, the text (also Chinese, special characters), font
types, bullet types, color, tables and headings are preserved.

Values choose either:

• Prompted if you want to allow the user to enter any value.
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In the field .. Fill In the ..
• Calculated if you want to use an ArtiosCAD formula to calculate the

attribute value (enter the ArtiosCAD formula in the field).

Note:  You should set Calculated attributes to  read-only as their values
are automatically updated from ArtiosCAD and should not be changed
by WebCenter users. To set the value of the calculated attributes during
upload, ensure that you have a default attribute category with the
calculated attributes for the ArtiosCAD documents.

• Restricted Set to limit the possible values.

Note:

• To choose a Restricted Set, it must be created before defining the
attribute (see Create a Restricted Set on page 303).

• Make sure that the Type of the Restricted Set is the same as the
attribute type.

• For Document Reference attributes, you will have only Prompted as
the value.

5. If you are creating a document reference specification:

Options Description

Values will be set to Prompted by default.

Versions and Revisions Use this field to point to the exact version
of the document you need as the document
reference link. This is especially useful when
you want to point to an approved version. By
default, it points to the latest version, but you
can set this to:

• Latest Version: When you select this, the
document reference link will be updated to
the latest version of the document.

Note:  When you update the referred
document, the document link will point to
the latest version regardless of the Change
Properties permissions in the Project >
Security tab.

• Selected Version: Use this setting if your
document reference link should point to
a certain version always. In this case, the
document reference will not be updated
to point to the latest version when a new
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Options Description
version of the reference document is
uploaded.

• Selected Revision: When you choose this,
the document reference will always point to
the latest version of the selected revision.

Note:  When you update the referred
document, the link will source the latest
version of the selected revision regardless
of the Change Properties permissions in the
Security tab.

Reference Category To apply a reference category to the document
reference, select from the drop down listing all
the attribute categories.

Note:  Rich text attributes and document
reference attributes cannot be used as
reference attributes.

You can use a reference category (which is an
attribute category) to assign certain attributes
to the document reference link. This is very
useful when the property is not linked to the
product or the component specifically. You can
use reference categories to specify properties
of the reference links.

Edit or Delete Specifications

• To edit a specification, click Task Types > Specifications. Click the name of the specification and
edit it as desired.

• To delete a specification, click Task Types > Specifications. Select the specifications you want to
delete and click Delete in the Actions menu.

Synchronizing Specifications with Project Attributes
You can use Task Specifications to ask project members to supply values for Project's attributes or to
assign Roles.

You can Synchronize Project attributes with Task specifications when the tasks are completed.

Note:

• While the task is running, project attributes and task specifications can be different. This is
indicated by the ! warning.

You can also assign a role using task specifications.
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1. Enable Synchronize Project Attributes and Task Specifications option to:

• automate the process of filling the Project Attributes if they are empty
• or to copy the values from Project Attributes to the Task specifications

Note:

• This function works without the user having the necessary Change Properties right at the
Project level. This allows you to give a user temporary permission to change the Project
Attributes.

• If the project attribute is blank, task specifications set in the previous sessions will be saved.

• The Specification values in the Task Execution Page will be filled with the Project Attribute
values when the Specifications are empty and when the Task Specification is read-only.

• When the task is completed, the changed Specification Values will be copied to Project
Attributes

• When a Task is saved without completing it, the new Specification value will be remembered,
but not Project Attribute Value will not be updated.

Note:  A warning sign will indicate that the Attribute values differ from the Specification value.
You can choose to change the Attribute value to the new Specification value.

2. Optionally, enable Update empty values. This option is only available when the Synchronize Project
Attributes and Task Specifications option is on.
This will result in clearing of the Project Attribute values if the corresponding Task Specifications
were left empty when the Task is completed.

Task Forms (Task Execution View)
You can fully customize your Task Execution Form (just like Project Creation Form  in WebCenter. This
way you can have a uniform customized look for a Task Execution Page. To configure a custom form,
you can combine Specifications with Task Properties in a dedicated Task Execution View.

1. Go to the Task Type's Specifications page and Add Task Execution View.
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Your Specification page will load all the default Task Properties in the default order.
2. Use << to remove Properties (just like Specifications). It is also possible to remove these properties

from the form, add them again or place them between the Task Specifications. You can customize
these properties just like Specifications. See Grid Layout.

Keep the following in mind when customizing Properties:

• You can show and hide fields or sections based on attribute values
• You cannot specify them as Read-Only or Required
• You can customize the label or image including their position (left or top).
• You can add Style to these Properties
• You can define the Column Span for them.

When the Task Execution view is defined in the Task Type’s Specification, this view (with custom Task
Properties) will be loaded on the Task Execution Page. When this view is loaded the whole page will
look like one continuous form.
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Note:  Use caution when configuring a Task form:

• If you remove the ButtonRow from the view, you will not be able to save the Task.
• If certain sections are not enabled, but are configured in the Task Execution View, they will not be

shown in the Task Execution View

Edit Terminology

It is possible to change the terminology used in Task Execution page so that it talks about "Designs"
instead of "Documents", or "Attributes" instead of "Specifications", for example...

Attention:  Your custom terms will not be automatically translated, and will show as you enter
them for all languages in which you run WebCenter.

You can achieve this by customizing the terminology in the Specification page of the Task Type. To edit
the terms:

1. Click Edit Terminology in the Specifications page

 

 
2. Specify the new terms next to the default terms.
3. Click OK.

Document Reference Task Specification
You can use a Document Reference Attributes as Specifications to refer to a document that is located
within another project or a document library. You can add documents to tasks this way as references
instead of copying them into tasks.

When you create such a task specification, select the specification type as document reference.

Note:  You can use your document reference attributes as task specifications if you have checked
Attribute is also a task specification.

Read more in:

• Document References on page 363

• Create a Document Reference Attribute on page 364

• Edit a Document Reference Attribute on page 368

• Copy Document References on page 402
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Edit Checklist
Checklists can be added to a task type. Checklist items can be things you want the operator to check
off before marking the task as completed. Another typical usage is to list subtasks.

Checklist items have no due dates but the system does track the day and user that checked off the
checklist item, in this way enforcing responsibility.

1. Navigate to Checklist tab in Edit Task Type.

• If you select Finish task if all steps from checklist are completed, it may not be possible to
complete a task of this type without having checked off all the checklist items.

• You can also decide that Only a task assignee can check off checklist items.
2. Choose Add checklist items  to open Add Check Items text box. Enter items and Finish to save.

Note:  You can create an empty checklist (with no checklist item) but in this case do not select
Finish task if all steps from checklist are completed, as otherwise tasks of this type can never be
completed!

Add Task Statuses
Tasks have three statuses by default: Created, In Progress and Completed.

Adding more statuses improves the accuracy of task progress. This comes in addition to the estimated
date.

The task status is reported in all task overviews. Task statuses can have high-quality icons. This allows
making these overviews much more visual.

Note:  Only Administrators can create task statuses but the task type owner can select task statuses
from the list.

Task statuses have a sequence and this sequence is automatically adopted by the task type.

• To create new task statuses, as an Administrator:
a) Click Task Types > Statuses > Add Status.
b) Type names of extra statuses and browse for an icon.

If you don’t add an icon, the name of your status will be displayed in the status column (so avoid
long names or use icons). Icons can be jpg/jpeg, png, gif, bmp file type. They are put without
any scaling in the task column so you should be careful not to use large icons. Good sizes are
between 15 and 30 pixels high and between 15 and 130 pixels wide.

Using wide icons allows showing progress very visually as in the example below:
 

 
c) Click Finish.

• To add task statuses to a Task Type, as a user with the User Can Create Task Type privilege:
a) On the Task Types page, click your Task Type.
b) Go to the Status tab and click Add Status.
c) Select the status you want to add and click Finish.
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Document Sources in Task Type
Use the Document Creation tab to setup the document creation settings. You can configure custom
document upload options (in Tasks) this way.

• Default

The default document creation options will be:

• Browse
• Copy
• New (when a template library is configured)

Note:  New document creation is only possible if a Document Template library is linked in this
template.Read more in: Create Document Templates on page 162.

• Custom

When you select this, you will see a list of customizable options:

Source Where the document will be sourced from.

Label The link description. You can create a custom label, such as Upload a
graphic file.

• Standard

• Simple

• Translated

Details Additional information such as:

• Allowed Extensions

• Document Template Selector

Here you can select the already specified document templates. Read
also:Document Templates on page 162

Operation The operation depends upon the Source button. For example, if you have
chosen Project+Folder, the operations would be Copy, Move or Link the
document

Sections The configured upload source is made available in these sections. By default,
all the options will be available and enabled. You can deselect the sections to
disable some of the locations.

• the Project Creation Documents

• the Project Creation Bill of Materials

• Bill of Materials

• Upload (Copy or Create Multiple Documents)
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Note:  You can also drag and drop multiple files onto an Upload button.

Target
Folder

The destination folder

When a task is created from this kind of a task type, you get custom upload options in the task
execution page.

Note:

If the task type does not have a document creation setup, the setup defined by the task’s project is
used as the upload options.

Define Task Documents Settings
Use the documents settings to define the relationship the tasks created from this task type will have
with documents.

1. Select Allow attached documents if you want to be able to attach documents to the tasks of this
task type.

Selecting this makes the other settings available. You can also customize document upload options
in the Document Creation tab. Read more in Create a Task Type on page 845

2. If the goal of the task is to produce one or more document, you can choose to Only allow task to
complete if it has one or more attached documents.

If the document(s) need(s) to be approved, you can also choose to:

• Complete task automatically when all documents are approved,
• Only allow task to complete when all attached documents are approved.

3. You can also select Start approval cycle on attached documents to start an approval cycle
automatically when documents are uploaded to the task.

This uses the approval settings defined for the project the task is in (or the folder the document is
uploaded into, if it has approval settings defined).

Note:  If neither the folder nor the project has approval settings defined, the approval cycle will not
be started automatically.

4. You can also choose to automatically Assign Attribute Category to uploaded documents. Select
the attribute category to use in the drop-down menu.

Note:  If the task has specifications that are also attributes, you can use this to assign those
specifications / attributes to the task documents as well.

Attention:  When linking documents that already have an attribute category to the task, the
existing attribute category will not be replaced by the one you select here.

5. If you want the documents to be uploaded to a predefined folder, you can enter the name of that
folder in the text field.

Note:  This default folder will only be used if there is a folder in the project with that name.
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6. If:

• the specifications used in the task are also attributes,
• those attributes are assigned to the document(s) attached to the task,

Select Automatically update attached documents attributes from task specifications to update
the values of the document(s) attributes with the values that the task assignee fills in for the task
specifications.

Note:  The update happens once the task is completed.

7. Click Save.

Define Task Discussions Settings
To allow project members to start discussions on all task created from the particular task type

1. Select Allow discussions. By default, this option is not selected.
2. On selection , Discussion Context drop down list is displayed. You can choose one of the following

options:

• Current Task : This is the default option enabled. The discussions in the task are created and
visible in the current task.

• Parent Workflow: If the task is part of a workflow, the discussions in the task are created on the
parent workflow. The discussions are visible in all tasks of the parent workflow with this setting.
The discussions are visible in the parent workflow task if the task type of the workflow has the
setting set to “current task” or if the workflow task has no parent.

• Root Workflow: If the task is part of a workflow the discussions in the task are created on
the top level workflow task of the task. The discussions are visible in all tasks in the workflow
that have this setting, and all first level child tasks of the root workflow that have the Parent
Workflow Discussion Context.

• Project: The discussions created in the task are Project Discussions. All Project Discussion are
shown in the task.

3. Choose the requisite option.
4. Select Show Discussions of Documents linked to the Task to view the discussion of documents

linked to the task.
5. Click Save.

Delete a Task Type
1. Click Task Types on the main menu.
2. Select the task type(s) to delete.
3. Click Delete in the Actions menu.

Note:  You can only delete task types that are not used in a task.
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Copy a Task Type
You can copy an existing Task Type. To do that

1. Click on the Task Type. From the Task type's details page, click Save as Copy
2. Specify a unique name.

The following details are copied:

• Basic settings of the task type:

• Description
• Estimated duration (days + hours)
• Restrict Assignees
• Automatically delete option

• Document settings, including the name of the default document category
• Discussion settings
• Checklist items + settings
• Specifications including the layout and the order
• Restricted Sets used in Specifications.
• Workflow
• Task Status List, including the name of the icons.

Note:  The icons are not copied.

• The Document upload configuration setup
• Document Rendering setup

4.15.5.  Working with Tasks

Create a Task
1. Click the Tasks tab in your project.

Note:  If you don't have a Tasks tab, you probably do not have the Task Management license.

2. Click Create New Task.
3. On the Create New Task page, select the Task Type.

To know how to create custom task types, see  Task Types on page 845.
4. Choose a Status among the statuses available for that task type.
5. Assign the task to a project member or user group using the Assigned to list.

Note:  If you assign a task to a user group in WebCenter, all members of this group will see the task
show up in their My Work pages, and they will all receive notification e-mails (if set up by your site
Administrator). Any member in the group can then take on the task and complete it.

6. Enter a Name and Description for the task.
7. If this task needs to start after another (already created) task, you can Add predecessor(s): hover

over Add predecessor(s) and select another one of the project's tasks as predecessor.

Repeat to add other predecessors if necessary.
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Note:  See Sequential Tasks on page 871 for more information on tasks' links with their
predecessors.

You can also choose to Automatically link documents from predecessor tasks when task is
started.

8. Define when the task is due: you can use a Lead Time or a Due Date.

Use Lead Time if you know how long the task will take, but haven't calculated a precise due date for
it (for example for a task in the middle of a project). This calculates the Due Date automatically by
adding the Lead Time to the current date.

Note:  The Lead Time only takes working days into account.

The Estimated field will be mostly used by the task assignee to indicate when he/she expect(s) to
have finished the task.

Note:  By default, Saturday and Sunday is considered as weekend. However, it is possible to switch
the weekend days to Friday and Saturday. The due date calculation will ensure that the due date will
always be on a weekday. To enable this in your WebCenter system, contact an Esko Representative.

9. Define when to Start the task:

• Choose Manually if you want the assignee to decide when to start the task him/herself.
• Choose Automatically at ... (due date minus lead time) to have the task start automatically a

certain number of days (the Lead Time) before the due date. This makes sure that the task is
automatically started when there is still enough time to finish it.

• Choose Automatically after predecessors complete if the task has predecessors, and you want
it to be started as soon as they are finished.

• Choose Automatically after predecessors complete and after ... (due date minus lead time) to
have the task start automatically a certain number of days (the Lead Time) before the due date,
but only after the predecessors are finished.

• Choose Automatically after project creation if you want the task or workflow to be started right
after project creation from a template containing this task.

Note:  If you are making the task start automatically, you can still give the assignee the option to
start it manually (select Assignee can start task manually).

10. If this task is crucial to the project, you can decide to have its completion change the project's
status (for example mark it as Completed).

Select Completion of this task changes project status to and choose your desired project status.
11. Click Create. When the task is created, a log is created in the project history with the Assigned to,

Lead time, Due Date, Estimated Date, Description.

Edit a Task

Note:  You need the Change Task permission to be able to edit a project's tasks.

1. In the project's Tasks tab, click the Edit link next to a task to go to the Task Information page.
2. Edit the task as desired and click Change.
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Note:  You can also edit the tasks assigned to you from the task execution page (see Working on Tasks
Assigned to You on page 866) by clicking the Edit Task Details link (if you have the Change Task
permission).

Restricting a Task to Project Roles or Groups
1. Create a Task Type.
2. In the Edit Task Type page, enable the option Restrict Task to an Allowed Assignee (Group or Role) 

in the General Information tab.

• After enabling this option, you can either select an Allowed Assignee role or group in the task
type or leave it as Default to Task Assignee.

3. Save the Task type.
4. Click Create New Task in the Tasks tab in your project.
5. Select the Task Type you created.
6. Choose a Status among the statuses available for that task type.
7. Select an Allowed Assignee (a group or a role). This will restrict the task to that specific group or

role.
8. In the Assigned To field, you can specify:

• the Allowed Assignee role or group. This field will list all the project members.
• the members of the Allowed Assignee role or group.

Warning:  If you specify an Allowed Assignee in the task type and select a different role /
group / project member in the Assigned To field, you will get an error while saving.

9. Click Create .
Your task is now restricted to the Allowed Assignee.

To change the Allowed Assignee, go to Edit Task > Task Information and select another role or group.

Note:  You need to be an admin user to be able to change the Allowed Assignee of the task.

Note:  If the Allowed Assignee role or group is specified in the Task Type, you cannot change it in the
Edit Task page.

Reschedule a Set of Tasks
Often, an entire set of tasks must change its due date. Some possible reasons are:

• The project is delayed.
• The project needs to speed up.
• A set of tasks needs to happen earlier or later in the project.
• The entire set of tasks was copied from a template or another project and it needs to be shifted as a

whole to be realistic for the current project.

Note:  You cannot change the due date of completed tasks.

To reschedule your project's due dates:

1. Open the project and select Tasks.
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2. Click the Schedule Tasks link.

You can see all due dates and lead times of the existing tasks but also their Estimated Finish Date.

 

 

This can differ from the due date because certain tasks are already overdue, or because due dates
were chosen without taking the predecessor tasks' due dates into account.

You can view the lead times in days only or in days and hours. When choosing days and hours, you
will be able to refine the scheduling to the hour a task should start or finish.

3. To change the due dates, you can either:

• Manually change the Lead Time of certain tasks (enter the New Lead Time and press Enter).
WebCenter then calculates a New Start Date (if the task isn't started yet) and a New Due Date (all
the dependent tasks are moved accordingly).

For example if your project is late, you can shorten some tasks' lead times to make sure it still
ends at the planned date.

Note:

• The Lead Time only takes working days into account.

• The fields in yellow show the tasks on the critical path. Those are the tasks that directly
influence the project's end date (the last task and its predecessors).

To make the project end sooner, you can shorten the lead times of the tasks in the critical
path (in yellow).

• Click Make estimated dates the new dates: this takes the Estimated Start Date and Estimated
Finish Date as New Start Date and a New Due Date.

Use this for example if your project is late and you want to update your planning accordingly.
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• Shift due dates with a certain number of days (select the tasks to change, enter a number of
days and click Try).

Note:  Selecting a task automatically selects its dependent tasks too.

You can use this if your project is late, or you can enter a negative number to speed the project
up.

• Shift due dates to have the latest ending on a certain date (select the tasks to change, enter
the due date of the last task and click Try). This will calculate how many days the latest task
needs to shift (to later or to earlier) and apply the same shift to all others.

• Shift due dates to have the first one starting on a certain date (select the tasks to change,
enter the start date of the first task and click Try). This will look how much the task with the first
starting date shifts and apply the same shift to the due dates of all tasks.

This would be typical for a set of tasks of which just one is started. This starting date allows
calculating the rest of the track.

Note:  You cannot move tasks to before Today.

• Re-distribute due dates to start on a certain date and end on a certain date (select the tasks to
change, enter the new start and end dates and click Try). This will compress the selected tasks'
lead times to fit within the given dates.

By default, the starting date is today, and the end date is the project due date.

Tip:  You can also use this to do backward planning by only giving an end date and disabling the
start date checkbox, or forward planning by only giving a start date and disabling the end date
checkbox.

4. If you are not satisfied with the changes, you can click Reset to go back to the original dates. You
can then Try to change the dates using a different method.

When you are satisfied with the changes, click Save. This will send an e-mail notification to the task
assignees (if this is configured).

You can also click Cancel to return to the task list without saving your changes.

You can also see your tasks in a Gantt Chart. You can display them by Day, Week or Month, and you can
choose to view the Original, Estimated or New dates.

 

 

Note:  You can also shift due dates from the project's Tasks page: select the desired tasks and click
Change Due Date in the actions menu.

Task Discussions
You can start a discussion on a task by clicking Edit Task Details then Discussions.
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Task discussions work in the same way as document discussions.

Read more on how to enable Task Discussion Enabling Discussions in Task Type on page 300

4.15.6.  Working on Tasks Assigned to You

To work on a task assigned to you, you can either:

• click the link to the task in the notification email you received,
• click the task name in the My Tasks section of your My Work page,
• in the project details page, click the Tasks tab then the name of the task.

This opens the task execution page.

 

 

Start a Task
• On the task execution page, click the Start Task button.

This sets the task status to In Progress.

Upload Documents to the Task
On the task execution page:

1. In the Task Documents section, click one of the options in the Task Documents section. You can
either:

• Upload a document saved on your computer or network (use Upload / Browse),
• Link a document already existing in the project to the task (use Link),
• Create a document placeholder from a document template (use New).
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Note:  This is only available if the project has been created from a project/template containing
document templates.

This is similar to the general upload document page. For more details, see Uploading a Document via
Upload on page 591.

2. Choose the project Folder in which to upload the document.
3. Click Change.

You can also Upload Multiple Documents (see Copy / Create Multiple Documents on page 595 for more
information).

Download a List of Documents from the Task
To download documents from the task execution page:

• Select the documents to download and click Download in the Actions menu.

• If you selected a single document (that you have download rights for), it will be downloaded
directly.

• If you selected several documents, you will get a ZIP archive containing all the documents you
selected and for which you have download rights.

Note:

• If you don't have download rights for any selected document, you will see an error message.
• If you selected CAD files as part of a multi-document download, they will be downloaded in

the native perspective.

Change the Task Status
When you are working on a task, you may want to change its status to reflect the task progression
(especially if the task was created from a task type with many precise statuses).

On the task execution page:

1. Choose the Status to give the task.
2. If the task contains a Checklist, mark some checklist items as done if necessary.
3. Click Change.

Complete a Task
Once you have completed a task, do the following to mark it as Completed in WebCenter.

On the task execution page:

1. If the task contains a Checklist, mark the checklist items as done.
2. If the task contains Specifications, fill them in as needed.
3. If the task type allows Discussions, you can add a comment if you wish.

Click Start a New Discussion if there is no discussion yet, or Reply if there is one, enter your
Message.

4. Click the Complete Task button.
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This sets the task status to Completed.

4.15.7.  Overview of My Group's Tasks

My Group's Tasks lets the Group Manager quickly view the tasks assigned to their group or group
members. It also allows to assign, re-assign, or distribute the tasks among the group members.

If a group member is ill or not available, the Group Manager can re-assign the task to an other group
member. A Group Manager can also monitor the progress on a selected Group or Group Member. Using
the filter options, the Group Manager can have a quick overview of the workload.

Group Task Manager
Every department has a Department Manager. In WebCenter Department Manager are referrred to as
Group Manager. A group can have any number of Group Managers including 0. Group Manager is always
part of a group.

A Group Manager likes to view the tasks assigned to a selected group or group members, which will
assist him in distributing the tasks and also get a quick view on the current status of a task.

The My Group's Tasks feature allows Group Managers to:

• View task assignments for a selected group and the workload overview.
• View tasks assigned to a group member and the workload overview.
• Re-assign any task assigned to a group member.
• Review the task overview filtering on status and due date.

Using My Group's Tasks
To access My Group's Tasks feature, log in as Group Manager. Click My WebCenter > My Group's Tasks
to view the Group Tasks for Group page.

Viewing Task Assignments
You can view the tasks assigned to a selected group and also for a group member within the group.

1. The task list for assigned group appears.

Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. In the Tasks assigned to drop-down list box, select the group or group member for whom you want
view the task assigned.

3. A task list assigned to the selected group or group member appears. Also in the list are:

• Task Name
• Project Name
• Assigned to
• Status
• Lead Time
• Due Date
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• Created Date
• Started Date
• Estimated Date
• Task Documents

Viewing a Workload Overview
During editing/re-assigning, the Group Manager can have an overview of number of tasks assigned and
how many are overdue. The Task Count is the number of assignments assigned to a group member. The
Task Count displayed is based on the filtering criteria and tasks with past due-date always appears.
The non-active projects do not appear and are not counted.

1. The task list for assigned group appears.

Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. The workload overview appears for the selected group.
 

 
If the task is past the due date, it appears in red.

Reassigning a Task
A Group Manager can re-assign a task to a group or a group member. A task can be re-assigned only to
a group member within the same Group. In addition to this when the task is reassigned, the WebCenter
UI displays the previous assignee in Previous column.

1. Note:  Ensure to log in as Group Manager.

1. The task list for assigned group appears.

Note:  If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. Select the new assignee in the Assigned to drop-down list box. This list contains group and group
members name.

3. WebCenter shows changed tasks with a yellow background indicating the change.
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Note:  Even if a task is not initially assigned to a group, the Group Manager has all the rights to re-
assign the task to a group member.

4. Click Save to commit the changes.

Filtering Based on Task Status and Due Date
A Group Manager manages multiple tasks at a time and this might lead to delay. Using the Search
Tasks Status, one can see tasks in a more specific status.

For example, you can filter the tasks which are in Completed or In Progress status. By filtering the
task, a Group Manager need not re-assign completed tasks or tasks which cannot start because a
predecessor is not complete.

Similarly the tasks can also be filtered by Due Date. This gives a Group Manager a quick view of the task
for the required time line. Using this information Group Manager can view what is due this week or this
month to make the required planning.

1. Note:  Ensure to log in as Group Manager.

1. The task list for assigned group appears.

Note:  If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

2. In the Search Tasks Status drop-down list, select the desired task status.
3. In Due Date, select the required due date and then click Go.

Note:  To set the Due Date filtering, setting a task status filter is not necessary. The Due Date
changes to completion date, if the task status is filtered to completed.

The following are the default due dates settings available:

• All
• Today
• Next 3 days
• Next week
• Next 2 weeks
• Next month
• Next 3 months
• Overdue
• Week overdue, all the tasks which are overdue for less than five days.

Filtering Based on Column
By clicking a column header, the Group Manager can view tasks for a selected group in ascending or
descending order.

For example, if Due Date is selected then the tasks for the selected group appears with the earliest
due date. Similarly if Due Date is clicked again, then the tasks for the selected group appears with the
latest due date.

1. Log in as Group Manager.
2. The task list for assigned group appears.
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Note:  If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

3. Click a column header, for example Due Date, to sort on this column.
The sorting is indicated by an arrow. For example, if Due Date is selected then it would appear as:
 

 

4.15.8.  Sequential Tasks

What is a sequential task?
Tasks can be made dependent on each other. You can define predecessors for a task, which
automatically chains tasks to each other.

For example, if you create a “Review the final design proposal” task for a member, and then add a
second task called “Implement design corrections” that has the “Review” task as a predecessor, you can
make sure that the “Implement design corrections” task starts automatically when the “Review” task
has been completed.

Starting tasks: options
Tasks can be set to start:

• Manually (the member changes the task status manually).

• Automatically, depending on the due date and lead time (in working days).

• Automatically, depending on the completion of the predecessor task(s).

Note:

If the Due Date is different from the Due Date of the predecessor plus the Lead time (i.e. the
earliest the task can be finished), the Reset Start Date button will appear. Clicking this button will
set the Due Date to the Due Date of the predecessor plus the Lead Time.

This option is only available if the task is in Created status, and if the Start Task is set to
Automatically after predecessors complete.

• A combination of the above options.

Also, task completion can change the project status.

4.15.9.  Linking Documents to Tasks

One of the strengths of Task management is the ability to link documents to tasks.

Documents always sit in a folder in a project. The link to Tasks is optional and comes on top of the
positioning inside a folder.
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Note:  If a default folder was defined in the Task Type setup, new files will automatically be uploaded to
that default folder. The user can still change the folder manually in the upload dialog.

You can also attach a document table to your Task Type. This gives you multiple referenced documents
in the Tasks. You can use the Document Rendering on page 873 tab to attach multiple documents (for
example, a copy sheet) to a Task Type's tasks.

Why Link Documents to Tasks?
Linking a document to a task gives purpose to the document. Without task management, the purpose
of the documents in a project is implicit. You typically figure out what they represent through their
name, through their Attributes, or through the name of the folder they are in.

Most documents linked to a task are one of the following:

• The result of the task. Creation type tasks end normally with a digital asset resulting from the
creative work. Good examples are ArtiosCAD .ARD files, or PDF files etc.

• The “current state” of the task. When the task is not yet completed, you can already show what you
have by linking the current version of the document to the task.

• A specification as a separate file. Although tasks can have structured specifications, it is possible
that you want a complete document to specify the task. You can then upload that document and link
it to the task.

• The input for a task. Creation of graphics for packaging demands a definition of the cutting shape.
So you can link the .ARD file to the graphics creation task or upload it to the task.

• Collateral information.

Tip:  Documents can be linked to multiple tasks. A typical example is where the same document is the
result of a first task and the input for a second task.

Documents Tab
In this tab, you can configure how documents are handled in a Task Type. See the options below:

• Allow Attached Documents: Enable this option to allow attached documents.
• Show link to Multiple Upload: This option is to streamline handling of tasks that do not require any

documents. It is common when a task is used to fill specified values (specifications) and/or fulfill
defined checklist only.

Upload Multiple Documents  : Disable this to hide the button from the task execution page.

Note:

• Only allow task to complete if it has one or more attached documents: When this is checked, you
have the extra options:

• Complete task automatically when all documents are approved
• Only allow task to complete when all attached documents are approved

• Start approval cycle on attached documents
• Assign Attribute Category to uploaded documents
• Automatically update attributes for attached documents from task specifications
• Set default folder for uploaded documents
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Link a Document to a Task
There are multiple ways of linking a document to a task:

• From the documents overview, select the document(s) and click Link to task(s) in the Actions
menu. This allows you to quickly associate multiple documents with multiple tasks

• Within the task details, click the Documents tab and then click Link document(s) in the grey bar.
Select the document(s) to link.

• You can directly upload a new document to a task. In the task details, click Documents and then
click Upload Document. This will give you the well-known upload dialog, but you will immediately
create a link to this task.

Find Documents Linked to a Task
• In the task, click Documents. This shows what documents are linked to this task and it also shows

their version, description and approval state.
• In the tasks overview, there is a Task Documents column showing the names of the documents

linked to this task. Clicking a document name brings you to the document.
• In the documents overview, there is a Tasks column. Clicking a task name brings you to the task.

Document Rendering
You can create Custom document rendering options in a Task Type's Document Rendering tab.

There are two options in this page.

• Default (this is selected by default). See the example of a Default Rendering:
 

 

• Custom
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To create a customized document table in the Task Type:

• Enable Allow Attached Documents in the Documents tab. This option is disabled by default.
• Select Custom in the Task Type > Document Rendering tab to configure the document table.

The options available are exactly the same as Document Reference Rendering. Read details about
the options in the document references section.

• Configure your table options.

You can attach a copy sheet in a task type this way. This allows you to send a copy sheet to edit,
translate or approve in a task (therefore automate it in workflows). If you are attaching a copy sheet,
also configure options for Text Documents.

Note:

You can configure Master Text and Translation Text widgets to appear in the Text document table.

Read more in:Creating a Copy Sheet on page 388

• Remember to Save. Only then it takes effect.

Documents section of all tasks created from this Task Type (old and new) are affected by the changes
saved on this page. See an example of a Task Document Rendering (Artwork with its copy sheet) below.
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Create an Advanced Table Rendering
Adding an advanced table of document references allows you to customize the way your document will
be shown to users when they are applied (For example, in a template).

It also allows you to configure advanced features such as making an attribute of the document
required or read only.

Note:  The document reference attributes will inherit the style specified in the attribute category.
This style is further expanded to the individual document's attributes as well.

• Click Use Grid Layout in the Edit Category page. Add your document reference attributes.

 

 
• Select the Rendering as Table in the grid layout.

In the Edit Render Configuration dialog, you can set up the advanced rendering.

Note:  You can create custom tables  for your different views.
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• Enable Hide Header if you do not want a header row in the document references table. The labels
will be displayed in line for each document.

• Enable Allow Bulk Operations when any action performed on the document reference is also
cascaded to all the references which are made to that particular document reference. Actions
performed on the document reference could be to

• Remove a Referenced document which removes all the document references in the tree
structure

• Replace and Undo
• Getting document to Local and Undo action
• Upload a new version and/or edit a text statement
• Update to the latest version

• Enable Limit Bulk Operations to Document References with matching Operations configured,
when you want to perform bulk operations on document rows which are filtered based on document
sources and actions configured for them. Read more about bulk operations.

User is informed about the number of rows the bulk operation will be really performed (after
filtering) in the specific bulk operation modal dialog.

 

 
• Enable Open Links in new Tab , to open any link in the document reference in a new tab.
• Click Add Column to add more columns to the table.

The rows in the Edit Render Configuration pop-up correspond to your document reference
columns.
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• Select Type as Document Name which is a mandatory field. In the Details section, you can disable:

• Show Document Source
• Show Document Description
• Show Folder
• Show Document Template

Your rendering will have a hyperlink to the document depending on the user permissions. These
options are additional details added to the document and can be viewed only when a new document
is added.

 

 

The name will not be a hyperlink for users without document view permissions.
• Depending on how your document properties should be rendered, configure the table columns. You

can create custom Labels for your selections. The properties will be displayed as read-only.
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Choose Document
PropertyDetails as...

The result in the rendering table will be...

• Description

• VersionRevision

• VersionAuthor

• Project

• ApprovalStatus

• ApprovalStage

• ModifiedDate

• Thumbnail

Tip:

• Create custom labels

• Specify the pixels for
your thumbnail.

• Check the box Allow
uploading a new Version
button

The selected document properties will appear in the table
header with the custom label. For example:

• the current Approval Stage of the document. The user can
click to access the approval pop-up.

• Clickable thumbnail of the document with the default
(50x50) or specified pixels.

• Upload New Version  if you have the rights to upload will
be available in theVersion column.

• You can configure document actions in the table rendering of the document references.

The actions will appear next to the documents listed in the table only when it is relevant.

Choose Document Actions as... The result in the rendering table will be...

• View

• Open in 3D

• Open in ArtiosCAD

• Download

• Upload New Version

• A 3D  button will be available only when
there is an existing 3D perspective.

• Open in ArtiosCAD option will be available
for CAD files. Clicking on it will open the CAD
document as set up in the preferences
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Choose Document Actions as... The result in the rendering table will be...
• Update to Latest Version • Download option will be available when the

user has download permission.

• Upload New Version: This is available when
the user has the rights to upload new version.

Note:  The Upload New Version  button
can also be placed in the Version column by
checking the Allow uploading a new version
check box.

• Update to Latest Version: Allows user to
update to the latest version

Note:

• If you change the attribute values during the upload of a new version, these are only applied on
the new version of the document. The previous version will have the old attribute values.

• If a document version is linked in multiple projects, all linked projects will get the new document
version.

• If the configured columns do not fit in the table, the table will assign each column its minimum
width and show a horizontal scroll bar.

• Configure how your Document attributes should be displayed. Select the relevant attribute from
the drop down as a specific column (with a custom Label) in your table.

 

 

Specify the Visibility of the
attribute as...

The result in the rendering table will be...

• Editable if you want the
users (with the right
permissions) to be able
to edit this attribute.

• Required if you want
to make it mandatory

• The selected document attributes will be displayed in the
table header and its values in the respective columns.
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Specify the Visibility of the
attribute as...

The result in the rendering table will be...

for users (with the right
permissions) to fill in this
attribute.

• Read Only if you don't
want any user to be able
to edit this attribute.

• The users can type in the values for the editable attributes.
 

 

Note:  You can configure the Visibility also at the attribute
level. If your settings differ, the most restrictive setting will be
applied.

Tip:  Click add column and select another attribute to have more attributes listed in your table.

Tip:

You can configure a project's document reference attributes to be non-editable and still allow the
user to edit the attributes of the documents referenced.

Your user can do this from the project's attribute category tab.

Tip:

Optionally, you can setup the Project > Notifications > Project Attribute/Category change to
receive notifications about document references.

Reference category changes will be notified according to the Project > Notifications > Document
Attribute/Category change settings.

•
Configure Expand Attributes  / Collapse Attributes  button for your document references.
This allows you to expand or collapse the document attributes of your references.

Tip:  You can configure different expand attributes settings for different views. Specify the view
name here.

Note:

The check box Use Creation View for new Documents is switched on by default. As a result, you will
get the creation view whenever you use Upload/ Browse, Copy or New regardless of the view you
are creating the rendering for. If this option is disabled, you will see the specific view or the default
view.

When you save the view will change to the specified or default view depending on the configuration.
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Edit the Visibility as... The result in the rendering table will be...

• read-only

• editable

Note:  The user needs Change
properties right to edit attribute
values.

Click  to expand the document attributes (which
may also be document references):

Tip:  Keep this editable, if your users have to edit
the document reference's attributes.

When the document attributes are expanded, you

can use  to collapse them.

 

 
• Select the relevant reference properties and specify if you want it to be Read-only / Editable /

Required / Hidden.

Reference properties are attributes (reference category )of the document reference link. You can
select one of them from the attribute drop down in the Details cell.

 

 

Note:  Reference Property field is only available when a reference category is specified for the
document reference.

Specify the Visibility of the
reference category attribute as...

The result in the rendering table will be...

• Editable if you want the users
(with the right permissions) to be
able to edit this attribute.

• Required if you want to make it
mandatory for users (with the
right permissions) to fill in this
attribute.

• The reference attributes will be displayed in the
table header and its values in the respective
columns.

• The users can type in the values for the editable
attributes.
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Specify the Visibility of the
reference category attribute as...

The result in the rendering table will be...

• Read Only if you do not want
any user to be able to edit this
attribute.

Hidden if you want to specify a
Reference Property, but do not want
to show it in the table.

Note:  This option is specific to
Reference Properties.

• No visible reference attributes in the table

• The values (of the reference attributes) are
retained when you duplicate or replace a
document reference.

Note:

Choose Collapse check box when you choose Document Property, Reference Property, Reference
Property Filter, Document Attribute, Project Property, Project Attribute, Master Text, Translation
Text, Text Language Flags fields for Type, to expand or collapse the column while rendering in the
table.

 

 
• You can allow the users to move a referenced document into the current project. To set this up,

create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
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You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.
 

 

The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see  indicating remote project.
• When you are creating a Copy Sheet using Text Document References, you can configure text

related data to the table. Read more in: Create a Table Rendering for Text Documents on page 389
• To configure the rendering with Project related parameters, choose from
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• Project Property
• Project Attribute

Read more details in: Project Properties in Advanced Table Rendering on page 387
• Optionally, add:

a) a Numbering column.
b) Up / Down arrows to let the users change the sequence.
c) Duplicate button which allows the user to duplicate a reference along with its properties. Read

more in: Duplicate a Document Reference on page 385.
d) Replace button which allows the user to replace a document reference. Read more: Replace a

Document Reference on page 386.
e) a Delete Button to let the users delete the document references from the table.
f) Row Selector to let the users select single or multiple documents. Using this, user can select

multiple documents from the document table and perform document actions on them.
• Save the configuration by clicking OK. To revert from this configuration, click Revert to WebCenter

Default Configuration.
• Save the Attribute Category.

If the logged in user does not have permissions to view the document, the document table will have
(based on the configuration):

1. Document name with !. The user will see a warning message.
2. Editable reference properties displayed in the specified columns
3. Up /Down arrows
4. Delete button
5. Numbering (“#”)

Note:  If the settings are not editable, the document table will have the document name and its
sequence number.

Creating a Copy Sheet

Copy sheet is a term used to describe all the content together which are attached to a particular
artwork or printed item. A copy sheet containing aggregated content helps you to:

• validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.

• review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

• track the content on an artwork.
• easily reuse existing approved content
• configure separate permissions and approval system for each text document.
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Tip:

By configuring Document Rendering for Text documents, you can attach copy sheets to Tasks. When
you configure Workflows with manual tasks for editing or approving, the users can work on the copy
sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

• the languages. To view a particular translation corresponding to a master, just select that language
in the filter drop down.

• the Instance Sequence. See more in: Dynamic Content documentation

• the option to replace a text document with another

• the button to duplicate a document with the same reference attributes

• advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.

Note:

The text document references are used when you import Dynamic Content into WebCenter. Read about
this in: Import Dynamic Text on page 926.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip:  You can configure the copy sheet with different Attribute Views to provide custom views to
your users. For example, a content collator and Translation Language Editors can have different
custom views of the same text document reference category.

Note:  You can also add the languages by clicking on the  displayed in the text statement. On

deletion of a language, the  icon is again displayed to enable adding back the language. You can
configure the corresponding attribute category to display the languages one by one in a table.

 

 

Adding or removing Master or Translation languages from a Project Attribute Category page or
Project Creation page or Document Attributes, or in a Task execution pages behaves differently now.
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Adding any of the available languages is possible based on permissions on all text content in the
page including documents that are from other than current project.

Similarly, it is possible to remove the language when it is added recently but not saved

• Even when text content document is referenced from other than the current project
• Even if it is not empty

• Even if you do not have permission to remove languages

Create a Table Rendering for Text Documents

You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option."

1. Create a Table Rendering.
2. In the Edit Rendering Configuration pop-up:

Configure The result in the rendering table will be...

Master Text or Translation
Text

Master Text Statement or the Translation Text is shown in
a text widget along with its content in the edit field and all
related text content actions.

Note:  The Visibility should be specified as Editable if you
want your users to edit the text. One or more columns can be
configured for the Master or Translations of the Master Text.

Master and Translation languages will either appear in a drop
down or you can choose Show Side by Side view.

You can also restrict the languages that will appear in the
drop down, by mentioning the languages ( pipe separated)
specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

Note:  The master and translation languages are populated
from the project attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.

Tip:

You can specify a default language code for Text statements. The selected language will be the
default in the document reference table. If default language is not specified, the first language from
the language drop down is selected as the default. WebCenter also supports right to left languages
like Arabic and Hebrew for text content.
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3. Specify the width for Master Text and Translation Text.By default, the width of every column is set
to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.

Tip:

To change the width of the columns, specify pixels or a percentage (of the width of the table).
If the label of the column is too big for the width specified, the column width will be bigger to
accommodate this.

 

 

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons
buttons and are active by default.

• Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the
content. Green for approved, red for rejected, blue for pending approval and grey for draft.

• Inheritance Button Shows the inheritance icon when active.

• Comments Button Shows the comments icon button when active.

• Approval Info Button Shows the approval info button when active.

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options “Ellipsis” button will also not be visible.
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4. Configure the display of Text Language Flags. You can configure the Display as Show only Flags or
Show Flags and Languages.
These flags will be based on the Project Language Attributes.

• In the copy sheet view, all the newly created text documents will have the current Project's 
Language attributes as flags. You can read about how to customize flags for languages here.

• All the sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the
available flags.You can add or delete flags in this view.

5. You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
 

 

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.
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The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see  indicating remote project.
6. If you are configuring Local / Remote button to allow copying of documents, ensure that you have

enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval status is retained as it is.

7. Define adequate permissions to view and edit Text Statements.
Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

• Visibility should be specified as Editable.

• If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

• The user should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 504.
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Tip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

• Change Properties

• Start/Stop Approval

• Upload new version

• Change Task

• Download

• View

• Add

Note:  The Text widgets, related languages and statuses are rendered only for Text Document
References.

4.15.10.  Setting Up Task Notifications

The biggest aim of Task Management is to make tasks happen at the right time. As with most
production processes, packaging production is a complex process with both sequential and parallel
operations.

The critical path is the set of dependent operations defining the total duration of the Project. At each
moment, only one task is on the critical path and any delay on that task delays the entire Project. Often,
people performing critical tasks are not even aware of the critical nature of their work.

Therefore, it is very important that people get correctly notified of what they are supposed to do and
that they get notified again if they cause delay to the Project.

Currently, WebCenter does not calculate critical paths; it leaves it to the Project manager to set good
due dates and it notifies people assigned to a task.

WebCenter also automatically sends overdue notifications to Project managers and assigned Project
members whenever a task is overdue. Overdue means that the task passes its due date without being
completed.

This information assumes that the e-mail environment is already set up. Please refer to the WebCenter
Installation Guide for detailed instructions.

Set Up Notifications for Tasks
Task management notifications are set up on the same pages as all other notifications.

The Admin sets system-wide default notifications for all projects at once (see "Notifications
Preferences" in the Administrator Guide), but you can change those defaults for the projects you
manage.
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• To set project-specific task notifications, click the Notifications tab in your project. Following
Notifications can be set up for task related events.

• Task created
• Task Assignment changed
• Task Due Date changed
• Task Predecessor changed
• Task Specification changed
• Task Information changed
• Task Document(s) changed
• Task Checklist changed
• Task Status changed
• Task started
• Task completed
• Task deleted
• Workflow canceled

For example, you can send notifications to the Involved People. For task management notifications,
the involved people are typically the task creator and the task assignee.

Tip:  On the notification setting page, click Involved People for more information about the involved
people for each kind of notification.

4.15.11.  Tasks, Templates and Copying Tasks

• When saving a project to a Template, you also save its tasks to this Template. When creating a new
project from this Template, you’ll automatically have these tasks in your new project.

• You can also create a project as a (partial) copy of an existing project. After clicking Create New
Project, click Copy setup from an Existing Project (see Create a Project Based on Another Project
on page 789). There you have the option to copy the tasks.

• A third way to quickly create a task from existing tasks is to create a task as a copy of another task.

Copy a Task from Another Task

Note:  You can only copy from other tasks in the same project.

1. Go into the task details of the task you want to copy and click Copy Task on the right of the screen.
2. Choose if you want to:

• Copy Specifications,
• Copy Documents.

... into the new task.
3. Enter the new task's Name and an optional Description.
4. Change the due date as desired.
5. Assign it to the project member of your choice.
6. Click Finish.
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4.15.12.  Example: Assign a Role using a Task

Use this to allow non-Project Managers to invite people, assign tasks or approvals to users or groups
via a task.

For example, use this if you want Marketing Managers or customers to invite an agency without getting
to project management details.

You will need your Administrator's help for this (steps 1 to 3).

1. As an Administrator, create a Restricted Set containing the people or groups that will be used to
assign the role in the task.

• Use the Text Type.

• For groups, use the exact group names.

• For users, use this format: Lastname, Firstname (username). Make sure this is spelled
correctly, especially the (username)!

See the Administration Guide for details.
2. Create a Specification (from the Task Types > Specifications menu) with the same name as the

role and add the Restricted Set you just created.
3. Create a Task Type that allows assigning roles with your restricted set values.

Note:  You can do this part yourself if you have the User Can Create Task Type permission. It is
possible to assign multiple users/groups to the same role in case you use the option Allow Multiple
Values for your specification.

In the Select available specifications screen of the Create New Task Type wizard:

a) Select Assign roles from task specifications.
b) Add the Specification you just created.

4. As a Project Manager, create a task from the task type your Administrator created.

Assign it to the person who needs to take the decision (who to assign the role to).

For example, assign it to the Marketing Manager to have him / her choose a design agency for this
project.

5. When you run the project, the assignee will get the task on his / her My Work page and will assign
the role with the appropriate user or group.

4.15.13.  Task Reporting

WebCenter has a number of areas where you can see progress of tasks and sets of tasks.

The most obvious one is the tasks overview within the project. Here you can rapidly see how the
project is doing and which tasks are in trouble.

You can also create reports that encompass multiple projects. The way to do this is through the task
searching combined with saved Global Searches.
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A typical task search for a follow-up report
 

 

The search pictured here shows all tasks in projects I have access to that need some follow-up.

Completed tasks are excluded and also tasks in non-active projects are not interesting. Tasks with due
dates far in the future or a long time ago are also excluded.

The result will show a set of tasks with their due dates. Those overdue will be shown in red and you can
rapidly click-through to these tasks and take action.

Step into Workflow

View a Sub Workflow from the Workflow Node
Workflow nodes are sometimes linked to a sub workflow. Viewing a sub workflow from the workflow
is simple. Right-click the node and the sub workflow opens up. With the browser backward or forward
buttons, navigate in and out of the sub workflow.
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4.15.14.  Workflows

What is a Workflow
A Workflow associated with a task enables you to automate actions and events in WebCenter, reducing
the number of human interventions during the project. Use these workflows to execute complex
business processes in an automated way. You can create smart workflows by using SmartNames,
subworkflows, routing and integration steps.

You can use Workflows in:

• task creation and assignment
• approvals
• communication to and from Automation Engine
• project creation
• setting the project status
• content management: translation
• ...

It uses attributes to decide what happens next (for example, who needs to approve a document,
perform a task or manage a project). This reduces the number of templates required and also makes it
possible to run many tasks in parallel.

Note:

To enable the workflow feature you need the following license module (depending on the License
model):

• the WebCenter Task Management Advanced module in the Named User License model

• the WebCenter Lifecycle Management module in the Concurrent User License model

 Workflow Basics

Workflow is attached to a Task Type
The workflows are attached to the Task types. Task types are templates for tasks which can be added
into projects.

You can create:
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• Manual Task types where human intervention is necessary. Read more in  Task Types on page 845.

• Workflow Task types where you attach a workflow to perform the automated action sequence.

Workflow Editor
WebCenter has HTML 5 based Editor for workflow.

Workflow Step / Node
A step in a workflow is a Task which is configured to:

• perform an action on an input file to produce an output file.
• manage files such as selecting or copying a document using an Auto Task

• decide the flow (Router) of the workflow or decide about other administrative decisions in the
workflow such as wait for action check points.

The actual workflow operations take place in these steps which are sequentially connected to each
other via “tubes”.

 

 

• A Transition is the line that connects each step in the workflow. It is a graphical representation of
communication of output file or data being sent as the input for the next step.

• By default, each node / step has an OK and an Error Output Pins. If the task ends in the OK state, the
output file will be sent to the following step. If it fails, the step connected with the Error output pin
will follow.

Note:  You can have more output pins depending on the possible outcomes.

• Workflow constructs can do administrative actions on the workflow, such as in the case of Router.

Documents in the Workflow
There are a few ways to attach input documents to a workflow.

• You can upload them to the project where the Workflow task is added to. In this case, these are
inputs for the Start node.

• You can use a Select Document node to pick up documents.

• You can have manual Tasks (conventional in the workflow. For example, when a designer creates
and uploads an artwork.
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Workflow Tokens
Documents and operations processed by the workflow are represented by tokens  traveling through
it. The number indicates the number of tokens. The position of a token indicates what is currently
happening (which node is being executed). A red token  indicates an error.

Using a Router node, you can split a token (and its documents) into multiple tokens based on certain
parameters which will follow their own path through the workflow network. After certain workflow
tasks, you can use a Data collector to aggregate these into a single token again. Read more in: Data
Splitter and Data Collector on page 971.

• You can view the Token information while a workflow is in progress. The route that the Token has
taken is highlighted.

• Open in Viewer is enabled when you right click some of these tokens

• You can  Retry (in case of error) or Relaunch (in case the workflow is stopped or cancelled) a
workflow when you right click on a token.

Workflow Feedback in Project Details
You can view a workflow's feedback from Project > Tasks page. To open the workflow feedback page
either:

• hover over the task name and click the Workflow  icon.

Tip:  You can use the Edit button to edit the Task Information.

•
or click the Show Active Nodes  and Expand the mini Feedback view.

 

 

SmartNames
Certain parameters of the workflow nodes are SmartName enabled. This is a variable that will be
resolved only when the node is executed. When the value is resolved (for example, an attribute value is
found), this will be used as the value during the execution of the node. Click the SmartName  button
in an input field to use this feature.

Building Workflows

Create a Workflow from a Task Type

Creating and Starting a Workflow
To create a Workflow, you need to:

1. Create a new Task Type or use an existing Task Type.
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Note:  Task types can only be created by Project Managers with the User Can Create Task Type
permission, or by Admins.

2. In that Task Type, open the workflow tab and create a Workflow by combining workflow nodes.

To start the workflow, make the task status active, such as in progress.

The Workflow Editor

To open the Workflow Editor, go to Task Types in the menu and:

•
Hover over the Task Type Workflow  where you want to create a Workflow and click the Task

Type icon. You can also create Workflows from the Manual Tasks directly from the list.

• Or click the required Task Type. Go to the Workflow tab to access the editor.

The workflow editor appears as below. By default, it contains a Start node and a Completed node. A
node or step represents an individual operation performed in the sequence of a workflow.

1 The workflow canvas in the edit mode. By default, this only contains a Start
node and a Completed node.

After the workflow has processed its files, you will see this canvas in the
feedback mode. In this mode, you can monitor your workflow or examine a
finished workflow.

2 The Workflow editor tool bar. Use it to:
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• Zoom in, Zoom out or Zoom to fit

• Maximize the canvas in your browser window (and minimize it again),

• Delete the selected items

3 • Use the filter to select certain workflow node types (seeWorkflow Nodes on
page 903 ). Using this you can choose to display All or only:

• Auto Tasks

• Statuses

• Task Types

• Use the search field to search on node names. The search field accepts
wildcards.

4 The Task pane shows all the Auto Tasks, Statuses and workflow constructs
that you can use in a workflow. Drag and drop them onto the canvas. You can
easily find tasks by using the filter and the search field.

Read more in: The Workflow Tools on page 898

The Workflow Tools

Table: Zoom Tools

Use this Tool or Shortcut... To...

 tool or CTRL + Plus(+) or F5
Zoom In on the Workflow Canvas

 CTRL + Minus(-) or F6

Note:  Scroll the mouse up or down to Zoom in and
out on the canvas.

Zoom Out on the Workflow Canvas

 or CTRL + Zero (0) or F9
Fit the Workflow on the Canvas

Table: Navigation Tools

Use this Tool or Shortcut... To...

 Pointer Select an area in the Canvas (including the Nodes
in it) and copy, cut or move those Nodes and
Transitions marked by the selection.

  Pan or Space
Pan the whole Canvas and to move all the Nodes
and Transitions within by using the click-drag-
release action.
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Table: Other Tools

Use this Tool or Shortcut... To...

 or CTRL + Z
Undo your actions on the Canvas

 or CTRL + Y or  CTRL + Shift + Z
Redo your actions

 or Delete  or Backspace To remove a Node. Select the Node or Transition
and click Remove.

To remove a Transition, select the arrow-head
and drag it away.

Note:  You cannot delete the Start Node.

Context Menu Right-Click to access the The Context Menu tools

Tip:  Use CTRL + click or click and drag to select multiple steps.

Table: Workflow Tools and View Tool

Use this Tool or Shortcut... To...

 or CTRL + S
Save all changes made to the Workflow

Import Workflow from an XML file. The import will
overwrite the current workflow.

Export Workflow  tand save it as an XML file on your
computer. It can be used later to Import  the workflow to
the same or another system

 Clear Workflow
Click Clear Workflow to clear an existing workflow from a
Task Type. This will make it a Manual Task Type.

 Workflow Priority

The priority of a workflow can be set and is used in the
queuing strategy of the workflow engine. Choose one of
the priority

• Low: to execute with lower priority than usual.

• Normal: the default priority

• High: to execute with higher priority than usual.

 or

Tip:  Use Esc to exit full screen.

To View the Workflow in  Full Screen or Minimize the
canvas in your browser window.
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Node Gallery
It contains all Task Types and Workflow Constructs required to build a workflow. Select using the below
filter options:

The Filters... and what they mean

All Nodes from all categories

Auto Tasks Tasks executed without human intervention

Statuses Task status for the current workflow task type

Task Types Manual, Auto Tasks and Workflow Task Types

Workflow Constructs Building blocks for the workflow used for Routing and Token
management. Read more in: Workflow Constructs on page 970

The Context Menu

Right-click anywhere on the Canvas or on a Node and access the context-sensitive menu.

Context Menu Actions on a Workflow Node/Canvas
 

 

See the details and keyboard shortcuts below:

To... Select this from the Context Menu.. Or use these Shortcut Keys..

Remove Nodes Remove Nodes(s) Delete Backspace

Copy Nodes Copy Nodes CTRL + C  (Windows) or CMD + C
(Mac)

Cut Nodes Cut Nodes CTRL + X (Windows) or CMD + X
(Mac)

Paste Nodes CTRL + V (Windows)  CMD + V
(Mac). Paste Nodes can be done
only by shortcut keys.

Add Sticky Notes on the
Canvas

Add Sticky Note Read more.

Edit Parameters of a Node Select a node, right-click and select
Edit Parameters

Configure Outputs of a
Node

Select a node, right-click and select
Configure Outputs
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To... Select this from the Context Menu.. Or use these Shortcut Keys..

Open Help on Canvas and
Tools

Click Open Editor Help to view
workflow editor help page.

Right-click on a Node and select Node
Help to get help on a specific Node.

Open a specific Help page
about a Node

Click Open Node Help to view details
of working with each Node type.

To create a Sticky Note:

• Select Add Sticky Note from the Context Menu.
 

 

• Click the body or the Edit Sticky Note icon in the top-left corner to edit the sticky note

•
Type your text and Save using the Save Sticky Note . To edit a Note, just click on it.

• To Remove Sticky Note, use .

• To resize the Sticky Note, drag the resize icon at the bottom-right of the Sticky Note

• To move the Note, click and drag to anywhere in the Canvas.

Create a Workflow
You can create a workflow from the Workflow Editor of any Task Type.

1. Click on the Task Types from the top menu items.
2. To open the editor:

•
Hover over the Task Type Workflow  where you want to create a Workflow and click the Task
Type icon.

• Or click the required Task Type. Go to the Workflow tab to access the editor.

You will get a blank canvas containing only the Start and Completed nodes.
3. Drag and drop your chosen nodes from the workflow nodes list onto the canvas.

You can add nodes to create a workflow. There are four types of nodes:

• Auto Tasks on page 907

• Manual Task Types

• Workflow Constructs on page 970

• Statuses on page 986

See Workflow Auto Tasks and Constructs on page 903 for more information about nodes.
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Tip:

• To find a node quickly, you can either use the filter or the search field on top of the workflow
nodes list.

• To delete a node, right-click and select Delete.

4. If desired, click your node names to rename them.
5. Connect your nodes with one another.

To do this, click a node’s green pin and drag it onto the next node. This links the two nodes with a
green transition or tube.

 

 

Note:

• You can connect a node’s output to several other nodes.
• To remove a connecting tube, drag its arrow head to a blank area on the canvas.

Warning:

It is not possible to self-reference a node. Self-referencing happens when the error pin is
connected again to the input pin of the same node. This will result in an error when you start
the workflow.
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6. Double-click each node and fill in its parameters in the Edit Parameters pop-up.
7. When you are done, click the Save button to save your workflow.

Workflow Nodes

Workflow Auto Tasks and Constructs

Nodes Description

Add to Bill of Materials Adds the incoming document(s) to the current project's Bill
of materials.

Assign Document Attribute Category Allows you to assign an Attribute Category to your
documents in a workflow step.

Add or Replace Approvers Allows you to add or replace existing approves in an approval
stage

Completed The workflow completes when all operations for a workflow
have finished.

Copy/Move Document Copies and moves the incoming document(s) to the given
project/folder and optionally renames it.

Create Project Creates or updates projects from your workflow. It can also
iterate the project creation to create multiple projects at
once. For example, using a multivalued attribute.

Note:  This node is only available if you have the WebCenter
Advanced license.

Copy Document Attributes Values Copies all non-empty document attribute values including
document references from a source document to one or
many target documents.

Create Graphics Placeholders

Create Color Cert Job Outputs a CCJ file and a mediastrip

Color Preflight

Delete Document Deletes the document when it is no longer required in
WebCenter

Delete View Files Deletes the view files of specified document

Delete Older Versions Deletes older or unused versions of the document

Execute JavasScript

Export Chili to PDF on page 922

Export to GS1 Format on page 921 Exports your text content along with its Element Type
tagging.
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Nodes Description

Export to XLIFF Format Exports your Text statements to be translated into a XLIFF
file.

Finish Approval Cycle

Get Dependent Colors Syncs the dependent standards belonging to the master
colors based on the conditions and shows these colors in the
input document attributes in WebCenter.

Import XLIFF Content Imports your translated Text statements in XLIFF format.

Import Dynamic Content Extracts the Dynamic Content from your artwork(s) as Text
Content Documents. You can configure this node to import
these Text Documents with a link to specific document
reference attributes and document templates.

Import Dynamic Table on page 930 Extracts the Tables from your artwork(s) as Table Content
Documents. You can configure this node to import these
Documents with a link to specific document reference
attributes and table document templates.

Import Dynamic Graphic on page 924 Extracts images or symbols from an incoming artwork
document and are added to the artwork file as document
references.

Import Dynamic Barcode on page 925 Extracts Dynamic Barcodes from an incoming artwork
document. For each Dynamic Barcode, a new document
is created and these Barcode documents are added as
Document References in the Artwork.

Invite Members to Project Invite a User / Group / Role to a Project in the workflow by
the users who can create Task Types.

Merge Text Content Merge incoming text content documents with matching text
content documents into the library project configured

Run Report Generate a report for the incoming document(s)/ Current
project/other reports

Reuse Text Content Reuse the text content documents that are referenced in
the incoming artwork document by matching and replacing
them with the library documents or updating the text
content document with SmartText that refers to library
documents.

Remove Member Remove User(s) / Group(s) / Role(s) from a project, who have
no approvals or task assigned to them

Replace Member Add and delete members in the project in Work flow
execution

Restore from Esko Cloud Restores the document from Esko cloud to Webcenter
location
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Nodes Description

Select Document Selects a document based on the folder, project name and
name of the document.

Select Children (Document Reference) Selects the document references associated with an
incoming document.

Select Parent (Document Reference) Selects the master documents of the incoming document
references.

Send Notification You can send automatic notifications to Project Manager,
Sales Person, Workflow Master, Groups, Users, Roles. Here
Workflow Master is the assignee of the workflow task.

See Send Notification for more information.

Set Document Attribute Sets the value of one or more document attribute(s)
automatically.

Set Project Attribute Sets the value of one or more project attribute(s)
automatically.

Set Project Status Automatically changes the status of the current project.

Set Workflow Specification Automatically sets the value of one or more specification(s)
for the current workflow.

Set Workflow Status Automatically sets the status of the current workflow to a
new status.

Start Approval Cycle Starts an approval cycle on a document and waits for its
approval status.

Start Approval Stage on page 946 This node starts an approval stage in a workflow and build a
staged approval.

Finish Approval Cycle on page 947 This node finishes the approval cycle of the incoming
documents and send e-mail notifications.

Submit Workflow Launches an Automation Engine workflow that is configured
in WebCenter.

Sync Workflow Synchronizes the project with the configured workflow
taken from the project/template setup.

Table Content Preview Report Generate report of the preview of Table Content

Update Text Document Specify or Update Text Document properties

Update Table Content Specify or Update Table Document properties

Upload to Asset Management System Uploads the document to Esko cloud location or the Asset
management location specified
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Nodes Description

Wait for view files Wait for view files in the work flow when it is not available

Wait Workflow waits/pauses for a specified amount of time

Nodes Description

Data Splitter and Data Collector If you have two or more documents with two different tasks
assigned to each of them, then use the Data Splitter node.
This node will put each document separately on this tube
after which these follow their own path.

Once the tasks are completed the Data Collector will wait
until both tasks are completed and then proceed to next
node.

See Workflow Example on page 986 for more information.

Error Handler Use this to collect failed tokens when other nodes go
into failure (make sure the other nodes' error dots are not
connected to anything).

Fork and Join on page 973 The Fork step automatically tags

• every file running through it
• and all the files that those files are related to in the next

steps

The Join step then groups all the files with the same tag and
outputs it together.

Mark and Select The Mark node marks the documents arriving to the node
with a named tag. For example, main design, original data or
admin data.

Later, the Select node can pick up the same documents
based on this named tag and then route it through the
outgoing tube.

Router Use the Router to build a rule list to meet a result, these
rules are evaluated from top to down. The rules can be based
on:

• Project Properties
• Project Status
• Project Attribute
• Document Name
• Document Attribute
• Workflow Specification

See Workflow Example on page 986 for more information.
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Nodes Description

Stop Use the Stop node to stop the workflow before being
completed. When a workflow token arrives at this step, it
stops the workflow.

Auto Tasks
An Auto Task is a step in the node which does not demand human intervention. Auto tasks are
automatically executed using predefined parameters (the attribute values or SmartNames).

Add or Replace Approvers

You can now add or replace approver(s) like users or groups or roles to a specified approval stage while
it is in progress using the Add or Replace Approves node.
 

 

Fill in the following in the node to add or replace :

Stage Name: Select the Approval Stage where the approvers are to be added. The stage can either be
ongoing or yet to start or stopped.

Replace approvers option: This option allows the approvers in the stage to be replaced by the
approvers specified in the workflow node.

Approver : Choose the type of approvers from the drop down like Users, Groups or Roles.

Note:  Ensure that the approvers added have view rights on the document.

When there are no approvers selected by the workflow and the option to replace is selected, then all
approvers are removed from the stage and an error is generated in the workflow.

When the approvers are replaced while they have already submitted their approval, their approval
status is not taken into account when calculating the final approval status. This is similar when the
approval is stopped, approvers are removed and the cycle is started again.
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Note:  After adding or replacing the approval users, the todo list and document history is updated.
Search is also updated with the new information.

An email notification to the newly added approvers is sent out if the notification event Approval Cycle/
Stage started is selected.

Add to Bill of Materials
Use this node to add documents to the current Project's Bill of Materials automatically.

Parameters
Count: Set the documents' Count in the Bill of Materials.

Tip:  You can use a SmartName (for example a document or project attribute) to set the count.

Copy/Move Document
Use this node to copy or move one or more document(s) to a new location.

Parameters
Double click a Copy/Move Document node to set up these parameters in its dialog box.

• Copy: select this if you want to copy a document to a new location, while keeping it in the original
location. You can choose to:

• Link the new document to the original document,

• Create a New version if the document already exists in the new location.

• New revision if Document already exists: enable this to raise the revision while copying or
updating. This will raise the revision letter (and create a new version) if the document already
exists.

Note:

The option is visible only if your Admin > Preferences > General > Allow increment Document
Revision when uploading a new Document Version  is on.

• Copy Viewer Annotations: use this option to copy annotations of a document to a new one.

• Update Document References to remove a current document and add a new document to the
document reference. A new version/revision of a document is now created in the target project
and added in the document reference attribute.

• Keep Text Content Element Status to retain each Text Content element approval status when
the document is copied as new version. (by default each element approval status is moved to
draft state).

Note:  You can retain the language content approval status only when the Packaging Content
Management Licence is enabled.
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Note:  You can choose to either copy the comments or can be cleared based on the option
chosen by the Admin user in the preference settings for Packaging Content Management. You
can read more on the option at Copy comments from a text document on page 99

• Move: select this if you want to move a document to a new location (removing it from the original
location).

Project Name: Enter the name of the Project into which you want to copy/move the document.

Folder: Enter the name of the Project's folder into which you want to copy/move the document.

Name: Enter the name to give the document in the new location if desired.

Tip:  You can use SmartNames for the Project Name, Folder and Name parameters.

These Copy/Move action have below results:

• When Moving, all document versions move along, including all the related features like approval,
history, attributes...

• When Copying, only the latest version is copied along with its view data, attribute... and the
Approvals reset.

• For each document, a line is added to the Project History stating that the document is deleted/
moved from the source project and added to the target project.

Note:  The node fails if the target project/folder does not exist.

Copy Document Attribute Values
You can use Copy Document Attribute Values node to copy all non-empty document attribute values
including document references from a source document to one or many target documents.
 

 

Set up the Parameters as below:

• General

In the Source Document tag drop down, choose the source document. This tag is to identify the
source document from where document attribute values need to be copied from.

Select Only select tagged source Document from the incoming Documents field to look up the
source document from the incoming documents instead of selecting all documents with the given
source document tag in the workflow. This allows bulk tagging of documents earlier in the workflow,
but when a set of documents reaches this node, the only Source Document that is selected from
the list of tagged documents is the one that is part of the documents of the incoming token.

• Document Reference
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You can use this tab to copy all the document references and other attribute values to the matching
attributes. When the same reference attributes are not available in the target document, then
document references are copied in the reference attribute chosen in Copy all unmatched
Document Reference to.

From 18.0.1 WebCenter, select Only copy if Reference Properties match target Document
Attributes option to decide whether the document references are to be filtered based on reference
properties or not.

When document references are copied from a source document, existing document references in the
target documents are removed. Basic attribute’s values are copied when matching attribute is found.

Create Project
Creates or updates projects from your workflow. It can also iterate the project creation to create
multiple projects at once. For example, using a multivalued attribute.

Note:  This node is only available if you have the WebCenter Advanced license.

Using this node, you can:

• create or update projects either in the current WebCenter or another WebCenter.
• create Child Projects in a Program.

• copy the existing project documents to the new project.
• iterate over an attribute to create multiple projects.
• specify project attributes.

 

 

Project Tab
Parameters for creating the project (all smart name enabled):

• Project Name is the name of the new project. If not specified, auto-naming is checked in the
template or in theadmin > general > preferences settings.

Note:

If the field is left empty without auto-naming in the Project Template, you will receive an error
message :

One or more mandatory parameters were not specified

• Update Project if it already exists, otherwise create a new Project: Check this option to update a
project with the specified name if it already exists.
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If it is not checked, a new project will be created. If a project with the specified name already exists,
it will result in an error. For copying documents, there is an option to be copied as new versions.

Project Name Sux is required when you are using auto-naming with a Sux field as Edit.

• Add as Child Project of the Current Project: Check this box to create Child Projects in a Program.
Use this to create Projects as part of a Program. This option is turned off by default.

• Template: The project template on which the new project should be based on. If left empty, a blank
project will be created.

• Project Description: The description of the new project.

• Project Status: The initial status of the new project. This list follows the order of the project
statuses as defined in WebCenter and by default, the Active status is selected automatically. You
can also select Blank as an option.

When a new project is created, the first active status is assigned whereas while updating existing
project, the project status is left unchanged. You can configure SmartNames to indicate this initial
status to make it context relevant.

• Customer/Company: The legal name of the company/customer. By default, it will be the customer/
company of the current project.

• Location: The customer/company location. By default, it will be the location of the current project.

• Project Due Date: The due date of the new project. By default, it will be the due date of the current
project.

• Project Manager: The project manager of the new project. By default, the node takes the current
project manager.

• Use SmartNames to choose a Group, Role, User as the Project Manager of the new Project
and an attribute (document / project / task) to automate the setup of the node. You may also
manually specify these parameters.

• When a SmartName for Project Manager is not resolved (for example, you choose an attribute
(with Group or User as value) and it cannot be resolved because you forgot to add the
attribute to the project's attribute category), an error

Project manager not found.

is shown.

• If you choose a role to assign the Project Manager, the current project is checked for the
assignment of that role. A unique User or Group should be assigned to that role. If more than
one group / user is assigned to then, you will receive a warning.

• If you assign a Group, at least one of the group members should be a Project Manager.
• If you assign a User, the user should be a Project Manager.

• If you choose an attribute to assign the Project Manager, the attribute should resolve to the
user name of a user or the name of a group.

Documents Tab
In this tab, you can set options to copy the incoming documents to the project or projects being
created.
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• Copy Documents (default): lets you copy the documents to the new project.

• Folder Name: specify the target folder in this field. If you leave it empty, it will take the root
folder as the target folder.

• Copy incoming documents as Link: enable this to copy the documents as links in the new
project.

Note:  If you are creating projects in a remote WebCenter, you cannot copy the documents as
links.

• Copy incoming documents as new version if they already exist: check this to copy the
documents as new versions.

• Raise revision if Document already exists: enable this to raise the revision while copying or
updating. This will raise the revision letter (and create a new version) if the document already
exists.

Note:

The option is visible only if your Admin > Preferences > General > Allow increment Document
Revision when uploading a new Document Version  is on.

• Copy Viewer Annotations: use this option to copy viewer annotations of documents while
copying.
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Note:  This will not work if you are copying to a remote WebCenter.

• Move Documents: choose this to move the documents to the newly created Project. You can
specify a folder for this document.

Note:  It does not work for remote WebCenter projects.

• Do Not Copy Documents: choose this option if you do not want to copy the documents to the new
project.

Iterate Tab
You can create multiple projects at once using the options in this tab. The default option is Do not
Iterate.

To create multiple projects over an attribute, choose  Iterate over Attribute.

 

 

You can select this attribute via a SmartName or by manually typing in the attribute. Based on the
resolved value of this attribute, this node will create multiple projects. For example,

• If the SmartNames resolves to a multi-value (text) attribute indicating languages, the created
projects will be language variants. You will get the same result when you type in the attribute values.

For example, if you type in Dutch | French | English, the iterator value will be “Dutch”,
“French” and "English". As a result of running the task in a Project, you can expect three new
Projects corresponding to each language.

Note:  While iterating project creation, you can send only the related attributes to the created
projects by specifying them iterator value as the attribute in the Project Attributes tab.

• When multiple documents with a multi-value document attribute (for example, Dutch | Spanish
| English as the Iterator) arrive at this step:

• In case there are two values for the attribute (e.g. Dutch and English), this document will be
attached to both the Dutch and English projects.

• If the documents' attribute value is left empty, they will not be added to any of the projects
created.

• The documents without the specified attribute  will be attached to all the created projects.
• If the SmartName resolves to an integer or if you type an integer (for example, you type 3), the

projects will be created based on these numbers.

For example, if the value resolves to 3, the iterator value will be 1, 2 and 3. You will get three new
projects when the task is finished.

Note:

If the attribute is missing in the Project, you will get an error.

Attribute not found
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Important:

• Do not aim to create more than a hundred projects using the Create Project Node . You will be
warned if you do so.

Maximum number of projects that can be created at once exceeded.

Tip:  You can use the Iterator Value SmartName from the Iteration category in the other node
parameters such as the Project Name or description.

Project Attributes Tab
For setting project attributes of the new projects, click on the +. Add the

• project attribute and the corresponding value. Enter this value via a SmartName or by manually
typing in.

Note:  The attribute values are set regardless the Attribute Category of the new project.

Note:  If the SmartNames are not resolved, it will not fail project creation. However, the attribute
value will not be set in the new project.

• You may also assign roles via attributes.

WebCenter Tab
In this tab, define the WebCenter on which you want the new project :

• Current WebCenter(default): Use this to create the new projects on the WebCenter where the
workflow is running.

• Other WebCenter: Use this to create the new projects on a remote WebCenter. For this to work,
the parameters specified in the node (for example, the Project Manager) should be present on the
remote WebCenter.

• WebCenter URL: The URL of the remote WebCenter.

• WebCenter User Name: The user name used to log in to the remote WebCenter

• WebCenter Password: The password used to log in to the remote WebCenter for the specified
user name.

Note:  If a user exports a task type containing a node with this option, this field will be blank in
the generated XML.

Note:  You may copy the documents remotely, but you cannot add them as links.

For every project created, you will find a log in the Project History.

Create Graphics Placeholders
You can use this node to create graphics placeholders to represent print area information available in
the Collada document, referenced in the input document attribute called CAD_REFERENCE. Any user
with Task Type creating rights can use this node to create graphics placeholders. Placeholders can be
replaced with actual printable parts later.
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These graphics placeholders are created to represent print areas available in the Collada document.
Name of these graphic placeholders will be created with print area id and the side of the print area, like
for example "printarea1_front”.

Based on the node configuration, each print area is extracted once for the printable side front or twice
for the printable side front and back.

Note:  When the input document is a component document, then the Thumbnail is updated.

Parameters

• Template Project: This is a smart name input field to get project name(s) where document
template is available.

• Document Template: This is to get document name available in the mentioned Template project.
This document is copied for creating placeholders documents for each print area available in
Collada document. Template document is having hard coded document type of an attribute
called CAD_REFERENCE. This attribute will reference Collada document from where print area
information is extracted. Two hard coded reference properties namely CAD_PRINTABLE_PART and
CAD_PRINTABLE_PART_SIDE are expected to be in the CAD_REFERENCE attribute to hold the print
area id and value of front/back.

• Target Folder: Name of the folder where new graphic placeholder documents are created.

• Target Reference Attribute: Select any one document reference attribute from the drop down to
attach graphic placeholder documents as reference in the incoming document. Selected document
reference attribute is expected to have one reference property called CAD_PRINTABLE_PART, to
hold the name of the print area.

• Extract printable part for front and back: An option is provided to decide whether printable parts
are expected for printable side front and back both or only for printable side front. Placeholder
for back side is only created if the print area information contains printable part for back and this
option is enabled.

Create ColorCert Job
ColorCert is a software application which helps you to get accurate, consistent precise colors and print
the specifications from pre-press to production process control.

In this work flow node, information that are available in WebCenter like

• Projects, Colors selected from library and assets within WebCenter
• Scorecard rules and profiles (ColorCert profiles, ICC profiles, CGATS profiles) that stored as regular

documents in WebCenter .

Note:  The documents are tagged with the Mark node in the work flow and then referred to by the
mark name. For Example, specify the ColorCert rule document, mark it and select the tag in the
ColorCert Rule parameter
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are all called to create a CCJ (Color Cert Job) and a media Strip (PDF file). Along with these, a CCJZ file
for debugging purposes is also uploaded back to the current project.

The work flow requires the following parameters in the respective tabs:

1. Job Details: Job Name, Job number, customer, business unit, brand, variety, UPC and Product
Order Number.

2. Output: Artwork Target, Orientation values like surface or reverse, Screen Count, Screen Type like
lpi or LCM, Lot Size, Supply As either Roll or Pallet, or Sample, Printer and Separator.

Note:  All the parameters are smartnames and maps to parameters with the same name in the
ColoCert job or the Job Details and Output tabs.

3. ColorCert Assets: ColorCert Rule which uses the tag for marking the ColorCert Rule document and
Substrate file for the ColorCert job.

4. Color : Specify the following with the tag used for identifying them

• Profile: Either colorcert profile, icc profile, cgats profile

• Primary Colors: Colors that are specifically tagged are picked in this parameter.

• Spot Colors: Colors that are specifically tagged are picked in this parameter.

Note:  Either a profile or colors need to be selected for a ColorCert job to be created.

5. Mediastrip: Smart Name enabled fields including

• Patch Width: for the width of the mediastrip

• Patch Height: for the height of the mediastrip

• Strip Type: Type of the strip, either can be ScanSingleRow, ScanTwoRow, ScanInkByInk
6. Configuration

• Cloud Connection Drop down where we show the available Cloud Color connections

• Folder The folder in the WebCenter project where the document is uploaded to. When the folder
does not exist, it is created. When the document already exists in the folder, the workflow will
create a new version of this document. If the document exists already and the folder specified is
different than the folder of the existing document, the workflow generates an error.

• Document Name (CCJ, PDF) This is the name of the resulting CCJ and PDF file. When the
document name is not unique in the project, WebCenter will take the document with the given
name and will create a new version of the document. In this case, the folder name is ignored.

The resulting CCJ file contains the colors specified by the primary and spot color tag. Color that are
in the profile, but not in the list of primary or spot colors are not included in the CCJ file.

Color Preflight
The Color preflight workflow node validates the colors referenced in the actual document against the
specifications provided and generates the preflight results in the workflow.

Preflight Results are stored as attribute value(s) of the document(s) which may include preflight
status, preflight report or both. Preflight results could indicate whether all the expected colors are
found or not and if any unexpected colors are found.

In this node, following information has to be provided in four tabs.
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1. Color Specification

• Color Specification: Specify the attribute(s) that has specification details for the color.

• Palette specification: Select the Attribute / task specification that holds the direct color
specifications in the palette(s).

Note:  Either the Color Specification(s) or the Palette Specification(s) is required for preflight.

• Palette Color Specify the attribute that has the color(s) information in the incoming
document(s).

For each incoming document, the workflow fetches the referenced color information, and
compares it against the specification(s) provided.

Note:  Colors having the attributes with matching condition specified in the Ignore tab will be
ignored from the actual color list.

2. Document Colors: Select the Document Reference attribute, that holds the colors list in the
incoming document.

3. Ignore: Specify the values for attributes that you may want to ignore from the actual colors from
the incoming document(s).

You can add multiple conditions in this tab, and even if any one condition specified in this tab is
true, the color is ignored from the preflight check. To ignore, select the attribute for which you want
to validate either by Matches condition or Contains condition for a given Value.

4. Preflight Result: Select Preflight Status Attribute or Preflight Result Attribute or both in the
respective drop-downs.

Preflight Status Attribute: Ensure the selected attribute is available in the attribute category of
the incoming document to set the Preflight Status. Resultant values possible for this attribute are:

• Additional Colors when the incoming document has some additional colors than specified.

• Missing Colors when the incoming document has some missing colors from the specified
colors.
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• Both Additional and Missing Colors when the incoming document has both additional and
missing colors.

• Matched Colors when the incoming document has exactly same colors as the specifications.

Preflight Result Attribute: Ensure the selected attributes is available in the attribute category of
the incoming document to set the preflight result provided in the rich text editor field.

Preflight Result Field is to provide data to be set in thePreflight Result Attribute selected.

Note:  There are four new SmartName introduced, that can be used to fill in the details for the
preflight result:

• Additional Colors: To resolve to the names of colors that are available in the incoming document
but not in the specifications.

• Ignored Colors: To resolves to the names of colors that are ignored from the document colors
for preflight check.

• Matched Colors: To resolve to the names of colors that are available in both incoming document
and specifications.

• Missing Colors: To resolve to the names of colors that are available in the specifications but not
in the incoming document.

Delete Document
#This node allows you to remove documents from WebCenter##whenever it is no longer required in all
the projects it is present ( in case of linked documents).

There is an option to Force Delete Documents used in Document References. When this option is
selected,the node deletes the documents that are used as a document reference in a Project or a
Document or in a Task and the document is then removed from the document reference(s) attribute
value too.

 

 

Note:  Documents cannot be deleted, when it is locked or pending for approval actions or is part of an
inactive projects.

After deletion, the Document is no longer available in WebCenter. Historic information about the
document can be found in the Project History.
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Delete View Files
This workflow node allows you to delete the view files of the incoming documents. Using this node, you
can clear out the view files for all versions of the Documents.

Note:  View Files of Page List documents are not deleted.

Delete Older Versions
This node enables you to delete old/unused versions of a Document from WebCenter.

In this node, the older versions of the input Documents are removed, and the remaining Versions have
their version numbers reordered.

 

 

When enabling the Delete Old Revisions option, only the latest revision is kept. If the option is turned
off, the latest version of each revision will be kept.

The document version is only removed when

1. It is not linked in any project where it is the most recent document
2. It is not used as a value for any document reference attribute
3. It is not used in any cart or task
4. It is not the last version of a revision
5. It does not contain final approval information.

Note: Document versions will not be deleted when the security settings of WebCenter do not permit
users to remove Documents with Approval actions.

Execute JavaScript
Use Execute JavaScript step to write and execute JavaScript code in a workflow. To access the
JavaScript editor, double-click the node.

You can use the WebCenter JavaScript API by using the API object. For example, API.getProject()
returns a project object representing the current Project.

Use CTRL+Space to enable auto-completion in the node. You will get pop-up with all possible options
related to the typed syntax.
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If you type API and enter CTRL+Space, a popup will list all possible methods of API (in this case
‘getProject’).

If you type  API.getProject(). and enter CTRL+Space, you will see a list of all possible
functions of a project.

Note:

• The auto completion does not list options if you nest multiple functions: for example, if you type in
API.getProject().getChildProjects()[0].setName(API.getProject().); and
enter CTRL+Space you will not get a list of options.

• By default, a script can be of maximum 100.000 characters.

The screenshot displays a case where the workflow calculates if a Parent Project (Program) is at Risk.
In this case, it updates the Parent Project's status to "At Risk" if more than 50 percent of the Child
Projects are at risk.
 

 

This workflow step executes JavaScript in a sandboxed environment which allows you to execute the
java classes of WebCenter API exclusively.

Note:  There is a limit of the stack depth (by default, 10,000) to avoid infinite recursions and there is
also an instruction count limit (by default, 1,000,000) to avoid infinite loops. The maximum script size is
also enforced during execution.

Any JavaScript error puts the token on the error pin with an appropriate error message.

Detailed list of Java Script API's that can be used with this work flow node are available in WebCenter
JavaScript API document.
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Export to XLIFF Format
Use this node to export your Text statements to be translated in a translation software that uses XLIFF
content (e.g. Trados or SDL). After translating, you can import them back.

Parameters
• XLIFF File Name: Specify the name for your target document.
• Target Folder: Specify the folder where the exported XLIFF file should be placed.

Note:  By default, the document is exported to the root folder of the current project. If an XLIFF file
(of the specific name) already exists, then exported document will be uploaded to the same folder
as a new version. If there are no content to be added for export to XLIFF, then instead of generating
an empty file, output is sent to No Files pin.

• Source Language: Specify the master language of the text content.
• Target Language

Note:  You can use SmartNames to set these parameters.

• Export statements only if Master Language is signed off: Check this to specify that the exported
XLIFF should only contain statements if their master is approved.

• Export statements only if target language is already added to document: Option to not add
statements without the target language. This is unchecked by default.

• Export Statements only if Target language is not signed off

This step creates an XLIFF file from the incoming text document (.wcc) and uploads it to the current
Project.

Notes
• If the source text is in rich text format, then the exported XLIFF file will have rich text identifiers.
• If a graphics file arrives at the node, it will search for Text Document References. If there are

referenced text documents, an XLIFF file is generated.
• Comments added in the text content document will be exported to XLIFF file.

Export to GS1 Format
You can export all of the text content, table content, symbols, images, Barcode attached to an artwork
to XML in GS1 format in a workflow.

For example, when a designer creates an artwork in Adobe Illustrator with placeholders for dynamic
content, they are tagged with appropriate GS1 Element Types (Content Types). Artwork is then
imported into WebCenter and Dynamic Content is then processed and approved in WebCenter. You
can then use this node to generate the GS1 XML file with the updated information. This node will add
the output file to the current Project. You can send this GS1 XML file back to the designer to place the
content on the artwork.

Update and configure the following information in the work flow node to export to GS1 format:

• GS1 File name: Specify the name for your exported document. It is possible to use SmartNames to
generate file names. If the file name is not specified, file name will be generated automatically.

• Folder: In this field, specify the folder where the exported GS1 file should be placed.
• Choose Include Empty Content in GS1 to view all the elements in the table document else only

elements with content are exported.
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• Note:

Default folder location is the root folder of the current project. If a GS1 document (of the specific
name) already exists, then exported document will be uploaded to the same folder as a new version.

The node will create a GS1 XML document for the specified languages with Language index mapping.
You can add a row for each locale mapping to include the languages in the artwork.

• Locale Index: Specify the sequence number referencing the locale index to the language. Locale
Index represents the GS1 localeSequence tag.

• Language: Select the language corresponding to the Locale Index from the drop-down. The drop-
down will list all the master and translation languages listed in the system.

Export Chili to PDF
You can use this workflow node to export Chili documents to PDF format. By default, the exported PDF
files are routed to the current project and the root folder with the incoming Chili file name. You can also
specify the target location of the exported PDF document including the Target Project, Target Folder
and the Document Name.

Specifications
• Target Project: Specify the location where the exported PDF documents are to be placed

• Target Folder: Specify the folder in the Target Project where exported document are to be placed.

• Document Name: Specify the new PDF document’s name. If left blank, the document name will be
same as the incoming document’s name with the extension .pdf.

• PDF Export Setting: Specify the PDF Export Settings name as defined in the CHILI Server. The pdf
document is created using the configuration defined in the XML of the export settings.

Note:

If there is an existing file in the target location with the same file name as the exported pdf, then the
node will fail. Alternatively, you can choose the option New Version if Document already exists.

Get Dependent Colors
In the ESKO Cloud and/or in Pantone LIVE, there are master/dependent relationship that exists
between the colors. Given a master color and conditions, there can be a dependent color linked to the
master color. This workflow node syncs the dependent standards belonging to the master colors based
on the conditions and shows these colors in the input document attributes in WebCenter.
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Input The inputs to the node are the document(s) that contain the master colors. Specify the following
information in this tab.

• Master Colors: Specify an attribute of the document that contains the master colors.

• Ink Type Specify a Smartname that represents an ink type.

• Printing Technique Specify a Smartname that represents a printing technique.

• Substrate Specify a Smartname that represents a substrate

• Finishing Specify a Smartname that represents the finishing profile and it is relevant for Pantone
Live colors only.

In the Output tab, specify the document reference attributes that you want to be updated for

• Dependent ColorsThis is a mandatory field. The dependent colors to the master colors specified is
added to the attribute.

• Missing Dependent Colors The masters colors for which no corresponding dependent colors are
found are added here

Specify the Cloud Connection that has been configured to the ESKO cloud for the Color Service in the
Configuration tab.
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Import Dynamic Graphic
When this node is executed, images or symbols are extracted from an incoming artwork file along with
expected number of occurrences from either AI files ( pdf) or Chili files and are added to the artwork as
document references.

Parameters
Symbol Tab

• Symbol Library: Field for providing the Project name(s) where all the Symbols are located. You can
either specify multiple project names with a "|" between them or provide SmartName which resolve
to multiple project names. Read more on this is How WebCenter finds previously used images on
page 925

• PlaceHolder Document Template: When matching symbols are not found in the Symbol Library, this
graphic document is copied into the current project as a placeholder which can be replaced with
actual symbol later.

• Upload Folder: Folder where the placeholder graphic documents are copied into.

• Document Reference Attribute: You can choose the Document Reference Attribute of the Artwork
file that has to be used to link the Symbols.

• Find Previously Used Symbols: If this option is selected, the node will find if an existing symbol in
WebCenter matches before creating a new document. In case the matching symbol was not found,
the node will create a new document.

Note:  This option is applicable only if the GS1 XML created in the system has been added to Artwork
file through Dynamic Content.

Image Tab

• Image Library: Field for providing the Project name where all the Images are located. You can either
specify multiple project names with a "|" between them or provide SmartName which resolve to
multiple project names.

• PlaceHolder Document Template: When matching images are not found in the Image Library, this
graphic document is copied into the current project as a placeholder which can be replaced with
actual image later.

• Upload Folder: Folder where the placeholder image documents are copied into.

• Document Reference Attribute: You can choose the Document Reference Attribute of the Artwork
file that has to be used to link the images.

• Find Previously Used Images: When this option is selected, the node will find if an existing image in
WebCenter matches with the reference property specified from the artwork before creating a new
document. In case the matching image was not found, the node will create a new document. Read
more on this is How WebCenter finds previously used images on page 925

Note:  This option is applicable only if the GS1 XML created in the system has been added to Artwork
file through Dynamic Content.

Import of Chili Documents
When the incoming document is a Chili file, then only the Chili variables with the data type as image are
imported and stored in the ARTWORK_VARIABLE.

Note:  Symbols are also considered as images in the Chili File.
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How WebCenter finds previously used images

When an artwork is imported into WebCenter, all its contents are also imported along with its meta
data ( XML)

Now when the images are imported and if the option Find previously used Images is enabled,
before creating a new document, search is made on the value in the reference property
EXTERNAL_IMAGE_PATH to find if any documents exist with the same name or matching image path.

If no matching document is found, then a placeholder document is copied into the project and its
attribute values are set accordingly.

Similarly when symbols are imported and if the option Find the previously used Symbol is enabled,
before creating a new document search is made on the value in the reference property SYMBOL_NAME
to find if any documents exist with the same SYMBOL_NAME. If no matching document is found, then a
placeholder document is copied into the project and its attribute values are set accordingly.

Import Dynamic Barcode
When the node is executed, Dynamic Barcodes along with the expected number of occurrences are
extracted from an incoming artwork file. For each Dynamic Barcode, a new document is created and
these Barcode documents are added as Document References in the Artwork.

Parameters:

• Document Template Project: Field for providing Project name(s) where the Barcode Document
Template is present. You can either specify multiple project names with a "|" between them or
provide SmartName which resolve to multiple project names.

• Document Template: Template used for creating a new document that stores the Barcode
information.

• Upload Folder: Folder where the new Barcode documents are created.

• Document Reference Attribute: You can choose the Document Reference Attribute of Artwork file
that has to be used to link the Barcode document.

• Find previously used Barcode: If this option is selected, the node will find if an existing Barcode in
WebCenter matches before creating a new document. In case the matching Barcode was not found
in the System, the node will create a new document.

Note:  This option is applicable only if the GS1 XML created in the system has been added to Artwork
file through Dynamic Content.

Import XLIFF Content
In a translation workflow involves third party solutions (e.g. Trados or SDL), you will get your translated
content as XLIFF documents (.xlf or .xliff). You can use the Import XLIFF step in your workflow to
import the translated statements into the WebCenter Text Document (.wcc).

If a particular language is missing in the Text Content document, this step will add that language.

This step will update the document only if the statement is in Draft or Pending Sign off or Signed off
rejected state.

Parameters
• Approve Translation: If you enable this all imported content will be Signed off.
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If this option is turned off, the imported text will be in the Ready for approval state.

• Create Translation: If you check this option, a new translation statement will be created even if the
language does not exist in the document.

If this option is turned off, the languages should exist in the document before the XLIFF content is
imported. Otherwise, the imported content will not be added to the document.

Note:

• If the statement is in Signed off state, it will not be updated with the XLIFF content.

• This step may update the Text Document partially, if there are reasons for the other statements
(parts) to fail. For example, if there are three languages, it is possible that only one language
statement is updated.

• Rich Text Support: If source and target languages contents are rich text format, then the same rich
text identifiers are added into translation content in the imported text content file.

• When the import of the XLIFF document is failed, the error pin is updated with the reason for the
failure.

• Any new comments given during translation is imported.

Warning:  This step will update the language statement in WebCenter regardless of the User
Permissions.

Import Dynamic Text
The Import Dynamic Text node extracts the Dynamic Content from your artwork(s) as Text Content
Documents  from either your AI files or Chili files. For AI files, the expected number of occurrences of
each text statement is also imported. You can configure this node to import the text documents with a
link to specific Document Reference Attributes and Document Templates.

Note:

1. You need a Copy Sheet Attribute Category with Text document references as a pre-requisite to
configure this node.

2. If the input is a Chili document, then read this for detailed explanation Import Dynamic Content from
Chili file using Import Dynamic Text node on page 930

Parameters- Configuration tab
• Specify the Upload Folder to store the extracted documents.

• Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your Text content specific templates. It can either be SmartName that
resolves to multiple project names or pipe separated values.

• Specify the Element Type. You can create a dedicated row per Element Type / Content Type. Click
+ to add a row. Read also: Configure Element Types as a List on page 499.

Tip:  Select All Element Types to import content that has no specified Element Type.

• Select the Document Reference Attribute for each row (per Element Type). Select the appropriate
document reference from the drop-down listing all document references.

These document references keep the link between the artwork and its Text Content active while
allowing you to process them separately.
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• specify the corresponding Document Template. You can configure document templates for each of
the Element Types in this SmartName enabled field.

Read also: Creating a New Text Document on page 510

 

 

Parameters- Language Mapping tab
You can map the Locale ID of the Dynamic Content to the corresponding language in WebCenter.

• Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

• Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

Note:

1. By default, an imported statement is imported as Translated language if it does not exist as a
Master Language in the Project's language attribute.

2. If you do not specify language mapping for the imported Dynamic Content, the node will try to
find the language in the Lists (Master and Translation languages).

–
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Parameters-Existing Text Content tab.
You can specify the reuse policy for matching Text Content Documents in this tab. Check Reuse
existing Text Content Documents to match the incoming text with the existing documents.

Note:

• When you enable this option, the matched Text Documents will be copied to the current Project if it
exists in another Project.

• If there is a 100 percent match with regard to the content and languages, the existing Text
Documents will not be updated.

• If the incoming document is a Chili file, then the content of this tab is ignored while importing.

If left unchecked, the import will create new documents.

The following settings allow you to handle partial mismatches with regard to content or languages.

If there is a partial text match (with same list of languages), choose from:

• Replace text and Reset the Status to Draft: The content will be updated and the document status
will become Draft.

• Replace text and Retain the Status: The content will be updated retaining the current status.

• Ignore Change: In this scenario, the changes are ignored and the existing documents will not be
updated in anyway.

If document is an Invariant, it will be reset to false.

If there is a language mismatch, then you have the option to:

• Add language and Reset the Status to Draft If document is available in different project, make
a copy of document to current project, add language and content and reset the status of full
document.

• Add Language and Retain the Status If document is available in the same project, then add new
language and content, and reset the status of full document.

• Ignore Change: ignore the incoming language.

Example
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document Attribute Category to the artwork (parent). This 'copy sheet'
category contains the document reference attributes to which the text content will be imported.

Note:  If this step is not in the workflow, the Import Dynamic Content will use the Project's attribute
as the default.

The category contains the Document Reference Attributes for:

• technical text statements,
• legal statements and
• marketing statements

to serve as the copy sheet template.
2. The Import Dynamic Content step maps the various Element Types to appropriate document

reference attributes as configured.
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3. The Select Children nodes select the text documents (technical, legal and marketing) separately.
These documents can be processed as separate text documents while keeping the link between
them and the artwork alive.

Import Dynamic Content from Chili file using Import Dynamic Text node

Import Dynamic Text node handles incoming Chili document in the same way as other artwork files
except it ignores any configuration in the Existing Text Contents tab.

WebCenter supports the following Chili data types for text content documents

• String, short text, long text, formatted text, unformatted, number for text content documents.

When imported, the imported Chili file is considered as GS1 complaint, if the Instance Sequence and
Locale are already defined in the Chili Variable name.

You can see examples of how Chili variables are handled by the workflow node in the table below.

 

 

Tip:  Chili variables should be GS1 compliant so that node can process the data correctly.

Import Dynamic Table
The Import Dynamic Table node extracts the Tables from your artwork(s) as Table Content
Documents. You can configure this node to import these Documents with a link to specific document
reference attributes and table document templates.

Note:  You need an Attribute Category with Table document references as a pre-requisite to configure
this node.

If there are multiple artworks coming into the documents, the node will iterate and extract tables from
all of them.

Parameters- Configuration tab
• Specify the Upload Folder to store the extracted documents.
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• Select the Document Reference Attribute for the table. Select the appropriate document
reference from the drop-down listing all document references.

• Add Imported Table Documents to Output . Check this if you want the document sent to the output
pin.

• Reuse existing Table Documents. The document version specified in the document reference will
be reused to store the data instead of creating a new Table Document. If there are no matching
tables in the system,new document will be created.

Document Template Tab
• Specify the corresponding Document Template. Select the Table Template (either simple or Smart)

that corresponds to the incoming Table.

Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your table templates. You can either specify multiple project names with
a "|" between them or provide SmartName which resolve to multiple project names. Read more in:
Creating a Simple Table on page 1028

• Add all Document Template elements Check this to import all statements present in the document
template.

• Set values from Document Template. Check this to take values from the Document Template for all
matching statements. If there are no matching statements, the incoming values will be used in the
table document.

Parameters- Language Mapping tab
You can map the Locale ID of the Dynamic Table to the corresponding language in WebCenter.

Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

• Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

Note:  By default, an imported table is imported as Translated language if it does not exist as a
Master Language in the Project's language attribute.

For new Table documents created from this node, the master language table will be added in the
Draft state, even if that language is not available on the artwork.

Note:  If you do not specify language mapping for the imported Dynamic Content, the node will try to
find the language in the Lists (Master and Translation languages).

–Read also: Import Dynamic Text on page 926.
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document attribute category to the artwork (parent). This 'copy sheet'
category contains the Document reference attributes to which the text and table content will be
imported.

Note:  If this step is not in the workflow, the Import  node will use the Project's attribute as the
default.

The category contains the Document reference attributes for:

• text statements,
• and nutrition facts table

to serve as the copy sheet template.
2. The Import Dynamic Text on page 926 step maps the various Element Types to appropriate

document reference attributes as configured.
3. The Import Dynamic Table extracts the table matching it to the document reference and the

table document template.

After the extraction of the content, the workflow processes the content based on the requirements.
You can, as in the example, update the incoming table and text using the workflow.

Invite Members to Project
This workflow node can be used to invite a User / Group / Role to a Project in the work flow itself by the
users who can create Task Types.

You can specify any active member to be invited to a project based on the Group or Role or even
specify a single user in the Members tab. This can also be done using Smart names. When you select
a Group, you can further select a member as Group Assignee. All the permissions are inherited based
on the Role selected to the added member. If no Role is assigned to the user, default( only view)
permission is available.
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In the Iteration tab when iteration is on, each of the member rows are evaluated for each value of the
attribute and then the members are added to the project.

You also have an option to choose Do not iterate, which is the default option.

Merge Text Content
This node is used to merge incoming text content documents with matching text content documents
into the library project configured. For every incoming text content document, library document
should match the content for each of the languages in both the documents.

This workflow node has the following configurable fields:

Text Content Library(s) – Enter project names or smart name that resolves into multiple projects.

Ignore Case while matching–Select this field to match only the content, ignoring the case.

Ignore white space while matching– Select this field to ensure that the leading and trailing spaces are
ignored.

Approve Content Enable this field to approve the content merged. When the master language of the
merged content is not approved already, then the newly added language will not be approved.

Library Upload Folder – Specify the folder, where the copied document should be placed in library
project.
 

 

Run Report
Use this node to generate a report for the incoming document(s)/ Current project/other reports
according to the setup in the node.

Details Tab
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You can Create Report for

• Incoming Documents: Choose this option to generate a report for the incoming documents into
this node. If there are no incoming documents, the node will fail.

• One Report for All Documents option generates a single report for all the incoming documents.

 

 

• Current Project: Choose this option to generate report for the current project.

• Other: Choose this option to generate any other report.

You can choose the Report Template, Target Report Name and Target Project and Target folder or
add a smart names for these fields.

Note:  It is mandatory to mention the Report Name.

Parameters tab

You can specify the parameters that are required for the report to be generated in this tab. If no
parameters are provided, default parameters configured in the Report setup page is considered.

• Parameter Name: Should be same as the name configured in Jasper Report. When the
parameter name does not match with the report parameter name, the node skips that
parameter altogether.

Note:  The name seen on the Report Setup Page is a label and is not same as the field in the
Jasper Report.

• Parameter Value: Define the value for the parameter set and it is a SmartName field.

In case there are wtc(table content) document references in the attribute category where you are
creating a report, and if the report template is PDF then the Table Content Preview is merged into
the report or else the Preview PDF report will be generated seperately.

Now choose the Report Template, Report Name, Project and the specific folder in which the report is
directed.
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Note:  You can read more about the set up of report parameters here.

Reuse Text Content node
This node helps you to reuse the text content documents that are referenced in the incoming artwork
document. This is done by matching and replacing them with the library documents or the text content
document is updated with SmartText that refers to library documents.

 

 

Text Content Library(s) Specify project names or smart name that resolves into projects.

Every text content document referenced in the artwork are searched in the mentioned Text Content
Library Project and if matching document is found, then based on the node configuration

• Create Smart References for Library Document : Text content document is updated with Smart
References to reuse the library document and all language content is also updated with smart
reference(s) and are also resolved automatically.

Delimiters: You can specify the delimiters that allows the workflow to split the available text and
search in the configured library. This field is a free text field, but the input is expected in certain
format to avoid any wrong match/splitting of string.

For Example : \n|,|.|||

• Replace with Library Document: Referenced text content document in the incoming artwork is
replaced with the matching document from the Text Content Library specified.

If the input Text document is inheriting content from another language, then the inherit content
settings is respected while updating the text with Smart Content.

Ignore Case while Matching:  When enabled, content matching ignores cases. By default, this option is
selected.

Ignore white space Select this option is to ignore the leading and trailing spaces. By default, this field
is selected.
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Remove Member
This workflow node allows you to remove User(s) / Group(s) / Role(s) from a project, who have no
approvals or task assigned to them. You can also remove the user(s) or group(s) assigned to a specific
role.

Members tab

In this tab, you can choose multiple member rows for removing at the same time.

 

 
You can specify to Remove from the project , either

• an User
• or a Group where an user is specified
• a Role completely
• member(s) of the Role

Name and the Role fields in this tab are SmartName enabled, and resolves values in the workflow.

Iterate tab

You can choose a Project/Document attribute or task specification via a smart name and Iterate Over
Attribute.

When iteration is on, each of the member rows are evaluated for each value of the attribute and then
the members are removed accordingly.

Note:  When the attribute value is empty or cannot be resolved in the workflow, the node fails to
remove the member(s).

You also have an option to choose Do not iterate, which is the default option.

936



4WebCenter

Replace Member
Many a times members are added to the project for a specific purpose like approval and later are
removed, while new members may have to be added for other purposes. To automate the adding and
deleting of members at certain juncture in the project, you can use the Replace Members workflow
node.

Current members of the role within a project can be dynamically replaced with new members using
Replace Members Workflow node. You can specify the member or groups or member of a group to
replace a member or a group or a member of a group already existing within the project. The node has
to be specified with the following details in the Members tab and Iterator tab.

Members tab: You can add as many rows that may be need, to replace the existing members in the
current project. You can delete the row if required. A member row requires the following fields :
 

 

• Role: You can specify the role which has to be replaced from the drop down of available roles in the
project or with smart name(s). You have an option to choose a member as a part of Any Role to be
replaced or a direct member (No Role ) in the project to be replaced.

• Current Member: You can specify the current member type (user/group) in the two optional fields
where a drop down is used and a smartname dropdown is used to specify the current member who
is to be replaced from the project.

• Replace by : You can choose a new member type as either a user or a group from the drop down and
you can also further use a smartname to specify the new member or choose from the drop down.

Group Assignee: You can optionally specify a member of the group as a smart name or choose from
the dropdown. The user selected in this field will become group assignee. The user should be part of
the selected group.

Note:  This option is enabled only when groups are chosen to replace.

Iterator tab: You can specify whether there are Iterations or No iteration. When the iteration is on, the
member rows are evaluated for each Iterator Value. You can

• Iterate Over an Attribute You can choose a Project or Document Attribute orTask Specification
with a smart name.

• Do not iterate (default option)
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Note:

1. If the current member configured in the row is not a member in the role/Project, then the
replacement of member is not performed.

2. The Tasks and Approvals assigned to the current member is reassigned to the first member
replaced.

Restore from Esko Cloud
Sometimes you might want to retrieve an archived document from Esko Cloud back to Web Center
filestore. It is possible to restore the Document using the Restore from Esko cloud. This means that
the Document will be downloaded from the Esko Cloud and saved in the WebCenter Filestore.

In this work flow node, you need to specify a working Esko Cloud Archiving Asset Management
connection and the node should receive document(s) that are archived in Esko cloud.

Note:  Ensure to choose the right Asset Management connection for Cloud Archiving, in which the
document is archived.

There is an additional option to retain the archived file in the Esko cloud or not. When the Remove
Document from Esko Cloud after Restore option is chosen (by default), the Document is removed from
the Esko Cloud and it is no longer archived ( as per the document status).

Save Document Colors in Attribute
Color Trace solution supports Color Ink Books/ Pantone Standards from the ESKO Cloud.

Save Document Colors in Attribute work flow node extracts the color information from the incoming
artwork document ( ROMD properties) and saves it as attribute values in the corresponding document
in WebCenter's  #COLOR Library Project.
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To extract the information from the incoming artwork, you need to define the following

• Document Attribute in which the values are stored

• On matching the incoming file with the existing document in WebCenter, the work flow node
progresses step by step in an orderly fashion.

• Firstly, checks if a color with the matching name exists in the specification. The attribute value
for #COLOR Name is found, when they are matched. If no match is found, then it is checked in
the preferred books.

• If the preferred book is not mentioned or not matched in the preferred book, the #COLOR
LIBRARY is searched for the color name.

• While searching in the #COLOR LIBRARY, a search is made to match the attribute "#COLOR
NAME” and “#COLOR BOOK”. If not found, then only #COLOR Name is searched for and it is
updated only if only one matching color is found. If more than one color is matched, the node is
failed.

• When the option Create if not exists is selected, then a new color document is created in the
Project  > Folder where the following attributes are specified as the cloud color.

• #COLOR NAME: Name of the color
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• #COLOR BOOK: Name of the book where the color is present

• #COLOR RGB: RGB value of the color

• #COLOR ORIGIN: Missing Color

If the #COLOR NAME exists in the project, then then same is linked to the document. Also note, that
the newly created color has a thumbnail indication that it is not a cloud color.

Select Children (Document Reference)
Using this node, you can select the documents that are referenced in the input document as a
document reference attribute value. Read more in: Document References on page 363.

This node collects the documents referenced in each of the input documents and sends them as the
output documents. Based on the settings, this task may output the incoming parent documents as
well.

In the following example, the node selects the artwork document referenced in a design file.

 

 

Double-click the node in the canvas to fill in the following options:
 

 

• Attribute: drop down listing all the document reference attributes defined in the system.

Note:  When you select the option Any Document Reference from the drop down, all document
reference children of the incoming documents are selected and added to the set of output
documents.
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• Project name: use SmartNames or type in the name of the project where the referred document
is located. This is handy when you want to filter the multi-valued document references located in
several projects.

This field is optional and by default empty.

• Fail if no Documents found: check this when you want the workflow to stop if there are no
document references for the attribute you selected.

This option is turned on by default.

• Add Input Documents to Output: check this to send the incoming documents (the documents
containing the document references) also to the output pin in addition to the selected document
references.

This option is turned off by default.

Select Document
Use the Select Document node to choose a document to be processed by the rest of the workflow.
When a workflow is started with a human task requiring documents, the Select Document node can be
used to provide documents.

Parameters
Project Name: The name of the Project containing the document to select (by default, this is the
project in which the workflow is launched).

You can select either:

• Documents in the project: then define the following:

• Name: The name of the document to select.

• Folder: The project folder containing the document to select. By default, this is the root folder.

Tip:  You can use SmartNames for the Project Name, Folder and Name parameters.

• From Project Document Reference

In 18.0.1 WebCenter release onwards, the documents that are referenced by the selected Project
Document Reference in the specified project are put on the output pin. You can scroll the drop
down list to select the document references.

• From Task Document Reference
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The documents that are referenced by the selected Task Document Reference in the currently
executed workflow task are selected. You can either select the Task Document Reference from the
drop down or select Any Document Reference. When Any Document Reference option is selected,
all documents that are referenced in the task’s specification are selected in the node.

• Documents in the Bill of Materials. When this option is selected, all the document(s) (versions) that
are in the Bill of Materials of the project specified in the Project Name field, are selected and put on
the green output pin as one token.

There is also an option to Fail if no document found. This option stops the workflow with a failed
state, if there are no documents in the defined Project location/Bill of Materials.

Select Parent (Document Reference)
Using this node, you can select the parent documents where the input documents are being
referenced as the attribute value. Read more in: Document References on page 363.

This node collects the master documents of the input documents (document reference values) and
sends them as the output documents.

In the example below, the document Christmas Bottle.zae has an ARD file as a document
reference value for the attribute  Die Line.

To select the parent when your input document is the CAD008.ard, specify the attribute ( Die
Line) in the node. The node will select Christmas Bottle.zae.

 

 

Double-click the node in the canvas to fill in the following options:
 

 

• Attribute: drop down listing all the document reference attributes defined in the system. Select
the attribute name where the input document is the referenced document.
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Note:  When you select the option Any Document Reference from the drop down, all parent
document referencing the incoming documents are selected and added to the unique set of output
documents.

 

 
• Project name: use SmartNames or type in the name of the project where the parent or master

document is located. When the project name is specified, only the parent documents that are in
this project are selected.

This field is optional and by default empty.
• Fail if no Documents found: check this when you want the workflow to stop if the parent

documents are not found.

This option is turned on by default.
• Add Input Documents to Output: check this to send the incoming document references also to the

output pin.

This option is turned off by default.

Send Notification
You can send automatic workflow notifications using the Send Notifications node. These notifications
are sent as an e-mail with a configurable subject and body. You can customize this according to your
needs.

Parameters

In the To field, type the e-mail addresses of the receivers or select them using SmartName . The
following SmartNames are supported:

• Project Manager
• Sales Person
• Workflow Master (the project member who is assigned the whole workflow as a task in the project)
• Groups
• Users
• Roles (the e-mail will be sent to the current holders of this role in the project)

Tip:  Use ; as a separator between the receivers.

In the Subject field, type the subject of the e-mail. The subject can be configured using SmartNames.
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In the Message field, type the body of the e-mail. You can use the buttons and options at the top of the
field to format your message. The e-mail body will automatically contain a link to the first document
coming into the node even if the node gets multiple documents.

Tip:

• Click the  icon to use SmartNames (for example to add Attributes, a link to a Document, the
Project name or a User name).

• In the Links section, You can find a SmartName to generate a Temporary Document Preview or a
Temporary Document Download link in the e-mail. The preview link SmartName is only available
if the admin has enabled Allow large Document preview (approval e-mail notifications) and
for download link Allow Project Members with Download permission to e-mail a link for non-
authenticated download of a Document.

•
Select some text and click  to create a hyperlink.

Set Document Attribute
Use this node to automatically add document attributes and their values to the documents processed
by the node.

Attention:  Your documents should have the attribute category (containing the attributes you
add) already assigned, otherwise the workflow will fail.

Parameters
Click + to add one of the attributes of the document's attribute category. If this is not the attribute you
wanted, click it and select another attribute.

Then double click in the Value column to enter the corresponding attribute value. You can use
SmartNames.

To remove an attribute, select it and click -.

Set Project Attribute
Use this node to automatically add project attributes and their values to the current project.

Attention:  Your project should have the attribute category (containing the attributes you add)
already assigned, otherwise the workflow will fail.

Parameters
Click + to add one of the attributes of the project's attribute category. If this is not the attribute you
wanted, click it and select another attribute.

Then double click in the Value column to enter the corresponding attribute value. You can use
SmartNames.

To remove an attribute, select it and click -.

Set Project Status
Use this node to automatically set the status of the current project.
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Parameters
Choose the project status in the Status list (it contains all project statuses configured in your
WebCenter system). You can also use SmartNames to configure a status parameter.

Set Workflow Specification
Use this node to automatically set the value of one or more specifications of the workflow you are
running.

Attention:  The specifications you want to use should already be added to the workflow task,
before starting the workflow.

Parameters
Click + to add one of the workflow specifications to the list. If this is not the specification you wanted,
click it and select another of the workflow's specifications.

Then double click in the Value column to enter the corresponding specification value. You can use
SmartNames.

To remove a specification, select it and click -.

Set Workflow Status
Use this node to automatically set the status of your workflow (this must be an active status).

Parameters
Choose the workflow status in the Status list (it contains all active workflow statuses configured in
your WebCenter system). You can also configure SmartNames to set the status parameter.

Start Approval Cycle
Use this node to start an approval cycle on any incoming document, and wait until the approval cycle is
finished.

Parameters
Choose to either:

• Use the default approval setup: This is the default approval setup of the incoming document. If no
approval setup exists for it, the default approval setup of the folder containing the document, or
failing that, of the project containing the document, is used.

• Use the approval setup of another document. In this case, enter the Project Name of the project
containing that document, and the Document Name.

You can use SmartName for both the Project Name and Document Name.

Note:

• If there is no active approval setup in your project or you chose to use a document that has no
approval setup, this node will fail.

• If the approval was already started, it won’t change. The node will wait until the document got
approved or rejected.

• If the document was already approved or rejected this node will fail.
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Start Approval Stage
Use this node to start an approval stage in a workflow and build a staged approval. You can set up an
approval stage in the workflow similar to a stage in the Approval Setup page in Projects.

You may have multiple stages of approval required within the same approval cycle. In such cases, you
can set up stages within the approval cycle to approve a document from different stakeholders.

Parameters

Stage Setup
The stage starts when the incoming document is received for the stage. The document is sent to the
appropriate output pin based on the outcomes defined for the stage.

Note:  If a document version is deleted while the node is waiting, the document is sent to the error pin
with the message Document version is deleted.

Approval stage has to be defined with the required information like:

• Stage Name

Provide a name to the approval stage. This is a mandatory field.

• Approver

Roles for a particular approval stage have to be assigned before the stage begins or else the
workflow will fail. Smart names can also be selected for this field. This field supports all possible
user options like User, All of Role, All of Role – One of Group, One of Role, One of Group, All of Group
and you can also have multiple SmartName fields and also multi- values for this field.

• Allow Conditional Approval Tick the check box if conditional approval has to be allowed. Read more
about it here

• Allow Forward Approval Link  Tick the check box to allow forwarding the document for approval.
Read more about it here.

• Inherit Previously Submitted Approvals Tick this check box to inherit the approvals. To know more,
read about it here

• Keep Forwarded Approvals Tick the check box to retain the forwarded approvals when a new
version is uploaded. Read more about it here.

• When one User Rejects Specify how document rejection should be handled. To know more on this
option read here

• Require review state on all annotations Specify how the review on annotations has to be handled
by approvers. To know more, read here

Due Date
Specify the due date for the approval stage. To know how to set up, read here

Approval Settings
Specify the setting for approval in this tab

• When a new version is uploaded You can read how to set up here

• Approval Master You can read on how to set up here

• Email Notifications You can read on how to set up Email Notifications here
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When a New Version is uploaded

When a document's approval cycle is started, and a new version of the document is uploaded, then
the approval cycle is automatically stopped. You can define what happens when the approval cycle
restarts.

In the When a new version is uploaded setting, choose either:
 

 

• Approval Restarts from Current Stage to keep the approval stages already completed (typically
approved) and restart the current stage. People who already approved / rejected the document in
the current stage will have to evaluate it again.

• Approval Continues to keep all the approval actions already done. Only people who have rejected
the document will see it again (to check whether the reason for their rejection was corrected).

• Go to New Version Pin redirects the uploaded new version of the document to the New Version
Uploaded output pin if the approval has already started. When no rule is specified, then the
approval of the document is in Waiting for workflow status.

The approval rule will be initialized, when the workflow starts an approval stage. Depending on the
stage that is started next, the inheritance of Stages/ Approvals is determined as follows:

• A new stage that was never executed before: All stages are inherited, except for the stage that
triggered the Go to New Version Pin.

• A previous stage: All stages are inherited up to the one that needs to be started.
• Same Stage: All previous stages are inherited.

Note:

• It is not possible for a document to go through two New Version Uploaded output pins in a row. This
is to prevent endless loops in the workflow. Go to New Version Pin setting in the second stage will
be overruled. In such a case, the stage is restarted.

• The new version can also be uploaded, when the approval is in a waiting for workflow state where
approval is required, but the workflow is pending completion of a manual task.

• When the document was already in a waiting for workflow status and a new version is uploaded,
the new version of the document will also be in waiting for workflow status and when entering an
approval stage node, the new version uploaded setting gets executed in this node.

Finish Approval Cycle
Use this node to finish the approval cycle of the incoming documents and send e-mail notifications.
Since there could be many stages in an Approval cycle, a workflow step is designed to determine the
completion of the approval cycle. The output pin of this node denotes the final approval status of the
document.

E-mail notifications:
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• No Notifications: No e-mail notifications will be sent when the Approval Cycle is completed.
• Default Notifications:

E-mail notifications are sent according to the notifications setup defined in the Document Approval
Setup, Folder Approval Setup, Project Notification Setup and System Notifications setup, each time
falling back to the next level if that level is set to default.

• Custom Notifications: Choice to send an e-mail notifications to the Project Manager, Involved
People and/or Project Members when the approval cycle is completed.

Documents with similar approval statuses are directed to the same output pin.

For example, two documents arriving in one token with final approval status as Approved would be
shown in the Approved output pin. The error output pin is split per document to view the error for each
document.

The final approval status of the document shown in the output pin is

• Approved: If the final status of the incoming document is approved
• Approved with conditions: If the final status of the incoming document is approved with condition
• Rejected: If the final status of the incoming document is rejected.
• New Version Uploaded: When a new version of the document is uploaded after all the approval

stages are completed then the document is directed to this pin.
• Error: For example, when there is no incoming document.

Submit Workflow
Use this node to launch a workflow in Automation Engine from WebCenter.

During execution this node will:

• connect to Automation Engine using the specified Workflow Connection.
• launch the workflow in the specified Automation Engine Job / Container

The incoming documents will be processed according to the Send incoming Documents option
setting. If there are documents to be sent, they will be copied to the specified Job or container and will
be added to the start node of the workflow in Automation Engine.

When the workflow is finished in Automation Engine, the WebCenter node will continue over the green
output pin. During execution, the workflow feedback shows that it is running on Automation Engine.

Note:  Your Administrator must have configured a Workflow Connection of the type Project/Workflow
(JDF) for this to work. See Configure Workflow Connections on page 418 in the Administration Guide.

Parameters Tab
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Workflow Connection:

Select the JMF type workflow connection (configured by your Administrator) from the drop down. Read
in: Configure Workflow Connections on page 418

Workflow Name:

Enter the name of the Automation Engine workflow to launch. You can use SmartNames.

Attention:  The Workflow Name is case sensitive.

Workflow Priority:

This parameter allows you to launch a workflow with a Normal, Low and High Priority. The default
option is Normal. The value is represented as sw.priority.low, sw.priority.normal or sw.priority.high if
you are using SmartNames.

Send incoming Documents (by default):

Check this to send the incoming documents to Automation Engine (e.g. because of an earlier submit or
a sync operation).

Select the check box Also send previous version with Document name sux to send the previous
version of the file as well.

Note:  Specify the mandatory sux when enabling this option. The previous version is submitted only
when a sux is specified. For example, if the name of the file name is file.pdf and the sux is _PVS,
the previous version will be submitted as file_PVS.pdf.

Choose if you want to launch the Automation Engine workflow on the files in:

• an Automation Engine Job; in this case, enter the Orderid and the Sub-orderid of that job.

• an Automation Engine Container (only if you use Automation Engine 12.1 or newer); in this
case, enter the path to the container in the Folder field, in the format file://aeserver/
containername.

You can use SmartNames in all of these fields.

Workflow Parameters Tab
To map your WebCenter Project Attributes to the Workflow parameters in Automation Engine, specify
them in this tab.

Note:  This is only supported if you use Automation Engine 12.1 or newer. Read also Add Documents
from Automation Engine on page 463
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You have the following options that you can enable:

• Add Project Properties to add the WebCenter project properties as Automation Engine workflow
parameters.

• Add Document Properties to add the project properties as parameters.

• Add All Project Attributes to add all the project attributes. They will be available as
project.attributename in Automation Engine.

• Add All Document Attributes to add all the document attributes. They will be available as
document.attributename in Automation Engine.

• Add All Task Specifications to add specifications.

• Define Custom List to type in the specific Parameter Name and specify their values manually in the
resulting columns below.

• In the left column, specify the workflow parameter name. It will show up as that workflow
parameter name in Automation Engine.

Note:  This list will overwrite the previously added values (For example, add all project
attributes as "project.attributename”).

• You can type in a text value or use SmartNames to specify the workflow parameter in the right
column.

Note:

The default behavior is to send no parameters unless specified. However, if you had enabled the Map
attributes to Workflow Parameters in a previous version, all the above options except the Define
Custom List are sent by default.

Manually force the node to an output pin
Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

This feature is useful, when the feedback from Automation Engine is not received, and you want to
let the WebCenter workflow continue after some manual correcting actions are done.
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Sync Workflow
Use this node to sync the current WebCenter project with the Automation Engine job configured in
your Workflow Connection. This syncs the WebCenter project data with the Automation Engine job
parameters.

This node uses the synchronization settings from the project/template setup by default. However, you
can setup alternative synchronization settings in the Sync Settings tab.

 

 

To change the project settings:

• Enable Override Project Settings and configure the following settings:

• To associate the workflow with a different workflow connection, select Override Workflow
Connection and Select new Workflow Connection from the drop-down.

Note:  This drop-down lists all the connections listed on the Project > Configure > Workflow
Connection page.

• For overriding the copy document settings, enable Copy Documents when Synchronizing and
select the specific setting:

• Only Documents in Folders: Select this to specify one or more folders in this editable field.
Use ; as the separator. Only the documents in the specified folders will be synchronized.

Note:

• If one of the specified folders does not exist in the project, the node will skip the workflow
synchronization.

• To specify the root, leave the field empty or as “[root]”.
• You may also specify the folders using wildcards. For example, A* will match the folders

A, ABC,and Amadeus.

• Only Approved Documents: Use this setting to synchronise only the approved documents.

• Only Documents matching: Type in the names of the specific documents that you want to
synchronise. This field accepts wild cards.

Note:  If Copy Documents when Synchronizing option is not checked, no documents are
synchronized.
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Specify the WebCenter Project Attributes that should be synchronized as Job Parameters in
Automation Engine. Configure the settings in the Job Parameters tab:

• Push All (default): All the Project Attributes from the project attribute category are pushed as Job
Parameters.

• Push None for not pushing any Project Attributes to Automation Engine
• Push Custom List: When you select this, you see two columns and two buttons:

• Select from All Project Attributes to add one or more attributes listed in the column. The  >>Add
All (Filtered) Attributes adds all attributes listed in the column.

• Select from Selected Project Attributes to remove one or more attributes listed in the column.
The << Remove All (Filtered) Attributes removes all attributes listed in the column.

 

 

Note:  The Sync Workflow node will push only the attributes that are assigned to the WebCenter
project in which the workflow is executed. If the attributes specified in this node are not assigned to
the Project, these will not be pushed.

Executing the node results in the project being synchronized with Automation Engine as per the
settings from the node and the Project in which the workflow runs. The workflow will wait until the
synchronization is finished and show an error in case this fails.

Warning:  When you push a custom list of attributes to Automation Engine as job parameters,
you may lose some of the existing job parameters. This happens if you are using the old JDF
policy on Automation Engine. Read about the JDF policy in: http://help.esko.com/docs/en-us/
suite-general/14/otherdocs/AE_Job_Parameter_Policy.pdf

Manually force the node to an output pin
Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

This feature is useful, when the feedback from Automation Engine is not received, and you want to
let the WebCenter workflow continue after some manual correcting actions are done.
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Sync Chili Variables
You can use this node to sync the attributes with the chili document.

When the node is executed for incoming CHILI documents, only those CHILI variables with data type
Text and Image are processed.

 

 

Ensure that the referenced text content documents in the incoming chili document contains the
attribute ARTWORK_VARIABLE or the chili variables in the incoming document is in the format

<element type>_L<x>_I<y>

where x and y are integers.

Basic Attributes are also synced if CHILI Variable name matches exactly with the Attribute Name. For
Images, the variable name of CHILI image file should match with ARTWORK_VARIABLE present in the
attribute category.

A new document version and a new thumbnail of the chili file is created after the workflow is
successfully completed.

Table Content Preview Report
This node allows you to generate a pdf report of the Table content document selected in the workflow.

The report is generated based on the preview of the document which is saved in the selected target
folder specified in the node. You can also select the Generate separate report per language option to
generate language specific reports.

When multiple Table Content Documents are received by this node, then separate reports are
generated for each input document.
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Report generated is named as <name of input document>_report.pdf. If the report is already
present, then new version of the report is created.

And when the report is generated for specified languages, then it is named as < name of input
document>_report_<language code>pdf.

By default, Use Table Content locale mapping is selected, and the locale mapping is done as per the
incoming table content document for which report is generated. You can choose to change the order
of language mapping in the incoming table document by selecting Use custom locale mapping  and
choose the languages for each locale number for which report has to be generated.

 Update Text Document
This workflow step allows you to specify or update Text Document properties such as:

• Text Content
• Role Mapping
• Languages
• Approval

954



4WebCenter

Text Content
In this tab, specify the properties in the Text Content Field and the corresponding values in the
SmartName supported Value field.

You can specify or update the following properties and their values in this tab:
 

 

• the Element Type of the Text Document. You can select from the list of text content element types
supported in the system.

Note:  The Element Type drop down is configured as a List. Read more in:  Text Content Element
Types on page 492

• Invariant : Specify this as True if translations are not required for a particular Text Document.

Note:  If the Invariant is set as True, then all translation languages will be removed from the
incoming document.

• the Approval Setup:

• Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

• Type of Text: Simple or Rich Text. If the Type changes from the existing type, the document status
will become Draft.

• Inherit Content From :

You can choose to inherit content one of the options below

• Default: Will inherit the content from the language that is configured to follow in the Language
List.
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• None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.

• Master Languages: Can choose any of the languages from the master language list.

By default Disable is chosen which will not allow Inherit content.

Role Mapping
This tab allows you to map Content Permissions to Roles. To specify the new set of permissions or to
specify permissions in a workflow:

1. Enable Set Permission. This will show the Permission Settings.
2. Select the Content Permission (Add Language, Editor, Approver or Content Manager).
3. Set the corresponding Language from a list of all the text content languages supported in the

system.

Select [All Other Languages] to specify permissions and role mapping to all languages without
permission assignment in one go.

Note:  The Content Manager has permissions to all languages by default and cannot be specified
per language.

4. Specify the Roles corresponding to the selected Content Permissions. The drop-down lists all Roles
configured in the system.

Languages
This tab lets you:

• add and remove languages to the document or Inherit content from the language configured in
document

• update or create actual text content

To do an Action:

1. Select Language – You can either select from the drop-down (listing all the languages present in the
system) or use a SmartName in this field.

Note:  If your SmartName points to a multi-value attribute, it will resolve to multiple values.

2. Specify the Action: Choose from Add/Remove/Update/Inherit.
3. You can add a condition where the workflow node can inherit/add/update/remove elements. There

may be a combinations of different conditions that may be given.

Condition Action Possible

Always Add, Remove, Update, Inherit

New Value is not empty Add, Update, Inherit

Current value is empty/not available Add, Update, Inherit

Current value is empty Remove, Inherit

Current value is not available Inherit

Current value is empty and new value is not
empty

Add, Update

4. Define the corresponding Value. This is the field where you can type in the actual text content.
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Warning:  If a language is specified in more than one row, only the settings specified in the last
row will be valid.

Approval Tab
This tab allows you to set Approval Status (per language) via workflow.

Note:  You can use SmartNames in this step and if your SmartName points to a multi-value attribute, it
will resolve to multiple values.

1. Select Language – You can either select from the drop-down (listing all the languages present in the
system) or use a SmartName in this field.

2. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

Update Table Content
This workflow node allows you to specify or update Table properties and Table values. You can add:

• Role Mapping
• Languages
• Approval
• Add / Remove / update/ inherit elements and set values for nutritional facts elements

Settings
In this tab, specify the properties in the Field and the corresponding values in the SmartName
supported Value field.

You can specify or update the following properties and their values in this tab:

• Invariant : Specify this as True if translations are not required for a particular Document.
• Approval Setup:

• Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

• Inherit Content From :

You can choose to inherit content one of the options below

• Default: Will inherit the content from the language that is configured to follow in the Language
List.

• None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.

• Master Languages: Can choose any of the languages from the master language list.

By default Disable is chosen which will not allow Inherit content.
• Type: Simple or Rich Text. If the Type changes from the existing type, the document status will

become Draft.
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Values
This tab lets you add / remove /update table statements and their values. Use a single row per element
or statement.

 

 

• Element – The table Element Type to be added or removed. This field is a smartname dropdown
populated with the list of table element types supported in the WebCenter.

• Instance Sequence – Specify the instance sequence number. This number indicates how many
occurrences of an Element is present in a Table. The default value is 1.

• Language – You can either select from the drop-down (listing all the languages present in the
system) or use a SmartName in this field.

If the specified SmartName resolves to multiple languages, then the specified configuration(from
that row) will be applied to all of them.

• Action: Choose from Add / Remove /Update/ Inherit .
• Condition You can add a condition where the workflow node can inherit/add/update/remove

elements. There may be a combinations of different conditions that may be given.

Condition Action Possible

Always Add, Remove, Update, Inherit

New Value is not empty Add, Update, Inherit

Current value is empty/not available Add, Update, Inherit
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Condition Action Possible

Current value is empty Remove, Inherit

Current value is not available Inherit

Current value is empty and new value is not
empty

Add, Update

• Value – Field where you can specify the actual content. You can enter the data or use SmartNames.

Tip:  Use List SmartNames(pointing to an Excel sheet based List) to provide content in a smart way.

Note:  If you specified the action as Add for an existing value, the value is updated. If the element
does not exist in the document, the element and the value will get added. However, if the action is
Update and the element does not exist, the row is ignored.

Note:  If you are updating a SmartName table using this node, the value from this node will replace
the SmartName in the table.

Approval Tab
This tab allows you to set Approval Status (per element, per instance and per language) via workflow.
This allows you an automated way of approving the nutrition fact statements.

Note:  You can use SmartNames in this step and if your SmartName points to a multi-value attribute, it
will resolve to multiple values.

1. Select the Element or the statement.
2. Specify the Instance Sequence of the element.
3. Select Language – You can either select from the drop-down (listing all the languages present in the

system) or use a SmartName in this field.
4. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

Upload to Asset Management System
The Asset Management configurations allow you to push a document to the asset management
system. The Upload to Asset Management System node allows you to specify the Asset Management
connection or a cloud connection and their metadata mapping.

Specify the Parameters
Choose the Asset Management Connection from the searchable drop-down. You can choose from
either

1. Esko Cloud connection which has an Archiving service connections that are already set up in the
system by the admin user.

Then the Workflow node allows you to configure the following parameters:

• Only archive old Versions of a Document when this option is selected, the versions uploaded
into the Esko Cloud are limited to all the versions that are no longer being linked to from within a
Project in WebCenter.

For example, if there is a#Document with 3 versions: version1, version2 and version3#and two
Projects
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ProjectA and ProjectB where ProjectA#contains Document version3 and

ProjectB contains Document version2.

On executing this workflow node, only the Document version1 (oldest) is uploaded to the cloud.

When this option is not selected, all versions of the Document are uploaded to the Esko Cloud.

• Remove Document from#Filestore#after upload to Esko Cloud: When this option is chosen,
(selected by default), the#documents are removed from the#File store on successful upload to
the Esko Cloud.

Note:  At a time, only one Document#version can be uploaded to the#Esko#Cloud and an
uploaded version cannot be overwriten.

2. Asset Management Connection

Note:  If you leave this field blank, the workflow will look from an Asset Management system
that acted as the source for the incoming document. This step will fail if it cannot find any Asset
Management configuration.

Define the DAM specific parameters

• Asset Path
• Specify if the zip files should be expanded on the MediaBeacon server on upload.

• Specify if it is a New Asset or a New Version of an existing asset.

• Specify the MediaBeacon Namespace and any parameters with its value.

Wait for View Files
With this node, you can

• have view files available before starting an approval cycle or starting a task
• detect warnings in the view file generation.
• re-generate view files after they are flushed

For example, before starting an Approval Cycle.

During execution, the node waits for the view file generation of the incoming documents and proceeds
to one of the output pins according to the view files status:

• If the view files are available or if the document is not viewable, the document is sent to the
Succeeded output pin

• If the view files are available but if it contains a warning, the document is sent to the Warning
output pin
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Note:  The Task Details of the view file generation has the text “Task(s) generated warnings”

• If the view file generation failed, the document is sent to the Failed output pin.
• If there are no incoming documents, the node fails and the token is sent to the Error pin.

If there are multiple documents in the incoming token, the node will wait until the status of all the
document(s) is known, and then proceed to the appropriate pins.

Note:  If the view files were deleted, the node will re-start the view file generation first before waiting
for its status.

Manually force the node to an output pin

Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

Wait
Use this node to pause the workflow for a certain amount of time (for example to wait for a user action).
The next node will start processing after the wait time is over.

Parameters
Release date:

By default, this is set to the current date (using the SmartName [Current Date]). You can change
it using any SmartName that resolves to a date (not only the SmartNames from the Date category but
also for example an Attributes or Specifications category SmartName resolving to a date).

Note:  When using an attribute or specification SmartName, the attribute category must be set on
the project in which you run the workflow, or the specification must be set on the workflow task.
See Project and Document Attributes on page 303 in the Administration Guide for more details about
attributes, restricted sets and attributes categories.

In Days offset, Hours offset, Minutes offset and Seconds offset, you can add a number of days,
hours, minutes and seconds to wait after the Release date. For example, if you set the Release date to
[Current Date] with an Hours offset of 2, the node will pause the workflow until two hours after
the workflow was started.

You can use SmartNames in all these parameters.

Select Count only working days if you are setting the node to wait a number of days and you only want
to count business days. For example, if you set it to wait two days and start it on a Thursday, it will start
again on the Monday after that. This is selected by default.

Manually force the node to an output pin
Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

961



4 WebCenter

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

Task Types
A Task Type can be either Manual or a Task Type with a Workflow. Both types can be added to a
workflow from the canvas.

The manual tasks require human intervention and they can be used as either individual tasks or as
workflow nodes.

Editing a Task Type
You can edit a Task Type in a workflow by double-clicking on a node and specifying details in the Edit
Parameters dialog. This dialog is task specific and has SmartNames-enabled tabs:

• Parameters
• Specifications
• Due Date
• Iterate
• Notifications
• Output

Note:  Click the  icon to use SmartNames in this node.

Parameters Tab
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Fields Description

Name The name of the task.

By default, the name will be derived from the
Task Type.

When a task is executed multiple times, the task
name will automatically get the sux _1, _2, and
so forth.

Description Type in a fixed description for the task assignee.

Status The initial status of the node. By default, the drop
down will have the following statuses:

• Created

• In Progress

• Completed

Note:  It will list all the statuses configured in the
task type. Read in: Add Task Statuses on page
857

Update the task if existing By default, this is off. The task will create a new a
task.

Enable this to update the task if it already exists.
If this happens, the task will get back from a
completed status to an in-progress status.

Assignee Specify the task assignee:

• Select Role (Default):

• Select Group

• Select User

Read more below:

Task Type Assignments

• Select Role (default): You can select the assignee from a SmartName enabled drop down with all
the roles in the system (visible to the current user):

• Project Manager (default): The project manager of the project containing the workflow.

• Project Creator : The user who created the project.

Note:  In case the project was created earlier than 18.1 or when the project creator does not have
access to the project, and the creation of task fails.

• Sales Person: The sales person of the project in which the workflow runs.

Note:  The Sales Person should be invited to the project.
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• Workflow Master: User/group/role to which the workflow is assigned (task assignee of the
workflow task).

• All other configured roles visible to the current user.

Use the Assign To field to specify the iteration settings for the task:

• One of Role setting for creating and assigning one task for the role.

• All of Role – One per Group setting for creating and assigning individual tasks for each group /
user in that role. Only one task is created and assigned per group.

• All of Role setting to create and assign individual tasks for each unique user in the role (including
users in groups assigned to the role).

• Select Group: You can select the assignee from the drop down listing all the visible groups. Specify
the Assign To field as:

• One of Group to create one task assigned to the group.

• All of Group to create and assign tasks for each user in the group.

• Select User from the drop down of all the users visible to the current user. The user should be
invited to the project.

Note:  The role / group /user should be invited to the project. If you are using a SmartName or free text,
the resolved role / group name should be invited in the project.

Note:  If the Project Manager or the Workflow Master is role / group, it follows the Assign To settings.

If your Assign To field settings create multiple tasks, the workflow will wait until all of these tasks are
finished to progress to the next step.

Specifications Tab
Use this tab to set the values for the task specifications. These values can be either fixed values or
selected using the SmartNames.
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Note:

If you want to see the specifications in the specifications tab you should add them in the task type.

Output Tab
Specify the output documents in this tab. The fields on the Output tab are:

Fields Description

Add as output • All task documents: Output all the documents
that are attached.

• Only new task documents: This excludes all the
task documents and the documents that were
previously available. This results in the new
task documents.

Note:  If there are new versions, these are also
considered as new documents.

• No documents: Set no documents as output of
the task.

Name Filter the output document by name or document
extension. For example, *_1.pdf files.

 

 

Iterate Tab
You can iterate task creation from a Task Type node. The Task Type node will create tasks depending
on the Iterator value.
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The default option is Do not Iterate.

To create multiple tasks over a Project /Document attribute or a Task Specification, select it in the 
Iterate over Attribute field.

 

 

You can select this attribute via a SmartName or by manually typing in the attribute. Based on the
resolved value of this attribute, this node will create the tasks. For example,

• If the SmartNames resolves to a multi-value (text) attribute indicating languages, the node will
create tasks based on the language variants. You will get the same result when you type in the
attribute values.

For example, if you type in Dutch | Spanish | English, the iterator value will be “Dutch”,
“Spanish” and "English". As a result, there will be three new Tasks corresponding to each language
attribute value.

 

 

For each iterator value, the node will create a task with the value of ‘iterator value’ filled in as the
value for the corresponding parameters.

• If the attribute/task specification is Integer type or if the SmartName resolves to an integer or if
you type an integer (for example, you type 3), the projects will be created based on these numbers.

For example, if the value resolves to 3, the iterator value will be 1, 2 and 3. As a result, this task type
will create three new tasks.
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Note:

• If the attribute is missing in the Project, you will get an error:

Attribute not found

• If the resolved attribute is empty, your error message will be:

Resolved
                iterate attribute value is empty

If you iterate over a project attribute or task specification, all incoming documents are added to the
tasks.

When you iterate over a multi-value document attribute (for example, Dutch | Spanish |
English):

• if the incoming document has two values for the Languages (the Iterator) attribute, Dutch and
English, this document will be attached to the Dutch and English Tasks.

• if you have documents where this attribute is empty, they will not be added to the iterated tasks.

• if you have documents without this attribute, they are attached to all the created tasks. However,
these documents will be transferred to the output pin (of the task type node) only once to avoid
duplication.

Note:  The output of this task type node will depend also on the Output Tab settings.

Tip:  You can use the Iterator Value in combination with other node parameters such as Role.
 

 

If you select multiple assignees (for example, by selecting All of Role) for a task, the node will execute
the Iterate over an attribute function first. Based on the Iterator value and Assignee, it will then create
tasks for the multiple task assignees (all of role in this example).

This allows using the iterator SmartName in the assignee fields for roles and groups. Read in:
Parameters Tab on page 962.

Notifications Tab
This tab allows you to create and send Notifications without adding a Send Notification node.

The configuration is almost the same as the Send Notification on page 943 node. However, the are
extra SmartNames available in this tab to refer to the just created/updated task.
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In the To field, type the e-mail addresses of the receivers or select them using SmartName . The
following SmartNames are supported:

• Project Manager
• Sales Person
• Workflow Master (the project member who is assigned the whole workflow as a task in the project)
• Groups
• Users
• Roles (the e-mail will be sent to the current holders of this role in the project)
• Current Task Owner (E-mail). Filled in by default.

Note:  This is not available in the Send Notification node.

In the Subject field, type the subject of the e-mail. The subject can be configured using SmartNames.

In the Message field, type the body of the e-mail. You can use the buttons and options at the top of the
field to format your message.
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Tip:

• Click the  icon to use SmartNames (for example to add Attributes, a link to a Document, the
Project name or a User name).

•
Select some text and click  to create a hyperlink.

•
Select the icons  to change the text direction from right to left or back when working
with languages like Arabic or Hebrew.Use SmartNames Link to Current Task from the category
Links and Current Task Due Date from the category Date.

Note:  This is not available in the Send Notification node.

Due Date Tab

Due Date Tab
 

 

In this tab you can setup the due date by configuring the following fields according to your needs.

Fixed Lead Time
Specify the Based on date as the reference. This field is SmartName enabled and you can use values
such as [Current Date], [Workflow Duedate], [Workflow start date] and any date-attribute as the
reference.

Also specify the Planning as either Forward or Backward.

The lead time is added or subtracted to your reference date depending on this setting:
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• If your Planning is set to Forward, the Lead days and hours are added.

• If your Planning is set to Backward, the Lead days and hours are subtracted.

Percentage Lead Time (Compressing)
Another way to specify the due date is by specifying the lead time in percentage. A percentage of the
difference between the current date and the reference date.

The Based on date is the SmartName enabled reference date. Use [Current Date], [Workflow
Duedate], [Workflow start date] and any date-attribute as the reference.

If your workflow due date is on 27th Thursday and the current date is the 13th,

• The number of days is calculated as 10 working days.
• If your percentage set as 20, the task will add two working days to the current date to calculate the

task due date.

 

 

Workflow Constructs
Workflow constructs are "tools", nodes that help you build the workflow. They help control the flow of
data and/or documents through the workflow.
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Data Splitter and Data Collector

Data Splitter
Use the Data Splitter if you want the next step in the workflow to process each file individually.

You cannot specify parameters for this node. When a token arrives with multiple documents, Data
Splitter will be split them up as separate tokens with a single document.

Data Collector
Use the Data Collector workflow control

• to collect all files that travel separately as individual tokens in the workflow and then merge them
before sending the group the next step.

• to wait for all files before continuing the workflow.

In the example below, four files arrive at the Data Splitter node and are outputted as four tokens with
a document each. The Design steps (a task per token) collect the design documents and sends it to
the Data Collector. This step outputs the processed files as a single token to the next step.
 

 

You can set the Error Policy:

• to Fail when errors occur

• or to Ignore Errors

Error Handler

The Error Handler node is a workflow construct with a single output pin. You can attach this to any
other node.

Note:  This node will not accept input connections.

When a workflow node has a failure, the system will check the error dot of the node. If this dot is NOT
connected to anything, and there is an error handler node on the canvas, the system will put the token
on the output dot of the error handler.
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In the example below, if Start Approval Cycle fails because there is no approval setup:

• the Error Handler will check if the error pin of the node is connected to any other node. When the
error pin is not connected to any workflow path, Error Handler will receive the error.

• the Send Error Mail node will send an e-mail to the person specified in this node.
• after the notification email, the token will be placed on the original node.

The person receiving the e-mail can then take action and retry the approval node.

 

 

Note:

• Do not connect the Error Handler node and its following nodes to the main Workflow to avoid
unexpected results.

• You only can add one Error Handler node in your canvas.

Feedback from the Error Handler node
To know the source of the error, click on the output token of the node connected to the Error Handler.
In the example below, the green output pin of the Send Error Email will show the error.
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Fork and Join
The Fork step automatically tags

• every file running through it
• and all the files that those files are related to in the next steps

This creates a tag for the group.

The Join step then groups all the files with the same tag and outputs it together.

 

 

In the example workflow:

• the designer uploads packaging designs (three files). This task will send a single token of three
files to the next steps.

• the Data Splitter  separates them into three tokens

• the Fork node tags these three files separately

• each design file gets tasks for collecting its own legal, marketing and regulatory content. This
results in 9 tasks to gather content.

• the Join node groups individual design files with related content using the tags. This step will
result in three groups of files and three create final artwork steps.

Mark and Select
The Mark and Select nodes are used as a pair. You can use Mark  to tag files in the workflow and use
Select to select those files later in your workflow.

You can have several pairs of Mark  and Select  in your workflow. By default, the tags will be set as
tag-1, tag-2, etc.
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Mark
To specify your own tag, double-click the node and enter the tag in Mark all incoming items with tag
field.

Select
You can use the drop-down in the Select all items with tag field to specify the tag for this node. The
drop-down list will contain tags specified during the Mark  step.

 

 

Router

The Router workflow control  serves to automatically decide the route that your workflow (tokens)
should follow.

When a workflow arrives at this node, the workflow will continue over one of the configured output pins
based on the specified rules. You can also create SmartName powered rules for routing.
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The screen shot above shows how to route a document through different paths depending on its
project attribute. The router decides which department should approve the document based on this
project attribute.

• These are the settings in the Router:
 

 
The rules were defined based on the attribute values. The Route to names correspond to these
values.

Note:  The rules are executed from top to bottom. Their order can be changed with Move Up /
Move Down. The last rule, no match will be applied when the other options are not applicable.
This will result in Error or a custom label.

Routing can be based on many different criteria (see the list below).

You can make all of them except the Project Status Case sensitive. Enable this option to match the
exact case.

Note:  The leading and trailing spaces are always ignored.

Adding and deleting rules
You can Add  or Remove rules. Use the options on the right hand side.

To Add a rule:

1. Click the Add button. For each additional rule another output dot is added to the node.
2. A new line appears under the current selected row (no match always stays at the bottom of the list).

Select the operator and value for your rule.

Note:  The name of the output will be the same as the matching value by default. However, you can
edit the name.

3. You can choose Move Up or Move Down to change the order of your rules, except for the no match
rule. The no match rule stays at the bottom.

Tip:  You can also set the same output token for multiple rules. To do this, select the same from the
drop down The node will then have less output dots than there are rules.

To Remove a rule:
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1. Select the rule you wish to remove.
2. Click the Remove button.

It is not possible to delete the no match rule.

Routing on Text Content Properties
 

 

Routing on Text Content Properties can be setup during execution, when setting main routing
dropdown on Text Content property, the Field selector allows following values:

Depending on the Text Content property, different options appear in the rule.

The Text Content Fields become available only if PCM license is enabled:

• Text Content Status : this is the overall status of a Text Content document. Options available are
Draft and Signed Off

• Text Content Element Status: This is a status of a particular language that needs to be selected
from language drop down. Options are Draft, Pending Sign off, Signoff Rejected and Signed off.

• Element type: All the Text Content element types supported in the system

• Approval Type: Default, All of role, one per group and One of role.

• Invariant: True or False

• Note:

Two rules apply to text Content Properties:

• Is valid if the Text Content Property value equals the value in the drop down field of the rule
• Is not valid if the Text Content Property does not equal the value in the drop down filed of the

rule.

• When a workflow comes in router having Text Content Property rules, the incoming documents will
be checked and put on the corresponding output pin as per the routing rules. If you have multiple
documents coming in, each of them is routed and put on the right pin.

Anomaly Handling: If there are no input documents, a No Input Documents error is put on the error pin.
If the Text Content Property cannot be found (for other type of documents), a Text Content Property
not found error is put on the error pin.

976



4WebCenter

Routing on Project Field

Route based on Project Field

Field list As an example, use this to...

• Project Name
• Project Description
• Project Manager
• Sales Person
• Customer Name
• Customer Location

Decide which part of the workflow to follow based
on naming conventions of the project name.

Note:  Use SmartNames to make the rules
dynamic.

Routing on Project Status

Route based on Project Status
 

 

When a workflow comes in a router checking on project status, the status of the project in which the
workflow runs is checked at that moment and matched against the values in the rule list.

Field list As an example, use this to...

Project Status

Choose from:

• All project statuses (Select from the drop
down containing all the statuses including the
custom ones.)

assign a different path depending on the status.
For example, 'Design' versus 'Correction'.
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Routing on Project Attribute

 

 

Field list As an example, use this to...

All attributes in the system Decide where to go based on the value of an
attribute 'Project Type'.

Routing on attribute values
When you configure the routing based on the attribute values, the behavior depends on the attribute
type.

For Text attributes:

• Is empty: applies when the attribute is not filled out.
• Is Equal To: valid if the attribute value equals the value in the input field of the rule.
• Is Not Equal To: applies if the attribute value equals the value in the input field of the rule.
• Contains: applies if the attribute value contains the specified rule value.
• Does not contain: applies if the attribute value does not contain the specified rule value.
• Matches: applies if the attribute value matches the specified rule value. This value can contain

wildcards and regular expressions.
• Begins With: valid if the attribute value begins with the rule input.

Note:  Leading spaces are ignored.

• Example: Attribute value = Sales Belgium and the rule says [Begins with] “Sales”.
• Ends with: Similar to the Begins with option. The rule applies if the attribute value begins with the

rule input.

Note:  Trailing spaces are ignored.

For Restricted Sets and Cascading Attributes:

• If the selected attribute is a restricted set, the rule options will be limited to is and is not. The input
field will have a drop down list with the restricted set values.

If your restricted set is a check box, the unchecked value resolves to no match instead of no.
• The cascading drop-downs defined by a list will be treated as text attributes, not as restricted set

attributes.

For Numeric Attributes (integer, float, weight, dimensions…):

The rule drop-down now has the following options:
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You can specify one or two floating point values in the input field.

Note:  When you specify lies between, the lower and upper limits will be taken in. For example, 4 lies
between 4 and 6. To exclude 4, type in 4.00001 (or 5 for an integer attribute).

When a project does not have the selected attribute (not part of the attribute category), the router will
always take the no match route.

For Multi-value Attributes:

If you are routing based on a multi-value attribute, the values are compared individually to the
specified rules.

For example, if your "Packaging Type" attribute has values:

• Label | Folding Carton

and the rules:

• is equal to Label'
• 'is equal to Folding Carton'

the router will have two outgoing pins with tokens.

Using SmartNames:

If your rule value is a SmartName that resolves to a multi-value attribute, the rule is evaluated as “OR”.

If your packaging project has a language attribute with multiple values, you may want to use this to
filter the documents (language variants with a Language attribute) to direct them through different
paths. To do this:

• Configure your Router to route based on Project Attribute Languages.

• Configure your rule to specify Languages (Document)
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If your project attribute “Languages” has the the value “English”, the router will select documents
with the attribute (a multi value attribute with values as different languages) that resolves to the value
“English”.

If the document attribute values are English and Dutch, the rule will be evaluated as:

• Project “English” is Document “English” OR
• Project "English" is Document "Dutch"

In this example, the router will direct all the documents with "English" to the first output pin and the
others with "Dutch" to the no match.

Routing on Document Reference Attributes: If you are routing on document reference attributes, the
router will treat it like text attributes. If you have a multi-valued document references, it is possible to
route based on the referred documents. It will route based on the document name of the references.

Routing on Reason(s) for Rejection

You can use the router to redirect the workflow based on the reasons selected for rejection.

The Router workflow node can collect information on the reasons for rejection of a document in any
(every) stage of the approval cycle. You can choose to enable the Handle Reasons of All Stages option
in the Router workflow node. If the option is not checked, the document is by default routed on the
reasons for rejection for the latest approval stage only.

 

980



4WebCenter

 

You can choose Handle Reasons Separately to ensure each stage is checked against the rules
separately.

Reasons chosen for rejection may be in different categories and you can route the documents
specifically on a particular category of the reason. To do so, specify the rule as 'reason @ category'.

Routing on Document Name
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Field list As an example, use this to...

Note:  Select Include the File Extension if the
entire document name has to be checked for.

Otherwise, the extension is parsed off before
doing any comparison.

Decide where to go based on naming conventions
of the incoming document.

Your incoming documents will be routed and put
on the right pin based on the name.

Example: If you have three documents “A.jpg”,
“B.jpg” and “C.png” with two rules “contains jpg”
and “contains png”,

• the two .jpg documents will be in the output
pin .jpg. These two will follow the workflow
together

• and the .png document will be in the .png pin.

If you are including the file extension, you can
check for types of files using ends with rule.

Routing on Document Attribute

 

 

Field list As an example, use this to...

All attributes in the system Decide where to go based on a document
attribute such as "Packaging Type" which can have
values like Label, Folding Carton, Corrugated Box,
etc..

The incoming documents will be checked for the
specified attribute and will be moved to the right
pin based on the first matched rule.

If you route on a multi value attribute of the
document, that document can occur on multiple
output pins (each value is evaluated separately,
which is in line with routing on a multi value
project attribute or task specification.
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Read about using different types of attributes and SmartNames in Routing on attribute values on page
978

Routing on Workflow Specifications

Field list As an example, use this to...

All specifications of the workflow task (so not all
specifications in the system).

Note:

If you want to see the specifications, you should
add them in the task type.

Decide where to go based on decisions taken
earlier in the workflow and saved in the workflow's
task specifications.

For example, you can use Set Workflow
Specification node first to set the specification
values and use them in the Router later on in the
workflow.

Routing on Text Content Properties

You can route your Text Content statements according to their Text Content Property.

When a workflow arrives at this node, this step will filter the statements and documents based on the
Text Content Property and route them based on the rules.

When you select Route based on Text Content Property, you have the following options:

Text Content Status
This is the status of the overall document including the individual language statements. You can route
based on whether the document is in Draft state or is Signed Off.

You can add one Language parameter in the node. In this example, the Master Language
SmartName is used.
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In the example above, the routing step:

• redirects Draft documents to Set Document Attribute step.

Text Content Element Status
This is status of a particular language Statement that needs to be selected from language drop down.
You can route based on:

• Draft

• Pending Sign-off

• Sign-off Rejected

• Signed Off

 

 

In this example, the Router routes the Signed off elements to the next step, whereas the other
elements are sent back to the editors.

Element Type
All configured Element Types are available and you can create routing rules based on a type. For
example, you can route all Warning statements to Legal Approver.

See the example screen shot below.
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You can route documents based on it's Approval Type. Configure the routing rules based on the fields
below.

• Default

• All of Role – One per Group

• One of Role

Invariant
To route documents based on whether translation is needed or not, you can use the Invariant
parameter.

 

 

In the example screen shot,

• the documents marked as Invariant =True are routed to Completed.

• the documents marked as Invariant =False are routed to the Translation flow.
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Stop
Use the Stop node to stop the workflow before being completed. When a workflow token arrives at this
step, it stops the workflow.

Note:  The task status will be set as Completed if at least one route of the workflow gets completed. If
none of the workflow routes are completed, the workflow will end in error state.

Statuses
Use statuses node to give the workflow task in the project the desired status. The workflow task can
have any of the statuses defined in the Task Type it was created from.

This means that you need to:

1. think about which statuses you need before creating the workflow,
2. ask your Administrator to create them if they don't exist in the system yet,
3. add them to the Task Type you want to create the workflow from (see Add Task Statuses on page

857),

and then create the required workflow.

If you didn't add any particular status to the Task Type, the workflow will only have the Completed
status node.

4.15.15.  Workflow Example

The example below describes a workflow from the Start node to the Completed state.

 

 

The Router (in the example renamed as Briefing Complete?) in the workflow will verify if the
briefing is completed.

• It checks if all specified Project Attributes are filled out. If it is all completed, the workflow will
continue to the Conceptual Design node.

• If the Project Attributes are not all filled out, a manual task Complete Briefing Data is created and
will be assigned to its assignees.
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• In the Conceptual Design phase, the workflow takes parallel paths. When one of the tasks is
completed its token moves to the Data Collector node. The Data Collector node will wait for the two
tasks to complete and send the tokens to the Start Approval Cycle step.

• Depending on the outcome of the Start Approval Cycle step, the workflow moves forward or sends
the token back to Design phase.

 

 

When the workflow is Completed, it will show up as completed in the Project > Tasks list. All tasks that
were created during the workflow will show up as subtasks of the workflow task.

4.15.16.  Working with Workflows

Note:  A workflow can be started by Administrators, Project Managers and people with the Change
Task right in the Project.

The workflow starts when its task in the Project (created from the workflow task type) is put in an
active status (typically In Progress).

Workflow Feedback and Actions

Viewing the Workflow Feedback
You can view a workflow's feedback from Project > Tasks page. To open the workflow feedback page
either:

•
hover over the task name and click the Workflow  icon.

Tip:  You can use the Edit button to access the Workflow Editor and edit it.

•
or click the Show Active Nodes  and Expand the mini Feedback view.
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Tip:

Show Active Nodes View zooms to the currently active node(s). If there are more nodes use the
Step Through . Read below in Troubleshooting tools on page 989.

Note:  When the workflow is not running, all controls are disabled.

In the toolbar of the workflow editor, you will see:

• some of the workflow tools,

• controls,

• the status of the workflow,
• the name of the Task Type,
• and view tools.

Read more below:

The following workflow statuses are self-explanatory.
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Workflow Controls

Use  to  Hold Workflow

Use  to  Resume Workflow

Use  to  Cancel Workflow

Note:  These actions can be performed only on Active Workflows.

Read more about Pausing and Resuming a Workflow on page 989.

Troubleshooting tools

Use  to  Highlight  the Active Nodes and Error Nodes. The workflow fades out everything else.

Use  to Step Through  all active or nodes in error state by zooming into them one by one.

Stepping into Sub-workflows
When you have embedded workflows, you can step into a sub-workflow from a master workflow's
canvas. To do this:

•
• Right-click on the In Progress

Right-click on the token above the sub-workflow node or on the sub-workflow node itself. Select the
Step into Workflow option from the context menu.

CTRL+Double-click on the token above the sub-workflow’s task node or on the node itself.

To access the master, click on the link from the top right corner of your subworkflow.

Note:

• This is only possible when your master workflow is in progress.
• You can use your browser's Back and Forward buttons after you step into the sub-workflow.

Pausing and Resuming a Workflow
The administrators, project managers and users who can edit tasks can pause the workflow by clicking

the Hold . The tokens (in a node) that are in progress will be paused after they finish.
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Note:  The workflow status will change to in Hold.

To resume the workflow, click the Resume  button. This control becomes active only when a
workflow is paused. This will move the tokens to the next step in the workflow.

Tip:

You can try holding and resuming to get out of workflow “hangs”.

After resuming, the workflow status becomes the current status.

Cancel a Workflow

A user with task edit rights (Admin, Project Manager and members with task edit rights) can Cancel 
a workflow in progress.

The ongoing workflow tokens will be cancelled and these will be moved to the error pin.

Note:

• Stopping a workflow will delete all the subtasks that are not completed yet.
• The status will change to Workflow cancelled. This is logged in the Project History. A canceled

workflow will always show the task status as canceled regardless what is already completed. You
have to enable Include in Project History > Workflow Canceled to include the cancellation events in
the Project History.

Solving a Workflow Failure

When a node goes into failure, you can either:

• retry the failed node after correcting the cause of failure,
• stop the workflow,
• relaunch(first, correct the cause of the failure) the workflow.

Note:

• We recommend you use the Error Handler node for troubleshooting your workflow.
• When a workflow has more than 5000 tokens (for example documents traveling through it), it will be

canceled and reported in the Project History. This typically happens when the workflow is stuck in
an endless loop.

Retry a Workflow Node

If you workflow failed due to an issue ( for example a missing approval setup) and you have corrected
the problem, you can retry the workflow.

Right-click on the failure icon (the red ellipse) and right-click again to Retry. Do this after you have
fixed the issue that caused the workflow failure.

Note:  The  Retry is accessible when the user has Task edit rights
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The  remains to indicate the workflow’s history.

Relaunch a Workflow at a Certain Point

A user with task edit rights (Admin, Project Manager and members with task edit rights) can right-click
on any output token with a number and relaunch.

This will re-create a new workflow task that is similar to the task that gets relaunched.

 

 

Note:

1. The workflow needs to be stopped first (see Cancel a Workflow on page 990).
2. This only works for first-level workflows, not for workflows which are already started from another

workflow.

991



4 WebCenter

Note:  When a workflow is re-launched, WebCenter automatically makes sure that any dependent tasks
will depend on the new workflow task, rather than on the cancelled one.

4.16.  Packaging Content Mangement in WebCenter

4.16.1.  Introduction to Packaging Content Management in WebCenter

WebCenter Packaging Content Management offers a simplified platform for creating, translating,
approving and managing text / copy assets.

The Packaging Content Management module offers:

• a repository / library for your text content with GS1 tagging
• re-use of your content across multiple projects
• support for a translation based or single language workflow.
• export to and import from industry standard formats
• ability to view and edit your text in the context of your artwork in the WebCenter Viewer.
• a complete approval workflow
• established content rights facilitating the ownership at different stages

4.16.2.  Working with Text Content

With the right permissions, you can edit, start approval or approve in all the following pages:

• Text Information tab. Here you can only view and perform actions on the single text document and
its elements.

• In Copy Sheet (Text Document References) attached to an Artwork or a Project. You will have a view
of multiple text documents. You can perform actions on their Master or Translation Elements. Read
more in: Creating a Copy Sheet on page 388.

• In a Task Document Rendering. Here also, you can view and perform actions on Master or
Translation Elements of multiple text elements.

• In the Viewer Text Content Widget. You can perform the same actions, but you can use viewer filters
to filter text content. Read in: Viewing Text Content

Text Document Details
When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

• Text Content

• Role Mapping

• Compare
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Text Content Tab

The Text Document > Text Information > Content tab displays all the content of the document along

with its classification and languages. To Configure Content, click on the  (gear) icon to expand and
view the following info:

• Element Type
• Approval Setup
• Type of Text

• SmartText Search

• Auto Suggestion
• Allow only Single SmartText
• Allow Inherit content
• Inherit Content from

• Character Limit
• Invariant or not

Note:  When you (as the Content Manager) change the text type, the Text Statements affected by
this change will be put into Draft status.

• Languages: The Master and Translation languages will be listed here. You can see the language
flags and the respective names. You can customize the language flags by following the steps given
in the WebCenter Customisation Guide.
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Note:  If the language selected is typed from right to left like Hebrew or Arabic, the text is displayed
or edited right to left.

Read more about the concepts in: Basic Concepts on page 488.

Working in the Content Tab
You can perform Text Content related actions in this tab if you are a Content Manager / Editor /
Approver or Add Language permission. You can perform the actions for which you have permissions
enabled.

If you are a Content Manager, you can do the following:

• Select the Element Type of the Text Document.

Note:  The Element Type drop down is configured as a  List and is only editable by Content
Managers. The regular users can see only the specific Element Type of the document as a label.

• Select the Type of text: Text can be Simple, Rich text, or Smart Name. When you choose the text
type as a Smart Name, you can view the SmartText Search field.

• SmartText Search drop down displays all the saved searches for the text content document
type. This field is optional and can be left blank. Read more in Create Smart Text in Text Content
on page 996.

You can resolve the Smart Content (containing both SmartName and SmartText) by clicking 
or saving the document.

• Enable Auto Suggestion: Suggested existing text content is shown, while you type the text
content. This option is enabled only if SmartName is chosen as the Type. When you are trying
to add text, the suggested text is visible as a tooltip for exceptionally long text statements
for accurate selection. Auto suggestion texts are taken from the results of configured saved
search.
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• Allow only Single SmartText: Restrict to allow only one SmartText in all of the languages
present. This option can be used when you have to restrict the content to a Smart Text like a
value (weight in grams).

• Make this an Invariant Text Document: Enable this, if translations are not required for a
particular Text Document. For example, Brand Names.

Text documents can have only one master language, when the document is marked as invariant.

Note:  Invariant content which existed prior to 18.1 and has more than one master language, will
become non-invariant.

• Allow Inherit Content : You can choose to either follow the Master Language or Default to the
element type choice or choose None.Read in detail about this option here.

• Character Limit: You can set the number of characters that are visible in the widget. Warning
message will be displayed if the limit set is exceeded.

• Define the Approval Setup:

• Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

• Add or Delete Master and Translation Languages

This list will contain the document's selected languages. You may have more languages to add from
if they are present in the Project's Attribute Category.

If you are an Editor or a Content Manager with Editor permissions, you can

• Modify text and save changes

• Edit content and start Approval in the text widgets if you are an Editor. Read in: Editing Text
Statements and Starting Approval on page 1007.

• Start Approval or change the status back to Draft.

An Approver can:

• Approve or Reject Text Content

• Add new Comments as an Approver/Editor

A user with Add Language permission can add specific languages for which permission has been
assigned.
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Note:

• It is important to click Save after every action to save changes to the status element. A new
document version is created after each Save action. You can view these changes in the Document's
Action History page.

• The older versions of the Text Content Document are displayed as read-only (even when you have

the right permissions). To Reload latest version, click .

• Tip:  There is no direct way (even as the Content Manager) to change the status of the Signed Off
Text Documents. Only an Admin user can make this change.

Create Smart Text in Text Content

Smart Text can be created for text contents which are reused frequently. The referenced Smart text
content may be within the same project or could be in multiple projects.

Changes made to the referenced text content in any one of the project, creates warning message
wherever the document in referenced in other projects. Although the text content is updated, the
approval of the text content has to be done in each project. This allows flexibility to retain the old
version of the text content or to update to the latest version.

Getting Started with Smart Text
Ensure you have a:

• Saved Search configured with text content which is chosen as a Reference Source.
• Document reference attribute named SMART_TEXT_REFERENCE added to the text content

document.

Add Smart Text by Clicking
Smart Text can be created by any user with Content Manger or Editor Permissions.

When user clicks on  icon, configured Saved Search results chosen in SmartText Search Field is
shown to the user in a pop-up.

User can select one or multiple Text Content documents to add. Selected documents are shown as
Smart Text in the Text Content editor. If saved search is not configured, or Reference Source is not
chosen, then Smart Text cannot be added.

Add Smart Text by typing text in Text Content editor
Select Enable Auto Suggestion to get prompts automatically when you type in the text content box.
Minimum of four characters should be typed for the search to be performed. You can choose any one of
the text content from the list of suggestions shown. Selected Text Content is shown as Smart Text in
the editor. Auto suggestions are not shown, if no matches are found for the text keyed in. You may add
any number of Smart Text in the text content editor.

Note:  If saved search is not configured, then auto suggestions are not shown even if the Enable Auto
Suggestion is selected.

Editors or Content Managers while editing an existing Content Sheet or an Attribute category or
creating a project, may want to add a text statement that is not available in the text library.
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A new text statement can be created on the go in the same page, and it is instantly added to
autosuggest and creates a smart reference even before saving the page.

Resolve Smart Content
The Language statement’s smart text will be resolved automatically on save of the document.

Alternatively you can also click  to resolve the Smart Content that are added to the text content
editor.

Note:  When Smart Content gets resolved in any language, other statements following that language
are resolved automatically.

For Example, if French and Dutch languages are following English language text, while resolving
English both French and Dutch language contents are also resolved.

Warning messages will be displayed when the Smart Text:

• added are resolved and it contains no text
• is empty or is broken
• character limit set is reached
• is not resolved although the user has permissions
• are not of the latest version and reference is made to an older version of the text document. You can

click on the Smart Text, where the user can optionally update to the latest version.

Copy Smart Content
SmartText Language

When a SmartText is added, by default current language is selected for the SmartText. You can change
from current language to any of the Master or Translation language by clicking on the SmartText pop up
window.

A language inherits content from another language:

• If the source language in the SmartText language is configured to current language, then the
inheriting language will get content for its own language

• If the source language SmartText language is configured to a specific language, then the inheriting
language will get the same content of the source language

Approve Smart Content
Smart content has to be resolved before the element is approved.

Delete Smart Text
You can delete Smart Text in the text content editor. On save, the text content is removed from
Document Reference attribute also.

Smart Text pop-over

You can click on the SmartText to view the referenced content in a pop-over.

Pop-over contains the following:

• View of the referenced text statement
• Text Document Name along with the Version
• Project Name where the referenced text statement is present
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• Language selection dropdown, which allows you to change the SmartText language to any of the
languages available.

You can select the languages available in the referenced text statements even though the language
may not be available in the current project.
 

 

• Warning message if the referenced text is not the latest version and an option to Update to Latest.
 

 

Note:  You cannot revert back to the previous version if you update the referenced text.

Editing Smart Reference in popover
When you click on a smart reference, a popover is opened to show the used smart reference text. The
referenced text can be edited provided you have the permission. You can then either save the changes
or cancel.

A new version is created for the referenced statement with all the changes made.
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When Latest Version is selected, then the current statement is resolved automatically and you can
save the document. When Selected Version is selected, then along with save, referenced statement is
also be updated to latest version automatically.

Any change made at any level of the smart text reference, has to be saved at the same level and also in
all the levels further.

Role Mapping Tab

Role Mapping
This tab displays all the permissions enabled in the Text document.

 

 

In this tab, you can see:

• the Content Permission

Note:  Content Manager is not associated with any language.
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• the Language relevant for each permission. For the Editor and Approver permissions, the language
is listed.

• the Role assigned to each permission. The roles will be links if you are a Project Manager or an
Administrator.

Note:

• The Roles list will have links only if these roles are invited to the project and exists in WebCenter.

• If you do not see Roles as links, check if you are looking at the latest version of the document. In
older versions, this data will be read-only.

• the Assignees (Groups or Users) assigned to a particular role with a certain permission.

Compare Tab
You can now compare different versions of the same document in the Compare tab in read only mode.
This allows you to view the differences between two selected versions of the same text content
document.

You can navigate from Document > Text Information  > Compare . This tab is divided into two parts
where, two versions of the text content document is shown side by side. By default, left side block
is loaded with the current version of the document and the right side block is loaded with previous
version with clear indication of differences.

Note:  If the document has only one version available, then the right side block is empty.

 

 

A drop-down is provided on the header of the both blocks to change the version of the document to
compare. Navigation arrows are provided to go to the next or previous versions of the document.
Hovering on the drop-down option or on the navigation arrows displays the Version Number along with
the modification date, Version Author, and Version Comment in a pop up window.

You can expand to view the content properties by clicking on the header and both versions are shown
simultaneously.

Selecting Show only differences option shows only the languages which have some difference in the
text content and languages not having any differences are hidden.
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When a language is not added in one of the compared version and is available in the other version, then
the language widget is shown as not added.

Note:  Compare is done only on the content of the two versions of the document and not on the
settings.

Managing Text Permissions
Ensure that:

• you have invited the right Roles in your Project or Template with the Text document.

• you have added the Master and Translation Languages to the Project's Attribute Category to
configure Language specific Editor and Approver permissions. It is important to do role mapping in
a smart way.

• you have enabled the right Preferences.

If you are a Project Manager / Admin, you can manage and assign content permissions.

Note:

A user without any of these permissions can only view (depending on the view permissions) the text
content documents.

1. To manage Permissions, go to the Document details > Text Information > Role Mapping.

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

• Text Content

• Role Mapping

• Compare
2. Click on Manage Permissions. This will open up the Role Mapping page.
3. Click Add Permission. Repeat this for as many permissions as you want.
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4. Choose the Content Permission from the drop-down listing:

• Content Manager

• Editor

• Approver

• Add Language
5. For the Content Managers permission, define the appropriate Role.

Read about the permissions below:

1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process
to ensure accuracy and compliance. For example, the role Marketing could have this permission
where the Marketing has the responsibility of the packaging content. The Content Manager will
manage the Master and Translated statements.

Note:  The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note:  Content Manager Role cannot act as an Editor or Approver unless this permission is
granted to the same role.

2. EDITOR
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The Content Manager typically assigns this right to the dedicated roles who will create, edit,
revise or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:

• The Content Manager Role has to configure the list of translation languages to make use of
multiple language based Editor permissions.

• You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also
be configured per language. The approver puts the Text Statement to Signed-Off or Rejected
state.

4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document.
The users can be assigned with permission to add only specific languages.
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Note:  You may choose to give more than one permission to a Role. For example, the Content
Manager can have Editor and Add Language permissions as well.

6. Define the Editor permission and assign it to a role. Select the corresponding Language from the
drop-down.
You can automatically create Editor and Approver Roles for all languages in one go. Read about
Smart Role Naming on page 508. To do this for the editor permission:
a) Make sure that the Admin preference section has the right Prefixes. Read here.
b) Next to the Editor permission, select All Other Languages.

 

 
7. Define the Approver permission and assign it to a role.

Select All Other languages to create Approver roles with default names in one go.

Note:  You can configure Editors and Approvers individually for some languages and choose the
Smart Role Naming for the rest of the languages by selecting All Other languages.

8. To edit Content Permissions, click Manage Permissions and edit or change the assignment of a
permission.

• The Role Mapping page will list all the Content Permissions, respective languages, Roles and their
assignees (individual or Group).

The Roles will be clickable if they exist in the system and are invited to the Project.

• The Master Language of the Project will be highlighted in bold.

If you would like to give content editing and approving permission during Project Creation, assign
Editor and Approver permission to the _REQUESTOR role.

For example,if you assign Editor permission to the _REQUESTOR role, the Editor can draft the text
during project creation.
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Warning:  During a Project's creation, you can assign another user as the Requester. If this
happens, the permissions defined for the _REQUESTOR role does not get transferred. In this
scenario, some updates done during the Project creation may be lost.

Smart Role Naming

When your content workflow contains translations into different languages, you can have Editor
and Approver permissions assigned to Roles (text authors/editors and approvers such as legal or
marketing) associated with these languages. To automate the naming of such Roles, you can specify
prefixes for these placeholder Roles.

 

 

The names of the Roles will have the specified prefix and Sux (In the example screenshot, Language
Editor) and the respective language code.

Adding and Deleting Languages in a Text Content Document
Go to Projects > Attributes page and assign the Master and Translation Language Attributes. This will
make them available in your Project's text documents.

In the Text Content Document Details > Text Content tab, you can view and add / delete the Master
Text Language and Translation Language(s).

It is also possible to view, add and delete these Languages in the Copy sheet view. Read also: Creating a
Copy Sheet on page 388

Note:  You can add or delete this only if you have Content Manager or Add Language Permissions.

• To add a language, hover over the blurred flag indicators and click + on the flag image to add a
language.
The languages that are added in the list have clear flags. Only four of the selected Translation
Languages (Flags) are displayed. Click on the ellipsis ... to view the expanded list of the other
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selected languages and  to collapse the list. Languages are displayed in the order of the
Language Index specified in the language list irrespective of the sequence it has been added.

• Hover over and click x on the flag image to delete a language. You can add or delete multiple
languages in one go by clicking multiple language flags.

• In the basic view, to delete a language of the text content from either the master languages or the
translation languages, click on ellipsis

After deleting a language, you get  icon to add the language again in basic view. Similarly in

attributes, if the translation languages is not added to the text content, then  is displayed. You
can also add back the language by clicking twice on the widget.

• To delete a language that is not present in the Project Attributes, and is available in a text
document, click .

The language is marked for deletion in the element status. Click  to revert the action.

Ensure that you save the modifications.

Adding any of the available languages is possible based on permissions on all text content in the page
including documents that are from other than current project. Similarly, it is possible to remove the
language when it is added recently but not saved.

The following conditions apply when you delete Master Text Languages:
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Note:

• If only one Master Text Language is present, it cannot be deleted.
• If two or more Signed Off Master Text Languages are present, then any one of them can be deleted.

But if there is only one Signed Off, that language cannot be deleted.
• If none of the Master Text Languages is Signed Off, then any of them can be deleted.
• A language can be deleted even if the Text Content document is linked with multiple projects.

Editing Text Statements and Starting Approval

Editing Content
With the Editor permission:

• You can edit a document in Draft state.
• Auto-Approve. If you are assigned the role of an Editor and an Approver, you can approve the

content you created immediately.

Approving after Editing (Auto- Approval)
For example, Marketing can create and approve Master Text of certain statements. Essentially, you can
skip Start Approval and Approve actions. To do auto-approve:

• Hover over Draft  state next to the Text widget. You see options to Approve or Start Approval.

• Approve and  Save. The document status is now  Signed Off.

 

 

Note:

If saving fails, check if:

• your Editor permission is revoked.
• there is any conflict from another user regarding content update.

You can Start Approval by clicking  (even after you auto-approve).

Note:

• You cannot Reject, when a document is set for Auto approval.

• You can auto-approve from all the pages where you have the Text widget (Text Document
Details, Task Execution Page, Document Attribute Category, Project Attribute Category, Project
Creation Page and Viewer ).

Starting Approval or Reverting to Draft
Hover over Draft  status to view and click Start Approval to kick start the approval process.
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To put the status back to Draft, hover and click the  Revert button.

When you save, the status changes to Draft.

Note:  After starting the approval process, users with Editor permission can revert the status back to
Draft.

On clicking on the Reject button, the element will be marked for reject and the Approve/Reject/Revert
to Draft button will disappear and replaced with a Revert button. Content won’t be editable, even if user
has editor permission for this statement.

Approval Information
You can click on the Approval Info icon for a Text Content element, and it opens a pop-up which
displays approval cycle information.

This pop-up window provides information on

• Language on the header
• Element type
• Approval type
• Approval Information along with user details and date of the action.
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Approving or Rejecting Text Statements

Approving Text Content Statements
To Sign-off text statements (as an Approver), hover over the Pending SignOff icon next to the Text
statement and Approve. When you save, the status changes to Signed Off or Pending SignOff (You
Approved) when there are more approvers.
 

 

You can revert your action (before you Save) by clicking  Revert .

Note:  Once Signed Off, you cannot makes changes to the text content or the text status. Translation
languages can be edited even if the master language is not yet signed off.

Rejecting Text Content Statements

To Reject, hover and click . When you save, the status changes to SignOff Rejected.

If there are more approvers, status remains Pending SignOff (You Rejected) until all Approvers
approve or reject.

 

 

Note:

If the Admin user has enabled Required password for Approvals/ Rejections in Preferences, your
Approve/Reject actions requires a password.

Other tools

Use this To...

Inherit Content For

View the Approval Overview. It will show

• The last updated state along with the date of change done with the user associated
with the change

• Element type and Approval Setup ( All of Role, or One of Role or Default )
• Language for which approval was done
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Use this To...

Inherit Content For

 

View the comments associated with a text statement. It allows you to view earlier
comments and also add a new comment.

Adds a new comment. This button indicates that there are no comments. Clicking it
enables you to add comments, to hide and show existing comments.

Note:  In case the user has delegated the tasks, any comment updated by the delegate
will mention the same.

4.16.3.  Text Document Actions

You have additional Project Documents Actions for Text Documents. These actions allow you to

• Export text documents
• Import XLIFF files
• Copy documents with their Approval State

Importing and Exporting Text Documents

Export and Import XLIFF
You can export your text documents to be translated into XLIFF files. Once translated, import the
XLIFF files back to WebCenter.

 

 

How to Export to XLIFF from a Project:

• Select the Documents and click Export to XLIFF in the Actions menu or bar.
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Note:  You may have these actions in the More drop down menu depending on your menu
configuration.

• In the resulting Export to XLIFF pop-up, select Source Language and Target Language and click
Download.

• There are other options which can be selected.
 

 

• Export Statement(s) only if the Master is signed off By default this option is checked. When
checked all the text statements which are signed off are exported and other statements are
ignored.

• Export Statement(s) only if Target language is specified in the Document By default this
option is unchecked. When checked only the text statements that has translations are added
and rest of the text statements are not exported.

• Export Statement(s) only if Target language is not signed off By default this option is
unchecked. When checked, only that statement for which translation language is not signed off
is added to xliff file.

Note:  If there are no text content documents to export to XLIFF, then a warning message is
displayed that No text content document(s) available to Export to XLIFF

The downloaded file contains the approved source language text and an empty statement of the target
language. Comments added in the text content document will be exported to XLIFF file.

To Import XLIFF files after translation:

• Click Import XLIFF in the Actions menu or bar. Click Browse to select the file for importing. The
translated XLIFF file are added to the corresponding Text Content Document(s).
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• When you import the XLIFF file, you can directly Approve Translation by enabling the option.
• You can view the XLIFF Import Report which gives the status of the import. If the import of the

document(s) fails for any reason, then the reason is updated in the Warnings column.
• Any new comments given during translation can be viewed in the XLIFF Import Report.

Note:  When you configure translation Workflows, you can use the Export and Import XLIFF content
nodes.

Exporting to GS1 XML
You can download a GS1 XML file containing all the content documents (Dynamic Content) including
text, table and Artwork files. In the Artwork creation process, this GS1 XML file can be sent to the
designer to place the content on the artwork in Adobe Illustrator with Dynamic Content. The Dynamic
Content plug-in will match the placeholders in the artwork with the GS1 XML content.

Note:  Any User with download permissions will be able to generate and download GS1 XML content.

Generate GS1 Export function supports below Text or Table Content and Artwork file types.

To generate a GS1 XML, follow the steps below:

• Go to the Project where the artwork or Text content document(s) or Table document is stored and
select the document to be exported

• Select Actions > Export to GS1.
• If the selected artwork document contains reference property filter values either at the Document

Attribute level or at the Project Attribute level, then the Export to GS1 pop up window display the
filters, from which you can select the Reference Property filters and Languages along with Locale.
Reference property filters are used to filter the content to be downloaded to the XML format.

• Choose Include Empty Content in GS1 to view all the elements in the table document else only
elements with content are exported.

• The locale mapping values are pre-populated from the Document or Project attribute in the pop-up
window, which holds unique values and these values are editable. When the locale mapping is not
available in both the Project or in the Document attributes, then you can manually provide locale
mapping and locale value will start with zero. Order of priority to pick locale value is Document
attributes followed by the Project attributes.

• Specify the Target Language (one or more) in the Export to GS1 pop-up window.
The Target Language drop-down lists the master and translation languages specified in a project.

Note:  If the project does not have specified language attributes, this drop-down then lists the
system wide language lists (Master and Translation).

• Click Download.

The GS1 XML will contain the dynamic content of the specified Target Language(s) including:

• the approval status
• the Instance Sequence value

Note:  If the instance sequence number is not available, then unique instance sequence
is auto generated and exported. When a GS1 document, if the referenced documents have
EXPECTED_NUMBER_OF_OCCURRENCES (hard-coded) reference property, then the GS1 file
will export this data for every dynamic element (Text Content, Table, Bar Code, Graphics). If this
reference property is not available, then GS1 will have “1” as value for this field.

• The generated GS1 XML will include only content for which the user has read permission.
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In 18.1 release we worked on “EXPECTED_NUMBER_OF_OCCURRENCES” while exporting to GS1
XML. But in that documentation we didn’t mention what should be the value (format) so while
exporting, right value is exported.

The value of this field should be JSON format {“locale_Id”:”value”} where locale_id is the mapping
integer to language. This locale_id should be same as what is used when we export to GS1.

How to get Attribute Category Report for Text Content
You can get a report of all the attributes present in a Project or in a Document Attribute Category.
Attribute Categories report can be downloaded and accessed by any users who has the permission and
the Admin user has configured the report and uploaded it. Read more about it here.

Users who have access to the report, will have the report icon in the Attributes page of the Document
or the Project. Labels defined to the attributes while creating are shown in this report for all attributes
except the document reference type.

1013



4 WebCenter

Note:  If the attribute name is derived from SmartName or if internationalization is done for the
attribute, then the label name is not considered and only the attribute name is shown.

While generating the report you can further filter the report based on the languages and the reference
properties.
 

 

To know more about configuring Attribute Category report, read this section in the Admin Guide. An
example Attribute Category report is shown below.
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Copying a Document with Status
You can copy a Text Content Document to another project along with their status.

When you select one or more documents in a Project (Signed Off, Pending Sign off..) and choose Copy
Documents(s)  Action

• You have the option to Copy Text Content Status. If you do not select this, the copied document will
be in Draft state.

 

 

If you are copying from the Document Details Page, you can:
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• Enable or disable the Copy Text Content Status option. If this is disabled, the copied document will
be in Draft state.

 

 

4.16.4.  Nutrition Facts Tables

The Nutrition Facts Table (also known as the nutrition information panel, and other slight variations) is
a highly regulated and required component in food and beverage packaging.

WebCenter Packaging Content Management offers a platform for data management of your nutrition
facts, review in the context of artwork and reuse.

The solution will address the following:

• Complying with regulatory requirements. For example, FDA and USDA requirements in the USA and
complex, multilingual Nutrition Facts Tables with predefined templates.

• The complexity of data management. SmartName can pull data from your data system for use in
your nutrition fact tables.

• Established table rights facilitating the ownership at different stages. For example, who can fill in
the data and who can approve, etc.

• Integration with Adobe Illustrator®

• Automation of Nutrition Facts Table creation. A content manager can pick a template which already
has the SmartName mapping to point to the right data.

• Smart content reuse. You can use our template system to create different tables from the same
pool of data. This is supported with a repository / library for your Table content.

• Support for a translation based or single language workflow.
• Export to and import from industry standard formats
• Approval workflow

Table
A Table in WebCenter is a collection of statements. The table is treated like a single document with
multiple statements. A Table has Content Permissions mapped to certain Roles, and specified
Languages.

Tables are created based on a Templates (Document Templates). An administrator user can import
Table Templates into your system. For example, an FDA approved template with pre-selected nutrition
fact statements. The best practice would be that the content manager adapts a series of table
templates with specified table statements and permissions and other users create tables based on
these templates (and localize them).
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Table Statements
A Table contains statements with a text label and an editable field. You can define different approval
processes for these statements. While the Table Templates contain a pre-determined set of such
statements (based on FDA regulations, for example), it is possible to add and delete statements.

• Element Type: This indicates what the value of the element represents (e.g.: “Calories”, “Vitamin A”,
“Saturated Fats”, …).

Note:  Although it is possible to use your custom Types, the Templates come with GS1 nutrient
element types.

• Instance: This will be a number indicating the numbered occurrence of a particular Element Type
in the table. By default, it takes the value “1” except when there are multiple occurrences. If you have
three daily values for every nutrient, their individual instances will be “1”, “2” and “3”.

• State: The statements can be in one of the following states: Draft, Pending Signoff and Signed Off.
Users with corresponding permissions can change the state of each element.

• Value: The actual value of this element that will be displayed in the table (e.g. “230”, “10 g”, “2%”, …)

• Static and Variable part: The text part of the table is treated as static and the numeric fields as
variables. This means that users won’t be able to edit or adapt the design components of the layout.
There are exceptions to this rule: for example, the “Serving Size” in “cups”.

Table Content Document in WebCenter

Table Content Document
A Table in WebCenter is a collection of statements (either nutrition fact statements or text
statements). The table is treated like a single document with multiple statements in it.

The WebCenter Table Content Document (.wtc) is an XML file that has the following features:

• Table Content that goes on in the Artwork. You can manage the values of the table.

This includes both the master and the translated content of the table

• Approval states for individual Table statements as well as for the whole Table.

• Clearly defined ownership rights for the Table.
• Stores the Layout type as either Grid or Default. If the layout chosen is Grid, then the layout

information additionally also captures the indentation, column span and Instance ID.
• Element Type for text statements within the table.
• Revisioning
• Download rules
• Attributes
• Document references from other documents. For example an artwork can refer to various text

content documents.
• Can be streamed through a workflow
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1. Table Properties Widget
2. Table Widget on page 1020
3. Preview
4. Translation Widgets

Table Properties
The content manager of the table can modify the table properties such as:

• add or delete translation languages
• make the table invariant
• choose the text type
• choose the layout of the table

Click the Configure icon to define the properties such as:

1. The tool bar with Configure icon and tools to:
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• Resolve SmartName (only if the table is of SmartName Type)

• Export to GS1 tool to export the table in GS1-XML format.
2. Approval Setup
3. Type: Select from Simple, Rich Text or SmartName. If you choose Smart Name, you can choose the

Reference Source from the drop down.
4. Translations: Enable Make this an Invariant Document if translations are not required for the table.
5. Choose the Allow Inherit Content option to follow a particular language for all the elements in the

table. You can either choose None where no language is selected by default or Default to follow the
language chosen at the element level or one of the Master language in the project.

6. Choose Layout as Grid to customize the Language Layout view. If you have chosen the Grid Layout,
you can perform the following actions in the language widget:

• Define the number of columns and rows for a table
• Drag and Drop support for rows and column
• Add or delete rows

Note:  If no option is chosen, default layout remains. When you export table content documents
to GS1, layout information of the document like indentation, column span, and concatenation
strategy are all included in the XML only when the layout chosen is grid.

7. Master Language is specified in the Project's attribute category.
8. Translation Language :This list will show the document's translation languages. You may have more

languages to add from if they are present in the Project's Attribute Category. Add more languages
by hovering and selecting the language.

Text Approval

The Packaging Content Management module offers separate approval processes for the Master and
its translations. All the Approval information with regard to the Master and Translations stay within the
Text or Table Content Document.

Note:  This approval process is different from the regular WebCenter approval process.

The Approval process starts when a content Editor starts approval on a text statement or a table
element.

When you have configured the right permissions, the users who has the Approver permission can
perform the approval actions. To automate the approval, you can configure manual tasks in a workflow
and assign them to the relevant Roles.

Once approved, the master and the translated text remain locked for the regular users.

Note:  Only the Content Manager has the rights to change the text element to draft.

The text element can be in one of the following states:

• Draft: The initial state of the Text Document where the content is still being worked on.

• Pending Sign-off: When drafting is complete, and the status is ready for its approval cycle. An
approver can review and approve or reject the document.

• Signed-off: When the approval cycle is completed and the content drafted in the document is
‘Signed Off'.

• Sign-off Rejected: When the approval cycle is completed and the content drafted in the document
is ‘Rejected'.
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Note:  Approver will be requested to re- enter the password before approving or rejecting any text
content document, provided the option is enabled by the Admin user.

Approval Types
Content Managers can set up the Approval Type for Text Content Documents. There are three Approval
Types:

• Default: Only one member has to approve. For example, if the Approver permission is assigned to
two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member or
user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there is
an individual User, then he or she has to approve as well.

Table Approval Status

The approval process can be done at two levels: approval of each nutritional fact statement and as a
composite table.

The status of the Table widgets (Master and Translation) depends on the approval state of the table
statements. If all the elements are signed off but one is still in the Draft state, the widget status will
also be Draft.

It is also possible to bulk approve all the statements within a particular language for both the Master
and Translation languages. During bulk approval of statements, if the status is reverted before saving
the change, previously signed off statements are not affected.

Note:  This option is available only for users with Editor and Approver permissions.

See the approval states below:

1. Signed Off
2. Ready for Approval
3. Draft
4. Rejected

The Approver user can approve the entire table (per language) in one go. To do that, hover over the
status icon and click Approve.

In the case of individual statements, the Approver can change the status to the next possible
Approval State. For example, if a statement is in Draft state, the user can put it to Ready for Approval.
Translation languages can be edited even if the master language is not yet signed off.

Note:  If Require Password for Approvals/rejections option is enabled, then the Approver is asked
to enter the password for approval or rejection. The same information is also updated in the Action
History.

Table Widget

The Master Language Widget contains the Statements or actual table content. The Editor users can
enter data in the specific fields.
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If the table has translations, they will appear as widgets below the master table.

Table Tools
In the Configure tool bar:

• you can add Table Elements.

• change the approval state of a document. After the data entry, you can approve or start the approval
process.

 

 

Table Statements
The individual statements or elements can have it's own approval state. The statements have a name
label(for example, serving size) and an editable field. Read about adding more elements in the table in:
Table Element Types on page 1023.

Language Widgets
If you have added Translation languages to the document, you will have translation widgets below the
master table.

Click on the configure  icon and T+ to add table elements to your translation widgets. You can add all
or some of the Table Elements present in the Master language.

However, you cannot add elements that are not in the Master language. Each Language has it's own
approval process and approval can be done at the language level or as individual elements.

Content Manager or a user with Add Language permission can add a empty Master or Translation
languages widget into the Table Content document. This allows the Content Manager to plan the
languages required for the document ahead, although the elements can be added later as per the
requirements.

Rows and Columns
Add or Remove columns / Rows in Grid Layout

You can easily add or delete Rows by clicking on any cell in the Grid layout by selecting the context
menu for the table documents. This can be done only by the users who have the Content Manager or
Editor permissions on the particular table document.
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Rows can be added above or below the selected row, using the options available in the language
header.

Similarly, the columns can also be added to the left or the right of the selected column using the
options available in language header.

Context Menu in Master Languages

When the master language is configured, you can easily access the context menu by a simple right-
click.

You can merge or split cells in a table document. When you want to merge any cell in the language
section and if the next cell is empty, then the selected cell is merged with next cell.

If any widget is present in the next cell, then it shows an alert message. Similar functionality is followed
inversely for split cells. You can add cell level indentation up to ten levels of indentation. Row (A, B,
C....) and column (1, 2, 3...) headers cannot be indented. Indentation is shown in preview but not inside
the cell. Indentation is applicable only for Grid Preview and is not available for the standard/default
Preview.
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Reorder Table Rows and Columns

Rows and columns in the Table document can be reordered by drag and drop. You can also re-size the
width of a column by using the column re-size handler.

Hide and Show Rows and Columns

Rows in the Table document can be hidden by selecting any cell in the Row and selecting the Hide
Row option in the language header. To show the hidden row, select the row and choose the Show Row
option in the language header.

Show and Hide columns also function similarly by using the Show Columns or Hide columns in the
language header.

Layout configuration in Master Languages

When there are multiple master languages in the table content document and if the layout is
configured in one of the master Language, changes made impacts the other master languages as well.

Table Element Types

The individual Table statements can have a particular Element Type. The default Table Types have
Element Types corresponding to the GS1 standard. However, you can add custom fields to suit your
particular needs.

You can add multiple instances of one Type and it will be indicated with a sux number.

Note:  You can add elements to the Master Table and the Translations have the same fields as the
master. You cannot add custom types to the translations.

As a Content Manager, you can add or delete fields.

•
Click on the configure  icon.

• To add an Element Type, click T+
• When you have selected a particular Standard, the corresponding table element types are available.

If your template is a Standard, you can add more from the Add Preview Fields …section.
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• You can choose from:

Options Description

Add Preview Fields To add Element Types of the particular
Standard you selected, just click on the field.
Use << to take all elements out of the table and
use >> to add all fields to the table.

Add a Listed Field To add one, click on that specific Field. Read
below.

Add a custom field To add a custom Field. Read below.

• You can store your GS1 (or custom) Table Element Types in a List and use them in a Table.
a) Create a List with the Nutrition Fact Element Types with the name TABLE_ELEMENT_TYPES.

These Types will be available to you in your Table Documents
b) To add one field from the List, select Add a listed field.

The gallery lists all the types from the List.

 

 
• You can also add custom fields that are only relevant in one Table. To create such a field select

Add a custom field option. You can use this option when you have to create Custom fields in some
tables or when you are using the Custom Templates on page 1030.
a) Enter the Element Type Code, the code that will be used for a the added element type. This is

used to highlight the field in the custom previews.
b) Also specify the Instance Sequence to identify each instance of the same element in a table.
c) Click Add.
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• After modifying the table Elements, remember to click OK and to Save  the table.

Note:  The Element Types are used when Dynamic Content Tables get imported into WebCenter.

Text Content / Table Ownership via Permissions

Text Content Ownership
offers established ownership for different phases of the text and table creation and the approval
process. You have four default content permissions:

• Content Manager
• Editor
• Approver
• Add Language

These permissions, when mapped to the WebCenter roles, allows their assignees to perform specific
functions on the document.

Note:

• To configure these permissions, the project manager needs to assign at least the Content Manager
rights to a relevant Role.

For example, you can configure a Role, Marketing to have the Content Manager function.
• The Content Manager can then activate the Editor, Approver and Add Language permissions by

assigning them to relevant WebCenter roles.

If you do not assign a role to a specific permission, the specific permission will remain inactive for
the document.

• The permissions are set at each text/table document (.wcc or .wtc ) level and will be passed on
along with the document and its versions when copied or moved.

• It is not possible to add custom permissions.

Four Types of Permissions
1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process to
ensure accuracy and compliance. For example, the role Marketing could have this permission where
the Marketing has the responsibility of the packaging content. The Content Manager will manage
the Master and Translated statements.

Note:  The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note:  Content Manager Role cannot act as an Editor or Approver unless this permission is granted
to the same role.

2. EDITOR

The Content Manager typically assigns this right to the dedicated roles who will create, edit, revise
or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.
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If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:

• The Content Manager Role has to configure the list of translation languages to make use of
multiple language based Editor permissions.

• You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also be
configured per language. The approver puts the Text Statement to Signed-Off or Rejected state.

4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document. The
users can be assigned with permission to add only specific languages.

 

 

_REQUESTOR Role
To create new Text/Table Documents, edit, approve or to reuse content during the Project Creation
phase, you need to grant the relevant permissions to the _REQUESTOR role. You can give these
permissions in the libraries of Text/Table Document Templates, or Projects with approved Documents.
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Delegation of Approvals in Text Content and Tables
An user can delegate his WebCenter tasks to another user. The delegated user can perform all actions
on behalf of the delegator. When the delegate approves text or table content, the password validation
is done on the delegate's password.

When a user has logged in on behalf of another user, and approves any text or table content, the
same can be viewed by clicking Approval Info in the ellipsis. Alternatively, it can also be viewed in the
Document > Action History.

 Nutrition Facts Preview
The Preview lets you view the data being edited and it adapts according to the changes you make in the
nutrition fact statements. You can see the preview of the table document.

Note:  The preview is an approximate representation of how it would appear in the artwork. It does not
support editing the design elements.

Configuring a Preview
The Preview is configurable and you can select from different Nutritional Facts table formats. To
specify a Preview:

• click Configure Preview

• select a Type

• specify the Standard

 

 

1. Available preview templates (default and custom). The following templates are available by default:

• FDA Nutrition Facts Tabular Tables 2016
• FDA Nutrition Facts Linear Tables 2016
• FDA Nutrition Facts Vertical Tables 2016
• Grid
• Custom Table
• Default

2. Standards available for the selected template.
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3. The language of the Preview (If you select French, your preview will be updated to show the French
content)

You can also add or delete table elements to the master language table to update the document. Read

in:Table Element Types on page 1023. Position Preview  icon allows you to configure, where the
preview is displayed.

Note:  To know more about Grid layout of the table, read hereTable Properties on page 1018

Download Preview
You can download the preview of a Nutritional Facts table in pdf format. PDF downloaded document
contains all the mandatory elements and other elements which has values in the same format, font and
styling as shown in the Preview.

If any custom fonts are used, then add the fonts also in the application server pcm/TablePreviews/
custom/fonts folder location to view and download the preview.

Note:  Download PDF option is not available if Default type is selected.

Creating Tables

Creating a Simple Table
You can create Tables for your artwork from scratch and store them in WebCenter. These tables can
be exported in GS1-XML and use it to communicate between different systems during the artwork
management workflow. You can involve various stakeholders through an approval process.

An intuitive preview section adjacent to the edit fields displays the data in the context of the table
design. The changes you make are highlighted on the go to give you a very visual data entry process.

Note:  You need Table Templates in the system to be able to create a new Table. An Administrator or
Project Manager can import Text or Table Document Templates into the system.

• Import a Project or Template with Table Templates and adapt the settings. When users will create
documents from this document template, they will inherit these settings.
a) Go to Document Details > Text Information >  Content tab of the Template to modify the Table

Properties on page 1018. You can specify the Approval Type, Table Type, Languages etc.
b) In the Role Mapping tab, assign the Content Permissions to have Roles mapped as Editors,

Approveres and Content Manager.

Note:  Specify _REQUESTOR as a Content Manager of the template if you want to create Tables
during Project creation.

c) Optionally, adapt the settings of a template to make it a SmartName based table. Read more in:
Creating Smart Tables on page 1029

• To create new tables from these Templates, plug these as a Document Source in your Project
Template. Follow the steps below:
a) In the Template's Project Details page, Configure > Document Templates.
b) Select Project or Template and select the Project your created in the first step and Save.

• Create an Attribute Category for your Template.
a) Add Language Attributes  and restrict them to Language Lists.
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b) You need Document Reference Attributes. Create and add them to this Category.
c) Configure the Document Sources and Rendering of this attribute.

Tip:  Use a Saved Search configured to search for Table Templates as a document source for
better user experience. You can, for example, add a Search Panel.

• Optionally, create and add workflows for approval and translation. You can also create a Library for
your approved tables.
When creating a Project from this Template, the user can click New and select a table template
from the Templates library to create new documents.

 

 

After creating a new simple table, you can enter the data either as a workflow step usting the Update
Table Content on page 957 node. The users (Editors) can also enter the values manually and send it
through the approval process. You can export this table in GS1 XML format (either using an action or a
workflow step) for merging it to the artwork in Illustrator with Dynamic Content.

Creating Smart Tables
You can automate the data collection process required in creating or updating the nutrition facts
tables. The process starts with a Table Template with dynamic data fields(SmartNames). These fields
can be constructed to point to an Excel based List or any WebCenter SmartName such as Attributes.

SmartNames are resolved as actual entries in the context of a Project. This way, you can source the
data instead of typing in the data manually. This approach helps you to avoid data entry errors in
nutrition facts. Also, when you require corrections to any of the data fields, you can just edit a single
data source instead of updating all related tables.
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To set up a SmartName based Template, follow the steps below:

1. In the Table Document Template > Text Content > Content tab, open the Table Properties on page
1018 widget.

2. Specify the Type as SmartName.
3. Specify WebCenter SmartNames for each field. For example, you could point the SmartName to an

Excel based WebCenter List. You can also select Attributes as the SmartName.
The Content Manager can approve the SmartNames to lock these fields. It is also possible to
delegate the approval to specific Roles based on permissions.

 

 
4. Plug the smart table as a document source in a Project template to create a new smart table. Read

more from: Creating a Simple Table on page 1028. SmartText Search drop down lists the Text Saved
search.
After creating a new Table in the context of a Project, the Content Manager can click Resolve
SmartNames to update the table with numerical values.

In the example screenshot, the SmartNames are from a List based on the specified Product Code of
the Project. You will also be able to see the original SmartNames when you hover over the values.

Note:  If one or more element of the table content has unresolved Smart Content, you will not be
able to approve the table nor the elements.

After the approval of the resolved table, the content remains locked. You can export this table as GS1
XML and finalize the table in Illustrator.

Custom Templates
To install custom preview templates, follow the steps below.

1. Place the HTML templates in WebCenter\WebServer\tomcat\webapps\WebCenter_Inst
\custom\pcm\table_layouts folder and also in pcm/TablePreviews/custom/folder
of the application server. If any custom fonts are used, then add the fonts also in the application
server pcm/TablePreviews/custom/fonts folder location.
Register the custom preview template in a “list.xml” in both the above mentioned folders.
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2. For each HTML Preview, create a layout entry in the list.xml file. This XML file has to be placed

in the same folder as above.
See the format of the entry below:

<layouts>
 …
 <layout>
  <type>Name of the Table</type>
  <name>Type of the Table</name>
  <path>Path to the Preview Template</path>
 </layout>
 …
</layouts>

Note:

The Type and Name fields will be used in the user interface drop-downs. If a Type is not specified, it
will be called “Custom”.

Read more in: Table Preview

The custom templates will be available in the Preview selector and you can use the Type and Name
fields in the interface to select a Preview.

Workflow Tasks for Tables

Import Dynamic Table
The Import Dynamic Table node extracts the Tables from your artwork(s) as Table Content
Documents. You can configure this node to import these Documents with a link to specific document
reference attributes and table document templates.

Note:  You need an Attribute Category with Table document references as a pre-requisite to configure
this node.

If there are multiple artworks coming into the documents, the node will iterate and extract tables from
all of them.

Parameters- Configuration tab
• Specify the Upload Folder to store the extracted documents.
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• Select the Document Reference Attribute for the table. Select the appropriate document
reference from the drop-down listing all document references.

• Add Imported Table Documents to Output . Check this if you want the document sent to the output
pin.

• Reuse existing Table Documents. The document version specified in the document reference will
be reused to store the data instead of creating a new Table Document. If there are no matching
tables in the system,new document will be created.

Document Template Tab
• Specify the corresponding Document Template. Select the Table Template (either simple or Smart)

that corresponds to the incoming Table.

Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your table templates. You can either specify multiple project names with
a "|" between them or provide SmartName which resolve to multiple project names. Read more in:
Creating a Simple Table on page 1028

• Add all Document Template elements Check this to import all statements present in the document
template.

• Set values from Document Template. Check this to take values from the Document Template for all
matching statements. If there are no matching statements, the incoming values will be used in the
table document.

Parameters- Language Mapping tab
You can map the Locale ID of the Dynamic Table to the corresponding language in WebCenter.

Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

• Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

Note:  By default, an imported table is imported as Translated language if it does not exist as a
Master Language in the Project's language attribute.

For new Table documents created from this node, the master language table will be added in the
Draft state, even if that language is not available on the artwork.

Note:  If you do not specify language mapping for the imported Dynamic Content, the node will try to
find the language in the Lists (Master and Translation languages).

–Read also: Import Dynamic Text on page 926.
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document attribute category to the artwork (parent). This 'copy sheet'
category contains the Document reference attributes to which the text and table content will be
imported.

Note:  If this step is not in the workflow, the Import  node will use the Project's attribute as the
default.

The category contains the Document reference attributes for:

• text statements,
• and nutrition facts table

to serve as the copy sheet template.
2. The Import Dynamic Text on page 926 step maps the various Element Types to appropriate

document reference attributes as configured.
3. The Import Dynamic Table extracts the table matching it to the document reference and the

table document template.

After the extraction of the content, the workflow processes the content based on the requirements.
You can, as in the example, update the incoming table and text using the workflow.

Update Table Content
This workflow node allows you to specify or update Table properties and Table values. You can add:

• Role Mapping
• Languages
• Approval
• Add / Remove / update/ inherit elements and set values for nutritional facts elements

Settings
In this tab, specify the properties in the Field and the corresponding values in the SmartName
supported Value field.

You can specify or update the following properties and their values in this tab:

• Invariant : Specify this as True if translations are not required for a particular Document.

• Approval Setup:

• Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

• One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

• All of Role – One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

• Inherit Content From :
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You can choose to inherit content one of the options below

• Default: Will inherit the content from the language that is configured to follow in the Language
List.

• None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.

• Master Languages: Can choose any of the languages from the master language list.

By default Disable is chosen which will not allow Inherit content.
• Type: Simple or Rich Text. If the Type changes from the existing type, the document status will

become Draft.

Values
This tab lets you add / remove /update table statements and their values. Use a single row per element
or statement.

 

 

• Element – The table Element Type to be added or removed. This field is a smartname dropdown
populated with the list of table element types supported in the WebCenter.

• Instance Sequence – Specify the instance sequence number. This number indicates how many
occurrences of an Element is present in a Table. The default value is 1.
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• Language – You can either select from the drop-down (listing all the languages present in the
system) or use a SmartName in this field.

If the specified SmartName resolves to multiple languages, then the specified configuration(from
that row) will be applied to all of them.

• Action: Choose from Add / Remove /Update/ Inherit .

• Condition You can add a condition where the workflow node can inherit/add/update/remove
elements. There may be a combinations of different conditions that may be given.

Condition Action Possible

Always Add, Remove, Update, Inherit

New Value is not empty Add, Update, Inherit

Current value is empty/not available Add, Update, Inherit

Current value is empty Remove, Inherit

Current value is not available Inherit

Current value is empty and new value is not
empty

Add, Update

• Value – Field where you can specify the actual content. You can enter the data or use SmartNames.

Tip:  Use List SmartNames(pointing to an Excel sheet based List) to provide content in a smart way.

Note:  If you specified the action as Add for an existing value, the value is updated. If the element
does not exist in the document, the element and the value will get added. However, if the action is
Update and the element does not exist, the row is ignored.

Note:  If you are updating a SmartName table using this node, the value from this node will replace
the SmartName in the table.

Approval Tab
This tab allows you to set Approval Status (per element, per instance and per language) via workflow.
This allows you an automated way of approving the nutrition fact statements.

Note:  You can use SmartNames in this step and if your SmartName points to a multi-value attribute, it
will resolve to multiple values.

1. Select the Element or the statement.
2. Specify the Instance Sequence of the element.
3. Select Language – You can either select from the drop-down (listing all the languages present in the

system) or use a SmartName in this field.
4. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

4.16.5.  Product Content Sheet

Artwork design involves coordinating information from many different sources and stakeholders.
There could be many possibilities for errors and hence it is important to keep all the assets related to a
product saved at one place.
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Product Content Sheet (PCS) or a copy sheet in simpler terms is a high level document that describes
the contents of multiple related products. The PCS will be a repository of all the constituents that are
going to be used on the products, like recipes, text, bar codes, symbols, images, nutritional tables
and so on. PCS are stored in a file type called Components. Components are unique file which has
no physical presence but acts a placeholder for all the documents related to the product. Read more
about component file type here Component File Type on page 590.

With Product Content Sheet, you can:

• Specify the constituents, and also list the usage of these elements.

For example, to ensure that a certain recipe is only applicable to the Flavor X of the product or that a
certain text statement should only be applicable for a certain serving size.

• Extract all the applicable content elements for a certain artwork, provided you specified the correct
usage for the artwork.

For example, when creating the artwork for a multipack, you could specify the requirements as the
contents of the PCS that are tagged with "Flavor X" and "Flavor Y". When creating the artwork for the
enclosed single flavor product, you would specify that the artwork is only applicable for either the
"Flavor X" or "Flavor Y".

Using Reference Property Filter in a Product Content Sheet

For example, Artwork 1 has the Reference Property Filter 1 (RFP 1) which has some of the content
extracted from Product Content Sheet. Similarly, Artwork 2 has the Reference Property Filter 2(RFP2)
with some of the content extracted. You can notice that Symbol 1 has both RFP 1 and RFP 2 defined and
hence are part of both the Artwork 1 and Artwork 2.
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It is now possible to compare the Dynamic Contents in Artwork to actual content referenced to the
Artwork in the Content Widget in the WebCenter Viewer. Details on how Artwork comparison works in
Viewer here.

Dashboards are also enabled now to view the content sheet and Dashboards can be configured to
compare content sheets in them. More information on Content sheet in Dashboards can be found here.

4.16.6.  Comparing Content Sheets in Dashboard

Dashboards are now enabled to view the content sheets and also compare two content sheets using
Content Sheet block. You can compare any of the two different

• content sheets or
• versions of the same artworks or
• artworks which has the same attributes
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When you choose to compare a document with another document, the Delta column shows the status
whether the contents have Changed or Removed  or Added.

The differences are shown specifically in each of the content for changes as follows

• Text: Color coded highlights on the exact location of the change on the text content itself for each
of the language present.

• Table: Changes to the values of every element type is compared and status is shown.
• Images: Change of values to the EXTERNAL_IMAGE_PATH are shown.
• Symbols: Change of values to the SYMBOL_NAME are shown.
• Barcode:Change of values to the BARCODE_BASECODE and

BARCODE_COMPOSITE_COMPONENT are shown.

Note:  EXTERNAL_IMAGE_PATH , SYMBOL_NAME, BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are all hard coded attributes.

Apart from the changed and unchanged statuses, the content Removed from the Source document
and content Added to the source document are shown specifically in the each of the tabs.

4.16.7.  Compare Artwork with the requirements In Viewer

Many a times, there is a challenge to compare the requirement provided to the Artwork designers
tand the actual artwork that is created. The new features in the Content Widget in Viewer shows
the comparison for Dynamic Contents in Artwork to actual content referenced to the Artwork in
WebCenter, in a click of a button and bridges this gap.

The planned requirements are also visible in the viewer in the Content widget and can easily identify
the Dynamic Content that are newly added or removed with color-coded visual feedback. This saves a
lot of time and effort in performing this action manually.
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Compare Mode in Text Content Widget

Three options are available to view the changes of the Dynamic Content in the Artwork with the
Attribute Category namely

• Collate Content: Shows all the Dynamic content in the arwork and referenced contents. In this
mode user can edit Text Statements.

• Compare Content Icon: Shows the compared status in icon if content has changed/added/
removed.

• Compare Content Label: Shows the compared status in the label, if content has been changed or
added or removed. You can view the changed status as shown in image below.
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Hovering on the content in the Compare Content Icon or Compare Content Label mode, presents the
detailed information about the compared document based on the Dynamic Content selected. For
example, a Barcode document is shown below.
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Below image shows an example of how Text Compare is viewed in the Viewer.
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5.  Customization Guide

5.1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

1042



5WebCenter

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

5.2.  Why Customize WebCenter?

You can customize the look and feel of WebCenter. This information describes what can, and what
cannot be modified, and includes instructions on how to make those changes.

Whenever you let your customers or partners work with your WebCenter-enabled website, you spread
a message to them. Therefore, most WebCenter customers want to brand their site and take the best
advantage of the time the WebCenter user spends using the site.

WebCenter allows changing color schemes, logos and images, and virtually every piece of text. You can
even change the logo based on who logs in. This way, you can make the user feel treated personally.
WebCenter gives you a high amount of flexibility in changing the look and feel. You can combine this
with custom menus to change the navigation within the site.

Esko cannot guarantee robust functionality and consistent behavior when upgrading when you start
changing the way WebCenter reacts to customer actions.

Some changes to the navigation are built into the product. Good examples are customizable menus,
the choice of what document types are allowed, whether documents are shown in a list view or a grid
view, or what CAD outputs are available.

Do provide your suggestion to Esko via your local Customer Services representative.
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5.3.  Where to Start the Customization?

Customizing the Look and Feel of WebCenter
The user interface to customize WebCenter's look and feel is the customizationConfig.xml file.
To apply your customizations, modify this file accordingly and save it. The changes are visible after a
little while (this can take up to a few minutes).

The customizationConfig.xml file should be placed into the customization directory on your
Webserver instance, which is <WebCenter_Instance>\custom directory (such as c:\Artios
\WebCenter\WebServer\tomcat\webapps\WebCenter_instance\custom).

See Customizing the Look and Feel of WebCenter Using the customizationConfig.xml file on page 1051
for details.

It is also possible to customize several of these elements from the Customization page (from
WebCenter 12.1) in the Admin section without editing the customizationConfig.xml file manually
anymore. See Customizing the Look and Feel of WebCenter Using the Customizations Page on page 1047
for details.

Customizing the WebCenter Menus
You can customize the WebCenter menus to tailor what users see to what they need to do in
WebCenter.

You can manage custom menus through the WebCenter user interface. Log in as an Admin, and go to
Admin > Preferences > Menus.

See Customizing the WebCenter Menus on page 1063 for details.

Since WebCenter 12.1, it is also possible to customize menus using the Menu Builder in the WebCenter
Admin section.

Customizing the E-Mail Notifications
All the e-mail notifications' related files are stored on the Application Server in the following path: C:/
Artios/WebCenter/ApplicationServer/EmailNotifications.

Inside the root directory you can find two subdirectories - Default and Custom. Actually you will notice
that there is also a third one - example - with an example customization.

To customize the e-mail notifications, modify the files in the Custom subdirectory.

See Customizing the E-Mail Notifications on page 1087 for details.

5.4.  Applying your WebCenter 12.X or 14.X customization to
WebCenter 16.X or 18.X or 20 or 21.03

It is possible to re-use your WebCenter 12.X or 14.X customization in your WebCenter 16.X or 18.X
or 20 or 21.03 installation. This section explains the changes that need to be made to make the
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customization work properly in WebCenter 16.X or later, along with new customization features that
come in WebCenter 16.X or 18.X.or 20 or 21.03

Moving your customization from WebCenter during Upgrade ( 12.X or 14.X to 16.X or 18.X
or 20 or 21.03)

Before upgrading your WebCenter installation, please make sure your custom folder is backed
up in a different location. You can find the custom folder on your WebCenter Web Server:
<WebCenter_Instance>\custom. You may have used different custom folders for different
WebCenter instances.

After you have created your new WebCenter instance, copy the contents of the custom folder into
the new, empty custom folder. The contents of the custom folder typically includes folders such as
"images", "text" and "languages".

Attention:

When copying folders from a different operating system into your custom folder (especially
from Mac OS to Windows), make sure the contents are not encrypted.

1. Right-click the old folder you are copying into the custom folder, and select Properties.
2. In the General tab, click Advanced.
3. Make sure Encrypt contents to secure data is not selected and click OK.

Encrypted folders and files have green names, and can cause problems in your customization.

 

 

If you would like to make a totally new customization at this point, you can copy the contents of the
custom_example folder into the custom folder and start making changes to this file.

In case you have copied your old customization into the new custom folder, please have a look at
the new customizationConfig.xml file. You can find this file in the <WebCenter_Instance>
\custom_example folder. Compare this new file to your old customizationConfig.xml file. The
recommended way of proceeding is to copy the customized settings from your old file into the new
one and use this new file in your custom folder. This way, you can use the new features that have been
added.

Note:  There may be sections in the customizationConfig.xml that are not actually used, these
sections are typically greyed out in XML editors and can also be recognized because they are between:
<!-- and -->
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Changes to the customizationConfig.xml file
The new customizationConfig.xml file contains some additional features, as well as some
features that have been removed. For example, the MenuBackground image is no longer used in 16.X.
Instead, the Menu background and font colors are calculated automatically based on a single Menu
Color, allowing for much easier customization.

A new feature in WebCenter 16.X is the "full screen Background Image" for the Login page. Also, it is
now possible to change the default background colors for the buttons.

Changes required to make your customization work
The old customizations you have created will largely work in WebCenter 16.X. After you have copied
your old customizations into the new customizationConfig.xml file and possibly made some
additional changes, it is a good idea to go over the Colors section. Since various colors have changed
and colors may have been added or removed, the color settings may have to be adapted.

Attention:  After applying your customization, you may need to restart the Tomcat service.

Moving your customization from WebCenter 18.X
1. Backup phase (during uninstallation)

When uninstalling WebCenter 18.0 or later, in the Web server the installer inspects the list of
Tomcat web instances and records the names of all the custom WebCenter instances while backing
up ‘custom’ folder including the default one - WebCenter_Inst.

Common App Data root folder is used to store the customization files backup on the target Web
server host. The default path on most Windows server is

                            C:\ProgramData\Esko\WebCenter\WebInstanceCustomData

This folder is the root and each of the WebCenter web instance custom folder files are stored under
a subfolder that takes the name of the appropriate instance.

The list of web instances that were found and later re-deployed is stored in the registry among the
other WebCenter upgrade values.

2. Re-deploy phase (during upgrade installation)

When performing an upgrade installation of a WebCenter Web server on the same host the installer
gives the User the following options:
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• Redeploy web instances with customizations: This is the default option. Re-deploys the
custom instances marked during the previous uninstallation as well as the custom folders
backup.

• Redeploy web instances without customizations: Re-deploys the custom instances marked
during the previous uninstallation and does not retain the backed-up custom folders

• Do not redeploy automatically: Does not re-deploy any of the custom instances and their
custom folder backups.

5.5.  Customizing the Look and Feel of WebCenter Using the
Customizations Page

In the Admin > Preferences > Customizationspage, you can customize a number of WebCenter user
interface elements visually.

The current customization for your instance is always visible when you first load the Customizations
page. You can alter this customization, reset the customization to default (the standard WebCenter
look) or load a theme, which gives you a starting point for your new customization.

You can customize images, colors, fonts and static text in this page.

You can also enable the Forgot Password option, that displays a Forgot Password? link on the
WebCenter Log In page, and allows users to reset their password.

1047



5 WebCenter

You can also customize WebCenter using the customizationConfig.xml file.

System History Logs
All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

5.5.1.  Viewing and Editing a Customization

Admin users are able to view and edit an existing customization on the Customizations page.

On the Customizations page the following items can be customized:

• Images: Application logo, Company logo, Product Line logo, Login page Background image and full-
screen Background image.

• Colors: Different colors can be set for various elements using a color picker.
• Fonts: The current font type can be changed and a base size for the font can be entered. Other sizes

are calculated proportionally to allow for easier customization.
• Static Text: Customized messages on the login page, welcome page and contact page by uploading

a valid XHTML file.

The following steps describe how to view and change the current WebCenter instance's customization:

1. Go to the WebCenter instance you would like to customize and open the Customization admin page.
2. In case any customization was done before, those files and values are displayed, if not, the page

shows the standard WebCenter values.
3. Change images, colors, the font that is used and upload a static text file.
4. After making your changes save your customization by clicking on the Save button.

Note:  After saving your customization, there is no need to restart the TomCat server, as the
changes are applied upon saving or after loading a theme. Since WebCenter 16.X, the customization
are re-applied by the system and the effect is not shown immediately. Reloading the customization
may take as long as 2 to 5 minutes.

Load a Theme
On the Customizations page, there is an option to load a theme. The first theme (Default) is the
WebCenter default look.

1. Click Load Theme for a particular theme to load it.
2. After confirmation the theme is installed.

Note:  Loading the theme, as applying a customization, may take up to a few minutes.

Reset to Default Look and Feel
From the Customization page, it is always possible to revert back to the standard WebCenter look and
feel.

1. Either click the button Reset to Default at the bottom of the page, or pick Default from the Themes
section.

2. After confirmation, the default WebCenter look and feel is applied and used again.
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Note:  You may need to do a deep refresh of your browser to see the changes.

The option to reset to default is also available for several individual items, like colors and images. In
this case, only that particular item will revert to the default look. Sometimes the 'default look' is to
not show the element, for example the Product Line image is not there by default.

Customize Logos and Hyperlinks
It is allowed to change several images on the Customizations page. An image can be changed by
uploading a new file, or reset an image to the default WebCenter value. Any changes to the images are
saved after clicking the page's main Save button.

There are four images (and their hyperlinks) on you can change:

• Application Logo: This is the top left logo and it appears on every page. It can be replaced by
uploading a new image with approximately the same height (50 pixels). In case you use an AppLogo
image higher than 50px, you will stretch the top header along with this image. The recommended
file type for this image is: GIF or PNG. It is common practice to give the top logo a hyperlink to a
more general web page (typically your company’s home page). In WebCenter 16.X you can choose
between showing the Application Logo in the Menu bar (default, more compact), or displaying it
above the Menu bar for wider images, by applying the setting Show the application logo above the
menu bar.

• Company Logo: To the bottom right of the login page is the Esko logo (and its hyperlink to
www.esko.com). It can be replaced by uploading a new image with approximately the same height
(28 pixels). We appreciate it when customers keep our logo visible.

• Product Line Logo: To the bottom left, there is a placeholder for another image (ProductLineLogo).
The standard installation does not put anything there. It is possible to upload a new image with a
height of approximately 28 pixels.

• Background Image: The default background image can be replaced with any image or with no
image at all. This watermark appears only on the login page. It has no hyperlink. The recommended
file type for this image is JPG or PNG. By disabling the setting Use full screen background image,
the image is displayed as a smaller rectangle on the page as in older versions of WebCenter.

1. To upload a new image click the Upload button and select an image from your system. Make sure
you select an image with roughly the correct dimensions and resolution (72 ppi).

2. To reset an image to the default value, click the Reset button. Note that sometimes there is no
default value, like for the Product Line Logo.

3. To add or modify an image link, enter a URL (starting with http://) in the URL field.

Customize Colors
It is possible to change various colors on the Customizations page. Any changes to the colors are saved
after clicking the page's main Save button.

There are several colors listed in the Colors section. Each with a title reflecting it's purpose. For
example, you can change the footer color on the login page by changing the value for Login Footer
Color.

Note:  Menu colors are all determined by the value set as Menu Color. The system automatically
calculates shades of your chosen color and determines the font color (black or white) based on the
optimal contrast with the calculated colors, to allow for easy and fast customization of the Menu bar.

1. In the Colors section, you can see an overview of the currently selected colors.
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2. To change a color, you can either paste a hexadecimal color code in the color field, or you can use
the color picker by clicking the color patch.

3. After opening the color picker you can move the little circle selecting the color around to change
the saturation and brightness within the same hue. It is also possible to edit the hexadecimal color
code manually, or to enter a new value for the RGB and HSB values.

4. After selecting a color, you can exit the color picker by simply clicking outside the color picker pop
up, or by clicking the little color circle icon.

5. By using the Reset button, you can revert a specific color to the original WebCenter value.

Customize Fonts
In the Fonts section, you can change the currently used font to a different font type and change the
font base size.

Any changes to the fonts are saved after clicking the page's main Save button.

1. To change the font type, enter a new value in the Font field. Make sure you use a commenly used
font, which is installed on your user's systems.

2. To change the font sizes, simply enter a new value in the Base Font Size field. All other font sizes
(larger/smaller) are calculated based on this base font size, to allow for easier customization.

Customize Static Text
There are a number of places in WebCenter where static text such as a marketing message is
displayed. You can replace these sections with your own valid HTML pages. Any changes to the static
text section are saved after clicking the page's main Save button.

Currently it is possible to replace the following sections:

• Welcome message on the login page (band above the main login section)
• Marketing message on the login page
• Marketing message on the welcome page
• Contact page (linked on top of each page)

The Static Text section shows an overview of the static text customizations that are currently applied.
The static text section can be filled in with HTML pages containing text, images and inline CSS. In case
no customization has been done, you will see "Default" next to the static text name. In case there is a
customization , Preview is visible and a Reset button is also shown.

1. To upload a new static text file, click the Upload button and select a valid HTML file from your
system.

Note:  Ensure that your HTML page does not contain !DOCTYPE else it could affect the functioning
of WebCenter.

2. To preview a static text file, click the Preview button.
3. To reset a static text item and remove the customization, click the Reset button.

Forgot Password
To add a Forgot Password? link to the WebCenter Log In page, do the following:

1. Go to Admin > Preferences > Customizations.
2. At the bottom of the Customization page, select Show Forgot Password link in the Other section.
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3. Click Save.
Alternatively, you can add this link when customizing the user interface.

When you click the Forgot Password? link, you are asked to supply user name or email address. You are
then sent an email with a temporary password and a link to the Log In page.

After logging in, you are prompted to change the password.

Fixed Navigation Bar
To fix the Navigation / Menu bar in the WebCenter application, do the following:

1. Go to Admin > Preferences > Customizations.
2. At the bottom of the Customization page, select Use Fixed Navigation Bar in the Other section.
3. Save the changes.

When a user scrolls down any page, the navigation bar is fixed on the top of the page.

5.6.  Customizing the Look and Feel of WebCenter Using the
customizationConfig.xml file

You can customize WebCenter's look and feel using the customizationConfig.xml file. All you
need to do to apply your customizations is to modify this file accordingly and save it. Reload your pages
to see your changes reflected.

Any settings from the customizationConfig.xml file overrule default WebCenter application
settings.

The customizationConfig.xml file should be placed into the customization directory on your
Web server instance, which is <WebCenter_Instance>\custom directory (such as c:\Artios
\WebCenter\WebServer\tomcat\webapps\WebCenter_instance\custom).

In the following section we will list what is possible to customize and how to achieve that.

For your convenience there is a <WebCenter_instance>\custom_example directory in the
web server instance including a customization example. This directory contains a commented
customizationConfig.xml file and necessary additional files which will help you easily try most of
the customizations described in this documentation.
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To use the example files, simply copy content from this directory into the <WebCenter_Instance>
\custom directory.

5.6.1.  Customizing Logos and their Hyperlinks

A number of logos are displayed in WebCenter, many of them with a clickable hyperlink. You can
change the logo image and the hyperlink target.

Customize Logos and Hyperlinks
In a standard WebCenter installation, the login window will look more or less like in the picture
below (the actual appearance depends on your screen settings, the browser used and the version of
WebCenter you have installed).

 

 

There are four images (and their hyperlinks) on this page you can change:

• The top logo WebCenter icon. This logo appears on every page. It can be adapted by replacing it
with any image of approximately the same height (50 pixels). In case you use an AppLogo image
higher than 50px, you will stretch the top header along with this image.

Once the user is logged in (and not before that), this image can be further changed to reflect your
relationship. It is common practice to give the top logo a hyperlink to a more general web page
(typically your company’s home page).

• The Background image (BackgroundImage) can be replaced with any image or with no image at all.
This image ONLY appears on the login page. It has no hyperlink. Since WebCenter 16.X, it can be set
as a full-screen image as well.
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• To the bottom left, there is a placeholder for another image (ProductLineLogo). The standard
installation does not put anything there.

• To the bottom right (CompanyLogo) is the Esko logo (and its hyperlink to www.esko.com). It can
be replaced just like any other logo. We appreciate it when customers keep our logo visible.
Esko stands for quality, innovation and communication. Your site will be more appreciated if you
reinforce it by showing what technology you are using for servicing your customers and partners.

1. To customize the logos on the log on page, add the following tags to
customizationConfig.xml:

<AppLogo 
   RelPath="images/DEFAULT_WebCenter-banner.png"  
   href="homepage.jsp"  /> 
<CompanyLogo 
   RelPath="images/DEFAULT_logo_esko.png"  
   href="http://www.esko.com"  />
<BackgroundImage 
   RelPath="images/BackgroundImage.png"  />
 <FloatAppLogo 
   value='false' />
 <FullScreenBackground 
   value='true' />

The settings FloatAppLogo and FullScreenBackground can be used to move the Application Logo
above the Menu bar and set the Background Image to full-screen respectively.

The following attributes can be used to provide the required image and optionally set the hyperlink:

• RelPath – defines the path of the logo image relatively to the custom directory.

• href – if the logo is also a hyperlink, you can specify its target.

2. To customize the logo for the normal pages, you can also use the following tag:

<AppLogo 
   RelPath="images/AppLogo.png" 
   href="http://www.esko.com"/>

The following is an example of a Login page with customized Application Logo and Background Image.
Note that in this case the header and footer colors have also been customized.
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Customize Logo for a User or Company
Besides from customizing different WebCenter instances, it is also possible to create different
customizations inside the same instance. Using this type of customization you are able to customize
the AppLogo image, in the top left corner, for specific users or companies.

1. Inside your WebCenter instance's custom folder, you can create individual folders. Each of these
folders should contain their own customizationConfig.xml file and a folder called images
in which the logo image is placed. These folders should be named according to the following
conventions:

• USER to apply for a user with a specific user name,
• Company_ to apply for a specific company,
• Company_Location to apply for a specific company and location.

For example, for a user called "John Doe" (with the user name "JOHNDOE") at the company "Esko",
that has two locations: "Ghent" and "Singapore", you should name the folders:

• JOHNDOE (the user name) when applying the customization to that user specifically,

• Esko when applying the customization to all users at the "Esko" company,

• Esko_Ghent when applying the customization to users at the "Esko" company and "Ghent"
location.
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Note:  Please make sure you use the exact user, company and location names, keeping the correct
case and any spaces or special characters they may contain. For example, user names should be in
capital letters.

2. The customizationConfig.xml file should only contain one tag:

<AppLogo 
   RelPath="images/AppLogo.png" 
   href="http://www.esko.com"/>

The following attributes can be used to provide the required image and optionally set the hyperlink:

• RelPath – defines the path of the logo image relatively to the custom directory.

• href – if the logo is also a hyperlink, you can specify its target.

In the example a special "JOHNDOE" folder has been created. This folder contains a
customizationConfig.xml file and an images folder with a different logo image. When the user
with the user name "JOHNDOE" now logs in, he will see his customized AppLogo image. All the other
users will still see the image used in the top level customization.

5.6.2.  Custom Language Flags for Text Content

You can now use customized flag images for the Master and Translation languages used in the
Packaging Content Management (PCM). To use custom languages for the master or translation
languages list, customized country flags can be stored in the custom folders in the Web Server. Since
the images are available in the custom folder, these images are retained after every WebCenter
upgrade.

To use custom images for flags for each of the languages,

1. Store the custom images in custom/country_flags and custom/country_flags/big folder in the
WebServer.

2. Along with this language list is also required to be updated to use these flags.
3. Ensure full path for the flag is mentioned in language list excel sheet for the image as custom/

country_flags/file name.
 

 

Note:  Flags which are available with WebCenter as default are mentioned with file name only.

5.6.3.  Change the Color Scheme

The WebCenter color scheme has been chosen to be business-oriented and to reflect Esko’s corporate
identity.

1055



5 WebCenter

It is possible to use your company's brand colors in WebCenter. The application uses several colors
consistently throughout the application and each one of them can be replaced with another color. Use
standard HTML-formatted color definition (e.g. #334444).

Tip:

The color definitions consist of 6 hexadecimal numbers, 2 for Red, 2 for Green, and 2 for Blue. The
easiest method for determining the hexadecimal RGB values of a color is to create it in the Color Picker
in Photoshop. You can copy and paste the hexadecimal values from the # field.

• Add the following tag to the customizationConfig.xml file:

 <Colors> <Color id="1" hexVal="FF0000"/>
            </Colors> 

Color Scheme Reference

ID Default Value Used in

8 fafafa Project Selected Folder

13 334444 Main Header and Menu

15 fbfbfb Footer Background Color

16 334444 Footer Login Page

18 334444 Primary Button

19 ffffff Default Button

20 5f7e7e Link Color

21 3e5353 Link Hover Color

5.6.4.  Change the Fonts

Fonts in WebCenter are based on a similar concept as the color scheme. One font in varying sizes is
consistently used through the application.

The default font sizes were chosen to optimally fit into the various WebCenter pages. You only need to
adapt the base font size and all the other font sizes adapt proportionally.

Add the following tag into the customizationConfig.xml file to change the font family to Open
Sans and increase the base font size.

<Font name="Opens Sans"> 
    <Size id="3" pxVal="14"/> 
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</Font>

5.6.5.  Customize Static Text

There are a number of places in WebCenter where static text such as a marketing message is
displayed. The software provides a straightforward mechanism for you to replace the text with your
own HTML pages.

What Static Text Items Can You Customize?
Currently it is possible to replace the following (see screen shots below):

• Welcome message on the Login page.

• Marketing message on the Login page.

• Marketing message on the Welcome page.

• Contact page (linked in the footer, at the bottom of each page)
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Customize a Static Text Item
There are some limitations you need to take into account when preparing your HTML page. You need to
make sure that your HTML page body is also valid XHTML. Therefore, the rules for HTML tags are a bit
stricter. There are many tools and online Web pages where you can validate your HTML, such as http://
validator.w3.org/. If the document body is not valid XHTML you may encounter runtime errors when
accessing your customized page.

Note that the default WebCenter stylesheet is applied to the whole page, as well as to your custom
HTML static text. That might be confusing because your text could look different than expected when
inserted as static text on the page. For example, links might look bigger. To avoid such effects, can
either use inline styling in your HTML, or set styles in your CSS to !important. For example:

a {font-size:15px !important; color:#f00 !important;}

• To replace the pieces of static text, add the following tags into the customizationConfig.xml
file:

<StaticText> 
    <LoginWelcomeMsg RelPath="text/loginWelcomeMsg.html"/> 
    <LoginMarketingMsg RelPath="text/loginMarketingMsg.html"/>  
    <HomeMarketingMsg RelPath="text/homeMarketingMsg.html"/> 
    <ContactPage RelPath="text/contactPage.html"/> 
</StaticText>
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Each of the StaticText sub-tags replaces the corresponding static text with your custom HTML
document. Using the RelPath attribute, specify the path to your HTML document relative to the
custom directory.

Example: Customizing Static Text
Let’s look at the following HTML with which we want to replace the Login page Welcome message. If
you put the content of our HTML into the XHTML document as shown below and it passes the validation
test, WebCenter should display your HTML correctly.

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" "http://www.w3.org/TR/xhtml1/
DTD/xhtml1-strict.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml" lang="en" xml:lang="en-us">
 <head> 
  <title>Login Page Marketing Message</title> 
  <style type="text/css"> 
   #welcome p {color:#4a5656;font-family:Verdana,Arial,Helvetica,sans-serif;font-
size:11px;font-weight:bold;}
   #welcomeimage {align:left;}
  </style> 
 </head> 
 <body> 
  <table>
   <tr>
    <td id="welcomeimage">
     <a href="http://www.esko.com/webcenter">
 <img src="custom/images/webcenterblue.jpg"/>
     </a>
    </td>
    <td id="welcome" width="220px">
      <p>We are proud to use Esko software to help your business grow.</p>
    </td>
   </tr>
  </table>
 </body> 
</html>

Note that all relative references that you use in HTML should be relative to the Web server root
directory which is the WebCenter instance directory, such as WebCenter_Inst. Like in the example
above, the path for images needs to be relative.
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5.6.6.  Customize the Language Files

You can customize your own language files or add completely new language translations.The example
below shows how to modify the customization configuration file to modify the default English language
translation:

1. In the customizationConfig.xml file, add the following language tag:

<Languages RelPath="languages"> 
 <Language key="en" zipencoding="Cp437"/> 
</Languages>

The RelPath attribute specifies the directory where the system looks for customized language files.
RelPath should be specified relative to the custom directory. In this case, you are referring to the
languages subdirectory in the custom directory.

The Language sub-tag has the same attributes as the corresponding tags in the default
config.xml file. Also, the naming convention and structure of the language files are the same as
for the standard language files.

2. Edit the wcstrings_en.xml file in the languages subdirectory to reflect your new language
strings.
If you are not familiar with the default language files structure and usage, the easiest method is
to copy the language file (from the default location <WebCenter_Instance>\languages) you
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want to modify to a subdirectory of the custom directory, such as wcstrings_en.xml in custom
\languages. Edit the file and remove all tags except the ones you want to change.

The edited results look like the example below and it can contain one or a multitude of strings (you only
need to add the ones you wish to modify):

<?xml version="1.0" encoding="UTF-8"?>
<language xml:lang="en-us">
 <application name="JSP_Strings">
  <lang_string key="WCAUTHOR" value="WebCenter is another awesome product created by"/>
 </application>
</language>

As you can see, we have changed the text in the footer lower left corner. The picture below shows the
result of our customization.

 

 

5.6.7.  Forgot Password

To add a Forgot Password? link to the WebCenter Log In page through the
customizationConfig.xml file, do the following:

1. Open the customizationConfig.xml file in an XML editor.
See Customizing the Look and Feel of WebCenter Using the customizationConfig.xml file on page
1051 to know where to find this file.

2. Add the following XML code between the WebCenterCustomizationConfig XML tags:

<ForgotPassword show="1"/>

3. Save the file and place it into the customization directory on your Web server instance.

When you click the Forgot Password? link, you are asked to supply user name or email address. You are
then sent an email with a temporary password and a link to the Log In page.

After logging in, you are prompted to change the password.
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Note:

The e-mail uses the e-mail customization framework to customize/translate the messages sent to the
user.

You can find an example of the data that can be used in the e-mail in C:/Esko/Artios/
WebCenter/ApplicationServer/EmailNotifications/Example/user. This folder
contains:

• reset_password_example_body.xsl

• reset_password_example_source.xml

• reset_password_example_subject.xsl

You should copy these files to C:/Esko/Artios/WebCenter/ApplicationServer/
EmailNotifications/Custom/user before editing them.

For more information about customizing e-mails, see Customizing the E-Mail Notifications on page
1087.

5.6.8.  Fixed Navigation Bar

To fix the Navigation / Menu bar in the WebCenter application, do the following:

1. Go to Admin > Preferences > Customizations.
2. At the bottom of the Customization page, select Use Fixed Navigation Bar in the Other section.
3. Save the changes.

When a user scrolls down any page, the navigation bar is fixed on the top of the page.

5.7.  Customizing the WebCenter Menus

You can customize the WebCenter menus to tailor what users see to what they need to do in
WebCenter.

This way, you can make sure their user experience is as smooth as possible.

You can:

• remove unused menu items to simplify the user interface,
• add menu items that link to frequently used WebCenter pages not already part of a menu,

• change which page a menu item links to,
• remove unwanted action buttons from tables,
• add custom action buttons.

You can assign custom menus to users and / or companies (see "Edit a User" and "Edit a Company" in
the Administration Guide).

Tip:  To see what a menu looks like, hover on it in the WebCenter user interface. This shows the sub
menus.

You can manage custom menus through the WebCenter user interface. Log in as an Admin, and go to
Admin > Preferences > Menus.
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See Menus  on page 107 in the Administration Guide for details.

5.7.1.  Create a Custom Menu

You can create a custom menu for each category of users, to make it more convenient for them.

Note:

Menus are XML files, so you will need an XML editor (you can find various freeware XML editors on the
internet, for example XML Marker or Notepad++).

However, if you are not comfortable using XML, you can also create a custom menu through the
WebCenter user interface (see Create a Custom Menu through the WebCenter User Interface on page 108
in the Administration Guide).

You will need to:

1. Determine the menu items a particular group of users would require for ecient funtioning.
2. Download the default menu to use as a starting point.
3. In an XML editor, remove the menu items that are not necessary for those users.

This allows you to simplify the WebCenter interface, especially for occasional users. For example,
you can create a menu that only contains My Work for approval users.

4. Add custom menu items, to link to the WebCenter pages of your choice.
This allows you to make the pages most used by your users accessible. For example, you can add
menu items linking to saved searches, or to project creation from a specific project template.

5. When you are done editing the menu file, save the menu with a name.
6. Upload your custom menu:

a) Click the Menu Upload button on the Menus page,
b) In the Menu Upload page, browse to your XML file,
c) Give your custom menu a Name and a Description,
d) Click Upload.

7. Assign the menu to the users (or company) you created it for.
8. Log out and log in to WebCenter as one of the users to which you gave the custom menu, and check

whether the menu works.

Download the Default Menu
You will use the default menu as a basis for creating custom menus.

1. Download the default menu:
a) On the Admin > Preferences > Menus page, click the Download Menu link corresponding to the

Default menu.
b) The (XML) menu file will typically open in your browser. You need to save it to a file. Use for

example:

• File > Save Asin Microsoft Edge,

• File > Save Page As or Ctrl+S / Command+S in Firefox,
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• File > Save As or Command+S in Safari (make sure you select Page Source as Format),

• Ctrl+S / Command+S in Google Chrome.

Note:  Do not copy and paste the XML from your browser as this can give corrupted XML.

2. Open the menu file you downloaded in your XML editor.

See Structure of the XML Menu File on page 1065 to familiarize yourself with the file.

Structure of the XML Menu File
Each menu and menu entry is enclosed in a menuitem tag.

 

 

You can expand and collapse menus and menu entries (use + to expand and - to collapse).
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Tip:  The comments between <!-- and --> indicate what the tags below correspond to.

Main Row Menus
The first <menuitem>, "NON_ADMIN", contains the menu items corresponding to the top menu bar
(when not in Admin mode).

 

 
 

 

Note:  It is not possible to edit the Admin menus.
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Task Type Details
The menu items inside the "TASKTYPEDETAILS" <menuitem> (under <!-- Task type details menu -->)
correspond to the tabbed menu you get when editing a task type (only for users who can create a task
type).
 

 

You will probably not need to change this.

Project Details
The menu items inside the "PROJDETAILS" <menuitem> correspond to the tabbed menu you get on the
Project Details page.
 

 

Template Details
The menu items inside the "TEMPLATEDETAILS" <menuitem> correspond to the tabbed menu you get
on the Template Details page (only for Admin users).
 

 

You will probably not need to change this.

Document Details
The menu items inside the "DOCDETAILS" <menuitem> correspond to the tabbed menu you get on the
Document Details page.
 

 

Task Type Details (Read Only Mode)
The menu items inside the "TASKTYPEDETAILSRO" <menuitem> correspond to the tabbed menu you
get when looking at task types in read only mode.

You will probably not need to change this.

My Users
The menu items inside the "MYUSERS" <menuitem> correspond to the tabbed menu you get when
going to My WebCenter > My Users and editing a user (for Project Managers with the User Can Create
User right).
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Remove Unused Menu Items
Remove the menus and / or menu entries that are not necessary for your target users.

• For each item to remove, delete everything between <menuitem> and </menuitem>, including the
<menuitem> and </menuitem> tags.
 

 

Attention:  Make sure you are very precise and delete only corresponding <menuitem> and
</menuitem> tags, so as not to break the XML structure!

Add Custom Menu Items
• To add a top level menu, add a <menuitem> element, with the following elements in it:

<name> Choose a unique name for your menu.

This name is only used to identify the menu in
the XML file.

<labeltag> Enter the language file tag corresponding
to your new menu. You can use a tag already
existing in the language files, or a new tag.

This makes displaying your new menu in
multiple languages possible: you enter
the tag here, and in each language file you
associate that tag with the text string that
will be shown for that menu in that language.

If for example you are adding a menu linking
to a(n existing) saved search showing
rejected documents:

1. Enter "REJECTED_DOCUMENTS_TAG"
as <labeltag>,

2. Associate that tag with the "Rejected
Documents" string in your English
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language file, with "Documents Rejetés" in
your French language file, etc.

Note:  If you are using a new tag, you need
to add it to the custom language files,
otherwise you will lose it with every upgrade.

See Customize the Language Files on page
1061 for more information about customizing
the language files.

<url> Enter the page which will be shown when
clicking the new menu.

Typically this will be a standard WebCenter
page which you otherwise would get by more
complex navigation.

<scope> Define which type of users will see the new
menu.

• Enter <project_managers/> if you only
want Project Managers to see it.

• Enter <admin_users/> if you only want
Administrators to see it.

• Enter <normal_users/> if you only want
normal users to see it.

• Enter <project_creators/>if you only want
Project Creators to see it.

If you want three types of users to see the
menu, enter them here. For example:

<scope>
      <admin_users/>
      <project_managers/>
      <project_creators/>
</scope>

If you want all user types to see it, don't enter
a scope at all.

Note:  Do not use spaces in the XML values.

For example, to create a menu showing the rejected documents saved search to all users, use this:

<menuitem>
   <name>REJECTED_DOCUMENTS</name>
   <labeltag>REJECTED_DOCUMENTS_TAG</labeltag>
   <url>dosavedsearch.jsp?searchName=RejectedDocuments</url>
</menuitem>
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• To add a menu entry under a top level menu, place that bit of XML between the <menuitem> tags of
the top level menu, as in the example below.

<menuitem>
    <name>SEARCH</name>
    <labeltag>SEARCH_TAG</labeltag>
    <url>projsearch.jsp</url>
    <menuitem>
        <name>REJECTED_DOCUMENTS</name>
        <labeltag>REJECTED_DOCUMENTS_TAG</labeltag>
        <url>dosavedsearch.jsp?searchName=RejectedDocuments</url>
    </menuitem>
</menuitem>

5.7.2.  Examples

Going to Projects I Am invited to in One Click
By default, the Projects menu of a normal (non Project Manager) user contains Favorite Projects and
Projects I am invited to.

You can optimise the menu options by removing the Favorite Projects and Projects I am invited to
entries, and make clicking on the Projects menu go directly to Projects I am invited to (instead of
going to Favorite Projects).

This makes going to Projects I am invited to a one-click operation.

1. Add a Projects menu (with no entries) going directly to Projects I am invited to for normal users:
Just before...

<menuitem> <name>PROJMGMNT</name>
                        …

add:

<menuitem>
                        <name>PROJECTS_NONPROJMGMNT</name>
                        <labeltag>PROJMGMNTPROJS_TAG</labeltag>
                        <url>iamprojectmember.jsp</url> <scope>
                        <normal_users/> </scope>
                        </menuitem>

Note:  The "PROJMGMNTPROJS_TAG" <labeltag> already exists in the language files with the value
"Projects" (in the English file), so you don't need to add it.

2. Change the scope of the old Projects menu by adding a <scope> element:

<menuitem> <name>PROJMGMNT</name>
                        <labeltag>PROJMGMNTPROJS_TAG</labeltag>
                        <url>myfavoriteproj.jsp</url> <scope>
                        <admin_users/> <project_managers/> </scope> …
                    

3. Save and upload your custom XML file.
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Customizing the Interface for Project Requests
Often you might want to allocate a separate menu item for creating a project (or requesting a project)
based on a fixed template.

Depending on your business process, you can use for example:

• New Sales Request
• Order Samples
• Create New Book
• Add Product
• New Campaign

If you only ever have one type of project request, you can Create a Project from a Fixed Template on
page 1071.

If you have different project request types, Create a Project from Different Templates on page 1072.

You can also Show Projects Created from the Request Template(s) on page 1075 and Add Your Requests
to Your My Work Page on page 1076.

Create a Project from a Fixed Template
If your users only need to create one type of project (request), you can add a button that will bring them
directly to the project creation page, with the template they need already selected.

1. In your XML menu file, remove all menu items the requesters won't need.
2. Add a menu item (called for example “New Request”), that links to creating a project based on an

existing template (called for example "New Box").

<menuitem> <name>NEW_REQUEST</name>
                        <labeltag>NEW_REQUEST_TAG</labeltag>
                        <url>projmgmntnewproject.jsp?template=New%20Box</url> <scope>
                        <project_managers/> </scope> </menuitem> 

Note:  Make sure you enter your template name precisely (the <url> is case sensitive and needs
%20 to represent a space).

3. Save and upload your custom XML file.
4. Assign the menu to the users (or company) you created it for.
5. Add a language string to the language files (see Add Custom Menu Items on page 1068 and

Customize the Language Files on page 1061).
6. Restart TomCat.
7. Log in to WebCenter as one of the users to which you gave the “New Request” menu, and check

whether:

• you see the "New Request" menu,
• clicking the menu opens the project creation page, with the "New Box" template selected.
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Note:

If this does not work, check all previous steps for spelling mistakes.

• If you don't get the new menu item, you have added the information incorrectly to the XML file.
• If you get an empty menu item (no text), your XML file is correct but your language file is not.
• If all is scrambled, you have broken the XML. Go back to a previous version.

Create a Project from Different Templates
If your users need to create several types of projects (requests), you can add a button that will bring
them to the project creation page, with a selection of templates to choose from.

1. Mark the templates they will need to choose from using a characteristic:
a) Log in to WebCenter as an Admin and go to Admin > Characteristics.
b) On the Characteristics page, make sure ROOT is selected and click New Characteristic. Create

a characteristic called "Request".
c) Go to one of the template the requesters will use (for example "New Box") and add the "Request"

characteristic to it.
d) Repeat for all templates the requesters will use.

2. In your XML menu file, remove all menu items the requesters won't need.
3. Add a “New Request” menu item, that links to the project creation page, and calls the "Request"

template characteristic.

<menuitem> <name>NEW_REQUEST</name>
                        <labeltag>NEW_REQUEST_TAG</labeltag>
                            <url>projmgmntnewproject.jsp?templatecharacteristicpath=\
\Request</url>
                        <scope> <project_managers/> </scope> </menuitem> 

Note:  Make sure you enter your template name precisely (the <url> is case sensitive).

4. Save and upload your custom XML file.
5. Assign the menu to the users (or company) you created it for.
6. Add a language string to the language files (see Add Custom Menu Items on page 1068 and

Customize the Language Files on page 1061).
7. Restart TomCat.
8. Log in to WebCenter as one of the users to which you gave the “New Request” menu, and check

whether:

• you see the “New Request” menu,
• clicking the menu opens the project creation page, with all the templates that have the

"Request" characteristic available.
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Note:

If this does not work, check all previous steps for spelling mistakes.

• If you don't get the new menu item, you have added the information incorrectly to the XML file.
• If you get an empty menu item (no text), your XML file is correct but your language file is not.
• If all is scrambled, you have broken the XML. Go back to a previous version.

Create a Project and Run a CAD Standard
If you are an ArtiosCAD user, you can run a CAD standard at project creation (see Run a CAD Standard
from WebCenter on page 406 in the Administration Guide).

You can create a custom menu item that allows users to create a project, based on a specific project
template (or a selection of templates), using specific ARD document templates to run a CAD standard.

1. Mark the ARD document templates the users will need to run a CAD standard using a characteristic:
a) Log in to WebCenter as an Admin and go to Admin > Characteristics.
b) On the Characteristics page, create the characteristic to assign to your ARD document

templates, and sub-characteristics if desired.

For example, create "Folding Carton" as a main characteristic and types of boxes as sub-
characteristics.

 

 

Note:  The main characteristic can be as deep as you want in the characteristics tree, but it
cannot contain more than two levels of sub-characteristics.

See Create a Characteristic on page 302 in the Administration Guide for details.
c) Add the characteristic or one of the sub-characteristics you just created to all ARD document

templates you want to make available to the users at project creation.
For example, you can have an ARD document template with the "Tall rectangular box" and "Cereal
box" characteristics, another one with the "Square box" characteristic, etc.

2. In your XML menu file, remove all menu items the requesters won't need.
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3. Add a menu item (for example "New Request") that links to creating a project based on an existing
template (for example "New Box"), using ARD document templates with your chosen main
characteristic (for example "Folding Carton") for running a CAD standard.

<menuitem> <name>NEW_REQUEST</name>
                        <labeltag>NEW_REQUEST_TAG</labeltag>
                            <url>projmgmntnewproject.jsp?template=New
%20Box&amp;documentcharacteristicpath=\\Product%20Type\\Folding%20Carton</url>
                        <scope> <project_managers/> </scope>
                        </menuitem> 

Note:

Make sure you enter your template and characteristic names precisely:

• the <url> is case sensitive,

• use %20 to represent a space,

• use &amp; between the reference to the project template and the reference to the document
characteristic,

• use \\ before each level of the characteristic tree under ROOT (so ROOT > Product Type > Folding
Carton is \\Product%20Type\\Folding%20Carton).

Tip:

If you want the requesters to select from a list of relevant project templates instead of using a
fixed one, mark these project templates with a characteristic as explained in Create a Project from
Different Templates on page 1072.

Then specify the project template and document template characteristics to use in the XML:

<menuitem> <name>NEW_REQUEST</name>
                            <labeltag>NEW_REQUEST_TAG</labeltag>
                                <url>projmgmntnewproject.jsp?templatecharacteristicpath=\
\Request&amp;documentcharacteristicpath=\\Product%20Type\\Folding%20Carton</url>
                            <scope> <project_managers/> </scope>
                            </menuitem> 

4. Save and upload your custom XML file.
5. Assign the menu to the users (or company) you created it for.
6. Add a language string to the language files (see Add Custom Menu Items on page 1068 and

Customize the Language Files on page 1061).
7. Restart TomCat.
8. Log in to WebCenter as one of the users to which you gave the "New Request" menu, and check

whether:

• you see the "New Request" menu,
• clicking the menu opens the project creation page, with the "New Box" template selected (or

with a list of all templates that have the "Request" characteristic available, depending on what
you specified in the XML).
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• when clicking New in the Documents section, you can see the ARD templates that have the
"Folding Carton" characteristic or one of its sub-characteristics, and you can filter on sub-
characteristics (select up to two levels of sub-characteristics in Show and click Go).

 

 

Note:

If this does not work, check all previous steps for spelling mistakes.

• If you don't get the new menu item, you have added the information incorrectly to the XML file.
• If you get an empty menu item (no text), your XML file is correct but your language file is not.
• If all is scrambled, you have broken the XML. Go back to a previous version.

Show Projects Created from the Request Template(s)
Once you allow users to create requests, you will probably also want a “Requests” menu item, which
shows all projects created from templates with the "Request" characteristic.

1. Add a "Request" menu item (under "NON_ADMIN" if you want it to be a top level menu, or under a top
level menu item if you want a menu entry):

<menuitem> <name>REQUESTS</name>
                        <labeltag>REQUESTS_TAG</labeltag>
                        <url>myallprojects.jsp?characteristicpath=\\Request</url>
                        </menuitem> 

2. Save and upload (update) your custom XML file.
3. Add a language string to the language files.
4. Restart TomCat.
5. Log in to WebCenter as one of the users who has this menu, and check whether the menu works.
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Add Your Requests to Your My Work Page
To complete the user experience of requests, you can add a My Work section that displays the list of
requests the user created him/herself on their My Work page.

1. Log in to WebCenter as an Admin and do a project search looking for the "Request" characteristic.
 

 
2. Save this search as a Global search with the name "Requests".
3. Create a My Work section displaying this search:

a) Go to Admin > Preferences > My Work and click Create New My Work Section.
b) Fill the fields on the Create New My Work Section page as shown below and click Create.
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Note:  You can choose another scope than All Users, for example only a group of requesters.

Now people in the scope can add the "My Requests" section to their My Work page (via MyWork >
Edit My Work setup).

 

 

Removing the Keyword Search
To remove the ability to search using a keyword, add the following under the "NON_ADMIN"
<menuitem>:

<keyword_search><enabled>false</enabled></keyword_search> 
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This will remove the search box at the top right corner of the WebCenter window, and the Keyword
Search option from the Search For Projects, Search For Documents and Search For Tasks pages.

5.7.3.  Will My Customizations Survive New Updates?

The XML files you create are uploaded to the database and as such, they will survive WebCenter
updates/upgrades. This means that the menus will remain as you have defined them.

However, new features added by a new version may mean extra menu items added in the default menu.

If you created your custom menu(s) from a full copy of the default menu, users having those menus will
not see the menus added by the new version.

To prevent this, we recommend you work with an XML file containing only the “differences” between
the default menu and your custom menu.

This means that you only put the part which you actually changed in the new XML file.

Examples
• If you only changed the top menu, your XML should only contain the "NON_ADMIN" menu item. This

way, the other menus will stay the same.
• If you only want to remove a part of the project details tabbed menu, create an XML file with only the

"PROJDETAILS" section (and change it to your needs).
• If you only want to add an item to the existing top level menu, just include that menu item in the XML

file (nothing else). It will be added to the right of the top level menu.

5.8.  Integrating an External Web Connection into the User
Interface

An external web connection is a connection to some data in an external system (usually a MIS system).
The MIS system calculates the data (for example a bill's details) and WebCenter retrieves this data
through the external web connection and displays it on a WebCenter page.

After configuring the external web connection (see Configure External Web Connections on page 414
in the Administration Guide), you can choose to add a link to it in a WebCenter top-level menu, project
menu or a My Work section.

5.8.1.  Integrating an External Web Connection into a Top-Level Menu

To integrate an external web connection into a WebCenter top-level menu, you need to edit the
menu.xml file (see the Customizing the WebCenter Menus chapter for some background information
about menus and how to edit them).

Note:  You can only have one link to an external web connection in the top level menu per menu file.

If the external system you are connecting to outputs XML, you will also need an XSL (eXtensible
Stylesheet Language) file to transform this to HTML and display it in WebCenter. Your WebCenter
installation comes with an example XSL file, that you can customize.

1. If the external system you are connecting to outputs XML, edit the example XSL file as necessary:
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a) Copy the example XSL file called externalwebtransform.xsl, located in your
custom_example\externalwebconnection folder, and paste it into custom
\externalwebconnection.

Tip:  Both the custom_example\externalwebconnection and the custom
\externalwebconnection folders are located on your Web server instance, for example
C:\Artios\WebCenter\WebServer\tomcat\webapps\WebCenter_instance
\custom_example\externalwebconnection.

b) Edit the custom\externalwebconnection\externalwebtransform.xsl file as
necessary. You can also rename it if desired.

Tip:  See the Customizing the E-Mail Notifications chapter for principles and tips about editing an
XSL file.

2. Download the default menu to use as a starting point.
3. In the menu.xml file, locate the part starting with <!-- External Web Connection (1-level Menu).

4. Uncomment the following section:

<!-- <menuitem>
            <name>MYEXTERNALWEB_INFO</name>
            <labeltag>MYEXTERNALWEB_INFO_TAG</labeltag>
            <url>myexternalwebinfo.jsp?ExternalWebConfigName=<Name of your external
 web configuration>&amp;XSLTransform=<Name of your xsl transformation in custom/
externalwebconnection directory>&amp;CallFromWebserver=<0/1 depending on whether the
 call to the external system needs to be made on the tomcat server (1), or the jboss
 server (0)></url>
</menuitem> -->

Tip:  To uncomment, remove the <!-- and --> signs that surround the section.

5. Edit this section as necessary:
a) Replace <Name of your external web configuration> by the name of your external web

connection.
b) If the external system you are connecting to outputs XML, replace <Name of your xsl

transformation in custom/externalwebconnection directory> by the name of the XSL file in your
custom\externalwebconnection folder.
You can skip this step if you didn't rename the externalwebtransform.xsl file.

c) In the CallFromWebserver parameter, replace <0/1 depending on whether the call to the
external system needs to be made on the tomcat server (1), or the jboss server (0)> by
either:

• <0> if you want to connect to the external system from the WebCenter Application Server,

• <1> if you want to connect to the external system from the WebCenter Web Server.

If you don't specify anything, WebCenter will try to connect to the external system from the
Application Server.

For example, if:

• your external web connection is called "ExternalWebConfig1",
• you haven't renamed the externalwebtransform.xsl file,

• you want to connect from the Application Server,
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then you should include the following section menu.xml file:

<menuitem>
            <name>MYEXTERNALWEB_INFO</name>
            <labeltag>MYEXTERNALWEB_INFO_TAG</labeltag>
            <url>myexternalwebinfo.jsp?ExternalWebConfigName=ExternalWebConfig1</url>
</menuitem>

6. When you are done editing the menu file, save it under a meaningful name.
7. Upload your custom menu:

a) click the Menu Upload button on the Menus page,
b) on the Menu Upload page, browse to your XML file,
c) give your custom menu a Name and a Description,
d) click Upload.

8. If desired, assign the menu to specific users (or companies).
9. Log out and log in to WebCenter as one of the users to which you gave the custom menu, and check

whether the menu works.
When clicking the menu item, the system will send a request to the configured service, and show
the result in a page containing the normal WebCenter navigation and:

• for a HTML connection: the returned HTML.

Note:  The external system must make sure this HTML is suciently self-contained.

• for an XML connection: the HTML resulting from converting the returned XML with the XSL file
you configured.

5.8.2.  Integrating an External Web Connection into a Project Menu

To integrate an external web connection into a WebCenter project menu, you need to edit the
menu.xml file (see the Customizing the WebCenter Menus for some background information about
menus and how to edit them).

Note:  You can only have one external web connection menu item per project.

If the external system you are connecting to outputs XML, you will also need an XSL (eXtensible
Stylesheet Language) file to transform this to HTML and display it in WebCenter. Your WebCenter
installation comes with an example XSL file, that you can customize.

1. If the external system you are connecting to outputs XML, edit the example XSL file as necessary:
a) Copy the example XSL file called externalwebtransform.xsl, located in your

custom_example\externalwebconnection folder, and paste it into custom
\externalwebconnection.

Tip:  Both the custom_example\externalwebconnection and the custom
\externalwebconnection folders are located on your Web server instance, for example
C:\Artios\WebCenter\WebServer\tomcat\webapps\WebCenter_instance
\custom_example\externalwebconnection.

b) Edit the custom\externalwebconnection\externalwebtransform.xsl file as
necessary. You can also rename it if desired.
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Tip:  See the Customizing the E-Mail Notifications for principles and tips about editing an XSL
file.

2. Download the default menu to use as a starting point.
3. In the menu.xml file, locate the part starting with <!-- External Web Connection (Project-level

Menu).

4. Uncomment the following section:

<!-- <menuitem>
            <name>PROJDETAILSEXTERNALWEBINFO</name>
            <labeltag>PROJDETAILSEXTERNALWEBINFO_TAG</labeltag>
            <url>projdetailsexternalwebinfo.jsp?ExternalWebConfigName=<Name of your
 External Web configuration>&amp;XSLTransform=<Name of your xsl transformation in
 custom/externalwebconnection directory>&amp;CallFromWebserver=<0/1 depending on
 whether the call to the External Web system needs to be made on the tomcat server
 (1), or the jboss server (0)></url>
</menuitem> -->

Tip:  To uncomment, remove the <!-- and --> signs that surround the section.

5. Edit this section as necessary:
a) Replace <Name of your external web configuration> by the name of your external web

connection.
b) If the external system you are connecting to outputs XML, replace <Name of your xsl

transformation in custom/externalwebconnection directory> by the name of the XSL file in your
custom\externalwebconnection folder.
You can skip this step if you didn't rename the externalwebtransform.xsl file.

c) In the CallFromWebserver parameter, replace <0/1 depending on whether the call to the
external system needs to be made on the tomcat server (1), or the jboss server (0)> by
either:

• <0> if you want to connect to the external system from the WebCenter Application Server,

• <1> if you want to connect to the external system from the WebCenter Web Server.

If you don't specify anything, WebCenter will try to connect to the external system from the
Application Server.

For example, if:

• your external web connection is called "ExternalWebConfig2",
• you have renamed the externalwebtransform.xsl file to

ExternalWebProjecttransform.xsl,

• you want to connect from the Web Server,

then you should include the following section menu.xml file:

<menuitem>
            <name>PROJDETAILSEXTERNALWEBINFO</name>
            <labeltag>PROJDETAILSEXTERNALWEBINFO_TAG</labeltag>
            <url>projdetailsexternalwebinfo.jsp?
 ExternalWebConfigName=ExternalWebConfig2&amp;XSLTransform=ExternalWebProjecttransform.xsl&amp;CallFromWebserver=1</
url>
</menuitem>
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6. When you are done editing the menu file, save it under a meaningful name.
7. Upload your custom menu:

a) click the Menu Upload button on the Menus page,
b) on the Menu Upload page, browse to your XML file,
c) give your custom menu a Name and a Description,
d) click Upload.

8. Go to a WebCenter project, and check whether the menu works.
When clicking the menu item, the system will send a request to the configured service, and show
the result in a page containing the normal WebCenter navigation and:

• for a HTML connection: the returned HTML.

Note:  The external system must make sure this HTML is suciently self-contained.

• for an XML connection: the HTML resulting from converting the returned XML with the XSL file
you configured.

5.8.3.  Integrating an External Web Connection into a My Work Section

To integrate an external web connection into a My Work section, you need to create a new homepage
section in the Admin > Preferences > My Work page.

If the external system you are connecting to outputs XML, you will also need an XSL (eXtensible
Stylesheet Language) file to transform this to HTML and display it in WebCenter. Your WebCenter
installation comes with an example XSL file, that you can customize.

1. If the external system you are connecting to outputs XML, edit the example XSL file as necessary:
a) Copy the example XSL file called externalwebtransform.xsl, located in your

custom_example\externalwebconnection folder, and paste it into custom
\externalwebconnection.

Tip:  Both the custom_example\externalwebconnection and the custom
\externalwebconnection folders are located on your Web server instance, for example
C:\Artios\WebCenter\WebServer\tomcat\webapps\WebCenter_instance
\custom_example\externalwebconnection.

b) Edit the custom\externalwebconnection\externalwebtransform.xsl file as
necessary. You can also rename it if desired.

Tip:  See the Customizing the E-Mail Notifications chapter for principles and tips about editing an
XSL file.

2. Click Admin > Preferences > My Work. The My Work Sections page appears.
3. Click Create New My Work Section.
4. Give your new section a Name.
5. In the Type option, select Generic.
6. In the URL field:

a) Paste the following:

http://<webserver_name>/<Instance name>/myexternalwebinfo.jsp?
ExternalWebConfigName=<Name of your External Web
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 configuration>&amp;XSLTransform=<Name of your xsl transformation in custom/
externalwebconnection directory>>&CallFromWebserver=<0/1>&homepageSection=1

b) Replace http://<webserver_name>/<Instance name> by the address of your WebCenter server.
c) Replace <Name of your external web configuration> by the name of your external web

connection.
d) If the external system you are connecting to outputs XML, replace <Name of your xsl

transformation in custom/externalwebconnection directory> by the name of the XSL file in your
custom\externalwebconnection folder.
You can skip this step if you didn't rename the externalwebtransform.xsl file.

e) In the CallFromWebserver parameter, replace <0/1 depending on whether the call to the
external system needs to be made on the tomcat server (1), or the jboss server (0)> by
either:

• <0> if you want to connect to the external system from the WebCenter Application Server,

• <1> if you want to connect to the external system from the WebCenter Web Server.

If you don't specify anything, WebCenter will try to connect to the external system from the
Application Server.

Note:  Make sure you keep the homepageSection=1 parameter at the end!

For example, if:

• the address of your WebCenter server is http://webcenter2.esko.com/
WebCenter_Inst/,

• your external web connection is called "ExternalWebConfig3",

• you have renamed the externalwebtransform.xsl file to ExternalWebHomepage.xsl,

• you want to connect from the Application Server,

then you should use the following as URL:

http://webcenter2.esko.com/WebCenter_Inst/myexternalwebinfo.jsp?
ExternalWebConfigName=ExternalWebConfig3&XSLTransform=ExternalWebHomepage.xsl
&homepageSection=1

7. In Scope, choose which type of users will be able to use this section in their My Work page:

• All Users,
• Administrators,
• Project Managers.

8. You can use groups to further filter the users that will be able to see the section. In Role Groups,
choose either:

• All Users if you want all users of the type specified in Scope to be able to use the section,
• Specific Groups if you want to restrict the section's visibility to specific groups (within that user

type).

In this case, select the groups which will able to use this section.
9. Click Create.
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10. Log out and log in to WebCenter as one of the users to which you assigned the new My Work
section, and check whether the link to the external web connection works.
When clicking the link, the system will send a request to the configured service, and show the result
in a page containing the normal WebCenter navigation and:

• for a HTML connection: the returned HTML.

Note:  The external system must make sure this HTML is suciently self-contained.

• for an XML connection: the HTML resulting from converting the returned XML with the XSL file
you configured.

5.9.  Customizing the Attributes

From WebCenter 12, it is possible to customize the attributes. You can now change the attribute's label
to an image, add an HTML help page, allow multiple values and more.

For more information about the Graphic Asset Browser and Cascading attributes, please consult the
WebCenter Admin Guide.

5.9.1.  Create Image Label for an Attribute

You can create Project request forms or Order forms with graphical labels by setting image labels
for specific Attributes in an Attribute Category. You can use this feature to make the form visually
attractive and user friendly. In addition, you can add graphical (packaging) symbols and warnings to aid
the user while filling in the forms.

1. Add the label images to the following folder on the WebServer: WebCenter\WebServer\tomcat
\webapps\WebCenter_Inst\custom\AttributeLabelImages.
Create a new folder custom if it does not exist yet and create a folder named
AttributeLabelImages under this folder.

Note:

• For the best user experience, use .jpg images. It does recognize .gif,.jpeg and .png.

2. Open your Attribute Category and select the Attribute  for which you want to give an image label.
3. In the cell details, enter the correct image name including the extension in the Label Image field

and save your attribute category.
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Note:  The image name is case sensitive.

You can see image labels appearing instead of attribute names in the forms.

 

 

Tip:  In case you wish to display a check box for the attribute, make sure you use an attribute with a
restricted set containing only the values Yes and No.
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Note:  You can either have a text label or an image label, but not both.

5.9.2.  Create HTML Information for an Attribute

When you design Project request forms or new Order forms, you might want to provide additional
information to the user who is filling in the information.

From WebCenter 12 onwards you can provide additional information as HTML help or information. This
is especially useful when technical fields need to be supported with extended HTML help.

There will be an information  icon that is added next to the attribute name or attribute image label.
When the user clicks on this icon, a pop-up HTML page with the information will appear.

1. Create an HTML file with the additional information you want to provide along with the attribute.
You can create textual information as well as images to explain the attribute.

2. Place this HTML file in the AttributeHelp folder ( WebCenter\WebServer\tomcat\webapps
\WebCenter_Inst\custom\AttributesHelp ).

3. Open the Attribute category and select the attribute for which you want to provide HTML help or
information.

4. In the cell details, enter the correct file name (of the HTML file) in the Info Page field and save your
Attribute Category.
 

 

If you have an HTML information page linked to an attribute, you can see an information icon next to

the attribute in the form that you created. When you click on the information , you can see a pop-up
window with the information to help the User.
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5.10.  Customizing the E-Mail Notifications

WebCenter users can determine the look and content of the e-mail notification messages themselves,
thus allowing for customizable e-mail notification messages.

5.10.1.  E-Mail Notification Templates In Detail

Each of the notification message types consists of two XSLT template files
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1. one for the message's body and
2. one for the message's subject.

For example the default Approval Cycle Finished notification message templates are following:

C:/Esko/Artios/WebCenter/ApplicationServer/EmailNotifications/Default/
Approval/cycle_finished_body.xsl

C:/Esko/Artios/WebCenter/ApplicationServer/EmailNotifications/Default/
Approval/cycle_finished_subject.xsl

All XSLT templates used for creating e-mail notification messages consume a single XML document
as a source for the actual transformation that leads to a plain-text-formatted output for message body
and subject. This XML source is supplied by the system when an appropriate action is triggered (i.e. a
project manager has changed a project status; an approval cycle has been started on a document; a
task was reassigned to a different user; etc.).

There are two basic parts of this XML source document:

• All supported String labels in XML format. These labels are inserted into the XML source document
by E-mail Language Manager. They are localized based on the language preference of the message's
recipient passed to the E-mail Language Manager.

• The actual data that makes up the "information part" of the message (i.e. project name/due date/
project manager name etc.)

These two parts of a XML source are enough for the XSLT template to create an appropriate output.

5.10.2.  Start from the example

The easiest way to customize the WebCenter e-mail notifications, is to start from the example files.
In the EmailNotifications folder, you can find an Default folder which contains an elaborate e-mail
customization.

Note:  This example has been tested for compatibility with the following e-mail clients: Outlook, iOS
Mail and GMail.

1. First of all, you may need to navigate to your ../EmailNotifications/Custom folder and
create a back-up of your current customized e-mail notifications.

2. Place the contents of the ../EmailNotifications/Example folder inside the Custom folder.
3. Restart the WebCenter services in order to update all language labels.

Basic customization
At the root of the Example folder, you can find 3 important XSL templates for basic customization of
the WebCenter e-mail notifications:

• header.xsl
• footer.xsl
• customize.xsl

These three template files contain the formatting of the header, the footer, style and content that is
used in all the e-mail notifications sent by WebCenter. If you make changes to these files, the changes
are reflected in all notification mails.

Another important file is: URL.xsl.
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Header.xsl
The Header.xsl file contains the logo of your company. The same header is included at the top of
every e-mail notification sent by WebCenter.

Logo image
In the example, the logo image is the same as the WebCenter AppLogo; the logo that is displayed in the
top left part of the header. This image is located on the Web Server. You can replace the WebCenter
logo by modifying the logoSource variable. You can use the host URL of WebCenter to build the URL, by
first adding:

<xsl:value-of select="host_url"
          />

After that, you add the path to the image, for example: /myimages/logo.gif, like in the example.
You could also use a web URL.

Note:  You can only specify an image source a server location (for instance, a web server on the
internet). A relative path to the e-mail customization folder will not work.

Logo link
By replacing the contents of the logoLink variable with the link to your company website, you change
the link attached to the company logo. When a user clicks on the logo in the e-mail notification, they
will be redirected to this specific URL.

Example:
Replace the existing variables:

 <xsl:variable name="logoLink"> <xsl:value-of
        select="host_url"/> </xsl:variable> <xsl:variable
        name="logoSource"> <xsl:value-of select="host_url"/>
        /images/WebCenter-banner.png </xsl:variable> 

By:

 <xsl:variable name="logoLink">
          http://www.mycompany.com </xsl:variable> <xsl:variable
          name="logoSource"> http://www.mycompany.com/image.jpg
          </xsl:variable> 

Footer.xsl
The Footer.xsl file is similar to the header file. It is included at the bottom of every e-mail
notification sent from WebCenter. You can modify the company name and address by changing the
company and address variables at the beginning of the file.

Example:
Replace the existing variables:

  
<xsl:variable name="company" select="'WebCenter © Esko'" />   
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<xsl:variable name="address" select="'Kortrijksesteenweg 1095, B-9051 Gent, België'" />  
  

By:

  
<xsl:variable name="company" select="'My company name'" />   
<xsl:variable name="address" select="'My address'" />    

Note:  Pay special attention to the single quotes that are used in addition to the double quotes.

Customize.xsl
The Customize.xsl file contains three parts: Styling, Content and Styles.

You can customize fonts and colors of the notifications in this file.
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Styling
The styles section contains all the elements that make up the fonts and the colors of the e-mail
notifications. For example, you can set a background color, font, font-size, font color, etc..

Example for styling in a customize.xsl file is given below:

<xsl:variablename="fontFamily">Roboto, Arial, Helvetica, sans-serif</xsl:variable>
        <xsl:variablename="fontSize">13px</xsl:variable
        ><xsl:variablename="buttonFontSize">15px</xsl:variable>
        <!-- colors -->
        <xsl:variablename="fontColor">#334444</xsl:variable>
        <xsl:variablename="backgroundColor">#efefef</xsl:variable>
        <xsl:variablename="cardBackgroundColor">#ffffff</xsl:variable>
        <xsl:variablename="headerBackgroundColor">">#babe13</xsl:variable>
        <xsl:variablename="headerFontColor">#ffffff</xsl:variable>
        <xsl:variablename="linkFontColor">#4cae4c</xsl:variable>
        <xsl:variablename="sectionFontColor">#5f7e7e</xsl:variable>
        <!-- Primary Button -->
        <xsl:variablename="btnPrimaryBackgroundColor">#5cb85c</xsl:variable>
        <xsl:variablename="btnPrimaryBorderColor">#4cae4c</xsl:variable>
        <xsl:variablename="btnPrimaryFontColor">#ffffff</xsl:variable>
        <!-- Secondary Button -->
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        <xsl:variablename="btnSecondaryBackgroundColor">#ffffff</xsl:variable>
        <xsl:variablename="btnSecondaryBorderColor">#cccccc</xsl:variable>
        <xsl:variablename="btnSecondaryFontColor">#668888</xsl:variable>

Content
The second part, content, allows you to control the presence of certain sections in the notifications.
You can display or hide the document, task and project sections. The section will be displayed when
you set it to true and hidden if you set it to false.

Example:
If you want to show the document and task sections, but hide the project section, your variables will
look like this:

 <xsl:variable name="document"
     select="true()"></xsl:variable> <xsl:variable name="project"
     select="false()"></xsl:variable> <xsl:variable name="task"
     select="true()"></xsl:variable> 

Note:  Pay attention to the brackets used behind the true and false values, these are neccessary.

Styles
The styles section contains all the elements that make up the layout of the e-mail notifications. You
can modify the CSS of a specific part in order to change the look and feel of the notifications.

Layout
Every e-mail notification follows the same layout pattern. The body of the e-mail notification contains
the main table that consists of three parts: header, information table and footer.

1. main
2. header
3. information card
4. message
5. section header
6. label
7. value
8. section header
9. footer

Header and footer
The header and footer information is imported from the Header.xsl and Footer.xsl files. The
styling of these sections can be modified in Customize.xsl.

Information card
The information card consists of multiple parts. First of all, there is a message that describes
the action. Next you find multiple sections describing the project, document and task changed
information. Every section has a sectionHeader.

A section typically contains two columns: label and value.
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Note:  Not all sections are relevant for, and therefore present in, every notification, it depends on the
action what is displayed. The same goes for label-value pairs, they are displayed depending on the
action and information in WebCenter.

Example:
If you want to change the background color of the sectionHeader in all e-mail notifications to green,
you only need to change the following value in the specific template:

'background-color: #EEEEEE;'

The sectionHeader template in the Style.xsl file will now look something like this:

 <!-- Section Header Style -->
          <xsl:variable name="sectionHeaderStyle"> font: 24px <xsl:value-of
          select="$fontFamily"/>; font-weight: bold; color: <xsl:value-of
          select="$sectionFontColor"/>; padding: 30px 0 5px 12px; </xsl:variable>
        

URL.xsl
The URL.xsl file contains a template that is called for every URL in the e-mail notifications. This
way, you can map the internal WebCenter URL to an URL that is accessible from the outside. This is
sometimes needed because you want to access the links to tasks, documents and projects in the
notification e-mails from the outside. The internal URL is specified in the internalURL variable and the
corrected accessible URL is specified in the correctURL variable. Change both variables to your URLs
to activate this feature for your WebCenter e-mail notifications

Example:
Replace the existing variables:

 <xsl:variable name="internalURL"
     select="'http://intranet.esko.com'"/> <xsl:variable name="correctURL"
     select="'http://accessible.esko.com'"/> 

By:

 <xsl:variable name="internalURL" select="'http://my.intranet.esko.com'"/>
     <xsl:variable name="correctURL" select="'https://correct.esko.com'"/> 

Note:  Pay attention to the usage of both double and single quotes.

Customize Time Zone details in notifications

You can insert customized timezone information in the notifications emails in by modifying the
Shared.xsl file. You can use Shared.xsl file's templates as they are quite generic and can be used in
context of any type of any event-type notification customization. For example., Comments for specific
logic: dateTimeWithTimeZone and timeZone templates allow for inserting the time zone as of the
Application server. This ensures that Date and Time values indicate what Time zone they are related to.

Note:  Time zone information is inserted by default in Overdue reminder notification emails and
Approval Started emails. For other notifications, Time Stamp can be added via customization only.
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Advanced customization
For a basic customization, you can change the layout of the e-mail notifications by modifying the
header, footer and/or style files. For a more advanced customization, you could alter every XSL of an e-
mail individually.

For example, you could:

• Include or exclude certain label-value pairs in sections.
• Change or override the layout of an e-mail individually from the style file.
• Change the links attached to certain fields (for instance, the document name).

In order to execute such a more advanced customization, you should have knowledge of both XSL and
HTML.

5.10.3.  Technology Used: XSLT

Staying true to the technology already used and the web anchored environment of WebCenter the
framework of e-mail notification templates is based on a XML/XSLT solution.

XSLT is an industry standard for transforming an XML source to any preferred output. It uses an XML-
based structure to process a passed source XML document in order to transform it into a desired
output (plain text format for e-mail notification messages' purposes). Although working with XSLT
requires some technical skills, it is a powerful and reliable tool.

In order to work with the XSLT template framework a user has to know:

• Structure of the XML document that is being processed by the XSLT template.

• Basic syntax and terminology of the XSLT technology.

Using XSLT also means that the templates are actually present in the form of physical files on the
Application Server. They are modified on the file system directly using any text editor. There is
currently no support for modifying the templates by using any part of the WebCenter user interface.

Note:  You can find various freeware XSLT editors on the internet.

5.10.4.  The E-Mail Template File Structure

All the e-mail notifications' related files are stored on the Application Server in the following path: C:/
Esko/Artios/WebCenter/ApplicationServer/EmailNotifications.

This is a root directory of the repository. All the subdirectories contain the required templates and
language files. The structure of the repository is following:

Inside the root directory you can find three subdirectories - Default, Custom and Example. In the
Example folder, you can find a customization example. Copy the contents of the Example folder into
the Custom folder to it try out.

Default directory is a container for all the default files related to e-mail notifications. Contents of
this directory come with the WebCenter installation and are overwritten whenever any of these files/
directories are updated (or new files/directories are added).
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Note:  It is forbidden to modify the contents of Default directory, since doing so may lead to incorrect
behavior in the process of creating the e-mail notification messages!

Custom directory is intended as a repository of the customized elements of the e-mail notification
framework. In a clean WebCenter installation it comes empty and is populated only when a
user decides to customize any part of the framework. In order to have the e-mail notifications
customization framework to acknowledge and use the customized XSLT templates and/or language
files it is necessary to mimic the file system structure of the default directory.

For example: a default XSLT template located on the following path:

C:/Esko/Artios/WebCenter/ApplicationServer/EmailNotifications/Default/
Approval/cycle_finished_body.xsl

This default template will only be overridden by a customized template on a following path: C:/Esko/
Artios/WebCenter/ApplicationServer/EmailNotifications/Custom/Approval/
cycle_finished_body.xsl

It is not necessary to mimic the entire directory/file structure of the Default directory inside the
Custom directory for the customized elements to be used by the system, but the user rather needs to
supply the file system structure ONLY for the individual customized elements (this means, that if the
user wants to customize just Approval Started notification message, he has to create an appropriate
file system structure for this notification type only).

5.10.5.  Customizing E-Mail Language Files

WebCenter in general uses XML based file as a source for all labels in the system with each of the labels
set stored in a single file for each of the supported languages.

The same applies to the e-mail notifications framework. This allows for supporting localized labels
inside the e-mail notification messages, based on the user profile preference of the notification
message's recipient.

In order to be independent on the rest of the application, the e-mail service utilizes its own E-Mail
Language Manager and a separate set of XML language files.

These language files are stored on the following path: C:/Esko/Artios/WebCenter/
ApplicationServer/EmailNotifications/Default/Languages.

If you wish to customize the labels, you need to copy an appropriate XML language file (based on
the language for which you want to customize the label for) to a corresponding path in the Custom
directory. After doing so, you need to restart the JBoss service.

5.10.6.  Customizing the Notification Templates Step by Step

The most important aspect of smooth and successful e-mail notification customization process lies in
basic knowledge of XSLT technology. The templates are rather simple and the XSLT constructs utilized
are few. This makes any modification of the templates confusing at first sight, but is understood soon
enough.
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What You Need to Know Before You Begin

Structure of the Source XML

Even more important than knowledge of XSLT is knowledge of the source XML, since that is the
cornerstone of X-Path usage.

To be able to work with the XSLT templates, the user has to know the structure of the XML document
that is consumed by the appropriate XSLT file. Since the XML source that is used in e-mail notification
message creation process is never stored anywhere on the disk and is held only in the server's memory
at runtime, there is no easy way to investigate its contents and their XML structure. Since each
of the individual notification templates share their “parent notification type” XML structure, it is
required to learn only one XML document structure to be able to work with a whole set of the parent's
"subtype" (by parent notification type one should think about Approval Notification Type, while its
subtypes are Approval Cycle Started Notification, Approval Cycle Finished Notification and Approval
Status Submitted Notification).

This is why each of the "parent notification type" directories contains an example XML file that
represents a model XML source document that is expected by each of the "subtype" XSLT templates.
The actual values of the elements in such an example XML document are of no importance. It's their
XML structure that matters for anyone who wishes to customize the templates.

XPath

XPath is something like XSLT's own proxy SQL query framework. While SQL queries are used to stalk
through a database, XPath is used to navigate through a XML document. The XML structure of XML
source used by notification templates is really simple so the XPath queries are also simple. To tell the
truth all the user doing the template modifications needs to know about XPath is parent-child relation
between XML elements.

XPath basic syntax is actually done through namespace navigation. This means that it is the same as
navigating through a Windows file system or internet URLs.

Here are some examples:

Windows file system - C:/Artios/WebCenter/.

Internet URL - http://myserver/WebCenter_Inst/login.jsp

In the first example:

• C: part stands for volume name (you can consider this to be the root definition of the namespace
through which it will navigate).

• Artios part is an element under this root.

• WebCenter is a subdirectory of Artios (thus it is a child element of Artios which in turn is its parent
element).

A similar logic applies for the second example:

• http:// part is a definition of a protocol that will be used for processing any element selected by this
"path".

• myserver part is a root namespace; in this case it is a server by the name myserver, that should
contain the selected element at the end of this "path".
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• WebCenter_Inst part is context name of the web application that contains the selected element;
myserver part of the path is its parent element.

• Login.jsp is the selected element of this path; it is a child element of WebCenter_Inst and myserver
elements.

Now if you take a trivial XML structure like:

  <car> 
    <engine HP="500"> 
       <parts>     Some parts¶    </parts> 
    <engine/> 
    <wheels> 
       <tires>     Bridgestone    </tires> 
    <wheels/> 
  </car>

You can use a similar path (this time it's XPath) structure to select (for example) the contents of tires
element this way:

select = "/car/wheels/tires"

This (hypothetical) XPath expression selects the tires element, which returns its contents giving the
result value Bridgestone.

If we analyze the path itself, it is very simple > car is the root element, wheels is its child element and
tires is in turn child element of the wheels element.
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6.  Maintenance Guide

6.1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
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without prior written permission from Esko Software BV.
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 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015
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copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

6.2.  Maintenance

6.2.1.  Installation Tips

Create a Detailed Installation Log
For Installation debugging and troubleshooting purposes, you can create a detailed installation log file
for any Esko Installer programs. To do this:

Run setup using the following syntax: Path+program space /v”/l*v space path+logfilename

• For example: For ArtiosCAD Enterprise installation from CD-ROM in my D:\ drive,

• Open a command prompt and Change to the D:\ drive
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• Type: setup /v”/l*v c:\temp\ACsetup.log”

6.2.2.  WebCenter Schema

Every time a new installation or upgrade is performed, the Database Schema scripts should always be
run. Schema changes are guaranteed for each version and build.

Since WebCenter 12.1, the database schema scripts can be run automatically from the installer, which
is recommended. In case a problem occurs, or additional parameters are needed, the scripts can still
be run manually.

Note:  Since WebCenter 12.1, no files need to be copied to the database server in case the database is
not installed on the Application Server. The scripts can simply be run from the Application Server itself.

To run the database scripts manually from the Application Server, execute the following steps:

1. Open a command prompt and go to \Esko\Artios\WebCenter\ServerTools.
2. Type update_db.bat to check your current configuration.
3. To run the database script, type update_db.bat and at least the "sa" password for MSSQL or "sys

as dba" for Oracle. This operation can take a considerable amount of time in case there are a lot of
projects and documents with attributes.

4. In case of errors check the servertools.log in \Esko\Artios\WebCenter\ServerTools.

6.2.3.  Cleaning Up the Database and FileStore

Items deleted through WebCenter's web interface are not permanently deleted from the Database
or the FileStore, only removed from the user interface. An Admin may be able to restore them if
necessary.

To delete them permanently (to keep the Database and FileStore sizes manageable), you should run the
Cleanup Utility.

Note:  We recommend you run this regularly (every week for example).

Important:  Do not run this utility during busy hours. The users might experience database deadlocks.

Read also https://wiki.esko.com/display/KBAS/KB74647891:+WebCenter+-+Use+of+Cleanup+Utility+in
+WebCenter

• To run the utility:

On the Application Server, go to C:\Esko\Artios\WebCenter\ApplicationServer
\Cleanup and double-click cleanup.bat.

You don't need to enter any parameter in the script. It will run and close itself automatically when
done.

This cleans up all FileStore files and Database records deleted through the WebCenter interface.
• To configure the utility to only clean up files and records deleted a certain time ago in the interface:

a) On the Application Server, go to Artios\WebCenter\ApplicationServer\Cleanup
\config and open access.properties in a text editor.
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b) For each table, change age=0 to the number of hours ago files and records must have been
deleted for them to be cleaned up.

For example, enter 168 hours if you want to only clean up files and records that were deleted at
least 1 week ago in the interface.

c) Save and close access.properties.
d) Restart the WebCenter services on the Application Server.

• To schedule the Cleanup Utility to run automatically, use the Windows Scheduler.

6.2.4.  Temporarily Block Access to a WebCenter Site

You may sometimes be required to bring down a WebCenter server for maintenance or upgrade. To
prevent users from accessing yourWebCenter sites at that point, you can stop all IIS services on the
Web Server. However, this will give anyone who types in your URL an error message, “Page Cannot Be
Found”. Alternatively you can convey the message in a user-friendlier page.

To redirect a virtual site to a specific page:

1. On the Web Server, open IIS Manager and expand Web Site node.
2. Right click on an WebCenter instance that should show the maintenance page and choose

Properties.
3. Select option Manage Virtual Directory > Advanced Settings.
4. In the popup window there should be a "Physical Path" option set to the tomcat directory of

WebCenter_Inst

Note:  This path typically is like <drive>:\Esko\Artios\WebCenter\WebServer\tomcat\webapps
\WebCenter_Inst

5. Set this Physical path to some other folder on the system containing the maintenance page (e.g.
c:\maintenance). Create your nice maintenance page and put it in the maintenance folder as the
"index.html" (e.g. c:\maintenace\index.html)

6. Test changes in IIS Manager.
7. Right click on the Virtual Site name and choose <Browse>.
8. You should see your custom page display correctly in right half of console.
9. You can test changes using Internet URL.Open a web browser and type in the site’s URL. You be

brought to your custom page as well.
10. Repeat these steps for each WebCenter virtual site you wish to block access.

To stop redirecting sites to a custom page:

• Change each WebCenter Virtual Site to use its own Tomcat directory.

• On the Web Server, open IIS Manager.
• Expand your Web Site node until you see your WebCenter virtual sites listed. Right click on an

WebCenter Virtual Site that is redirecting (i.e. WebCenter_Dev).

• Choose Properties.
• On the Virtual Directory tab, locate the Local Path field.
• Click <Browse> button. Change to \Artios\WebCenter\WebServer\Tomcat\webapps directory.
• Select the folder name that matches the virtual site name (i.e. WebCenter_Dev). Click <Apply>.
• On Documents tab, highlight your custom page name at top of the list. Select <Remove> button.

Click <Apply>, then <OK>.
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• Ensure WebCenter services are all started on the Web Server and the Application Server.

• Test this site in IIS Manager. Right click on the Virtual Site name and choose <Browse>.
• You should reach the WebCenter login page. Test this site using Internet URL.

• Open a web browser and type in the site’s URL. You be brought to same WebCenter login page.

• Repeat these steps for each WebCenter virtual site you desire to allow access.

6.2.5.  Moving the FileStore

WebCenter’s FileStore is installed by default on the Application Server within the \Artios
\WebCenter\ directory. The name and location can be changed as long as it meets the below
requirements (even if it is a non-Windows system):

• Default share is named FileStore and can be renamed using alphanumeric characters only. For
example: instead of using default location C:\Artios\WebCenter\FileStore, you may create
a new share on D: partition called ESKOFS instead, D:\ESKOFS.

• New destination share must have local user called BGSYSTEM. There is a default password which
can be changed as per your requirement. Ensure that the Password never expires.

• It is NOT recommended that the group EVERYONE is given access to the new destination share. If
so, please remove this share and security permission.

• New local user BGSYSTEM must have full share and security permissions to the new destination
share.

• The new destination share must be reachable from the WebCenter’s Application Server.

• If you are configuring a production Automation Engine server instead of the OBGE (not
recommended), the Automation Engine production server's local user BGSYSTEM also requires full
permissions to the new destination share via Windows networking.

• WebCenter’s Application Server should maintain constant connection to the new destination share
and at no point shall lose the connection and if so then all WebCenter services must be restarted.

To move the FileStore from its default location:

1. Create the new share and ensure it meets the above requirements.
2. Test communication to new share from the Application Server.

• From Application Server, log in as local user BGSYSTEM.
• Browse to the new share.
• Create a new text file within new share. Delete test file after successful writing.

3. Stop IIS and WebCenter Services on both the Web and the Application Server. This ensures that no
files are in use and locked for backup.

• On Web Server: IIS Admin, Word Wide Web Publishing, HTTP SSL, and WebCenter Tomcat.
• On the Application Server: WebCenter JBOSS, and WebCenter CAD-X.

4. Backup the Web Server, Application Server, Database, and current FileStore share. You may want to
have a full normal backup of any \Artios directory on both servers, as well as a full backup of current
FileStore share.

5. Move entire contents of current FileStore share to its new destination share.

After the move, follow these steps to ensure it works correctly:

1. After move is completed, ensure new share is not marked as 'Read Only'. If so, remove the attribute
on share and all subfolders and files.
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2. Uninstall WebCenter completely. Please note that changing configuration files is not supported. A
reinstall is always required.

3. Inspect the old FileStore share's Properties. Record the total size, number of files and folders. Use
this information after the reinstall is finished for comparison.

4. Rename old share (i.e. \Artios\WebCenter\FileStoreOLD).
5. Reinstalling WebCenter using the new FileStore share. You must use a UNC path to the new

FileStore share in these files. You CANNOT use a mapped network drive.
6. On WebCenter's Application Server, configure the OBGE to use the new FileStore location.

• Using the Pilot, login as an admin user.
• Delete the old container and add a new container.
• Using the Configure tool (Tools - Configure) delete the container pointing to the old FileStore

share (FileStore@<application_server_name>).
• Using the Configure tool, create a new container pointing to the new FileStore share

(<new_share_name>@<new_server_name>).
• Delete the old hotfolder or Access Point and add a new hotfolder/Access Point.
• Convert the old JDF Folder to a normal folder.
• Convert the new hotin folder to a JDF hotfolder or Access Point Folder.
• Expand the new container pointing to the new FileStore share.
• Configure the hotin and hotout folders of your new JDF hotfolder or Access Point.
• Make sure your Folder is Active.

7. Restart IIS and WebCenter services on both Web Server and Application Server.
8. Test WebCenter with the new FileStore location.
9. Login to WebCenter as an admin or a project manager.
10. Create a new project.
11. Upload a new "Graphics File" document. Follow the successful upload link to the document details.

Ensure you see a "Checking and Registering" message in the document header.
12. Wait about a minute and refresh the WebCenter page. You are waiting for Checking and Registering

to finish. You will see a 3D thumbnail and 'View and Annotate' will appear in the Document Actions
menu.

13. Launch the View and Annotate applet on the new Graphic file.
14. Search and open an existing Graphic file. Ensure you can launch the View and Annotate tool as well.
15. Upload an ArtiosCAD ARD file and ensure can view 3D Model successfully.
16. Download any document.

6.3.  Configuration

6.3.1.  Configuring ArtiosCAD Defaults

To properly configure CAD-X for best WebCenter performance and display, make the necessary
changes to the ArtiosCAD settings that WebCenter uses.

The following settings should already be applied after installing ArtiosCAD 12.1 or higher, but you can
verify or change them:
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1. On the Application Server, open ArtiosCAD.
2. From menu bar, choose Options > Defaults.
3. Expand Database Defaults and open the General Options.
4. Make sure the Design Thumbnail format is ArtiosCAD 3D, click Apply then OK.
5. Expand Design Defaults – VRML Export Options for CAD-X.
6. Make sure Use compression is selected, deselect Automatically Open, and click OK.
7. Set the View Zoom Factor to 90%.

To enable different download formats for CAD files, execute the following steps:

1. Expand Outputs - Artios – Export to Common File Formats.
2. Repeat the steps below for each export conversion desired for WebCenter downloads:

a. Open the data item (DXF Inch, etc.) by double clicking it.
b. Within the Shown In section, select WebCenter.
c. Click OK.

After changing the Defaults, make sure to save them by choosing File > Save.

6.3.2.  Configuring to use NAT translation

It is essential for the correct working of WebCenter that the Web Server can find the Application Server
via host name resolution and that the host name used for directing the Web Server to the Application
Server matches the host name set for the Application Server.

JBoss on the Application Server resolves its own host name dynamically and communicates this to
the Web Server. The host name must match the one provided on the Web Server or WebCenter will not
work.

The best way to make this work, is if the Web Server can find the Application Server via DNS records or
via active directory look-up.

If however this is impossible (for example for security or other reasons), a possible workaround is to
manually configure the host mapping on the Web Server. If this workaround is used it is ESSENTIAL
that it is properly documented. It will make the system work, but without proper insight into the
configuration, troubleshooting can become problematic (for example when the IP address of the
Application Server is changed).

To preform this workaround, open C:\Windows\System32\drivers\etc\hosts in a text
editor and add the line: <ip_address> <app_server_host> (for example: 10.20.30.40
mywcrappserver), then save the file.

From then on any resolving of the Application Server host name from the Web Server side will result in
the provided IP address.

In case of NAT translation it is of course the IP address visible to the Web Server that needs to be used.

6.3.3.  Create Usage Log Files for Each Virtual Site

WebCenter creates Usage Log files for each WebCenter site. Refer to LOG FILES section for details.
The location and names of these log files can be changed so that each virtual site has its own set of log
files.
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For example: I have 3 virtual sites (WebCenter, SamAdams, and BlueMoon). I configure WebCenter site
to have different log files than SamAdams and the BlueMoon sites. This way I know who is doing what
and from which UI - even though they are all using the same database!

On the Web Server, using Notepad, Edit each site’s config.xml appropriately.

• Located in \Artios\WebCenter\Tomcat\webapps\<sitename>\config folder.
• Locate the <MetricsFiles> tag, as seen below:

<MetricFiles>

<MetricsFile id="CheckOut" path="C:\Artios\WebCenter\logs\WebCenterCheckoutLog.txt"/>

<MetricsFile id="Download" path="C:\Artios\WebCenter\logs\WebCenterDownloadLog.txt"/>

<MetricsFile id="Upload" path="C:\Artios\WebCenter\logs\WebCenterUploadLog.txt"/>

<MetricsFile id="Login" path="C:\Artios\WebCenter\logs\WebCenterLoginLog.txt"/>

</MetricsFiles>

• Modify the path and file name of each the 4 log files as desired.

Attention:  If you change the path of the log files, be sure that the local Administrators Group
and the local IIS users (IUSR_<localcomputername> and IWAM_<localcomputername>) of the
Web Server have full permissions to the destination location, and that the new location’s local
Administrators Group has full permissions to the virtual sites tempfiles folder on the Web
Server. Without proper permissions, log files cannot be written there.

• Save Changes and Exit.
• Repeat for each Virtual Site.
• On the Web Server and the Application Server, restart WebCenter services for changes to take

affect.

6.3.4.  Modify main configuration files

appconfig.xml
This file contains configurable application data (described below):

• FileStore location (changing not recommended, reinstalling WebCenter is always preferred)
• Log File names and locations
• Search Crawler settings
• ArtiosCAD 2D View layers used in WebCenter (overlays)

• ArtiosCAD Design files print side used

On the Application Server edit C:\Artios\WebCenter\Config\appconfig.xml (this is always
on the C:\ drive).

• Make modifications, Save changes, and Exit.
• Restart all IIS and WebCenter services on both the Web Server and the Application Server for

changes to take effect.
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ImageList.ini
The Viewer’s configuration file contains the path and location of the FileStore, which holds the pyramid
files to be retrieved by viewer.

Attention:  If you have moved your FileStore after initial application installation, it is always
recommended to reinstall WebCenter.

• on the Application Server, open \Artios\WebCenter\ApplicationServer\program\ImageList.ini and
verify that the paths are correct.

6.3.5.  Change file name used at the time of download

A configuration has been added for allowing you to decide how a specific site handles file downloads.
Each virtual site has its own configuration, so they can all be different. The purpose is to control the file
name assigned to the file being downloaded—whether it keeps the name displayed in WebCenter or the
original disk file name it was at the time of upload.

In WebCenter, on the General Information page of any Document, there is new data displayed called
"Original Disk Filename". Nothis "Original Disk Filename" value is NOT searchable.

Here is an example of how these download settings work:

• Config file set to False.
• Uploaded Peter.txt file as version 1 to WebCenter.

• On Gen Info page, Orig. disk Filename = Peter.txt.
• Locked Peter.txt.
• Uploaded New version but browsed to Melissa.txt.
• Result was:
• Document remains named Peter.txt as version 2.
• BUT on Gen Info page, Orig. disk Filename = Melissa.txt.
• When choose to download version 2, name of file to be saved is Peter.txt
• Config file set to True.
• Uploaded Craig.txt file as version 1 to WebCenter.

• On Gen Info page, Orig. disk Filename = Craig.txt.
• Locked Craig.txt.
• Uploaded New version but browsed to Chris.txt.
• Result was:
• Document remains named Craig.txt as version 2.
• BUT on Gen Info page, Orig. disk Filename = Chris.txt.
• When choose to download version 2, name of file to be saved is Chris.txt.

To change the way a specific site downloads files:

• On the Web Server, edit \Artios\WebCenter\WebServer\tomcat\webapps\<sitename>\config
\config.xml.

• Locate section below:

<! Download name option >
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<! true - to use the uploaded document version file name when downloading >

<! false - to use the original document name when downloading à

DocVersionDownloadName value="false"/>

• Change value of DocVersionDownloadName from true to false as desired.
• On the Web Server, Restart WebCenter Tomcat service for changes to take affect.

6.3.6.  Change CAD plotting style in WebCenter and Viewer

• Backup your style.xml file within your FileStore share.
• Within your FileStore share, Browse to \FileStore\views\Style directory.
• Make a copy of style.xml for backup purposes.
• on the Application Server, open ArtiosCAD and modify Defaults.
• From the menu bar, choose Options – Defaults, then expand Plotting Style Catalog.
• Select desired plotting style(s) and make necessary modifications.
• Click <Save as XML> button, and save the file to desktop with exact name of style.xml.
• <OK> to exit, Close Defaults, Save Changes, and Exit ArtiosCAD.
• Copy new style.xml file from desktop into existing FileStore location.
• Copy the new file and replace one in your FileStore in the \FileStore\views\Style directory.
• Changes will take effect immediately, no need to restart any WebCenter services.

6.4.  Backup and Restore Strategy

To properly back up WebCenter and ensure you can recover from a disaster, such as disk failure, there
are 3 major components to be able to restore successfully and minimize your downtime:

• WebCenter application, configurations, and Virtual Sites
• WebCenter’s FileStore and Database
• OBGE/Automation Engine application, configurations, and Database

In the event of a disaster (disk or system failure) or in case you want to setup a test system that mimics
your production environment from a specific point in time, then you will need to rely on whatever
Backup Plan you have in place to successfully Restore to a specific state in time.

Backups can be performed using 3 methods: Full, Incremental and Differential. We suggest you
choose one of the following Backup Modes:

• Always Full - you back up all files every time, whether some of them were changed or not.
• Full+Incremental - you create a Full backup relatively seldom: once a month, or once a week, or on

achieving some important point in your work. You create all other backups with the Incremental
mode, only backing up files changed since the last backup.

This approach is good when the project includes too many files to do a Full backup each time. It
is faster and takes less disk space than a Full backup. It also allows you to create backups more
frequently.

However, to restore all the files, you have to restore the last Full backup, then all the following
Incremental backups.
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• Full+Differential - is an intermediate mode. Each Differential backup includes all the project files
changed since the last Full backup. It takes less time and space than Always Full, but more than Full
+Incremental.

The good thing is that restoring is simpler than for Full+Incremental - you will only have to restore
the last Full backup and the last Differential backup.

6.4.1.  What to Back up for WebCenter

• The WebCenter application, configurations, and Virtual Sites.
• The Application Configuration only needs to be backed up after initial installation, upgrades, or

when changes are made to application configuration files.
• Virtual Sites need to be backed up when they are initially created and after each modification.
• WebCenter’s FileStore and Database.
• The Database and FileStore need to be backed up at least on a daily basis. Furthermore, they must

be backed up at the same time. One is useless without the other.
• The database cannot be locked in any way during backup procedures, otherwise WebCenter will

stop responding and all WebCenter services will need to be restarted.
• If the database is out-of-sync with the FileStore, or vice-versa, then your clients will receive errors

and your data will become corrupt.
• It is recommended that you create a backup plan that will copy the database and FileStore at the

same time several times per day, during your peak hours of activity.
• The OBGE/Automation Engine application, configurations, and database.
• If the OBGE was installed on the Application Server, then its application and configuration only

needs to be backed up after initial installation, upgrades, or when changes are made to the
configuration files.

• If using a Production Automation Engine server rather than the OBGE (which is NOT recommended
but is possible), its database should be backed up daily, if not several times per day.

• If backups of the database and FileStore cannot be synchronized fully, it is preferred to first back
up the database and immediately thereafter the FileStore. This will ensure all files referred in the
database are also present in the FileStore. Files added after the database backup will be orphaned
and are best removed after restore using the WebCenter clean up tool.

An Example Backup Plan
• WebCenter application, configurations, Database, and Virtual Sites
• After initial installation/upgrade, make full system backups of the Web, Database, and Application

Servers.
• Store these backups off-site on tape for safe keeping.
• When changes to Virtual Sites and/or application configurations are made, retrieve the tapes and

back up the Web and/or Application Server in full again. Return tapes to off-site storage when
finished.

• OBGE/Automation Engine application, configurations, and database.
• During initial installation, either the OBGE was installed on the Application Server, or a production

Automation Engine server was configured. Determine which server was used.
• Using the Server Admin tool, located at Start > Programs > Esko > Automation Engine, configure

and setup backups for the software application and database:
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• On the Automation Engine tab, configure a server software backup and Backup Server Software
configuration using the Wizards.

• On the Database tab, use the <Manage Databases> button to Database Properties and Backup
Database.

• WebCenter’s FileStore and Database
• Hardware Configuration: Configure a mirrored disk RAID subsystem on the Application Server. The

rest of the disks should be configured with a different RAID level, such as parity. On the mirrored
partition, only the system Operating System is installed and a directory for the purpose of storing
temporary backup files, such as “WC_BACKUP”. The parity RAID drives will be where WebCenter
applications and OBGE are installed.

• Schedule Full backups:
• On the Application Server, use backup software, such as Veritas, to schedule a Full backup of the

FileStore to Tape every Sunday at 2 am (a day and time where little or no system activity can be
guaranteed).

• On the Database Server, use database backup software, such as Veritas SQL Server Agent, to
schedule a Full WebCenter Database backup to Tape at exactly every Sunday at 2 am, the same time
as the FileStore backup.

• Store these weekly Full backup tape(s) off-site for safe keeping when not in use during the week.
• Schedule daily Incremental backups to local disk:
• We determined most active hours for WebCenter activity. We choose times of day that will satisfy

us in the event we have to recover (8am, 12pm, 4pm, 8pm).
• on the Application Server, schedule daily Incremental backups (8am, 12pm, 4pm, 8pm) to backup

FileStore to local disk on the Application Server in directory “WC_BACKUP” on the mirrored disk
raid.

• On the Database Server, schedule daily Incremental backup at exactly same time as the FileStore
backup (8am, 12pm, 4pm, 8pm), to backup the database to a local disk on the Application Server in
the “WC_BACKUP” directory .

• Schedule daily Differential backups to tape.
• We determined a time of day that has least WebCenter activity and ensures that the other daily

backups have completed writing to disk (11pm).
• on the Application Server, schedule a Differential backup of the FileStore to Tape every day (except

Sunday) at 11pm (a time after the last Incremental backup completes and when little or no system
activity can be guaranteed).

• On the Database Server, schedule a Differential backup of database to Tape every day (except
Sunday) at exact same time as FileStore backup at 11pm (a time after the last Incremental backup
completes and when little or no system activity can be guaranteed).

Example Backup Schedule

Frequency Day & Time What Where How To

Manually as
needed

At time of
installation and
when changes
are made

Entire system,
all partitions
(contains
WebCenter
application files,
configurations,
Database, and
Virtual web Sites)

Web Server,
Database
Server, and
Application
Server

FULL TAPE
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Frequency Day & Time What Where How To

Manually as
needed

At time of
installation and
when changes
are made

Entire system,
all partitions
(contains
OBGE/Automation
Engine app,
configurations, and
Database)

Application
Server or
Production
Automation
Engine server

FULL TAPE

Weekly Sundays at 2am WebCenter’s
FileStore

Application
Server

FULL TAPE

Weekly Sundays at 2am WebCenter’s
Database

Database
Server

FULL TAPE

Daily 8am, 12pm, 4pm,
8pm

WebCenter
FileStore and
Database

Application
Server

INCREMENTAL DISK

Daily 8am, 12pm, 4pm,
8pm

WebCenter’s
Database

Database
Server

INCREMENTAL DISK

Daily (except
Sundays)

11 pm WebCenter
FileStore and
Database

Application
Server

DIFFERENTIAL TAPE

Daily (except
Sundays)

11 pm WebCenter’s
Database

Database
Server

DIFFERENTIAL TAPE

An Example Restore Plan

Attention:  Anytime you restore a WebCenter SQL Server database, you must fix orphaned
logins before the database is usable. See Restoring the master database on page 1115 for more
information.

PROBLEM: Disk failure on the Application Server, Thursday 6/15/06 at 2:26 pm.

SOLUTION: Assuming the backup schedule is the same as the chart above, this is a 5 part restore plan:

• Determine exact period of data loss and inform specific users of activity that will need to be redone.
• Repair systems
• Restore WebCenter application to a working state.

• Restore WebCenter application configurations.

• Restore data using most recent point of backup for the WebCenter FileStore, Database, and Virtual
Sites.

This is a possible course of action:
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• Determine data loss risk and begin communicating this to end users.
• Calculate the difference between the time of failure and the time of the last incremental backup to

disk.
• In this example, the data loss risk would be 12pm – 2:26pm, approximately 2.5 hours.
• This means that any changes made to WebCenter during these 2.5 hours will be lost.
• Determine which users were logged into WebCenter during the 2.5 hours and inform them they will

need to redo this work after system has been restored.
• Using WebCenter usage log files, you can determine what users were logged in at the time of

failure.
• Using WebCenter usage log files, you can determine what activities users performed in WebCenter

as it relates to Uploads, Downloads, and versioning of files during the 2.5 hours where you will lose
data.

• Resolve point of failure in hardware or software.
• Reinstall from original Media or Restore WebCenter application from Tape (no data at this point).
• Ensure that you use the exact same version and build used before point of failure.
• Test blank application.
• Ensure WebCenter application is working in the correct network configuration (such as in a DMZ

with SSL security) using a blank database, blank FileStore, and the Installation site is accessible
(WebCenter_Inst).

• Ensure that you can create a new project, upload a document, use View and Annotate tool,
download a document, etc.

• Restore Database, FileStore, and Virtual Sites
• Using backup Tapes, restore files from the Last FULL Tape Backup (Sunday 6/11/06).
• Then restore files using the previous nights DIFFERENTIAL backup Tapes (Wed 6/14/06).
• Then restore files using ALL the current days incremental backups to Local Disk up until point of

failure, ensuring to apply them in proper order (Thurs 8am first then Thurs 12pm).
• Run the database restore script to reset ‘WebCenter’ user login.
• For the SQL Server, you must run the stored procedure against WebCenter4_0 database.
• Using Query Analyzer, type in these 2 command lines below:

Use WebCenter4_0

Sp_change_users_login auto_fix, WebCenter, null, Database Password

• Run the query.
• You should see a message that orphaned records have recovered.
• Restart all IIS, WebCenter, and Database services on the Web Server, Application Server, and

Database Server.
• Test the application with the restored data.
• Verify can view existing projects, download docs, and use View and Annotate tool on existing

documents.
• Verify can create new projects, upload documents, use View and Annotate tool on new docs,

download new docs in existing database, etc.
• Do a FULL backup on all systems.

6.4.2.  Microsoft SQL Server (2008 R2 or later) Backup and Restore

Backing up the WebCenter database is a critical part of its maintenance. If the database is lost, there is
no way to rebuild it without a valid backup.
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Microsoft SQL Server 2008 R2 or later version uses a master database in conjunction with the
WebCenter4_0 database. Both must be backed up regularly in order to be able to recover from a
database failure.

Backing up the WebCenter database
To back up the Microsoft SQL Server 2008 R2 or later database used by WebCenter, do the following:

1. Log on to the database server as a member of the local Administrators group.
2. Start SQL Server Management Studio Express in the Microsoft SQL Server 2008 folder on the Start

menu.
3. In the Connect to Server dialog, enter the server name in the Server name: field if it is not there

already, followed by \<instance name>, such as MBCAPPSERV\WEBCENTER.

If you used the default instance and not a named instance, just enter the server name.
4. Click Connect.
5. Click the plus sign (+) next to the Databases folder icon to expand it.
6. Right click WebCenter4_0, click Tasks, and then click Back Up.
7. In the Back Up Database - WebCenter4_0 dialog, set the Backup type: to either Full or Differential.

Full is a complete backup, while Differential is everything that has changed since the last full
backup. The first backup must be a full backup.

A recommended strategy is to make a Full backup once a week and a Differential backup on the
other days.

8. In the Backup set group, enter the current date in the Description: field.
9. In the Destination group, select either Disk or Tape.

Tape is unavailable if there is no tape drive attached to the system. Most installations will use Disk.

A default backup location and file name is shown. To change the location and file name, first select
the default location and click Remove, and then click Add and enter a new location and file name.

A disk backup may only be made to an internal physical disk on the system; you may not specify an
external drive or a network drive.

10. Click Options in the Select a page pane.
11. In the Overwrite media group, select Overwrite all existing backup sets for a full backup. For a

differential backup, leave Append to the existing backup set selected.
12. Click OK to start the back up.
13. Click OK when informed that the back up of database ‘WebCenter4_0’ completed successfully.

Copy the backup file whose location was set in step 9 to a different hard drive or networked drive. It is
also recommended that the location is part of your general backup strategy.

The WebCenter database is now backed up.

Backing up the master database
The master database does not need to be backed up as frequently as the WebCenter database, but it
still should be backed up regularly.

To back up the master Microsoft SQL Server 2008 R2 database, do the following:

1. Log on to the database server as a member of the local Administrators group.
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2. Start SQL Server Management Studio Express in the Microsoft SQL Server 2008 folder on the Start
menu.

3. In the Connect to Server dialog, enter the server name in the Server name: field if it is not there
already, followed by \<instance name>, such as MBCAPPSERV\WEBCENTER.

If you used the default instance and not a named instance, just enter the server name.
4. Click Connect.
5. Click the plus sign (+) next to the Databases folder icon to expand it.
6. Click the plus sign (+) next to the System Databases folder icon to expand it.
7. Right click master, click Tasks, and then click Back Up.
8. In the Backup set group, enter the current date in the Description: field.
9. In the Destination group, select either Disk or Tape.

Tape is unavailable if there is no tape drive attached to the system. Most installations will use Disk.

A default backup location and file name is shown. To change the location and file name, first select
the default location and click Remove, and then click Add and enter a new location and file name.

A disk backup may only be made to an internal physical disk on the system; you may not specify an
external drive or a network drive.

10. Click Options in the Select a page pane.
11. In the Overwrite media group, select Overwrite all existing backup sets.
12. Click OK to start the backup.
13. Click OK when informed that the backup of database ‘master’ completed successfully.

Copy the backup file whose location was set in step 9 to a different hard drive or networked drive. It is
also recommended that the original location is part of your general backup strategy.

The master database is now backed up.

Restoring the WebCenter database
There are three situations in which you would have to restore the WebCenter database: a hard drive
failure, a corrupt database file, or corrupt data within the database.

Recovering from a hard drive failure

When the hard drive holding the WebCenter database fails, after you have replaced it and reloaded
the Microsoft SQL Server 2008 R2 software (if necessary), do the following to restore the WebCenter
database:

1. Log on to the database server as a member of the local Administrators group.
2. Start SQL Server Management Studio Express in the Microsoft SQL Server 2008 folder on the Start

menu.
3. In the Connect to Server dialog, enter the server name in the Server name: field if it is not there

already, followed by \<instance name>, such as MBCAPPSERV\WEBCENTER.

If you used the default instance and not a named instance, just enter the server name.
4. Click Connect.
5. Once connected to the database, right-click the Databases folder and click Restore Database on

the context menu.
6. In the Restore Database dialog, in the Source for restore group, click From device.
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7. Click the ... (Browse) button at the end of the From device: field.
8. In the Specify Backup dialog, click Add and select the file to which you backed up the WebCenter

database, for example WebCenter4_0.bak.
9. Click OK. The selected file should be listed in the Backup location: field in the Specify Backup

dialog.
10. Click OK. A list of full and differential backup sets should appear.
11. Select all the backup sets in the Restore column. If you chose to not have full backups overwrite

each other, select the most recent Full backup and all the Incremental backups (or the last
Differential backup) taken after it.

12. In the Destination for restore group, in the To database: list, select WebCenter4_0.
13. Click OK to start restoring.

Click OK when informed that the restore completed successfully.

The database should now be restored and ready for use by WebCenter.

Recovering from a corrupt database file

If the database file becomes corrupted and unreadable, meaning WebCenter4_0.mdf still exists but
Microsoft SQL Server 2008 R2 cannot read it, do the following to restore the WebCenter database:

1. Log on to the database server as a member of the local Administrators group.
2. Start SQL Server Management Studio Express in the Microsoft SQL Server 2008 folder on the Start

menu.
3. In the Connect to Server dialog, enter the server name in the Server name: field if it is not there

already, followed by \<instance name>, such as MBCAPPSERV\WEBCENTER.

If you used the default instance and not a named instance, just enter the server name.
4. Click Connect.
5. Once connected to the database, right-click the Databases folder and click Restore Database on

the context menu.
6. In the Restore Database dialog, in the Source for restore group, click From device.
7. Click the ...  button (Browse) at the end of the From device: field.
8. In the Specify Backup dialog, click Add and select the file to which you backed up the WebCenter

database, for example WebCenter4_0.bak.
9. Click OK. The selected file should be listed in the Backup location: field in the Specify Backup

dialog.
10. Click OK. A list of full and differential backup sets should appear.
11. Select all the backup sets in the Restore column. If you chose to not have full backups overwrite

each other, select the most recent Full backup and all the Incremental backups (or the last
Differential backup) taken after it.

12. In the Destination for restore group, in the To database: list , select WebCenter4_0.
13. In the Select a page pane, click Options.
14. In the Restore options group, select Overwrite the existing database.
15. Click OK to start the restore.

Click OK when informed that the restore completed successfully.

The database should now be restored and ready for use by WebCenter.
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Recovering from corrupt data

If the database file contains corrupted data, meaning that Microsoft SQL Server 2008 R2 can read the
database but that there is missing or incorrect data, think carefully about the restoration, as whatever
data was added to the database since the last backup will be lost after the restoration with no way to
recover it. You should ensure as few users as possible are using WebCenter before performing this
procedure.

1. Log on to the database server as a member of the local Administrators group.
2. Start SQL Server Management Studio Express in the Microsoft SQL Server 2008 folder on the Start

menu.
3. In the Connect to Server dialog, enter the server name in the Server name: field if it is not there

already, followed by \<instance name>, such as MBCAPPSERV\WEBCENTER.

If you used the default instance and not a named instance, just enter the server name.
4. Click Connect.
5. Once connected to the database, expand the Databases folder, right-click WebCenter4_0, and then

click Properties on the context menu.
6. In the Select a page pane, click Options.
7. In the Other options: list, scroll to the bottom and double-click Database Read-Only to change its

value from False to True.
8. Click OK.
9. Click OK to confirm changing the properties of the database and to close all other connections.
10. Right-click the Databases folder and click Restore Database from the context menu.
11. In the Restore Database dialog, in the Source for restore group, click From device.
12. Click the ... button (Browse) at the end of the From device: field.
13. In the Specify Backup dialog, click Add and select the file to which you backed up the WebCenter

database, for example WebCenter4_0.bak.
14. Click OK. The selected file should be listed in the Backup location: field in the Specify Backup

dialog.
15. Click OK. A list of full and differential backup sets should appear.
16. Select all the backup sets in the Restore column. If you chose to not have full backups overwrite

each other, select the most recent Full backup and all the Incremental backups (or the last
Differential backup) taken after it.

17. In the Destination for restore group, in the To database: list , select WebCenter4_0.
18. Click OK to start restoring.

Click OK when informed that the restore completed successfully.

The database should now be restored, automatically set back to multi-user mode, and ready for use by
WebCenter.

Restoring the master database

If the master database is damaged or absent, as long as the sa user can connect to the database and
backups have been made, use the above procedures to restore the master database, substituting
master in the System Databases folder for WebCenter4_0 as necessary.
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If the master database is lost because of a disk crash and no connections are possible, uninstall
and reinstall Microsoft SQL Server 2008 R2 and then restore the WebCenter4_0 database using the
procedures described above.

After restoring the WebCenter 4_0 database subsequent to reinstalling Microsoft SQL Server 2008 R2,
recreate the WebCenter user login for the database by doing the following:

1. Log on to the database server as a member of the local Administrators group.
2. Start a command prompt.
3. Type osql -Usa -P”sa_user_password” -Sdatabase_server \instance_name and

press enter. If you are using the default instance, use -Sdatabase_server instead.
4. At the 1> prompt, type the following: sp_addlogin ‘webcenter’, ’Database

Password’,’WebCenter4_0’ and press enter.
5. At the 2> prompt, type go and press enter.
6. At the 1> prompt, type use WebCenter4_0 and press enter.
7. At the 2> prompt, type go and press enter.
8. At the 1> prompt, type sp_change_users_login update_one, webcenter, webcenter,

null and press enter.
9. At the 2> prompt, type go and press enter.
10. At the 1> prompt, type exit and press enter.
11. Close the command prompt window and log off the database server.

The database is now restored and ready for use by WebCenter.

6.5.  Troubleshooting

6.5.1.  Testing WebCenter

On the Application Server and the Web Server, ensure IIS and the WebCenter services are started and
configured to start automatically.

After starting/restarting the WebCenter services, always wait a few moments until the CPU processor
activity on both servers become idle (<5%) before attempting to access the login page.

Testing each facet of WebCenter in the exact order below helps to easily and quickly identify points of
failure, if any.

• IIS Connectivity – use IIS Manager to access the WebCenter_Inst site
• IIS Security settings – can access the home page after logging in
• Database connection and Schema – can add a new record to the database
• FileStore connectivity – can write a file to the FileStore and then retrieve it
• View Data generation – can upload a graphic file and the OBGE does its job
• View and Annotate applet – can launch the applet successfully on a Graphic file
• View the status in the Trouble shooting tool for View Server Deployment Status
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Verify IIS is working
• On the Web Server, from a web browser type: //<webservername> (such as //MBCWEBSERV).
• If you get an “Under Construction” page, IIS is working.
• If you get “The page cannot be displayed”, then most likely IIS services are not started or still

starting.

Verify Tomcat is working
• On the Web Server, from a web browser type: //<webservername>:8081 (such as //

MBCWEBSERV:8081).
• If you get Tomcat’s home page, Tomcat is working.

 

 

Test IIS connectivity
• On the Web Server, open IIS Manager and expand the website node.
• Right click on WebCenter_Inst virtual directory; choose Browse (only test with this directory for

now).
• Wait… watch progress in status bar. Will take longer very first time…
• You should be brought to login page (login.jsp). If you get to this page, then you know IIS is

responding.
• If not, verify IIS and WebCenter services are all Started. This is one of the most common errors.

• If services are all Started and still cannot access login page from IIS Manager, then see if you can
bypass IIS and talk to Tomcat directly.

• Close IIS Manager and Open a web browser.
• In address URL type: http://<name_web_server>:8081/WebCenter_Inst (case sensitive)
• You should be brought to login page (login.jsp).
• If you can access this way using port 8081, then you know IIS cannot talk to Tomcat.
• Check whether 32-bit applications is set to False in IIS.

• Check via netstat whether TomCat is listening on port 8009.
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Test IIS security settings
• Logon to WebCenter as username admin (if this is a new database, the password will be blank).

• Wait… watch progress in status bar. Will take longer very first time…You should be brought to the
home page (homepage.jsp).

• If you get to this page, then you know that your security settings within IIS Manager are correct.
• If you get an error page, then you must look at your IIS settings for this virtual directory. Most of the

time Execute Permissions and Application Protection settings need to be modified. This happens
when the IIS default settings for the entire Web Site have been customized. You will experience
this most often when a customer is installing WebCenter into an existing IIS web server. Also check
whether 32-bit applications are enabled in IIS.

Test Database connection and schema
• After logging in as user Admin successfully, create a new project. If you can add a new project

successfully then your Database schema has been created correctly.
• If you cannot add a new project or receive SQL errors, run the Database Schema batch file again and

ensure there are no error messages.

Test FileStore connectivity
• Still logged in as Admin, upload a PDF or Word Document as type “Other” to the project you just

created.
• When receive successful message, click on file name link to view document Online.
• Either a new web browser window will open or native application will launch automatically and

display contents of file. If you can view the contents of the file, then you know your FileStore is
configured and working properly.

• If you cannot open and view it, then you may have FileStore permission issues. Did you move your
FileStore off the Application Server? If so, go back and follow those directions again.

Test View Data Generation
• After correctly configuring WebCenter and OBGE on the Application Server, you should be able to

upload ArtiosCAD design files, PDF, and Esko Graphic files as document type “Graphics File” and
successfully use the View and Annotate tool on these types of documents. This means that the
Checking and Registering message disappears and “View and Annotate” action is added to the
document action list in top right corner.

• If the Checking and Registering message seems to take forever to disappear or never disappears,
you can watch the communication between the two to see what is happening. To do this, open the
OBGE and watch the jdf hotfolder activity.

• on the Application Server, login to Pilot as user admin.
• Expand the FileStore container.
• Expand JDFHotFolder - hotin subfolders. This is the folder in which WebCenter composes a JDF

ticket and drops it off in this location for Automation Engine (OBGE) to pick it up and take action.

• Minimize Pilot.

• Open a web browser and login to WebCenter as user ADMIN.
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• Upload a document of type “Graphics file” to a project.

Attention:  As soon as you click Upload button you must act quickly to do next few steps to be
able to watch real-time communication between WebCenter and the OBGE.

• After upload says successful, immediately click file name link to jump to Graphic Details page.
• In document header you should see message next to document name “Checking and Registering…”.
• Quickly minimize WebCenter, maximize Pilot.

• Watch creation of JDF ticket appear in the hotin folder.
• In the FileStore Container View within the monitor pane, you should see when Automation Engine

(OBGE) begins processing the JDF ticket.

• You should see a running task named “Prepare for Viewer”. Task should finish fast (definitely less
than 1 minute).

• Once task finishes (successful or failed), you can see the JDF ticket move to the hotout folder.
• Minimize Pilot, maximize WebCenter.

• You should still be on that document’s details page with “Checking and registering…” message still
displaying.

• Refresh your browser window (F5).
• The “Checking and registering…” message should disappear and View and Annotate action appears

in Document Action Menu.
• If task failed, a red ‘X’ and failure message will appear next to document name and no new action will

appear in menu. Review the task log file within Pilot to see why task failed.

Test View and Annotate Applet
• Logged into WebCenter, locate a Graphic document type that has successfully generated view data,

meaning that there is an action called “View and Annotate” on the document actions menu.

• Click the “View and Annotate” action to launch the Applet.
• The page will change and go blank for a moment, or turn light grey.
• You should see the Java Sun logo with a progress bar, then the tool will launch and display the

Graphic File.
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• If you get a Red ‘X’ in top left corner instead (as seen below), then Java is being blocked from
downloading or installing on your computer. This usually happens when either:

• a company’s firewall or Proxy Server prevents automatic downloads,
• browser settings need to be modified to allow applets.

 

 

• Try these steps to resolve it:
• Install Java manually
• Visit www.java.com, choose correct OS (Windows or Mac), download and install the free Java

Software.
• Close any open browser windows.
• Try to access the Viewer applet again.
• If Java is installed on the client, but you still get a Red ‘X’, then most likely your browser settings are

locked down tightly and blocking Applets.
• Ensure your browser options allow applets.
• Ensure that under Advanced settings within your Internet Options, you have a section for Java Sun

and that “Use JRE …. <for applet> (requires restart)” is there and checked. If not checked, check it
and reboot computer. Try again.

• In Internet Options where you can define custom settings for the Internet zone, customize your
current settings to ensure the below are set to Enabled or Prompt, but not Disabled:

• Run Active X controls and plug-ins.
• Java VM
• Scripting – Active Scripting
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• Scripting of Java Applets
• Close any open browsers and try again.
• Clean out Java cache

• From Control Panel – Java, delete Temporary Internet Files and check Applets, Applications, Other
Files. After deleting these can close Java console and try again.

• If you still cannot use the Applet then you need to contact your system administrator as some other
local setting is preventing the applet from running on this client.

Cannot access WebCenter login page anymore
• Restart WebCenter Services in the correct order. Either use the batch files on the desktop or do

them manually as below:

• Stop all IIS and WebCenter services on the Web Server and the Application Server.

• Start services on the Application Server first (JBoss, CAD-X, FlexLM, BGMD).

• Then start services on the Web Server (IIS and Tomcat).
• Wait until the CPU activity is idle on all servers (<5% activity).
• Try to access the installation site (WebCenter_Inst) again.
• Verify you are using the correct URL.
• Ensure you are using the correct case– the W, C, and I are uppercase in WebCenter_Inst.
• Test WebCenter's individual components.

• Do all of the previous steps under Testing WebCenter on page 43. This can rule out a port conflict or
installation problem.

• Determine if the Code and web pages are of the same version.

• If you can access the installation site (WebCenter_Inst) but not a custom deployed site, it is possible
that the installation site pages are a different version than your other virtual sites.

• For sites to be on different versions, WebCenter was upgraded but your custom sites were not. In
this case, your WebCenter application has new code and is expecting the web pages to be version B
and able to read new code, but the pages are still version A. This won’t work.

• After an upgrade the only site that gets upgraded automatically is “WebCenter_Inst”. Use the
deployment tool to redeploy new sites.

• Determine if your configuration files are corrupted.
• Certain non-XML standard editors, such as WordPad or FrontPage, corrupt XML files when used and

Java cannot compile them. The most common file that gets corrupted is APPCONFIG.XML.
• on the Application Server, browse to C:\Artios\WebCenter\Config (always on the C:\ drive).

• Open appconfig.XML file using a web browser.

• Right click on the file and choose Open With and chose any browser.

• You may sometimes receive the error page saying “The XML page cannot be displayed” as seen
below.

• If you receive this message, your APPCONFIG.XML is corrupt. This means that someone edited
this file with WordPad or an editor that changed the XML formatting.
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• To fix a corrupted page, you can restore this file from a known good backup, or reinstall WebCenter
on the Application Server only. The latter means you will have to reconfigure most of the settings
again.

• On restoration of the file, you must restart all IIS and WebCenter Services on the Web Server and
Application Server for the new file to take effect.

• Verify IIS ISAPI filters are correct
• On the Web Server, open IIS Manager.
• Right click on web server name node, and choose Properties.
• On the ISAPI Filters tab, WCTomcat should have a green arrow pointing up.
• Right click on WebCenter_Inst node, choose Properties.
• In the Application Settings section, ensure Application Name =“WebCenter_Inst” and is not

blank.
• If blank, choose Create button to create it.
• Right click on Jakarta node, choose Properties.
• On Virtual Directory Tab, local path should be

\Artios\WebCenter\WebServer\Tomcat\bin\win32\i386

If not, browse to it.

• Review IIS and WebCenter log files for obvious errors. Refer to the log files section for log file
locations and details.

6.5.2.  Easily Identify when WebCenter is Ready to Access

WebCenter services loads a lot of data into memory during startup of its services. It is important to
watch the CPU activity before accessing a WebCenter site.

You want both the Web Server and the Application Server to have a CPU activity of under 5% before
accessing the site, otherwise all components may not have started and you may experience error
messages. Another way is to check whether wcr_jboss_srv.exe threads exceed 160 and
wcr_tomcat_srv.exe threads exceed 100.

To help watch the CPU activity easily, add the CPU performance monitor to the system tray of each
WebCenter server. To do this (on both the Web Server and the Application Server):

1. Create a new shortcut in theStart Menu > Programs > Startup folder.
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2. Browse to Windows\system32\TASKMGR.EXE.
3. Set the shortcut to Run "Minimized".

6.5.3.  Log files

Installation
A log of how WebCenter was installed, repaired, or upgraded will always be located on the Web Server
right under the C:/ drive (C:\WCInstall.log). You can review this file for obvious errors and to see
what settings were entered during the initial installation.

Web Server logfile rotation

Web server log files are split into day-encompassing blocks in the same way that the Application server
log files are. This means that shortly after midnight, each day all the logs recorded the previous day on
the Web server are zipped into a single ZIP archive with the time stamp of the day in the archive name
for easier troubleshooting for the administrator.

This logic adds all the following log file types on the Web server into the target archive:

• catalina.log
• SDK.log
• localhost_access.log
• localhost.log

Note:  Some of those log file types may not always exist for that particular day. For Example, Access
log file is only written if a servlet error occurred during that time period in the Web server.

Shared log file age limit

Both the Application and Web server log files share the age-limit. The length of time the log file
archives are to be stored in the system can be set. Log file archives older than the set value will be
removed shortly after midnight each day.

Site Usage
Usage log files are located on the Web Server by default, in \Artios\WebCenter\logs. They record
activities such as:

• Logins/Logoffs (including when sessions time out and when users click Logout).

WebCenterLoginLog.txt example:

Action Date/Time User Reason
LOGOUT Apr 21, 2006 4:23:18 PM JOEC Reason: user logged out
LOGIN Jun 13, 2006 9:46:01 AM MELISSAA
LOGOUT Jun 13, 2006 10:14:53 AM MELISSAA Reason: session timed out

• File CheckOuts/CheckIns (Lock & Downloads and Upload of new versions).

WebCenterCheckoutLog.txt example:

Action Date/Time User File Unique Doc ID Size (bytes)
CHECKIN Jun 7, 2006 2:13:08 PM MIKEG ACAD Demo.ARD 00002_0000025472 50176
CHECKOUT Jun 8, 2006 2:07:20 PM CHRISJ R.ARD 00002_0000025613 10240
CHECKIN Jun 8, 2006 2:07:54 PM CHRISJ R.ARD 00002_0000025614 10240
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CHECKOUT Jun 9, 2006 8:24:15 AM CHRISJ 4A.ARD 00002_0000025688 4098
CHECKIN Jun 9, 2006 8:24:25 AM CHRISJ 4A.ARD 00002_0000025689 40912

• File Downloads/Uploads (including when downloads start, finish, and fail).

WebCenterDownloadLog.txt example:

Date/Time User File Version Unique Doc ID Size Status
Jun 7, 2006 3:13:30 PM BEAPM 123_Hoegaarden_silver_front.pdf 1 00002_0000000683 85373
 Download Started
Jun 7, 2006 3:13:30 PM BEAPM 123_Hoegaarden_silver_front.pdf 85373 Download Finished
Jun 8, 2006 2:17:24 PM MIKEG Scope_fc.pdf 1 00002_0000001681 1068473 Download Started
Jun 8, 2006 2:17:50 PM BEAPM WebCenterDownload.zip 196608 Download failed

WebCenterUploadLog.txt example:

Date/Time User File Project Size Status
Jun 9, 2006 2:14:10 PM DAZZ docB1.txt bea p 115 Upload started
Jun 9, 2006 2:14:10 PM DAZZ docB1.txt bea p 115 5 Upload finished
Jun 12, 2006 8:15:10 AM ADMIN CMM_CASE.JPG permtest666 0 Upload started
Jun 12, 2006 8:15:10 AM ADMIN CMM_CASE.JPG permtest666 182090 Upload finished
Jun 12, 2006 1:59:57 PM ADMIN DCS.ct bjrtest 0 Upload started
Jun 12, 2006 1:59:58 PM ADMIN DCS.ct bjrtest 189672 Upload finished

Note:

On the Web Server, the local Administrators Group, the SYSTEM user, and both IIS users need full
permissions to the log folder(s) location and the tempfiles folder within each virtual site. To do this:

• Browse to the \Artios\WebCenter\Logs folder

• Ensure that these users and group have full permissions to the log and tempfiles folders:
IUSR_<Web Server_servername> , IWAM_< Web Server_servername>, SYSTEM, Administrators
Group.

Tomcat Service

These log files are located on the Web Server in \Artios\WebCenter\WebServer\tomcat\logs directory.
You can also download them from the WebCenter user interface.

• isapi.log
• Logs IIS to JSP redirection.
• *.log, Catalina*.log, host-manager*.log, localhost*.log, and manager*.log
• Logs various start-up information and service errors.

IIS Services

These log files are located on the Web Server in the \Windows\system32\LogFiles\W3SVC1
directory. They follow the format of exYYMMDD.log, where YYMMDD refers to the calendar Year,
Month, and Day.

The date and time the log file was created represents the first request made on that day. These log all
HTTP and HTTPS requests for that specific date. If there is no client activity on an WebCenter site that
day, no log file is created.

• For example: ex122205.log was created at 5:46 am.

• This means that the first site activity for WebCenter was at 5:46 am and this log file contains all
activity made on 12-22-2005.
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Example IIS log file:

Time of     IP address   Method    Page returned              Status
request        of client           to client                   code
17:09:52  10.31.226.94  GET   /WebCenter_Inst/images/logo_esko.gif      200
17:09:52  10.31.226.94     GET   /WebCenter_Inst/images/bg_Dots2.gif       200
17:10:18  10.31.226.94  POST  /WebCenter_Inst/dologin.jsp      200
17:10:18  10.31.226.94  GET   /WebCenter_Inst/home.jsp      200
17:10:18  10.31.226.94  GET   /WebCenter_Inst/homepage.jsp     200 

JBoss Service

These log files are located on the Application Server in the \Artios\WebCenter\Application-
Server\JBoss\server\default\log directory. You can also download them from the WebCenter
user interface.

• Boot.log and Server.log: These record JBOSS startup activity. The created date and time of
this file represents the last time the WebCenter JBoss service was started or restarted.

• server.log.YYYY-MM-DD: this records the server activity for the specified day, where YYYY-
MM-DD refers to the calendar Year, Month, and Day.

Viewer Applet

This log file is located on the Application Server in \Artios\WebCenter\ApplicationServer
\program directory.

• imageList.log: This logs information about the View & Annotate Tool.

Change logging level for troubleshooting
You can adapt the logging level in <webcenter_install>\ApplicationServer\Jboss
\server\default\deploy\jboss-logging.xml.

Levels are:

• • NONE =  don't log anything
• SEVERE = logs only the important issues
• WARNING = logs all of the above but also possibly unexpected but less critical problems
• INFO = logs all of the above and a lot of information about internal state
• FINE, FINER, FINEST = logs all of the above and debugging output in 3 levels of detail
• ALL = logs everything

Log levels should not be changed in general, but might be changed for troubleshooting reasons
(increase logging) or on heavy loaded systems to reduce disc spamming with logging data (reduce
logging).

Note that these changes can be made to the app server logging without needing to restart the JBoss,
the configuration is reloaded dynamically.

Logging can be changed for the console by changing the name attribute value of the level node in the
console handler: /logging/console-handler/level

<level name="ALL"/>

It can be changed to any of the mentioned levels.
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Logging can be changed for the file based log by copying the level node mentioned above to: /
logging/periodic-rotating-file-handler/level and again adapting the level.

It is also possible to do more granular logging adaptions, for that just go to the bottom of the config
file.

<logger category="com.esko">   
 <level name="INFO" />
</logger> 

<logger category="com.esko.webcenter.src.root.BaseObjectDB">  
 <level name="INFO" />
</logger> 

<logger category="WEBCENTER">   
 <level name="INFO" />
</logger> 

<logger category="appx">   
 <level name="INFO" />
</logger> 

<!--<logger category="com.esko.webcenter.search12">   
 <level name="ALL"/>
</logger>--> 

Here you see different possibilities to raise or lower the logging level.

The WEBCENTER category is used by some of the historical webcenter code. Recent or updated
webcenter code will use a category matching it's class (e.g. 'com.esko.webcenter.src.util.Statement').
This allows to adapt logging levels up to the class. So the following would silence any logging
information coming from the statement class.

<logger category="com.esko.webcenter.src.util.Statement">      
 <level name="NONE"/> 

The categories are hierarchical (with the '.' as separator) which means that you do not need to declare
each an every class all the time.

<logger category="com.esko.webcenter.search12">      
 <level name="ALL"/> 

The example above will enable all (full detail logging) for all the classes/categories in the reworked
search component. The actual logging level is determined by the best match declared here. So
this specific example will enable all logging for 'com.esko.webcenter.search12.SomeClass' but
'com.esko.webcenter.src.util.Statement' will not be affected. That one is covered by the second last
example or if that is not defined by 'com.esko'.

6.5.4.  Interacting with services for troubleshooting

You can change any service to display activity in real-time by starting a .bat file:

• To start TomCat, open a command window on the Web Server at \WebServer\tomcat\bin.
Enter wcr_tomcat_srv_cmdrun.bat to start the service interactively.

• To start JBoss, open a command window on the Application Server at \ApplicationServer
\JBoss\bin. Enter wcr_jboss_srv_cmdrun.bat to start the service interactively.
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• To start CadX, open a command window on the Application Server at \ApplicationServer
\CadXServer\bin. Enterwcr_cadx_srv_cmdrun.bat to start the service interactively.

6.5.5.  Possible Problems

Cannot connect to Database
If you attempt to access login page or login and then receive this error, these are the common causes:

1. You lost the connection to your database server for some reason.
2. You did not use the correct instance name during installation.

Something is preventing the database services from starting or staying started. First try the following
first: Restart your database services. Verify you are using the correct Instance name.

In case that does not help, perform the following steps:

• Check the log files JBoss\server\default\log\{server.log,boot.log}.
The inability to connect to the database is clearly indicated:
'ConnectionException'.

• Read and interpret the messages that are passed by the: 'ConnectionException', they are quite
descriptive.

Three of the most common connection problems are:

• The database is local but TCP is not enabled:

• Look for the 'SQL Server Configuration Manager' in the Windows Start menu and start it.

• In the network section, select Protocols for the WCR database (typically WEBCENTER) and
enable TCP.

• Go to the server services and restart the database in order to make the TCP enablement
effective.

• Restart the WebCenter Application Server.

• Browser is not enabled:

• Go to the server that contains the database and ensure the database browser service is running.
• Restart the WebCenter Application Server.
• If it still does not work, you may try enabling the same option on the Application Server service

and restarting the Application Server again.

• The connection information is incorrect:

• Use SQL Management Studio (it should be on the Application Sever since it is a prerequisite) and
verify the connection information.

• Once you have the correct connection information, we recommend you uninstall the Application
and Web Server and reinstall them.

Cannot connect to Application Server
This usually means one of 4 things:
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• WebCenter JBOSS service on the Application Server is stopped or has not finished loading yet.
• on the Application Server, verify WebCenter_Jboss service is Started. Restart it.
• on the Application Server, open the Task Manager; in the process view enable the threads column;

the app server is started when the number of thread reaches or exceeds about 160.
• There is a JBOSS port conflict on the Application Server.
• Do port testing to ensure that port 1099, 4444, 2500 and 3873 are not in use when all WebCenter and

OBGE services are stopped on the Application Server.
• During the Web Server installation, the name of the Application Server was not entered correctly.
• On the Web Server, Using Notepad, Edit \Artios\WebCenter\WebServer\tomcat\webapps

\WebCenter_Inst\Web Server-INF\classes\jndi.properties.
• Ensure name of the Application Server is correct with the correct port number.

Note:  The Web Server needs to locate the Application Server based on the host name (strict
requirement, see NAT section).

• Restart WebCenter services on both the Web and the Application Server if changes were made.
• The Web Server cannot access the Application Server (meaning Tomcat can’t talk to JBOSS).
• Ensure you can telnet to the Application Server's IP address on WebCenter ports (default 1099,

4444, 2500, 3873) from the Web Server.
• Use this syntax: telnet <ip_address> <port_number>.
• Ensure that you get a Java response and successfully can telnet on each port.
• Ensure that if you are using NAT that you have configured the Web Server and the Application

Server appropriately.

Page 404 after logging in
In this case you can access WebCenter’s login Page. However after you enter in login credentials, you
receive a “Page 404” rather than WebCenter’s home page.

• 99% of the time this is because all WebCenter services haven’t finished starting completely.

Could not load a valid license for WebCenter
Usually this means you don’t have a license or the license has expired.

• Make sure you have a WebCenter License and you have activated it (see the License Manager User
Guide for more information).

• Contact Support hotline to ensure your license has not expired.

Cannot access WebCenter site from external Internet
In this case you can access the site by using the Web Server machine name or IP address within the
LAN (i.e. MBCWEBSERV/WebCenter_Inst), but you cannot access the site(s) using the registered
domain name over the internet (for example http://www.meeberboxcompany.com/WebCenter_Inst).

• Verify that your ISP has registered this domain name with an ‘A’ record setup with your ISP.
• Verify that your ISP is forwarding HTTP and HTTPS trac for this domain name to your firewall.
• Verify that your Firewall routes HTTP and HTTPS trac to the Web Server server within the DMZ.
• Ensure IIS on the Web Server is configured to receive HTTP or HTTPS trac on correct port and

assigned IP address.
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• Refer to the Exposing WebCenter to the Internet section in the Installation Guide to review the
things needed to access your site from the external Internet.

Note:  It is recommended not to use internal server names as this will cause certificate errors for
valid certificates.

Automation Engine error when publishing to WebCenter site
You will only get this message on Automation Engine servers that attempt to publish files to a secured
WebCenter site that uses https://.

If for example the SSL certificates haven't been installed properly on the WebCenter Web Server, all
Automation Engine Publish tasks will fail with the following error message:

javax.net.ssl.SSLHandshakeException:
sun.security.validator.ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to
find valid certification path to requested target

To fix this, you can either:

• make sure the certificates are installed properly on the WebCenter Web Server (see Secure your
WebCenter Site with SSL on page 49 in the Installation Guide),

• import the WebCenter site’s SSL certificates into Automation Engine’s keystore (see Install SSL
Certificates on the Workflow Production Server on page 58 in the Installation Guide).

Cannot use WebCenter SQL Server Database after a restore
Anytime you restore an WebCenter SQL Server database, you must run a stored procedure to fix
orphaned logins before the database is usable.

• Run a manual query against WebCenter4_0 database: sp_change_users_login auto_fix, webcenter,
null,Database Password

• Alternately, follow the instructions at the end of An Example Restore Plan on page 1110.

VRML 3D Animations “stutter” and some graphics may be missing
When viewing a 3D Model on a server, this is to be expected as servers generally do not have good
quality graphics cards.

For clients, when both ArtiosCAD and Cortona are running on same video card, both using Direct3D or
OpenGL to draw 3D designs with a moderate amount of graphics, there is competition for video card
memory. This causes Cortona to “stutter” while running animations and some graphics may be missing.
There are 3 possible workarounds:

• Close ArtiosCAD and re-open VRML in Cortona.

• Specify that Cortona is to use ‘R98 Renderer’.
• Upgrade your Video Card.

No license present to use the Launch API
Sometimes this error appears when trying to use the View and Annotate tool. Sometimes everything
seems to stop working in WebCenter all of a sudden. To resolve:
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• Restart WebCenter and OBGE services on the Application Server.

• Try again. If still get error, then verify that the Graphics license has the Task Launching API module
in it (flfastif).

• On OBGE edit \Esko\bg_data_system_v010\licenses.dat.
• Verify that it contains an ‘flfastif’. If not, have a new license file generated.

The Page cannot be displayeds
This means that IIS and/or WebCenter Tomcat service on the Web Server are Stopped.

The Viewer suddenly stopped working on a Windows XP client
This is a known problem with Windows XP, when an older version of Java is installed on client by
another application.

To fix, clean out the Java Applet Cache. This will allow our applet to use the most recent Java version.

• From Control Panel, open Java configuration.
• On General tab, in ‘Temporary Internet Files’ section, click the <Delete Files> button.
• Check all settings, choose <OK> to empty cache.
• Click <OK> to exit.
• Attempt to access Viewer tool again. Applet should load now.

6.5.6.  E-mail Troubleshooting

Symptom: You get a "Mail Server Connection Error" while trying to send a Test Mail.
Possible resolution: This means that the service cannot connect to the specified mail server. It can
either be down, not accepting external mail session connections, or unreachable from your current
subnet.

First, try to connect to the mail server manually. This is done by running the telnet command from the
command prompt on the appropriate Application Server.

The syntax for telnetting to the mail server is: telnet <MAIL SERVER NAME> <LISTENING PORT>

For example, telnet mail.eskowebcenter5.com 25 tries to connect to the mail server
mail.eskowebcenter5.com that is listening for mail session connections on port 25.

If the telnet command connects to the server, you should also send a EHLO command in the Command
Prompt window, to make sure it is prepared to accept incoming e-mail messages. The Output of the
EHLO command should return OK on the last line. If the output return another result, consult your mail
server administrator.

Symptom: Sending a Test Mail succeeded but WebCenter notifications are not sent.
Possible resolution: This situation points toward a possible error in notification handling on the client
and/or server side. You should first check the Application Server and the Web Server logs for any error
messages.

On the Application Server:

• mail service is logging under this header: com.esko.webcenter.service.MailDispatcher onMessage
• notification message e-mail creation and sending to a JMS queue is logging under this header:

com.esko.webcenter.mail.MailNotificationBean
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On the Web Server:

• notification message data preparation is logging under this header:
com.esko.webcenter.jsp.TaskNotificationMgr (where the Task part is replaced by an appropriate
Notification Type that you're looking for; other possibilities might be ApprovalNotificationMgr,
ProjectNotificationMgr and so on; search for NotificationMgr inside the Web Server log file).

Note:  WebCenter MBean Services will have their own log files in the future.

If you cannot find any suspicious log messages related to any of the notification dispatchment phases,
you should also check the JMS E-mail Queue for corrupted messages that block correct messages
from being sent.

To check a JMS Queue, open the JBoss admin console that is used to inspect all running JBoss
services. To open the admin console, open a browser and point to the following URL: http://
<Application Server Host Name>:8086/admin-console/ where <Application
Server Host Name> is the host name of the machine that is running the WebCenter JBoss (if it is
the current machine, then you can just use localhost).

Note:  Even though the JMX console is listening on port 8080 by default, WebCenter uses port 8086.

When you open the admin console, you have to locate the appropriate E-mail Notifications JMS queue,
which actually is a JBoss service. It is found at <hostname> > JBossAS Servers > JBoss AS
6 (default) > JMS Manager > JMS Queues > jms.queue.WCRMailQueue. From here
you can check how many messages are waiting in the JMS queue (message count). From the control
section you can also flush the queue.

An alternate way to flush the queue is disabling e-mail in the WebCenter e-mail settings. If you don't
plan to use notifications, e-mail should always be disabled to prevent the mail queue from filling up.

Symptom: If the e-mail notification seems to be sent correctly, but the recipient
doesn't receive it:

Possible resolution: This situation indicates that there are issues on the mail server side. The e-
mail service within WebCenter is only responsible for connecting to an appropriate mail server and
dispatching e-mail message through this connection. Further processes that run on the mail server
side are out of the scope of WebCenter. There are several aspects of the mail server configuration that
affect if the WebCenter notifications really get sent to the appropriate recipients:

• Spam policy: messages may be considered spam by the server. It is important to have a valid e-mail
address in the FROM address field on the E-mail Environment Setup page in case there is a spam
policy in place on the appropriate Mail Server

• Authenticated mail session: this situation is already observed by the e-mail service, but some mail
servers might be configured more strictly in this respect.

• Internal vs. external recipient addresses: some mail servers are configured to process outgoing
e-mail messages based on their target e-mail addresses. The distinction is between internal
addresses and external addresses is determined by the domain part of the address. For example,
the domain part of user@esko.com is esko.com. The mail server may be configured to dispatch e-
mail messages to an internal address (so, from the example above, a mail server with hostname of
xxxx.esko.com would consider user@esko.com to be internal, while user@elsewhere.cz would be
external), but it would not send any messages to an external target.

All these issues are determined by the setup of a given mail server, so if you encounter any indications
toward such issues, consult the mail server administrator.

But how would you find out what happens on the mail server when the WebCenter mail service
communicates with it? There is an option to turn on a debug mode for mail sessions in the Mail
Dispatcher MBean.
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To do so, open the JMX Console of the running WebCenter JBoss Server and open the management
interface of the Mail Dispatcher Mbean (at the bottom of the entire list of registered Mbeans under the
section webcenter and service name service=MailDispatcher). Inside the management interface is a
List of Mbean Attributes.

Change the DebugSession attribute to TRUE, which will switch the mail session to debug mode.

If you turn on debug mode, the log file on the Application Server will contain a log of the
communication between the WebCenter mail server and the mail server. Inspect these extra log
messages to see what your problem may be and report the results to the mail server administrator.

6.5.7.  Troubleshooting proxy servers

The influence of proxy servers on your configuration
A proxy server services the requests of its clients by forwarding requests to other servers. The client is
mostly a browser but it can also be another computer program like Automation Engine.

The proxy server provides the resource by connecting to the specified server and requesting the
service on behalf of the client. A proxy server may optionally alter the client's request or the server's
response, and sometimes it may serve the request without contacting the specified server.

A proxy server that passes all requests and replies unmodified is usually called a gateway or sometimes
tunnelling proxy.

For the Automation Engine to WebCenter connectivity, proxy servers that just act as a gateway are
ideal. No extra configuration is required.

• In the other case (not a pure gateway) it can happen that the proxy server is programmed to act
differently than expected on the Automation Engine calls to WebCenter.

• It might decide to just not pass them through; Automation Engine to WebCenter upload fails.
• It might request authentication; nobody there to answer the authentication request since

Automation Engine is an automatic program.
• It might bother the Java viewing.
• It might slow down the communication.
• It might bother the JMS connectivity in the approval feedback.

Most problems can be solved by bringing the proxy server closer to the ideal gateway situation.
However, in many cases it is dicult to convince the local IT people to do any changes to the setup.

How to detect proxy problems?
Proxy problems are mostly detected because certain operations between Automation Engine and
WebCenter fail:

• Upload from Automation Engine to WebCenter fails.
• Approval feedback from WebCenter to Automation Engine fails.

Proxy problems are not the only possible reasons why these operations can fail. Other reasons are:

• Wrong parameters in the upload ticket (mistakes with user accounts, passwords, network address
of the web server, …).

• Broken networks
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The best way to troubleshoot is as follows:

• Check whether you can reach WebCenter from a normal internet browser from the Automation
Engine computer. If that doesn't work, first troubleshoot this. Check whether WebCenter itself
is on the internet (can you reach it from anywhere?). If that works, try reaching Google from the
Automation Engine computer. If that doesn't work, your Automation Engine computer is not
connected to the internet. Contact local IT to get this fixed. If you can reach Google, but not
WebCenter and you can reach WebCenter from outside, then there is a big chance that proxy
settings are in the game.

• If you can reach WebCenter from a browser but upload doesn't work, then first check the
connection in Automation Engine configure (there is a check button). If this works, double check
the ticket settings. If it doesn't work, it means that Automation Engine doesn't have the same
abilities to go to the internet as a browser. Mostly this means that the browser has a proxy setting in
use.

In your browser, check the LAN settings for your internet connection. This is usually found under
Internet Options, Connections where you normally can see whether a proxy server is used and what
settings it uses for the HTTP connection. These same settings need to be used by Automation Engine.

 

 

You need:

1133



6 WebCenter

• Name of the proxy server for HTTP, further called proxyHost
• Port number, further called proxyPort
• In some cases (not so common) it is also possible that the proxy server demands authentication.

You might see this because an authentication window displays when trying to connect to Google or
WebCenter via the browser. In that case you'll also need a username and a password. You should get
this from local IT. This username is further called proxyUser and the password is proxyPassword.

• We have a tool (makeurlconnection.jar) to test a connection with these settings before even trying
them out of Automation Engine. The tool is used as follows:

• Save the makeurlconnection.jar file somewhere on the disk of the Automation Engine server.
Open a command prompt, go to that directory and type the following command:

• Simplest form:

Java.exe -jar makeurlconnection.jar
      http://the_url_to_the_login_page_of_their_webcenter.

Note:  The above command supposes that java.exe is in the path. If not, you need to specify the
location of java.exe, for example.

"C:\Program Files\Java\jre1.6.0_01\bin\java.exe" ... (other parameters as
      above)

It also supposes that it is Java 1.6. It is possible you need to install Java 1.6 first.

This checks whether a connection can be made without specifying anything about the proxy server. If
this works, you get the WebCenter login html code dumped on your screen (scroll back to verify this). If
it doesn't work, you either get an error message or it hangs (type Ctrl-C in that case).

In case it doesn't work, try specifying the just-found parameters. The most complex form is:

Java.exe -Dhttp.proxyHost="name of their proxy server" -Dhttp.proxyPort="80"
      -Dhttp.proxyUser="their_domain_if_applicable\user name" -Dhttp.proxyPassword="guess
 what comes
      here" -jar makeurlconnection.jar
      http://the_url_to_the_login_page_of_their_webcenter.

Note:  All the parameters are case-sensitive. Get help from your local IT administrator if necessary.

Once you know these settings, you need to use them in Automation Engine.

Running cfsedt2.bat in ..\bg_prog_fastserverctltnt_v070\com_win. Browse to the keys as shown in the
screenshot and modify the values. Do a "net stop bgmd" and "net start bgmd" to activate the changes.
Then the upload from Automation Engine to WebCenter should work.
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